
கணினி த�ொழில்நுட்பம்   

மேல்நிலை முதலாம் ஆண்டு

தமிழ்நாடு அரசு

தீண்டாமை மனித நேயமற்ற செயலும் பெருங்குற்றமும் ஆகும்

தமிழ்நாடு அரசு விலையில்லாப் பாடநூல் வழங்கும் திட்டத்தின்கீழ் வெளியிடப்பட்டது

பள்ளிக் கல்வித்துறை
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தமிழ்நாடு அரசு

முதல்பதிப்பு	   -     2018

திருத்தியப்பதிப்பு - 2019, 2020

(புதிய பாடத்திட்டத்தின்கீழ் 
வெளியிடப்பட்ட நூல்)

மாநிலக் கல்வியியல் ஆராய்ச்சி 
மற்றும் பயிற்சி நிறுவனம்
© SCERT 2018

பாடநூல் உருவாக்கமும் 
த�ொகுப்பும்

தமிழ்நாடு பாடநூல் மற்றும் 
கல்வியியல் பணிகள் கழகம்

www.textbooksonline.tn.nic.in

நூல் அச்சாக்கம்

The wise
possess all

க ற ்க  க ச ட ற

விற்பனைக்கு அன்று
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மனித நாகரீக வளர்ச்சியின் மிக உயர்ந்த கண்டுபிடிப்பு “கணிப்பொறிகள்”. 
கணிப்பொறிகள் நமது அன்றாட வாழ்வின் ஒவ்வொரு நிலையிலும், நீக்கமற 

நிறைந்து காணப்படுகிறது. இன்று நாம் வாழும் யுகம், 
“கணிப்பொறி யுகம்”. இந்த யுகத்தில் கணிப்பொறி 
பற்றிய அறிவு இன்றியமையாத ஒன்றாகும். எவர் 
ஒருவர், கணிப்பொறியை இயக்கும் அடிப்படை 

அறிவை பெற்றிருக்கவில்லைய�ோ அவர் எத்தனை 
பட்டங்கள் பெற்றிருப்பினும், கல்லாதவர் என்றே 

கருதப்படுவார். அந்த அளவுக்கு கணிப்பொறி கற்றல் அதி முக்கியத்துவம் வாய்ந்தது. 
நாட்டின் வளர்ச்சி, இளைஞர்களின் கைகளில் தான் உள்ளது, ஒவ்வொரு இளைஞரும் 

கணிப்பொறி அறிவை பெறவேண்டியது அவசியமாகும். இதனை மனதில் க�ொண்டே, இந்த  
பாடப் புத்தகம் வடிவமைக்கப்பட்டுள்ளது.

	� இந்த பாடப்புத்தகத்தை படிக்க கணிப்பொறி 
த�ொழில்நுட்பம் பற்றிய முன்னறிவு 
தேவையில்லை.

	� ஒவ்வொரு அலகும், ஆசிரியர் மற்றும் 
மாணவர்கள் செய்து பழகக்கூடிய  எளிய 
செயல்முறைகள் மற்றும் செயல்பாடுகளைக் க�ொண்டுள்ளது.

	� த�ொழில்நுட்ப கலைச்சொற்களை எளிதில் புரிந்துக�ொள்வதற்காக, 
”கலைச்சொல் அகராதி” இணைக்கப்பட்டுள்ளது.

	� ”உங்களுக்குத் தெரியுமா?” பெட்டி செய்தி, கற்பவருக்கு பாடத் த�ொடர்பான கூடுதல் 
தகவல்களை தருகிறது.

	� மென்பொருள் பயன்பாடுகளைப் பயன்படுத்தி, செய்முறை பயிற்சிகளை தீர்ப்பதற்கான 
”பயிற்சி பட்டறை” அறிமுகம் செய்யப்பட்டுள்ளது.

	� QR குறியீடு, பாடத் த�ொடர்பான கூடுதல் தகவல்களை மின்கற்றல் மூலம் பெறும் 
வகையில் இணைக்கப்பட்டுள்ளது.

QR குறியீட்டை எவ்வாறு இணைப்பது?
o	� உங்கள் ஸ்மார்ட் கைபேசியில், QR ஸ்கேனர் பயன்பாட்டை கூகுள் பிளே 

ஸ்டோரிலிருந்து பதிவிறக்கம் செய்து, நிறுவிக்கொள்ளவும்.
o	 QR ஸ்கேனர் பயன்பாட்டை திறந்துக�ொள்ளவும். 
o	� ஸ்மார்ட் கைபேசியை பாடப்புத்தகத்திலுள்ள QR குறியீட்டுக்கு அருகில் 

க�ொண்டுசெல்லவும்.
o	� ஸ்மார்ட் கைபேசி, QR குறியீட்டை படித்தவுடன், குறியீட்டில் உள்ள இணைய முகவரி 

உங்கள் ஸ்மார்ட் கைபேசியில் இணைக்கப்பட்டு, பாடத் த�ொடர்பான கூடுதலான 
தகவல்களை அறிந்து க�ொள்ளலாம்.

முகப்புரை

இந்த 
பாடப்புத்தகத்தை 

எவ்வாறு 
பயன்படுத்துவது
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12ஆம் வகுப்பிற்கு பிறகு மேற்படிப்பு மற்றும் வேலை வாய்ப்பு ஆல�ோசனை

படிப்புகள் கல்லூரிகள் / பல்கலைக் 
கழகங்கள் வேலை வாய்ப்புகள்

ப�ொறியியல்

இளங்கலை ப�ொறியியல் 
(B.E./B.Tech)

இந்தியா மற்றும் வெளிநாடுகளில்  
உள்ள எல்லா பல்கலைக் 
கழகங்கள் மற்றும் அதன் 
உறுப்புக்கல்லூரிகள், 
சுயநிதிக்கல்லூரிகள்

மென்பொருள் ப�ொறியாளர்/ 
வன்பொருள் ப�ொறியாளர்/ 
மென்பொருள் 
உருவாக்குவர். 
கணிப்பொறி துறையில் 
மருத்துவ சேவைப் பிரிவு.

அறிவியல் மற்றும் கலை

இளங்கலை அறிவியல் (B.Sc.) 
- கணிப்பொறி அறிவியல்
B.C.A. (இளங்கலை 
கணிப்பொறி பயன்பாட்டியல்)
இளங்கலை அறிவியல் 
– கணிதம், இயற்பியல், 
வேதியியல், உயிரிவேதியியல், 
புவியியல், இதழியல்/ 
நூலக அறிவியல்,  அரசியல் 
அறிவியல், பயணம் மற்றும் 
சுற்றிலாவியல். 

இந்தியா மற்றும் வெளி 
நாடுகளில் உள்ள எல்லா 
பல்கலைக் கழகங்கள் மற்றும் 
அதன் உறுப்புக்கல்லூரிகள், 
சுயநிதிக்கல்லூரிகள்

அரசு மற்றும் தனியார் 
நிறுவனங்களில், நில 
அமைப்பியல் வல்லுனர்,
வணிக செயலாக்க 
புறத்திறனீட்டம் (B.P.O.)

சட்டம்

LLB, இளங்கலை- சட்டம்,
இளங்கலை மற்றும் சட்டம்,
இளங்கலை வணிகவியல், 
இளங்கலை வணிக 
மேலாண்மை,
இளங்கலை வணிக நிர்வாகம், 

இந்தியா மற்றும் வெளி 
நாடுகளில் உள்ள எல்லா 
பல்கலைக் கழகங்கள் மற்றும் 
அதன் உறுப்புக்கல்லூரிகள், 
சுயநிதிக்கல்லூரிகள்

வழக்கறிஞர்கள், சட்ட 
அதிகாரிகள் மற்றும் அரசு 
வேலைகள்
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படிப்புகள் கல்லூரிகள் / பல்கலைக் 
கழகங்கள் வேலை வாய்ப்புகள்

வணிகவியல் படிப்புகள்

இளங்கலை-வணிகவியல் 
(வரி  மற்றும் வரி 
நடைமுறைகள்), இளங்கலை-
வணிகவியல் ( பயணம் 
மற்றும் சுற்றுலா),
இளங்கலை-வணிகவியல் 
(வங்கிமேலாண்மை), 
இளங்கலை-வணிகவியல் 
(த�ொழில்முறை), இளங்கலை-
மேலாண்மை நிர்வாகம்.
இளங்கலை-பங்குசந்தை,
இளங்கலை-கணக்கியல் 
மற்றும் நிதி

இந்தியா மற்றும் வெளி நாடுகளில் 
உள்ள எல்லா பல்கலைக் 
கழகங்கள் மற்றும் அதன் உறுப்புக்
கல்லூரிகள், சுயநிதிக்கல்லூரிகள்

தனியார் நிறுவனங்கள், 
வங்கிதுறைகள் மற்றும் 
சுயவேலை வாய்ப்புகள்.

கணக்காயர் படிப்புகள்

C.A. பட்டைய கணக்காயர், 
C.M.A. –செலவு மேலாண்மை 
கணக்காயர்

ICAI –இந்திய பட்டைய 
கணக்காயர் பயிற்சி நிறுவனம்,

கணக்காயர் தனியார் 
நிறுவனங்கள், வங்கி 
துறைகள் மற்றும் 
சுயவேலை வாய்ப்புகள்.

அறிவியல் படிப்புகள்

இளங்கலை-அறிவியல் 
தாவரவியல், விலங்கியல், 
மனையியல், உணவு 
மேலாண்மை, பால் 
த�ொழில் நுட்பம், உணவக 
மேலாண்மை, ஆடை 
அலங்கார மேலாண்மை,
தகவல் த�ொடர்பு, முப்பரிமாண 
அசைவுபட த�ொழில்நுட்பம் (3D)

இந்தியா மற்றும் வெளி நாடுகளில் 
உள்ள எல்லா பல்கலைக் 
கழகங்கள் மற்றும் அதன் உறுப்புக்
கல்லூரிகள், சுயநிதிக்கல்லூரிகள்

அரசு மற்றும் தனியார் 
நிறுவனங்களில், நில 
அமைப்பியல் வல்லுனர்,
வணிக செயலாக்க 
புறத்திறனீட்டம்  (B.P.O.)
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 இயல்
 எண் பாடத் த ைலப்புகள் பக்க 

எண் மாதம்
அலகு I - கணினி அறிமுகம்

1 கணினி அறிமுகம் 1 ஜூன்
2 எண் முறைகள் 15 ஜூன்
3 கணினி அமைப்பு 43 ஜூன்
4 இயக்க அமைப்பின் க�ோட்பாட்டு கருத்துக்கள் 44 ஜூலை

5 விண்டோஸ் - ல் வேலை செய்தல் 52 ஜூலை

அலகு II - ச�ொற்செயலி 
6 ச�ொற்செயலி ஓர் அறிமுகம் 73 ஜூலை

7
ஆவணத்தில் அட்டவணைகள், ப�ொருள்கள் சேர்ப்பது மற்றும் 
ஆவணத்தை அச்சிடல் 105 ஆகஸ்ட்

8 மெயில் மெர்ஜ் மற்றும் கூடுதல் கருவிகள் 123 ஆகஸ்ட்

அலகு III - அட்டவணைச் செயலி
9 அட்டவணைச் செயலி 138 செப்டம்பர்

10 செயற்கூறுகள் மற்றும் வரைபடம் 174 செப்டம்பர்

11 தரவு கருவிகள் மற்றும் அச்சிடுதல் 205 அக்டோபர்

12 நிகழ்த்துதல் - ஓர் அறிமுகம் 225 அக்டோபர்

13 நிகழ்த்துதல் (மேம்பட்டது) 246 அக்டோபர்

அலகு IV - அலுவலக தானியங்கு கருவிகள் 
14 கணிப்பொறி வலையமைப்பு 267 நவம்பர்

15 இணையம் மற்றும் மின்னஞ்சல் 294 நவம்பர்

16 கணிப்பொறியில் தமிழ் 312 நவம்பர்

ப�ொருளடக்கம்ப�ொருளடக்கம்

மின்னூல் மதிப்பீடு இணைய வளங்கள்

பாடநூலில் உள்ள விரைவுக் குறியீட்டைப் (QR Code) பயன்படுத்துவ�ோம்! எப்படி?
  • � உங்கள் திறன்பேசியில், கூகுள் playstore /ஆப்பிள் app store க�ொண்டு QR Code ஸ்கேனர் செயலியை இலவசமாகப் பதிவிறக்கம் செய்து நிறுவிக்கொள்க.
  • �செ யலியைத் திறந்தவுடன், ஸ்கேன் செய்யும் ப�ொத்தானை அழுத்தித் திரையில் த�ோன்றும் கேமராவை QR Code-இன் அருகில் க�ொண்டு செல்லவும்.
  • � ஸ்கேன் செய்வதன் மூலம் திரையில் த�ோன்றும் உரலியைச் (URL) ச�ொடுக்க, அதன் விளக்கப் பக்கத்திற்குச் செல்லும்.
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1

கணினி அறிமுகம்

கற்ைலின் தநொக்கஙகள் ்:

 இந்த பொடபபகுதிசயக் கற்ைபின் மைொணவர் 

அறிந்து ்கொள்வது.

• கணிப்பொறிசயப பற்றி ் தரிந்து்கொள்ளுதல் 

• கணிப்பொறியின்  பல்தவறு தசை 

முசைகசளப பற்றி அறிந்து ்கொள்ளுதல் 

• கணிப்பொறியின் அடிபபசட ்ையல்பொடுகள் 

பற்றி புரிந்து ்கொள்ளுதல்

• கணிப்பொறியின் பொகஙகசளப பற்றியும் 

அதன் ்ையல்பொடுகசளயும் ்தரிந்து 

்கொள்ளுதல் 

• கணிப்பொறி ்தொடஙகுதல் (Booting) பற்றி 

்தரிந்து ்கொள்ளுதல்

உஙகளுக்கு ்தரியுமைொ?

1837 ம் ஆண்டு, 
“அனைடிக்கல் இன்ஜின்” 
(Analytical Engine) என்ை 
கருவிசய வடிவசமைத்த 
ைொர்ைஸ பொதபஜ், 
“கணிப்பொறியின் தந்சத” 
என அசழக்கபபடுகிைொர். 

“அனைடிக்கல் இன்ஜின்” – கணித ஏரணச் 
்ையைகத்சதயும், அடிபபசட கடடுபபொடடு 
அசமைவுகசளயும், உள்ளிசணந்த 
நிசனவகத்சதயும் உள்ளடக்கியது. இவரின் 
இந்த “அனைடிக்கல் இன்ஜின்”, முதல் 
்பொதுபபயன்  கணிப்பொறிகசள வடிவசமைக்க 
அடிபபசடயொக அசமைந்தது.

கணிப்பொறியின் 
தந்சத

1.1 கணிப்பொறி ஓர் அறிமுகம்

 
 நமைது அன்ைொட வொழ்வில், நம்சமைச் சுற்றி 

எல்ைொ இடஙகளிலும், கணிப்பொறிகள் நீஙகொ இடம் 

்பற்றுள்ளன. கல்வி, ஆரொய்ச்சி, சுற்றுைொ, வொனிசை 

முன்னறிவிபபு, ைமூக வசைதளம், மின்வணிகம் 

(e-commerce) தபொன்ை பை  துசைகள். வொயிைொக 

நமைது வொழ்வில் கணிப்பொறிகள் ஒரு தவிர்க்க 

முடியொத அஙகமைொக மைொறிவிடடது. ஒரு தவசைசய 

தவகமைொகவும், அதத தநரத்தில் துல்லியமைொகவும் 

்ைய்துமுடிக்கும் கொரணத்தொல் நமைது 

வொழ்க்சகசயக் கணிப்பொறிகள் புரடசிகரமைொனதொக 

மைொற்றியுள்ளன என்பது உண்சமையிதைதய 

குறிபபிடத்தக்கது.  இன்று எந்த ஒரு நிறுவனமும் 

கணிப்பொறி இல்ைொமைல் இயஙக முடியொது. 

உண்சமையில் பை நிறுவனஙகள் “்கொகி�மில்லொ” 

அலுவைகஙகளொகச் ்ையல்படத் ்தொடஙகிவிடடன. 

கணிப்பொறிகள், ்தொடக்கத்தில் ஒரு ைொதொரணக் 

கணக்கிடும் கருவியொக வடிவசமைக்கபபடடு, கடந்த 

பை ஆண்டுகளொகப பரிணொமை வளர்ச்சி ்பற்று, 

இன்று அதிதவகக் சகயடக்கக் கணிப்பொறிகளொக 

மைொற்ைபபடடுள்ளன. 

 கணக்கீடுகசள விசரவொகவும், 

துல்லியமைொகவும் ்ைய்ய தவண்டியதன் 

அவசியதமை, கணிப்பொறி ்தொழில்நுடப 

வளர்ச்சியின் அடிபபசடயொக அசமைந்தது. 

சகவழிக் கணக்கீடுகள் நீண்ட தநரம் 

எடுத்துக்்கொள்வதுடன், பிசழயுள்ளதொகவும் 

இருந்தது. எனதவ விசரவொகக் கணக்கிடும் 

ைொதனஙகசளத் தயொரிக்கும் முயற்சிகளில் 

தமைற்்கொள்ளபபடட பயணம், அபொ்கஸ்-ல் 

்தொடஙகி, இன்று மிக அதிதவகக் கணக்கீடடுக் 

கருவிகசள வடிவசமைக்கும் பொசதயில் ் தொடர்ந்து 

பயணித்துக் ்கொண்டிருக்கின்ைது. 

1.2 கணிப்பொறியின் தசைமுசைகள்

 ்தொழில் நுடபத்தின் வளர்ச்சி, 

கணிப்பொறித் துசையின் வளர்ச்சிசயத் 

தீர்மைொனிக்கின்ைது.  பல்தவறு வடிவசமைபபு 

கடடஙகளின் அடிபபசடயில் கணிப்பொறிகசளப 

பை தசைமுசைகளொக வசகபபடுத்தைொம்.

பொடம் 1கணினி அறிமுகம்அைகு I 
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வரிசை 

எண்

கணிப்பொறியின் 

தலைமுறை
காலம் 

பயன்படுத்திய 

முதன்மை சாதனம்  
 நிறை  / குறை 

1
முதலாம் 

தலைமுறை 
1940-
1956

வெற்றிடக் குழல்கள் 
(Vaccum tubes) 

•	 அளவில் பெரியது 
•	 அதிக அளவு மின்சாரத்தை 

எடுத்துக்கொண்டது.
•	 அதிக வெப்பம் காரணமாக 

செயலிழக்கும்.
•	 இயந்திர ம�ொழி  

பயன்படுத்தப்பட்டது.

 முதல் தலைமுறை கணிப்பொறிகள்  - ENIAC , EDVAC , UNIVAC 1, ENAIC - 27 டன் எடை, பரப்பளவு

8 x 100 x 3 அடி, மின்சாரத் தேவை 150 வாட்கள்

2
இரண்டாம் 

தலைமுறை 
1956-
1964

திரிதடையங்கள் 

(Transistors)

•	 முதல் தலைமுறையுடன் 
ஒப்பிடும்போது அளவில் சிறியது.
குறைந்த வெப்பத்தை  
வெளியேற்றியது. (குறைந்த 
மி ன்சா   ர த்தை    
எடுத்துக்கொண்டது).

•	 துளையிட்ட அட்டை, உள்ளீட்டுக்கு 
பயன்படுத்தப்பட்டது.

•	 முதல் இயக்க அமைப்பு 
(Operating System) 
உருவாக்கப்பட்டது.

•	த� ொகுப்பு செயலாக்க அமைப்பு 
மற்றும் பன்முக இயக்க 
அமைப்பு(Batch Processing and 
multiprogramming operating 
system) உருவாக்கப்பட்டது

•	 இயந்திர ம�ொழி மற்றும் அசெம்பளி 
ம�ொழி பயன்படுத்தப்பட்டது.

இரண்டாம் தலைமுறை கணிப்பொறிகள்  - IBM 1401, IBM 1620, UNIVAC 1108

3
மூன்றாம் 

தலைமுறை 
1964 
-1971

ஒருங்கிணைந்த 
சுற்றுகள் (Integrated 

circuits-IC)

•	 கணிப்பொறிகள் அளவில் 
சிறியதாகவும் , விரைவாக 
செயல்படும் மற்றும் அதிக 
நம்பகத் தன்மையுடையது.

•	 குறைந்த மின்சாரத்தை  எடுத்துக் 
க�ொண்டது.

•	 உயர் நிலை ம�ொழி 
பயன்படுத்தப்பட்டது

மூன்றாம்  தலைமுறை கணிப்பொறிகள் - IBM 360 series, Honeywell 6000 series

4
நான்காம் 

தலைமுறை 
1971-1980

நுண் செயலி (மிகப் 
பெரிய அளவிலான 

ஒருங்கிணைந்த 
சுற்றுகள்)

(Very Large Scale 
Integrated Circuits 

-VLSI)

•	 சிறியது மற்றும் வேகமானது 

•	 IBM மற்றும் APPLE ப�ோன்ற 

நுண் கணிப்பொறிகள்  

உருவாக்கப்பட்டது

•	கை யடக்க கணிப்பொறிகள் 

அறிமுகபடுத்தப்பட்டது .
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5
ஐந்தாம்  

தலைமுறை

1980 - 
இன்று 
வரை

மீப்பெரு அளவிலான 
ஒருங்கிணைந்த 

சுற்றுகள்
(Ultra Large Scale 
Integration -ULSI)

•	 இணை செயலாக்கம் (Parallel 
processing)

•	 கணிப்பொறியின் அளவு மிகவும் 
கணிசமாகக் குறைக்கப்பட்டது.

•	 நிழற்படங்கள் மற்றும் 
வரைபடங்களைப் புரிந்து 
க�ொள்ளும் திறன்.

•	செ யற்கை நுண்ணறிவு மற்றும் 
நிபுணர் அமைப்பு (Expert 
Systems) அறிமுகம்.

•	 தீர்மானித்தல் மற்றும் தருக்க 
முறையில் அதிகச் சிக்கலான 
பிரச்சனைகளுக்குத் தீர்வு 
க ா ணு த ல் .

6
ஆறாவது 

தலைமுறை

எதிர்

காலத்தில்

•	 இணை மற்றும் பகிர்வு கணிப்பீடு

•	 கணிப்பொறிகள் திறமையாகவும்,  
விரைவாகவும் மற்றும் 
சிறியதாகவும் இருக்கும்.

•	செ யற்கை மனிதர்கள் (Robots) 
உருவாக்குதல்.

•	 இயற்கை ம�ொழி செயலாக்கம்
•	 குரல் அறிதல் மென்பொருள் 

உருவாக்குதல்.

அட்டவணை 1.1 கணிப்பொறி தலைமுறைகள்

உங்களுக்கு தெரியுமா?

முதல் இயக்கவகை கணிப்பொறி

ஜே. பிரெஸ்பர் எகெர்ட் 
மற்றும் ஜான் 
ம�ௌச்சிலி ஆகிய 
இருவர் 
பென்சில்வேனியா 
பல்கலைக் கழகத்தில் 

1943ம் ஆண்டின் த�ொடக்கத்தில் ENIAC – யை 
வடிவமைக்கத் த�ொடங்கினர். ஆனாலும், 1946 
வரை வடிவமைப்பு பணிகள் நிறைவு பெறவில்லை.  
ENIAC 1800 சதுர அடி இடப்பரப்பில், சுமார் 18000 
வெற்றிடக்குழல்களுடன், 
50டன் எடையில் 
வடிவமைக்கப்பட்டது. 
ENIAC ஒரு 
கணிப்பொறிக்கான 
அனைத்து அம்சங்களை  
க�ொண்டு, செயல்படும் 
விதத்தில் இருந்ததால், இதுவே முதல் 
கணிப்பொறியாகக் கருதப்படுகிறது.

1.3 ஆறாவது தலைமுறை கண்ிப்பொறிகள்

	 செயற்கை நரம்பியல் வலையமைப்பின் 
(ANN - Artificial Neural Networks) 
அடிப்படையில் ஆறாவது தலைமுறை  
கணிப்பொறிகள், அறிவு சார்ந்த கணிப்பொறிகள் 
என வரையறுக்கப்படுகிறது. ஆறாவது 
தலைமுறை, கணிப்பொறிகளின் வியத்தகு 
மாற்றங்களில் ஒன்று பரந்த வலையமைப்பு 
(WAN - Wide Area Networking) -ன் வளர்ச்சி 
ஆகும். இயற்கை ம�ொழி செயலாக்கம் (NLP–
Natural Language Processing)  என்பது 
செயற்கை நுண்ணறிவு (AI–Artificial 
Intelligence)-ன் ஒரு அங்கமாகும்.  இது  மனித 
ம�ொழியைப் புரிந்துக�ொள்ளக் கூடிய  ஒரு 
கணிப்பொறி நிரலை  உருவாக்குவதற்கான 
திறனை வழங்குகிறது. 

1.4 தரவு மற்றும் தகவல்

	 கணிப்பொறி என்றால் என்னவென்று 

நாம் அனைவரும் அறிவ�ோம் - அது 

க�ொடுக்கப்பட்ட கட்டளைகளை உள்ளீடாகப் 
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்பற்று, அதிதவகமைொகச் ்ையல்படடு, விரும்பிய 

்வளியீடசட வழஙகும் ஒரு மின்னணு ைொதனம் 

ஆகும். 

 கணிப்பொறிகள் தரவுகசளச் 
தைமிக்கவும், வொனிசை முன்னறிவிபபு, விமைொனம், 
ரயில் தபொக்குவரத்து பயணச்சீடடு முன்பதிவு, 
திசரயரஙக நுசழவுச்சீடடு முன்பதிவு தபொன்ை 
பை பணிகசளயும், விசளயொடடு மைற்றும் இதர 
்பொழுதுதபொக்கு அம்ைஙகசளயும் ்ைய்யும் 
பல்திைன் ்பற்ைசவயொக உள்ளது.
தரவு: பல்தவறு வசககளிலும் திரடடபபடும் 
்ையற்படுத்தபபடொத  ்ைய்தித் துணுக்கு தரவு 
எனபபடும். 
 இது ்தொடர்பு ்கொள்வதற்கும், 
விளக்குவதற்கும் அல்ைது ்ையைொக்கம் 
்ைய்வதற்கும் ஏற்ைது.
 எடுத்துக்கொடடொக 134, 16, `கவிதொ', `சி' 
தபொன்ைசவ தரவிற்கு உதொரணம். தரவு எந்த  
விளக்கமைொன தகவசையும் அளிக்கொது
தகவல் : தகவல் என்பது முடிவுகசள 
எடுக்கக்கூடிய உண்சமைகளின் ்தொகுபபொகும் 
எளிசமையொக கூைதவண்டு்மைனில், தரவு என்பது 
ைரியொன ்பொருள் ்கொண்ட, முசைபடுத்தபபடட 
அல்ைது கடடசமைக்கபபடட தகவசை 
வழஙகுவதற்கு ்ையைொக்கபபடட மூை 
உண்சமைகளொகும். எடுத்துக்கொடடொக, 
கவிதொவின் வயது 16 என்ை கூற்று, கவிதொசவப 
பற்றி ைரியொன ்பொருள் ்கொண்ட அர்த்தமுள்ள 
தகவசை ்தரிவிக்கின்ைது. தரவுகசளத், 
தகவல்களொக மைொற்ைம் ்ைய்யும் இந்த 
்ையல்முசை "�ரவு தசயலொக்கம்" என்று 
அசழக்கபபடுகிைது.

உள்ளீடு ்ையைொக்கம் ்வளியீடு

தரவு
தகவல்

படம் 1.1 தரவு மைற்றும் தகவல்

 "கணிப்பொறி என்பது ஒரு மின்னணு 
ைொதனம் ஆகும். இது மூைத்தரவுகசளப 
(்ையல்படுத்தபபடொத) பயனரிடம் இருந்து 
உள்ளீடொகப ்பற்று, ்கொடுக்கபபடட 
கடடசளகளின் படி (நிரல்) ் ையல்படுகிைது. இதன் 
விசளவொகக் கிசடக்கும் தரசவ, (்வளியீடு) 
எதிர்கொைப பயன்பொடடிற்கொகச் தைமித்து, 
் வ ளி யி டு கி ை து . "

1.5 கணிப்பொறியின் பகுதிகள்

 கணிப்பொறி என்பது வன்்பொருள் மைற்றும் 
்மைன்்பொருளின் கைசவயொகும். கணிப்பொறியில் 
உள்ள பருப்பொருள்களொன மைதர்தபொர்ட 
(motherboard), நிசனவகம் (memory), 
திசரயகம் (monitor) மைற்றும் விசைபபைசக 
(keyboard) தபொன்ைசவ  வன்்பொருள் 
(hardware) ஆகும்.  ்மைன்்பொருள் (software) 
என்பது கணிப்பொறிக்கு வழஙகபபடும் கடடசள 
அல்ைது கடடசளகளின் ்தொகுபபு ஆகும். ஒரு 
கணிப்பொறியின் இயக்கத்திற்கு வன்்பொருள் 
மைற்றும் ்மைன்்பொருள் ஆகிய இரண்டும் 
து ச ண பு ரி கி ை து . 

படம் 1.2  கணிப்பொறி

 முதலில் நொம் ஒரு கணிப்பொறியின் 
்ையல் பகுதிகசளப பற்றிக் கற்தபொம். 
கணிப்பொறியில்,  ்கொடுக்கபபடட ஒவ்வொரு 
பணியும், உள்ளீடு- ்ையைொக்கம்-்வளியீடு என்ை 
சுழற்சிசய (IPO- Input Process Output- cycle) 
அடிபபசடயொகக் ்கொண்டு ்ையைொற்றுகிைது. 
கணிப்பொறியின் ஒவ்வொரு ் ையைொக்கத்திற்கும் 
ஒரு சிை உள்ளீடுகள் ததசவ. இந்த உள்ளீடசடச் 
்ையல்படுத்தி  விரும்பிய ்வளியீடசட 
உருவொக்குகிைது.  உள்ளீடடகம், உள்ளீடசடப 
்பறுகிைது, சமையச்்ையைகம் தரசவச், 
்ையைொக்கம் ்ைய்கிைது, ்வளியீடடகம் 
்வளியீடசட ்வளியிடுகிைது.  நிசனவகம் 
்ையைொக்கத்தின் தபொது தரவு மைற்றும் 
கடடசளகசள இருத்தி சவக்கிைது.
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கணித ஏரண 
செயலகம்

உள் 
நினைவகம்

முதன்மை நினைவகம்

இரண்டாம் நிலை நினைவகம்

வெளியீட்டகம்உள்ளீட்டகம்

கட்டுப்பாட்டகம்

தரவுப் பாதை
கட்டுப்பாட்டுப்

 பாதை

படம் 1.3 கணிப்பொறியின் பகுதிகள்

1.5.1  உள்ளீட்டகம் 

	 உள்ளீட்டகம் அனைத்து வகையான 
தரவுகளையும் கணிப்பொறிக்குள் உள்ளிடப் 
பயன்படுகிறது. உள்ளிடப்பட்ட தரவுகள் 
செயலாக்கத்திற்காக நினைவகத்தில் 
சேமிக்கப்படுகின்றன. எடுத்துக்காட்டு 
விசைப்பலகை, சுட்டி ப�ோன்றவை. 

1.5.2  மையச் செயலகம்

மையச் செயலகம் என்பது, கணிப்பொறிக்கு 
வழங்கப்படும் கட்டளைகளைக், கணிப்பொறி 
புரிந்துக�ொள்ளும் வகையில் மாற்றி அதனை 
செயலாக்கம் செய்யும் முதன்மையான பகுதியாகும். 
இது நினைவகம், உள்ளீடு மற்றும் வெளியீடு 
ப�ோன்ற மற்ற அனைத்துச் சாதனங்களின் 
செயல்பாட்டைக் கட்டுப்படுத்துகிறது.  இது தரவை 
உள்ளீடாகப் பெற்று, க�ொடுக்கப்பட்ட 
கட்டளைகளின் படி செயல்படுத்தி,  வெளியீட்டை 
வெளியிடுகிறது.

	மை யச்செயலகத்தில்  மூன்று பகுதிகள் 
உள்ளன, அவை கட்டுப்பாட்டகம் (CU - Control 
Unit), கணித ஏரணச் செயலகம் (ALU - 
Arithmetic and Logic Unit) மற்றும் நினைவகம் 
(MU - Memory Unit) ஆகும்.

1.5.2.1 கணித ஏரணச் செயலகம் 

	மை யச்செயலகத்தின் ஒரு பகுதியாக 
உள்ள கணித ஏரணச் செயலகம்,   பல கணிப்பீடு 
செயல்களைத் தரவின் மீது நிகழ்த்துகிறது. 
கூட்டல், கழித்தல், பெருக்கல், வகுத்தல் 
மற்றும் தருக்க செயல்கள் ப�ோன்ற கணிதச் 
செயல்பாடுகளைக் கணித ஏரணச் செயலகம் 
செய்கிறது. மையச்செயலகத்தில் உள்ள உள் 
நினைவகத்தில் இதன் விடை சேமிக்கப்படுகிறது. 
கணித ஏரணச் செயலகத்தின் தருக்கச்  செயல் 
திறனே கணிப்பொறியின் முடிவெடுக்கும் திறனை 
மேம்படுத்துகின்றன.

1.5.2.2 கட்டுப்பாட்டகம்  

	மை யச்செயலகம் - நினைவகம் மற்றும் 
உள்ளீடு  வெளியீடு சாதனங்களுக்கு இடையே 
பரிமாறப்படும் தரவைக் கட்டுப்பாட்டகம் 
கட்டுப்படுத்துகிறது. மேலும், கணிப்பொறியின் 
முழுச் செயல்பாடுகளையும் இது 
கட்டுப்படுத்துகிறது. 
1.5.3 வெளியீட்டகம்

	 பயனர்கள் புரிந்து க�ொள்ளக்கூடிய 
வகையில் தகவலைத் தெரிவிக்கும் எந்தவ�ொரு 
வன்பொருளும் வெளியீட்டகம்  எனப்படும்.  
எடுத்துக்காட்டு: திரையகம், அச்சுப்பொறி 
ப�ோன்றவை. 

1.5.4 நினைவகம் 

	  முதன்மை நினைவகம் மற்றும் இரண்டாம் 
நிலை நினைவகம் என இருவகை நினைவகங்கள் 
உள்ளன. கட்டளைகள் நிறைவேற்றத் தயாராக 
இருக்கும்போது தரவு மற்றும் நிரல்களைத் 
தற்காலிகமாகச் சேமிக்க முதன்மை நினைவகம்  
பயன்படுகிறது. தரவுகளை நிரந்தரமாகச் 
சேமித்துவைக்க இரண்டாம் நிலை நினைவகம் 
பயன்படுகிறது. 

	 அதாவது, முதன்மை நினைவகம் அழியும் 
நினைவகமாகும் முதன்மை நினைவகத்துக்கு 
மின்சாரம் நிறுத்தப்பட்டவுடன் அதில் 
சேமிக்கப்பட்டுள்ள அனைத்துத் தகவல்களும் 
அழிந்துவிடும். முதன்மை நினைவகத்திற்கு 
எடுத்துக்காட்டு; நேரடி அணுகல் நினைவகம் 
(RAM - Random Access Memory) ஆகும்.  
இரண்டாம் நிலை நினைவகம் அழியா 
நினைவகமாகும், அதாவது இரண்டாம் நிலை 
நினைவகத்திற்கு மின்சாரம் நிறுத்தப்பட்டாலும் 
அதில் சேமி்க்கப்பட்டுள்ள அனைத்துத் 
தகவல்களும் அழியாமல் இருக்கும். வன்வட்டு 
(Hard disk), குறுவட்டு (CD-ROM) மற்றும் டிவிடி  
ர�ோம் (DVD ROM) ப�ோன்றவை இரண்டாம் நிலை 
நினைவகத்திற்கு எடுத்துக்காட்டுகள் ஆகும்.

1.5.5	 உள்ளீட்டு மற்றும் வெளியீட்டு 
சாதனங்கள்

உள்ளீட்டு சாதனங்கள்: 
	 (1) விசைப்பலகை: விசைப்பலகை (கம்பி / 
கம்பியில்லா / மாய) கணிப்பொறிகளில் மிகவும் 
ப�ொதுவாகப் பயன்படுத்தப்படும் உள்ளீட்டு 
சாதனம் ஆகும். எழுத்துகள், எண்கள் மற்றும் 
சிறப்பு குறியீடுகளுக்கான தனித்தனிப் 
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மின்நகல் இயந்திரம்" (Xerox machine) தபொல் 

்ையல்படுகிைது. எழுதபபடட அல்ைது 

அச்சிடபபடட, புசகபபடஙகசள உள்ளடக்கிய 

எந்த்வொரு தகவசையும் வருடி  கணிப்பொறிக்கு 

இைக்கமுசை  தகவைொக மைொற்றியசமைக்கிைது.

(4) சகதரசக வருடி (Fingerprint Scanner): 

சகதரசக வருடி என்பது 

சகதரசகசய உணர்ந்து  

க ணி ப ் ப ொ றி க் கு ப 

பொதுகொபபு வழஙகிடும் 

ஒரு கருவி, அதன்  

்ையல்திைன்,  சகதரசக 

உ யி ர ள ச வ யி ய ல் 
( b i o m e t r i c ) 

்தொழில்நுடபத்தின் அடிபபசடயில் 

இயஙகும் தன்சமை ்கொண்டது. நிசனவில் 

சவத்துக்்கொள்ள முடியொத, கடினமைொன 

மைற்றும் தமைொைடிக்கு வழிவகுக்கக் கூடிய 

கடவுச்்ைொல்லுக்கு பதிைொக மிகவும் 

பொதுகொபபொனது மைற்றும் வைதியொனது சகதரசக 

படிபபொன் (Fingerprint Reader) / வருடி 

(Scanner) ஆகும். 

(5) டிரொக் பந்து (Track Ball):  டிரொக் பந்து 

சுடடியின் தசைகீழ் வடிவசமைபசபப தபொன்ைது, 

பயனர் பந்சத நகர்த்தும்தபொது, கருவி நகரொமைல் 

படம் 1.6 சகதரசக 
வருடி

்பொத்தொன்கசள ்மைொத்தமைொக "எழுத்துரு 
தபொத்�ொன்்கள்" எனைொம். கணிப்பொறிகளில் 
பயன்படுத்தபபடும் விசைபபைசக, தடடச்சுப 
்பொறிகளில் (typewriter) உள்ள விசைப 
்பொத்தொன்களின் அடிபபசடயில் 
தருவிக்கபபடடது. தரவுகளும், தகவல்களும் 
விசைபபைசகயின் மூைம் தடடச்சு ்ைய்து 
கணிப்பொறியில் உள்ளிடபபடுகின்ைது. எழுத்து 
மைற்றும் எண் வசக ்பொத்தொன்கசளத் தவிர 
்வவதவறு ்ையல்பொடுகசளச் ்ைய்வதற்கொன 
பிை தசயல்பொட்டு தபொத்�ொன்்களும் (function 
keys) உள்ளன. விசைபபைசகயில் பல்தவறு 
வசக ்பொத்தொன்களின் ்தொகுபபுகள் உள்ளன, 
அசவ எழுத்துவசக, எண்வசக, 
்ையல்பொடடுவசக, நுசழவு மைற்றும் பதிபபொய்வு 
்பொத்தொன்கள் ஆகும்.

படம் 1.4  விசைப பைசக

(2) சுடடி :  சுடடி (கம்பி / கம்பியில்ைொ) என்பது 
திசரயில் இடசுடடின் (cursor)  இயக்கத்சதக் 
கடடுபபடுத்தும்  ஒரு சுடடுச் ைொதனமைொகும். 
கணிப்பொறியில் உள்ள பணிக் குறிகள் (icons), 
படடிகள் (menus), கடடசள ்பொத்தொன்கள் 
(command buttons) தபொன்ைவற்சைத்    
ததர்ந்்தடுத்துச் ்ையல்படுத்துவதற்கு இது 
பயன்படுகிைது. கிளிக், இரடசடக் கிளிக், வைது 
கிளிக், இழுத்து விடு தபொன்ைசவ, சுடடியின் சிை 
்ையல்பொடுகள் ஆகும். 

பைவசகயொன சுடடிகள்  உள்ளன, அசவ 
இயந்திரவியல் (Mechanical) சுடடி, ஒளியியல் 
சுடடி (Optical Mouse ), தைைர் (Laser) 
சுடடி, ஏர் சுடடி (Air Mouse) 3D சுடடி , 
்தொடுபபுைன்(Tactile) சுடடி , ஏர்்கொ்னொமிக் 
சுடடி (Ergonomic Mouse), தகமிங சுடடி 
(Gaming Mouse).  
(3) வருடி(Scanner): கணிப்பொறியின் 

நி ச ன வ க த் தி ல்  

தநரடியொகத் தகவசை 

உள்ளிட வருடிகள் 

பயன்படுத்தபபடுகின்ைன. 

இந்தக் கருவி ஒரு "உைர் படம் 1.5 வருடி

உஙகளுக்கு ்தரியுமைொ?

சுடடிசயக் கண்டுபபிடுத்தது யொர்?

 இன்சைக்கு நொம் 

ப ய ன் ப டு த் து ம் 

கணிப்பொறியின் சுடடிசய, 

டக்ளஸ எங்கல்பர்ட 
(Douglas Engelbart) 

என்பவர் பில் இஙகிலீஸ 

(Bill English) என்பவரின் 

உதவியுடன் 1960 இல் 

கண்டுபிடித்தொர். பின்னர் 1970 ஆம் ஆண்டு 

நவம்பர் 17 ஆம் தததி அன்று அதற்குக் 

கொபபுரிமைம் வழஙகபபடடது.
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இருக்கும். திசரயில் 

இ ய க் க ங க ச ள ச் 

் ை ய ல் ப டு த் து வ த ற் கு ப 

பயனர் பல்தவறு 

திசைகளில் பந்சதச் 

சுழற்றுவொர்.

(6) விழித்திசர வருடி (Retinal Scanner): 

விழித்திசர  வருடி என்பது  ஒரு உயிரளசவயியல் 

(biometric) நுடபத்தில் ்ையல்படும் கருவி ஆகும். 

இது ஒரு நபரின் விழித்திசர இரத்த நொளஙகளின் 

தனிபபடட வடிவஙகசளப பயன்படுத்துகிைது.  

படம் 1.8  விழித்திசர வருடி
(7) ஒளிப தபனொ (Light Pen) : ஒளிப தபனொ 
என்பது ஒரு தபனொ தபொன்ை வடிவம் ்கொண்ட 
சுடடிக்கொடடும் கருவி, 
அது  திசரயகத்துடன் 
இசணக்கபபடும். ஒளிப 
தபனொவின் முசனயில் 
ஒரு ஒளி உணர்திைன் 
( l i g h t - s e n s i t i v e ) 
்கொண்ட ்பொருள் 
்பொருத்தபபடடுள்ளது, அது திசரயில் இருந்து 
்வளிச்ைத்சதக் கண்டறிந்து தபனொவின் 
இடத்சத அசடயொளம் கொணக் கணிப்பொறிக்கு 
உதவுகிைது.  ஒளிப தபனொக்கள் திசரயில் 
தநரடியொக வசரயும் தன்சமை ்கொண்டசவ, 
ஆனொல் இது பயன்படுத்தக்  கடினமைொனது 
தமைலும் துல்லியமைொக வசரவதற்கு 
துசணபுரிவதில்சை.

8) ஒளிவழி எழுத்து படிபபொன் 
(Optical Character Reader) :

இது  கொகிதத்தில் 
அச்சிடபபடட  அல்ைது 
எழுதபபடட எழுத்துகசளக் 
கண்டறிகிைது. இசதப 
பயன்படுத்திப பயனர் ஒரு 
புத்தகத்தில் இருந்து ஒரு 

படம் 1.9  ஒளிப  தபனொ

படம் 1.10  ஒளிவழி 

எழுத்து படிபபொன்

பக்கத்சத வருட முடியும். கணிப்பொறி பக்கத்தில் 
உள்ள எழுத்துகள் மைற்றும் நிறுத்தற்குறிகசள 
உணர்ந்து, தைமித்துக் ்கொள்ளும். வருடபபடட 
ஆவணத்சதச் ்ைொற்்ையலி மூைம் பதிபபொய்வு 
்ைய்யைொம்.

(9) படசடக் குறியீடு / கியூ. ஆர் படசட படிபபொன் 
(Bar Code / QR Code Reader) :  படசடக் 
குறியீடு என்பது ்வவதவறு தடிமைன் வரிசையில் 
அச்சிடபபடும் ஒரு வடிவம் 
ஆகும். படசட குறியீடடு 
படிபபொன், படசடக் 
குறியீடசடப படித்து 
அவற்சை மின் 
துடிபபுகளொக (electric 
pulses) மைொற்றி 
க ணி ப ் ப ொ றி 
்ையைகத்திற்கு அனுபபும் ஒரு கருவியொகும். 
கணிப்பொறியில் தகவசை விசரவொகவும் 
பிசழயின்றி பதிவு ்ைய்யவும் இது பயன்படுகிைது. 

கியூ.ஆர் (Q.R. – Quick Response) குறியீடொனது, 
இரு பரிமைொண படசடக் குறியீடொகும், இது ஒரு 
தகமைரொ மூைம் படிக்கபபடட படத்சத ் ையல்படுத்த  
உணர்த்துகிைது.

(10) குரல் உள்ளீடடு  ைொதனம் (Voice Input 
Systems) : நுண்தபசி 
ஒரு குரல் உள்ளீடு 
ை ொ த ன மை ொ க ச் 
்ையல்படுகிைது. இது 
குரல் தரசவப ்பற்று 
க ணி ப ் ப ொ றி க் கு 
அ னு ப பு கி ை து . 
நு ண் த ப சி யு ட ன் , 
த ப ச் சி ச ன 
உணர்ந்து்கொள்ளும் ்மைன்்பொருசளப 
பயன்படுத்திக் கணிப்பொறிக்கு உள்ளிடபபடும் 
தகவலுக்கொன முற்றிலும் புதிய அணுகுமுசைசய 
வழஙகுகிைது .

(11) இைக்கவசக 
தகமைரொ (Digital 
Camera): இந்த ைொதனம் 
இைக்க (digital) வடிவில்  
தநரடியொகப படஙகசள 
எடுக்கிைது. இது சிசிடி 
( மி ன் த ன ற் ை ப ப ட ட 
இசண ைொதனம்) – CCD 
(Charged Coupled Device) எனும் மின்னணு 
சில்லு (Electronic chip)-சவ பயன்படுத்துகிைது. 

படம் 1.11  படசடக் 
குறியீடு படிபபொன்

படம் 1.12 குரல் 

உள்ளீடடு ைொதனம்

படம் 1.13 
இைக்கவசக தகமைரொ

படம் 1.7 டிரொக் பந்து
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ஒளி வில்சை (lens) மூைம் ்வளிச்ைம் சில்லுவின் 
மீது விழும்தபொது ஒளிக்கதிர்கள் 
இைக்கமுசைக்கு மைொற்ைபபடுகிைது.

(12) ்தொடு திசர (Touch Screen):  ்தொடுதிசர 
என்பது ஒரு கொடசி ைொதனம். 
இது பயனர் கணிப்பொறியுடன் 
ஊடொடுவதற்கு விரசைப 
பயன்படுத்த அனுமைதிக்கிைது.  
ஒரு வசரகசை பயனர்  
இசடமுகத்தில் (GUI) 
உைவுவதற்கு, சுடடி அல்ைது 
விசைபபைசகக்கு மைொற்ைொகத் 
்தொடு திசர பயன்படுகிைது.  
கணிப்பொறி மைற்றும் மைடிக்கண்ினி, திசரயகம்,  
ஸமைொர்ட சகதபசிகள், தடபைடஸ (tablets), 
பணபபதிதவடுகள் (cash registers) மைற்றும் தகவல் 
கணிப்பொறியகம் (information kiosks) தபொன்ை 
பல்தவறு வசகயொன ைொதனஙகளில் ்தொடு திசர 
பயன்படுத்தபபடுகின்ைன. சிை ்தொடு திசரகள் 
்தொடு உணர் திைசன உள்ளிடுவதற்குப பதிைொக 
ஒரு விரலின் இருபசப உணர, அகச்சிவபபு 
பிம்பஙகளின் ஒரு கடடத்சதப பயன்படுத்துகின்ைன.

(13) விசை (Keyer):  ஒரு விசை என்பது சகயொல் 
ைமிக்சஞை ்ைய்வதற்கொன ஒரு ைொதனமைொகும். இது 
ஒன்று அல்ைது 
அதற்கு தமைற்படட 
நிசைமைொற்றி (switch)-
கசளக் ்கொண்டு 
அழுத்துவதன் மூைம்   
்ையல்படுகிைது.  முழு 
அளவு விசைபபைசக 
தபொல் அல்ைொமைல், நவீன விசை ஏரொளமைொன 
நிசைமைொற்றிகசளக் ்கொண்டிருக்கும்.  
்பொதுவொக, இந்த எண்ணிக்சக 4 மைற்றும் 50க்கு 
இசடயில்  இருக்கும். விசையில் “எந்�ப் 
பலம்கயும் இல்மல” (“no board”) என்ை 
கருத்தில்தொன் விசை ஒரு விசைபபைசகயிலிருந்து 
மைொறுபடுகிைது, ஆனொல் விசைகள் ஒரு 
குழுக்களொக அசமைக்கபபடடுள்ளது.

்வளியீடடு ைொதனஙகள் :

(1) திசரயகம் (Monitor)
 தகவசைத் திசரயில் கொடடப ்பொதுவொகப 
பயன்படுத்தபபடும் ்வளியீடடு ைொதனம் திசரயகம் 
ஆகும். இது ் தொசைக்கொடசி ் படடிசயப தபொன்ைது. 
திசரயகத்தில் படஙகள் பிகதசல்ஸ் (PIXELS) 
எனபபடும் படக் கூறுகளுடன் உருவொக்கபபடுகிைன.   

படம் 1.14 ்தொடு 
திசர

படம் 1.15 விசை

படம் 1.16  திசரயகம்

ஒதர வண்ணமுசடய 
திசரயகம் கருபபு மைற்றும் 
்வள்சள நிைத்தில் 
கொடடுகிைது. வண்ணத் 
திசரயகம் பை நிைஙகளில் 
கொடடுகிைது. சிஆர்டி(கத்ததொட 
தர டியூப)- CRT (Cathode 
Ray tube),  எல்சிடி (லிக்விட 
கிரிஸடல் டிஸபிதள)- LCD 
(Liquid Crystal Display) 
மைற்றும் எல்ஈ டி(சைட 
ஏமிடடிங சடதயொடகள்)- LED (Light Emitting 
Diodes) தபொன்ை பல்தவறு வசகயொன திசரயகஙகள் 
கிசடக்கின்ைன. திசரயகம் தகவசை விஜிஏ 
(ஒளிஉரு வசரபட வரிசை)-VGA (Video Graphics 
Array) மூைம் திசரயில் கொடடுகிைது. விசைபபைசக 
திசரயகத்துடன் ் தொடர்பு ் கொள்ள ஒளிஉரு வசரபட 
அடசட (Video Graphics Card) உதவுகிைது. இது 
கணிப்பொறி மைற்றும் திசரயகத்தின் இசடதய 
இசடமுகமைொக ்ையல்படுகிைது.  அண்சமையில்  
மைதர்தபொர்டகள் (motherboards) வசரபட 
அடசடகசள உள்ளிசணந்ததொக வழஙகுகிைது. 

 1973 ஆம் ஆண்டு மைொர்ச் 1 ஆம் தததி 
்வளியிடபபடட ்ேரொக்ஸ ஆல்தடொ (Xerox 
Alto) என்ை கணிப்பொறி அசமைபபின் ஒரு 
பொகமைொக முதல் திசரயகம் இருந்தது.
(2) வசரவி (Plotter) :  வசரவி என்பது ஒரு 
்வளியீடுச் ைொதனம் ஆகும். இது தொள்களில்  
வ ச ர க ச ை 
்வளியீடசட அச்சிட 
பயன்படுகிைது. இது 
படஙகசள வசரய 
ஒற்சை நிைம் அல்ைது 
பை வண்ணம் 
் க ொ ண் ட 
தபனொக்கசள பயன்படுத்துகிைது.

(3) அச்சுப்பொறிகள் (Printers) : தொள்களில் 
தகவல்கசள அச்சிட அச்சுப்பொறிகள் 
பயன்படுத்தபபடுகிைது. அச்சுப்பொறிகள் இரண்டு 
முக்கியப பிரிவுகளொகப பிரிக்கபபடுகிைது. 

• தடடல் அச்சுப்பொறிகள் (Impact Printers)
• தடடொ அச்சுப்பொறிகள் (Non Impact 

Printers)

தடடல் அச்சுப்பொறிகள்

 இந்த வசகயில் ஒரு  சிறு கம்பி, சமை  

நொடொ (ribbon) மீது தடடி ஒரு புள்ளிசய 

படம் 1.17 வசரவி

படம் 1.18 தடடல் 
அச்சுப்பொறி 
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ஏற்படுத்தும் அல்லது ஒரு 

முழு எழுத்தை தட்டி அந்த 

எழுத்தை ஏற்படுத்தும். இந்த 

அச்சுப்பொறிகள் இயந்திர 

அழுத்தத்தைப் பயன்படுத்தி  

ஒரே சமயத்தில் பல படிகள் 

எடுக்க வகை செய்கிறது.  

வரி அச்சுப்பொறி மற்றும்  வரிபுள்ளி அச்சுப்பொறி 

ஆகியவை தட்டல் வகைக்கு எடுத்துக்காட்டுகள் 

ஆகும்.

	 புள்ளி  அச்சுப்பொறி (Dot Matrix Printer) 
ஒரு குறிப்பிட்ட எண்ணிக்கையிலான செருகி 
அல்லது கம்பிகளைப் பயன்படுத்தி அச்சிடுகிறது. 
ஒவ்வொரு புள்ளியும் ஒரு சிறிய உல�ோகக் கம்பி 
மூலம் உருவாக்கப்படுகிறது. இது ஒரு சிறிய 
மின்காந்தம் அல்லது வரிச் சுருள் சக்தியைச் 
செயல்படுத்தி நேரடியாகவ�ோ அல்லது 
நெம்புக�ோல்களால�ோ செயல்படுகிறது.  இதில் 
ப�ொதுவாக ஒரு நேரத்தில் ஒரு வரி உரையை 
மட்டுமே அச்சிட முடியும்.  இந்த  அச்சுப்பொறிகளின்,  
அச்சிடும் வேகம் 30 முதல் 1550 சிபிஎஸ் (CPS - 
Character Per Second) வரை வேறுபடுகிறது.

	 வரிபுள்ளி அச்சுப்பொறிகள் (Line Matrix 
Printer) அச்சிடுவதற்கு நிலையான அச்சு 
தலைகளைக் (print head) க�ொண்டுள்ளது. 
அடிப்படையில், இது ஒரு பக்க அளவிலான 
புள்ளிகளை அச்சிடுகிறது. ஆனால் இது 
புள்ளிகளின் அச்சிடும் க�ோடுகள் மூலம் ஒரு வரி 
உரையை உருவாக்குகிறது.  வரி அச்சுப்பொறிகள் 
வினாடிக்கு 1000 க்கு மேற்பட்ட வரிகளை (Lines 
Per Minute) அச்சிடும் திறன் க�ொண்டது. இதன் 
விளைவாக ஒரு மணிநேரத்திற்கு 
ஆயிரக்கணக்கான பக்கங்கள் அச்சிடப்படும். 
இந்த வகை அச்சுப்பொறிகளும் இயந்திர 
அழுத்தத்தைப் பயன்படுத்துவதால்  ஒரே 

சமயத்தில் பல படிகள் எடுக்க வகை செய்கிறது.

தட்டா அச்சுப்பொறிகள் (Non-Impact Printers)
	 இந்த வகை 
அ ச் சு ப ் ப ொ றி க ள் 
அச்சிடுவதற்டு தட்டும் 
( s t r i k i n g ) 
ப ா க ங ்களைப்    
பயன்படுத்துவதில்லை. 
இது லேசர் மற்றும் 
நி ல ை மி ன்  ன ோ ட ்ட 

படம் 1.19 லேசர் 

அச்சுப்பொறி 

ஒரே வண்ணமுடைய 
திரையகம் கருப்பு மற்றும் 
வெள்ளை நிறத்தில் 
காட்டுகிறது. வண்ணத் 
திரையகம் பல நிறங்களில் 
காட்டுகிறது. சிஆர்டி(கத்தோட் 
ரே டியூப்)- CRT (Cathode 
Ray tube),  எல்சிடி (லிக்விட் 
கிரிஸ்டல் டிஸ்பிளே)- LCD 
(Liquid Crystal Display) 
மற்றும் எல்ஈ டி(லைட் 
ஏமிட்டிங் டைய�ோட்கள்)- LED (Light Emitting 
Diodes) ப�ோன்ற பல்வேறு வகையான திரையகங்கள் 
கிடைக்கின்றன. திரையகம் தகவலை விஜிஏ 
(ஒளிஉரு வரைபட வரிசை)-VGA (Video Graphics 
Array) மூலம் திரையில் காட்டுகிறது. விசைப்பலகை 
திரையகத்துடன் த�ொடர்பு க�ொள்ள ஒளிஉரு வரைபட 
அட்டை (Video Graphics Card) உதவுகிறது. இது 
கணிப்பொறி மற்றும் திரையகத்தின் இடையே 
இடைமுகமாக செயல்படுகிறது.  அண்மையில்  
மதர்போர்ட்கள் (motherboards) வரைபட 
அட்டைகளை உள்ளிணைந்ததாக வழங்குகிறது. 

	 1973 ஆம் ஆண்டு மார்ச் 1 ஆம் தேதி 
வெளியிடப்பட்ட ஜெராக்ஸ் ஆல்டோ (Xerox 
Alto) என்ற கணிப்பொறி அமைப்பின் ஒரு 
பாகமாக முதல் திரையகம் இருந்தது.
(2) வரைவி (Plotter) :  வரைவி என்பது ஒரு 
வெளியீடுச் சாதனம் ஆகும். இது தாள்களில்  
வ ரை  க ல ை 
வெளியீட்டை அச்சிட 
பயன்படுகிறது. இது 
படங்களை வரைய 
ஒற்றை நிறம் அல்லது 
பல வண்ணம் 
க�  ொ ண்ட  
பேனாக்களை பயன்படுத்துகிறது.

(3) அச்சுப்பொறிகள் (Printers) : தாள்களில் 
தகவல்களை அச்சிட அச்சுப்பொறிகள் 
பயன்படுத்தப்படுகிறது. அச்சுப்பொறிகள் இரண்டு 
முக்கியப் பிரிவுகளாகப் பிரிக்கப்படுகிறது. 

•	 தட்டல் அச்சுப்பொறிகள் (Impact Printers)
•	 தட்டா அச்சுப்பொறிகள் (Non Impact 

Printers)

தட்டல் அச்சுப்பொறிகள்

	 இந்த வகையில் ஒரு  சிறு கம்பி, மை  

நாடா (ribbon) மீது தட்டி ஒரு புள்ளியை 

படம் 1.17 வரைவி

படம் 1.18 தட்டல் 
அச்சுப்பொறி 

(electrostatic) த�ொழில்நுட்பத்தைப்  
பயன்படுத்துகிறது.  இந்த அச்சுப்பொறிகள் தட்டல் 
அச்சுப்பொறிகளைவிட வேகம் மற்றும் தரத்தில்  
சிறந்தது. மைப்பீச்சு (Inkjet) அச்சுப்பொறி மற்றும்  
லேசர் (Laser) அச்சுப்பொறி ஆகியவை தட்டா 
வகைக்கு எடுத்துக்காட்டுகள் ஆகும்.  

லேசர் (Laser) அச்சுப்பொறி:

	லேச ர் (Laser) அச்சுப்பொறிகள் 
பெரும்பாலும் படியெடுப்பான் (photocopiers) 
பயன்படுத்தும் ஒத்த த�ொழில்நுட்பத்தையே  
பயன்படுத்துகிறது. அச்சுப்பொறியின் உள்ளே ஒரு 
உருளை (drum) முழுவதும் லேசர் கதிர் முன்னும் 
பின்னுமாக வருடும் ப�ோது ஒரு நிலையான மின்சாரம் 
ஒரு வடிவத்தை உருவாக்குகிறது. இது வரைகலைப் 
படங்களைத் திறன்பட உருவாக்குகிறது.  லேசர் 
அச்சுப்பொறியின் முக்கியச் சிறப்பியல்புகளில் 
ஒன்று அவற்றின் தெளிவுதிறன் (resolution) ஆகும் 
- ஒரு அங்குலத்திற்கு எத்தனை புள்ளிகள் (DPI) 
என்பது 1200 dpi க்கு கிடைக்கக்கூடிய 
தெளிவுதிறன் வரம்பு, ஏறக்குறைய  ஒரு நிமிடத்திற்கு 
100 பக்கங்களை அச்சிடலாம் (PPM – Pages Per 
Minute).
மைப்பீச்சு அச்சுப்பொறிகள் (Inkjet Printers) :
	மைப் பீச்சு அச்சுப்பொறிகள் கருஞ்சிவப்பு 
(Magenta), மஞ்சள்(Yellow) மற்றும் சியான்(Cyan) 
உள்ளடக்கிய மைகுப்பியைப் பயன்படுத்தி வண்ண 
சாயலை (color tones) உருவாக்குகிறது.  ஒரு நிற 
வண்ணத்தில் (monochrome) அச்சிடுவதற்கு 
கருப்பு (black) 
மை  கு ப் பி யை  
ப ய ன்ப  டு த் து கி ற து . 
மைப்   பீ ச் சு 
அச்சுப்பொறிகள்  ஒரு 
காகிதத் தாளில் 
மின்னூட்டம் பெற்ற 
மையைத் தெளிப்பதன் மூலம் செயல்படுகிறது.  
இதன் அச்சிடும் வேகம் ப�ொதுவாக ஒரு 
நிமிடத்திற்கு 1 முதல் 20 பக்கங்களை அச்சிடும் 
(PPM – Pages Per Minute).
	மைப் பீச்சு அச்சுப்பொறிகள்,  வெப்பம் 
மூலம் மின்கலன் சூடாக்குவதால் மை காகிதத்தில் 
குமிழிகளாக (bubbles) தெளிக்கப்படும் 
த�ொழில்நுட்பத்தை அல்லது தகைவுமின்சாரத்தை 
(piezoelectricity)பயன்படுத்தி மின்சுற்றுகள் 
மூலம் கட்டுப்படுத்தபடும் சிறிய மின்னோட்டங்கள் 
ஜெட் வேகத்தில், அச்சுப்பொறியின் உள்ளே 

படம் 1. 20 மைப்பீச்சு 
அச்சுப்பொறி 
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மையைப் பரப்புகின்றன.

ஒலிபெருக்கிகள் (Speakers): ஒலிபெருக்கிகள் குரல் 
ஒலியை (audio) 
வெளியிடுகிறது. பேச்சு 
இ ணை  ப ்பாக்க    ம் 
மென   ் ப ொ ரு ளை  
ஒ லி பெ  ரு க் கி யு ட ன் 
பயன்படுத்திக் கணிப்பொறி 
குரல் வெளியீட்டை வழங்க 
முடியும். விமான நிலையங்கள், பள்ளிகள், வங்கிகள், 
இரயில் நிலையங்கள் ப�ோன்ற பல இடங்களில் இது 
மிகவும் ப�ொதுவானதாக உள்ளது.

பல்லூடகப் படவீழ்த்தி (Multimedia Projector):  
பல்லூடகப் படவீழ்த்தி, 
கணிப்பொறி திரையக 
வெளியீட்டைப் பெரிய 
திரையில் திரையிடப் 
ப ய ன்ப  டு கி ன்ற  து . 
இ வை  க ள்  
வ கு ப ்பற  ை க ளி ல் 
அல்லது கூட்ட அரங்குகளில் விளக்கக்  
காட்சிகளைக் காட்சிப்படுத்தப் 
பயன்படுத்தப்படுகின்றன.

1.6	� கணிப்பொறியைத் த�ொடங்குதல் 
(Booting)

	 ஒரு கணிப்பொறியை இயக்கும் 

அடிப்படை மென்பொருள் “இயக்க அமைப்பு” 
(OS - Operating System) ஆகும்.  ஒரு 

கணிப்பொறி த�ொடங்கும் ப�ோது அதன் 

முதன்மை நினைவகத்தில் (RAM) எந்தத் 

தகவல்களும் இருக்காது. அதே நேரத்தில், 

அதன் “படிக்க மட்டும் நினைவகத்தில்” (ROM 
– Read Only Memory) ஏற்கனவே எழுதப்பட்ட 

“மின் இணைப்பில் சுய ஆய்வு” (POST - 
Power On Self Test)  என்ற நிரல் முதலில் 

இயங்கத் த�ொடங்கும். இந்த நிரல் 

கணிப்பொறியில் இணைக்கப்பட்டுள்ள 

அனைத்துப் புறக்கருவிகளும் (முதன்மை 

நினைவகம், விசைப்பலகை, திரையகம் 

ப�ோன்ற), இயங்கும் நிலையில் உள்ளதா என 

ஆய்வு செய்யும். அனைத்தும் சரியான நிலையில் 

இருந்தால் மட்டுமே, த�ொடர்ந்து “அடிப்படை 

உள்ளீட்டு-வெளியீட்டு முறைமை”- (BIOS-
Basic Input Output System) யை இயக்கும். 

படம் 1. 21 
ஒலிபெருக்கிகள்

இந்தச் செயல்முறை “த�ொடங்குதல்” (Booting) 

என அழைக்கப்படுகின்றது. அதன் பின்னர், 

Boot Strap Loader என்ற நிரல், “இயக்க 

அமைப்பு” மென்பொருளை வன்வட்டிலிருந்து, 

முதன்மை நினைவகத்திற்கு அனுப்புகின்றது.  

இப்போது கணிப்பொறி திரையில், நமது 

கணிப்பொறியில் நிறுவப்பட்டுள்ள இயக்க 

அமைப்பு மென்பொருள் (விண்டோஸ் / லினக்ஸ் 

அல்லது வேறு ஏதேனும் ஒரு இயக்க அமைப்பு) 
இயங்க த�ொடங்கும். 

	 ஒரு கணிப்பொறியில் இரண்டு வகையான 
“த�ொடங்குதல்” (Booting) முறைகள் உள்ளன.  
அவை 

(1) தண் த�ொடக்கம் (Cold booting) 

(2)  உடன் த�ொடக்கம் (Warm booting). 

1. தண் த�ொடக்கம் (Cold booting) 

	 ஒரு கணிப்பொறியை முதன்முதலில் 

த�ொடங்குவதைத் தண் த�ொடக்கம் அல்லது வன் 

த�ொடக்கம் (Hard booting) எனலாம். இந்தத் 

த�ொடக்க முறையில், பயனர் மின் இணைப்பைத் 

த�ொடங்கும் ப�ோது, படிக்க மட்டும் நினைவகத்தில் 

(ROM) உள்ள த�ொடங்குதல் நிரல் இயங்கத் 

த�ொடங்கும்.

2.  உடன் த�ொடக்கம் (Warm booting)

	 இயங்கிக் க�ொண்டிருக்கும் ஒரு 

கணிப்பொறியை ஏதேனும் ஒரு சூழலில் அதன் 

இயக்கத்தை நிறுத்தி மீண்டும் த�ொடங்குதலை 

உடன் த�ொடக்கம் அல்லது மென் த�ொடக்கம் 

(Soft booting) எனலாம். இந்த முறையில், 

கணிப்பொறி “தண் த�ொடக்க முறையில்” 

த�ொடங்கியது ப�ோல் அனைத்துப் 

புறக்கருவிகளின் இணைப்பை உறுதி செய்து 

த�ொடங்குவதில்லை. மேலும், இந்த த�ொடக்க 

முறையில் முதன்மை நினைவகத்தில், முந்தைய 

இயக்கத்தின் ப�ோது பயன்படுத்தப்பட்ட 

தகவல்கள் முறையாக இரண்டாம் நிலை 

நினைவகத்திற்கு மாற்றப்படாத நிலை 

ஏற்படுவதால், தகவல்கள் அழியும் நிலையும், 

கணிப்பொறியின் இயக்க அமைப்பு பழுதடையும் 

நிலையும் ஏற்படும்.

படம் 1.22 பல்லூடகப் 
படவீழ்த்தி
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நினைவில் க�ொள்ள வேண்டிய குறிப்புகள்:

•	 நமது அன்றாட வாழ்வில், நம்மைச் சுற்றி 
எல்லா இடங்களிலும், கணிப்பொறிகள் நீங்கா 
இடம் பெற்றுள்ளன.

•	 கணிப்பொறி என்பது, க�ொடுக்கப்பட்ட 
கட்டளைகளை உள்ளீடாகப் பெற்று, 
அதிவேகமாகச் செயல்பட்டு, விரும்பிய 
வெளியீட்டை வழங்கும் ஒரு மின்னணு 
சாதனம் ஆகும். 

•	 கணிப்பொறியின் வளர்ச்சியைப் பல்வேறு 
நிலைகளின் அடிப்படையில் ஆறு வெவ்வேறு 
தலைமுறைகளாகப் பிரிக்கலாம்.

•	 கணிப்பொறி என்பது மென்பொருள் மற்றும் 
வன்பொருளின் கலவையாகும்.

•	 வன்பொருள்  என்பது கணிப்பொறியின் 
பருப்பொருள்களாகும்.

•	 உள்ளீட்டகத்தைப் பயன்படுத்தி 
கணிப்பொறிக்கு எந்தவ�ொரு தரவையும் 
க�ொடுக்கலாம்.

•	 மையச்செயலகம் என்பது கட்டளைகளை 
செயல்படுத்துவதற்கு பயன்படுகிறது.

•	 கணித ஏரணச் செயலகம் (ALU), ஆனது 
மையச்செயலகத்தின் (CPU) ஒரு பகுதியாகும்,  
தரவுகளில் பல்வேறு கணிப்பீட்டு 
செயல்பாடுகள்  இதில்  நிகழ்த்தப்படுகிறது.  

•	 மையச்செயலகம், நினைவகம் மற்றும் உள்ளீடு /  
வெளியீடு சாதனங்களுக்கு இடையில் 
தரவைக் கட்டுப்பாட்டகம் கட்டுப்படுத்துகிறது.

•	 பயனர்கள் புரிந்து க�ொள்ளக்கூடிய வகையில் 
தகவலைத் தெரிவிக்கும் எந்தவ�ொரு 
வன்பொருளும்  ஒரு வெளியீட்டகம்  ஆகும்.

•	 முதன்மை நினைவகம் மற்றும் இரண்டாம் 
நிலை நினைவகம் ஆகிய இருவகை 
நினைவகங்கள் உள்ளன 

•	 தண் த�ொடக்கம் (Cold booting) மற்றும்  
உடன் த�ொடக்கம் (Warm booting) ஆகிய 
இரண்டு வகையான “த�ொடங்குதல்” 
(Booting) முறைகள் உள்ளன.

மாணவர் செயற்பாடுகள்
1.	 கணிப்பொறியின் வகைகளை விளக்குக.

2.	 கணிப்பொறியின் மதர்போர்ட்-களின் 
பெயர்களைத் தருக. மேலும் 1993, 1995, 
2005, 2008 மற்றும் 2016 ஆண்டுகளில் 
பயன்பாட்டில் இருந்த முதன்மை 
நினைவகத்தின் (RAM) க�ொள்ளளவைத் 
தருக.

3.	 இந்தப் பாடப்பகுதியில் விளக்கப்படாத 
ஏதேனும் இரண்டு உள்ளீட்டு, வெளியீட்டு 
சாதனங்களைக் குறிப்பிடுக.

செயல்பாடு

மதிப்பாய்வு

பகுதி - அ 

சரியான விடையை 

தேர்ந்தெடுத்து எழுதுக:

1.	 முதல் தலைமுறை 

க ணி ப ் ப ொ றி க ளி ல் 

ப ய ன்ப  டு த்த  ப ்ப ட ்ட 

பகுதிப்பொருள்

	 (அ) வெற்றிடக் குழல்

	 (ஆ) திரிதடையகம்

	 (இ) ஒருங்கிணைந்தச் சுற்றுகள்

	 (ஈ) நுண்செயலிகள்

2.	 தற்காலிக நினைவகம் எது?

	 (அ) ROM		  (ஆ) PROM

	 (இ) RAM		  (ஈ) EPROM

3.	வெ ளியீட்டு சாதனத்தை அடையாளம் 
காண்க.

	 (அ) விசைப்பலகை	 (ஆ) நினைவகம்

	 (இ) திரையகம்		  (ஈ) சுட்டி

4.	 உள்ளீட்டு சாதனத்தை அடையாளம் 
காண்க 

	 (அ) அச்சுப்பொறி	 (ஆ) சுட்டி

	 (இ) வரைவி		  (ஈ) படவீழ்த்தி 
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5.	 கட்டிட வரைபடத் திட்டம்,  பிளக்ஸ் 

அட்டை ப�ோன்றவற்றை அச்சிடப் 

பயன்படும் வெளியீட்டு சாதனம் எது?

	 (அ) வெப்ப அச்சுப்பொறி

	 (ஆ) வரைவி	

	 (இ) புள்ளி அச்சுப்பொறி	

	 (ஈ) மைபீச்சு அச்சுப்பொறி 

6.	 ஏ.டி.எம் இயந்திரங்களில், 

கீழ்க்கண்டவற்றுள் எது 

பயன்படுத்தப்படுகிறது?

	 (அ) த�ொடுதிரை		 (ஆ) திரையகம்		

(இ) ஒலி பெருக்கி	 (ஈ) அச்சுப்பொறி

7.	 ஒரு கணிப்பொறி  மீண்டும் த�ொடங்கும் 

ப�ோது எந்த வகையான த�ொடங்குதலைப் 

பயன்படுத்துகிறது.

	 (அ) உடன் த�ொடக்கம்

	 (ஆ) தண் த�ொடக்கம்

	 (இ) த�ொடு த�ொடக்கம்

	 (ஈ) மெய் த�ொடக்கம்

8.	 POST – ன் விரிவாக்கம்.

	 (அ) Post on self Test
	 (ஆ) Power on Software Test	

	 (இ) Power on Self Test
	 (ஈ) Power on Self Text

9.	 கீழ்வருவனவற்றுள் எது ஒரு முதன்மை 

நினைவகமாகும்?

	 (அ) ROM		  (ஆ) RAM

	 (இ) Flash drive		 (ஈ) Hard disk

10.	 எந்த கணிப்பொறி தலைமுறையில் 

ஒருங்கிணைந்த சுற்றுகள் 

பயன்படுத்தப்பட்டது?

 	 (அ) முதலாம்		  (ஆ) இரண்டாம்

	 (இ) மூன்றாம்		  (ஈ) நான்காம்

பகுதி - ஆ 

குறு வினாக்கள்:

11.	 கணிப்பொறி என்றால் என்ன?

12.	 தரவு மற்றும் தகவல் வேறுபடுத்துக.

13.	மை யச் செயலகத்தின் (CPU) பகுதிகள் 

யாவை?

14.	 கணித ஏரணச் செயலகத்தின் (ALU) 

செயல்பாடு யாது?

15.	 கட்டுப்பாட்டகத்தின் செயல்களை 

எழுதுக?

16.	 நினைவகத்தின் செயல்பாடு யாது?

17.	 உள்ளீட்டகம் மற்றும் வெளியீட்டகம் 

வேறுபடுத்துக. 

18.	 முதன்மை நினைவகம் மற்றும் இரண்டாம் 

நிலை நினைவகம் வேறுபாடு யாது?

பகுதி - இ

சிறு வினாக்கள்:

19.	 கணிப்பொறியின் தன்மைகள் யாவை?

20.	 கணிப்பொறியின் பயன்பாடுகளை 

எழுதுக.

21.	 உள்ளீட்டு சாதனங்கள் என்றால் என்ன? 

இரண்டு எடுத்துக்காட்டுகள் தருக.

22.	 ஏதேனும் மூன்று வெளியீட்டு 

சாதனங்களை விளக்குக?

23.	 ஒளியியல் சுட்டி மற்றும் லேசர் சுட்டி 

வேறுபடுத்துக 

24.	 தட்டல் வகை அச்சுப்பொறியைப் பற்றி 

சிறுகுறிப்பு வரைக.

25.	 ஆறாவது தலைமுறையின் 

தன்மைகளைப் பற்றி சுருக்கமாக 

எழுதுக.

26.	 திரையகத்தின் குறிப்பிடத்தக்க 

சிறப்பியல்புகளைப் பற்றி எழுதுக.
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பகுதி - ஈ 

நெடு வினாக்கள்:

27.	 ஒரு கணிப்பொறியின் அடிப்படை 

பாகங்களைத் தெளிவான 

விளக்கப்படத்துடன் விளக்கு. 

28.	 கணிப்பொறியின் பல்வேறு 

தலைமுறைகளை விளக்குக.

29.	 பின்வருபவற்றை விளக்குங்கள்

 	 அ) மைப்பீச்சு அச்சுப்பொறி 

	 ஆ) பல்லூடகப் படவீழ்த்தி

	 இ) பட்டைக் குறியீடு / QR  குறியீடு 

படிப்பான்

நூற்பட்டியல்: 
(1)	 கணிப்பொறிகளின் அடிப்படைகள் -  

வி. ராஜராஜன் - PHI பிரசுரங்கள்

(2)	 கணிப்பொறி அறிவியல் பாடப்புத்தகம் - 
NCERT, புது தில்லி

இணைய வளங்கள்: 

(1)	 www.wikipedia.org
(2)	� https ://www.computerhope.com/

j a r g o n / c / c o m p u t e r. h t m

நிகழ் ஆய்வு

	வே கம், நினைவகம், அளவு, மின்சார நுகர்வு 

மற்றும் பிற அம்சங்களைக் கருத்தில் க�ொண்டு 

கடந்த கால மற்றும் தற்போதைய பல்வேறு 

கணிப்பொறிகளை ஒப்பிட்டு ஒரு ஆய்வு தயார் செய்க.

ச�ொற்களஞ்சியம்

கணிப்பொறி - Computer
கணிப்பொறி என்பது ஒரு மின்னணு சாதனம், அதற்கு வழங்கப்பட்ட 

கட்டளைகளின் படி உள்ளீட்டைப் பெற்று அதைச் செயல்படுத்தி, 

தேவையான வெளியீட்டை மிக வேகமாகக் க�ொடுக்கிறது.

வெற்றிடக்குழல்-
Vacuum tube

வெற்றிடக் குழல்கள் எலெக்ட்ரான் ஓட்டத்தைக் கட்டுப்படுத்த 

மின்சுற்றுகளைக் க�ொண்டுள்ளன, ஆரம்பகாலக் கணிப்பொறிகளில்  ஒரு 

நிலைமாற்றி அல்லது ஒரு பெருக்கியாகப் பயன்படுத்தப்பட்டன.

தி ரி த டை  ய க ம் - 
Transistors

திரிதடையகம் ("பரிமாற்ற எதிர்ப்பாற்றல்") அரை கடத்திகளால் 

உருவாக்கப்படுகிறது. இது  மின்னழுத்த அளவைக் கட்டுப்படுத்த ஒரு 

மின்னணு சமிக்ஞையின் பெருக்கம் / பண்பேற்றம் அல்லது நிலைமாற்றி 

ஆகியவற்றிற்காகப் பயன்படுத்தப்படுகிறது.

துளையிட்ட அட்டை  
-Punched cards 

(Hollerith) அட்டைகள் என அழைக்கப்படும் துளையிட்ட அட்டைகள் 

காகித அட்டைகள் ஆகும். பல துளையிடப்பட்ட அல்லது சிறு துளையிட்ட 

அட்டைகளில் தரவைக் குறிக்கக் கை அல்லது இயந்திரம் 

பயன்படுத்தப்பட்டது.

இயந்திர ம�ொழி - Machine 
Language

இயந்திர ம�ொழி என்பது இருநிலை இலக்கங்கள் அல்லது பிட்டுகளின் 

த�ொகுப்பாகும். அது கணிப்பொறி படிக்க மற்றும் விளங்கிக்கொள்ளப் 

பயன்படுகிறது.  
த�ொகுப்பு ம�ொழி

assembly language
த�ொகுப்பு ம�ொழி என்பது ஒரு  தாழ்மட்ட (low-level )  நிரலாக்க 

ம�ொழியாகும்.
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ஒருங்கிணைந்த சுற்று 

Integrated Circuits 

ஐசி பல சுற்றுகள், பாதைகள், திரிதடையகங்கள் மற்றும் பிற மின்னணு 

கூறுகளை உள்ளடக்கிய ஒரு த�ொகுப்பு ஆகும், இது ஒரு குறிப்பிட்ட 

செயல்பாடு அல்லது த�ொடர்ச்சியான செயல்பாடுகளைச் செய்ய,  

ஒருங்கிணைந்து வேலை செய்கிறது.
நு ண்க  ணி ப ் ப ொ றி 

M i c r o c o m p u t e r
நுண்கணிப்பொறி ஒரு நிலையான தனிநபர் கணிப்பொறியை விவரிக்கப் 

பயன்படுகிறது. 

உயர் நிலை ம�ொழி -High-
level languages

உயர்-நிலை ம�ொழி (High-Level Language ) என்பது ஒரு கணிப்பொறி 

நிரலாக்க ம�ொழியாகும், இது கணிப்பொறியால் வரையறுக்கப்படாதது, 

எளிதில் புரிந்து க�ொள்ளக்கூடிய ஒரு குறிப்பிட்ட வேலைக்காக 

வடிவமைக்கப்பட்டது.
இயற்கை ம�ொழி 

செயலாக்கம் -

Natural language 
processing (NLP)

இயற்கை ம�ொழி செயலாக்கம் (NLP - Natural Language Processing) 

என்பது செயற்கை நுண்ணறிவியலில்   பயன்படுத்தப்படும் ஒரு 

முறையாகும். இது மனித ம�ொழியிலிருந்து ப�ொருளைப் பெறுவதற்குப் 

பயன்படுகிறது.

ர�ோபாட்டிக்ஸ்

Robotics 

1921 ஆம் ஆண்டு ஆர்யூஆர்-ரை இயங்குவதற்காக (ர�ோசம்ஸ் 

யுனிவர்சல் ர�ோப�ோஸ்) RUR (Rossum's Universal Robots) இல் கரேல் 

கபீக் (Karel Capek) என்பவரால்  “ர�ோப�ோட்“  என பெயர் சூட்டப்பட்டது.  

கைவழியாக அல்லது அதன் சுற்றுப்புறத்தில்  இருந்து பெறப்பட்ட 

உள்ளீடுகளுக்குப் பதிலளிப்பதற்காக வடிவமைக்கப்பட்ட கணிப்பொறி   

இயந்திரத்தை விவரிக்க இது பயன்படுகிறது.

நான�ோ த�ொழில்நுட்பம்

Nanotechnology

நான�ோ  என்பது ஒரு ப�ொறியியல், விஞ்ஞானம் மற்றும் த�ொழில்நுட்பம்   

சார்ந்தது ஆகும், இது இயந்திரங்களை உருவாக்க அல்லது வேலை 

செய்ய ஒரு அணு அல்லது ஒரு மூலக்கூறு அதாவது 100 நான�ோமீட்டர் 

அல்லது அதற்கும் குறைவானவற்றுடன் வேலை செய்கிறது .

உயிரிப்பொறியியல்

Bioengineering
உயிரியல் அமைப்புகள் மற்றும் உயிரியல் த�ொழில்நுட்பங்கள் வடிவமைப்பு 

மற்றும் பகுப்பாய்வு ப�ொறியியல் க�ொள்கைகள் ப�ொருந்தும் ஒரு முறையான 

த�ொகுதி ஆகும்.
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கற்றலின் ந�ோக்கங்கள்

•	 கணிப்பொறிகள் தரவுகளை எவ்வாறு 
புரிந்துக�ொண்டு நினைவகத்தில் 
சேமிக்கின்றன என்பதை அறிந்து 
க�ொள்ளுதல்.

•	 பல வகையான தரவு பிரதியீடுகளையும் மற்றும் 
இருநிலை கணக்கீடுகளையும் பற்றி கற்றல். 

•	 பல வகையான எண்முறைகளை ஒன்றிலிருந்து 
மற்றொன்றுக்கு மாற்றுதல் பற்றி கற்றல்.

2.1 அறிமுகம்

	 தரவு என்பதற்கான ஆங்கில வார்த்தையான 
Data என்ற ச�ொல் Datum என்ற ச�ொல்லிலிருந்து 
வந்தது, அதன் ப�ொருள் "செயல்படுத்தப்படாத மூல 
தகவல்" (Raw facts)  என்பதாகும். தரவு என்பது 
மக்கள், இடங்கள் அல்லது ப�ொருட்களின் பல 
தகவல்களை க�ொண்டது. 

எடுத்துக்காட்டு:

	பெ யர் (Name), வயது(Age), வகுப்பு 
(class), மதிப்பெண் (Marks) மற்றும் பாடம் 
(Subject) ப�ோன்றவை மாறிகள் என்று 
எடுத்துக்கொள்வோம். இப்போது, இந்த 
ஒவ்வொரு மாறியிலும் அதற்குரிய மதிப்புகளை 
இருத்தினால், கீழ்க்கண்டவாறு த�ோன்றும்.

Name 		  =	 Rajesh
Age		  =	 16
Class		  =	 XI
Mark		  =	 65
Subject		 =	 Computer Science

	 படம் 2.1 தரவிற்கான எடுத்துக்காட்டு	

	மேலே  கூறப்பட்ட எடுத்துக்காட்டில்,  
ஐந்து மாறிகளில் இருத்தப்பட்ட மதிப்புகள் தரவு 
எனப்படும். இந்த தரவுகள் செயற்படுத்தப்படும் 
ப�ோது, "ராஜேஷ் வயது 16,  பதின�ொன்றாம் 
வகுப்பில் பயின்று வருகின்றார். அவர் 

கணிப்பொறி அறிவியல் பாடத்தில் 65 
மதிப்பெண்களைப் பெற்றுள்ளார்" என்ற தகவல் 
கிடைக்கும். 

2.2 தரவு பிரதியீடு
	 கணிப்பொறிகள் தரவுகளை ‘0’ (சுழியம்) 
மற்றும் ‘1’ (ஒன்று) என்ற எண்களில் 
கையாளுகின்றது.  எண், எழுத்து, சிறப்புக்குறியீடு 
என தரவு எந்த வகையாக இருந்தாலும் அவை 
கணிப்பொறியால் புரிந்துக�ொள்ளக்கூடிய ‘0’ 
(சுழியம்) அல்லது ‘1’ (ஒன்று) என்ற எண் வடிவில் 
மாற்றப்பட வேண்டும். கணிப்பொறிகள் 
புரிந்துக�ொள்ளக்கூடிய 0 மற்றும் 1 ஆகியவை 
இயந்திர ம�ொழி (Machine Language) என 
அழைக்கப்படுகின்றது. 0 அல்லது 1 ஆகிய இரண்டு 
எண்கள் ஆங்கிலத்தில், Binary Digits (Bit) என்று 
அழைக்கப்படுகிறது. தமிழில் இவை “இருநிலை 
எண்கள்” அல்லது “இரும எண்கள்” (Binary) 
என்று அழைக்கப்படுகிறது.   எனவே, தரவு 
பிரதியீடுகளைப் பற்றி கற்றல்  கணிப்பொறி கற்றலில் 
முக்கியான பகுதியாகும். 	 இருநிலை 
எண்கள் அதன் அளவை அடிப்படையாக க�ொண்டு 
பல்வேறாக அழைக்கப்படுகின்றது. அவை வருமாறு:

•	  பிட் (Bit) – இருநிலை எண்களான 0 அல்லது 1 
பிட் என அழைக்கப்படும். இது கணிப்பொறி 
தரவின் அடிப்படை அலகு ஆகும். Bit என்ற 
ஆங்கில வார்த்தை Binary digit என்பதின் 
சுருக்கம். நிபில் (Nibble) என்பது 4 பிட்டுகளின் 
த�ொகுதி.

•	 பைட் (Byte) என்பது 8 பிட்டுகளின் த�ொகுதி. 
கணிப்பொறியில் நினைவகத்தை அளவிடுவதற்கு 
அடிப்படை அலகு பைட் ஆகும்.

•	 வேர்டு நீளம் (Word length) என்பது ஒரு 
கணிப்பொறியின் மைய செயலகத்தில் எத்தனை 
பிட்டுகள் செயற்படுத்தப்படும் என்பதை குறிக்கும். 
எடுத்துக்காட்டாக, வேர்டு நீளம் – 8 பிட்டுகள், 16 
பிட்டுகள், 32 பிட்டுகள் மற்றும் 64 பிட்டுகளின் 
அளவில் அமைக்கப்படும்  (இன்றைய 
கணிப்பொறிகள் 32 பிட்டுகள் அல்லது 64 பிட்டு 
வேர்டு நீளத்தில் வடிவமைக்கப்படுகிறது).

பாடம் 2கணினி அறிமுகம்

எண் முறைகள்

அலகு I 
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டெரா பைட் (1024 GB)

ஜிகா பைட் (1024 MB)

மெகா பைட் (1024 KB)

கில�ோ பைட் (1024 bytes)

பைட்(8 bits)

நிபில் (4 bits)

பிட்
(0 or 1)

படம் 2.2 தரவுகளின் குறிப்பு முறை

கணிப்பொறி நினைவகம் (முதன்மை மற்றும் 

இரண்டாம்நிலை நினைவகம்)

	 கணிப்பொறி நினைவகங்கள் (முதன்மை 

மற்றும் இரண்டாம்நிலை நினைவகம்) ப�ொதுவாக 

கில�ோபைட் (Kilobyte - KB) அல்லது மெகா 

பைட் (Megabyte -MB) என்ற அளவுகளில் 

குறிப்பிடப்படும். பதின்ம எண் முறையில் 1 கில�ோ 

என்பது 1000 என்பதாகும். அதாவது, 103. 
இருநிலை எண் முறையில் 1 கில�ோ பைட் என்பது 

1024 பைட்டுகள் அதாவது 210 ஆகும். கீழே 

க�ொடுக்கப்பட்டுள்ள அட்டவணை பல்வேறு 

நினைவக அளவுகளைக் காட்டுகிறது.
அட்டவணை 2.1 நினைவகத்தின் அளவு

பெயர் சுருக்கம் அளவு

கில�ோ K 2^10 = 1,024
மெகா M 2^20 = 1,048,576
ஜிகா G 2^30 = 1,073,741,824
டெரா T 2^40 = 1,099,511,627,776
பீட்டா P 2^50 = 1,125,899,906,842,624
எக்ஸா E 2^60 = 1,152,921,504,606,846,976
ஜீடா Z 2^70 = 1,180,591,620,717,411,303,424

ய�ோட்டா Y 2^80 = 1,208,925,819,614,629,174,706,173

	 ஒரு உரையில் உள்ள எழுத்துருக்களைக் குறிக்க பைட்டுகள் பயன்படுத்தப்படுகின்றன. 

எழுத்துருக்கள் மற்றும் எண்களைக் குறிக்க பல்வேறு குறியீட்டு முறைகள் பயன்படுத்தப்படுகின்றது. 

இதில், ”தகவல் பரிமாற்றத்திற்கான அமெரிக்க தரநிலை குறியீடு முறை” (ASCII - American Standard 
Code for Information Interchange) ப�ொதுவாக பயன்பாட்டில் உள்ள ஒரு குறிமுறையாகும். இந்த 

குறிமுறையில், 0 லிருந்து 127 வரையான இருநிலை மதிப்புகள் ஒவ்வொரு ஆங்கில எழுத்துருவையும் 

குறிக்க பயன்படுகின்றது. இடைவெளிக்கான ASCII குறியீடு 32. சுழியத்தின் (0) குறியீடு 48 ஆங்கில 

சிறிய எழுத்துக்களுக்கான குறியீட்டு மதிப்புகள் 97 முதல் 122 வரை. ஆங்கில பெரிய எழுத்துக்களின் 

மதிப்புகள் 65 முதல் 90 ஆகும்.

2.3 பல்வேறு எண் முறைகள்

எண் முறைகள்

பதின்ம
(Decimal)

இருநிலை
(Binary)

எண்ணிலை
(Octal)

பதினாறு நிலை
(Hexa Decimal)

அடிமானம் 10
(0,1,2,3,4,5,6,7,8,9)

அடிமானம் 2
(0,1)

அடிமானம் 8
(0,1,2,3,4,5,6,7)

அடிமானம் 16
(0,1,2,3,4,5,6,7,8,9,A,B,C,D,E,F)

படம் 2.3 எண் முறைகள்
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	 எண் முறைகள்-எண்களைக் குறிக்கும் 

ஒரு வழிமுறையாகும். நடைமுறையில் நாம் 

பயன்படுத்தும் மிகவும் ப�ொதுவான எண்முறை 

பதின்ம எண்முறையாகும்.  இவை தவிர 

இருநிலை, எண்ணிலை மற்றும் பதினாறு நிலை 

எண்முறைகளும் பயன்பாட்டில் உள்ளது. 

ஒவ்வொரு எண் முறையும் அதன் அடிமான 

மதிப்பை க�ொண்டு அடையாளம் காணப்படும். 

அடிமானம் என்பது ஆங்கிலத்தில் Radix 

அல்லது Base எனப்படும். அடிமானம் ஒவ்வொரு 

எண்முறையிலும் உள்ள ம�ொத்த எண் மதிப்பு 

உருக்களின் எண்ணிக்கையைக் குறிக்கும்.

உங்களுக்கு தெரியுமா?

•	 ஒரு கணிப்பொறியின் வேகம், அது 
செயல்படுத்தும் பிட்களின் 
எண்ணிக்கையைப் ப�ொருத்தது, 
எடுத்துக்காட்டாக 64 பிட் கணிப்பொறி, 
ஒரு செயற்பாட்டில் 64 பிட் எண்களை 
செயற்படுத்தும், அதே நேரத்தில் 32 பிட் 
கணிப்பொறிகள் 64 பிட் எண்களை 
இரண்டு 32 பிட்டுகளாக பிரித்து 
செயற்படுத்தும். இதனால் 64 பிட்-யை விட 
32 பிட் கணிப்பொறியின் செயல் வேகம் 
குறைவு.

2.3.1 பதின்ம நிலை எண்முறை

	 இந்த எண் முறை 0,1,2,3,4,5,6,7,8,9 
ஆகிய பத்து எண் உருக்களைக் க�ொண்டது. 
இது பழமையான, ப�ொதுவாக பயன்பாட்டில் 
உள்ள முறையாகும். இது “நிலை மதிப்பு” 
(Positional Value) முறையாகும். ஒரு பதின்ம 
எண் த�ொடரில் உள்ள ஒவ்வொரு எண்ணின் 
மதிப்பும், அதன் நிலையை அல்லது அந்த எண் 
அமைந்துள்ள இடத்தைப் ப�ொருத்து அமையும். 
அதாவது, பதின்ம எண்ணின் ஒவ்வொரு 
இலக்கத்தையும், அந்த இலக்கத்தின் நிலை 
மதிப்பை 10-ன் அடுக்குகளில் பெருக்கவேண்டும்.

எடுத்துக்காட்டு

(123)10	= 1x102  +  2x101  +  3x100  
		  = 100 + 20 + 3 
		  = (123)10

2.3.2 இருநிலை எண்முறை

	 இருநிலை எண் முறையில் 0 மற்றும் 1 
என்ற இரண்டு எண் உருக்கள் மட்டுமே உள்ளது. 

இந்த முறை,  "2ன் அடுக்கு நிலை நிறை முறை"-

(2's Power positional weightage method) யில் 

2யை அடிமானமாகக் க�ொண்டுள்ளது. ஒரு 

இருநிலை எண் த�ொடரின் இடது ஓர பிட், அதிக 

நிலை நிறை மதிப்பை க�ொண்டுள்ளதால், அது 

“மிகு மதிப்பு பிட்” (Most Significant Bit – MSB) 

எனவும், வலது ஓர பிட் குறைந்த மதிப்பைப் 

பெறுவதால், அது “குறை மதிப்பு பிட்” (Least 
Significant Bit – LSB) என அழைக்கப்படுகின்றது.  

1 1 0 1

MSB LSB

எடுத்துக்காட்டு

 (1101)2   என்ற இருநிலை எண்ணிற்கு நிகரான 

பதின்ம எண் :

(1101)2	 = 1 × 23  +  1 × 22 + 0 × 21 + 1 × 20

		  = 8 + 4 + 0 + 1
		  = (13)10

2.3.3 எண்ணிலை எண் முறை

	 எண்ணிலை எண் முறையில் 0 முதல் 7 
வரை ம�ொத்தம் எட்டு எண் உருக்கள் உள்ளது. 

இந்த எண் முறையும் “நிலை நிறை” முறையாகும். 

இதன் ஒவ்வொரு இலக்கமும், 8-ன் அடுக்களில் 

மதிப்பைப் பெறுகிறது.

எடுத்துக்காட்டு

(547)8 
என்ற எண்ம எண்ணிற்கு நிகரான பதின்ம 

எண்:

(547)8	 = 5×82 + 4×81 + 7×80

		  = (5×64) + (4×8) + (7×1)
		  = 320 + 32 + 7
		  = (359)10

2.3.4 பதினாறு நிலை எண்முறை

	 பதினாறுநிலை எண்முறையின் 

மதிப்புகள் 16-ன் அடிமானத்தில் குறிப்பிடப்படும். 

பதினாறு நிலை எண்கள், இருநிலை எண்களுக்கு 
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குறுக்கு வழி வடிவங்களாகப் 

பயன்படுத்தப்படுகின்றது. தரவுகளை மிகவும் 

கச்சிதமாக குறிப்பிட இந்த முறை பயன்படுகிறது. 

இந்த முறையில் 0 முதல் 9 வரை எண் உருக்களும், 

A, B, C, D, E, F ஆகிய எழுத்துக்களுடன் 16 
இலக்கங்களைக் க�ொண்டுள்ளது. இதில், A, B, 

C, D, E, F உருக்கள் முறையே 10, 11, 12, 13, 14 

மற்றும் 15 க்கு நிகரானவையாகும். 

அட்டவணை 2.2 இரும, எண்ம, பதினாறுநிலை 

எண்களின் சமமான பதின்ம எண்கள்

பதின்ம இருநிலை எண்ணிலை பதினாறு 

நிலை

0 0000 000 0000
1 0001 001 0001
2 0010 002 0002
3 0011 003 0003
4 0100 004 0004
5 0101 005 0005
6 0110 006 0006

7 0111 007 0007
8 1000 010 0008
9 1001 011 0009

10 1010 012 A
11 1011 013 B
12 1100 014 C
13 1101 015 D
14 1110 016 E
15 1111 017 F

எடுத்துக்காட்டு	

2516 என்ற பதினாறு நிலை எண்ணிற்கு நிகரான 

பதின்ம எண்ணாக மாற்றுதல்

(25)16	 = 2×161 + 5×160

		  = 32+5	
		  = (37)10

பயிற்சி பட்டறை

1. பின்வரும் எண்கள் எந்த எண்முறை சார்ந்தது 

என்று கண்டுபிடித்து எழுதவும்.

வ. எண். எண்கள் எண் முறை

1 (1010)10
பதின்ம எண் முறை

2 (1010)2

3 (989)16

4 (750)8

5 (926)10

2. கீழே க�ொடுக்கப்பட்டுள்ள கூற்றுகள் சரியா, 

தவறா எனக் காண்க, தவறு எனில் அதற்கான 

காரணத்தை கூறுக.

வ. 

எண்.

கூற்றுகள் சரி / 

தவறு

தவறு எனில் 

காரணம்

1. 786 

என்பது ஒரு 

எண்ணிலை 

எண்
2. 101 ஒரு 

இருநிலை 

எண்
3. எண்ணிலை 

எண்ணின் 

அடிமானம் 7

2.4 எண் முறை மாற்றங்கள்

2.4.1	 பதின்ம எண்களை இருநிலை 
எண்களாக மாற்றுதல்:

	 பதின்ம எண்களை, இருநிலை எண்களாக 

மாற்ற இரண்டு முறைகள் உள்ளன 2–ன் த�ொடர் 

வகுத்தல் முறை  பயன்படுத்தப்படுகிறது. ஒரு 

பதின்ம எண்ணை 2-ல் வகுக்கும் ப�ோது அதன் 

மீதி 0 அல்லது 1 என மட்டுமே இருக்கும். 2-ன் 

த�ொடர் வகுத்தல் முறையில் கிடைக்கும் “0” 
மற்றும் “1” ன் த�ொடர்ச்சி க�ொடுக்கப்பட்ட பதின்ம 

எண்ணிற்கு நிகரான இருநிலை எண்ணாகும். N 
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என்ற பதின்ம எண்ணை இருநிலை எண்ணாக 

மாற்ற வேண்டுமெனில், க�ொடுக்கப்பட்ட N-யை 
2-ல் வகுக்கும் ப�ோது, N ஈவு மற்றும் R என்ற மீதி 

0 அல்லது 1 ஆக கிடைக்கும். இந்த செய்முறையை 

ஈவு 0 அல்லது 1 என வரும் வரை த�ொடர்ச்சியாக 

வகுக்க வேண்டும். ஈவு 0 அல்லது 1 ஆக 

வரும்போது, அதுவே கடைசி மீதியாக 

எடுத்துக்கொள்ள வேண்டும். கடைசி மீதி 

மதிப்பிலிருந்து முதல் மீதி மதிப்பு வரை உள்ள 

எண்களை எடுத்து எழுதினால் கிடைக்கும் விடை 

க�ொடுக்கப்பட்ட பதின்ம எண்ணிற்கு நிகரான 

இருநிலை எண்ணாகும்.
எடுத்துக்காட்டு

	 (65)10 க்கு நிகரான இருநிலை எண்ணாக 

மாற்றுக 

2	 65
2	 32 -1
2	 16 - 0
2	   8 - 0

2	   4 - 0
2	   2 - 0

 1 - 0

LSB

MSB

குறிப்பு : 
65/2	 = 32 + 1
32/2  	 = 16 + 0
16/2  	 = 8 + 0
8/2  	 = 4 + 0
4/2  	 = 2 + 0
2/2  	 = 1 + 0

மீதி

(65)10 = (1 0 0 0 0 0 1)2

முறை 2: இரண்டின் அடுக்குமுறை
	 பதின்ம எண்ணை இருமநிலை எண்ணாக 

மாற்ற 2-ன் அடுக்கங்களை கூட்டிக் க�ொண்டே 

வர வேண்டும். பின்னர் அந்த எண்ணின் ம�ொத்த 

மதிப்பையை கணக்கிட தேவைப்படும் பிட்டுகளை 

ஒன்றாக சேர்க்க வேண்டும்.

அ) �65-க்கு சமமான அல்லது அதை விட சிறிய 

இரண்டின் மடங்கை கண்டறிக.

6510 > 6410

ஆ) 64 என்ற மதிப்பைக் க�ொண்ட பிட்டில் 1 என 

இடுக. மேலும் க�ொடுக்கப்பட்ட எண்ணிலிருந்து 

64-ஐ கழிக்க.

65-64=1

இ) �மீதமுள்ள மதிப்பை விட அடுத்த இரண்டின் 

மடங்காகிய 32 என்பது பெரியதாகும். எனவே, 

32 என்ற மதிப்பைக் க�ொண்ட பிட்டில் 0 என 

இடுக.

ஈ) �மீதமுள்ள மதிப்பை விட அடுத்த இரண்டின் 

மடங்காகிய 16 என்பது பெரியதாகும். எனவே 16  

என்ற மதிப்பைக் க�ொண்ட பிட்டில் 0 என இடுக.

உ) �மீதமுள்ள  மதிப்பை விட 8 என்பது பெரியதாகும். 

எனவே 8 –ல் 0 என இடுக.

ஊ) �மீதமுள்ள மதிப்பை விட 4 என்பது 

பெரியதாகும். எனவே 4-ல் 0 என இடுக.

எ) �மீதமுள்ள மதிப்பை விட 2 என்பது பெரியதாகும். 

எனவே 2-ல் 0 என இடுக.

ஏ) �மீதமுள்ள மதிப்பு 1 க்கு சமமானதாக 

உள்ளதால் 1 என இடுக.

1-1=0

மாற்றும் செயல் முடிவடைந்தது. 
6510=(1000001)2

எடுத்துக்காட்டு

	 மாற்றும் படிநிலைகள் பின்வருமாறு 

க�ொடுக்கப்பட்டுள்ளன. க�ொடுக்கப்பட்ட 

எண் : 65

சமம் அல்லது சிறிய இரண்டின் அடுக்கம் :64

65-64=1

1-1=0
இரண்டின் 

அடுக்கம் 
64 32 16 8 4 2 1

இ ரு நி லை  

எண் 
1 0 0 0 0 0 1

6510=(1000001)2

2.4.2 பதின்ம எண்ணை எண்நிலை 
எண்ணாக மாற்றுதல்

	 ஒரு பதின்ம எண்ணை எண்ணிலை 

எண்ணாக மாற்றுவதற்கு “8 ன் த�ொடர் 
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வகுத்தல்” முறை பயன்படுத்தப்படுகிறது. இந்த 

முறை 2.4.1- ல் கற்றது ப�ோல அதே  

வழிமுறையைப் பயன்படுத்த வேண்டும். ஆனால் 

இம்முறையில் க�ொடுக்கப்பட்ட பதின்ம எண்ணை 
8-ல் த�ொடர்ச்சியாக வகுக்க வேண்டும்.

எடுத்துக்காட்டு

(65)10 
என்ற எண்ணை எண்ம நிலை எண்ணாக 

மாற்றுக

8	 65
8	 8 - 1

1 - 0

LSB

MSB

(65)10   = (1 0 1)8

2.4.3 பதின்ம எண்ணை பதினாறு நிலை 

எண்ணாக மாற்றுதல்

	 ஒரு பதின்ம நிலை எண்ணை பதினாறு 

நிலை எண்ணாக மாற்ற “16-ன் த�ொடர் 

வகுத்தல்” முறை பயன்படுத்தலாம். இந்த 

முறையிலும் 2.4.1 ல் கற்றது ப�ோல் அதே 

வழிமுறையைப் பயன்படுத்த வேண்டும். ஆனால் 

இம்முறையில் க�ொடுக்கப்பட்ட பதின்ம எண்ணை 
16-ல் த�ொடர்ச்சியாக வகுக்க வேண்டும்.

எடுத்துக்காட்டு

16	    31
1 - 15

LSB

MSB

(31)10 = (1F)16

2.4.4 மிதப்புப் புள்ளி பதின்ம எண்ணை இருநிலை 

எண்ணாக  மாற்றுதல்

	 “2ன் த�ொடர் பெருக்கல் முறை” யைப் 

பயன்படுத்தி க�ொடுக்கப்பட்ட மிதப்புப் புள்ளி 

பதின்ம எண்ணை இருநிலை எண்ணாக 

மாற்றலாம்.

“2-ன் த�ொடர் பெருக்கல் முறை” யின் வழிகள் 

பின்வருமாறு:

படிநிலை 1: மிதப்புப் புள்ளி பதின்ம எண்ணை 

2ஆல் பெருக்கி வரும் விடை மதிப்பின் 

முழு எண் பகுதியைத் தனியாக 

குறித்து வைக்க வேண்டும். முழு எண் 

பகுதி 0 அல்லது 1 ஆக மட்டுமே 

இருக்கும்.

படிநிலை 2: படிநிலை 1ல் கிடைக்கப்பெற்ற விடை 
மதிப்பின் முழு எண் பகுதியை, 
க�ொடுக்கப்பட்ட மிதப்புப் புள்ளி 
எண்ணிலிருந்து கழித்து விட்டு, 
மீதமுள்ள மிதப்புப் புள்ளி மதிப்புகளை 
மீண்டும் 2ஆல் பெருக்கி, அதன் விடை 
மதிப்பின் முழு எண் பகுதியைத் 
தனியாக குறித்து வைக்கவும்.

	 படிநிலை 1 மற்றும் 2யை, இறுதி 

மதிப்பு 0 என வரும் வரைய�ோ அல்லது 

த�ொடர்ந்து சில இலக்கங்கள் 

வரைய�ோ மீண்டும், மீண்டும் 

பின்பற்றுக.

படிநிலை 3:	படிநிலை 1 மற்றும் 2ன் படி தனியே 

எழுதி வைக்கப்பட்டுள்ள அனைத்து 0 
மற்றும் 1-களை மேலிருந்து கீழாக 

எழுதவேண்டும். இதுவே, 

க�ொடுக்கப்பட்ட மிதப்புப் புள்ளி 

எண்ணுக்கு நிகரான இருநிலை எண் 

ஆகும்.

எடுத்துக்காட்டு:

முழு எண்பகுதி

0.2 × 2 = 0.4 0 (விடையாக கிடைக்கப் 

பெற்ற முதல் முழு எண்)

0.4 × 2 = 0.8 0

0.8 × 2 = 1.6 1

0.6 × 2 = 1.2 1

0.2  × 2 = 0.4 0 (விடையாக கிடைக்கப் 
பெற்ற கடைசி முழு எண்)

குறிப்பு: மிதப்புப் புள்ளி மீண்டும் அதே பெருக்கு 

மதிப்பு முதல் படிநிலை ப�ோலவே கிடைக்கும்.

படிநிலை 4: �விடையாக கிடைக்கப்பெற்ற 

அனைத்து முழு எண்களையும், 

மேலிருந்து கீழாக எடுத்து எழுதுக. 
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அதுவே, க�ொடுக்கப்பட்ட மிதப்புப் 

புள்ளி எண்ணிற்கு நிகரான 

இருநிலை எண் ஆகும். (0.2)10 = 
(0.00110)2

பயிற்சி பட்டறை

பின்வரும் பதின்ம எண்களை இருநிலை, 

எண்ணிலை மற்றும் பதினாறு நிலை எண்களாக 

மாற்றுக.

1) 1920		 2) 255		  3)126

2.4.5 இருநிலை எண்களை, பதின்ம எண்களாக 

மாற்றுதல்:

	 இருநிலை எண்களை, பதின்ம 
எண்களாக மாற்றுவதற்கு, 2's அடுக்கு நிலை 
நிறை முறையைப் (2s Power Positional notation 
method) பயன்படுத்தலாம்.

படிநிலை 1:	க�ொடுக்கப்படும் இருநிலை எண்களை 
எழுதி, வலமிருந்து இடமாக 
ஒவ்வொரு இருநிலை மதிப்புக்கும் 
நிகரான 2ன் அடுக்கு நிலை மதிப்பை 
எழுதுக.

படிநிலை 2:	ஒவ்வொரு 2ன் அடுக்கு நிலை 
மதிப்பிற்கும், அதன் நிறை மதிப்பை 
எழுதுக.

படிநிலை 3:	ஒவ்வொரு இருநிலை 
இலக்கத்தையும், அதற்கு நிகரான 
நிறை மதிப்புடன் பெருக்கி எழுதுக.

படிநிலை 4:	விடை மதிப்புகள் அனைத்தையும் 
கூட்டி வரும் இறுதி மதிப்பு, 
க�ொடுக்கப்பட்ட இருநிலை எண்ணிற்கு 
நிகரான பதின்ம எண் ஆகும்.

அட்டவணை 2.3 - 2ன் அடுக்கு நிலை நிறை 

மதிப்பு

2ன் 

அடுக்கு 

நிலை

நிறை 

மதிப்பு
2ன் 

அடுக்கு 

நிலை

நிறை 

மதிப்பு

20 1 26 64
21 2 27 128
22 4 28 256
23 8 29 512
24 16 210 1024
25 32

எடுத்துக்காட்டு:

(111011)2 க்கு நிகரான பதின்ம எண்ணாக 

மாற்றுக.

நிறை மதிப்பு 32 16 8 4 2 1

2ன் அடுக்கு 

நிலை மதிப்பு
25 24 23 22 21 20

க�ொடுக்கப்பட்ட 

இருநிலை எண்
1 1 1 0 1 1

32+16+8+0+2+1= (59)10

(111011)2= (59)10

2.4.6 	 இருநிலை எண்களை எண்ணிலை 
எண்களாக மாற்றுதல்:

படிநிலை 1: 	க�ொடுக்கப்பட்ட இருநிலை 
எண்களை வலமிருந்து இடமாக 
மூன்று பிட்டுகளாக குழுவாக்கவும்.

படிநிலை 2: இடது ஓரம் மூன்று பிட்டுகளாக   
அமையவில்லை எனில், 
முன்னொட்டாக 0-வை நிரப்பி, மூன்று 
பிட் குழுவாக அமைக்கவேண்டும்.

படிநிலை 3:	"2ன் அடுக்கு நிலை நிறை முறை”-
யைப் பயன்படுத்தி,  ஒவ்வொரு 
குழுவிலும் உள்ள இருநிலை 
மதிப்புக்களுக்கு நிகரான பதின்ம 

எண்களைக் கணக்கிட வேண்டும்.

எண்ணிலை எண்
நிகரான 

இருநிலை எண்

0 000
1 001
2 010
3 011
4 100
5 101
6 110
7 111

எடுத்துக்காட்டு:

(11010110)2 க்கு நிகரான எண்ணிலை 
எண்ணாக மாற்றுக. 

படிநிலை 1:	க�ொ டுக்கப்பட்ட இருநிலை 
எண்களை வலமிருந்து இடமாக 

மூன்று பிட்டுகளாக குழுவாக்குக.

011 010 110
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குறிப்பு:

இடது ஓர குழு மூன்று பிட்டுகளாக 

அமையவில்லை. எனவே, அதனை மூன்று 

பிட்டாக மாற்ற 0 முன்னொட்டாக 

சேர்க்கப்பட்டுள்ளது.

படிநிலை 2:	"2ன் அடுக்கு நிலை நிறை முறை”-

யைப் பயன்படுத்தி,  ஒவ்வொரு 

குழுவிலும் உள்ள இருநிலை 

மதிப்புக்களுக்கு நிகரான பதின்ம 

எண்களை கணக்கிட வேண்டும். 

011	        010    	  110

(11010110)2   = (326)8

  3	          2    	    6

{ { {

2.4.7 இருநிலை எண்களைப் பதினாறு நிலை 
எண்களாக மாற்றுதல்:

படிநிலை 1: 	க�ொடுக்கப்பட்ட இருநிலை 

எண்களை வலமிருந்து இடமாக 

நான்கு நான்கு பிட்டுகளாக 

குழுவாக்கவும்.இடது ஓரம் நான்கு 

பிட்டுகளாக அமையவில்லை எனில், 

முன்னொட்டாக 0-வை நிரப்பி, 

நான்கு பிட் குழுவாக 

அமைக்கவேண்டும்.

படிநிலை 2:	"2ன் அடுக்கு நிலை நிறை முறை”-

யைப் பயன்படுத்தி,  ஒவ்வொரு 

குழுவிலும் உள்ள இருநிலை 

மதிப்புக்களுக்கு நிகரான பதின்ம 

எண்களைக் கணக்கிட வேண்டும். 

படிநிலை 3: ஒவ்வொரு பதின்ம எண்ணுக்கும் 

நிகரான பதினாறு நிலை எண்களாக 

எழுதவேண்டும். 

எடுத்துக்காட்டு:

(1111010110)2 க்கு நிகரான பதினாறு நிலை 

எண்ணாக மாற்றுக.

படிநிலை 1:	க�ொடுக்கப்பட்ட இருநிலை 

எண்களை வலமிருந்து இடமாக 

நான்கு பிட்டுகளாக குழுவாக்குக.

0011	     1101     0110

குறிப்பு: இடது ஓரக் குழு நான்கு பிட்டுகளாக 

அமையவில்லை. எனவே, அதனை நான்கு 

பிட்டாக மாற்ற 0-வை முன்னொட்டாக 

சேர்க்கப்பட்டுள்ளது.

படிநிலை 2:	"2ன் அடுக்கு நிலை நிறை முறை”-

யைப் பயன்படுத்தி,  ஒவ்வொரு 

குழுவிலும் உள்ள இருநிலை 

மதிப்புக்களுக்கு நிகரான பதின்ம 

எண்களைக் கணக்கிட வேண்டும். 

0011	        1101    	  0110

(1111010110)2   = (3D6)16

  3	          D    	    6

{ { {

2.4.8 மிதப்புப் புள்ளி இருநிலை எண்களை 
பதின்ம எண்களாக மாற்றுதல்:

	 கீழ்காணும் படிநிலைகளைப் பயன்படுத்தி, 

ஒரு மிதப்புப் புள்ளி இருநிலை எண்களைப் 

பதின்ம எண்களாக மாற்றலாம்.

படிநிலை 1: 	க�ொடுக்கப்பட்ட மிதப்புப் புள்ளி 

இருநிலை எண்ணின் முழு எண் 

பகுதியைப் பத்தி 2.4.5ல் 

குறிப்பிடப்பட்டுள்ளவாறு, 2ன் 

அடுக்கு நிலை நிறை முறையைப் 

பயன்படுத்தி, பதின்ம எண்ணாக 

மாற்றுக.

படிநிலை 2:	மிதப்புப் புள்ளி இருநிலை 

எண்ணிற்கு நிகரான பதின்ம 

எண்ணைக் கணக்கிட கீழ்காணும் 

வழிமுறைகள் பின்பற்றப்பட 

வேண்டும்.

	 படிநிலை 2.1:	 மிதப்புப் புள்ளி 

இருநிலை எண்களை எடுத்து 

எழுதுக.

	 படிநிலை 2.2:	 ஒ வ ் வொ  ரு 

இருநிலை எண்ணிற்கும் நிகரான 

எதிர்மறை 2ன் அடுக்கு நிலை 

மற்றும் நிறைகளை இடமிருந்து 

வலமாக எழுதவும்.
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	 படிநிலை 2.3:	 ஒ வ ் வொ  ரு 

இருநிலை எண் மதிப்புடனும், 2ன் 

அடுக்கு நிலை நிறையைப் 

பெருக்குக.

	 படிநிலை 2.4:	 மு ந்தை   ய 

படிநிலையில் கிடைக்கப்பெற்ற 

பெருக்கல் மதிப்புகளைக் கூட்டுக.

2ன் எதிர்மறை அடுக்கு

நிலை மதிப்பு

நிறை மதிப்பு

2-1  (1/2) 0.5
2-2   (1/4) 0.25
2-3   (1/8) 0.125
2-4  (1/16) 0.0625
2-5   (1/32) 0.03125
2-6  (1/64) 0.015625
2-7   (1/128) 0.0078125

2.5 அட்டவணை

படிநிலை 3: இறுதியாக, முழு எண் பகுதியையும், 

மிதப்புப் புள்ளி எண் பகுதிகளை ஒரு 

தசமப்புள்ளியுடன் சேர்த்து எழுத 

வேண்டும்.

எடுத்துக்காட்டு:

	 க�ொடுக்கப்பட்டுள்ள (11.011)2 இருநிலை 

எண்ணிற்கு நிகரான பதின்ம எண்ணாக 

மாற்றுக.

க�ொடுக்கப்பட்ட இருநிலை எண்ணின் 

	 முழு எண் பகுதி: 11

	 மிதப்புப் புள்ளி பகுதி: .011
க�ொடுக்கப் 

பட்ட 

இருநிலை 

எண்கள்

1 1 . 0 1 1

2ன் அடுக்கு 

நிலை 

மதிப்புகள்

21 20 2-1 2-2 2-3

நிறை 

மதிப்புகள்
2 1 1/2 1/4 1/8

0.5 0.25 0.125
பெருக்கல் 

மதிப்பு
2 1 . 0 0.25 0.125

(11.011)2  = (2+1). (0.25 + 0.125)
(11.011)2	 = (3.375)10

பயிற்சி பட்டறை

4. கீழே க�ொடுக்கப்பட்டுள்ள இருநிலை எண்களை 

அதற்கு நிகரான பதின்ம எண்ணிலை மற்றும் 

பதினாறுநிலை எண்களாக மாற்றுக.

1) 101110101
2) 1011010
3) 101011111

2.4.9	 எண்ணிலை எண்களைப் பதின்ம 
எண்களாக மாற்றுதல்:

	 8-ன் அடுக்கு நிலை நிறை முறையைப் 

பயன்படுத்தி, ஒரு எண்ணிலை எண்ணை 

அதற்கு நிகரான பதின்ம எண்ணாக மாற்றலாம்.

படிநிலை 1: 	க�ொடுக்கப்பட்டுள்ள எண்ணிலை 

எண்களை எடுத்து எழுதி, ஒவ்வொரு 

எண்ணின் நிலை மதிப்புக்கும் 

நிகரான 8-ன் அடுக்கு நிறைகளை 

வலமிருந்து இடமாக எழுத வேண்டும்.

படிநிலை 2: 	ஒவ்வொரு எண்ணிலை 

எண்ணையும், அதன் 8-ன் அடுக்கு 

நிலை நிறை மதிப்புடன் பெருக்க 

வேண்டும்.

படிநிலை 3: அனைத்து பெருக்கல் மதிப்புகளையும் 

கூட்டுக.

எடுத்துக்காட்டு:

(1265)8 
க்கு நிகரான பதின்ம எண்ணாக 

மாற்றுக.

நிறை மதிப்பு 512 64 8 1

8ன் அடுக்கு 

நிலை மதிப்பு

83 82 81 80

க�ொடுக்கப்பட்ட 

எண்ணிலை 

மதிப்புகள்

1 2 6 5
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(1265)8	 = 512 ×1 + 64×2 + 8×6 +1×5
	 = 512 + 128 + 48 + 5
(1265)8 	 = (693)10

2.4.10	எண்ணிலை எண்களை இருநிலை 
எண்களாக மாற்றுதல்:

	 ஒவ்வொரு எண்ணிலை எண்ணிற்கும் 

நிகரான 3 இலக்கு இருநிலை எண்களைக் 

கணக்கிட்டு எழுத வேண்டும்.

எடுத்துக்காட்டு:

(6213)8 க்கு நிகரான இருநிலை எண்ணாக மாற்றுக.

6 2 1 3

110 010 001 011

(6213)8=(110010001011)2

பயிற்சி பட்டறை

5. கீழ்காணும் எண்ணிலை எண்களை 

இருநிலை எண்களாக மாற்றுக:

(அ) 472	 (ஆ) 145 	 (இ) 347		
(ஈ) 6247	 (உ) 645

2.4.11	 பதினாறுநிலை எண்களைப் பதின்ம 

எண்களாக மாற்றுதல்:

	 16-ன் அடுக்கு நிலை நிறை முறையை 

பயன்படுத்தி, ஒரு பதினாறுநிலை எண்ணுக்கு 

நிகரான பதின்ம எண்ணைக் கணக்கிடலாம்.

படிநிலை 1: 	க�ொடுக்கப்பட்டுள்ள பதினாறுநிலை 

எண்களை எடுத்து எழுதி, ஒவ்வொரு                   

எண்ணின் நிலை மதிப்புக்கும் 

நிகரான 16-ன் அடுக்கு நிறைகளை 

வலமிருந்து, இடமாக எழுத 

வேண்டும்.

படிநிலை 2: 	ஒவ்வொரு பதினாறு எண்ணையும், 

அதன் 16-ன் அடுக்கு நிலை நிறை 

மதிப்புடன் பெருக்க வேண்டும்.

படிநிலை 3:  அனைத்து பெருக்கல் மதிப்புகளையும் 

கூட்டுக.

எடுத்துக்காட்டு:

(25F)16 
க்கு நிகரான பதின்ம எண்ணாக மாற்றுக.

நிறை மதிப்பு 256 16 1

16 ன் அடுக்கு நிலை 

மதிப்பு

162 161 160

க�ொடுக்கப்பட்ட 

பதினாறு நிலை 

மதிப்புகள்

2 5 F

(25F)16 = 512 + 80 +15
(25F)16 = (607)10

2.4.12	 பதினாறுநிலை எண்களை இருநிலை 

எண்களாக மாற்றுதல்:

	க�ொ டுக்கப்படும் பதினாறுநிலை எண்கள் 

ஒவ்வொன்றுக்கும் நிகரான நான்கு இலக்க 

இருநிலை எண்களைக் கணக்கிட வேண்டும். 

எடுத்துக்காட்டு:

(8BC)16 க்கு நிகரான இருநிலை எண்ணாக 

மாற்றுக.

8 B(11) C(12)

1000 1011 1100

(8BC)16 = (100010111100)2

6. கீழ்க்காணும் பதினாறுநிலை எண்களை 

இருநிலை எண்களாக மாற்றுக:

(அ) A6			   (ஆ) BE	 

(இ) 9BC8	 	 (ஈ) BC9

பயிற்சி பட்டறை

2.5 குறியுரு எண்களின் இருநிலை பிரதியீடு:

	 கணிப்பொறிகள் நேர்மறை (குறியுறா) 

மற்றும் எதிர்மறை (குறியுரு) எண்களைக் 

கையாளும் திறன் பெற்றவை. எதிர்மறை 

இருநிலை எண்களை எளிதாக குறிக்க 
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பயன்படும் முறை  “குறியுரு அளவு” (Signed 
Magnitude) முறை என்று அழைக்கப்படுகிறது. 

“குறியுரு அளவு” முறையில், இடது ஓர பிட்டான 

(Left most bit), மிகு மதிப்பு பிட் (MSB) “குறி 

பிட்” (Sign Bit) அல்லது “சமநிலை பிட்” (Parity 
Bit) என அழைக்கப்படுகிறது. 

	 கணிப்பொறியில் எண்கள் பல்வேறு 

வழிகளில் பிரதியிடப்படுகின்றன. அவை,

•	 	குறியுரு அளவு பிரதியிடுதல் (Signed 
Magnitude Representation)

•	 	1-ன் நிரப்பி (1's compliment)
•	 	2-ன் நிரப்பி (2's compliment)
2.5.1	 குறியுரு அளவு பிரதியிடுதல் (Signed 

Magnitude Representation)
	 ஒரு முழு எண்ணின் மதிப்பு அதன் 
முன்னொட்டான குறியை அடிப்படையாக 

க�ொண்டே  தீர்மானிக்கப்படுகிறது. ‘+’ குறியுடன�ோ 
அல்லது எந்த ஒரு குறியும் இல்லாமல�ோ இருக்கும் 
எண்கள் நேர்மறை எண்களாக கருதப்படுகிறது. 

‘-’ குறியை முன்னொட்டாக க�ொண்ட எண்கள் 
எதிர்மறை எண்களாக கருதப்படுகிறது. 

எடுத்துக்காட்டு:

+43 அல்லது 43 ஒரு நேர்மறை எண்

-43 என்பது ஒரு எதிர்மறை எண்

குறியுரு இருநிலை பிரதியீட்டில், இடது ஓர பிட் அதன் 

குறி பிட்டாக கருதப்படுகிறது. இடது ஓர பிட் 0 எனில், 

அது நேர்மறை எண், 1 எனில் அது எதிர்மறை எண் 

எனக் கருதப்படும். எனவே, ஒரு 8 பிட் குறியுரு 

இருநிலை எண்ணில் அதில் 7பிட்கள் மதிப்புகளைச் 

சேமிக்கும் தரவு பிட்டுகளாகவும்  (Magnitude) மற்றும் 

இடது ஓர 1பிட் அதன் குறியாகவும் பயன்படுகிறது.

+43 என்பது நினைவகத்தில் கீழ்க்கண்டவாறு 

பிரதியிடப்படுகிறது.

0 0 1 0 1 0 1 1

குறி பிட் அளவு மதிப்பு

மிகு மதிப்பு பிட் (MSB )
(‘0’ என்பது இந்த எண் ஒரு 
நேர்மறை எண் என்பதை குறிக்கிறது)

குறை மதிப்பு பிட் (LSB)

-43 என்பது நினைவகத்தில் கீழ்க்கண்டவாறு 

பிரதியிடப்படுகிறது.

1 1 0 1 0 1 0 1

குறி பிட் அளவு மதிப்பு

மிகு மதிப்பு பிட் (MSB )
(‘1’ என்பது இந்த எண் ஒரு 
எதிர்மறை எண் என்பதை குறிக்கிறது)

குறை மதிப்பு பிட் (LSB)

2.5.2  –  1ன் நிரப்பி  (1's compliment)

	 குறியுரு எண்களைக் குறிப்பிடுவதற்கு 

இந்த முறை மிகவும் எளிதான ஒன்றாகும். இந்த 

முறை எதிர்மறை எண்களுக்கு அதாவது மிகு 

மதிப்பு பிட் 1 என த�ொடங்கும் மதிப்புகளுக்கு 

மட்டுமே ப�ொருந்தும். 

ஒரு எண்ணின் 1ன் நிரப்பைக் காண கீழ்க்காணும் 

வழிமுறைகள் பின்பற்றப்பட வேண்டும்.

படிநிலை 1:	க�ொடுக்கப்பட்ட பதின்ம எண்ணுக்கு 

நிகரான இருநிலை எண்ணாக 

மாற்றுக.

படிநிலை 2:	மாற்றப்பட்ட இருநிலை எண் 8 
பிட்டுகளாக உள்ளதா என்பதைச் 

சரிபார்க்கவும். 8 பிட்டுக்கும் குறைவாக 

இருப்பின், முன்னொட்டாக 

0-க்களைச் சேர்த்து 8 பிட்டுகளாக 

மாற்றவும்.

படிநிலை 3:	அனைத்து பிட்டுகளையும், 

தலைகீழாக மாற்றவும். (அதாவது 1 
என்பதை 0 எனவும், 0 என்பதை 1 
எனவும் மாற்றுக.)

எடுத்துக்காட்டு:

(-24)10 கான 1-ன் நிரப்பு காண்க.

க�ொடுக்கப்பட்ட 

பதின்ம எண்

இருநிலை 

எண்

1-ன் நிரப்பு

(-24)10 00011000 11100111

2.5.3  2-ன் நிரப்பி (2's compliment)

	 எதிர்மறை எண்களுக்கான 2ன் நிரப்பி 

வழிமுறைகள் வருமாறு:
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(அ) இருநிலை எண்களின் அனைத்து 

பிட்டுகளையும் தலைகீழாக்குக. (அதாவது, 

1களை 0ஆகவும், 0-வை  1ஆகவும் மாற்றுக 

இதுவே 1ன் நிரப்பி)

(ஆ) பின்னர், குறை மதிப்பு பிட்டுடன் 1-யைக் 

கூட்டவும்.

எடுத்துக்காட்டு:

(-24)10ன் 2-ன் நிரப்பியைக் காண்க.

+24க்கு நிகரான இருநிலை 

எண்கள்

11000

8பிட் வடிவில் 00011000
1-ன் நிரப்பி 11100111
குறை மதிப்பு பிட்டுடன் 1யை 

கூட்டுதல்

+1

-24க்கான 2ன் நிரப்பி 11101000

7. க�ொடுக்கப்பட்டுள்ள பதின்ம எண்களை 1ன் 

நிரப்பி மற்றும் 2ன் நிரப்பிகளில் எழுதுக.

(அ) 22	    (ஆ) -13	 (இ) -65	       (ஈ) -46

பயிற்சி பட்டறை

2.6 இருநிலை எண்களின் கணக்கீடுகள் 
(Binary Arithmetic)

	 பதின்ம எண்களைப் ப�ோலவே, இருநிலை 

எண்களிலும் அடிப்படை கணக்கீடுகளான, 

கூட்டல், கழித்தல், பெருக்கல் மற்றும் வகுத்தல் 

ஆகியவைகளைச் செய்ய முடியும். இப்பகுதியில், 

இருநிலை எண்களின் கூட்டல் மற்றும் கழித்தல் 

செயல்முறைகளைப் பற்றி மட்டும் கற்கலாம்.

2.6.1 இருநிலை கூட்டல் (Binary Addition)

	 இருநிலை எண்களை விரைவாக 

கூட்டுவதற்கு பின்வரும் கூட்டல் அட்டவணை 

பயனுள்ளதாக இருக்கும்.

A B கூட்டுத் 

த�ொகை

(A + B)

மேலே எடுத்து 

செல்லப்படும் பிட் 

(Carry Bit)

0 0 0 -
0 1 1 -
1 0 1 -
1 1 0 1

	 1 + 1 = 10 என்பதில், 0-வை மட்டும் 
வைத்துக்கொண்டு, 1-னை அடுத்த சுற்றுக்கு 
எடுத்து செல்ல வேண்டும். எனவே இது “எடுத்து 
செல்லப்படும் பிட்” (Carry Bit) எனப்படும்

எடுத்துக்காட்டு: கூட்டுக: 10112 + 10012

(Carry Bit)→	 	 1	 1

	 1	 0	 1	 1

+	 1	 0	 0	 1

1	 0	 1	 0	 0

} 1 0

எடுத்து செல்லப்படும் பிட்

	 10112 + 10012 = 101002

எடுத்துக்காட்டு: இருநிலை எண் வடிவில் கூட்டுக: 

2310 + 1210

படிநிலை 1:  23 மற்றும் 12யை இருநிலை எண் 

வடிவில் மாற்றுதல்

2310   

(1) 23 – 16 = 7         (2) 7 – 4 = 3
(3) 3 – 2 = 1              (4) 1 – 1 = 0

2ன் அடுக்கு 

மதிப்புகள்

16 8 4 2 1

இருநிலை எண்கள் 1 0 1 1 1
2310 = 000101112

1210   

(1) 12 – 8 = 4		                  (2) 4 – 4 = 0	

2ன் அடுக்கு 

மதிப்புகள்
8 4 2 1

இருநிலை எண்கள் 1 1 0 0
1210 = 000011002

படிநிலை 2: 
23 மற்றும் 12-யை இருநிலை எண் வடிவில் 
கூட்டுதல்:

Carry Bit 1 1

2310 = 0   0 0 1 0 1 1 1

1210  = 0   0 0 0 1 1 0 0

3510 = 0   0 1 0 0 0 1 1

இருநிலை கழித்தல் (Binary Subtraction)
	 இருநிலை எண் கழித்தல் விதிகளின் 

அட்டவணை:
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A B கழித்தல் 

மதிப்பு

(Difference)

கடன் வாங்கும் 

மதிப்பு

(Borrow)
0  0 0 0
1  0 1 0
1  1 0 0
0  1 1 1

	 0 லிருந்து 1-னைக் கழிக்கும் ப�ோது, அதன் 
முந்தைய “மிகு மதிப்பு பிட்” (MSB)-லிருந்து 1யை 
கடனாக பெறவேண்டும். அவ்வாறு 1-னை கடனாக 
பெறும் ப�ோது,  அதன் மதிப்பு (முந்தைய மிகு மதிப்பு 
பிட்) 1 எனில், அதனை 0-ஆக மாற்ற வேண்டும்.  
அல்லது அதன் முந்தைய மிகு மதிப்பு பிட் 0 எனில், 
அதற்கும் முந்தைய எந்த மிகு மதிப்பு பிட்டு 1-னை 
பெற்றுள்ளத�ோ அதனை கடனாக பெற்று, 
அதனையும் 0-ஆக மாற்ற வேண்டும். மேலும், 
அங்கிருந்து அதன் இடதுபக்கமாக மீதமுள்ள 
அனைத்து 0 பிட்டுகளும் 1ஆக மாற்ற வேண்டும்.

எடுத்துக்காட்டு: கழித்து எழுதவும் 10010102 - 
101002

0 1 10 0 10

1 0 0 1 0 1 0

(-) 1 0 1 0 0

1 1 0 1 1 0

 எடுத்துக்காட்டு: இருநிலை எண் வடிவில் கூட்டுக: 

(-21)10 + (5)10

படிநிலை 1: -21 மற்றும் 5 ஆகியவற்றை இருநிலை 

வடிவில் மாற்றுக.

2110 

2-ன் அடுக்கு 

நிலை நிறை
16 8 4 2 1

இருநிலை எண்கள் 1 0 1 0 1
2110 = 000101012

510 

2-ன் அடுக்கு 

நிலை நிறை
4 2 1

இருநிலை எண்கள் 1 0 1

510 = 000001012

படிநிலை 2:

 2110 0 0 0 1 0 1 0 1
1-ன் நிரப்பி 1 1 1 0 1 0 1 0
2-ன் நிரப்பி 1 1 1 0 1 0 1 1

படிநிலை 3:
-21 மற்றும் 5க்கான இருநிலை கூட்டல்:

எடுத்து 

செல்லப்படும் பிட்
1 1 1 1

-2110 1 1 1 0 1 0 1 1

   510 0 0 0 0 0 1 0 1

-1610 
 (விடை) 1 1 1 1 0 0 0 0

8. பின்வரும் குறியுரு இருநிலை எண்களின் 

கணக்கியல் செயல்பாடுகளை செய்க:

(அ) 1010 + 1510	 	 (ஆ) -1210 + 510 	
(இ) 1410 – 1210		

(ஈ) (-210) – (-610)

பயிற்சி பட்டறை

2.7 நினைவகத்தில் எழுத்துருக்களின் 
பிரதியீடுகள் (Representing Characters in 

Memory)

	 அறிமுகத்தில் குறிப்பிட்டது ப�ோல, ஒரு 
கணிப்பொறிக்கு தரப்படும் தரவுகள் அனைத்தும், 
கணிப்பொறி புரிந்துக�ொள்ளும் எண் வடிவில் 
(Numerical form) இருக்க வேண்டும். 

	ப�ொ துவாக கணிப்பொறியில், 26 ஆங்கில 
பெரிய எழுத்துக்கள் (Uppercase), 26 சிறிய 
எழுத்துக்கள் (Lowercase), 10 எண் குறிகள் (0 
முதல் 9 வரை), 7 நிறுத்தற்குறிகள் மேலும் 20 
முதல் 40 இதர குறியீடுகள் பயன்படுத்தப்படுகிறது. 
இவை அனைத்தையும் “குறியுரு த�ொகுதி” 
(Character Set) எனலாம். அனைத்து குறியுரு 
த�ொகுதிகளும்,  கணிப்பொறியில் எண்களாக 
மட்டுமே குறிப்பிடப்பட வேண்டும். 

குறியுரு த�ொகுதியில் உள்ள அனைத்து 
குறிகளுக்கும் ஒரு ப�ொதுவான குறியீட்டு முறை 
(Encoding System) தேவைப்படுகிறது. எனவே 
பல்வேறு குறியீட்டு முறைகள் உருவாக்கப்பட்டது. 
அவை,

•	 BCD – Binary Coded Decimal
•	 EBCDIC – Extended Binary Coded 

Decimal Interchange Code
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•	 ASCII – American Standard Code for 
Information Interchange

•	 Unicode 
•	 ISCII - Indian Standard Code for 

Information Interchange
2.7.1 Binary Coded Decimal (BCD)
	 இந்த குறியீட்டு முறை தற்போது 
வழக்கில் இல்லை. இந்த முறை 26 பிட் குறியீட்டு 
முறையாகும். அதாவது, 26 = 64  எழுத்துருக்கள் 
மட்டுமே இந்த முறையில் கையாள முடியும்.

2.7.2 தகவல் பரிமாற்றத்திற்கான அமெரிக்க 
தரநிலை குறியீடு முறை. American Standard 
Code for Information Interchange (ASCII)
	 மிகவும் பிரபலமான இது, அமெரிக்க 
ஐக்கிய நாட்டின் (USA) அங்கீகாரம் பெற்ற ஒரு 
குறியீட்டு முறையாகும். பெரும்பாலான 
கணிப்பொறிகளில் இந்த முறை 
பயன்படுத்தப்படுகிறது. இந்த குறியீட்டு முறை 
ஆங்கில ம�ொழி எழுத்துருக்களை மட்டுமே 
கையாளும் திறன் க�ொண்டவை என்பதை 
நினைவில் க�ொள்க. இது 27 பிட் அளவுக்கு 
எழுத்துருக்களைக் கையாளும் திறன் பெற்றது. 
அதாவது, 27 = 128 எழுத்துருக்களை இந்த 
முறையில் குறியீடு செய்ய முடியும். இந்த முறையில் 
ஒவ்வொரு எழுத்துருவுக்கும் ஒரு குறிப்பிட்ட எண் 
வழங்கப்பட்டுள்ளது (பிற்சேர்க்கை காண்க).

	 ASCII-8 என்ற புதிய பதிப்பு, 28 பிட் 
முறையில் 256 எழுத்துருக்களைக் கையாளும் 
திறன் பெற்றது. இந்த முறையில் 
எழுத்துருக்களுக்கு 0 முதல் 255 வரை குறியீட்டு 
எண்கள் வழங்கப்பட்டுள்ளது. 

ஆங்கில பெரிய எழுத்துரு Aக்கு நிகரான ASCII 
குறியீட்டு எண் 65. இதற்கு நிகரான 7பிட் 
ASCIIயின் இருநிலை மதிப்பு 1000001 ஆகும். 
ASCII-8ன் இருநிலை மதிப்பு 01000001.
2.7.3 Extended Binary Coded Decimal 
Interchange Code (EBCDIC)
	 ASCII குறியீட்டு முறையைப் ப�ோன்றே 
இதுவும் 8 பிட் குறியீட்டு முறையாகும். இந்த 
குறியீட்டு முறை IBM (International Business 
Machine) நிறுவனத்தால் உருவாக்கப்பட்டது. அந்த 
நிறுவனத்தின் கணிப்பொறிகளில் தகவல் 
பரிமாற்றத்திற்கு இந்த முறை பயன்படுத்தப்படுகிறது. 
இந்த முறையில் 256 எழுத்துருக்களைக் கையாள 
முடியும். ASCII முறையில் குறியீடு செய்யப்பட்ட 
தரவுகளை, இந்த முறையில் இயங்கும் 

கணிப்பொறிகளில் பயன்படுத்த வேண்டுமெனில், 
தரவுகளின் குறியீட்டை ASCII முறையிலிருந்து 
EBCDIC முறைக்கு மாற்ற வேண்டும். அதே ப�ோல, 
EBCDIC முறையில் குறியிடப்பட்ட தரவுகளை, 
ASCIIயில் இயங்கும் கணிப்பொறிக்கு மாற்ற 
குறியீட்டு முறையை மாற்ற வேண்டும்.

2.7.4 தகவல் பரிமாற்றத்திற்கான இந்திய 
தரநிலை குறியீடு முறை Indian Standard Code 
for Information Interchange (ISCII)
	 இந்திய ம�ொழிகளின் பல்வேறு 
எழுத்துருக்களை மட்டும் கையாளும் ந�ோக்கில் 
வடிவமைக்கப்பட்ட ஓர் முறை ISCII ஆகும். இதுவும் 
8 பிட் குறியீட்டு முறையாகும். எனவே, இந்த 
முறையில் 256 எழுத்துருக்களைக் கையாள முடியும். 
இந்திய அரசின் மின்னணு துறையின் (Department 
of Electronics) 1986-88 ஆண்டுவாக்கில் இந்த 
முறை உருவாக்கப்பட்டு, இந்திய தரநிர்ணயக் 
குழுமத்தால், (Bureau of Indian Standards – BIS) 
ஏற்றுக்கொள்ளப்பட்டுள்ளது. தற்போது இந்த 
குறியீட்டு முறை யுனிக�ோட் குறியீட்டு முறையில் 
இணைந்துவிட்டது.
2.7.5 யுனிக�ோட் (Unicode)

	 அனைத்து நவீன கணிப்பொறிகள் மற்றும் 
த�ொலை த�ொடர்பு சாதனங்களில் பரவலாக 
பயன்படுத்தப்படும் ஓர் முக்கிய குறியீட்டு முறை 
யுனிக�ோட் ஆகும். ASCII குறியீட்டு முறைக்கு 
பிறகு மிகப்பிரபலமான ஓர் முறை தான் யுனிக�ோட் 
குறியீட்டு முறையாகும். 

ASCII குறியீட்டு முறை 8பிட் அளவில், 256 
எழுத்துருக்களுக்கு மட்டுமே குறியிட முடியும். 
எனவே ASCII முறையில் ஆங்கிலம் மற்றும் 
ஐர�ோப்பிய ம�ொழிகளை மட்டுமே கையாள முடிந்தது. 
உலகில் உள்ள மற்ற ம�ொழிகளைக் கையாளும் 
திறன் ASCII குறியீட்டு முறைக்கு இருக்கவில்லை. 
குறிப்பாக, நமது இந்திய ம�ொழிகளான தமிழ், 
மலையாளம், தெலுங்கு, கன்னடம் ப�ோன்றவற்றை 
ASCII யில் கையாள முடியாத நிலை இருந்தது.

எனவே, உலகின் அனைத்து ம�ொழிகளுக்கும் ஒரே 
குறியீட்டு முறையை ஏற்படுத்தும் ந�ோக்கில் 
உருவாக்கப்பட்டது “யுனிக�ோட்” குறியீட்டு முறை 
ஆகும். இது 16பிட் முறையில் 65536 
எழுத்துருக்களைக் கையாளும் திறன் பெற்றது. 
யுனிக�ோட் குறியீட்டு முறை, பதினாறு நிலை எண் 
முறையில் குறியிடப்படுகின்றது. தமிழ், தெலுங்கு, 
மலையாளம் மற்றும் கன்னடத்தின் யுனிக�ோட் 
குறியீட்டு அட்டவணை 2.6ல் க�ொடுக்கப்பட்டுள்ளது.
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பிற்சேர்க்கை

தகவல் பரிமாற்றத்திற்கான அமெரிக்க தரநிலை குறியீடு முறை

American Standard Code for Information Interchange (ASCII)
(சில குறிப்பிட்ட எழுத்துருக்கள் மட்டும்)

ஆங்கில எழுத்துக்கள் (Alphabets)

ஆங்கில 

எழுத்துக்கள்

பதின்ம 

எண்

இருநிலை எண்

(8 பிட்)

எண்ணிலை 

எண்

பதினாறு நிலை 

எண்

A 65 01000001 101 41
B 66 01000010 102 42
C 67 01000011 103 43
D 68 01000100 104 44
E 69 01000101 105 45
F 70 01000110 106 46
G 71 01000111 107 47
H 72 01001000 110 48
I 73 01001001 111 49
J 74 01001010 112 4A
K 75 01001011 113 4B
L 76 01001100 114 4C
M 77 01001101 115 4D
N 78 01001110 116 4E
O 79 01001111 117 4F
P 80 01010000 120 50
Q 81 01010001 121 51
R 82 01010010 122 52
S 83 01010011 123 53
T 84 01010100 124 54
U 85 01010101 125 55
V 86 01010110 126 56
W 87 01010111 127 57
X 88 01011000 130 58
Y 89 01011001 131 59
Z 90 01011010 132 5A
a 97 01100001 141 61
b 98 01100010 142 62
c 99 01100011 143 63
d 100 01100100 144 64
e 101 01100101 145 65
f 102 01100110 146 66
g 103 01100111 147 67
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h 104 01101000 150 68
i 105 01101001 151 69
j 106 01101010 152 6A
k 107 01101011 153 6B
l 108 01101100 154 6C

m 109 01101101 155 6D
n 110 01101110 156 6E
o 111 01101111 157 6F
p 112 01110000 160 70
q 113 01110001 161 71
r 114 01110010 162 72
s 115 01110011 163 73
t 116 01110100 164 74
u 117 01110101 165 75
v 118 01110110 166 76
w 119 01110111 167 77
x 120 01111000 170 78
y 121 01111001 171 79
z 122 01111010 172 7A

எண்ணுருக்கள் (Numerics)

எண்ணுருக்கள்
பதின்ம 

எண்

இருநிலை எண்

(8 பிட்)

எண்ணிலை 

எண்

பதினாறு நிலை 

எண்

0 48 00110000 60 30
1 49 00110001 61 31
2 50 00110010 62 32
3 51 00110011 63 33
4 52 00110100 64 34
5 53 00110101 65 35
6 54 00110110 66 36
7 55 00110111 67 37
8 56 00111000 70 38
9 57 00111001 71 39

சிறப்பு எழுத்துருக்கள் (Special Character)

சிறப்புக் 

குறியீடுகள்

பதின்ம 

எண்

இருநிலை எண்

(8 பிட்)

எண்ணிலை 

எண்

பதினாறு நிலை 

எண்

Blank 32 00100000 40 20
! 33 00100001 41 21
" 34 00100010 42 22
# 35 00100011 43 23
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$ 36 00100100 44 24
% 37 00100101 45 25
& 38 00100110 46 26
' 39 00100111 47 27
( 40 00101000 50 28
) 41 00101001 51 29
* 42 00101010 52 2A
+ 43 00101011 53 2B
, 44 00101100 54 2C
- 45 00101101 55 2D
. 46 00101110 56 2E
/ 47 00101111 57 2F
: 58 00111010 72 3A
; 59 00111011 73 3B
< 60 00111100 74 3C
= 61 00111101 75 3D
> 62 00111110 76 3E
? 63 00111111 77 3F
@ 64 01000000 100 40
[ 91 01011011 133 5B
\ 92 01011100 134 5C
] 93 01011101 135 5D
^ 94 01011110 136 5E
_ 95 01011111 137 5F
` 96 01100000 140 60
{ 123 01111011 173 7B
| 124 01111100 174 7C
} 125 01111101 175 7D
~ 126 01111110 176 7E

மதிப்பாய்வு

பகுதி – அ

சரியான விடையைத் தேர்ந்தெடு:

1.	 கணிப்பொறியின் மையச் செயலகத்தில் பிட்டுகளின் எண்ணிக்கை எவ்வாறு குறிப்பிடப்படுகிறது?

	 (அ) பைட்		  (ஆ) நிபில்		  (இ) வேர்டு நீளம்		 (ஈ) பிட்

2.	 ஒரு கில�ோ பைட் என்பது எத்தனை பைட்டுகளைக் க�ொண்டது?

	 (அ) 1000	 	 (ஆ) 8			   (இ) 4			   (ஈ) 1024

3.	 ASCII என்பதன் விரிவாக்கம்:
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	 (அ) American School Code for Information Interchange
	 (ஆ) American Standard Code for Information Interchange
	 (இ) All Standard Code for Information Interchange
	 (ஈ) American Society Code of Information Interchange
4. 	 2^50 என்பது எதை குறிக்கும்

	 (அ) கில�ோ (Kilo)	 (ஆ) டெரா (Tera)	 (இ) பீட்டா (Peta)	 (ஈ) ஜீட்டா (Zetta)

5.	 Binary Coded Decimal முறையில் எத்தனை எழுத்துருக்களைக் கையாள முடியும்?

	 (அ) 64			   (ஆ) 255	 		  (இ) 256		 (ஈ) 128

6.	 11012-க்கு நிகரான பதினாறுநிலை மதிப்பு எது?

	 (அ) F			   (ஆ) E			   (இ) D			   (ஈ) B

7. 	 00100110 க்கான 1-ன் நிரப்பி எது?

	 (அ) 00100110		  (ஆ) 11011001		  (இ) 11010001		  (ஈ) 00101001

8.	 கீழ்க்கண்டவற்றில் எது எண்ணிலை எண் அல்ல?

	 (அ) 645		  (ஆ) 234	 	 (இ) 876			  (ஈ) 123

பகுதி – ஆ

குறு வினாக்கள்:

1.	 தரவு என்றால் என்ன?

2.	 1-ன் நிரப்பு முறைக்கான வழிமுறைகளை எழுதுக.

3.	 (46)10க்கு நிகரான இருநிலை எண்ணாக மாற்றுக.

4.	 (28)10 க்கு 1-ன் நிரப்பு முறையில் விடை காண முடியாது. ஏன் காரணம் கூறு.

5.	 எழுத்துருக்களை நினைவகத்தில் கையாளுவதற்கான குறியீட்டு முறைகளைப் பட்டியலிடுக.

பகுதி – இ

சிறு வினாக்கள்:

1.	 எண் முறையில் அடிமானம் என்றால் என்ன? எடுத்துக்காட்டு தருக.

2.	 இருநிலை எண் முறை – குறிப்பு வரைக.

3.	 (150)10 
க்கு நிகரான இருநிலை எண்ணாக மாற்றி, அதனை எண்ணிலை எண்ணாக மாற்றுக.

4.	 ISCII குறிப்பு வரைக.

5.	 கூட்டு: (அ) -2210 + 1510	(ஆ) 2010 + 2510

பகுதி – ஈ

நெடு வினாக்கள்:

1. 	 (அ) மிதப்புப் புள்ளி பதின்ம எண்ணை, இருநிலை எண்ணாக மாற்றுவதற்கான வழிமுறைகளை 		

	 விவரி.

	 (ஆ) (98.46)10 
க்கு நிகரான இருநிலை எண்ணாக மாற்றுக.

2.	 பின்வரும் பதின்ம எண்களுக்கு 1ன் நிரப்பி மற்றும் 2ன் நிரப்பிகளைக் காண்க.

	 (அ) -98		 (ஆ) -135
3. 	 (அ) கூட்டுக: 	 11010102 + 1011012

	 (ஆ) கழிக்க:	 11010112 – 1110102
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கற்றலின் ந�ோக்கங்கள்

	 இந்தப்பாடப் பகுதியைக் கற்றபின், 

மாணவர்கள்

•	 கணிப்பொறியின் பல்வேறு சாதனங்கள் 

மற்றும் அதன் இணைப்புகள் பற்றி அறிதல்.

•	 நுண்செயலியும் அதன் தன்மைகளைப் 

பற்றி அறிந்து க�ொள்ளுதல்.

•	 நினைவகச் சாதனங்களின் 

முக்கியத்துவத்தையும், கணிப்பொறியில் 

அதன் பங்கினையும் அறிந்து 

க�ொள்ளுதல்.

1.	 RAM மற்றும் ROM களை ஆராய்ந்து  

அதனை வேறுபடுதல்

2.	 கேச் நினைவகத்தை அறிதல் 

மற்றும் கணிப்பொறியின் செயல் 

திறனை கேச்நினைவகம் எவ்வாறு 

மேம்படுத்துகிறது  என்பதையும் 

அறிதல்

•	 இரண்டாம் நினைவகச் சாதனங்களும் 

அதன் பயன்பாடுகளும் பற்றி அறிந்து 

க�ொள்ளுதல்.

•	 த�ொடர்பு முகம் மற்றம் இடைமுகம் 

பயன்படுத்தி, வெளிச்சாதனங்கள் எவ்வறு 

இணைக்கப்படுகிறது என்பதை அறிதல்.

3.1 முன்னுரை

கணிப்பொறி அமைப்பு என்பது கணினியின் 

வன்பொருள் கூறுகளை உள்ளடக்கியது. இதில் 

உள்ளீட்டு / வெளியீட்டு சாதனங்கள், மையச் 

செயலகம் (CPU), சேமிப்பு சாதனங்கள்  மற்றும் 

முதன்மை நினைவகம் ஆகியவை அடங்கும். 

இது  கணினியின் பல்வேறு பாகங்களை எப்படி 

செயல்படுத்துகிறது என்பதைப் ப�ொறுத்தது. இது 

ஒரு கணினியின் அனைத்து வன்சாதனங்களும் 

எவ்வாறு வேலை செய்கிறது என்பது பற்றியும், 

மேலும் பல்வேறு பாகங்களின்  இணைப்பு 

பற்றியும் விளக்குகிறது. கணினியின் கட்டமைப்பு 

என்பதும் கணிப்பொறியின் அமைப்பு என்பதும் 

ஒன்றே. ஆனால் கணிப்பொறியை 

வடிவமைப்பதில் ஈடுபட்டிருக்கும் ப�ொறியியல் 

கருதுக�ோளுடன் கணினி கட்டமைப்பு 

உள்ளடக்கியது. அதே நேரத்தில் கணினி 

அமைப்பானது, நிரலருக்கு வன்பொருள் 

கூறுகளை  வெளிப்படையாக விளக்குகிறது. 

3.2. நுண்செயலிகளின் அடிப்படைகள்
	

	 கணிப்பொறியின் மையச்செயலகம் 

என்பது கணிப்பொறியின் முதன்மை 

அங்கமாகும். இது அனைத்து செயல்களையும் 

செய்கிறது. இது ஒருங்கிணைந்த சுற்றுகளை 

உள்ளடக்கிய நுண்செயலியை (Micro 
processor)அடிப்படையாகக் க�ொண்டது. முதன் 

முதலில் நுண்செயலிகள் 1970 ஆம் ஆண்டில் 

அறிமுகப்படுத்தப்பட்டது. 4004 என்ற முதல்   

ப�ொதுப்பயன் நுண்செயலியை இண்டெல் (Intel)
என்ற நிறுவனம் உருவாக்கியது.

	 நுண்செயலியானது ஒரு  நிரலாக்கம் 

செய்யக்கூடிய, பற்பல உபய�ோகத்திற்கான ஒரு 

சிலிகான் சிப்பாகும். இது கடிகார துடிப்புகளால் 

இயங்குகிறது. நுண்செயலி இரும எண்களை 

உள்ளீடாகப் பெற்று எண் கட்டளைக்கேற்ப, 

செயலாக்கம் செய்து பின்பு வெளியீடுகளை 

நினைவகத்தில் தேக்கி வைக்கிறது. படம் 3.1ல் 

உள்ள வரைபடம்  நுண்செயலியின் அடிப்படையில் 

கணிப்பொறியின் செயல்பாகங்களைக் 

காட்டுகிறது .

3
கணினி அமைப்பு

பாடம்கணினி அறிமுகம்அலகு I 
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உள்ளீடு நுண்செயலி வெளியீடு

நினைவகம்

படம் 3.1 நுண்செயலி - அடிப்படை அமைப்புகள்

	 நுண்செயலி மூன்று முக்கிய பகுதிகளைக் 

க�ொண்டுள்ளது. அவை

•	 கணித ஏரணச் செயலகம்(Arithmetic and 
Logic Unit - ALU): கணித மற்றும் ஏரணச் 

செயல்பாடுகளைக் கணிப்பொறியின் 

கட்டளைக்கேற்ப செயல்படுத்தும்.

•	 கட்டுப்பாட்டகம்:  கட்டுப்பாட்டு  சமிக்ஞைகளைப் 

பெற்று கணிப்பொறியின் எல்லா 

பாகங்களையும் கட்டுப்படுத்துகிறது.

•	 பதிவேடுகள்- உள்ளமைந்த நினைவகம் 

(Registers – Internal Memory): 

செயல்பாடுகளுக்குத் தேவையான தரவு 

மற்றும் கட்டளைகளைச்  சேமிக்கும்.
•	 படம் 3.2ல் க�ொடுக்கப்பட்டுள்ளதைப் ப�ோல், 

நுண்செயலியால் நினைவகம், உள்ளீடு மற்றும் 
வெளியீடு சாதனங்கள�ோடு த�ொடர்பு க�ொள்ள 
முடியும். பாட்டை என்னும் அமைப்பானது 
கம்பிகளின் குவியலாகும். இது முகவரி 
பாட்டை தரவு பாட்டை மற்றும் கட்டுப்பாட்டு 
பாட்டை ஆகியவற்றின் திரட்டாகும். இது, 
நுண்செயலி பிற சாதனங்கள�ோடு த�ொடர்பு 
க�ொள்ளும் பாதையாக வேலை செய்கிறது.

A.L.U பதிவேடு

கட்டுப்பாட்டகம்
அமைப்பு

உள்ளீடு / வெளியீடு

RAMROM
நினைவகம்

படம் 3.2 நுண்செயலியும் மற்ற சாதனங்களின் 

இணைப்பும்

நுண்செயலின் பண்பியல்புகள்

ஒரு நுண்செயலின் செயல்பாடு, 
கீழ்க்காணும் அதன் பண்பியல்களை 
அடிப்படையாக க�ொண்டது:

a)	 கடிகார வேகம் (Clock Speed) 

b)	 கட்டளைத் த�ொகுப்பு (Instruction Set)
c)	வேர் டு அளவு (Word Size)

நுண்செயலி

a) கடிகார வேகம்
	 ஒவ்வொரு நுண்செயலிலும் உள்ளே ஒரு 
கடிகாரம் உள்ளது. கணிப்பொறியின் ஒவ்வொரு 
கட்டளையும் நிறைவேற்றுதலின் வேகத்தை இந்த 
கடிகாரம் கட்டுப்படுத்துகிறது. இதுவே கடிகாரத்தின் 
வேகம் எனப்படும். கணிப்பொறியின் வேகத்தை மெகா 
ஹெர்ட்ஸ் (MHz-Mega Hertz)  மற்றும் ஜிகா ஹெர்ட்ஸ் 
(GHz-Giga Hertz) அளவில் அளக்கப்படுகிறது.
b) கட்டளைத் த�ொகுப்பு:
	 ஒரு தரவின் மீது செயல்பாடுகளைச் 
செயல்படுத்துவதற்காக, கணிப்பொறிக்கு 
க�ொடுக்கப்படும் கட்டளைகளே அறிவுறுத்தல் 
எனப்படும். நுண்செயலியைச் செயல்படுத்துவதற்காக 
வடிவமைக்கப்பட்ட அடிப்படை இயந்திர நிலை 
அறிவுறுத்தல் த�ொகுதிகளைக் கட்டளைத் த�ொகுப்பு 
என்கிற�ோம். இந்த கட்டளைகளின் த�ொகுதி 
பின்வரும் செயல்களை செயல்படுத்துகிறது.

கடிகாரத்தின் வேகம் கணக்கிடுதல்
•	 Hz என்பது Hertz ன் சுருக்கம் ஆகும்.

ஹெர்ட்ஸ்,  ப�ொதுவாக ஒலி அலை 
அதிர்வெண்களை அளவிடப்  பயன்படுகிறது. 
ஒலி அலைகள் ஒரு ந�ொடியில்  எத்தனை 
சுற்றுகள் என்ற அளவில் அளக்கப்படுகிறது.

•	 ஒலி அலைகள், வான�ொலி அலைகள் ப�ோன்ற 
அலை அதிர்வெண்களை அளவிடுவதற்கு  
ஹெர்ட்ஸ் பயன்படுகிறது.  உதாரணமாக, 
சராசரி மனிதனின் காது 20 முதல் 20,000 
ஹெர்ட்ஸ் அலைகளைக் கேட்க முடியும். 20 
ஹெர்ட்ஸ் அருகிலுள்ள ஒலி அலைகள் 
குறைவான சுருதியில் அமைவதையே “bass” 
அலைகள் எனப்படுகிறது. 5000 Hz –க்கு 
அதிகமான  ஒலி அலைகள் உயர்ந்த 
சுருதியில் அமைவதை “treble” அலைகள் 
எனப்படுகிறது.

•	 ஹெர்ட்ஸ் அலை அதிர்வெண்களை 
அளவிடுவதற்கு பயன்படுவது ப�ோல் கணினி 
செயலியின் வேகத்தை அளவிடவும் 
பயன்படுகிறது. உதாரணமாக, ஒவ்வொரு 
மையச் செயலகத்தின் வேகம் ஒரு குறிப்பிட்ட 
கடிகார வேகத்தின் மதிப்பிடப்படுகிறது. இந்த 
எண் ஒவ்வொரு செயலியும் ந�ொடிக்கு எத்தனை  
வழிமுறை சுழற்சிகளை  இயக்கும் என்பதைக் 
குறிக்கிறது. நவீன செயலிகளில் ஒரு 
ந�ொடிக்கு மில்லியன் அல்லது பில்லியன் 
செயல்களைச் செய்ய முடியும் என்பதைக்  
கடிகார வேகம் ப�ொதுவாக மெகா ஹெர்ட்ஸ் 
அல்லது ஜிகா ஹெர்ட்ஸில் அளவிடப்படுகிறது.

உங்களுக்கு தெரியுமா?
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•	 தரவு மாற்றம்
•	 எண் கணித செயல்முறைகள்
•	 தருக்க செயல்முறைகள்
•	 கட்டுப்பாட்டு நகர்வு
•	 உள்ளீடு / வெளியீடு

c) வேர்டு அளவு

	வேர் டின் அளவு என்பது ஒருதடவை செயலி 
செயற்படுத்தும் பிட்டுகளின் அளவாகும். ஒரு வேர்டு  
அளவு என்பது கணிப்பொறியின் முதன்மை 
நினைவகம் (RAM) செயற்படுத்தும் கட்டளையின் 
அளவையும், நுண்செயலியில் உள்ள ஊசிகளின் 
(Pins) எண்ணிக்கையை  ப�ொருத்ததாகும். 
முறையே உள்ளீடு மற்றும் வெளியீடு ஊசிகளின் 
ம�ொத்த  எண்ணிக்கையானது  நுண்செயலியின் 
கட்டமைப்பைத் தீர்மானிக்கிறது.

3.3 மையச் செயலகம் மற்றும் நினைவகத்திற்கு 

இடையேயான தரவு பரிமாற்றம்

	 மையச் செயலகம் (CPU), தரவு 
நினைவகப் தரவு பதிவேடுகளையும் (MDR) 
மற்றும் நினைவக முகவரி பதிவேடுகளையும் 
(MAR) க�ொண்டுள்ளது. நினைவகத்திற்கும் 
மற்றும் மையச் செயலகத்திற்கும் இடையே 
தேவையான தரவைத்  நினைவக தரவு 
பதிவேடுகள் தேக்கி வைக்கும் .  நிரலின் அடுத்து 
செயற்படுத்த வேண்டிய கட்டளையின் முகவரியை 
மையச்செயலகத்தில் சேமித்து வைக்கும் ஒரு 
சிறப்பு பதிவேடு தான் நிரல் பதிவேடு ஆகும்.   
மையச் செயலகத்திலுள்ள கணித ஏரணச் 
செயலகம் செயற்படுத்த வேண்டிய நினைவக 
முகவரியை, நினைவக முகவரி பதிவேட்டில் 

(Program Counter) சேமித்து வைக்கும். 

	பாட்டை  (bus) என்பது கணினியின் 
கூறுகளுக்கிடையே த�ொடர்பு க�ொள்ள 
பயன்படும் கம்பிகளின் த�ொகுப்பு ஆகும்.

	 RAM யில் உள்ள வேர்டின்  அளவும் 
நினைவக தரவு பதிவேட்டின்  அளவும் ஒன்றாகும். 
8 – பிட்  செயலியான Intel 8085 யில் நினைவக 
தரவு பதிவேடும்  மற்றும் RAM யில் உள்ள 
வேர்டின்  அளவும் 8 பிட் ஆகும்.

	 READ செயல்பாடு தரவுகளை 
(பிட்டுகளை) வேர்டில் இருந்து  நினைவக தரவு 
பதிவேடுகளுக்கு அனுப்பும். WRITE செயல்பாடு 
தரவுகளை (பிட்டுகளை) நினைவக தரவு 
பதிவேடுகளில் இருந்து வேர்டிற்கு அனுப்பும்.

•	 கம்பியின் ஒரு முனையில் 5V 
க�ொடுக்கப்பட்டால்  எதிர்  முனையில் அதே 

5Vபெற முடியும். இதைப்போல கம்பிகளான 

பாட்டைகள் இரும தரவுகளை  

மின்னெழுத்துக்களாக (5V என்பது 1  
–ஆகவும் , 0V என்பது 0 –ஆகவும்) கம்பியின் 

ஒரு முனையிலிருந்து மறுமுனைக்கு தர வை 

வ�ோல்ட்டேஜ்யாக அனுப்பும்.

உங்களுக்கு தெரியுமா?

3.4 நுண்செயலியின் வகைகள்

	 நுண்செயலிகளைப் பின்வரும் 

நிபந்தனைகளின் அடிப்படையில் 

வகைப்படுத்தலாம்:

•	 செயலாக்கப்படும் தரவின் அகலம்

•	 கட்டளைத் த�ொகுப்பு

3.4.1	செய லாக்கப்படும் தரவின் அகலத்தின் 

அடிப்படையில் நுண்செயலியின் வகைகள் 

•	 	த ரவின் அகலத்தின் அடிப்படையில் 

நுண்செயலி கட்டளைகளைச் செயலாக்கும். 

நுண்செயலியைப் பின்வருமாறு 

வகைப்படுத்தலாம்:

•	 8- பிட் நுண்செயலி

•	 16-பிட் நுண்செயலி

•	 32-பிட் நுண்செயலி

•	 64-பிட் நுண்செயலி

3.4.2 கட்டளைத் த�ொகுதியின் அடிப்படையில் 

நுண்செயலியை வகைப்படுத்தல்

	 நுண்செயலியை வகைப்படுத்தும் ப�ோது 

கட்டளைத் த�ொகுதியின் அளவு ஒரு முக்கியமான 

கருத்தாக அமையும்.

	 RISC என்பது Reduced Instruction Set 
Computers.

	 CISC என்பது Complex Instruction Set 
Computers.

•	 RISC செயலிக்கு எடுத்துக்காட்டு :Pentium IV ,  
Intel P6, AMD K6 மற்றும் K7.
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நினைவகத்தில் சேமிக்கப்படும் மிகச் சிறிய 

தகவலை பிட் (Bit) என்றழைக்கின்றோம். 

நினைவகம் ஒரு நேரத்தில் 8 – பிட்டுகளைக் 

க�ொண்ட த�ொகுப்புகளை அணுகும். இதையே ஒரு 

பைட் (Byte) என்கின்றோம். ‘B’ என்ற ஆங்கில 

பெரிய எழுத்தால் பைட் குறிப்பிடப்படும். ஒரு 

கணினியின் நினைவகம் 1 மெகா 

பைட்டாகயிருந்தால் (MB) அதில் 10,48,576 
பைட்கள் (அல்லது எழுத்துக்கள் ) தகவல்களைச் 

சேமிக்க முடியும் (1 MB என்பது 1024 KB மற்றும் 

1KB என்பது 1024 பைட்கள், இதில் 1024 x 1024= 
10,48,576 பைட்களாகும்.) 

	 RAM ஒரு தற்காலிக நினைவகம் ஆகும். 

அதாவது இதில் சேமிக்கப்படும் தகவல்கள் 

நிரந்தரமில்லை. கணிப்பொறிக்கு செலுத்தும்  

மின்சாரம்  நிறுத்தப்பட்டவுடன் அதில் உள்ள   

அனைத்து தரவுகளும் அழிந்து விடும். முதன்மை 

நினைவகம் READ  மற்றும் WRITE செயல்களை 

அனுமதிக்கும்.

3.5.2	 நேரடி அணுகல் நினைவகத்தின் 
வகைகள்

 RAM – ன் இரண்டு அடிப்படை வகைகள்

•	 மாறும் முதன்மை நினைவகம் [Dynamic 
RAM -DRAM]

•	 நிலையான முதன்மை நினைவகம் [Static 
RAM -SRAM]

	மேலே  கூறிய நினைவகங்கள் தரவை 

வைத்திருக்கும் த�ொழில்நுட்பத்தில் மாறுபடுகிறது. 

மாறும் முதன்மை நினைவகம்  அடிக்கடி 

நினைவகத்தைப் புதுப்பிக்க வேண்டியிருக்கும். 

ஆனால் நிலையான முதன்மை நினைவகம் சில 

நேரங்களில் புதுப்பித்தால் ப�ோதும். இதனால் 

இந்த வகையான நினைவகம் வேகமாக 

செயல்படுகின்றது. நிலையான முதன்மை 

நினைவகம், மாறும் முதன்மை நினைவகத்தை விட 

அதிக உயர்ந்ததாகும்.

3.5.3 படிக்க மட்டும் நினைவகம் (ROM)

	 படிக்க மட்டும் நினைவகம் (ROM) 
கணிப்பொறியின் ஒரு சிறப்பு நினைவகம். இது 

உருவாக்கப்படும் ப�ோதே, தரவுகள் பதிவு 

	 Intel 386 & 486, Pentium, Pentium II, III 
மற்றும் Motorola 68000 கணினிகள் CISC 
செயலியைக் க�ொண்ட கணிப்பொறிகளுக்கு 

எடுத்துக்காட்டுகள் ஆகும்.

3.5 நினைவகச் சாதனங்கள்

	 கணிப்பொறி நினைவகம் என்பது மனித 

மூளையைப் ப�ோன்றதாகும். கணிப்பொறி நினைவகம் 

தரவுகளையும் கட்டளைகளையும் சேமித்து வைக்கப் 

பயன்படுகிறது. நினைவகத்தில் சேமித்து 

வைக்கப்பட்ட தரவு ் மற்றும் கட்டளைகள் இரண்டு 

வகையில் கையாளப்படுகின்றது (படிக்க / எழுத), 

அவை த�ொடர்ச்சியான மற்றும் நேரடி அணுகல் 

முறையாகும். த�ொடர்ச்சியான அணுகல் முறையில் 

நினைவகம் முதலிலிருந்து கடைசிவரை 

ஒவ்வொன்றும் வரிசையாக அணுகும். ஆனால் நேரடி 

அணுகல் முறையில் நினைவகம் ஒவ்வொன்றாக 

அணுகுவதற்கு பதிலாக நேரடியாக அணுகும். படம் 

3.6 ல் பல வகையாக நினைவகச் சாதனங்கள், அதன் 

க�ொள்ளளவு, வேகம் மற்றும் விலையின் 

அடிப்படையில்  வரிசைப்படுத்தப்பட்டுள்ளது.
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படம் 3.6 நினைவக வரிசை முறை

3.5.1 நேரடி அணுகல் நினைவகம் (RAM) 	
	 கணிப்பொறியின் முதன்மை நினைவகம் 

நேரடி அணுகல் நினைவகம் (Random Access 
Memory) என்றும் அழைக்கப்படுகிறது. இது 

கணிப்பொறியில் ஒரு ஒருங்கிணைந்த சுற்றுகளாக 

ப�ொருத்தப்பட்டுள்ளது. கணிப்பொறியில் இங்கு 

தான் இயக்க அமைப்பு, பயன்பாட்டு நிரல்கள் 

மற்றும் தற்போது பயன்பாட்டில் உள்ள தரவுகள் 

தற்காலிகமாக சேமிக்கப்பட்டிருப்பதை 

கணினியின் செயலியால் அணுகும். 
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மூலம் தகவல்கள் அழிக்கப்படுகிறது. EPROM –ல் 

தகவல்கள் புற ஊதா ஒளி செலுத்தும் வரை 

தகவல்களைச் சேமித்து வைக்கும். புற ஊதா 

ஒளியை செலுத்தி PROM-ன் உள்ளடக்கத்தை 

அழித்தும், மீண்டும் வேறு நிரல்களை மறுபடியும் 

எழுதலாம். PROM ஒரு முறை எழுதப்பட்டபின் 

அதை அழிக்கமுடியாது, அதனால் EPROM, 
PROM லிருந்து மாறுபட்டது. EPROM ப�ொதுவாக 

தனியாள் கணினியில் பெரும்பாலும் 

பயன்படுத்தப்படுகிறது.  ஏனெனில் 

உற்பத்தியாளர்கள் கணினியை வழங்குமுன் 

PROM-ன் உள்ளடக்கத்தை மாற்றி, மேம்படுத்தி 

அல்லது நீக்க வேண்டியவற்றை அழிக்க முடியும். 

படம்  3.7 அழிக்கக் கூடிய நிரலாக்கு படிக்க மட்டும் 

நினைவகம்

3.5.3.3 மின்சாரத்தால் அழிக்கும் மற்றும் 

நிரலாக்கு படிக்க மட்டும் நினைவகம்  

(EEPROM) Electrically Erasable 
Programmable Read-Only Memory:

	 EEPROM  ஒரு சிறப்பு PROM வகையைச் 

சார்ந்த நினைவகம் ஆகும். இதில் உள்ள 

தரவுகளை மின்சாரத்தைச் செலுத்தியே 

அழிக்கலாம்.  மற்ற PROM வகையைப் ப�ோல  

மின்சாரம் நிறுத்தப்பட்டாலும் தரவுகள் அழியாது. 

மற்ற ROM வகைகளை ஒப்பிட்டால், EEPROM ஒரு 

மெதுவாக இயங்கும் நினைவகம் ஆகும். 

•	 ப�ொதுவாக EPROM சில்லுகளின்  மேல் 

பகுதியில் வெளிப்படையாக வைக்கப்பட்டு, 

ஸ்டிக்கர் மூலம் மறைக்கப்பட்டிருக்கும். 

ஸ்டிக்கர் அகற்றப்பட்டால் சூரிய ஒளியில் 

உள்ள புற ஊதா ஒளி அதில் உள்ள 

தரவுகளை அழித்து விடும்.

உங்களுக்கு தெரியுமா?

செய்யப்பட்டு விடுவதால் அதில் மாற்றம் செய்ய 

முடியாது. இதில் சேமிக்கப்படும் நிரல்கள் 

கணினியைத் துவக்கவும் மற்றும் த�ொடங்கும் 

ப�ோது செய்ய வேண்டிய செயல்கள் ப�ோன்றவை 

இத்தகைய நினைவகங்களில் 

வைக்கப்படுகின்றன. ROM ல் கணினியைத் 

துவங்குவதற்கான மிக முக்கிய நிரல்களைச் 

சேமித்து வைக்கும். ஒரு முறை தரவுகளை இதில்  

எழுதிவிட்டால் அதை மாற்றவ�ோ அல்லது 

அழிக்கவ�ோ முடியாது. ஆனால் படிக்கமட்டும் 

முடியும். ROM ன் உள்ளடக்கம் மின்சாரம் 

நிறுத்தப்பட்டாலும் அழிவதில்லை. இதனால்  

ROM அழியா நினைவகம் என்று 

அழைக்கப்படுகிறது.

3.5.3.1	நிரலாக்கு படிக்க மட்டும் நினைவகம்   

(Programmable Read-Only Memory - 
PROM)

	 நிரலாக்கு படிக்க மட்டும் நினைவகம், ஒரு 

அழியா நினைவகம் ஆகும். இதில் தரவுகள் ஒரு 

முறைமட்டும் எழுத முடியும். PROM - ல் ஒரு முறை 

நிரல்களை எழுதிவிட்டால் எப்பொழுதும் 

அழியாமலிருக்கும். முதன்மை நினைவகம் 

ப�ோன்று அல்லாமல் கணினியின் செயல்பாடு 

நிறுத்தப்பட்டாலும் PROM நிரலர் அல்லது  PROM 

–ன் உள்ளடக்கம் அழியாமல் இருக்கும். 

	 PROM – ROM ல் இருந்து மாறுபட்டதாகும் 
PROM தயாரிக்கப்படும் ப�ொழுது ஒரு காலி 
நினைவகமாக தயாரிக்கப்படும், ஆனால் ROM 
தயாரிக்கும் ப�ொழுதே அதில் நிரல்கள் 
சேமிக்கப்படுகின்றது.ஆனால் PROMல் 
நிரலருக்கு தேவைப்படும் ப�ொழுது நிரல்களை 
எடுத்துக் க�ொள்ளலாம். PROM Burner 
பயன்படுத்தி PROM சிப்பில் தரவுகள் 
எழுதப்படுகின்றது. இந்த வகையான PROM-ன் 
நிரலாக்கம் PROM-ல் எழுதுதல் 
என்றழைக்கப்படும்.

3.5.3.2 அழிக்கக் கூடிய நிரலாக்கு படிக்க மட்டும் 

நினைவகம் (EPROM)Erasable 
Programmable Read-Only Memory:

	  அழிக்கக் கூடிய நிரலாக்கு படிக்க மட்டும் 

நினைவகம், ஒரு  PROM வகையான சிறப்பு 

நினைவகம் ஆகும். ஆனால் அதில் புற ஊதா ஒளி 
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3.5.4 நகச் நியனவகம்
 நகச் நியனவகம் அதிநவகமோன, வியல 
உைரந்த நியனவகம் ஆகும். நியனவகத்தில 
உள்ை ்தரயவத் திரும்் எடுத்்தயலத் 
துரி்தப்டுத்துவ்தறகு ்ைன்்டும் நியனவகம் 
ஆகும். இ்தன் வியல கூடு்தலோகும். அ்தனோல 
யமைச் ்சைலகத்தில மு்தன்யம நியனவகத்தின் 
அையவ விட நகச் நியனவகத்தின் அைவு மிகவும் 
குய்றவோக இருககும். நகச் நியனவகம் 
இலயல்ைனில யமைச் ்சைலகம் ஒவ்வோரு  
முய்றயும்  ்தரவு ந்தயவ்டும்ந்ோது அய்த 
மு்தன்யம நியனவகத்திலிருநது ்்றும். இது 
அதிக ந�ரத்ய்த எடுத்துக ்கோள்ளும். நகச் 
நியனவகம் அறிமுகப்டுத்்தப்ட்ட்தறகு கோரணம், 
இந்த நியனவகத்தில அடிககடி ந்தயவப்டும் 
மறறும் அணுகககூடிை ்தரவுகள் நசமிககப்டும். 
இது வியரவோன ்திலளிபபு ந�ரத்ய்தத் ்தகக 
யவகக உ்தவுகி்றது. அஙகு இைகக ந�ரம் (Access 
Time) நியனவகம் ்டிகக / எழு்த நகோரிகயகககு 
எவவைவு வியரவோக ்திலளிகக முடியும் என்்ய்த 
குறிககின்்றது. ் டம் 3.8ல யமைச் ் சைலகத்திறகும் 
மு்தன்யம நியனவகத்திறகும் இயடநை 
அயமககப்ட்டுள்ை நகச் நியனவகத்ய்தக 
கோணலோம்.

CPU Cache Main
Memory

Fast Slow

்டம் 3.8 நகச் நியனவகத்தின் அயமபபு

3.6 இரணடோம் நியல நசமிபபு சோ்தனஙகள்

 கணினியின் மு்தன்யம நியனவகம், 
்்ோதுவோக குய்றந்த அைவிலும், வியல உைரநதும் 
மறறும் அழியும் நியலயிலும் இருககும். இரணடோம் 
நியல நசமிபபு சோ்தனஙகளில ்தரவு மறறும்  
நிரலகள் நிரந்தரமோக நசமித்து யவககப்டும். 
இரணடோம் நியல நசமிபபு சோ்தனஙகள் இைல்ோக 
அழிைோ நியலயில இருப்்தோல இயவ மு்தன்யம 
நியனவகத்திறகு ஒரு இயண நசமிபபு சோ்தனமோக 
்ணிைோறறுகி்றது. இ்தனோல இரணடோம் நியல 
நசமிபபு "கோபபு நசமிபபு" (Backup Storage) 
என்்றயழககப்டுகி்றது.

3.6.1 வன்வட்டுகள் (Hard Disks)
 வன்வட்டு ஒரு கோந்தவட்டோகும். இதில 

்தரவுகயைச் நசமிககலோம். வன்வட்டு ஒவ்வோரு 

வட்டிறகும் ஒரு நஜோடி ்தயலகள் ்கோணடு 

அணுகும் வணணம் ்ல வட்டுககயை ஒன்றின் 

மீது ஒன்்றோக அடுககப்ட்டுள்ை ஏற்ோட்டில 

அயமநதிருககும். வன்வட்டுககள் ஒறய்ற அலலது 

இரட்யட ்கக வட்டுககைோக இருககும்.

3.6.2 குறு வட்டு (CD)
 CD எனப்டும் CD-ROM 1.2 மிலலிமீட்டர 

்ருமன் அைவில ்ோலிகோர்நனட் பிைோஸ்டிக 

்்ோருைோல ஆன்தோகும். ்மலலிை அைவிலோன  

அலுமினிைம் அலலது ்தஙக முலோம் அ்தன் 

நமல்குதியில பூசப்ட்டிறகும். CD - ல ்தரவுகள் 

சிறிை ்தடஙகளில துணுககுகைோக அதில  

நசமிககப்டுவது “pits” எனப்டும். இயவ 

அடுககின் நமல ஒரு சுருள் ்ோய்தயில 

வடிவயமககப்ட்டிருககும். இரணடு Pits – களுககு 

இயடநை உள்ை இயட்வளி “lands” என்று 

அயழககப்டும். CD - யைப ்டிககும் சோ்தனத்தில 

உள்ை நமோட்டர CD-யைச் சுழறறும். ஒரு சோ்தோரண 

CD - ன் ்கோள்ைைவு 700  MB ஆகும்.

்டம் 3.9  குறு வட்டு

3.6.3 டிஜிட்டல ்வரசயடல வட்டு (DVD)
 DVD (Digital Versatile Disc அலலது 

Digital Video Disc) கணணோடியியழ வட்டு 

(Optical Disc),  4.7 GB வயர ்தரவுகள் நசமிககும்.  

இந்த அைவு 6 CD-ன் ்கோள்ைைவுககு சமமோகும்.  

தியரப்டஙகயைச் சி்றந்த  ்தரத்தில DVD-களில 

நசமித்து யவககலோம். குறுவட்டுககயைப ந்ோல 

DVD- களும் நலசர மூலம் ்டிகக முடிகின்்றது. 

 இவவயக வட்டு ஒன்று அலலது இரணடு 

்ககஙகயைக ்கோணடு, நமலும் ஒரு ்ககத்திறகு 

ஒன்று அலலது இரணடு அடுககுகளில இருககும். 

அய்த ் ்ோறுத்ந்த DVD யின் ் மோத்்த ் கோள்ைைவு 

கணககிடப்டுகி்றது. இரு அடுககு DVD ்தஙக 

நி்றத்திலும் ஒரு அடுககு உள்ை DVD ்வள்ளி 

நி்றத்திலும் கியடககும்.
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்டம்  3.10 டிஜிட்டல ்வரசயடல வட்டு

3.6.4 ஃபிைோஷ் நியனவக சோ்தனஙகள் (Flash 
Memory Devices)

 ஃபிைோஷ் நியனவகம் ஒரு மின்னனு (திட 
நியல) அழிவு்றோ்த நசமிககும் சோ்தனமோகும். 
நமலும் மின்சோரத்தின் மூலம்  நிரலகயை அழித்து, 
மறு்டியும் நிரலோகக முடியும். ஃபிைோஷ் நியனவகம் 
ஒரு EEPROM அலலது EPROM வயகப்டும். 
்்ன் டியரவ (Pen drive), ்மமரி கோரடு (Memory 
card) ந்ோன்்றயவ ஃபிைோஷ் நியனவகத்திறகோன 
எடுத்துககோட்டுகைோகும்.  ்தனிைோள் கணிப்்ோறி 
(Personal Computer), ்தன்னுயட இலகக வயக  
உ்தவிைோைர (Personal Digital Assistant), 
டிஜிட்டல ஆடிநைோ பிநைைரகள், டிஜிட்டல நகமிரோ, 
யகைடகக ்்தோயலந்சிகள் (்மோய்ல 
்்தோயலந்சி) ந்ோன்்றவறறில இவவயக ஃபிைோஷ் 
நியனவகம் உ்நைோகிககப்டுகி்றது. ஃபிைோஷ் 
நியனவகம் நவகமோக அணுகல ந�ரத்ய்த 
வழஙகுகி்றது.நியனவகத்தில ஒரு எழுத்துருயவ 
்டிகக அலலது எழு்த ்ைன்்டும் ந�ரத்ய்த 
அணுகல ந�ரம் எனப்டும். 

 ஃபிைோஷ் நியனவகம் ்கோள்ைைவு 1 ஜிகோ 

ய்ட்ஸ் (GB) – யிலிருநது 2 ்டரோ ய்ட்ஸ் (TB) 
வயரயில கியடககும். ்டம் 3.11–ல ஃபிைோஷ் 

நியனவகத்தின் ஒரு மோதிரியைக கோணலோம்.

்டம்  3.11 ஃபிைோஷ் நியனவகம்

3.6.5 பளு - நர வட்டு (Blu – Ray Disc)
 பளு-நர வட்டு அதிக அடரத்திைோன 

கணணோடி இயழ வட்டு வடிவயமபபு ்்ற்ற DVD-
யை ஒத்்த்தோகும். பளுநர வட்டு ்்ரும்்ோலும் 

வியைைோட்டு ்மன்்்ோருட்கயை, உைர வயரைய்ற 

தியரப்டஙகயைச் நசமிககவும் 

்ைன்்டுத்்தப்டுகி்றது. ஒரு இரணடு அடுககு பளு-

நர வட்டில 50 GB வயர ்தரவுகயைச் நசமிககலோம்.  

DVDயில ்தரயவ நசமிப்்தறகு மறறும் ் டிப்்தறகு 

சிகபபு நலசர ்ைன்்டுத்்தப்டுகி்றது. ஆனோல 

பளு-நர பளு யவயலட் நலசர – யைத் ்தரயவ 

எழுதுவ்தறகு ்ைன்்டுத்துவ்தோல பளு-நர என்று 

்்ைர ்்ற்றது.

்டம் 3.12 பளு-நர வட்டு 

3.7 ்்தோடரபு முகம் (Ports) மறறும் 
இயடமுகம் (Interface)

 ்டம் 3.13-ல கோட்டப்ட்டுள்ைது ந்ோல 

ஒரு கணிப்்ோறியின் "ம்தரந்ோரடு"யின் (Mother 
Board) பின்பு்றத்தில  ்்தோடரபு முகம் மறறும் 

இயடமுகஙகயை இயணப்்தறகு I/O 
துயைகள் உள்ைன. கணிப்்ோறியுடன் 

்வளிககருவிகயை இயணப்்தறகு ்தனித்்தனி 

்்தோடரபு முகமும், இயடமுகஙகளும் உள்ைன. 

்ல வயகைோன ்்தோடரபு முகஙகள் கீநழக  

்கோடுககப்ட்டுள்ைன. 

 ்்தோடர ்்தோடரபு முகம் (Serial Port)– 

்யழை கணினிகளில ்வளிககருவிகயை  

இயணப்்தறகு  ்ைன்்டுத்்தப்ட்டது.

 இயணைோன ்்தோடரபு முகம் (Parallel 
Port) – ்யழை கணினிகளில அச்சுப்்ோறியை 

இயணப்்தறகு ்ைன்்டுத்்தப்ட்டது.

 USB ்்தோடரபு முகம் – நகமரோககள், 

ஸ்நகனரகள் , ் மோய்லகள், ் வளிபபு்ற வன்்தட்டு  

மறறும் அச்சுப ்்ோறிப ந்ோன்்ற ்வளிபபு்ற 

கருவிகயை இயணப்்தறகு 

்ைன்்டுத்்தப்டுகி்றது.
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 VGA  இயணப்ோன்: LCD பு்ரோ்ஜகடர 
அலலது கோட்சி தியரயைக கணினியுடன் 
இயணப்்தறகு ்ைன்்டும். 
 ஆடிநைோ பிைகஸ் (Audio Plugs): 
கணினியுடன் ஒலி்்ருககி, யமகநரோ ஃந்ோன் 
மறறும் ்ெட் ந்ோன்கள் (Head phones) 
இயணப்்தறகு ்ைன்்டுகி்றது.
 PS/2 Port: சுட்டி மறறும்  
வியசப்லயகயைக கணினியுடன் 
இயணப்்தறகுப ்ைன்்டுகி்றது.
 SCSI Port: வன்வட்டு, பியணை 
இயணபபிகள் கணினியுடன் இயணப்்தறகுப 
்ைன்்டுத்்தப்டுகி்றது.

்டம் 3.13 USB 3.0 ்்தோடரமுகஙகள் 

Mouse Port

Keyboard Port

VGA
Port

HDMI Port

USB Port
Network Port

Serial
Port Power Supply

்டம் 3.14 ்்தோடரபு முகஙகள் மறறும் 

இயடமுகஙகள்

உைர வயரைய்ற ்லலூடக இயடமுகம் 
(HDMI)
 உைர வயரைய்ற ்லலூடக என்றும் 
இயடமுகம் ஒலி / ஒளி இயடமுகம் சுருககப்டோ்த 
ஒலி மறறும் ஒளி ்தரவுகயைக கணிப்்ோறி 
தியரைகம்,  LCD பு்ரோஜகடர, டிஜிட்டல 
்்தோயலககோட்சி ஆகிைவறறிககு ்கோடுககப 
்ைன்்டுகின்்றது

Micro HDMI HDMI

 ்டம்  3.15 HDMI ்்தோடரபு முகஙகள் 

மோணவர ்சைல்ோடுகள்

• கணினியில உள்ை ்லநவறு ்்தோடர 

முகஙகயையும் அவறறின் ்ைன்கயையும் 

கோணபித்து விைககவும்.

• கணினியின் ் ல ் ோகஙகயைக  கணடறிைவும்.

• ்வளிபபு்றச் சோ்தனஙகயை 

கணிப்்ோறியுடன் எவவோறு இயணகக 

நவணடும் என்்ய்த ்்தரிநதுக ்கோள்ை 

நவணடும். உ்தோரணமோக அச்சுப்்ோறி 

அலலது LCD பு்ரோஜகடர.

ஆசிரிைர ்சைல்ோடுகள்

• கணினியின் ்ோகஙகயைக கோணபிகக 

நவணடும்.

• ்ல வயகைோன ROM சுறறுகயைக 

கோணபிகக நவணடும்.

• ஃபிைோஷ் நியனவகஙகயை 

மோணவரகளுககுக கோணபிகக நவணடும்.

மதிப்ோய்வு

்குதி – அ
சரிைோன வியடயைத் 
ந்தரந்்தடுககவும்
1.  பின்வருவனறறுள் எது 

க ணி ப ் ் ோ றி யி ன் 
மூயை என 
அயழககப்டுகி்றது? 

 (அ) உள்ளீட்டுச் சோ்தனஙகள்
 (ஆ) ்வளியீட்டுச் சோ்தனஙகள்
 (இ) நியனவக சோ்தனஙகள்
 (ஈ) நுண்சைலி

2.  பின்வருவனறறுள் எது நுண்சைலியின் 
்ோகம் அலல?

 (அ) கணி்த ஏரணச்்சைலகம்  
 (ஆ) கட்டுப்ோட்டகம்  
 (இ) நகச் நியனவகம்
 (ஈ) ்திநவடு

3.  எத்்தயன பிட்டுகள் ஒரு நவரயட 
கட்டயமககும்?

 (அ) 8 
 (ஆ) 16
 (இ) 32 
 (ஈ)  ் ைன்்டுத்்தப்டும் ்சைலியைப 

்்ோருத்்தது
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4.	� பின்வரும் எந்த சாதனம், நினைவக 
முகவரி பதிவேட்டில் முகவரியைக் 
குறிக்கும் ப�ோது அதன்  		
இருப்பிடத்தை அடையாளம் காட்டும் ?   

	 (அ) ல�ொகேட்டர் (Locator)
	 (ஆ) என்கோடர் (Encoder) 
	 (இ) டிக�ோடர் (Decoder)
	 (ஈ) மல்டி ஃபிளக்சர் (Multiplexer)
5.	� பின்வருவனற்றுள் எது ஒரு CISC செயலி 

ஆகும்?
	 (அ) Intel P6		  (ஆ) AMD K6 
 	 (இ) Pentium III 	 (ஈ) Pentium IV
6.	� எது வேகமாக செயல்படும் நினைவகம் 

ஆகும்?
	 (அ) வன் வட்டு 
	 (ஆ) முதன்மை நினைவகம்
	 (இ) கேச் நினைவகம்
	 (ஈ) புளு- ரே நினைவகம்
7.	� ஒரு 8 – பிட் நினைவக பாட்டை உள்ள 

செயலி எத்தனை நினைவக இடங்களை 
அடையாளம் 			   காணும்?

	 (அ) 28  		  (ஆ) 1024 
	 (இ) 256  		  (ஈ) 8000
8.	� ஒற்றை பக்க மற்றும் ஒற்றை அடுக்கு  12 

செ.மீ விட்டம் உள்ள DVD-யின் ம�ொத்த 
க�ொள்ளளவு 			   எவ்வளவு?

	 (அ) 4.7 GB		  (ஆ) 5.5 GB
	 (இ) 7.8GB		  (ஈ) 2.2 GB	
9.	� CD யின் குறைந்த அளவிலான தரவின் 

அளவு யாது ?
	 (அ) த�ொகுதி		  (ஆ) பகுதி 
	 (இ) பிட்ஸ்		  (ஈ) தடங்கள்
10.	� கணிப்பொறியின் திரைச்சாதனத்தை 

இணைக்க உதவும் த�ொடர்பு சாதனம் 
எது?

	 (அ) USB 		  (ஆ) Ps/2
	 (இ) SCSI		  (ஈ) VGA 

பகுதி – ஆ
குறு வினா:
(1)	� ஒரு நுண்செயலின் பண்புகளைக் 

குறிக்கும் காரணிகள் யாவை?
(2)	 அறிவுறுத்தல் என்றால் என்ன?
(3)	 நிரல் கவுண்ட்டர் என்றால் என்ன?
(4)	� உயர் வரையரை பல்லூடக இடைமுகம் 

(HDMI )என்றால் என்ன?
(5)	� EPROM- உள்ள தரவை எவ்வாறு 

அழிப்பாய்? 

பகுதி – இ
சிறு வினா:
(1)	� கணிப்பொறி  அமைப்பு, கணிப்பொறி  

கட்டமைப்பு வேறுபடுத்துக.
(2)	�த ரவின் அளவைப் ப�ொருத்து 

நுண்செயலியை வகைப்படுத்துக.
(3)	� கட்டளையின் த�ொகுதியின் அடிப்படையில் 

நுண்செயலியின் வகைகளை எழுதுக.
(4)	  PROM மற்றும்  EPROM  வேறுபடுத்துக.
(5)	� கணிப்பொறியில் பயன்படுத்தப்படும் 

இடைமுகம்  மற்றம் த�ொடர்புமுகங்களை 
எழுதுக.

(6)	 CD மற்றும் DVD வேறுபடுத்துக.
(7)	� ஃபிளாஷ் நினைவகம் மற்றம் EEPROM 

எவ்வாறு வேறுபடுத்துவாய்?

பகுதி – ஈ
நெடு வினா:
(1)	� நுண்செயலியின் பண்பு கூறுகளை 

விளக்குக.
(2)	�ப டித்தல் / எழுதுதல் (READ / WRITE) 

செயல்களை செயலி எவ்வாறு செய்கிறது? 
விளக்குக.

(3)	� இயக்க  நேரத்தின் அடிப்படையில் 
நினைவக சாதனங்களை ஏறுவரிசையில் 
அமைக்கவும்.

(4)	� ROM ன் வகைகளைப் பற்றி விளக்கமாக 
எழுதுக.
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ச�ொற்களஞ்சியம்

கணினி  வன்பொருள்
கணினி வன்பொருள் ப�ோன்ற CPU, தாய் பலகை, திரைசாதனம், 

விசைப்பலகை ப�ோன்றவை

Intel

Intel Corporation என்றும் அமெரிக்க நிறுவனம் கணினி வன்பொருள் 

உற்பத்திச் செய்யும் நிறுவனம் ஆகும். முக்கியமாக தாய் பலகை மற்றும் 

செயலிகளை உற்பத்தி செய்யும் அமெரிக்க நிறுவனம் ஆகும்.

Silicon Chip Silicon chip என்பது ஒரு ஒருங்கிணைந்த சுற்று ஆகும்.

பற்பல உபய�ோகம்
நுண்செயலியானது ஒரு நிரலாக்கம் செய்யக்கூடிய, பற்பல 

உபய�ோகத்திற்கான ஒரு சிலிகான் சிப்பாகும்.

முகவர் பாட்டை
முகவரி பாட்டை முகவரியை BITS- ஆக எடுத்துச் செல்லும் கம்பிகளின் 

த�ொகுப்பு ஆகும்.

தரவுப்பாட்டை
தரவுப்பாட்டை தரவுகளை எடுத்துச் செல்லும் கம்பிகளின் த�ொகுப்பு 

ஆகும்.

கட்டுப்பாட்டு பாட்டை
கட்டுப்பாட்டுப்பாட்டை என்பது கம்பிகளின் த�ொகுதி ஒரே ஒரு 

கட்டுப்பாட்டை அதாவது படித்தல் / எழுதுதல் வேலையைச் செய்யும்

கணித செயல்பாடுகள்
கணித செயல்பாடுகள் என்பது கூட்டல் கழித்தல் ப�ோன்ற 

செயல்பாடுகளை செய்யும் செயலாகும்.

தரவு பரிமாற்றம்
தரவு பரிமாற்றம் என்பது தரவை ஒரு சாதனத்திலிருந்து மற்றொரு 

சாதனத்திற்கு செல்வதாகும்.

ஏரணச் செயல்பாடுகள்
ஏரண செயல்பாடுகள் என்பது ஏரணச் செயல்பாடுகளை AND, OR, NOT 

செயல்பாடுகள் ஆகும்.

இருவழி இருவழி என்பது தரவுகளை இரு திசைகளிலும் க�ொண்டு செல்லும்

ஒரு வழி ஒரு வழி என்பது தரவுகளை ஒரே ஒரு திசையில் க�ொண்டு செல்லும்.

அணுகல் நேரம் எழுத மற்றும் படிக்க எடுத்துக் க�ொள்ளும் நேரம் ஆகும்.
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இயக்க அமைப்பின் க�ோட்பாட்டு கருத்துக்கள்

கற்றலின் ந�ோக்கங்கள்

•	 இயக்க அமைப்பின் கருத்துரு மற்றும் அதன் 

வகைகளைப் பற்றி அறிந்துக�ொள்ளுதல்.

•	 இயக்க அமைப்பின் அடிப்படை அறிவு மற்றும் 

அதன் செயல்பாடுகளை அறிந்து க�ொள்ளுதல்.

4.1  மென்பொருள் ஒர் அறிமுகம்

	 மென்பொருள் என்பது கணிப்பொறியில் 

ஒரு குறிப்பிட்ட பணியைச் செய்வதற்கான 

கட்டளைகளின் த�ொகுப்பாகும். அடிப்படை 

வன்பொருள்களுடன் செயல்பட்டு இது 

தேவையான வெளியீடுகளைத் தருகின்றது.

4.1.1	 மென்பொருள் வகைகள்

மென்பொருள் இரண்டு வகைகளாகப் 

பிரிக்கப்படுகிறது:

1) பயன்பாட்டு மென்பொருள் (Application 
Software)

2) அமைப்பு மென்பொருள் (System Software)

பயன்பாட்டு மென்பொருள்

	 பயன்பாட்டு மென்பொருள் ஒரு குறிப்பிட்ட 

பணியைச்  செய்வதற்கு தேவையான நிரல்களின் 

த�ொகுப்பாகும். எடுத்துக்காட்டாக, எம்.எஸ், 

வேர்டு (MS-word) என்பது உரை ஆவணங்களை 

(text document) உருவாக்க பயன்படும் ஒரு 

பயன்பாட்டு மென்பொருள் (application 
software) ஆகும். VLC பிளேயர் என்பது ஒரு 

பிரபலமான ஒலி, ஒளிக் காட்சிகள் மற்றும் பல 

க�ோப்புகளைத் திரையிடப் பயன்படும் ஒரு  

பயன்பாட்டு மென்பொருள் ஆகும்.  

அமைப்பு மென்பொருள்:

	 அமைப்பு மென்பொருள் என்பது 

வன்பொருள்கள் மற்றும் பயன்பாட்டு 

மென்பொருள்களை இயக்குவதற்கு 

வடிவமைக்கப்பட்ட ஒரு கணிப்பொறி நிரலாகும். 

இயக்க அமைப்பு (Operating System) மற்றும் 

நிரல் பெயர்ப்பி (Language Processor) ப�ோன்றவை 

அமைப்பு மென்பொருளுக்கு எடுத்துக்காட்டாகும்.

4.2  இயக்க அமைப்பு ஓர் அறிமுகம்

	 இயக்க அமைப்பு என்பது 

கணிப்பொறிக்கும், பயனருக்கும் இடைமுகமாக 

செயல்படும் ஒரு அமைப்பு மென்பொருள் ஆகும். 

	 இது உள்ளீடு, வெளியீடு மற்றும் 

கணிப்பொறி வெளிப்புற சாதனங்களாகிய வட்டு 

இயக்கி (Disk Drive), அச்சுப்பொறி (Printer) 
மற்றும் பிற மின்னணு சாதனங்களைக் 

கட்டுப்படுத்துகிறது. க�ோப்பு மேலாண்மை (File 
Management), நினைவக மேலாண்மை (Memory 
Management), செயலாக்க மேலாண்மை (Process 
Management) மற்றும் சாதன  மேலாண்மை(Device 
Management) ப�ோன்றவை இயக்க அமைப்பின் 

செயல்பாடுகள் ஆகும்.

	 இயக்க அமைப்பு இல்லாமல் ஒரு 
கணிப்பொறி அதன் வளங்களைத் திறம்பட 
நிர்வகிக்க இயலாது. ஒரு கணிப்பொறி  
இயங்க துவங்கும்போது, அதன் இயக்க 
அமைப்பு தானாகவே நினைவகத்திற்கு 
ஏற்றப்படும். இயக்க அமைப்பு ஏற்றப்படாமல் 
ஒரு பயனர் நேரடியாக, கணிப�ொறியின்  
வன்பொருட்களுடன் த�ொடர்புக�ொள்ள 

பாடம் 4கணினி அறிமுகம்அலகு I 
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இயலோது.

இயக்க
அமைப்பு

வன்வடடு

அச்சுப்க்ோறி விமெப்்லம்க

சுடடி

திமரய்கம்

்யன்்ோடு

்ைம்: 4.1 இயக்க அமைப்பு

 விண்கைோஸ், யுனிகஸ் ைறறும் லினகஸ் 

க்ோன்்றமவ தனி்�்ர் ்கணிப்க்ோறி்கள் ைறறும் 

ைடிக்கணினி்களில் ்யன்்டுத்தப்்டும் 

பிர்லைோன இயக்க அமைப்பு்கைோகும். ம்கப்க்சி 

ெோதனங்களில் க்ரும்்ோலும்  ஆண்டிரோயடு 

(Android) ைறறும் iOS இயக்க அமைப்பு்கள் 

்யன்்டுத்தப்்டுகி்றது.
்யன்்ோடடு 

கைன்க்ோருள்

அமைப்பு 
கைன்க்ோருள்

வன்க்ோருள்

்யனர்

்ைம்: 4.2 இயக்க அமைப்பு ைறறும் ்யனர் 

ஊைோடுதல்

 இயக்க அமைப்பு ஒரு 
கைோழிக்யர்ப்பியோ்க கெயல்்டடு, ்யனர் 
எழுதும் நிரமல ்கணிப்க்ோறி 
புரிந்துக்கோள்ளும் இயந்திர கைோழியோ்க 
(இருநிமல கைோழி) ைோறறி கெயலோக்கம் 
கெயது, இயக்க அமைப்பிறகு மீண்டும் 
திருப்பி அனுப்புகி்றது. இயக்க அமைப்பு, 
கெயலோக்கம் கெயத த்கவல்்கமைப் ்யனர் 
்டிக்கககூடிய வடிவில் ைோறறியமைககி்றது.

இயக்க அமைப்பின் ்யன்்கள்

இயக்க அமைப்பின் சில முககிய ்யன்்ோடு்கள்:

• ்கணிப்க்ோறிமயப்  ்யன்்டுத்தி ்யனர் 

கெயய விரும்புவமத உறுதிப்்டுத்துதல்.

• ்யனர் ைறறும் ்கணிப்க்ோறி இமையிலோன 

எளிய ஊைோடுதல்.

• ்கணிப்க்ோறியில் மின் இமணப்பு  

க்கோடுக்கப்்்டை உைன் ்கணிப்க்ோறி 

தோனோ்ககவ கெயல்்ோடமைத் கதோைஙகுதல் 

(்கணிப்க்ோறி இயககுதல் - Booting)

• உள்ளீடு ைறறும் கவளியீடு ெோதனங்கமைக 

்கடடுப்்டுத்துதல்

• முதன்மை நிமனவ்கத்தின் ்யன்்ோடமை 

நிர்வகித்தல்

• ்யனர் நிரல்்களுககு ்ோது்கோப்பு வைஙகுதல்.

4.3  இயக்க அமைப்பின் வம்க்கள்

 கெயலோக்க தி்றன்்கமைப் க்ோருத்து 

இயக்க அமைப்பு்கள் பின்வரும் வம்க்கைோ்கப் 

பிரிக்கப்்டுகின்்றன.

4.3.1 ஒறம்றப் ்யனர் இயக்க அமைப்பு

 இந்த வம்க இயக்க அமைப்பு, ஒரு 
க�ரத்தில், ஒரு  ்யனமர,  ஒகர ஒரு ்ணிமய 
ைடடுகை கெயய அனுைதிககி்றது. எனகவ, இது 
"ஒறம்றப் ்யனர் ைறறும் ஒறம்றப் ்ணி இயக்க 
அமைப்பு" என அமைக்கப்்டுகி்றது.  MS-DOS  
என்்து ஒறம்ற ்யனர் ைறறும் ஒறம்ற  ்ணி 
இயக்க அமைப்புககு ஒரு எடுத்துக்கோடடு அகும்.

4.3.2 ்ல ்யனர் இயக்க அமைப்பு

 ஒகர க�ரத்தில் ஒன்றுககும் கைற்டை 
்யனர்்கள், ஒகர ைோதிரியோன   தரவு்கமையும் 
்யன்்ோடு்கமையும் ்கணிப்க்ோறியில் 
்யன்்டுத்த அனுைதிககும் இயக்க அமைப்பு 
“்ல ்யனர் இயக்க அமைப்பு” எனப்்டும். 
இந்த இயக்க அமைப்பில், ்யனர்்கள் 
ஒருவருகக்கோருவர் கதோைர்பு க்கோள்ை முடியும். 
விண்கைோஸ், லினகஸ் ைறறும் யுனிகஸ் 
க்ோன்்றமவ ்ல ்யனர் இயக்க அமைப்புககு 
எடுத்துக்கோடடு்கள் ஆகும்.
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4.4	 இயக்க அமைப்பின் முக்கிய 
சிறப்பியல்புகள்

பயனர் 

இடைமுகம்

நி
னை


வ

க
 

மே


ல
ாண்மை




பிழைப்

 ப�ொறுப்பு

இயக்க 
அமைப்பின் 

முக்கிய 
அம்சங்கள்

க�ோப்பு 

மேலாண்மை


செயல்
 

மேல
ாண்மை




பா
து

கா
ப்

பு 
மே

ல
ாண்மை




படம் 4.3 இயக்க அமைப்பின் முக்கிய 

சிறப்பியல்புகள்

பல்வேறு முக்கிய சிறப்பியல்புகள் கீழே 

க�ொடுக்கப்பட்டுள்ளன.

4.4.1	 பயனர் இடைமுகம்

	 பயனர் இடைமுகம், இயக்க அமைப்பில் 
குறிப்பிடத்தக்க சிறப்பியல்புகளில்  ஒன்றாகும். 
பயனர் கணிப்பொறியுடன் ஊடாட இதுவே சிறந்த 
வழிமுறையாகும். இதுவே "வரைகலை பயனர் 
இடைமுக” (Graphical User Interface – GUI) 
அடிப்படையிலான  இயக்க அமைப்புகளின் 
வெற்றிக்கு முக்கிய காரணமாகும். "வரைகலை 
பயனர் இடைமுகம்” (GUI) சன்னல் திரை 
அடிப்படையிலான, நேரடியாக உள்ளீட்டு / 
வெளியீடுகளை கையாள்வதற்கும், 
பட்டிகளிலிருந்து தேர்வு செய்வதற்கும், 
தேர்ந்தெடுப்பதற்கு தேவையான சுட்டும் 
கருவிகளைக் (Pointing devices) க�ொண்டது. 
மேலும், உரைகளை உள்ளிட விசைப்பலகை 
பயன்படுத்தப்படுகிறது. "வரைகலை பயனர் 
இடைமுகத்தின்” கவரும் வண்ணங்கள், பயனரை 
எளிதாக ஈர்க்கின்றது.

	 தற்போது, லினக்ஸ் இயக்க அமைப்பும் 

"வரைகலை பயனர் இடைமுக” வசதியுடன் 

கிடைக்கிறது.  ஒரு பயன்பாட்டிற்கான 

இடைமுகத்தை வடிவமைக்கும் ப�ோது, கவனத்தில் 

க�ொள்ள வேண்டியவை பின்வருமாறு:

1.	 பயனர் இடைமுகமானது,  இந்த அனுபவத்தை 

நீண்ட காலத்திற்கு பயன்படுத்துவதற்கு 

பயனருக்கு உதவுகிறது. 

2.	 இடைமுகம் பயனரின்  தேவைகளைத் திருப்தி 

செய்ய வேண்டும்.

3.	 பயனர் இடைமுகமானது, பயனரின் 

விலைமதிப்பற்ற நேரத்தை சேமிக்கிறது. 

வரைகலை கூறுகளான பட்டிகள், சன்னல் 

திரைகள், தத்தல், பணிக்குறிகள் மற்றும் 

தட்டச்சு செய்யும் வேலையைக் குறைத்தல் 

ப�ோன்றவை இயக்க அமைப்பின் கூடுதல் 

பயனாகும்.

4.	 எந்தவ�ொரு தயாரிப்பின் உயரிய  ந�ோக்கமும், 

வாடிக்கையாளரைத் திருப்திப்படுத்த வேண்டும் 

என்பதாகும். அதே ப�ோல், பயனர் இடைமுகும் 

வாடிக்கையாளரைத் திருப்திப்படுத்துமாறு 

வடிவமைக்கப்பட வேண்டும்

5.	 பயனர் செய்யும் தவறுகளை இடைமுகம் 

குறைக்க வேண்டும். அதே ப�ோல் பயனர் 

குறைந்த பயிற்சியிலும், தவறுகளைத் 

தவிர்க்கும் வண்ணம்  இருத்தல் வேண்டும். 

4.4.2	 நினைவக மேலாண்மை

	 நினைவக மேலாண்மை என்பது 

கணிப்பொறியின் முதன்மை நினைவகத்தைக் 

கட்டுப்படுத்தவும் மேலும் ஒருங்கிணைக்கவும்,  

கணிப்பொறியின் ஒட்டும�ொத்த செயல்திறனை 

மேம்படுத்துவதற்காக, பல்வேறு இயங்கும் 

நிரல்களுக்கு நினைவக த�ொகுதிக்குள் இடம் 

ஒதுக்கும் செயல்முறை ஆகும். பயனரின் 

தேவைக்கேற்ப, குறிப்பிட்ட நிரல்களுக்கு 

நினைவகத் த�ொகுதிக்குள்  தேவையான இடத்தை 

ஒதுக்கீடு செய்யும் செயல்முறையில் நினைவக 

மேலாண்மை ஈடுபடுகிறது. எல்லா நேரங்களிலும் 

இயங்கும் ஒவ்வொரு பயன்பாட்டு நிரல்களுக்கும் 

தேவையான நினைவகம் ஒதுக்கீடு செய்வதை 

நினைவக மேலாண்மை உறுதி செய்கிறது.

	 மையச்  செயலகத்தின் பயன்பாட்டை  

மேம்படுத்துவதும், முதன்மை நினைவகத்தின் 

வழியாக கணிப்பொறியின் வேகத்தையும் 

அதிகப்படுத்துவது ஆகிய இரண்டும் நினைவக 

மேலாண்மையின் ந�ோக்கங்கள் ஆகும். இதன் 
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காரணமாக பல்வேறு வகையான நினைவக 

மேலாண்மைத் திட்டங்களுடன் த�ொடர்புடைய 

நிரல்களை முதன்மை நினைவகத்தில் 

வைத்திருக்கிறது.

	 இயக்க அமைப்புகள் கீழ்க்காணும் 

நினைவக மேலாண்மையுடன் த�ொடர்புடைய 

செயல்களுக்கு ப�ொறுப்பாகும்: 

•	 நினைவகத்தின் எந்த  பகுதியைத் தற்போது 

யார் பயன்படுத்துகிறார்கள் என்று த�ொடர்ந்து 

கண்காணித்தல்.

•	 நினைவகத்திற்கு உள்ளேயும், வெளியேயும் 

நகரும் செயல்முறைகள் மற்றும் தரவுகளைத் 

தீர்மானித்தல்.

•	 முதன்மை நினைவகத்தில், நிரல்களுக்கு 

தேவையான நினைவகத் த�ொகுதிகளை 

ஒதுக்கிடுதல் மற்றும் நீக்கம் செய்தல். (பயனற்ற 

தரவுகளின் த�ொகுப்பு) 

4.4.3.செயல் மேலாண்மை (Process Management)

	 ஒரு செயல்முறையை உருவாக்குதல், 

நீக்குதல் மற்றும் அவை ஒன்றோட�ொன்று த�ொடர்பு 

க�ொண்டு ஒத்திசைவாக செயல்பட தேவையான 

வழிமுறைகளை வகுத்தல் ஆகிய செயல்களை 

உள்ளடக்கியது “செயல் மேலாண்மை” எனப்படும்.

	 "செயல்முறை” என்பது கணிப்பொறி 

செயலாக்க பணியின் ஒரு அலகு (நிரல்) ஆகும். 

ஒரு கணிப்பொறியில் தனிப்பட்ட பயனரால் 

இயக்கப்படும் ச�ொற்செயலி நிரலானது 

"செயல்முறை" ஆகும். ஒரு வெளியீட்டைத் 

திரையில் த�ோன்ற செய்வது அல்லது 

அச்சிடுவதற்காக அச்சுப்பொறிக்கு அனுப்புவது 

ப�ோன்ற கணிப்பொறி செயலாக்க பணிகளும் 

“செயல்முறை” என்றே அழைக்கப்படுகிறது.

	 ஒரு கணிப்பொறி செயல்முறைகளின் 

த�ொகுப்பை க�ொண்டுள்ளது. செயல்முறைகள் 

இரண்டு வகைப்படும். 

1.	 இயக்க அமைப்பு செயல்முறை, அமைப்பு 

குறியீடாக இயக்கப்படும்

2.	ப யனர் செயல்முறை இது பயனர் குறியீடாக 

இயக்கப்படும்.

	 இந்த செயல்முறைகள் அனைத்தையும் 

ஒரு மையச் செயலகத்தில், ஒரே நேரத்தில் 

செயல்படுத்த முடியும். 

	 ஒரு கணிப்பொறியின் செயலகத்திற்குத்  

தேவையான செயல்முறைகளை ஒதுக்கீடு 

செய்வதற்கு கீழ்க்காணும் நெறிமுறைகள் 

(Algorithms) முதன்மையாகப் 

பின்பற்றப்படுகின்றது. 

1.	 முதலில் வந்தது முதலில் செல்லும் (FIFO)

2.	 சிறியது முதலில் (Shortest Job First)

3.	 வட்ட வரிசை (Round Robin)

4.	 முன்னுரிமைக்கு ஏற்ப (Based on Priority)

முதலில் வந்தது முதலில் செல்லும் (FIFO -  
First In First Out):
	 முதலில் வந்தது முதலில் செல்லும் 

நெறிமுறை என்பது வரிசை நுட்பத்தை (Queuing 
Technique) அடிப்படையாகக் க�ொண்டது. ஒரு 

சேவையைப் பெற நாம் வரிசையில் நிற்கிற�ோம். 

முதலில் வந்தவர் முதலில் சேவையைப் பெறுகிறார். 

மதிப்பெண் பட்டியலை ஆசிரியர் வழங்குவதற்காக 

மாணவர்கள் வரிசையில் நிற்பது ஒரு 

எடுத்துக்காட்டு ஆகும். வரிசையில் முதலில் 

நிற்கும் மாணவன் முதலில் மதிப்பெண் பட்டியலைப் 

பெற்றுக் க�ொண்டு வரிசையிலிருந்து 

வெளியேறுகிறான். இதுவே "முதலில் வந்தது 

முதலில் செல்லும்” நெறிமுறையின் அடிப்படை 

வழிமுறை.

	 நுட்ப ரீதியாக, வரிசையில் முதலில் 

நுழையும்  செயல்முறை முதலில் CPU-வில் 

செயல்படுத்தப்பட்டு ,அடுத்தடுத்து த�ொடர்கிறது. 

வரிசையின் அடிப்படையில்  செயல்முறைகள் 

செயல்படுத்தப்படுகின்றன.

சிறியது முதலில் (Shortest Job First)
	 இந்த நெறிமுறை, மையச் செயலகத்தால் 

இயக்கப்படும் ஒரு வேலையின் அளவை 

அடிப்படையாகக் க�ொண்டது.  A மற்றும் B என 

இரண்டு வேலைகளை எடுத்துக்கொள்வோம். 

	 இதில், A வேலையின் அளவு 6 கில�ோ 

பைட்டுகள் மற்றும் B வேலையின் அளவு 9 கில�ோ 

பைட்டுகளும் ஒதுக்கப்படுகிறது.

	 இந்த இரண்டு வேலைகளில், A 
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வேலையின் அளவு, B வேலையை விட குறைவாக 

இருப்பதால், முதலில் A வேலை இயக்கப்படும். 

வட்ட வரிசை திட்டமிடல் (Round Robin)
	 வட்ட வரிசை திட்டமிடல் “நேரப் பகிர்வு 

அமைப்பு”-களுக்கு (Time Sharing System) 

சிறப்பாக வடிவமைக்கப்பட்ட நெறிமுறை ஆகும்.  

சுழற்சி முறையில், ஒவ்வொரு பணிக்கும், ஒரு 

குறிப்பிட்ட நேரம் ஒதுக்கப்படும். எடுத்துக்காட்டாக, 

A, B, C என மூன்று வேலைகள் இருப்பதாக 

எடுத்துக்கொள்வோம். இதில், முதலாவது A 
பின்னர் B அதை த�ொடர்ந்து C என ஒவ்வொரு 

வேலைக்கும் ஒரு குறிப்பிட்ட நேரம் சுழற்சி 

முறையில் மையச் செயலகத்தால்   ஒதுக்கப்படும். 

மீண்டும் அடுத்த சுழற்சியில் வட்டவரிசை 

முறையில் வேலை ஒதுக்கீடு செய்யப்படும். 

முன்னுரிமைக்கு ஏற்ப (Based on Priority)

	 க�ொடுக்கப்பட்ட வேலை முன்னுரிமை 

அடிப்படையில் ஒதுக்கப்பட்டுள்ளது. மற்ற 

வேலைகளை விட அதிக முன்னுரிமை 

க�ொண்டிருக்கும் வேலை மிகவும் முக்கியமானது. 

இரண்டு வேலைகள் A மற்றும் B  என 

எடுத்துக்கொள்வோம். A-க்கு முன்னுரிமை  எண் 5 
எனவும், B-க்கு 7 எனவும் இருந்தால், முதலில் 

B-க்குதான் செயலகம் ஒதுக்கப்படும்.

4.4.4.	 பாதுகாப்பு மேலாண்மை

	 பயனரின் முறையான தரவுகளை 

மின்னணு தரவு திருடர்களிடமிருந்து பாதுகாப்பது 

முக்கிய சவாலாக உள்ளது. இயக்க அமைப்பு 

பயனருக்கு மூன்று நிலைப் பாதுகாப்பை 

வழங்குகிறது. 

1.	 க�ோப்பு நிலை

2. 	 அமைப்பு நிலை

3. 	 வலை நிலை

	 பிற பயனர்களால் உருவாக்கப்பட்ட 

க�ோப்புகளை நாம் அணுகுவதற்கு அதற்குரிய 

அனுமதியை பெற்றிருக்க வேண்டும். க�ோப்பினை 

உருவாக்கியவர் அல்லது கணிப்பொறி நிர்வாகி 

அனுமதியை வழங்கமுடியும்.

	 அமைப்பு நிலையில், ஒரு பயனர் குறிப்பிட்ட 

கடவுச்  ச�ொல்லைக்  க�ொடுத்தால�ொழிய கணிப் 

ப�ொறியைப் பயன்படுத்த இயலாது.விண்டோஸ், 

லினக்ஸ் ப�ோன்ற இயக்க அமைப்புகள் இத்தகைய 

வகையில் செயல்படுகின்றன.

	 வலை பாதுகாப்பு என்பது சற்று சிக்கலான 

விஷயம்.ஏனென்றால் உலகத்தின் எந்த மூலையில் 

இருந்தும் கணிப்பொறியை அணுகலாம். உரிய 

பாதுகாப்பு அளிக்க பலரும் முயற்சி  செய்து 

வருகின்றனர்.

4.4.5 பிழை ப�ொறுத்தல்:

	 இயக்க அமைப்பு வலுவான பிழை 

ப�ொறுத்தல் தன்மையுடன் இருக்க  வேண்டும். 

ஏதாவது ஒர் தவறு நேரும்போது, இயக்க அமைப்பு 

செயல் இழக்கக்கூடாது; மாறாக இயக்க அமைப்பு 

பிழைப�ொறுப்புத்திறன் க�ொண்டு இயல்பு நிலைக்கு 

மாற வேண்டும். 

4.4.6 க�ோப்பு மேலாண்மை

	 க�ோப்பு மேலாண்மை என்பது தரவுகளைச்  

சேமிக்கும் த�ொழில்நுட்பங்களைக் கையாளும் 

ஒரு முக்கிய செயல்பாடாகும். இயக்க அமைப்பு 

ஒரு கணினியில் க�ோப்புகள், க�ோப்புறைகள் 

மற்றும் அடைவு அமைப்புகள் ஆகியவற்றை 

நிர்வகிக்கிறது. ஒரு கணிப்பொறியில் உள்ள 

வெவ்வேறு தரவுகளை  க�ோப்பு ஒதுக்கீடு 

அட்டவணை (FAT) மூலம்  க�ோப்பு மற்றும் 

அடைவுகள் / க�ோப்புறைகள் வடிவத்தில் 

சேமிக்கப்படும்.க�ோப்புப்பெயர், வகை (உரை 

அல்லது பைனரி), அளவு, ஆரம்ப முகவரி மற்றும் 

அணுகல் பயன்முறை (த�ொடர் / குறியிடப்பட்ட / 

குறியிடப்பட்ட - தொடர்ச்சியாக / நேரடியாக / 

த�ொடர்புடையதாக) ப�ோன்ற க�ோப்பின் ப�ொது 

தகவல்கள்  FAT - ல் சேமிக்கப்படும். 

இயங்குதளத்தின் க�ோப்பு மேலாளர், க�ோப்புகளை 

உருவாக்க, திருத்த, நகலெடுக்க, க�ோப்புகளுக்கு 

நினைவகத்தை ஒதுக்க உதவுகிறது, மேலும் 

க�ோப்பு ஒதுக்கீடு அட்டவணை 

மேம்படுத்தப்படுகிறது. அடுத்த தலைமுறை க�ோப்பு 

முறைமை (NTFS) மற்றும் ext12 (லினக்ஸ்) 

ப�ோன்ற சில க�ோப்பு மேலாண்மை நுட்பங்களும் 

உள்ளன.
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4.4.7 பல செயலாக்க இயக்க அமைப்பு

	 இது இயக்க அமைப்பு அம்சங்களில் 

ஒன்றாகும். பல செயலாக்க செயல்முறை (வேலை) 

இரண்டு அல்லது அதற்கு மேற்பட்ட செயலிகளைக் 

க�ொண்டுள்ளது. செயலாக்கம் இணையாக 

செயல்படுவதால் இது இணையாக்க செயலி 

ஆகும். ஒவ்வொரு செயலாக்கமும் ஒரே வேலையில் 

வெவ்வேறு பகுதிகளில் அல்லது இரண்டு அல்லது 

அதற்கு மேற்பட்ட வெவ்வேறு பணிகளை 

செய்கிறது. பல செயல்கள் இணையாக 

நிறைவேற்றப்படுவதால், இந்த அம்சமானது 

அதிகபட்ச இயக்கத்திற்கு  பயன்படுத்தப்படுகிறது. 

இது கணினிப்பணியின் திறனை மேம்படுத்துகிறது. 

4.4.8 நேரப் பகிர்வு இயக்க அமைப்பு

	 இது இயக்க அமைப்பு அம்சங்களின் 

ஒன்றாகும். ஒரே நேரத்தில் பல பணிகளை 

அல்லது செயல்களைச் செயல்படுத்துகிறது.

ஒவ்வொரு பணிக்கும் ஒரு குறிப்பிட்ட நேரம் 

ஒதுக்கீடு செய்யப்படுகிறது. நேரத்தைப் பிரித்து 

செயல்படுவதால் இது நேரப் பகிர்வு என்று 

அழைக்கப்படுகிறது. ஒரு முறை நேரம் ஒதுக்கீடு 

அல்லது செயல்முறை நிறைவடைந்தவுடன்,  

செயலி பல்வேறு செயல்களுக்கு இடையில் 

விரைவாக மாறுகிறது.

உதாரணத்திற்கு

	 P1, P2, P3 என மூன்று செயல்முறைகள் 

உள்ளன என எடுத்துக்கொள்வோம். 

ஒவ்வொன்றிற்கும் ஒதுக்கப்படும் நேரம் முறையே 

30,40,50 நிமிடங்கள் ஆகும். செயல்முறை P1,  20 
நிமிடங்களில் முடிவடைந்தால், அடுத்த 

செயல்முறை P2ஐ செயலி எடுத்துக்கொள்கிறது. 

செயல்முறை P2வை  40 நிமிடங்களில் முடிக்க 

முடியவில்லை எனில், தற்போதைய செயல்முறை 

P2வை  இடைநிறுத்தம் செய்து அடுத்த செயல்முறை 

P3ஐ எடுத்துக்கொள்ளும்

4.4.9 பரவல் இயக்க அமைப்பு

	 டிஜிட்டல் இணையம் (இணைய தளம் / 

உள்வலை) வழியாக உலகெங்கிலும் பல 

இடங்களில் சேமிக்கப்பட்டு செயலாக்கப்பட்ட 

தரவுகள் மற்றும்  பயன்பாட்டுகளை இந்த அம்சம் 

கவனித்து க�ொள்கிறது.

	 பரவல் இயக்க அமைப்பின் நன்மைகள் 

பின்வருமாறு:

•	 ஒரே இடத்தில் உள்ள ஒரு பயனர், 

வலையமைப்பின் மூலம் மற்றொரு 

இடத்திலுள்ள   எல்லா வளங்களையும் 

பயன்படுத்தலாம்.

•	 	ப ல கணினி வளங்களை வலையமைப்பில் 

எளிதாக இணைக்க முடியும்

•	 	 வாடிக்கையாளர்களுடன்  உள்ள 

த�ொடர்புகளை மேம்படுத்துகிறது

•	 	 புரவலன்/புரவலர் (Host)  கணினியில் 

உள்ள சுமையைக் குறைக்கிறது

படம் 4.4 பரவல் இயக்க அமைப்பு

4.5 முக்கிய இயக்க அமைப்புகள்

முக்கிய இயக்க அமைப்புகள் பின்வருமாறு:

•	 யுனிக்ஸ்

•	 மைக்ரோசாஃப்ட் விண்டோஸ்

•	 லினக்ஸ்

•	 iOS
•	 ஆண்ட்ராய்டு

	ந வீன இயக்க அமைப்புகள் ஒரு 

வரைகலை பயனர் இடைமுகத்தை (GUI) 
பயன்படுத்துகின்றன. வரைகலை மற்றும் உரை 

கூறுகளைப் பயன்படுத்தி, பணிக்குறிகள், 

ப�ொத்தான்கள், பட்டியல்கள் மற்றும் 

எல்லாவற்றையும் தெளிவாக திரையில் 

காண்பிக்க GUI உதவுகிறது .

படம்: 4.13xiOS - ஐப�ோன் முகப்பு திரை
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கெயல்்ோடு

ைோணவர் கெயல்்ோடு

கெயல்்ோடு 1: இயக்க அமைப்பு முத்திமர (Logo) 

ைறறும் விைக்கத்மதயும் இமணக்க க்கோடு 

வமர்க.
ஒரு ்கடைமை வரி இயக்க 

அமைப்பு தி்றந்த மூல 

கைன்க்ோருள் கைம்்ோடடு ைறறும் 

இலவெ இயக்க 

அமைப்பிறக்கோன ஒரு 

எடுத்துக்கோடடு
ஆப்பிள் தயோரிப்பு்களுைன் 

இமணக்கப்்ைோத கைோம்ல் 

ஃக்ோன் கதோழில்நுட்த்திற்கோன 

பிர்லைோன இயக்க அமைப்பு

ஆப்பிள் ்கம்ப்யூடைர்்களுைன் 

்யன்்டுத்தியது ைறறும் கிைவுட 

்கம்ப்யூடடிங மூலம் �ன்்றோ்க 

கவமல கெயகி்றது 
ஆப்பிள் ஐக்ோன் ்யன்்ோடடிறகு  

வடிவமைக்கப்்டைது

்ல்்கமலக்கை்கங்கள், 

நிறுவனங்கள், க்ரிய 

நிறுவனங்கள் முதலியவறறில் 

மி்கவும் பிர்லைோ்க இயக்க 

அமைப்பு
தனிப்்டை ்கணினி்களுக்கோன 

மி்கவும் பிர்லைோன GUI இயக்க 

அமைப்பு.

கெயல்்ோடு 2: கீகை உள்ை க்கள்வி்களுக்கோன 

க்ோருத்தைோன ்தில்்கமை விவோதித்து தரவும்.

ஒரு இயக்க அமைப்பின் ்ல கெயல்்ோடு்களில் 

ஒன்று ்ல-்ணியோகும் 

1)  இயக்க அமைப்புப் ் ணி கதமவப்்டுவதற்கோன 

ஒரு ்கோரணத்மத விைககு்க

2)  ஒரு இயக்க அமைப்பின் இரண்டு கவறு 

கெயல்்ோடு்கமைக கூறு்க?

ைதிப்்ோயவு

்குதி - அ

ெரியோன விமைமயத் 

கதர்ந்கதடுக்கவும்

1) இயக்க அமைப்்ோனது 

------------------

 அ) ்யன்்ோடடு கைன்க்ோருள்  

 ஆ) வன்க்ோருள்

 இ) அமைப்பு கைன்க்ோருள்

 ஈ) உ்்கரணம்

2) இயக்க அமைப்பு்களின்  ்யன்்ோடமைக 

்கண்ைறியவும்

 அ) ைனித ைறறும் ்கணினி இமைகய எளிதோ்க 

கதோைர்பு

 ஆ) உள்ளீடு ைறறும் கவளியீடு ெோதனங்கள் 

்கடடுப்்டுத்தும்

 இ) முதன்மை நிமனவ்கத்மத கைலோண்மை 

கெயய

 ஈ) இமவ அமனத்தும்

3) பின்வரும் எது, இயக்க அமைப்பு கெயல்்ோடு 

அல்ல?

 அ) கெயல்மும்ற கைலோண்மை

 ஆ) நிமனவ்க கைலோண்மை

 இ) ்ோது்கோப்பு கைலோண்மை

 ஈ) நிரல் க்யர்ப்பி சூைல்

4) பின்வரும் எந்த இயக்க அமைப்பில் வணி்க 

ரீதியோ்க உரிைம் க்ற்ற இயக்க அமைப்பு 

ஆகும்?

 அ) விண்கைோஸ்   ஆ) உபுண்டு

 இ) க்கைோரோ   ஈ) கரடகஹட

5) பின்வரும் இயக்க அமைப்பு்களில் கைோம்ல் 

ெோதனங்கமை ஆதரிப்்து எது? 

 அ) விண்கைோஸ் 7   ஆ) லினகஸ்  

 இ) ்ோஸ்   ஈ) iOS 
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6)	 க�ோப்பு மேலாண்மை எவற்றை 

நிர்வகிக்கிறது ?

	 அ) கோப்புகள்

	 ஆ) கோப்புறைகள்    

	 இ) அடைவு அமைப்புகள் 

	 ஈ) இவை அனைத்தும்

7)	 ஊடாடு இயக்க அமைப்பு வழங்கும் வசதி.

	 அ) வரைகலை பயனர் இடைமுகம் (GUI)

	 ஆ) தரவு விநிய�ோகம்

	 இ) பாதுகாப்பு மேலாண்மை

	 ஈ) உண்மையான நேரம் செயலாக்க

8)	  ஒற்றை பயனர் இயக்க அமைப்பிற்கு 

எடுத்துய்க்கட்டு 

	 அ) லினக்ஸ்		  ஆ) விண்டோஸ்

	 இ) MS DOS		  ஈ) யுனிக்ஸ்

9) 	 லினக்ஸ் எந்த வகை க�ோப்பு 

மேலாண்மையை பயன்படுத்துகிறது

	 அ) ext2		  ஆ) NTFS 

	 இ) FAT	 	 ஈ) NFTS 

பகுதி – ஆ

குறு வினா:

1) 	 நினைவக  மேலாண்மையின் நன்மைகள் 

ஏதேனும் இரண்டை கூறு ?

2) 	ப ல பயனர் இயக்க அமைப்பு என்றால் 

என்ன?

3) 	 GUI என்றால் என்ன?

4) 	பா துகாப்பு மேலாண்மையின் நன்மைகள் 

யாவை?

5) 	ப ல் பணியாக்கம் என்றால் என்ன?

6) 	க ணிப்பொறியில் பயன்படுத்தப்படும் 

வெவ்வேறு இயக்க அமைப்புகள் யாவை?

பகுதி - இ

சிறு வினா:

1)	 நேரம் பகிர்தல் இயக்க அமைப்பின் 

நன்மைகள் மற்றும் தீமைகள் என்ன? 

2)	 இயக்க அமைப்பின் முக்கிய 

சிறப்பியல்புகளை பட்டியலிடுக.

3)	ப ல செயலாக்க இயக்க அமைப்பு சிறு 

குறிப்பு வரைக

பகுதி - ஈ

நெடு வினா:

1)	ப ரவல் இயக்க அமைப்பின் கருத்துரு பற்றி 

விளக்குக மேலும் அதன் பயன்பாடுகள் 

யாவை ?

2)	 ஒரு இயக்க முறைமைக்கான பயனர் 

இடைமுகத்தை உருவாக்கும்போது 

கவனத்தில் க�ொள்ள முக்கிய 

கருத்துக்களை  பட்டியலிடுக.

3)	 இயக்க அமைப்பின் செயல் மேலாண்மை 

நெறிமுறைகளை விளக்குக.

  நூற்பட்டியல்  

1)	 Silberschatz, Galvin Gagne, 
Operating System Concepts – John 
Wiley&Sons,inc

2)	 Andrew S. Tanenbaum, Modern 
Operating Systems – Pearson 
Publication

3)	 Andrew S. Tanenbaum , 
Operating Systems Design And 
Implementation, Prentice Hall 
Publication

4)	 Tom Anderson,Operating Systems: 
Principles And Practice, Recursive 
Books 

5)	 Thomas W. Doeppner, Operating 
Systems In Depth: Design And 
Programming, John Wiley&Sons,Inc
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கற்றலின் ந�ோக்கங்கள்

இந்த பாடத்தைக் கற்றபின் மாணவர்கள் அறிந்து 

க�ொள்பவை

•	 இயக்க அமைப்பின் கருத்துருக்களைத் 

தெ  ரி ந் து க �ொ  ள் ளு த ல் .

•	 விண்டோஸ் இயக்க அமைப்பின் பதிப்புகளை 

அறிந்து க�ொள்ளுதல். 

•	 முகப்புத்திரை மற்றும் சன்னல் திரையின் 

கூறுகளின் கருத்துருக்களைத் அறிந்து 

க �ொ  ள் ளு த ல் .

•	 ஆவண சன்னல் திரையை ஆராய்தல்

•	 பல்வேறு வகையான பணிக்குறிகளை 

ஒ ப் பி டு த ல் .

•	 விண்டோஸ் க�ோப்புறை அடைவு அமைப்பை  

ஆராய்தல்.

•	 ஒரு குறிப்பிட்ட இயக்கவட்டில் 

க�ோப்புகளையும், க�ோப்புறைகளையும், 

உருவாக்குவதற்கான பயிற்சி.

•	 க�ோப்புகளையும், க�ோப்புறைகளையும் 

நி ர ்வ கி த ்த ல் .

•	 முறைப்படி ஒரு கணிப்பொறியின் 

இயக்கத்தைத் த�ொடங்குதல் மற்றும் நிறைவு 

செ  ய ்த ல் .

5.1. இயக்க அமைப்பு ஓர் அறிமுகம் 
	 இயக்க அமைப்பு (Operating  System) 
ஒரு அமைப்பு மென்பொருள் (System Software) 
ஆகும். இது வன்பொருட்களை, மற்ற 

பாடம் 5கணினி அறிமுகம்

மென்பொருட்களுடன் த�ொடர்பு க�ொள்ளவும், 

இயக்கவும் வகை செய்கிறது. மேலும், 

பயனரையும், வன்பொருட்களையும் இணைக்கும் 

இடைமுகமாகவும், கணிப்பொறியின் 

அனைத்து இயக்கங்களைக் கட்டுப்படுத்தவும் 

பயன்படுகிறது. (படம் 5.1)
1 பயனர் 2 பயனர் n பயனர்

மென்பொருள்

அமைப்பு 
மென்பொருள்

பயன்பாட்டு
மென்பொருள்

இயக்க அமைப்பு

வன்பொருள்  மைய 
செயலகம் நினைவகம்

உள்ளீடு /
வெளியீடு

படம் 5.1 இயக்க அமைப்பு ஒரு பார்வை

	 முந்தைய பாடத்தில் கற்ற, இயக்க 

அமைப்பின் சில முக்கிய செயல்பாடுகள் பின் 

வ ரு ம ா று :

•	 நினைவக மேலாண்மை

•	 செயல் மேலாண்மை

•	 சாதன மேலாண்மை 

•	 க�ோப்பு மேலாண்மை 

•	 பாதுகாப்பு மேலாண்மை

•	 கணிப்பொறி செயல்பாடுகளின் மீதான 

ஒட்டும�ொத்த கட்டுப்பாடு

•	 பிழை கண்டறியும் சாதனம்

•	 பயனருக்கும் இதர மென்பொருள்களுக்கும் 

இடைேயயான ஒருங்கிணைப்பு.

அலகு I 

விண்டோஸ் - ல் வேலை செய்தல்
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5.2. விணநடோஸ் இயகக அ்மப்பு ஓர 
அறிமுகம்

 ஒவ்கவோரு  கணிப்கபோறியும் 

இயஙகுவ்தறகு ஏந்தனும் ஒரு இயகக 

அ்மப்பு ந்த்வப்படுகி்றது. அந்த வ்கயில், 

்மகநைோசோப்ட விணநடோஸ் மிகவும் பிைபலமோ்ன 

ஒரு “வ்ைக்ல பய்னர இ்டமுகம்” (GUI - 
Graphics User Interface) இயகக அ்மப்பு 

ஆகும். விணநடோஸ்-ல் ஒநை ந�ைததில் 

ஒன்றுககும் நமறபடட பயன்போடுக்ை 

இயகக முடியும் இ்தறகு “பல்பணியோககம்” 

(Multitasking)  என்று கபயர.

 விணநடோஸ் இயகக அ்மப்பில், 
வி்சப்பல்க மறறும் சுடடி ஆகிய இைண்டயும் 
உள்ளீடடு சோ்த்னஙகைோகப் பயன்படுத்தலோம். 
சுடடி்ய பணிககுறிகளில் கிளிக கசயவ்தன் 
மூலம்,                 விணநடோஸ்-ல் கூறுகளுடன் எளிதில் 
கசயல்பட முடியும். வி்சப்பல்க, எழுததுககள், 
எணகள் மறறும் சி்றப்பு குறியீடுக்ை உள்ளிடப் 
பயன்படுகி்றது.

விணநடோஸ் இயகக அ்மப்பின் சில  
க ச ய ல் ப ோ டு க ள்

• கசோறகசயலிகள், அடடவ்ணச் கசயலிகள், 
கணிப்போன், வி்ையோடடுகள் நபோன்்ற  
பயன்போடுக்ை இயககுவ்தறகு.

• கணிப்கபோறியில் புதிய பயன்போடுக்ை 
நி று வு வ ்த ற கு .

• அச்சுப் கபோறி, வருடி, சுடடி, இலகக 
வ்க நகமைோ நபோன்்ற வன்கபோருள்க்ை 
நமலோண்ம கசயவ்தறகு.

• நகோப்பு மறறும் நகோப்பு்்றகள் உருவோககு்தல், 
பதிப்போயவு கசய்தல், நசமித்தல்,  
அழித்தல் நபோன்்ற நகோப்புநமலோண்ம 
கசயல்போடுக்ை கசயவ்தறகு.

• கணிப்கபோறியின் அ்மப்புகைோ்ன 
(Settings), வணண திடடஙகள் (Colour 
Scheme), தி்ைககோப்பு (Screen Savers) 
நபோன்்றவற்்ற தி்ையில்மோறறி அ்மகக.

அடடவ்ண 5.1 ல் விணநடோஸ் 
இயகக அ்மப்பின் பல்நவறு பதிப்புகள் 

ப ட டி ய லி ட ப் ப ட டு ள் ை து .

5.3. வின்நடோஸின் பல்நவறு பதிப்புகள்

பதிப்புகள் சின்்னம் ஆணடு முககிய சி்றப்பியல்புகள்

விணநடோஸ் 1.x

 

1985

(1) 16 பிடடுகளில் வ்ைக்ல பய்னர          இ்டமுகம் 
அறிமுகம் கசயயப்படடது.

(2) சுடடி, உள்ளீடடுச் சோ்த்னமோக அறிமுகம் 
கசயயப்படடது.

விணநடோஸ் 2.x 1987

• சன்்னல் தி்ை்ய சிறி்தோககு்தல், அல்லது 
கபரி்தோககு்தல் வசதி.  

• ்தனிப் பய்னோககு்தல்  விருப்பத ந்தரவுகள் 
(Customising Options) மறறும் கணிப்கபோறி 
அ்மப்பு (Computer System Setting) 
மோறறு்தல் நபோன்்ற சி்றப்பம்சஙகளுடன் 
”கடடுப்போடடுப் பலகம்” (Control Panel) 
அறிமுகம் கசயயப்படடது.

விணநடோஸ் 3.x 1992

• விணநடோஸ்-ல் “பல்பணி கருததுரு” 
(Concepts of Multitasking) அறிமுகம்.

• 256 வணணஙக்ை ஆ்தரிப்ப்தோல், 
அதி�வீ்ன வணணமயமோ்ன ந்தோற்றத்்த 
இ்டமுகததிறகு அளிககி்றது. 
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விணநடோஸ் 95 1995

• க்தோடகக கபோத்தோன், பணிப்பட்ட, 
விணநடோஸ் எகஸ்ப்நைோைர மறறும் 
க்தோடககப்படடி அறிமுகம்.

• 32 பிட கசயலி அறிமுகம் மறறும்  
பல்பணியோககம் மீது அதிக கவ்னம் 
க ச லு த ்த ப் ப ட ட து .

விணநடோஸ் 98 1998

• இயகக அ்மப்புடன், ஒருஙகி்ணந்த 
இ்ணய உலவி (இணடரக�ட எகஸ்ப்நைோைர 
- Internet Explorer) அறிமுகம்.

• DOS  அடிப்ப்டயிலோ்ன வி்ையோடடுகள்  
ம்்றயத க்தோடஙகி, விணநடோஸ் 
அடிப்ப்டயிலோ்ன வி்ையோடடுகள் 
ந ம ம் ப டு த ்த ப் ப ட ட து .

• கசருகி (Plug and play)  உபநயோகித்தல் 
சி்றப்பம்சம் அறிமுகம்.

விணநடோஸ் NT
• வ்லய்மப்பில் நச்வயகம் நபோல் 

வ டி வ ் ம க க ப் ப ட ட து .

விணநடோஸ் Me 2000
• ்தோனியஙகு  கணிப்கபோறி 

பரிநசோதித்தல் மறறும் மீடபுக கருவிகள் 
அ றி மு க ப் ப டு த ்த ப் ப ட ட ்ன .

விணநடோஸ் 
2000 2000

• வணிகநம்சக கனிணி மறறும் மடிக 
கனிணிகளில்  இயகக அ்மப்போக 
ந ச ் வ ய ோ ற றி ய து .

• விணநடோஸ் 2000ல் �ோன்கு பதிப்புகள் 
கவளியிடப்படட்ன.

• Professional (வணிக நம்சக கனிணி 
மறறும் மடிககணினிகள்)

• Server (இ்ணய நச்வயகம் மறறும் 
அலுவலக நச்வயகம்).

• Advanced Server (க்தோழில்து்்ற 
ப ய ன் ப ோ ட டி ற க ோ க )

• Data Centre Server (உயர நபோககுவைதது 
(high-traffic) கணிப்கபோறி நச்வயகம்). 

விணநடோஸ் XP 2001
• 64-பிட கசயலிகள் அறிமுகம்.

• வின்நடோஸ் ந்தோற்றம் மறறும் நி்லயோ்ன 
பணித்தைம் நமம்படுத்தப்படடது.

கோரடோ்னோ குைல் கசயலியகக ்தனி உ்தவியோைர வசதி (Cortana voice activated Personal assistant) 

5.4. சுடடி்யக ்கயோளு்தல் 

 விணநடோஸ் இயகக அ்மப்பில் நவ்ல 

கசயவ்தறகு முன்பு சுடடியின் இயககத்்தப் 

பறறி அறிநது ககோள்ை நவணடும்.
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விணநடோஸ் 
Vista 2006 • விணநடோஸ் ந்தோற்றம் நமம்படுத்தப்படடது.

விணநடோஸ்  7 2009

• கணிப்கபோறியின் க்தோடஙகு்தல் ந�ைம் 
நமம்படுத்தப்படடது.

• ஏநைோ பீக (Aero Peek), பணிப்பட்டயில் 
பயன்போடுக்ை இ்ணத்தல் (pinning 
programs to taskbar), ்ககயழுதது 
உணர்தல் (Handwriting recognition), 
இன்டரக�ட எகஸ்புநைோைர 8 (Internet 
Explorer 8) நபோன்்ற புதிய பய்னர இ்டமுக 
வசதிகள் அறிமுகப்படுத்தப்படடது.

விணநடோஸ் 8 2012

• விணநடோஸ்-ன் முந்்தய பதிப்புக்ை 
விட விணநடோஸ் 8 மிகவும் நவகமோக 
க ச ய ல் ப ட க கூ டி ய து . 

• க்தோடகக கபோத்தோன் நீககப்படடது.

• விணநடோஸ் 8 - யில் "பல் அடுககு கசயலி" 
(Multi Core Processing), திட நி்ல 
இயககிகள், க்தோடுதி்ை மறறும் மோறறு 
உள்ளீடடு மு்்றகள் நபோன்்ற சி்றந்த 
�ன்்மகள் உள்ை்ன.

• ்கப்நபசி மறறும் கணிப்கபோறிகளுககோ்ன 
கபோதுவோ்ன பணிநம்டயோக கசயல்படடது.

விணநடோஸ் 10 2015

• க்தோடகக கபோத்தோன் மீணடும் 
ந ச ர க க ப் ப ட ட து .

• ஒன்றுககும் நமறபடட தி்ை முகப்பு.

• "கசயலி அறிவிப்பு" மறறும் "வி்ைவு 
�டவடிக்க கசயலிககோ்ன மததிய அறிவிப்பு 
்மயம்" அறிமுகம்.

கோரடோ்னோ குைல் கசயலியகக ்தனி உ்தவியோைர வசதி (Cortana voice activated Personal assistant) 

5.4. சுடடி்யக ்கயோளு்தல் 

 விணநடோஸ் இயகக அ்மப்பில் நவ்ல 

கசயவ்தறகு முன்பு சுடடியின் இயககத்்தப் 

பறறி அறிநது ககோள்ை நவணடும்.

(Cortana voice activated Personal assistant)
வலது கிளிக

இடது கிளிக

XI Std Computer Science Vol-1 TM Chapter 5 090-130.indd   55 4/20/2020   12:56:57 PM



56

படம் 5.2.சுடடியின் கசயல்போடுகள்

சுடடியின் கசயல்போடுகள்

கசயல் வி்ைவு

ஒரு உருப்படி்ய 
(item) சுடட 

சுடடி்ய ஒரு உருப்படியின் மீது 
�கரதது்தல்.

கிளிக

தி்ையில் உள்ை ஒரு 
உருப்படியின் மீது சுடடி்ய 
்வதது இடது கபோத்தோ்்ன 
அழுததி உடந்ன விடடுவிடு்தல்.

வலது கிளிக

ஒரு உருப்படியின் மீது சுடடி்ய 
்வதது, வலது கபோத்தோ்்ன 
அழுத்த, ஒரு நமல்மீடபுப் படடி 
ந்தோன்றும், அதில் பல விருப்பத 
ந்தரவுகள் படடியலிடப்படும்.

இரு கிளிக 
கசய்தல்

தி்ையில் உள்ை ஒரு 
உருப்படியின் மீது சுடடி்ய 
்வதது, இடது கபோத்தோ்்ன 
இருமு்்ற நவகமோக அழுததி 
வி டு ்த ல் .

இழுதது விடு்தல்

ஒரு உருப்படியின் மீது 
சுடடி்ய ்வதது, சுடடியின் 
இடது கபோத்தோ்்ன அழுததி 
பிடித்தவோறு, சுடடி்ய 
ந்த்வயோ்ன இடம் வ்ை 
இழுதது, பின் விடடுவிடு்தல்.

அடடவ்ண  5.2
5.5. விணநடோஸின் தி்ைமுகப்பு

விணநடோஸின் க்தோடகக தி்ை ”தி்ைமுகப்பு”  
(Desktop) என்று அ்ைககப்படுகி்றது. 
உஙகள் கணிப்கபோறியில் உள்ை தி்ை முகப்பு 
படம்  5.3ல் கோடடப்படடது நபோல இல்லோமல் 
நவறுபடடிருககலோம். ஏக்னனில் விணநடோஸ் 
அ்தன் ந்தோற்றம், தி்ை முகப்பு ஆகியவற்்ற 
மோறறி அ்மகக வழி கசயகி்றது.
படம் 5.3 -ல் க்தோடகக கபோத்தோன், 
பணிப்பட்ட, அறிவுப்புப் பகுதி, ந்ததி 
மறறும் ந�ைம் ஆகியவற்்றத தி்ைமுகப்பில் 
க ோ ண ல ோ ம் .

• நீஙகள் எந்த பயன்போடடில் நவ்ல கசயது 

ககோணடிருந்தோலும் Winkey + D அல்லது 

ஏநைோ பீக (Aero Peak) பயன்படுததி எந்த 

ந�ைததிலும் தி்ை முகப்புககுச் கசல்லலோம்.

• பணிப்பட்டயில் ஏநைோ பீக எஙகு உள்ைது 

என்ப்்த படம் 5.4ல் அறியலோம்.

உஙகளுககு க்தரியுமோ?

பணிககுறிகள்

பணிப்பட்ட

அறிவிப்பு பகுதிக்தோடகக கபோத்தோன்

நககஜடடுகள்

படம் 5.3. ்மகநைோசோப்ட விணநடோஸ் 7 

தி்ைமுகப்புதி்ைமுகப்பு

ஏநைோ பீக கபோத்தோன்

படம் 5.4. ஏநைோ பீக கபோத்தோன்.

5.5.1. பணிககுறிகள் (Icon)
 விணநடோஸ்-ன் கூறுகைோ்ன நகோப்பு, 

நகோப்பு்்ற, குறுககுவழிகள் நபோன்்றவற்்றக 

குறிககும் படககுறியீடு "பணிககுறி" எ்னப்படும். 

வ்ைக்லப் பய்னர இ்டமுக (GUI) 

பயன்போடுகளில் பணிககுறிகள் முககிய பஙகு 

வ கி க கி ்ற து .

5.5.1.1 கசந்தை பணிககுறி (Standard 
Ic ons)
  விணநடோஸ் இயகக அ்மப்பு 

நிறுவப்படும் நபோது உருவோககப்படும் ககோடோநி்ல 

பணிககுறிகள், "கசந்தை பணிககுறிகள்" 

(Standard Icons) எ்ன அ்ைககப்படுகி்றது. 

்மகம்ப்யூடடர (My Computer), டோககுகமன்ட 
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(ஈ) கைப்பேசி, ஸ்மார்ட் கைப்பேசி, டேப்ளட் 

(Tablet) ப�ோன்ற நீக்கக்கூடிய நினைவகங்கள்

(உ) உங்கள் கணிப்பொறி பிற கணிப்பொறிகளுடன் 

இணைக்கப்பட்டு இருந்தால், அதன் வலை 

இயக்கி (படம் 5.6 பார்க்க)

பயன்பாட்டு பணி-
க்குறி

க�ோப்புைற 
பணிக்குறி

படம் 5.5.பணிக்குறியின்  வகைகள்

(Documents) மற்றும் ரிசைக்கிள் பின் (Recycle 
Bin) ப�ோன்றவை அைனத்து விண்டோஸ் 

இயக்க அமைப்புகளிலும் காணப்படும் செந்தரப் 

பணிக்குறிகள் ஆகும். 

5.5.1.2. குறுக்கு வழி பணிக்குறிகள் :

	 எந்தெவாரு பயன்பாடு அல்லது  க�ோப்பு 

அல்லது க�ோப்புைறகளுக்கு குறுக்கு வழி 

பணிக்குறிகளை உருவாக்கலாம்.  இதன் மீது இரு 

கிளிக் செய்யப்படும் ப�ோது இதற்கான பயன்பாடு 

/ க�ோப்பு அல்லது க�ோப்புைற திறக்கப்படும்.  

குறிப்பிட்ட பயன்பாட்டைத் திறப்பதற்கான  

குறுக்குவழியாக பணிக்குறிகள் பயன்படுகிறது. 

(படம் 5.5).

5.5.1.3. வட்டு இயக்கி பணிக்குறிகள்	

	 வட்டு இயக்கி பணிக்குறிகள், ஐந்து 

வகையான வட்டு இயக்கிகளைப் படக்குறியீடாக 

வ ழங்  கு கி் ற து .

(அ) வன்வட்டு (C,D,E) 

(ஆ)CD-ROM / DVD வட்டு

(இ) ெபன்டிைரவ் (Pen Drive)

பல்வேறு வட்டு இயக்கி 

பணிக்குறி

ம�ொத்த நினைவக இடம் 

மற்றும் மீதமுள்ள நினைவக 

இடத்துடன் வன்வட்டு இயக்கி

நீக்கக் கூடிய நினைவகம் (பென் இயக்கி)

படம் 5.6.வட்டு இயக்கி பணிக்குறிகள்

5.6. சன்னல் திரை

	 ஒரு ஆவணம் அல்லது பயன்பாட்டின் ப�ொதுவான செவ்வகப் பகுதி "சன்னல்" திரை எனப்படும். 
குறிப்பிட்ட பயன்பாட்டின் தகவல்களைத் திரையிடுவதற்கு  பயன்படும் பகுதியாகும்.
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5.7 பயன்பாட்டு சன்னல்திரை

	த கவல்களைத் திரையிடுவதற்கான, 
வரையறுக்கப்பட்ட எல்லைகளைக் க�ொண்ட 
கணிப்பொறி திரையின் பகுதி, "பயன்பாட்டு 
சன்னல்திரை" எனப்படும். சன்னல் திரைகளை 
சிறிதாக்குதல் (Minimize), பெரிதாக்குதல் 
(Maximize), அருகருகே வைத்தல் (side 
by side), ஒன்றன் மீது ஒன்றாக வைத்தல் 
(Overlap) ப�ோன்ற செயல்களைச் செய்ய 
முடியும். ஒரு பயன்பாட்டு சன்னல்திரை என்பது 
திறக்கப்பட்டுள்ள ஒரு  பயன்பாடு. அதாவது Word, 
Paint ப�ோன்ற இயங்கும் பயன்பாடுகளைக் 
குறிக்கும். இரண்டுக்கும் மேற்பட்ட சன்னல்கள் 
திறந்திருக்கும் ப�ோது அதனுள் ஒன்று மட்டுமே 
செயலில் இருக்கும். மற்றது செயலற்றதாக 
இருக்கும். படம் 5.7 மற்றும் 5.8 ல் ஓபன் ஆஃபீஸ் 
ரைட்டர் பயன்பாட்டு சன்னல் திரை மற்றும் திரை 
முகப்பில் திறந்துள்ள ஒன்றுக்கும் மேற்பட்ட 
சன்னல்களின் த�ோற்றத்தைக் காணலாம்.

5.8. ஆவண சன்னல் திரை

	 ஒரு ஆவணத்தின் உள்ளடக்கத்தைக் 

காட்டும் சன்னல் திரை "ஆவண சன்னல் 

திரை"  எனப்படும். படம் 5.9 ல் ஆவண சன்னல் 

திரைக்கான எடுத்துக்காட்டாகும்.
குறிப்பு

ஓபன் ஆஃபீஸ் ரைட்டர், இம்ப்ரெஸ் 
அல்லது கால்க் ப�ோன்ற பயன்பாடுகளைத் 
திறக்கும் ப�ோது, கணிப்பொறி திரையில் 
இரண்டு சன்னல் திரைகள் ஒன்றினுள் 
ஒன்றாக த�ோன்றும். அதில், பெரிய 
சன்னல் திரை “பயன்பாட்டு சன்னல் திரை” 
என்று அழைக்கப்படுகிறது. இது, பயனர், 
பயன்பாட்டு மென்பொருளுடன் த�ொடர்பு 
க�ொள்ளப் பயன்படுகிறது. பயன்பாட்டு 
சன்னல் திரையின் உள்ளே அமைந்துள்ள 
சிறிய சன்னல் திரை “ஆவண சன்னல் 
திரை” என்று அழைக்கப்படுகிறது. இது, 
உரை மற்றும் படங்களை (graphics) 
உருவாக்கவும், பதிப்பாய்வு செய்யவும், 
படங்களை வரையவும் மற்றும் வடிவூட்டல் 
செய்யவும் பயன்படுகின்றது.

பயன்பாட்டு பணித்தளம்

ஆவணத்தின் தலைப்புடன் "தலைப்புப் பட்டை"

கருவிப் பட்டை

உருளல் பட்டை

பட்டிப் பட்டை

வி
ண

்
ட

ோஸ்
 க

ட்
டு

ப்பாட்
டு

 ப�ொத
்தான்க




ள்
 

படம் 5.7. பயன்பாட்டு சன்னல்திரை

படம் 5.8. ஒன்றுக்கும் மேற்பட்ட சன்னல்கள் 

திரைமுகப்பில் திறக்கப்பட்டுள்ளது
பயன்பாட்டு சன்னல்

ஆவண பகுதி

ஆவண சன்னல்

ரூலர்

படம்  5.9.ஆவண சன்னல் திரையின் கூறுகள்
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5.9. சன்னல் திரையின் கூறுகள்

	 படம் 5.10 சன்னல் திரையின் 

கூறுகளைப்ப புரிந்து க�ொள்ள பயன்படுகிறது.

	 சிறிதாக்கு, பெரியதாக்கு மற்றும் மூடு 

ப�ொத்தான்களும் உள்ளன.

5.9.1 தலைப்புப்பட்டை

	 திறந்துள்ள ஆவணத்தின் பெயரும், 

பயன்பாட்டின் பெயரும் தலைப்புப் பட்டையில் 

த�  ோ ன் று ம் .

5.9.2 பட்டிப்பட்டை

	தலை ப்பு பட்டையின் கீழ் புறம் 

பட்டிப்பட்டை காணப்படும். Alt ப�ொத்தானை 

அழுத்தியவாறே பட்டித் தலைப்பில் அடிக�ோடிட்டு 

த�ோன்றும் எழுத்தினையும் அழுத்தி, 

பட்டிப்பட்டையில் உள்ள பட்டிகளைப் பயன்படுத்த 

முடியும். மேலும் Alt ப�ொத்தான் அல்லது F10 
ப�ொத்தானை அழுத்தினால் பட்டிபட்டையில் 

உள்ள முதல் பட்டியை முன்னிறுத்தும். 

	 விண்டோஸ் 7  இல் பட்டி பட்டை 

இல்லாவிட்டால் organize ப�ொத்தானில் க்ளிக் 

செய்து த�ோன்றும் கீழ்விரிப் பட்டியிலிருந்து 

layout Option கிளிக் செய்து பட்டிப் 

பட்டையைத் த�ோன்றச்செய்யலாம். படம் 5.11ன் 
மூலம் பட்டி பட்டை த�ோன்றாவிட்டால் அதை 

எவ்வாறு த�ோன்றச் செய்வது என்பதைத் தெரிந்து 

க �ொள்ள    ல ா ம் .
மூலைகள்

மூலைகள் மூலைகள்

உருளல் பட்டை

பணித்தளம்

Menu Bar

மூலைகள்
தலைப்புப் பட்டை

எ
ல

்
லை

க
ள்

எல்லைகள்

எல்லைகள்

படம்  5.10. விண்டோஸின் கூறுகள் 

படம்  5.11. பட்டிப் பட்டையை த�ோன்ற செய்வது

5.9.3. பணித்தளம் 
	 ஒரு ஆவணத்தில் உரையைத் தட்டச்சு 
செய்யும் ஆவண சன்னல் திரையின் பகுதி 
பணித்தளம் ஆகும். படம்  5.10 ஆவண 
சன்னலின் பணித்தளத்தைக் காட்டுகிறது.
5.9.4 உருளல் பட்டை
	 உருளல் பட்டைகள் பணித்தளத்தைச் 
செங்குத்தாகவும், கிடைமட்டமாகவும் உருள 
செய்யப் பயன்படுகிறது. படம் 5.10 உருளல் 
பட்டையின் த�ோற்றத்தைக் காட்டுகிறது.
5.9.5 மூலைகள் மற்றும் எல்லைகள்
	 விண்டோஸில் அளவை மாற்றி அமைக்க 
மூலை மற்றும் எல்லை உதவி செய்கிறது.
சன்னல் திரையின் மூலைகள் மற்றும் 
எல்லைகளின் மீது சுட்டியின் அம்புக்குறியை 
வைக்கும்போது, அது இருதலை க�ொண்ட 
அம்புக்குறியாக மாறும். இருதலை 
அம்புக்குறியின் திசைக்கு ஏற்ப இழுக்கும் ப�ோது, 
சன்னல் திரையின் அளவு மாறும் (படம் 5.10யை 
காண்க). சன்னலின் மூலைவிட்டத்தில் இருதலை 
அம்புக்குறியை வைத்து இழுக்கும்போது, அதன் 
அளவு மாற்றப்படும். 

5.10 கணினியை ஆராய்தல்

5.10.1 த�ொடக்கப்பட்டி
	 திரைமுகப்பின் கீழ் இடது கை 
மூலையில் த�ொடக்க ப�ொத்தான் உள்ளது. 
த�ொடக்க ப�ொத்தானைக் கிளிக் செய்யும் 
ப�ோது த�ொடக்கப்பட்டி த�ோன்றும். மேலும் 
அதை பயன்படுத்தி எந்த ஒரு பயன்பாட்டையும் 
த�ொ   ட ங ்க ல ா ம் .
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பணிப்பட்டை

	 திரைமுகப்பின் கீழே உள்ள 
கிடைமட்ட பட்டை “பணிப்பட்டை” (Taskbar) 
என்று அழைக்கப்படுகிறது. இந்த பட்டை, 
(இடமிருந்து வலமாக) த�ொடக்கப் ப�ொத்தான், 
பல்வேறு பயன்பாடுகளின் குறுக்குவழிகள், 
சிறிதாக்கப்பட்ட பயன்பாடுகளை 
க�ொண்டிருக்கும். மேலும், அதன் வலதுக�ோடியில், 

ஒலி கட்டுப்பாட்டகம், வலையமைப்பு, தேதி 
மற்றும் நேரம் ப�ோன்ற வசதிகளை உள்ளடக்கிய 
”கணினி அமைப்பு தட்டு” (System tray)  
உள்ளது. அடிக்கடி பயன்படுத்தப்படும் 
பயன்பாடுகளைக் க�ொண்டிருக்கும். ”விரைவு 
த�ொடக்க கருவிப்பட்டை” (Quick launch 
toolbar), த�ொடக்க ப�ொத்தானுக்கு அடுத்ததாக 
உ ள்ள  து .

இந்த தேர்வுடன் மேலும் 
துணைப்பட்டி உள்ளதைக் 
காட்டும் குறியீடு.

கணிப்பொறி அமைப்பை  
மாற்றுவது

(கட்டுப்பாட்டு பலகம்)

இதர சாதனங்கள் மற்றும் 
அச்சுப்  

ப�ொறிகளைச் சேர்த்தல் / 
மாற்றுதல்

உதவி பெறுதல்

வெளியேறுதல் / மீண்டும்  
த�ொடங்குதல், பணி  நிறுத்தம்

நிறுவப்பட்ட 
பயன்பாடுகள்

தேடல் பெட்டி

த�ொடக்க 
ப�ொத்தான்

படம் 5.12.த�ொடக்க பட்டி 
த�ொடக்கப் ப�ொத்தான்

சிறிதாக்கப்பட்ட 
பயன்பாடுகளும், க�ோ-

ப்புைறகளும்

மறைக்கப்பட்ட பணி-
க்குறிகளைக் காட்டும்

தானமைவு 
ம�ொழி

வலையமைப்பு 
பணிக்குறி

ஒலி சரிசெ-
ய்தல்

நேரம் மற்றும்  நாள்

ஏர�ோபீக் 
ப�ொத்தான்

படம்  5.13 பட்டிப்பட்டை
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5.10.2 கணிப்பொறி பணிக்குறி

	 இந்த பணிக்குறியைக் கிளிக் செய்தால், 
கணிப்பொறியுடன் இணைக்கப்பட்டுள்ள 
வட்டு இயக்கிகளைப் பயனர் காண முடியும். 
விண்டோஸ் XP மற்றும் விஸ்டா பதிப்புகளில், 
இந்த பணிக்குறி “மை கம்ப்யூட்டர்” (My 
Computer) என்றும், விண்டோஸ் 8 மற்றும் 
10ல் ”திஸ் பீஸி” (This PC) என்றும் 
அழைக்கப்படுகிறது. இந்த பணிக்குறியின் 
செயல்பாடு விண்டோஸ்-ன் அனைத்து 
பதிப்புகளுக்கும் ப�ொதுவானதாகும். (படம்  
5.14 யை காண்க)

5.10.3 பயன்பாட்டைத் த�ொடங்குதல் மற்றம் 
மூ டு த ல் 
	 கணிப்பொறியில் நிறுவப்பட்டுள்ள 
பெரும்பாலான பயன்பாடுகள், த�ொடக்கப்பட்டியில் 
கிடைக்கும். கணிப்பொறியின் அமைப்பைப் 
ப�ொறுத்து த�ொடக்கப் பட்டியில் உள்ள பயன்பாடுகள் 
வே  று ப டு கி ன ்ற ன . 

1.	 ஒரு பயன்பாட்டைத் த�ொடங்குவதற்கு: Start 
ப�ொத்தானைக் கிளிக் செய்து, All Programs 
ல் சுட்டியை வைக்கவும்.  நிரல் பட்டி படம் 5.15 
ல் உள்ளவாறு த�ோன்றும்.

2.	 நீங்கள் த�ொடங்க விரும்பும் பயன்பாட்டைக் 
க�ொண்ட குழுவில் சுட்டியை வைத்து, பின்னர் 

பயன்பாட்டின் பெயரைக் கிளிக் செய்யவும்.

படம்  5.14 விண்டோஸ் இயக்க அமைப்பு பதிப்பில் உள்ள மைகம்ப்யூட்டர் பணிக்குறி

படம் 5.15 த�ொடக்கப் ப�ொத்தானைப் 

பயன்படுத்த பயன்பாட்டைத் த�ொடங்குதல்.

3.	த�ொ டக்க  பட்டியிலுள்ள Run என்பதைக் கிளிக் 

செய்து, த�ோன்றும் பெட்டியில், திறக்கப்பட 

வேண்டிய பயன்பாட்டின் பெயரைத் தட்டச்சு 

செய்தும், ஒரு பயன்பாட்டைத் த�ொடங்கலாம். 

(படம் . 5.16   யை காண்க)

படம்  5.16. Run கட்டளையைப் பயன்படுத்தி 

பயன்பாட்டைத் த�ொடங்குதல்

4.	 ஒரு பயன்பாட்டை விட்டு வெளியேற 

பயன்பாட்டு சன்னல் திரையின் மேல் வலது 

மூலையில் உள்ள மூடு ப�ொத்தானைக் கிளிக் 

செய்க. (படம் 5.17)
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மூடு ப�ொத்தான்

வெளியேறு

படம் 5.17. மூடு (Close) மற்றும் வெளியேறு (Exit)
ப�ொத்தானைப் பயன்படுத்தி வெளியேறுதல்

5.	  File → Exit அல்லது File → Close 

கட்டளைகளையைப் பயன்படுத்தியும், ஒரு 

பயன்பாட்டிலிருந்து வெளியேறலாம்.

பயிற்சி பட்டறை

	த�ொ டக்கப்  பட்டி மற்றும் RUN தேர்வு 
பயன்படுத்தி Word Pad பயன்பாட்டைத் 

த�ொ   ட ங் கு க .

	 File பட்டியைப் பயன்படுத்தி Word Pad ஐ 

மூடுக.

5.11 க�ோப்புகளையும், 
க�ோப்புைறகளையும் நிர்வகித்தல்

	 விண்டோஸ் 7 ல், ஆவணங்கள் மற்றும் 
நிரல்களைக் க�ோப்புகள் மற்றும் க�ோப்புைறகளாக  
நிர்வகிக்கலாம். க�ோப்பு மற்றும் க�ோப்புைறகளை 
நகர்த்துதல், நகலெடுத்தல், மாற்றுப்பெயரிடுதல், 
நீக்குதல் மற்றும் தேடல் ப�ோன்ற செயல்களைச் 
செய்ய முடியும்.

5.11.1. க�ோப்பு மற்றும் க�ோப்புைறகளை 

உ ரு வ ாக்  கு த ல்

5.11.1.1 க�ோப்புைறகளை உருவாக்குதல்

	 உங்கள் க�ோப்புகளைப் பல இடங்களில் 

சேமிக்கலாம் - வன்வட்டு அல்லது பிற 

இயக்கிகளில். உங்கள் க�ோப்புகளை சிறப்பாக 

அமைக்க க�ோப்புைறகளில்  சேமிக்கலாம். 

புதிய க�ோப்புைறயை உருவாக்க இரண்டு 
வழிமுறைகள் உள்ளன.

முறை 1
படி 1.	 கம்ப்யூட்டர் குறும்படத்தை திறக்கவும்

படி2.	 புதிய க�ோப்புைறயை உருவாக்க விரும்பும் 
இயக்கியை திறக்கவும். (உதாரணம் D:/)

படி3.	 File  New  Folder கிளிக் செய்க.

படி4.	 புதிய க�ோப்புைற, தானமைவாக “New 
Folder” என (படம் 5.19) காட்டியவாறு 
உ ரு வ ா கு ம் .

படி 5.	 க�ோப்புைறயின் பெயரைத் தட்டச்சு 
செய்து, Enter ப�ொத்தானை அழுத்தவும். 
(புதியதாக உருவாக்கப்பட்ட க�ோப்புைற  
"test folder" என ெபயரிடப்பட்டுள்ளதைப்  
படம் 5.20 காண்க)

படம் 5.18. File பட்டியைப் பயன்படுத்தி 

க�ோப்புைறகளை உருவாக்குதல்.

படம் 5.19 தானமைவு பெயரில் புதிதாக 

உருவாக்கப்பட்ட க�ோப்புைற
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படம் 5.20. புதிதாக உருவாக்கப்பட்ட 
க�ோப்புைறக்கு  மறுபெயரிடுதல்.

முறை 2
திரைமுகப்பில் க�ோப்புைறயை உருவாக்க

படி 1- �திரைமுகப்பில் சுட்டியின் வலது 
ப�ொத்தானைக் கிளிக் செய்து, New 
 Folder  கட்டளையைக் கிளிக் செய்க. 
(படம் 5.21)

படி 2- �பெயரிடப்படாத ஒரு new folder என்ற 
க�ோப்புைற த�ோன்றுகிறது (படம் 5.22)

படி 3- �க�ோப்புைறக்கு ஒரு பெயர் தட்டச்சு 
செய்து. Enter ப�ொத்தானை 
அ ழு த ்த வு ம் .

படி 4 – �க�ோப்புைறயின் பெயர் மாற்றம் பெறும். 
(படம் 5.20)

2. மை டாக்குமென்ட் (My Document) ல், நாம் 
பயின்ற ஏதேனும் ஒரு முறையைப் பயன்படுத்தி 
ஒரு க�ோப்புைறயை உனது பெயரில் 
உருவாக்கவும். 

பயிற்சி பட்டறை

5.11.1.2 க�ோப்பு உருவாக்குதல் (வேர்டு பேட்)
வேர்டு பேட் (Word Pad) விண்டோஸ் இயக்க 
அமைப்பின் உள்ளிணைந்த ச�ொற்செயலி 
பயன்பாடாகும். உரை ஆவணங்களை 
உருவாக்கவும், கையாளவும் இது 
ப ய ன்ப  டு கி ற து . 
	 இதில் க�ோப்பினை உருவாக்க 
விரும்பினால் கீழ்க்காணும் படிநிலைகளைப் 
பி ன்ப  ற ்ற வு ம் .

படம் 5.21. திரை முகப்பில் க�ோப்புைறயை 

உருவாக்குதல்.

1.	  Start  All Programs  Accessories  
Wordpad அல்லது Run  type Wordpad 
என தட்டச்சு செய்த பிறகு ok ப�ொத்தானைக் 

கிளிக் செய்ய வேண்டும்.

	 Word Pad சன்னல் திரை படம் 5.23 ல் 

காட்டியுள்ளவாறு திறக்கப்படும்.

2.	 பணித்தளத்தில் தட்டச்சு செய்யப்பட 

வேண்டிய உரையைத் தட்டச்சு செய்து, File 

 Save அல்லது Ctrl + S  பயன்படுத்தவும். 
3.	 Save As உரையாடல் பெட்டி திரையில் 

த�  ோ ன் று ம்

4.	 அந்த உரையாடல் பெட்டியில் ஆவணத்தை 

எங்கு சேமிக்க வேண்டும�ோ அதை  
look –in கீழிறக்குப்  பெட்டியில் தேர்வு செய்ய 

வேண்டும்.

5.	 File name என்ற உரைப்பெட்டியில் க�ோப்பின் 

பெயரைத் தட்டச்சு செய்ய வேண்டும்.

6.	 Save ப�ொத்தானைக் கிளிக் செய்ய வேண்டும் 

படம் 5.22. திரைமுகப்பில் புதிய க�ோப்புைற
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படம்  5.23.Word pad- ச�ொற்செயலி பயன்பாடு

3.	 Wordpad- யை பயன்படுத்தி ஒரு 
ஆவணத்தை உருவாக்கி பின் அதை 
மை டாக்குமென்டில் உள்ள உங்கள் 
பெயரில் உருவாக்கப்பட்ட க�ோப்புைறயில் 
சே  மி க ்க வு ம் .

பயிற்சி பட்டறை

5.11.2. க�ோப்பு மற்றும் க�ோப்புைறகளைத் 
தேடுதல்

கணினியில் அல்லது குறிப்பிட்ட இயக்கிகளில் 

உள்ள க�ோப்பு அல்லது க�ோப்புறையை விரைவாக 

த�ொடக்கப் ப�ொத்தானிலுள்ள Search பெட்டி 

பயன்படுத்தப்படுகிறது.

படம் 5.24. த�ொடக்க பட்டியைப் பயன்படுத்தி 

க�ோப்பு அல்லது க�ோப்புறையைக் கண்டுபிடித்தல்.

க�ோப்பு அல்லது க�ோப்புறையைக் கண்டுபிடிக்க

1.	 Start ப�ொத்தானை கிளிக் செய்யவும், 
த�ொடக்க பட்டியின் கடைசியில் Search 
பெட்டி காணப்படும்.

2.	தே டப்பட வேண்டிய க�ோப்பு அல்லது 
க�ோப்புைறயின் பெயரை Search  
பெட்டி - ல் தட்டச்சு செய்க. தேடவேண்டிய 
க�ோப்பு அல்லது க�ோப்புைறயின் பெயரில் 
ஒரு பகுதியை நீங்கள்கொடுத்தாலே 
ப�ோதும்.

3.	 குறிப்பிடப்பட்ட பெயரிலுள்ள க�ோப்பு அல்லது 
க�ோப்புைறகள் திரையில் த�ோன்றும். அந்த 
க�ோப்பு அல்லது க�ோப்புைறயை கிளிக் 
செய்தால், அது நேரடியாக திறக்கும்.

4.	 Search பெட்டிக்கு மேலே “See more 
results” என்ற மற்றொரு தேர்வும் உள்ளது.

5.	 இந்த தேர்வைக் கிளிக் செய்யும் ப�ோது, 
Search Results உரையாடல் பெட்டி 
த�ோன்றும். இதன் மூலம், க�ோப்பு அல்லது 
க�ோப்புைறகளை தேடித், திறக்கலாம். 

க�ோப்பு அல்லது க�ோப்புைறயை கம்ப்யூட்டர் 
பணிக்குறி  மூலம் தேடுதல்.

படி 1	 கம்ப்யூட்டர் பணிக்குறியை திரை முகப்பில் 
தேர்வு செய்க அல்லது Start பட்டி மூலம்  
தேர்வு செய்க.

படி 2	 கம்ப்யூட்டர் வட்டு இயக்கி(Disk Drive) 
என்ற திரை, மேல் வலது மூலையில் 
த�ோன்றும்.அதில் Search box தேர்வு 
உள்ளது. (படம் 5.25) 

படி 3	 அதில் க�ோப்பு அல்லது க�ோப்புைறயின்  
பெயரை தட்டச்சு செய்க. க�ோப்பு அல்லது 
க�ோப்புைற பெயரின் ஒரு பகுதியை  
க�ொடுத்தால் குறிப்பிட்ட பெயரில் 
த�ொடங்கும் அனைத்து க�ோப்பு அல்லது 
க�ோப்புைறகளைக் காட்டும்.

படி 4	 க�ோப்பு அல்லது க�ோப்புைறயை திறக்க 
அதனை கிளிக் ெசய்யவும்.
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படம் 5.25. 'கம்ப்யூட்டர்' பணிக்குறியைப் பயன்படுத்தி, க�ோப்புஅல்லது க�ோப்புைறயைத் தேடுதல்.

4.	 மேலே கூறியுள்ள முறைகளைப் 
பின்பற்றி நீங்கள்  பயிற்சி பட்டறை 3 ல் 
உருவாக்கிய க�ோப்பினைத் தேடவும்.

பயிற்சி பட்டறை

5.11.3. முன்னரே உருவாக்கிய க�ோப்பு அல்லது 

க�ோப்புைறயைத் திறத்தல்

க�ோப்பு அல்லது க�ோப்புைறயைத் திறக்க மிக 

ப�ொதுவான வழி, அதை இரட்டைக் கிளிக் 

செய்தல் ஆகும்.

5.11.4 க�ோப்பு அல்லது க�ோப்புைறக்கு 

ம று பெ  ய ரி டு த ல்

	 க�ோப்பு மற்றும் க�ோப்புைறக்கு 

மறுபெயரிடுவதற்கு பல வழிகள் உள்ளன.

File பட்டி அல்லது இடது சுட்டிப் ப�ொத்தான் 

அல்லது வலது சுட்டிப் ப�ொத்தானைப் 

பயன்படுத்தி மறுபெயரிடலாம்.

முறை 1

File பட்டியைப் பயன்படுத்தி மறுபெயரிடுதல்

1.	 மறுபெயரிட வேண்டிய க�ோப்பு அல்லது 

க�ோப்புைறயைக் கிளிக் செய்க.

2.	 கிளிக் File -> Rename

3.	 புதிய பெயரைத் தட்டச்சு செய்க.

4.	 படம் 5.26 ல் காட்டியபடி மறு பெயரிடும் 

செயலினை முடிக்க  Enter  ப�ொத்தானை 

அழுத்தவும் அல்லது OK ப�ொத்தானைக் 

கிளிக் செய்யவும்.

படம் 5.26. File பட்டியைப் பயன்படுத்தி க�ோப்பு 

அல்லது க�ோப்புைறக்கு மறுபெயரிடுதல்

படம் 5.27. மறுபெயரிடப்பட்ட க�ோப்புைற படம்

5.27 SCERT  என்ற  க�ோப்புைற SCERT-
DPI என மாற்று பெயரிடப்பட்டுள்ளதைக் 

காணலாம்.
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முறை   2 

சுட்டியின் வலது ப�ொத்தானைப் பயன்படுத்துதல்.

படி 1- மறுபெயரிட விரும்பும் க�ோப்பு அல்லது 

க�ோப்புைறயைத் தேர்வு செய்க.

படி 2  க�ோப்பு அல்லது க�ோப்புைறயின் மீது 

சுட்டியின் வலது ப�ொத்தானைக் கிளிக் 

செய்க. (படம் 5.28)

படி 3 மேல் மீட்புப் பட்டித் த�ோன்றும். அதில் 

rename என்ற கட்டளையைத் தேர்வு  செய்க. 

படி 4  புதிய பெயரைத் தட்டச்சு செய்க.

படி 5  மறு பெயரிடும் செயலினை முடிக்க Enter   
அல்லது OK ப�ொத்தானை அழுத்தவும்.

படம்  5.29ல். New Folder  என்ற க�ோப்புைற 

C++  என பெயர் மாற்றம் செய்யப்பட்டுள்ளது.

படம் 5.28. க�ோப்பு அல்லது க�ோப்புைறயைச் 

சுட்டியின் வலது ப�ொத்தானைப் பயன்படுத்தி  

மறுபெயரிடுதல்

படம்  5.29. C++என பெயர் மாற்றம் செய்யப்பட்ட 
க�ோப்புைற

முறை 3 
சுட்டியின் இடது ப�ொத்தானைப் பயன்படுத்தி 
மறுபெயரிடுதல்.
படி 1- 	 மறுபெயரிட விரும்பும் க�ோப்பு அல்லது 

க�ோப்புைறயைத் தேர்வு செய்க.
படி 2 – F2 ப�ொத்தானை அழுத்த வேண்டும் 
அல்லது க�ோப்பு அல்லது க�ோப்புைறயின் மீது  
கிளிக் செய்ய வேண்டும். க�ோப்பின் பெயரை சுற்றி 
ஒரு செவ்வக வடிவம் த�ோன்றும்.
படி 3 – புதிய பெயரைத் தட்டச்சு செய்க.
படி 4 – மறு பெயரிடும் செயலினை முடிக்க Enter   

அல்லது  OK ப�ொத்தானை அழுத்தவும்.

5. நீங்கள் உருவாக்கிய க�ோப்பினை File 
பட்டி, இடது சுட்டி, வலது சுட்டி  பயன்படுத்தி 

மறுபெயரிடுக.

பயிற்சி பட்டறை

5.11.5. க�ோப்பு மற்றும் க�ோப்புைறயை 
நகலெடுத்தல் அல்லது நகர்த்துதல்
	க� ோப்பு  மற்றும் க�ோப்புைறயை பிற 
பகுதிகளுக்கு நகர்த்துவதற்கு பல வழி முறைகள் 
உ ள்ளன   .
க�ோப்பு மற்றும் க�ோப்புைறயை நகர்த்துதல்:
முறை 1-வெட்டுதல் மற்றும்  ஒட்டுதல் 
•	 ஒரு க�ோப்பு அல்லது ஒரு க�ோப்புைறயை 

நகர்த்துவதற்கு முதலில் தேர்ந்தெடுக்க 
வேண்டும். பிறகு கீழ் வரும் வழி முறைகளில் 
ஏதேனும் ஒன்றை செய்க.

•	 Edit → Cut அல்லது Ctrl + X அல்லது 
வலது சுட்டி ப�ொத்தானை அழுத்தினால் 
மேல் மீட்புப் பட்டித் த�ோன்றும். அதில் Cut 
என்பதை தேர்வு செய்க.  

•	 க�ோப்பு அல்லது க�ோப்புைறயை புதிய 
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இடத்திற்கு நகர்த்துவதற்கு Edit→ Paste  
அல்லது  Ctrl + V     என்ற சாவி சேர்மானத்தை 
அல்லது வலது சுட்டி ப�ொத்தானை 
அழுத்தினால் மேல் மீட்புப் பட்டித் த�ோன்றும். 
அதில் Paste என்ற கட்டளையைத் தேர்வு 
செய்தால் , க�ோப்பு புதிய இடத்திற்கு 
ந க ர ்த ்த ப்ப  டு ம் .

முறை 2 – இழுத்துவிடுதல்	

•	 விண்டோஸின் இயக்க வட்டு சன்னல் 
திரையில், இடது மற்றும் வலது சாளரப் 
பிரிவுகள் உள்ளன. இடது சாளரப் பிரிவில் 
க�ோப்பு மற்றும் க�ோப்புைறகள் மரக் 
கிளைகள் ப�ோல் காட்சியளிக்கும். வலது 
சாளரப் பிரிவில், இடது சாளரத்தில் உள்ள ஒரு 
குறிப்பிட்ட க�ோப்பு அல்லது க�ோப்புைறகள் 
பல்வேறு விருப்பங்களுடன் காட்டப்படும். 

•	 இயக்க வட்டு சன்னல் திரையில்  நகர்த்தப்பட 
வேண்டிய க�ோப்பு அல்லது க�ோப்புைறகளை 
தேர்வு செய்க. 

•	 வலது பக்க சாளரத்தில் உள்ள க�ோப்பு 
அல்லது க�ோப்புைறயை இழுத்து, இடது பக்க 
சாளரப் பிரிவு க�ோப்புப்பட்டியில் சேர்க்கவும். 
பிறகு சுட்டியின் ப�ொத்தானை விடுவிக்கவும். 

•	 உங்கள் க�ோப்பு அல்லது க�ோப்புைறகள் 
புதிய பகுதியில் த�ோன்றும்.

படம்  5.30. இழுத்து விடுதல் முறையில் க�ோப்பு 
அல்லது க�ோப்புைறயை நகர்த்துதல்.

5.11.6 க�ோப்பு மற்றும் க�ோப்புைறகளை 
ந க லெ  டு த ்த ல்
	 க�ோப்பு மற்றும் க�ோப்புைறகளை 
நகலெடுக்க பல வழிகள் உள்ளன.
முறை 1
நகலெடுத்தல் மற்றும் ஒட்டுதல்
1.	ந கலெடுக்க வேண்டிய க�ோப்பு அல்லது 

க�ோப்புைறயை தேர்வு செய்க.
2.	 Edit → Copy  அல்லது Ctrl + C அல்லது 

சுட்டியின் வலது ப�ொத்தானை அழுத்தினால் 
மேல் மீட்புப் பட்டித் த�ோன்றும். அதில் Copy 
என்ற கட்டளையை தேர்வு செய்து புதிய 
இடத்தில் க�ோப்புைறயை ஒட்ட வேண்டும்.

3.	 ஒட்டுவதற்கு Edit → Paste அல்லது  Ctrl + V  
யைக் கிளிக் செய்ய வேண்டும்.

4.	 அல்லது, சுட்டியின் வலது ப�ொத்தானை 

அழுத்தினால் மேல்மீட்புப் பட்டித் த�ோன்றும். 

அதில் Paste என்ற கட்டளையை தேர்வு 

செய்க.

முறை 2 இழுத்துவிடுதல்
1.	 வலது சாளரப் பகுதியில் நகலெடுக்க 

வேண்டிய க�ோப்பு அல்லது க�ோப்புைறயைத் 
தேர்வு செய்ய வேண்டும்.

2.	தேர் வு செய்த க�ோப்பு அல்லது க�ோப்புைறயை, 
இடது சாளரப் பகுதியில் க�ோப்புைறப்பட்டியில் 
இழுத்து விட வேண்டும்.

3.	 புதிய பகுதியில் க�ோப்பு மற்றும் க�ோப்புறை 
த�  ோ ன் று ம்

3.	 புதிய இடத்தில் க�ோப்பு அல்லது க�ோப்புரை 
காணப்படும்.

குறிப்பு

ஒன்றுக்கும் மேற்பட்ட க�ோப்பு 

அல்லது க�ோப்புைறயைத் தேர்வு செய்ய  

Ctrl + Click யைப் பயன்படுத்த வேண்டும்.

5.11.6. நீக்கக் கூடிய வட்டிற்கு க�ோப்பு மற்றும் 
க�ோப்புைறயை நகலெடுத்தல்

	 நீக்கக் கூடிய வட்டிலிருந்து அல்லது 
வட்டுக்கு ஒரு க�ோப்பு அல்லது க�ோப்புைறயை 
நகலெடுக்க அல்லது அனுப்ப பல வழிகள் உள்ளன. 
1.	 நகலெடுத்தல் மற்றும் ஒட்டுதல்

2.	 Send To
முறை 1
நகலெடுத்தல் மற்றும் ஒட்டுதல்
	 USB flash இயக்கியை USB ல்  நேரடியாக 
இ ணை  க ்க வு ம் .
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•	 இணைக்கப்பட்ட USB flash இயக்கி 
தானாக திறக்கவில்லை எனில், கீழ்காணும் 
வழிமுறையைப் பின்பற்றுக.

•	 Start Computer கிளிக் செய்க. (படம் 5.31)
•	 நீக்கக்கூடிய இயக்கியுடன் த�ொடர்புடைய 

USB flash இயக்கியை இருகிளிக் செய்க. 
இப்போது, USB இயக்கி திறக்கப்படும். (படம் 
5.32)

•	 நகலெடுக்க வேண்டிய க�ோப்பின் மீது 
சுட்டியின் வலது ப�ொத்தானைக் கிளிக் செய்து 
த�ோன்றும் மேல் மீட்புப் பெட்டியிலிருந்து, 
Copy தேர்வைக் கிளிக் செய்க.

•	 இப்போது USB இயக்கிக்கு திரும்பி, காலி 
இடத்தில், சுட்டியின் வலது ப�ொத்தானைக் 
கிளிக் செய்து, கிடைக்கும் மேல்மீட்புப் 
பட்டியிலிருந்து, Paste தேர்வைக் கிளிக் 
செய்யவும். (படம் 5.34)

முறை – II Sent To
•	 USB flash இயக்கியை நேரடியாக USBல் 

இணைக்கவும்.

•	 க�ோப்புகள் அடங்கியுள்ள க�ோப்புைறயைத் 
திறந்து க�ொள்ளவும்.

•	 மாற்றப்பட வேண்டிய க�ோப்பின் மீது சுட்டியின் 
வலது ப�ொத்தானைக் கிளிக் செய்க.

•	 த�ோன்றும் மேல்மீட்பு பட்டியில், Send To 
என்ற தேர்வைக் கிளிக் செய்து, அதில் 
த�ொடர்புடைய USB flash இயக்கியைத் 
தேர்வு செய்க. (படம் 5.35)

படம் 5.31 Start பட்டி மூலம் கம்ப்யூட்டரைத்  

தேர்வு செய்தல்.

படம் 5.32 நீக்க கூடிய இயக்கியை இரட்டைக் 
கிளிக் செய்தல்

படம் 5.33 சுட்டியின் வலது ப�ொத்தானை Click 
செய்து க�ோப்பை நகலெடுத்தல்

6.	 நீங்கள் உருவாக்கிய க�ோப்பை மை 

கணினியில் இருந்து D வட்டு இயக்கிக்கு 

நகர்த்தவும்.

	 D:/ வட்டி இயக்கியில் உருவாக்கப்பட்ட 

க�ோப்ைப நீக்கக்கூடிய இயக்கிக்கு 

ம ாற்  று க .

பயிற்சி பட்டறை
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படம் 5.34 வலது கிளிக் மூலம் ஒட்டுதல்

5.11.7. க�ோப்பு மற்றும் க�ோப்புைறகளை 

நீ க் கு த ல்

•	 வட்டு இயக்கிகளிலிருந்து க�ோப்பு அல்லது 

க�ோப்புைறயை நீக்கும் ப�ோது அவை Recycle 
bin-க்கு நகரும்.

க�ோப்பு மற்றும் க�ோப்புைறகள் நீக்குதல்

	 நீக்கப்பட வேண்டிய க�ோப்பு அல்லது 

க�ோப்புைறயைத் தேர்வு செய்து க�ொள்க.

	 சுட்டியால் க�ோப்பு அல்லது க�ோப்புைறயை 

வலது ப�ொத்தானால் கிளிக் செய்யவும், மேல் 

மீட்பு பட்டி த�ோன்றும், அதிலிருந்து Delete என்ற  

விருப்பத்தைத் தேர்ந்தெடுக்கவும். அல்லது விசை 

பலகையில் Delete ப�ொத்தானை அழுத்தவும். 

க�ோப்பானது நீக்கம் செய்யப்பட்டு Recycle bin-
க்கு நகர்த்தப்படும்.

	 File → delete கிளிக் செய்யவும்

7.	 நீங்கள் உருவாக்கிய க�ோப்ைப My 
Document-ல் நகலெடுத்துக் க�ொண்டு,  

அதனை மூல பதிப்பை நீக்கவும்.

பயிற்சி பட்டறை

நீக்க கூடிய இயக்கி 

Removable disk

படம் 5.35. Send to மூலம் க�ோப்பை நகலெடுத்தல்

குறிப்பு
	 ஒரு க�ோப்பு அல்லது க�ோப்புைறயை 

நிரந்தரமாக கணிப்பொறியில் இருந்து 

Recycle bin-ல் தங்காமல் நீக்க SHIFT 

விசையுடன் Delete விசையும் சேர்த்து 

அழுத்த வேண்டும்.

மறு சுழற்சி த�ொட்டி (Recycle bin) 

	 மறுசுழற்சி த�ொட்டி என்பது, பயனரால் 
நீக்கப்பட்ட க�ோப்பு அல்லது க�ோப்புைறகள், 
தற்காலிகமாக சேமிக்கப்படும் சிறப்பு 
க�ோப்புைறயாகும். அழிக்கப்பட்ட க�ோப்புகளை 
மீட்டெடுக்க இது மீண்டும் ஒரு வாய்ப்பை 
வழங்குகிறது.  மறுசுழற்சித் த�ொட்டியிலுள்ள 
க�ோப்புகள் மட்டும் க�ோப்புைறகளை 
மீட்டெடுக்காமல் இயக்க முடியாது.

	 மறுசுழற்சி த�ொட்டியிலுள்ள ஒரு க�ோப்பு 
அல்லது க�ோப்புைறயை மீட்டெடுத்தல்:

•	 திரைமுகப்பிலிருந்து மறுசுழற்சி த�ொட்டியைத் 
திறக்கவும்.

•	 அதில், அழிக்கப்பட்ட க�ோப்புகள் அல்லது 
க�ோப்புைறகள் த�ோன்றும். மீட்டெடுக்க 
வேண்டிய க�ோப்பு அல்லது க�ோப்புைறயின் 
மீது வலது கிளிக் செய்யவும். அப்போது 
த�ோன்றும் மேல்மீட்புப் பட்டியிலிருந்து, Restore 
தேர்வைக் கிளிக் செய்யவும்.
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•	 மறுசுழற்சி த�ொட்டியிலுள்ள அனைத்து க�ோப்பு அல்லது க�ோப்புைறகளையும் மீட்டெடுக்க, Restore all 
என்ற பணிக்குறியைக் கிளிக் செய்யவும்.

•	 மறுசுழற்சி த�ொட்டியிலுள்ள அனைத்து க�ோப்பு அல்லது க�ோப்புைறகளையும் நிரந்தரமாக அழித்துவிட, 
“Empty Recycle bin” என்ற பணிக்குறியைக் கிளிக் செய்யவும். 

5.12 முகப்புத் திரையில் குறுக்கு வழி பணிக்குறி்களை உருவாக்குதல்.

	 உங்கள் வேலையைத் தானியங்கியாக மாற்றுவதற்கு உங்களுக்கு அடிக்கடி பயன்படும் க�ோப்புகள் 
மற்றும் க�ோப்புைறகளின் குறுக்கு வழிகளை உருவாக்கி, அதை முகப்புத் திரையில் வைக்கலாம்.  
திரை முகப்பில் க�ோப்பு அல்லது  க�ோப்புைறயின் குறுக்கு வழியைத் தேர்ந்தேடுக்கவும். வலது கிளிக் செய்யவும்.

•	 ஒரு மேல்மீட்புப் பட்டி த�ோன்றும். அதிலிருந்து Send to  Desktop (Create Shortcut) என்ற தேர்வை 
கிளிக் செய்க.

•	 விண்டோஸ் திரைமுகப்பில், க�ோப்பு அல்லது க�ோப்புைறயின் குறுக்குவழி பணிக்குறி த�ோன்றும். 
(படம் 5.36)

படம் 5.36 குறுக்கு வழி பணிக்குறி  முகப்புத் திரையில் உருவாக்குதல்

5.13. ஒரு கணிப்பொறியிலிருந்து முறையாக வெளியேறுதல்

	 அனைத்து பயன்பாடுகளையும் மூடிவிட்ட பின்னர், கணிப்பொறியின் இயக்கத்தை முறையாக 

நிறுத்தவிட்டு வெளியேற வேண்டும்.

Logoff/shutdown செய்ய:

•	 Start -> log off  அல்லது  Start -> Shut down கிளிக் செய்க. (படம் 5.37) 
•	 ஏதேனும் திறந்த நிரல்கள் இருக்குமாயின் அதை மூடச் ச�ொல்லி விண்டோஸ் கேட்கும், 

அவ்வாறு மூடாமல் விட்டால் கட்டாயப்படுத்தி (Force Shut Down) மூடும், அதனால் சேமிக்காத 
தகவல்களை இழக்க நேரிடலாம்.
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Figure 5.37. Log off தேர்வு
•	 Switch User
	 அடுத்த பயனர் கணக்கினுள் திறக்கப்பட்ட 
நிரல்கள் மற்றும் விண்டோஸின் செயல்களை 
மூடாமலே நுழைய விண்டோஸ் வழி வகுக்கும்.

•	 Log off
	 திறந்துள்ள அனைத்து நிரல்களும் முடிந்த 
பின்னரே அடுத்த பயனர் கணக்கிற்கு மாற்றம்  
செய்ய இயலும்.

•	 Lock
	 கணினியை விட்டு த�ொலைவில் இருக்கும் 
ப�ொழுது கணினியைப் பூட்டும் வசதி உள்ளது.

•	 Restart
	 கணிப்பொறியை மறு த�ொடக்கம் செய்வது 
(விண்டோஸ் இயக்க அமைப்பு மேம்படுத்தும் 
ப�ோதும் புதிய மென்பொருள் நிறுவும் ப�ோதும் இந்த 
விருப்பம் பயன்படும்).

•	 Sleep
	 குறைந்த மின் சக்தியில் கணிப்பொறி 
இயக்க இந்த நிலை பயன்படும். இந்த நிலையில் 
திறந்து வைக்கப்பட்டுள்ள அனைத்து 
பயன்பாடுகளும் இயங்கி க�ொண்டிருக்கும்.

	 சூப்பர் விரைவு மறுத�ொடக்கத்திற்கு 
விண்டோஸ்- யைக் கணினியின் நினைவகத்தில் 
இருந்து திறக்கும்.

•	 Hibernate
	 குறைந்த சக்தியில் கணிப்பொறி இருக்கும் 
ப�ோது எல்லா இயங்கும் நிரல்களும் விரைவு 
மறுத�ொடக்கத்திற்கு கணினியின் வன்வட்டில் 
விண்டோஸைத் திறக்கும்.

செயல்பாடு

மாணவர் செயல்பாடு
1. �விண்டோஸ்  இயக்கமைப்பில் க�ோப்பு மற்றும் 

க�ோப்புைறகளை உருவாக்கி ஒப்பிடவும்.

2. �விண்டோஸ் 7, விண்டோஸ் 8 மற்றும் 
விண்டோஸ் 10 இல் ஒரு க�ோப்பு / க�ோப்புரையை 

உருவாக்கவும். அதே நேரத்தில் நீங்கள் 
எதிர்கொள்ளும் வேறுபாடுகள் குறித்த 
அறிக்கையைத் தயாரிக்கவும்.

மதிப்பாய்வு

பகுதி – அ

சரியான விடையைத் 
தேர்ந்தெடுத்து எழுதுக

1.	 கீழே க�ொடுக்கப் 
பட்டுள்ளவற்றுள்  இயக்க 
அமைப்பு  நிர்வகிக்கும் 
செயல்களைத் தேர்வு செய்யவும்

	 (அ) நினைவகம்   	 (ஆ) செயலி

	 (இ) I/O சாதனங்கள்

	 (ஈ) இவை அனைத்தும்

2.	 விண்டோஸ் பயன்பாட்டில்  க�ோப்புகள் 
க�ொடாநிலையாக எந்த க�ோப்புைறயில் 
சேமிக்கப்படும்?

	 (அ) My document
	 (ஆ) My Picture
	 (இ) Document and settings
	 (ஈ) My Computer
3.	 எந்த இயக்கமைப்பில் shift + delete என்ற 
தேர்வு க�ோப்பு மற்றும் க�ோப்புைறயை நிரந்தரமாக 
நீக்கும்?

	 (அ) windows 7
	 (ஆ) windows 8
	 (இ) windows 10
	 (ஈ) இவற்றில் ஏதும் இல்லை
4.	 Windows XP/Windows 7 –ல் 
“ஹைபர்னேட்”என்பதன் ப�ொருள் என்ன?

	� அ) Safe modeல் கணினியை 
மறுத�ொடக்கம் செய்தல்.

	� ஆ) hibernate modeல் கணினியை 
நிறுத்துதல்.

	� இ) இயக்கத்தில் இருக்கும் 
பயன்பாடுகளை நிறுத்திய பிறகு 
கணினியை நிறுத்துதல்.

	� ஈ) இயக்கத்தில் இருக்கும் பயன்பாடுகளை 
நிறுத்தாமல் கணினியை நிறுத்துதல்.

5.	 சாளரங்களில் ஒரு க�ோப்பின் மறுபெயரிட 
பயன்படுத்தப்படும் குறுக்குவழி விசை

	 (அ) F2		  (ஆ) F4
	 (இ) F5		  (ஈ) F6
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பகுதி – ஆ

குறுவினாக்கள்

1.	 பல்பணியாக்கம் என்றால் என்ன ?

2.	செ ந்தர பணிக்குறி என்றால் என்ன ?

3.	க� ோப்பு மற்றும் க�ோப்புைறக்கு உள்ள வித்தியாசங்கள் யாவை?

4.	 Save மற்றும் Save As-க்கு உள்ள வித்தியாசங்கள் யாவை?

5.	 ஒரு க�ோப்பை எவ்வாறு மறுபெயரிடுவீர்கள்?

பகுதி – இ

சிறுவினாக்கள்

1.	� விண்டோஸ் இயக்க அமைப்பின் செயல்பாடுகள் யாவை?

2.	� மறுசுழற்சி பெட்டியை பற்றி ஒரு குறிப்பு வரைக.

3.	 விண்டோஸ் சன்னல் திரைக் கூறுகளைப் பற்றி குறிப்பு வரைக.

4.	 ஒரு க�ோப்புரையை உருவாக்கும் இரண்டு வழிமுறைகளை  எழுதுக.

5.	 வெட்டுதல் மற்றும் நகலெடுத்தல்- க்குப் உள்ளவேறுபாடுகள் யாவை?

பகுதி – ஈ

நெடுவினாக்கள்

1.	� விண்டோஸ் இயக்க அமைப்பின் பலவகையான பதிப்புகளை விவரி.

2.	� ஒரு க�ோப்பு அல்லது க�ோப்புரையை தேடிக் கண்டுபிடிக்கும் பல்வேறு வழிமுறைகளை விளக்குக. 

3.	� விண்டோஸ் இயக்க அமைப்பில் குருக்கு வழி பணிக்குறிகளை உருவாக்கும் செயல் முறையை 
விளக்குக-ல் குறுக்குவழியை உருவாக்க செயல்முறை எழுதவும்.

ச�ொற்களஞ்சியம்

இயக்க அமைப்பு
அமைப்பு மென்பொருளானது பிற மென்பொருளுடன் 

த�ொடர்புக�ொள்வதற்கும் மற்றும் வன்பொருள்களைச் செயல்படுத்துகிறது

சுட்டி
ஒரு GUI - இல் ஒரு சுட்டியைக் கட்டுப்படுத்துகின்ற கையுறை வன்பொருள், 

உள்ளீடு சாதனம் மற்றும் உரை குறும்படங்கள், க�ோப்புகள் மற்றும் 

க�ோப்புறைகள் ஆகியவற்றை நகர்த்தவும், தேர்ந்தெடுக்கவும் முடியும்.

விண்டோஸ் மைக்ரோசாப்ட் நிறுவனம் உருவாக்கிய பிரபலமான இயக்க அமைப்பு.

திரைமுகப்பு விண்டோஸ் இயக்க அமைப்பின் முகப்புதிரை

குறும்படம் ஒரு கட்டளையைக் குறிக்கும் சிறிய படம்

க�ோப்புைற க�ோப்புகளை உள்ளடக்கிய க�ொள்கலன்

லினக்ஸ் ஒரு இயக்க அமைப்பு
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பகுதி – I   ச�ொற்செயலி ஓர் அறிமுகம்

 கற்றலின் ந�ோக்கங்கள்

•	 ச�ொற்செயலியின் 
முக்கியத்துவத்தை புரிந்து 
க�ொள்ளுதல்.

•	 ஓபன் ஆஃபீஸ் 
பயன்பாடுகளை புரிந்து 
க�ொள்ளுதல்.

•	 ஓபன் ஆஃபீஸ் ரைட்டர் சன்னல் திரைகளில் 
வேலை செய்வது மற்றும் புரிந்து க�ொள்ளுதல்.

•	 ஓபன் ஆஃபீஸ் ரைட்டரில் பதிப்பித்தலுக்கான 
செயல்பாடுகள் அறிந்து க�ொள்ளுதல்.

•	 ஓபன் ஆஃபீஸ் ரைட்டரில் உரை  மற்றும் பக்க 
வடிவூட்டல் பற்றி அறிந்து க�ொள்ளுதல்.

•	 ஓபன் ஆஃபீஸ் ரைட்டரில் உள்ள எழுத்துப் 
பிழைகளைக் கண்டறியும் சிறப்பு அம்சங்களை 
பற்றி அறிந்து க�ொள்ளுதல்..

குறிப்பு

இந்த பாடத்தில் உள்ள பயிற்சிகளை 

தமிழிலேயே செய்யலாம்.

பாடம் 6அலகு II ச�ொற்செயலி

6.1 ச�ொற்செயலி ஓர் அறிமுகம் 

	 ஒரு உரை ஆவணத்தை உருவாக்குதல், 
பதிப்பித்தல், கையாளுதல், பரிமாற்றம் செய்தல், 
சேமித்தல் மற்றும் திரும்ப எடுத்தல் ஆகிய 
செயற்பாடுகளைச் செய்யும் கணிப்பொறி 
மென்பொருள் “ச�ொற்செயலி” (Word processor) 
எனப்படும். இம்மென்பொருளைப் பயன்படுத்தி 
செய்யப்படும் செயல்கள் “ச�ொற்செயலாக்கம்” 
(Word processing) என்று அழைக்கப்படுகிறது. 
“ச�ொற்செயலாக்கம் என்பது கணிப்பொறியில் 
ப�ொருத்தமான ஒரு மென்பொருளைப் 
பயன்படுத்தி உரை ஆவணங்களை 
உருவாக்குதல், பதிப்பித்தல், கையாளுதல், 
பரிமாற்றுதல், சேமித்தல் மற்றும் திரும்ப எடுக்கும் 
செயற்பாடாகும்.”

	ப� ொதுவாக ச�ொற்செயலி  
மென்பொருள்கள், தனியுரிமை ஆதார 
(Proprietary source) மற்றும் திறந்த மூல (Open 
source) ச�ொற்செயலிகளாக கிடைக்கின்றன. 
பிரபலமான ச�ொற்செயலி த�ொகுப்புகளை 
பின்வரும் அட்டவணை 6.1ல் காணலாம்.

அட்டவணை 6.1 தனி உரிமை ஆதாரம் மற்றும் திறந்த மூல மென்பொருள்

தனியுரிமை ஆதார ச�ொற்செயலிகள் திறந்த மூல ச�ொற்செயலிகள்

மென்பொருள் 
த�ொகுப்பு (Package)

உருவாக்கியவர்
(Developer)

மென்பொருள் 
த�ொகுப்பு (Package)

உருவாக்கியவர்
(Developer)

மைக்ரோ சாஃப்ட் 
வேர்டு 

(Microsoft Word)

மைக்ரோ சாஃப்ட் 
கார்ப்பரேசன் 

(Microsoft Corporation)

ஓபன்ஆஃபீஸ் ரைட்டர் 
(OpenOfficeWriter)

அப்பாச்சி 
(Apache)

WPS வேர்டு
கிங் சாப்ட்
(Kingsoft)

லிபரே ஆஃபீஸ் 
ரைட்டர்

(Libre Officewriter)

தி டாக்குமென்ட் 
ப�ௌண்டேசன்

(The document 
foundation)

வேர்டுப்ரோ 
(Word Pro)

ல�ோட்டஸ் கார்ப்பரேசன்
(Lotus Corporation)

அபிவேர்டு
(Abiword)

அபி ஸ�ோர்ஸ்
(AbiSource)
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தமிழ் ச�ொற்செயலிகள்: (Tamil Word 
P r o c e s s o r s )

	த மிழ் ஓபன்ஆஃபீஸ் 
ரைட்டர் (Tamil OpenOffice 
writer), தமிழ் லிப்ரேஆஃபீஸ் 
ரைட்டர் (Tamil Libre 
Office), கம்பன் 3.0 (Kamban 
3.0), மென்தமிழ் 2017 (Mentamizh 2017) - 
இவை தமிழ் ம�ொழியில் மட்டுமே பிரபலமான 
ச�ொற்செயலிகள் ஆகும். மைக்ரோ சாஃப்ட் 
நிறுவனத்தின் ஆஃபீஸ் த�ொகுப்பு தமிழ் 
இடைமுகத்துடன்  செயல்படுகிறது. 

இந்த பாடப்பகுதியில் ஓபன் ஆஃபீஸ் ரைட்டர் 
ச�ொற்செயலியை பற்றி கற்க உள்ளோம்.  

6.2 ஓபன் ஆஃபீஸ் ரைட்டர் ஓர் அறிமுகம்:

	 ஓபன் ஆஃபீஸ் என்பது ஆவணங்கள், 
அட்டவணைத்தாள் (Worksheet), நிகழ்த்துதல் 
(Presentation), வரைபடம் (Graphics), 
தரவுத்தளங்கள் (Databases) ப�ோன்றவற்றை 
உருவாக்கப் பயன்படுத்தப்படும் ஒரு முன்னணி 
திறந்த மூல அலுவலக மென்பொருள்களின் 
த�ொகுப்பாகும். இந்த மென்பொருளை   
அனைத்து வகை கணிப்பொறிகளிலும், 
எல்லா ம�ொழிகளிலும் பயன்படுத்தலாம். இதில் 
அனைத்து தரவுகளையும் சர்வதேச திறந்த 
நிலை தர வடிவமைப்பில் (International open 
standard format) சேமித்து, மற்ற ப�ொதுவான 
அலுவலக மென்பொருள் த�ொகுப்புகளில் உள்ள 
க�ோப்புகளை படிக்கவும், எழுதவும் முடியும். 
ஓபன்ஆஃபீஸ் மென்பொருள் கற்பதற்கு மிகவும் 
எ ளி மை  ய ான  து . 

	 ஓபன்ஆஃபீஸ் பல்வேறு அலுவலக 
த�ொகுப்புகளை உருவாக்கக்கூடிய கீழ்க்கண்ட 
மென்பொருள்களை க�ொண்டுள்ளது. 

•	 ஓபன்ஆஃபீஸ் ரைட்டர் (OpenOffice 
Writer) - உரை ஆவணங்களை உருவாக்கப் 
பயன்படும் ச�ொற்செயலி

•	 ஓபன்ஆஃபீஸ் கால்க் (OpenOffice Calc) 
- அட்டவணைத் தாள்களை உருவாக்கப் 
பயன்படும் அட்டவணைச் செயலி\

•	 ஓபன்ஆஃபீஸ் பேஸ் (OpenOffice Base) –
தரவுத்தளங்களை உருவாக்கப் பயன்படும் 
மென்பொருள்.

•	 ஓபன்ஆஃபீஸ் இம்ப்ரெஸ் (OpenOffice 
Impress) - நிகழ்த்துதலை உருவாக்கப் 
பயன்படும் மென்பொருள்.

•	 ஓபன்ஆஃபீஸ் ட்ரா (OpenOffice Draw) - 
படங்கள் வரைய பயன்படும் மென்பொருள்

•	 ஓபன்ஆஃபீஸ் பார்முலா (OpenOffice 
Formula) - வாய்ப்பாடுகள் மற்றும் 
சமன்பாடுகளை உருவாக்க.

	 ஓபன்ஆஃபீஸ் ரைட்டர் என்பது 
ஓபன்ஆஃபீஸ் த�ொகுதியிலுள்ள 
ச�ொற்செயலியாகும். ஒரு ச�ொற்செயலியின் 
வழக்கமான சிறப்பியல்புகளான,  எழுத்துப்பிழை 
திருத்துதல் (Spelling Check),ச�ொற்களஞ்சியம் 
(Thesarus), ச�ொற்களை சிறுக�ோடிட்டு சேர்த்தல் 
(Hyphenation), தானியங்கு சரிசெய்தல் 
(Autocorrect), கண்டுபிடித்து மாற்றுதல் (Find 
&Replace) ப�ொருளடக்கம் மற்றும் குறியீட்டு 
அட்டவணைகளின் தானியங்கு உருவாக்கம் 
(Automatic Generation of Table of contents 
and indexes), அஞ்சல் இணைப்பு (Mail 
Merge) ப�ோன்றவை நீங்கலாக,ரைட்டர் கீழே 
க�ொடுக்கப்பட்டுள்ள முக்கிய சிறப்பியல்புகளை 
வ ழங்  கு கி ன ்ற து :

•	 வார்ப்புருக்கள் மற்றும் பாணிகள் (Templates  
and Styles) 

•	 சட்டகங்கள் (Frames), நெடுவரிசைகள் 
மற்றும் அட்டவணைகள் உள்ளிட்ட பக்க 
வடிவமைப்பு முறைகள்.

•	 வரைபடங்கள், அட்டவணைச் செயலிகள் 
மற்றும் பிற ப�ொருட்களை உட்பொதித்தல் 
அல்லது இணைத்தல்

•	 வரைதலுக்கான உள்ளிணைந்த கருவிகள்.

•	 பல ஒற்றை ஆவணங்களை ஒரு முதன்மை 
ஆவணமாக (Master Document) 
உ ரு வ ாக்  கு த ல் .

•	 ஆவணங்களைத் திருத்தும்போது அதன் 
நடையை மாற்றும் வசதி (Track changes to 
document)

•	 நூலகத் தரவுத்தள பட்டியல் சேர்த்தலுடன் 
இணைந்த தரவுத்தள ஒருங்கிணைப்பு 
(Database integration, including a 
bibliography database)

•	 ஆவணத்தை PDF வடிவிற்கு ஏற்றம் செய்தல்.
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6.2.1 கணிப்பொறியில்  ஓபன் ஆஃபீஸ் 
பதிவிறக்கம் செய்து நிறுவுவதற்கு	

	 http://www.openoffice.org/download 
என்ற இணையத்திலிருந்து ஓபன்ஆஃபீஸின் 
அண்மைப் பதிப்புகளை இலவசமாக 
பதிவிறக்கம் செய்து நிறுவலாம்.

6.2.2 ஓபன்ஆஃபீஸ் ரைட்டரில் ஒரு புதிய 
ஆவணத்தை உருவாக்குதல்

	 ஓபன்ஆஃபீஸ் ரைட்டரில் ஒரு புதிய 
ஆவணத்தை  பல்வேறு வழிமுறைகளில் 
உருவாக்கலாம். 

விண்டோஸ் இயக்க அமைப்பிலிருந்து

StartAll Programs  OpenOffice  
OpenOffice Writer 

(அல்லது)

ஸ்டார் சென்டர் (Star Center) வரவேற்பு 
திரையிலிருந்து  

•	 விண்டோஸ் திரை முகப்பிலுள்ள, 
OpenOffice பணிக்குறியை இருமுறை 
கிளிக் செய்யவும் 

•	 இப்பொழுது படம் 6.1 ல் காட்டப்பட்டுள்ளது 
ப�ோன்ற ஒரு வரவேற்பு திரை த�ோன்றும் 

Open Office Writer

படம் 6.1 ஓபன்ஆஃபீஸ் வரவேற்பு திரை 

•	 இந்த வரவேற்புத்  திரை “ஸ்டார் சென்டர்” 
(Star Center) என்றழைக்கப்படுகிறது. 
ரைட்டர், ஓபன்ஆஃபீஸின் ஒரு பயன்பாடு 
ஆகும்.எனவே, “ஸ்டார் சென்டர்” – ல் உள்ள  
“Text Document” பணிக்குறியை 
அழுத்தியும் இதனைப் பெறலாம்.

(அல்லது)

	 படம் 6.2 ல் க�ொடுக்கப்பட்டுள்ளது ப�ோல 
File  New  Text Document என்ற 
கட்டளை அல்லது Ctrl + N என்ற விசைப் பலகை 
குறுக்குவழியை பயன்படுத்தியும்  ஒரு புதிய 
ஆவணத்தை உருவாக்கலாம்.

படம் 6.2 ஓபன்ஆஃபீஸ் ரைட்டர் சன்னல் திரை

6.2.3. ரைட்டர் சன்னல் திரையின் பாகங்கள்

	 ஓபன்ஆஃபீஸ் ரைட்டர் சன்னல் திரை 

படம் 6.3 – ல் காட்டியுள்ளது ப�ோல தலைப்பு 

பட்டை(Title bar), பட்டி பட்டை (Menu 
bar),செந்தர கருவிப்பட்டை (Standard Toolbar), 

வடிவூட்டல் கருவிப்பட்டை (Formatting Toolbar), 

ரூலர் (Ruler), பணியிடம் (Workspace) மற்றும் 

நிலைமைப்பட்டை (Status bar) ப�ோன்றவற்றை 
க�ொண்டுள்ளது. படம் 6.3 -ல் உள்ள ஓபன்ஆஃபீஸ் 

ரைட்டர் சன்னல் திரையின் பாகங்கள் கீழே  

விளக்கப்பட்டுள்ளது.

தலைப்புப் பட்டை (Title bar)

	தல ைப்புப் பட்டை சன்னல் திரையின் 
மேல் பகுதியில் த�ோன்றும். இதில் ஆவணத்தின் 
தலைப்பு மற்றும் பயன்பாட்டின் பெயர் த�ோன்றும்.
ஆவணத்திற்கு பெயரிடப்படவில்லையெனில் 
Untitled1 என்ற பெயர் தானமைவாகஅமையும். 

கட்டுப்பாட்டு ப�ொத்தான்கள் (Control buttons)
மீட்டமை

படம் 6.4 அளவிடும் ப�ொத்தான்கள் 

	 தலைப்பு பட்டையின் வலதுபுற மூலையில்    
1. சிறிதாக்கு (Minimize) 2. பெரிதாக்கு/ 
மீட்டமை (Maximize / Restore) 3.மூடு (Close)
என்ற கட்டுப்பாட்டு ப�ொத்தான்கள் உள்ளன.
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கட்டுப்பாட்டு 

ப�ொத்தான்கள்

பட்டி பட்டை

ரூலர்

உருள் பட்டைகள்

கருவிப் பட்டை

செருகும் புள்ளி

நிலைமைப் பட்டை

ஆவணத்தின் பெயருடன் கூடிய தலைப்பு பட்டை

படம் 6.3 ரைட்டர் சன்னல் திரையின் பாகங்கள்

1.	 சிறிதாக்கு ப�ொத்தான் :

	 சிறிதாக்கு ப�ொத்தானை கிளிக் செய்தால், ஆவண சன்னல் திரையை சிறிய அளவிற்கு சுருக்கி 
பணி பட்டியில் ஒரு சிறிய ப�ொத்தானாக காட்டும். மீண்டும் ஆவணத்தை அதன் மூல அளவிற்கு 
மீட்டமைக்க, சுட்டெலியைப் பணிப்பட்டையில் உள்ள ஓபன்ஆஃபீஸ்பொத்தான் மீது நகர்த்தினால், 
சுருங்கிய அளவில் உள்ள ஆவணத்தை ஒரு சிறிய படமாக (Miniature) காணலாம்.  இந்த ப�ொத்தானைக் 
கிளிக் செய்தால் ஆவணம் மூல அளவிற்கு மீண்டும் மீட்டமைக்கப்படும். 

படம் 6.5. Open Office ஆவணத்தை சிறிய படமாக க�ொண்ட திரை

2. பெரிதாக்கு ப�ொத்தான்:

	 பெரிதாக்கு ப�ொத்தானை கிளிக் செய்தால், ஆவணத்தின் சன்னல் திரை முழு அளவில் திரையில் 
த�ோன்றும். ஆவணத்தின் சன்னல் திரை முழு திரையில் காட்டப்படும் ப�ொழுது “பெரிதாக்கு” ப�ொத்தான் 
“மீட்டமை” ப�ொத்தானாக மாற்றம் பெறும். 

Exit /Quit

ஆவணத்தை மூட

படம் 6.6 மூடு மற்றும் ஆவணத்தை மூடு ப�ொத்தான்கள்
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	 மீட்டமை ப�ொத்தானை கிளிக் செய்தால், 
ஆவணத்தின் சன்னல்திரை அதன் மூல 
அளவை மீண்டும் பெறும்.

3. மூடு ப�ொத்தான்:	
	ப டம் 6.6 ல் சிவப்பு நிறத்தில்  உள்ள மூடு 
ப�ொத்தானை “Exit” அல்லது “Quit” என்று 
அழைக்கலாம்.இந்த ப�ொத்தானை கிளிக் 
செய்தால் பயன்பாடு மூடப்பட்டு ஓபன் ஆபீஸ், 
விண்டோஸ் திரைமுகப்புக்குத் திரும்பிவிடும். 

	 பணிப் பட்டையின் வலது மூலையில் 
மற்றொரு X என்ற குறி உள்ளது. இந்த குறி 
உங்கள் ஆவணத்தை மூடுவதற்கு உதவும். இந்த 
X குறியைக் கிளிக் செய்தால் உங்கள் ஆவணம் 
மூடப்படும், ஆனால் ஓபன்ஆஃபீஸ் திறந்து 
இருக்கும்.

பட்டிப்பட்டை

	 தலைப்பு பட்டையின் கீழே உள்ள 
பட்டிப்பட்டையில் பல்வேறு விருப்பங்களுடன் 
கூடிய பட்டிகள் உள்ளன. ஒவ்வொரு பட்டியும் 
பல்வேறு தேர்வுகளைக்  க�ொண்டுள்ளன.

படம் 6.7 பட்டிப்பட்டை

File 
	க�ோ ப்பு மேலாண்மை பணிகளான, ஒரு 
புதிய க�ோப்பை உருவாக்குதல், திறத்தல், மூடல், 
சேமித்தல், சேமித்த க�ோப்பை வேறு பெயரில் 
சேமித்தல், அச்சிடல், க�ோப்பு ஏற்றம் செய்தல் 
ப�ோன்ற பல்வேறு  விருப்பங்கள் File 
பட்டிப்பட்டையில் உள்ளன.
Edit 

	 பதிப்பு (Edit) பட்டிப்பட்டையில் 
பதிப்பித்தலுக்குத்  தேவையான நகல் எடுத்தல் 
(Copy), வெட்டுதல் (Cut), ஒட்டுதல் (Paste), 
செயல்தவிர் (undo), மீண்டும் செய் (Redo) 
ப�ோன்ற விருப்பங்கள்  உள்ளன. 

View 

	 வலை வடிவமைப்பு, அச்சு வடிவமைப்பு, 
நேவிகேட்டர் ப�ோன்ற ரைட்டரின்சூழலை மாற்ற 
பயன்படும் விருப்பங்கள் View பட்டிப்பட்டையில் 
உள்ளன.

Insert

	 படங்கள், அட்டவணைகள், 

வரைபடங்கள், கருத்துகள், தலைப்புகள், 
அடிக்குறிப்புகள், சிறப்பு குறியீடுகள், குருக்கு 
மேற்கோள் ப�ோன்ற பல்வேறு கூறுகளை 
செருகுவதற்கான கட்டளைகள் Insert 
பட்டிப்பட்டையில் உள்ளன.

Format 
	 வடிவமைப்பு பட்டிப்பட்டையில் உரை 
மற்றும் பக்க வடிவமைப்பிற்கான பக்க அளவு, 
அமைப்பு, எழுத்துரு பண்புகள், புல்லட் குறி 
மற்றும் எண் வரிசை ப�ோன்ற அம்சங்கள்  
உள்ளன.

Table

	 அட்டவணை பட்டியில் அட்டவணைகளை 
உருவாக்குதல், வரிசைகள், நெடுவரிசைகளைச் 
சேர்த்தல், சிற்றரைகளாக பிரித்தல், 
சிற்றரைகளை இணைத்தல் மற்றும் அட்டவணை 
நிர்வகிக்கவும், கையாளவும் பல்வேறு கருவிகள் 
உள்ளன.

Tools 
	 கருவிகள் பட்டியில் எழுத்துப்பிழை 
சரிபார்த்தல், குறுநிரல்கள் (Macros), அஞ்சல் 
இணைப்பு, இறுதி குறிப்புகள்/அடிக்குறிப்புகள் 
ப�ோன்ற பல கருவிகள் மற்றும் செயல் 
கூறுகளைக் க�ொண்டுள்ளது. 

Window
Window பட்டியில் புதிய Window திறக்க, மூட, 
பிரிக்க மற்றும் செயலிழக்க (Freeze) 
செய்வதற்கான விருப்பங்கள் உள்ளன.

Help 
	 ஓபன்ஆஃபீஸ் help பட்டிப்பட்டையில் 
உள்ளமைந்த (built-in) உதவி அம்சங்கள் 
உள்ளன.

கருவிப்பட்டை (Tool bar):

இயல்பாகவே பட்டிப்பட்டையின்  கீழ் இரண்டு 
கருவிப் பட்டைகள்  உள்ளன. 

அவை :

1.	 செந்தர (Standard) கருவிப்பட்டை

2.	 வடிவூட்டல் (Formatting) கருவிப்பட்டை

செந்தர கருவிப்பட்டை

	 செந்தர கருவிப்பட்டை பட்டிப்பட்டையின் 
கீழ் உள்ளது. வெட்டுதல், நகலெடுத்தல், ஒட்டுதல், 
செயல்தவிர்  ப�ோன்ற அடிக்கடி 

XI Std Computer Technology Vol-1 TM Chapter 6 .indd   77 20-04-2020   14:33:10



78 79

உபய�ோகப்படுத்தக் கூடிய குறுக்கு வழி பணிக்கூறுகள் உள்ளன. (படம் 6.8ஐ பார்க்க)

படம் 6.8 செந்தர  கருவிப்பட்டை

வடிவூட்டல் கருவிப்பட்டை

	 செந்தர கருவிப்பட்டையின்  கீழ் வடிவூட்டல் கருவிப்பட்டை உள்ளது. உரையை தடித்த 
எழுத்துக்களாக (bold), அடிக�ோடிட(underline), சாய்ந்த (italics) எழுத்துக்களாக மாற்ற, எழுத்துரு 
வகை (font type), எழுத்து வகையின் நிறம் (font color) ப�ோன்ற வடிவமைப்பதற்கான பணிக்குறிகளைக் 
க�ொண்டுள்ளது.(படம் 6.9ஐ பார்க்க)

படம் 6.9  வடிவூட்டல்  கருவிப்பட்டை

ரூலர் (Ruler)

	 பக்க ஓரங்களை காட்டும் அளவுக�ோளாக ரூலர், வடிவூட்டல் கருவிப்பட்டையின் கீழ் உள்ளது. 
இரண்டு வகையான ரூலர்கள் உள்ளன. 

படம் 6.10 ரூலர் (Ruler)

1.	 கிடை மட்ட ரூலர் (Horizontal) 

2.	 செங்குத்து ரூலர் (vertical) 

	 கிடைமட்ட ரூலர் (Horizontal ruler) 
பக்கத்தின் இடது மற்றும் வலது ஓரங்களையும், 
செங்குத்து ரூலர் (vertical ruler) பக்கத்தின் 
மேல் மற்றும் கீழ் ஓரங்களை அமைக்க 
பயன்படுகிறது.

தட்டச்சு செய்யும் இடம் (Work space)

	 ஆவணம் திறக்கப்பட்டவுடன், திரையில் 
உள்ள தட்டச்சு செய்வதற்கான காலியான 
இடத்தை தட்டச்சு செய்யும் இடம் என்று கூறுவர். 
அந்த இடத்தில் ஆவணத்தை தட்டச்சு செய்ய 
வேண்டும். திரையின் ஆரம்பத்தில் விட்டு விட்டுத் 
த�ோன்றும் நெடுப்பட்டையை செருகும் இடம் 
(Insertion pointer) என்றழைக்கப்படும்.

நிலைப் பட்டை (Status bar)

	 சன்னல் திரையின் கீழ் உள்ள நிலைப் 
பட்டையில் ஆவணத்தின் தற்போதைய நிலை 
தெரியும். அந்த நிலைப்பட்டையில் பக்கங்களின் 
எண்ணிக்கை, தற்போதைய பக்க எண், இயல்பு 
ம�ொழி ப�ோன்றவை த�ோன்றும்.

6.2.4 உரையை உள்ளீடுதல் அல்லது உள்ளீடல்

	 புதிதாக ஆவணம் திறக்கப்பட்டவுடன், 
திரையில் உள்ள பெரிய காலியான இடத்தில் 
உரையை தட்டச்சு செய்யலாம். ஒவ்வொரு 
எழுத்தாகத் தட்டச்சு செய்யும் ப�ொழுது விட்டு 
விட்டுத் த�ோன்றும் (flashing) நெடும்பட்டை 
(vertical bar) ஒன்று வலது புறமாக நகர்ந்து 
க�ொண்டே இருக்கும். இதற்கு செருகும் புள்ளி 
என்று பெயர். ஒரு வரியின் கடைசி வரை தட்டச்சு 
செய்து விட்டால் அதைத் த�ொடர்ந்து வரும் 
எழுத்துக்கள் தானாகவே மடிந்து அடுத்த 
வரியின் த�ொடக்கத்திற்கு செல்லும். இது 
ச�ொற்செயலியில்  “ச�ொல் மடிப்பு” (Word wrap) 
என்று அழைக்கப்படும்.

	 நுழைவுப் (Enter) ப�ொத்தானை 
ஒவ்வொரு வரியின் இறுதியிலும் அழுத்த 
வேண்டியது  இல்லை. ஒரு பத்தியின் கடைசியில�ோ 
அல்லது ஒரு காலி வரி வேண்டுமென்றால�ோ 
மட்டும் தான் நுழைவுப் ப�ொத்தானை அழுத்த 
வேண்டும். ஒரு பக்கம் நிறைந்தவுடன் ஓபன் 
ஆபீஸ் ரைட்டர் தானாகவே அடுத்த புதிய 
பக்கத்தை உருவாக்கிக் க�ொள்ளும். 

6.2.5 ஆவணத்தினுள் நகர 

	 ஒரு ஆவணத்தினுள் செருகும் புள்ளியை 
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நகர்த்த பல்வேறு வழிகள் உள்ளன. அட்டவணை 
6.2 - ல் ஆவணத்தினு்ள்  எளிதில் நகர்வதற்கான 
பல குறுக்கு வழிகள் க�ொடுக்கப்பட்டுள்ளன.

அட்டவணை 6.2 விசைப்பலகை குறுக்கு வழி 
சாவிகள்

சாவி நகர்த்துவதற்கு

 ஒரு எழுத்து வலதுபுறமாக

 ஒரு எழுத்து இடப்புறமாக

 ஒரு வரி மேலே செல்ல

 ஒரு வரி கீழே செல்ல

Ctrl +  வலது புறத்தில் உள்ள ஒரு 
ச�ொல் அளவிற்கு

Ctrl +  இடது புறத்தில் உள்ள ஒரு 
ச�ொல் அளவிற்கு

Ctrl +  ஒரு பத்தி மேலே செல்ல

Ctrl + ஒரு பத்தி கீழே செல்ல

Home வரியின் த�ொடக்கத்திற்கு

End வரியின் இறுதிக்கு

Ctrl +Home ஆவணத்தின் 
த�ொடக்கத்திற்கு

Ctrl + End ஆவணத்தின் இறுதிக்கு

Tab சிற்றரையின் முன்புறமாக

Shift + Tab சிற்றரையின் பின்புறமாக

Pg Up(Page up) முன்பக்கத்திற்கு செல்ல

Pg Dn (Page 
Down)

அடுத்த பக்கத்திற்குச் 
செல்ல

6.2.6 ஆவணத்தைச் சேமித்தல்

	 முதன்முறையாக ஒரு ஆவணத்தைச் 
சேமிக்கும் ப�ோது, ஓபன்ஆஃபீஸ் ரைட்டர் அந்த 
ஆவணத்தை எந்தப் பெயரில் சேமிப்பது என்று 
பயனரை வினவும். ஆவணத்திற்கு பெயரிடுவதன் 
மூலம் அதனைப் பிரித�ொரு நேரத்தில் தேடுவதும், 
திறப்பதும் இயலும். பயனர் எந்த இயக்கி (Drive) 
மற்றும் எந்த உறையில் (Folder) அந்த 
ஆவணத்தைச் சேமிக்க வேண்டும் என்பதையும் 
தேர்வு செய்யலாம். முதன் முறையாக ஒரு 
ஆவணத்தை சேமிப்பதற்கான வழிகள் 
பின்வருமாறு :

•	 File ->Save அல்லது File -> Save As 
அல்லது ctrl + S  கிளிக் செய்க

•	 “Save As” என்ற உரையாடல் பெட்டி படம் 
6.11- ல் உள்ளது ப�ோல் த�ோன்றும்.

உரிய இடத்தில் சேமிக்கவும்

Save with 
Password

சேமிக்கும் 

வகை

File Name

சேமிப்பு  ப�ொத்தான்

List of drivers and folders

படம் 6.11 Save As உரையாடல் பெட்டி
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•	 ஆவணத்தை சேமிக்கும் இடத்தை தேர்வு 
செய்ய வேண்டும். இடம் தேர்வு செய்யாவிடில் 
அனைத்து ஆவணங்களும் தானாகவே 
விண்டோஸில்  உள்ள “Documents” 
க�ோப்புறையில் சேமிக்கப்படும்.

•	 ஆவணத்தின் பெயரை File Name உரைப் 
பெட்டியில் தட்டச்சு செய்ய வேண்டும்.

•	 ஓபன்ஆஃபீஸ் ரைட்டரில் உள்ள அனைத்து 
ஆவணங்களும் .odt நீட்டிப்புடன் 
சேமிக்கப்படும். பயனர் ஓபன் ஆபீஸ் 
ஆவணத்தை மைக்ரோசாப்ட்வேர்டு 
(Microsoft Word) ஆவணம் அல்லது PDF 
வடிவில் சேமிக்கலாம். அவ்வாறு செய்ய “Save 
As type” பட்டியல் பெட்டியில் உள்ள க�ோப்பு 
வகையை தேர்வு செய்ய வேண்டும். 

•	 இறுதியாக Save ப�ொத்தானைக் கிளிக் 
செய்ய வேண்டும்.

•	 ஒரு முறை க�ோப்பை சேமித்தவுடன், 
ஆவணத்தின் பெயர் தலைப்புப் 
பட்டையில்(Title Bar) த�ோன்றும்.

கடவுச் ச�ொல்லுடன் ஆவணத்தை சேமிப்பது

•	 ஓபன் ஆபீஸ்  ரைட்டரில் ஆவணத்தை கடவுச் 
ச�ொல்லுடன்  பாதுகாக்கலாம். ஆவணத்தை 
பாதுகாக்க சேமிக்கும் ப�ோதே கடவுச் ச�ொல்லை  
அமைத்து ஆவணத்தை  பாதுகாக்கலாம்  . 
கடவுச் ச�ொல்லுடன் ஒரு க�ோப்பை சேமிக்கபடம் 
6.11 ல் உள்ள “Save with Password” (கடவுச் 
ச�ொல் மூலம் சேமித்தல் ) என்ற தேர்வுப் 
பெட்டியை  (Check box) கிளிக் செய்த பின் 
“Save” ப�ொத்தானை அழுத்த வேண்டும். 
உடனடியாக கடவுச்சொல் உரையாடல் பெட்டி 
படம் 6.12 ல் உள்ளவாறு த�ோன்றும்.

கடவுச் ச�ொல்லை தட்டச்சு செய்யவும் 

Enter the same password

அறிவிப்புகளை கவனமாக படிக்கவும்

Click "OK" to Finalise

படம் 6.12 கடவுச்சொல் உரையாடல் பெட்டி

	 இந்த உரையாடல் பெட்டியில், கடவுச் 
ச�ொல்லை “Enter Password to open” என்ற 
உரைப்பெட்டியில் தட்டச்சு செய்து, உறுதிப்படுத்த 
“Confirm Password” என்ற பெட்டியில் மீண்டும் 
கடவுச் ச�ொல்லை தட்டச்சு செய்து இறுதியாக 
“OK” ப�ொத்தானை கிளிக் செய்ய வேண்டும். 

	 இவ்வாறு பாதுகாக்கப்பட்ட (Protected) 
ஆவணத்தின் கடவுச் ச�ொல் மற்றும் “Read 
only”ப�ோன்ற பல அம்சங்களை  மாற்றுவதற்கு  
“More Options” ப�ொத்தான் உதவுகிறது.

6.2.7 ஆவணத்தை மூட

	 ஒரு ஆவணத்தைச் சேமித்தவுடன், 
பயனர் த�ொடர்ந்து அந்த ஆவணத்தில் வேலை 
செய்யும் வகையில் திறந்தே இருக்கும். 
தேவைப்பட்டால் மேலும் ஆவணத்தில் தட்டச்சு 
செய்யலாம். வேலை முடிந்தவுடன், ஆவணத்தை 
சேமித்தபின் File-> Close கட்டளை அல்லது 
Ctrl+W பயன்படுத்தி ஆவணத்தை மூடலாம்.

சேமிக்கப்படாத ஆவணத்தை மூட

	 Close ப�ொத்தானை பயன்படுத்தி நீங்கள் 
சேமிக்கப்படாத க�ோப்பை மூடப்படும் ப�ோது 
ரைட்டர் ஒரு எச்சரிக்கை செய்தியைக் 
காட்டுகிறது. (படம் 6.12 -ஐ  பார்க்க). 

படம் 6.13 எச்சரிக்கை செய்தி பெட்டி

	 எச்சரிக்கை செய்தியை நீங்கள் 
ஏற்றுக்கொண்டால், “Save” ப�ொத்தானை கிளிக்  
செய்யவும். “Save” ப�ொத்தானை கிளிக் செய்தால் 
அது க�ோப்பை சேமிக்க முயற்சி செய்யும். 
க�ோப்பை சேமிக்க விருப்பமில்லை என்றால் 
“Discard” ப�ொத்தானை  கிளிக் செய்ய வேண்டும் 
அல்லது இந்த எச்சரிக்கையை இரத்து செய்து 
அதே ஆவணத்தில் த�ொடர்ந்து பணியாற்ற 
“Cancel” ப�ொத்தானை கிளிக் செய்யவும்.

6.2.8 ஏற்கனவே உள்ள ஆவணத்தை திறக்க

சேமிக்கப்பட்ட ஒரு ஆவணத்தை எப்பொழுது 
வேண்டுமானாலும் மீண்டும் திறக்கலாம். 
மீண்டும் திறப்பதற்கு File -> open அல்லது 
Ctrl+O கட்டளையைப் பயன்படுத்த வேண்டும். 
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படம் 6.14 இல் உள்ள Open உரையாடல் பெட்டியில் க�ோப்பின் பெயரை File Name உரைப்பெட்டியில் 
தட்டச்சு செய்து Open ப�ொத்தானை கிளிக் செய்யவும்.

File Name Open Button

படம் 6.14 Open உரையாடல் பெட்டி

6.3 தமிழ் தட்டச்சு இடைமுகம்

தமிழில் தட்டச்சு செய்ய பல வழிமுறைகள் 
உள்ளன.

•	 தமிழ் எழுத்துருவைப் (font) பயன்படுத்தி

•	 தமிழ் இடைமுகத்தைப் பயன்படுத்தி

	 முதல் முறையில் குறிப்பிட்ட 
எழுத்துருக்களை பதிவிறக்கம் செய்து 
கட்டுப்பாட்டு பலகத்தில் (Control Panel) உள்ள  
க�ோப்புரையில் சேர்த்துக் க�ொள்ளலாம். ஆனால் 
இந்த முறையில் சில குறைபாடுகள் உள்ளன.

•	 தமிழில் தட்டச்சு செய்ய பயனருக்கு 
தெரிந்திருக்க வேண்டும்.

•	 கணிப்பொறியில் அந்த குறிப்பிட்ட எழுத்துரு 
இருக்க வேண்டும்.

•	 ஆங்கிலம்  உட்பட மற்ற ம�ொழிகளை 
ஏற்காது.

•	 எழுத்துக்களை ம�ொழிகளாக அல்லாமல் 
குறிகளாகத் தான் கணிப்பொறி கையாளும்.

•	 ஒரு ஆவணத்தை  ஒரு கணிப்பொறியிலிருந்து, 
மற்ற கணிப்பொறிக்கு அனுப்பும் ப�ோது, 
இரண்டு கணிப்பொறிகளிலும் அதே 
எழுத்துரு இல்லாவிடில்  மூல எழுத்துக்கள் 
குறியீடுகளாகவே கருதும்.

முதல் முறையில் உள்ள இந்த குறைபாடுகளை 
நீக்கி, இடைமுக முறை பல்வேறு நன்மைகளை 
தருகின்றது.

•	 இந்த முறை, Unicode த�ொழில்நுட்பத்தைப்  
பின்பற்றுவதால், இதில் தட்டச்சு செய்ய தமிழ் 
தட்டச்சு செய்யும் முறையை அறிந்திருக்க  
தேவையில்லை.

•	 எந்த  ஒரு ச�ொற்செயலியிலும் எளிதாக 
ஆவணத்தை தமிழில் தட்டச்சு செய்யலாம்.

•	 “Arial Unicode” ப�ோன்ற Unicode 
எழுத்துக்கள் தமிழ் மற்றும் ஆங்கிலம் 
மட்டுமல்லாத எல்லா இந்திய ம�ொழிகளிலும், 
அந்த ம�ொழியின் இடைமுத்தை 
ஆதரவளிக்கும்.
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6.3.1 தமிழ் தட்டச்சு இடைமுகத்தை பதிவிறக்கம் 
செய்து நிறுவுதல்

	 முரசு (Murasu) ( தமிழுக்கே உரிய 
எழுத்துரு) “NHM Writer” (இந்திய 
ம�ொழிகளுக்கு ப�ொதுவான எழுத்துரு) இது 
ப�ோன்ற பல தட்டச்சு இடைமுகங்கள் திறந்த 
மூல மென் ப�ொருளாக இருக்கின்றன.

பதிவிறக்கம் செய்ய மற்றும் நிறுவ

•	 http://anjal.net/download என்ற 
இணைப்பின் மூலம் “Murasu” யை 
பதிவிறக்கி நிறுவலாம்.

•	 http://software.nhm.in என்ற இணைப்பின் 
மூலம் “NHM Writer” யை பதிவிறக்கி 
நிறுவலாம்.

6.3.2 ரைட்டரில் இணைக்க

	 தமிழ் இடைமுகம் பதிவிறக்கம் 
செய்யப்பட்டு  கணிப்பொறியில் நிறுவப்பட்டபின், 
ஒவ்வொரு முறையும் துவங்கும் ப�ோது, இடைமுகம் 
தானாகவே கணிப்பொறியில் செயல்படுத்தப்படும். 
அவ்வாறு செயல்படும் ப�ோது அறிவிப்புப் 
பகுதியில் (Notification Area) ஒரு தனிப்பட்ட 
அடையாள குறியீடு க�ொண்டு இது 
குறிப்பிடப்பட்டிருக்கும். க�ொடாநிலையாக 
ஆங்கிலத்தில் தட்டச்சு  செய்ய Alt + 1 என்ற 
குறுக்குவழி சாவி சேர்மானத்தையும், தமிழில் 
தட்டச்சு செய்ய Alt +2 என்ற குறுக்குவழி சாவி 
சேர்மானத்தையும் பயன்படுத்தலாம். மேலும், பிற 
ம�ொழிகளுக்கு தட்டச்சு செய்ய குறுக்கு வழி 
சாவிகள் ஒதுக்கப்பட முடியும்.

6.3.3 தமிழில் உரையை தட்டச்சு செய்ய

1.	 ரைட்டரில் ஒரு புது ஆவணத்தை திறக்கவும்

2.	 	தமிழில் தட்டச்சு  செய்ய Alt +1 என்ற சாவி 
சேர்மானத்தையும் அழுத்தி, ஆங்கிலத்தில் 
தட்டச்சு  செய்ய Alt +1 என்ற சாவி 
சேர்மானத்தையும் அழுத்தவும்.

	 இணைப்பு 2 –ல் தமிழ்    இடைமுகத்திற்கான 
விசைபலகை கட்டமைப்பு க�ொடுக்கப்பட்டுள்ளது.

	 h t t p : / / w w w. t a m i l v u . o r g / t k b d /
indexen.html என்ற இணைப்பு மூலம் Unicode  
தமிழ் எழுத்துரு வகைகளின் பல பாணிகளை 
பதிவிறக்கம் செய்யலாம்.

6.4 ஒரு ஆவணத்தைப் பதிப்பித்தல்

	 தட்டச்சு செய்த ஆவணத்தை பல்வேறு 
வழிகளில் பதிப்பிக்கலாம். தட்டச்சு செய்யும் 
ப�ொழுது அல்லது தட்டச்சு செய்த பின்னர் 
தேவையானவற்றை சேர்க்க அல்லது நீக்க 
முடியும். இவ்வகையான திருத்தங்கள் செய்ய 
இரண்டு வழிகள் உள்ளன. 

	 Backspace ப�ொத்தான்: செருகும் 
புள்ளிக்கு இடது பக்கத்தில் உள்ள 
எழுத்துக்களை நீக்கும். 

	 Delete ப�ொத்தான்: செருகும் புள்ளிக்கு 
வலது பக்கத்தில் உள்ள எழுத்துக்களை நீக்கும்.

	 புதிய உரையை ஆவணத்தின் இடையில் 
சேர்க்க முடியும். வேண்டிய உரையை 
செருகுவதற்கு அல்லது  சேர்ப்பதற்கு, செருகும் 
புள்ளியை வேண்டிய இடத்தில் வைத்து Insert 
ப�ொத்தானை அழுத்திய பின் தட்டச்சு செய்தால், 
புதிய உரை சேர்க்கப்பட்டு ஏற்கனவே உள்ள உரை 
வலதுபக்கத்திற்கு நகரும்.இது செருகுதல் முறை 
எனப்படும். மேல் அச்சிடல் (Type over) முறையில் 
புதிய உரை சேர்க்கப்படும் ப�ோது செருகும் 
புள்ளிக்கு வலது பக்கத்தில் உள்ள எழுத்துக்கள் 
அழியும். Insert  ப�ொத்தானைப் பயன்படுத்தி 
மேல் அச்சிடல் (Type over)அல்லது செருகல் 
(Insert) முறை ஆகியவற்றை ஒன்றிலிருந்து 
மற்றொன்றுக்கு மாற்றிக் க�ொள்ளலாம். 

6.5 உரையை தேர்ந்தெடுக்க, நகர்த்த மற்றும் 
நகலெடுக்க

6.5.1 உரையைத் தேர்ந்தெடுக்க

	 ச�ொற்செயலியில் உள்ள உரையை 
நகலெடுக்க, நகர்த்த, வடிவூட்டல் ப�ோன்ற 
செயல்களைச் செய்ய உரையை தேர்வு செய்ய 
வேண்டும். இரு முறைகளில் உரையைத் தேர்வு 
செய்யலாம். 

1.	 த�ொடர்ச்சியாக உள்ள உரையை தேர்வு 
செய்ய

2.	 வெவ்வேறு இடங்களில் உள்ள உரையை 
தேர்வு செய்ய

த�ொடர்ச்சியாக உள்ள உரையை தேர்வு செய்ய

	த� ொடர்ச்சியாக உள்ள உரையை தேர்வு 
செய்ய, உரையின் த�ொடக்கத்திற்கு செருகும் 
புள்ளியை க�ொண்டு செல்லவும். 
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•	 Shift ப�ொத்தானை அழுத்திக�ொண்டே 
சுட்டியை அழுத்தியவாறு தேவையான 
உரையை தேர்வு செய்ய வேண்டும். தேர்வு 
செய்யப்பட்டபின் Shift ப�ொத்தானை 
அழுத்துவதை விட்டு விடவும். 

•	 இவ்வாறு தேர்வு செய்யப்பட்ட உரை 
அனைத்து செயல்பாட்டிற்கும் 
பயன்படுத்தலாம். 

வெவ்வேறு இடங்களில் உள்ள உரையை தேர்வு 
செய்ய

	வெ வ்வேறு இடங்களில் உள்ள உரையை 
தேர்வு செய்ய, செருகும் புள்ளியை உரையின் 
த�ொடக்கத்திற்கு க�ொண்டு செல்லவும்,

•	 Ctrl ப�ொத்தானை அழுத்திக் க�ொண்டே 
சுட்டியை அழுத்தி தேவையான உரையை 
தேர்வு செய்யவும். தேர்வு செய்யப்பட்டபின் 
Ctrl ப�ொத்தானை அழுத்துவதை விட்டு 
விடவும்.

•	 இவ்வாறு தேர்வு செய்யப்பட்ட உரை 
அனைத்து செயல்பாட்டிற்கும் 
பயன்படுத்தலாம்.

உரையைத் தேர்ந்தெடுப்பதற்கான பல்வேறு 
வழிகள்

சுட்டெலியின் மூலம் உரையைத் தேர்ந்தெடுத்தல்

•	 செருகும் புள்ளியை தேர்ந்தெடுக்கப் பட 
வேண்டிய உரையின் த�ொடக்கத்தில் வைக்க 
வேண்டும்.

•	 சுட்டெலியின் இடது ப�ொத்தானை அழுத்திப் 
பிடித்தவாறு உரையின் மீது நகர்த்த 
வேண்டும்.

•	 உரை தேர்ந்தெடுக்கப்பட்ட பின் ப�ொத்தானை 
விட்டு விட வேண்டும். இவ்வாறு  
தேர்ந்தெடுக்கப்பட்ட உரை உயர்த்தி 
காட்டப்பட்டிருக்கும்.

விசைப் பலகையின் மூலம் உரையைத் 
தேர்ந்தெடுத்தல்

•	 செருகும் புள்ளியை தேர்ந்தெடுக்கப்பட 
வேண்டிய உரையின் த�ொடக்கத்தில் வைக்க 
வேண்டும்.

•	 Shift ப�ொத்தானை அழுத்தியவாறு நகர்வுப் 
ப�ொத்தான்களை பயன்படுத்தி தேவையான 
உரையை தேர்வு செய்யலாம். பின்னர்  Shift 

ப�ொத்தானை அழுத்துவதை விட்டு விடவும்.

•	 இவ்வாறு  தேர்ந்தெடுக்கப்பட்டிருக்கும் உரை 
உயர்த்திக் காட்டப்பட்டிருக்கும்.

உரையைத் தேர்ந்தெடுப்பதற்கான குறுக்கு 
வழிகள்

	 உரையை எளிதாகவும், விரைவாகவும் 
தேர்வு செய்ய குறுக்கு வழி சாவிகள் 
உதவுகின்றன.

•	 ச�ொல்லின் மீது இரண்டு முறை கிளிக் 
செய்தல் - ஒரு வார்த்தை அல்லது 
ச�ொல்லானது  தேர்ந்தெடுக்கப்படும்.

•	 Ctrl+A  ப�ொத்தானை அழுத்துதல் -  
ஆவணம் முழுவதும் தேர்ந்தெடுக்கப்படும்.

6.5.2 உரையை நகர்த்துதல் மற்றும் நகலெடுத்தல் 

உரையை நகர்த்த  

	 உரையை ஒரு இடத்திலிருந்து இன்னொரு 
இடத்திற்கு நகர்த்த.

•	 நகர்த்த வேண்டிய உரையை தேர்வு செய்ய 
வேண்டும்.

•	 Ctrl + X அல்லது Cut பணிக்குறி 
அல்லது Edit  Cut கிளிக் செய்ய 
வேண்டும்.

•	 மூல இடத்திலிருந்து உரை நீக்கப்பட்டு 
பிடிப்பலகையில் (Clip Board) சேர்க்கப்படும்.

•	 உரை எந்த புதிய இடத்திற்கு நகர்த்தப்பட 
வேண்டும�ோ அங்கு செருகும் புள்ளியை 
க�ொண்டு செல்லவும்.

•	 Ctrl + V அல்லது Paste பணிக்குறி 
அல்லது Edit Paste கிளிக் 
செய்யவும்.

தேர்வு செய்யப்பட்ட உரை இப்பொழுது வேண்டிய  
இடத்திற்கு நகர்த்தப்பட்டிருக்கும். 

உரையை நகலெடுக்க

	 உரையை ஒரு இடத்திலிருந்து வேற�ொரு 
இடத்திற்கு நகலெடுக்க

•	 நகலெடுக்க, தேவையான உரையை தேர்வு 
செய்ய வேண்டும்.

•	 Ctrl + C அல்லது Copy பணிக்குறி 
அல்லது EditCopy கிளிக் செய்யவும்.
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•	 நகலெடுக்கப்பட்ட உரை பிடிப்பலகையில் 
சேர்க்கப்படும்.

•	 நகலெடுக்கப்பட்ட உரை எங்கு நகலெடுக்க 
வேண்டும�ோ அங்கு செருகும் புள்ளியைக் 
க�ொண்டு செல்லவும்.

•	 Ctrl + V அல்லது Paste பணிக்குறி  
அல்லது Edit  Paste கிளிக் 
செய்யவும்.

	தே ர்வு செய்யப்பட்ட உரை இப்பொழுது 
வேண்டிய இடத்தில் நகலெடுக்கப்பட்டிருக்கும்.

பதிப்பாய்விற்குரிய  குறுக்கு வழி சாவிகள் 
அட்டவணை 6.3 - ல் க�ொடுக்கப்பட்டுள்ளது.             
(நீக்குதல், நகலெடுத்தல் , ஒட்டுதலுக்கான 
பணிக்குறிகளும் மற்றும் குறுக்கு வழிகளும்)

அட்டவணை 6.3. நீக்க, நகலெடுக்க, ஓட்ட 
மற்றும் செயல் தவிர் குறுக்கு வழிகள்

செயல் செயல்பாடு பணிக்குறி
குறுக்குவழி 

சாவி

CUT
நீக்க

தேர்ந்தெடுத்த 
உரையை 
நீக்க

Ctrl +X

COPY
நகலெடுக்க

தேர்ந்தெடுத்த 
உரையை 
நகலெடுக்க  

Ctrl +C

PASTE
ஒட்ட

நீக்குதல் 
அல்லது 
நகலெடுத்தல்  
செயல் 
பாட்டிற்கு 
பிறகு 
உரையை 
ஒட்ட

Ctrl +V

UNDO
செயல் தவிர்

முந்தைய 
செயல் 
பாட்டை
ரத்து செய்ய  

Ctrl +Z

6.6 Writer உதவி அமைப்பு

	
ஓ ப ன் ஆ ஃ பீ ஸ் 
ரைட்டர் பல்வேறு 
வி த ம ான  
உ த வி க ள ை 
வழங்குகின்றது. F1 
அ ல்ல  து 
ப ட் டி ப்ப  ட ் டை யி ல் 
உள்ள Help –யை 
தேர்வு செய்தால் 
உதவித்திரை  படம் 
6.15 - ல் உள்ளது 
ப�ோல் த�ோன்றும்.

•	 கருவிக் குறிப்புகள் (Tools tips), 
நீட்டிக்கப்பட்ட குறிப்புகள் (Extended tips), 
உதவி முகவர் (Help agent)ப�ோன்றவற்றை 
செயல்படுத்த Tools  Options  
OpenOffice என்பதை கிளிக் செய்ய 
வேண்டும்.

•	மே லும் விரிவான விளக்கத்திற்கு, Help  
What’s this? என்பதை தேர்வு செய்ய 
வேண்டும், கூடுதலான உதவி தேவைப்படும் 
ப�ோது உதவி பணிக்குறியின் மேலே 
சுட்டெலியை வைத்தால் படம் 6.16 –ல் 
உள்ளது ப�ோன்ற General Settings சன்னல் 
திரை த�ோன்றும்.

படம் 6.15 உதவி சன்னல் 

திரை

குறிப்புகள்
நீட்டிக்கப்பட்ட குறிப்புகள்

படம் 6.16 General Settings சன்னல் திரை
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     6.1 :

ஒரு புதிய ஓபன்ஆஃபீஸ் ரைட்டர் ஆவணத்தை திறக்கவும்.

•	 அதில் கீழே க�ொடுக்கப்பட்டுள்ள பத்தியை தட்டச்சு செய்யவும்.

	 “The ignited minds of the youth is the most powerful resource on the earth. The power of 
the youth, if properly 	 directed, will bring about transformed humanity by meeting its 
challenges and bring peace and prosperity.”

•	 உரை ஆவணத்தை சேமித்த பின் மூடவும்.

•	 ஓபன்ஆஃபீஸ் ரைட்டரை விட்டு வெளியேறவும்.

6.2 :

•	 பயிற்சி பட்டறை 6.1 - ல் உருவாக்கப்பட்ட ஆவணத்தை திறக்கவும்.

•	 ஆவணத்தின் இறுதியில், கீழே க�ொடுக்கப்பட்டுள்ள பத்தியை சேர்க்கவும்.

	 “We are as young as our faith and as old as our doubts. We are also as young as our self – 
confidence and as old as our fears. We are as young as our hopes and as old as our despairs.”

•	 ஆவணத்தை சேமிக்கவும்.

•	 முதல் பத்தியில்  உள்ள கடைசி வரியை Delete அல்லது Backspace ப�ொத்தானை பயன்படுத்தி 
நீக்கவும்.

•	 இரண்டாவது பத்தியின் இறுதியில் கீழே க�ொடுக்கப்பட்டுள்ள வரிகளை ஒரு புதிய பத்தியாக 
தட்டச்சு செய்யவும்.

	 “It doesn’t matter who you are, if you have a and determination to achieve that vision, you 
will certainly do so.”

•	 மூன்றாவது பத்தியில் ‘a’ மற்றும் ‘and’ என்ற  வார்த்தைக்களுக்கிடையில் “vision” என்ற 
வார்த்தையை சேர்க்கவும்.

 6.3 :

•	 பயிற்சி பட்டறை 6.1 -  ல் உருவாக்கப்பட்ட ஆவணத்தை திறக்கவும்.

•	 அதில் கீழ்க்காணும் ச�ொற்களை விசைப்பலகை அல்லது  குறுக்குவழியை பயன்படுத்தி நகல் 
எடுத்து ஒரு புதிய ஆவணத்தில் ஒட்டவும். 

 (i) ignited (ii) powerful (iii) humanity (iv) challenges (v) prosperity

•	 புதியதாக உருவாக்கப்பட்ட ஆவணத்தை சேமிக்கவும்.

•	 முதல் ஆவணத்தில் விசைப்பலகை குறுக்கு வழிகள் அல்லது சுட்டெலி மூலம் கீழே க�ொடுக்கப்பட்ட 
வார்த்தையை நகர்த்தவும் (i) ignited (ii) challenges (iii) prosperity

பயிற்சி பட்டறை 

6.7 உரை வடிவூட்டல்

	 வடிவூட்டல்  செய்யப்படாத  உரை படிக்கும் ஆர்வத்தை தூண்டுவதாக அமையாது. எழுத்துருக்களை 
தடிமனாகவும் (Bold), சாய்வானதாகவும் (Italics), எழுத்துரு வகை (Font style), அளவு (Font size) 
ப�ோன்றவற்றை மாற்றுவதற்கான பல்வேறு வடிவூட்டல் விருப்பத் தேர்வுகளை ஓபன் ஆபீஸ் ரைட்டர் 
வழங்குகிறது. எழுத்துருக்களை தடிமனாகவும், சாய்வானதாகவும் அல்லது அடிக்கோடிடுதல் 
(Underline) ப�ோன்றவை ப�ொதுவான உரை வடிவூட்டல்  வகைகளாகும். பெரும்பாலான  வடிவூட்டல் 
விருப்பத் தேர்வுகள் Format பட்டிப்பட்டையில் உள்ளன.
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6.7.1 எழுத்து வகை, அளவு மற்றும் நிறம் மாற்றுதல்

	 எழுத்து வகை என்பது ஒரு குறிப்பிட்ட வடிவிலான எழுத்துருக்களின் த�ொகுப்பாகும். உரையை 
தட்டச்சு  செய்யும்போது  க�ொடாநிலையாக உள்ள எழுத்துவகை, அளவு, நிறம், வடிவமைப்பு  ப�ோன்றவற்றை 
மாற்றியமைப்பது “உரை வடிவூட்டல்” எனப்படும்.  பின்வரும் அட்டவணை 6.4-ல் க�ொடுக்கப்பட்டுள்ள 
வடிவூட்டல் தேர்வுகளைப் பயன்படுத்தி, எழுத்துக்களை தடிமனாக்குதல், சாய்வெழுத்தாக்குதல் மற்றும் 
அடிக�ோடிடுதல் ப�ோன்ற  வடிவூட்டல்களின் மூலம் ஒரு உரையை படிக்க ஆர்வமூட்டுவதாக அமைக்க முடியும்.

அட்டவணை 6.4 உரை வடிவூட்டல் குறுக்குவழிகள்

செயல் செயல்பாடு பணிக்குறி குறுக்குவழி

தடிமனாக்குதல் உரையைத் தடித்த எழுத்துக்களாக மாற்றுவதற்கு B Ctrl+B

சாய்வெழுத்தாக்குதல் உரையை சாய்ந்த எழுத்துக்களாக மாற்றுவதற்கு I Ctrl +I

அடிக்கோடிடுதல் உரையை அடிக் க�ோடிடுவதற்கு U Ctrl +U

	 Times New Roman என்பது க�ொடாநிலை எழுத்து வகையாகும். எழுத்து வகையை மாற்ற 

Font Type Times New Roman  பணிக்குறியை கிளிக் செய்து மாற்றலாம்.

	 எழுத்தின் க�ொடாநிலை அளவு 12 புள்ளிகளாகும். எழுத்தின்  அளவை மாற்ற எழுத்து அளவு 

12  பணிக்குறியை கிளிக் செய்து மாற்றலாம்.  

	 எழுத்தின் க�ொடா நிலை நிறம் கருப்பு, A  என்ற பணிக்குறியை கிளிக் செய்தால் ஒரு 

வண்ணத்தட்டு (Color Palette) திரையில் த�ோன்றும், இதில் தேவையான நிறத்தை தேர்வு செய்யலாம். 

தடிமனாக்குதல், சாய்வெழுத்தாக்குதல், அடிக்கோடிடல் ப�ோன்றவை ப�ொதுவான  வடிவூட்டல் 

தேர்வுகளாகும். பல்வேறு விதமான வடிவூட்டல்களுக்கு FormatCharacter தேர்வு செய்தால் படம் 
6.17 இல் காட்டப்பட்டுள்ள Character உரையாடல் பெட்டி த�ோன்றும். இதில் அனைத்து வகையான 

வடிவூட்டல்களையும் செய்ய முடியும்.

Font த�ொகுதி

Preview Window

படம் 6.17 எழுத்துரு உரையாடல் பெட்டி
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6.7.2 சிறிய, பெரிய எழுத்துகளாக மாற்றுதல் 
(Changing case)

	ப� ொதுவாக ஒரு உரையை ஆங்கில பெரிய 
எழுத்து (Upper Case) அல்லது சிறிய 
எழுத்துகளில் (Lower Case) தட்டச்சு செய்யலாம். 
தட்டச்சு செய்யப்பட்ட எழுத்துக்களை கீழ் 
க�ொடுக்கப்பட்டுள்ளவாறு மாற்றிக் க�ொள்ள 
முடியும். 

•	 Upper case (ஆங்கில பெரிய எழுத்துக்களாக 
மாற்ற)

•	 Toggle case (ஆங்கில பெரிய எழுத்துக்களை, 
சிறிய எழுத்துக்களாகவும் - சிறிய 
எழுத்துக்களை பெரிய எழுத்துக்களாகவும் 
மாற்ற முடியும் )

•	 Sentence case (வரியின் முதல் எழுத்தை 
ஆங்கில பெரிய எழுத்தாக மாற்ற )

•	 Capitalize every word (ஒவ்வொரு 
வார்த்தையின் முதல் எழுத்தை ஆங்கில 
பெரிய எழுத்தாக மாற்ற)

•	 Lower case (ஆங்கில சிறிய  எழுத்தாக 
மாற்ற )

மேற்கண்டவாறு மாற்றுவதற்கு கீழ்காணும் 
வழிமுறைகளை பயன்படுத்தலாம்.

•	 மாற்ற வேண்டிய உரையை தேர்ந்தெடுக்கவும்.

•	 Format Change case தேர்வு செய்க.

6.7.3 உரையை உயர்த்திக்காட்டுதல்:

	 ஒரு உரையின் முக்கியமான பகுதிகளை 
படிப்பவரின் கவனத்திற்கு க�ொண்டு செல்ல 
உரையை உயர்த்திக்காட்டுதல் பயன்படுகிறது.
படிப்பவர் முதலில் உரையின் முக்கிய பகுதிகளைத் 
தேர்வு செய்து, அதை உயர்த்திக்காட்டுவதன் 
மூலம் மீண்டும் அந்த பகுதிகளை சீரிய முறையில் 
மறுபரிசீலனை செய்ய எளிதாகும். 

	தே ர்வு செய்யப்பட்ட உரையை உயர்த்திக் 
காட்ட, Highlighting பணிக்குறியை ,கிளிக் 
செய்தால் ஒரு வண்ணத்தட்டு த�ோன்றும், அதில் 
தேவையான வண்ணத்தை தேர்வு செய்து 
உரையை உயர்த்திக் காட்டலாம். உயர்த்திக் 
காட்டப்பட்ட உரையை அதன் இயல்பு 
த�ோற்றத்திற்கு மாற்ற, உயர்த்திக் காட்டப்பட்ட 
உரையை தேர்வு செய்து, வண்ணத்தட்டில் No fill 
தேர்வை கிளிக் செய்யவும்.

உரையை உயர்த்திக்காட்டுதல் 
என்பது , ஒரு ஆவணத்திலுள்ள 
முக்கியமான பகுதிகளைப் 
படிப்பவரின் கவனத்தை ஈர்க்கும் 

வகையில், அதன் மீது ஏதேனும் ஒரு 
வண்ணத்தை  பயன்படுத்துதலாகும்.

6.7.4 வடிவூட்டல் தேர்வுகளை நீக்குதல்

வடிவூட்டம் செய்யப்படாத உரை படிப்பவரின் 
கவனத்தை ஈர்க்காது, எனவே பல்வேறு  
வழிமுறைகளில் வடிவூட்டல்களை செய்ய முடியும்.

	 வடிவூட்டல்களை நீக்குவதற்கு 
கீழ்காணும் வழிமுறைகளை பின்பற்றவும்:

•	 Ctrl+A அல்லது Edit  Select All தேர்வு 
செய்து முழு ஆவணத்தை தேர்ந்தெடுக்கவும்.

•	 வடிவூட்டலை நீக்க, Ctrl+M கிளிக் செய்யவும்.

6.8 பத்தி வடிவூட்டல்
 

	 உரையை தட்டச்சு செய்யும் ப�ோது  
நுழைவுப் (Enter) ப�ொத்தானை அழுத்தினால் 
ஒரு பத்தி உருவாகும். இவ்வாறு நுழைவு 
ப�ொத்தான்அழுத்தப்படுவது திருப்புதல் (Hard 
return) எனப்படும். ஒரு பத்தியின் வரிகள் தட்டச்சு 
செய்யப்படும் பக்கத்தின் எந்த திசையில் (இடது  
அல்லது வலது) அமைய வேண்டும் என்பது பத்தி 
இசைவு எனப்படும். ஒவ்வொரு பத்தியின் 
அமைவையும் பத்தி இசைவு கட்டுப்படுத்துகிறது.  
ஓபன் ஆஃபீஸ் ரைட்டரில், இடது (Left), வலது 
(Right), மைய (Center) மற்றும் நேர்த்தி (Justify) 
என்ற நான்கு வகையான இசைவுகள் உள்ளன.

இடது இசைவு

	 ஒரு பத்தியின் எல்லா வரிகளும் இடது 
ஓரத்தில் ஒரே சீரான முறையில் அமைவது இடது 
இசைவு எனப்படும். இந்த இசைவில் பத்தியின் 
வரிகள் வலது ஓரத்தில் சீரான முறையில் 
அமையாது. ப�ொதுவாக ஒரு பத்தியை தட்டச்சு 
செய்யப்படும் ப�ோது க�ொடாநிலையாக இடது 
இசைவில் தான் அமையும்.

வலது இசைவு

	 ஒரு பத்தியின் எல்லா வரிகளும் வலது 
ஓரத்தில்  ஒரே சீரான முறையில் அமைவது வலது 
இசைவு எனப்படும். இந்த இசைவில்  பத்தியின் 
வரிகள் இடது ஓரத்தில்  சீரான முறையில் 
அமையாது. 
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மைய இசைவு

	 இந்த இசைவில் எல்லா வரிகளும் அந்த பக்கத்தின் மைய பகுதியில் அமையும்.

நேர்த்தி இசைவு

	 இந்த இசைவில் ஒரு பத்தியின் எல்லா வரிகளும் இடது மற்றும் வலது ஓரங்களில் சீராக அமையும். 
இந்த இசைவு வார்த்தைகளுக்கு இடையே அதிக வெற்றிடங்களை தானாகவே சேர்த்துக் க�ொண்டு 
அமையும்.

Format  Paragraph கட்டளையைப் பயன்படுத்தினால் Paragraph உரையாடல் பெட்டி படம் 6.18-ல் 
உள்ளது ப�ோல் த�ோன்றும், இதன் மூலம் பத்தி வடிவூட்டலை செய்யலாம்.

படம் 6.18 Paragraph உரையாடல் பெட்டி

	 படம் 6.19 ல் க�ொடுக்கப்பட்டுள்ள வடிவூட்டல் கருவிப் பட்டையின் பணிக்குறிகள் மற்றும் 

அட்டவணை  6.5 ல் க�ொடுக்கப்பட்டுள்ள குறுக்கு வழிகளைப் பயன்படுத்தி பத்தி வடிவூட்டல்களைச்  

செய்யலாம்.

படம் 6.19 வடிவூட்டல் கருவிப்பட்டை
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அட்டவணை 6.5 பத்தி இசைவு பணிக்குறிகள் மற்றும் குறுக்கு வழி சாவிகள்

இசைவு செயல் பணிக்குறி குறுக்கு வழி

இடது இடது இசைவாக மாற்ற Ctrl + L

வலது வலது இசைவாக மாற்ற Ctrl + R

மையம் மைய இசைவாக மாற்ற Ctrl + E

நேர்த்தி நேர்த்தி இசைவாக மாற்ற Ctrl + J

Left Alignment

All power is with in you take up one idea, make that one idea your life. 
Think of it dream of it, live on that idea let the brain, muscles, nerves, every 
part of your body be full of that idea, and just leave avry other idea alone.
This is the way to success.

Right Alignment

All power is with in you take up one idea, make that one idea your life. 
Think of it dream of it, live on that idea let the brain, muscles, nerves, every 

part of your body be full of that idea, and just leave avry other idea alone. 
This is the way to success.

Center Alignment

All power is with in you take up one idea, make that one idea your life. 
Think of it dream of it, live on that idea let the brain, muscles, nerves, every 

part of your body be full of that idea, and just leave avry other idea alone. 
This is the way to success.

Justified Alignment

All power is with in you take up one idea, make that one idea your life. Think 
of it dream of it, live on that idea let the brain, muscles, nerves, every part of 
your body be full of that idea, and just leave avry other idea alone. This is the 
way to success.

எடுத்துக்காட்டு  6.1 பத்தி இசைவுக்கான எடுத்துக்காட்டு
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6.8.1 வரி இடைவெளி

	 “வரி இடைவெளி” என்பது,  ஒரு பத்தியின் ஒரு வரிக்கும் மற்றொரு வரிக்கும் இடையே உள்ள  
அளவை தீர்மானிக்கும் நெடுக்கை இடைவெளியாகும் . க�ொடாநிலை வரி இடைவெளி  ஒற்றை இடைவெளி 
(Single space) ஆகும். 

	 ஓபன்ஆஃபீஸ் ரைட்டரில், மேல் மீட்பு பட்டிப்பட்டையின் மூலம் எளிதாக வரி இடைவெளி அமைக்க, 
அந்த பத்தியின்  வரி, வார்த்தை அல்லது ச�ொற்தொடரை தேர்வு செய்து வலது ப�ொத்தானைக் கிளிக் 
செய்தால் த�ோன்றும் மேல் மீட்பு பட்டிப்பட்டையில் உள்ள line spacing என்ற தேர்வை கிளிக் செய்யவும். 
இப்போது த�ோன்றும் Single, 1.5 அல்லது Double ப�ோன்ற ஏதேனும் வரி இடைவெளியைத் தேர்வு 
செய்யலாம்.

படம் 6.20-ல் உள்ள உரையாடல் பெட்டியில் ஏழு வெவ்வேறு வரி இடைவெளி வகைகளை காணலாம்.

படம் 6.20 Paragraph உரையாடல் பெட்டி

பகுதி II உரை மற்றும் பத்தி வடிவூட்டல்

Paragraph உரையாடல் பெட்டியை பயன்படுத்தி 
வரி இடைவெளியை மாற்றுதல்

•	 Edit  Select All கட்டளையைப் 
பயன்படுத்தி முழு ஆவணத்தையும் தேர்வு 
செய்யவும்.

•	 Format Paragraph கட்டளையைக் 
கிளிக் செய்யவும்.

•	 Paragraph உரையாடல் பெட்டி த�ோன்றும், 
இதில் Indents & Spacing த�ொகுதியைக் 
கிளிக் செய்யவும்.

•	 Line Spacing  கீழ்விரிப்  பட்டியில்  
தேவையான வரி இடைவெளியைத் தேர்வு 
செய்து OK ப�ொத்தானைக் கிளிக் செய்யவும்.

6.8.2 உரையை உள்தள்ளல்

	 ஒரு பத்தியின்  இடது மற்றும் வலது 
ஓரத்திற்கும் உள்ள தூரம் உரை உள்தள்ளல் 
எனப்படும். உள்தள்ளல்,  ஒரு பத்தியை  
படிப்பதற்கு எளிமையாகவும் மற்றும் படிப்பதற்கு 
தூண்டுவதாகவும் உள்ளது. செருகும் புள்ளியை 
ஒரு பத்தியின் முதல் வரிக்கு க�ொண்டு சென்றபின் 

XI Std Computer Technology Vol-1 TM Chapter 6 .indd   90 20-04-2020   14:33:11



90 91

விசைப் பலகையில் தத்தல் (tab) ப�ொத்தானை 
அழுத்தி எளிமையான முறையில் 
உள்தள்ளல்செய்ய முடியும். உரையை உள்தள்ள 
இரண்டு வழிமுறைகள் உள்ளன. அவை 

•	 பணிகுறிகளின்   உதவியுடன்

•	 உரையாடல் பெட்டியின் உதவியுடன்

மிகுப்பு  உள்தள்ளல்  பணிக்குறி 

	 பத்திக்கும் இடது ஓரத்திற்கும் இடையே 
உள்ள இடைவெளியை இந்தப் பணிக்குறி 
கட்டுப்படுத்துகிறது. ஒவ்வொரு முறை இந்தப் 
பனிக்குறியை கிளிக் செய்யும் ப�ோதும் பத்தி 
இடது ஓரத்தில் இருந்து 1/2 அங்குலம் 
உள்தள்ளப்படும் 

குறைப்பு  உள்தள்ளல்  பணிக்குறி 

	 இது மிகுப்பு  உள்தள்ளல் பனிக்குறிக்கு 
நேர் எதிரானது. இது மிகுப்பு உள்தள்ளலின் 
மூலம் செய்யப்பட்ட செயலை தவிர்க்கிறது. 
ஒவ்வொரு முறை இந்தப் பனிக்குறியை கிளிக் 
செய்யும் ப�ோதும் பத்தி வலது புறத்திலிருந்து   1/2 
அங்குலம் உள்தள்ளப்படும்

உரையாடல் பெட்டியின் உதவியுடன் 

	 Format Paragraph என்ற தேர்வின் 
மூலம்  பத்தி உரையாடல்பெட்டியானது  படம் 

6.20 ல் உள்ளவாறு த�ோன்றும்.மூன்று 
உள்தள்ளல் தேர்வுகளை க�ொண்ட தத்தலை 
தேர்வு செய்யவும் Indents & Spacing 
த�ொகுதியை பயன்படுத்தி இடது உள்தள்ளல் 
செய்யலாம்,  “Before text” சுழல் பெட்டியில் 
உள்தள்ளலுக்கான அளவைத் தட்டச்சு செய்தால் 
பத்தி இடது உள்தள்ளல் செய்யப்படும்.

முதல் வரியை உள்தள்ளல்

	 ஒரு பத்தியை தட்டச்சு செய்ய த�ொடங்கும் 
ப�ோது அதன் முதல்வரியை உள்தள்ளி 
அமைப்பது இயல்பான முறையாகும். இதை 
முதல்வரி உள்தள்ளல் என்கிற�ோம். 

	 Format  Paragraph Indents & 
Spacing த�ொகுதியை பயன்படுத்தி First line 
விருப்பத்தை தேர்வு செய்து உள்தள்ளல் குழுவில் 
(group) ஒரு நேர்மறை மதிப்பைத் தட்டச்சு 
செய்தால் முதல்வரியை மட்டும் உள்தள்ள முடியும்.

த�ொங்கும் உள்தள்ளல்

	த� ொங்கும் உள்தள்ளல் என்பது  ஒரு 
சிறப்பு உள்தள்ளலாகும்.  இதில் முதல் வரியானது 
இதர வரிகளைக் காட்டிலும் இடது ஓரத்திலிருந்து  
வெளியே தள்ளப்பட்டிருக்கும். பத்தி உரையாடல் 
பெட்டியில் First line விருப்பத்தில் ஒரு எதிர்ம 
மதிப்பை (negative) தட்டச்சு செய்து த�ொங்கு 
உள்தள்ளல் பெறலாம்.

Increase Indent

Decrease 
Indent

முதல் 

வரியை 

உள்தள்ளல்

த�ொங்கு உள்தள்ளல்

எடுத்துக்காட்டு 6.2 பல்வேறு விதமான உள்தள்ளல் வகைகள்
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வரிசையிடப்பட்ட பட்டியலில்  பயனர் ஒரு பத்தியை 
சேர்க்கவ�ோ அல்லது நீக்கவ�ோ செய்தால் 
பட்டியல் தானாகவே அதற்கேற்றவாறு 
எண்களை மாற்றிக் க�ொள்ளும். எண் வரிசை 
பணிக்குறியை கிளிக் செய்தால் தேர்வு செய்து 
பத்தி எண் வரிசையிடப்படும்.	

6.8.4 புல்லட் மற்றும் எண்வரிசையின் உருவாக்க

	க� ொடாநிலையாக  புல்லட் (.) குறியுடனும், 
எண் வரிசை (1, 2, 3……) என்ற வரிசையிலும் 
த�ோற்றமளிக்கும். பல வகையான புல்லட் 
மற்றும் எண்வரிசை பாணியை மாற்ற 
கீழ்க்கண்ட வழிமுறைகளை பின்பற்ற 
வேண்டும்:

•	 புல்லட் குறியிடப்பட வேண்டிய உரையைத் 
தேர்வு செய்க.

•	 Format  Bullets and Numbering 
என்ற கட்டளையைத் தேர்வு செய்க.

•	 Bullets  த�ொகுதியைக்  கிளிக் செய்ய 
வேண்டும்.

•	 பல்வேறு வகையான புல்லட் குறிகள் 
க�ொண்ட Bullets and Numbering 
உரையாடல் பெட்டி திரையில் த�ோன்றும்.

•	 இதில் நமக்குத் தேவையான புல்லட் குறியை 
கிளிக் செய்த பின் OK ப�ொத்தானைக் கிளிக் 
செய்யவும்.

•	 தேர்வு செய்யப்பட்ட உரை புல்லட் 
குறியிடப்படும்.

புல்லட் த�ொகுதியுடன் உள்ள Bullets and 
Numbering உரையாடல் பெட்டி படம் 6.21 ல் 
காட்டப்பட்டுள்ளது.

6.8.3 புல்லட் குறி மற்றும் எண் வரிசை 

	 முக்கியக் குறிப்புகளை பட்டியலிட, 
மேலும் அந்த பட்டியலை எளிதாக படிக்க மற்றும் 
பின்பற்ற புல்லட் மற்றும் எண்வரிசை 
பயன்படுகிறது. படிப்பவருக்கு ஒரு சிறந்த 
முறையில் தகவலை பட்டியலிட்டு, பிரித்து மற்றும் 
ஒருங்கிணைப்பதற்கு இது மிகவும் சிறந்த 
முறையாகும். புல்லட் மற்றும் எண் வரிசையின் 
த�ோற்றத்தையும் வடிவூட்டலையும் பயனர் 
கட்டுப்படுத்தலாம். 

புல்லட்

	 பத்தி நிலை பண்பான  புல்லட் குறியீடு 
மூலம்  பத்தியின் த�ொடக்கத்திற்கு புல்லட் 
குறியை அமைக்கலாம். புல்லட் 
பணிக்குறியை   கிளிக் செய்வதன்  மூலம்  
விரைவாக  புல்லட் குறியிடப்பட்ட  உரையை  
உருவாக்க முடியும். ஒவ்வொரு பத்தியின் 
த�ொடக்கமும் புல்லட் குறியுடன் த�ொடங்கும். 
ஆவணத்திலுள்ள முக்கியமாக பகுதிகளை 
பட்டியலிடுவதற்கு புல்லட் பயன்படுகிறது.

எண் வரிசைப் பட்டியல் 

	 பத்தி நிலை  பண்பான  எண் வரிசை 
பட்டியல் மூலம் ஒவ்வொரு பத்தியின் 
த�ொடக்கத்திலும் எண் வரிசைப் பட்டியல் 
அமைக்கலாம். ஒவ்வொரு பத்தியின் 
த�ொடக்கத்திற்கு வரிசையிட, எண் 
வரிசைப்பட்டியல் உதவுகிறது. ஒவ்வொரு 
பத்தியின் த�ொடக்கத்திற்கு வெளிப்பாடாக  எண் 
அல்லது எழுத்தைக் க�ொண்டு வரிசை இடலாம். 
மேலும்  இந்த எண் அல்லது எழுத்தை அடைப்புக் 
குறிக்குள்ளும் க�ொண்டு  வரலாம். எண் 

படம் 6.21 Bullets and Numbering உரையாடல் பெட்டி
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படம் 6.22 Bullets and Numbering உரையாடல் பெட்டி

எண்வரிசை உருவாக்க

•	 எண் வரிசை இடப்படவேண்டிய  உரையைத் 

தேர்வு செய்க.

•	 Format  Bullets and Numbering 
என்ற கட்டளையைத் தேர்வு செய்க.

•	 Numbering   த�ொகுதியைக்  கிளிக் செய்ய 

வேண்டும்.

•	 பல்வேறு வகையான எண்வரிசைகள்  

க�ொண்ட Bullets and Numbering 

உரையாடல் பெட்டி திரையில் த�ோன்றும்.

•	 இதில் நமக்குத் தேவையான  எண்வரிசையை 

கிளிக் செய்த பின் OK ப�ொத்தானைக் கிளிக் 

செய்யவும்.

•	 தேர்வு செய்யப்பட்ட  உரைக்கு  எண் 

வரிசையிடப்படும்.

புல்லட் மற்றும் எண்வரிசை நீக்க

	 ஏற்கனவே உள்ள உரையில் புல்லட் 

அல்லது எண்வரிசையிடுவது பணிக்குறியின் 

மூலம் எவ்வளவு  எளிமையானத�ோ அதே ப�ோல 

அவற்றை நீக்குவது மிகவும் எளிதானதாகும்.

•	 புல்லட் மற்றும் எண்வரிசை நீக்க வேண்டிய 

உரையைத் தேர்வு செய்ய வேண்டும்.

•	 Bullets பணிக்குறியை  கிளிக் செய்தால் 

புல்லட் நீங்கும்.

•	 Numbering பணிக்குறியை  கிளிக் 

செய்தால் எண் வரிசை நீங்கும்.

•	 	பல்வேறு வகையான எண் வரிசைகள் 

க�ொண்ட  Bullets and Numbering 
உரையாடல் பெட்டி படம் 6.22 
காட்டப்பட்டுள்ளது.

குறிப்பு

 உரையை தட்டச்சு செய்யும் முன்னர�ோ அல்லது பின்னர�ோ இந்த முறையை 
பயன்படுத்தினால் உரை புல்லட் குறியுடன் அமையும்.
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6.9 பக்க வடிவூட்டல்

	 ச�ொற்செயலியின் ஒரு முக்கிய பணி பக்க 
வடிவூட்டலாகும். பக்க வடிவூட்டல் என்பது 
பக்கத்தின் ஓரம், பக்க எண், பக்க அமைப்பு, 
தலைப்பு மற்றும் அடிக்குறிப்பு ப�ோன்ற 
பக்கத்தின் பண்புகளை வடிவூட்டல் செய்வதாகும். 
வடிவூட்டல் செய்யப்பட்ட பக்கங்கள் படிப்பதற்கு 
எளிமையாகவும் ஆர்வமூட்டுவதாகவும் அமையும்.

6.9.1 பக்க அளவு மற்றும்  பக்க ஓரங்களை மாற்ற

பக்க அளவை மாற்ற

	ர ைட்டரில் ஒரு பக்க அளவு A4 அச்சிடும் 
தாளின் அளவான 8.5x11” க�ொடாநிலை 
அளவாக இருக்கும். பலவகையான 

ஆவணத்தின் அளவிற்கேற்ப பக்க அளவை 
பயனர் மாற்றிக் க�ொள்ளலாம்.  பக்க அளவை 
மாற்ற:

•	 பக்க அளவை மாற்றுவதற்கான பக்கத்தைத் 
தேர்வு செய்ய வேண்டும்.

•	 Format  page என்ற கட்டளையைத் 
தேர்வு செய்தால் படம் 6.23 - ல் உள்ள Page 
Style உரையாடல் பெட்டி த�ோன்றும்.

•	 Page த�ொகுதியைக் கிளிக் செய்யவும்.

•	 Paper format குழுவில் A4, Legal ப�ோன்ற 
வடிவூட்டல் தேர்வுகளிலிருந்தோ அல்லது 
width மற்றும் Height என்ற விருப்பத்தைப் 
பயன்படுத்திய�ோ பக்க அளவை மாற்றலாம். 

படம் 6.23 Page Style உரையாடல் பெட்டி

பக்கத்தின்  ஓரங்களை மாற்ற

	 பக்க ஓரம் என்பது, ஒரு பக்கத்தின்  மேல், கீழ், இடது மற்றும் வலது ஓரங்களில்  உள்ள 
வெற்றிடத்தை குறிக்கும். ஒரு பக்கத்தின் உரையில் மேல் ஓரம்,த�ொடங்குமிடம், தட்டச்சு செய்யும் ப�ோது 
கீழ் ஓரம் முடிந்தால் அடுத்த பக்கத்திற்கு செல்ல, இடது ஓரத்திலிருந்து துவங்கி வலது ஓரம் வந்தவுடன், 
அடுத்த வரிக்கு செல்ல இவையனைத்தும் ரைட்டரின்   ஓரங்கள் தீர்மானிக்கும்.

பக்கத்தின்  ஓரங்களை மாற்ற அல்லது அமைக்க ஓபன் ஆஃபீஸ் ரைட்டரில் இரு வழிகள் உள்ளன:
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•	 ஓரத்தின் அளவுகள் சரியாகத் தெரியாத 
ப�ொழுது ரூலர்கள் க�ொண்டு விரைவாகவும் 
மற்றும் எளிதாகவும் மாற்றலாம். 

•	 ஓரத்தின் அளவுகள் சரியாகத் தெரிந்தால் 
Page style உரையாடல் பெட்டி க�ொண்டு 
ஓரங்களை மாற்றலாம்.

1.	 ரூலரின் உதவியுடன் பக்கத்தின்  ஓரங்களை 
மாற்ற

1.	 ரூலரின் மங்கலாக உள்ள பகுதிகளே 
ஓரங்களாகும்.

2.	 சுட்டியின் சுட்டியை சாம்பல் நிறப்பகுதிக்கும் 
வெள்ளை நிற பகுதிக்கும் இடையே 
வைத்தால் சுட்டியின் குறியீடானது   இரு 
தலை (Double headed) க�ொண்ட 
அம்புக்குறியாக மாறும்.

3.	 சுட்டெலியின் இடது புற ப�ொத்தானை 
அழுத்திக் க�ொண்டே சுட்டெலியை ஓரங்கள் 
மீது நகர்த்தி, தேவையான இடத்தில் 
அழுத்துதலை விடுவித்தால், புதிய ஓரங்கள் 
அமையும்.

2.	 Page style உரையாடல் பெட்டியின் மூலம் 
ஓரங்களை மாற்ற

1.	 பக்கத்தில் ஏதேனும் ஓரிடத்தில் சுட்டெலியின் 
வலது ப�ொத்தானை கிளிக் செய்தால் மேல் 
மீட்புப் பட்டி (pop up) த�ோன்றும் அதில் page 
தேர்வு செய்யவும் அல்லது Page Style 
உரையாடல் பெட்டியில் page த�ொகுதியைத் 
தேர்வு செய்யவும்.

2.	 Margins பெட்டியில் இடது, வலது, மேல் 
மற்றும் கீழ் ஓரங்களுக்கு உரிய மதிப்பை 
தட்டச்சு செய்து

3.	 OK ப�ொத்தானை கிளிக் செய்ய வேண்டும்.

6.9.2 பக்க அமைவு (Page Orientation)

	 பக்க அமைவு என்பது திரையில் 
ஆவணத்தின் த�ோற்றம் எவ்வாறு அமையும் 
மற்றும் அது எவ்வாறு அச்சிடப்படும் என்பதைக் 
குறிக்கும்.  இரண்டு வகையான பக்க அமைவுகள் 
உள்ளன:

லேண்ட்ஸ்கேப்  (Landscape)

	 ஆவணத்தின் அகலம் அதன் நீளத்தை 
விட பெரிதாக இருந்தால் லேண்ட்ஸ்கேப் 
எனப்படும். த�ொழில் முறை புகைப்படங்கள், 
அழைப்பிதழ்கள் ப�ோன்றவற்றிற்கு  இந்த 
அமைவு மிகவும் பயனுள்ளதாக உள்ளது.

Landscape

ப�ோர்ட்ரைட் (Portrait)

	க� ொடாநிலையாக ஒரு ஆவணத்தின் 
பக்கமைவானது ப�ோர்ட்ரைட்டில்  இருக்கும். 
இந்த அமைவில் ஆவணத்தின் நீளம் அதன் 
அகலத்தை விட பெரிதாக இருக்கும். 
புத்தகங்கள், செய்தித்தாள்கள் ப�ொதுவாக இந்த 
வடிவத்தில் அச்சிடப்படும்.

Portrait

பக்கத்தின் அமைவை மாற்ற  

•	 பக்க அமைவை மாற்றியமைக்க அதற்குரிய  
பக்கத்தை தேர்வு செய்யவும்.

•	 Page style உரையாடல் பெட்டியில் 
Orientation குழுவில் நீளவாக்கு or 
பக்கவாக்கு ப�ொத்தானை தேர்வு செய்தால் 
பக்கத்தின் அமைவு மாற்றப்படும். 

6.9.3 பக்க வண்ணம் மற்றும் எல்லைகள் மாற்ற

	 பக்கத்தின் வண்ணத்தை 
மாற்றியமைப்பது பயனரின் இயல்பான செயல் 
அல்ல. 

	 படம் 6.24-ல் Page style உரையாடல் 
பெட்டியில் உள்ள Background த�ொகுதியிலுள்ள 
Color கீழிறங்கு பெட்டியை கிளிக் செய்தால் ஒரு 
வண்ணத்தட்டு த�ோன்றும், அதில் தேவையான 
வண்ணத்தை அல்லது “graphic” தேர்வு 
செய்தால் பக்கத்தின் பின்னணியில் படத்தை 
சேர்க்கலாம். 
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	 ஒரு ஆவணத்தில் உள்ள ஒரு பத்தி, ஒரு குறிப்பிட்ட பகுதி, ஒரு பக்கம் அல்லது ஆவணம் 
முழுமைக்கும் அதன் எல்லைகளை மாற்றியமைக்க முடியும். Page Style உரையாடல் பெட்டியிலுள்ள  
Borders த�ொகுதியைத்  தேர்வு செய்து, பயனர் வரையறுத்த பகுதியில் உள்ள எல்லைகளின் அளவு, 
எல்லைக் க�ோடுகளின் பாணி (Border line style), எல்லைகளின் நிறம் ஆகியவற்றை மாற்றியமைக்கலாம். 
படம் 6.25 Page Style உரையாடல் பெட்டியில்  உள்ள எல்லைகளின்  வடிவமைப்பை காட்டுகின்றது. 

படம் 6.24 பக்க பிண்ணனி நிறம் (Background color)

6.25 Page Style உரையாடல் பெட்டி - எல்லைகள்

6.10 தலைப்பு மற்றும் அடிக்குறிப்புகளில் 
செயலாற்ற

	தல ைப்பு என்பது ஒரு பக்கத்தின் மேல் 
பகுதியைக் குறிக்கும், தலைப்பு பகுதியில், 
தலைப்பு மற்றும் நூலாசிரியர் 
பெயர்போன்றவற்றை சேர்க்கலாம். 

	 அடிக்குறிப்பு என்பது பக்கத்தின் 
கீழ்பகுதியைக் குறிக்கும், அடிக்குறிப்பில் பக்க 
எண்கள், தேதி, நேரம் ப�ோன்றவற்றை சேர்க்கலாம். 
இவ்வாறு சேர்க்கப்பட்ட, தலைப்பு மற்றும் 
அடிக்குறிப்புகள் எல்லா பக்கங்களிலும் த�ோன்றும்.

	 File பட்டிப்பட்டையில் உள்ள Page 
Preview விருப்பத்தை தேர்வு செய்து தலைப்பு 
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மற்றும் அடிக்குறிப்புகளை காணலாம்.

6.10.1 தலைப்பு மற்றும் அடிக்குறிப்புகளை 
சேர்க்க 

தலைப்பு உருவாக்க

•	 InsertHeaderDefault என்ற 
கட்டளையை பட்டிப்பட்டையிலிருந்து தேர்வு 
செய்யவும்.

•	 தற்போது தலைப்பு பகுதியும், பணியிடத்தில் 
தட்டச்சு செய்த பகுதியும் தனித் தனியாக 
பிரிக்கப்பட்டிருக்கும்.

•	 தலைப்பு பகுதியில் நேரடியாகவே தலைப்பை 
தட்டச்சு செய்யலாம் அல்லது எல்லா 
பக்கங்களிலும் தலைப்பை சேர்க்க தலைப்பு 
பகுதியில் கிளிக் செய்து 
InsertFieldsTitle என்ற கட்டளையை 
தேர்வு செய்து தலைப்பைச் தட்டச்சு செய்யலாம்.

அடிக்குறிப்புகளை உருவாக்க

•	 Insert->Footer->Default என்ற 
கட்டளையை பட்டிப்பட்டையிலிருந்து தேர்வு 
செய்தால் அடிக்குறிப்பு உருவாகும்.

•	 அடிக்குறிப்பில் செருகும் புள்ளியை வைத்து 
கிளிக் செய்யவும்.

•	 InsertFieldsDate என்ற கட்டளையை 
தேர்வு செய்தால் எல்லா பக்கங்களுக்கும் 
கணிப்பொறியின் தேதி புகுத்தப்படும்.

•	 முதல் பக்கத்தில் தலைப்பு மற்றும் 
அடிக்குறிப்பை உருவாக்கினால் அதுவே 
அனைத்துப் பக்கங்களிலும் த�ோன்றும் 

6.10.2 அடிக்குறிப்பில் பக்க எண்களை புகுத்தி 
அவற்றை வடிவூட்டம் செய்ய

தலைப்பு மற்றும் அடிக்குறிப்பு உருவாக்கிய பின் 
அவற்றில் பக்க எண்களை புகுத்த பின்வரும் வழி 
முறைகளை பின்பற்றலாம்:

•	 செருகும் புள்ளியை அடிக்குறிப்பில் க�ொண்டு 
சென்று கிளிக் செய்யவும், 
InsertFieldsPage Number என்ற 
கட்டளையை பயன்படுத்தினால் எல்லா 
பக்கங்களிலும் பக்க எண்கள் சாம்பல் நிற 
பின்புற வண்ணத்துடன் 1,2,3... எனத்  
த�ோன்றும் சேர்க்கப்படும்.

•	 அடிக்குறிப்பில் உள்ள பக்க எண்களை 
வடிவூட்டம் செய்ய.

•	 Format Page என்ற கட்டளையை  தேர்வு 
செய்தால் Page Style உரையாடல் பெட்டி படம் 
6.26-ல் உள்ளது ப�ோல த�ோன்றும்.

•	 இதில் Page த�ொகுதியைக் கிளிக் செய்யவும்.

•	 Layout Settings-ல் த�ோன்றும் Format 
கீழிறங்கு பட்டிப்பெட்டியில் (drop down 
combo box) உள்ள விருப்பமான வடிவூட்டல் 
வகையை தேர்வு செய்து OK ப�ொத்தானை 
கிளிக் செய்தால் அடிக்குறிப்பில் பக்க 
எண்கள் வடிவூட்டம் செய்யப்பட்டிருக்கும்.

படம் 6.26 Page style உரையாடல் பெட்டி
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6.4	 புதியதாக ஒரு ஆவணத்தை திறக்கவும்.

•	 கீழ்க்கண்ட பத்தியை தட்டச்சு செய்யவும்.

	 “Learning gives creativity, creativity leads to thinking, thinking provides knowledge and 
knowledge makes you great”

•	 ஆவணத்தை சேமிக்கவும்.

•	 தடிமனான, சாய்ந்த, அடிக�ோடிட்ட, எழுத்து வகை மாற்றம், எழுத்தின் அளவு மாற்றம், எழுத்தின் 

வண்ணத்தில் மாற்றம், ஆங்கில எழுத்துக்களை பெரிய எழுத்துகளிலிருந்து சிறிய 

எழுத்துக்களாகவும் மற்றும் சிறிய எழுத்துக்களை பெரிய எழுத்துக்களாக  மாற்றம் ப�ோன்ற உரை 

வடிவூட்டல்களை   செய்து பத்தியை படிப்பவரின் ஆர்வத்தை தூண்டுவதாக அமைக்கவும்.

•	 “Knowledge makes you great”என்ற உரையை உயர்த்திக்காட்டுக. 

•	 மேலும் விசைப்பலகை குறுக்கு வழியின் மூலம், நீங்கள் செய்த எல்லா வடிவூட்டல்களையும் 

நீக்குக.

6.5	 பயிற்சி பட்டறை 6.4ல் சேமித்த ஆவணத்தை திறக்கவும்.

•	 கீழே க�ொடுக்கப்பட்டுள்ள பத்தியை முதல் பத்தியின் கீழ் தட்டச்சு செய்யவும்.

	 “When one door closes, another opens, but we often look so long and so regretfully upon 
the closed door that we do not see the one that has opened for us – Alexander Grahambell”.

•	 முதல் பத்தியை விசைப்பலகை குறுக்கு வழிகள் அல்லது பத்தி இசைவு பணிக்குறிகளை 

பயன்படுத்தி (வலது, இடது, மைய அல்லது நேர்த்தி) இசைவில் அமைக்கவும்.

•	 இரண்டாவது பத்தியின் வரி இடைவெளியை ஏதேனும் ஒரு வகையில் மாற்றியமைக்கவும்.

•	 முதல் பத்திக்கு புல்லட் குறி  மற்றும் இரண்டாவது பத்திக்கு எண் வரிசையை  பணிக்குறி அல்லது 

பட்டிப்பட்டையின் மூலம் செய்து பார்.

•	 ஆவணத்தை சேமித்து மூடவும்.

6.6 	 பயிற்சி பட்டறை 6.5 - ல் உள்ள ஆவணத்தை திறக்கவும்.

•	 பக்க அளவு, ஓரம் , அமைவு, எல்லை, பின்னணி நிறம் ப�ோன்றவற்றை மாற்றுக.

•	 ஆவணத்திற்கு உரிய தலைப்பு மற்றும் அடிக்குறிப்புகளை இடுக.

பயிற்சி பட்டறை  

•	 பகுதி III : உரைப் பகுதியை கண்டுபிடித்து மாற்றுதல் (Find and Replace)

6.11 வேண்டிய உரைப் பகுதியை கண்டுபிடித்து மாற்றம் செய்ய

	 ரைட்டரில் உள்ள Find and Replace வசதி, ஆவணத்தில் உள்ள ஒரு ச�ொல்லைக் கண்டுபிடித்து 

அதனை வேற�ொரு ச�ொல்லாக மாற்றியிட உதவுகின்றது. Find and Replace - ல் ச�ொற்கள் மற்றும் 

ச�ொற்றொடர்களுக்கு மட்டுமல்லாது, வைல்டு கார்டுகள் மற்றும் வழக்கமான வெளிப்பாடுகளைக் 
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(Expressions) க�ொண்டு ஒரு மேம்பட்ட தேடலை பயனர் செய்ய முடியும். இதில் ஒரு ச�ொல்லைத் தேட,

•	 Edit  Find & Replace அல்லது Ctrl+F கிளிக் செய்யவும்.

•	 படம் 6.27 உள்ளது ப�ோன்ற Find & Replace உரையாடல் பெட்டி த�ோன்றும்.

Bombay

Mumbai

படம் 6.27 Find & Replace  உரையாடல் பெட்டி

வேண்டிய ச�ொல் அல்லது உரையைத் தேடி மாற்றுவதற்கான வழிகள்:

1.	 Search for பெட்டியில் தேட வேண்டிய ச�ொல்லை தட்டச்சு செய்யவும். எடுத்துக்காட்டாக “Bombay” 
என்ற வார்த்தையை தேடி அதற்கு பதிலாக “Mumbai” என்று மாற்றம் செய்ய Search for பெட்டியில் 

“Bombay” என்று தட்டச்சு செய்யவும். Replace with பெட்டியில் மாறி வர வேண்டிய “Mumbai”  என்ற 

ச�ொல்லை தட்டச்சு செய்க. 

2.	 Find ப�ொத்தானை கிளிக் செய்தவுடன், தேடல் த�ொடங்கி “Bombay”  என்ற வார்த்தையின் முதல் 

இருப்பிடத்தில் அந்த வார்த்தையைக் கண்டுபிடித்து அது உயர்த்திக் காட்டப்படும்.

3.	 உயர்த்திக் காட்டப்பட்ட ச�ொல்லை மட்டும் மாற்றியிடுவதற்கு Replace ப�ொத்தானை கிளிக் செய்யவும்.

4.	 Find All கிளிக் செய்தால் ஆவணத்தில் தேடப்படும் ச�ொல் உள்ள எல்லா இடங்களிலும் தேடப்பட்டு 

அந்த ச�ொல்லானது அனைத்து இடத்திலும்   தேர்வு செய்யப்பட்டு உயர்த்திக்  காட்டப்படும்.

5.	 Replace All ப�ொத்தானை கிளிக் செய்தால் உயர்த்திக் காட்டப்பட்ட அனைத்து “Bombay” என்ற 
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வார்த்தை இருக்கும் எல்லா இடத்திலும் “Mumbai” என்று மாற்றப்பட்டிருக்கும்.

6.	 உரையாடல் பெட்டியில் உள்ள Match case தேர்வு செய்தால் பெரிய மற்றும் சிறிய வடிவிலான வழக்கு 

எழுத்துக்களை தனித்தனியாக தேடலின் ப�ோது வேறுபடுத்த முடியும். 

7.	 Whole words only-ஐ தேர்வு செய்தால் அந்த வார்த்தையை மட்டும் தேடும்.
எடுத்துக்காட்டாக"Imagine"என்ற ச�ொல்லை தேடினால் இது  "image", "images" ப�ோன்ற 

ச�ொற்களைத்  தவிர்த்து Imagine என்ற ச�ொல்லை மட்டுமே காட்டும்

•	 புதிய ஆவணத்தை திறக்கவும்.

•	 கீழே க�ொடுக்கப்பட்டுள்ள பத்தியை தட்டச்சு செய்யவும்.

	 “ All birds find shelter during rain. But Egles avoid rain by flying above the clouds,problems 
are common, but attitude make the difference”

•	 “Egles” என்ற தவறான வார்த்தையை தேடி அதற்கு  பதிலாக “Eagles” என்ற பிழை திருத்தப்பட்ட 
வார்த்தையாக Find & Replace  மூலம் மாற்றியமை.

•	 கடவுச் ச�ொல்லுடன் ஆவணத்தை சேமிக்கவும்.

பயிற்சி பட்டறை  

இணைப்பு

விசைப்பலகை குறுக்கு வழிகள்

திசை குறுக்குவழி செயல்பாடு

Ctrl+A முழு ஆவணத்தை தேர்வு செய்ய

Ctrl+B உரையை தடித்த எழுத்தாக மாற்ற

Ctrl+C உரையை நகலெடுக்க

Ctrl+D உரைக்கு இரு அடிக்கோடிட

Ctrl+E உரையை மைய இசைவில் அமைக்க

Ctrl+End ஆவணத்தின் இறுதிக்குச் செல்ல

Ctrl+F உரையை தேடுதல் மற்றும் மாற்றியிடுதல்

Ctrl+Home ஆவணத்தின் த�ொடக்கத்திற்கு செல்ல

Ctrl+I உரையை சாய்ந்த எழுத்தாக மாற்ற

Ctrl+J உரையை நேர்த்தி இசைவில் அமைக்க

Ctrl+L உரையை இடது இசைவில் அமைக்க

Ctrl+R உரையை வலது இசைவில் அமைக்க
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Ctrl+U உரையை அடிக்கோடிட

Ctrl+V நகலெடுத்த அல்லது நகர்த்திய உரையை ஒட்ட

Ctrl+X உரையை நகர்த்த

Ctrl+Y கடைசியாக செய்த செயலை மீண்டும் செய்ய

Ctrl+Z கடைசியாக செய்த செயலை நீக்க

DownArrow கீழ்ப்புறமாக ஒரு வரி நகர்த்த

End வரியின் இறுதிக்கு

Home வரியின் த�ொடக்கத்திற்கு 

Left Arrow இடது புறம் உள்ள ஒரு எழுத்துக்கு நகர்த்த

Right Arrow வலது  புறம் உள்ள ஒரு எழுத்துக்கு நகர்த்த

Shift+ DownArrow கீழ்புறத்திலுள்ள வரிகளைத் தேர்வு செய்ய

Shift+ LeftArrow
தேர்வு செய்த உரையின் இடப்புறத்திற்கு செருகும் 
புள்ளியை நகர்த்த

Shift+ RightArrow
தேர்வு செய்த உரையின் வலப்புறத்திற்கு செருகும் 
புள்ளியை நகர்த்த

Ctrl+ LeftArrow இடது புறமாக ஒரு ச�ொல் அளவுக்கு

Ctrl+ RightArrow வலது புறமாக ஒரு ச�ொல் அளவுக்கு

Shift+End
செருகும் புள்ளி இருக்கும் இடத்திலிருந்து வரியின் 
இறுதி வரை தேர்வு செய்ய

Insert செருகுவதற்கு

Page Up ஒரு பக்கத்தின் மேலே செல்வதற்கு

Page down ஒரு பக்கத்தின் கீழே செல்வதற்கு

Shift+Home
வரியின் த�ொடக்கத்திலிருந்து செருகும் புள்ளி 
இருக்கும் வரை தேர்வு செய்ய

Shift+Up Arrow மேல்புறத்திலுள்ள வரிகளைத் தேர்வு செய்ய

UpArrow மேல்புறமாக ஒரு வரி நகர்த்த

Ctrl+Shift+B எழுத்துக்களை கீழ்ஒட்டாக அமைக்க

Ctrl+Shift+P எழுத்துக்களை மேல்ஒட்டாக அமைக்க 
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Unicode தமிழ் விசைபலகைக்கான தட்டச்சு விளக்கப்படம்

a அ k க் ka க ke கே
aa ஆ ng ங் nga ங kee கே
i இ s ச் sa ச ko க�ொ
ii ஈ nj ஞ் nja ஞ koo க�ோ
u உ d / t ட் da / ta ட kau க�ௌ
uu ஊ N ண் Na ண
e எ w ந் wa ந we நெ
ee ஏ th த் tha த wee நே
ai ஐ p ப் pa ப wo ந�ொ
o ஒ m ம் ma ம woo ந�ோ
oo ஓ y ய் ya ய wau ந�ௌ
au ஔ r ர் ra ர
q ஃ l ல் la ல

v வ் va வ
z ழ் za ழ
L ள் La ள
R ற் Ra ற
n ன் na ன

j ja jaa je jee jo joo ji jii ju juu
ஜ் ஜ ஜா ஜெ ஜே ஜ�ொ ஜ�ோ ஜி ஜீ ஜு ஜூ
sh sha shaa she shee sho shoo shi shii shu shuu
ஷ் ஷ ஷா ஷெ ஷே ஷ�ொ ஷ�ோ ஷி ஷீ ஷு ஷூ

தமிழ் இடைமுகத்தை பயன்படுத்தி கீழே க�ொடுக்கப்பட்டுள்ள உரையை தட்டச்சு செய்க.

முரசு / NHM / அழகி

	 இதில் உள்ள ஏதேனும் இடைமுகம் மூலம் கீழே க�ொடுக்கப்பட்டுள்ள தமிழ் உள்ளடக்கத்தை 

தட்டச்சு செய்யவும்.

kaNNan - கண்ணன் joothpur – ஜ�ோத்பூர்
sennai – சென்னை juulai – ஜூலை
thamizwaadu – தமிழ்நாடு shiiradi – ஷீரடி
thaajmahaal – தாஜ்மஹால் hamadu – ஹமது
shaajakaan – ஷாஜகான் vaashingtan - வாஷிங்டன்
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	 சென்னையில் உள்ள மாநகராட்சிப் பள்ளிகள் சென்னைப்பள்ளிகள் (Chennai Schools) 
என்று அழைக்கப்படுகின்றன. இந்தப் பள்ளிகளை நிர்வகிக்க சென்னை மாநகராட்சியில் 
கல்வித்துறை (Education Department) இயங்கி வருகின்றது. ஒரு இந்திய ஆட்சிப்பணி (IAS) 
அதிகாரி, ஒரு கல்வி அலுவலர் (Educational Officer) மற்றும் 10 துணைகல்வி அலுவலர்களுடன் 
(Assistant Educational Officers – AEO) இத்துறை செயல்படுகிறது.

செயல்பாடு

மாணவர் செயல்பாடு

1.	 பள்ளியின் ஆண்டு விழாவிற்கான அழைப்பிதழை தயார் செய்.

2.	 பிறந்தநாள் வாழ்த்து மடல் லேண்ட்ஸ்கேப்பில்  தயார் செய்து வாழ்த்துச் செய்தியை படத்துடன் 

சேர்க்கவும்.

ஆசிரியர் செயல்பாடு

1.	 செய்முறை வகுப்பில் வினாத்தாளில் வாய்பாடு மற்றும் சிறப்பு எழுத்துகளுடன் எவ்வாறு தயார் 

செய்வது, பக்கத்தின் ஓரங்களை மாற்றும் முறை, அச்சிடும் முறைகளை விளக்குக.

மதிப்பாய்வு

பகுதி - அ

I சரியான விடையை தேர்வு செய்க

1.	 Table Format உரையாடல் பெட்டியை திறப்பதற்கு இவற்றுள்  எந்த கட்டளையைத் தேர்வு செய்ய 
வேண்டும்?

	 அ. File  Table properties		  ஆ. Format  Table properties

	 இ. Table  Table Properties		  ஈ. Edit  Table Properties

2.	 திரையின் கீழ் பகுதியில் உள்ள எந்த ப�ொத்தான் ஆவணத்தின் நிலையைக் காட்டும்?

	 அ. பணிப்பட்டை				    ஆ. தலைப்பு பட்டை 

	 இ. நிலைமை பட்டை 			   ஈ. கருவிப்பட்டை

3.	 ஆவணத்தின் மேல் ஓரத்தில் இவற்றுள் எந்த பகுதி த�ோன்றும்?

	 அ. Head		  ஆ. Foot		  இ. Header		  ஈ. Footer

4.	 இவற்றுள் எந்த பகுதி பயன்பாட்டின் பெயரை திரையின் மேல் புறத்தில் காட்டும்?

	 அ. பட்டிப்பட்டை 				    ஆ. கருவிப்பட்டை  

	  இ. தலைப்புப் பட்டை			   ஈ. வடிவூட்டல் பட்டை

5.	 உரையின் க�ொடாநிலை த�ோற்றத்தை மாற்றுவது?

	 அ. உரை வடிவூட்டம் 			   ஆ. பக்க வடிவூட்டம்	

	 இ. சிறப்பு வடிவூட்டம் 			   ஈ. பத்தி வடிவூட்டம்
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6.	 Find & Replace அம்சம் எந்த பட்டிப்பட்டையில் உள்ளது?
	 அ. File		  ஆ.  Edit		  இ. Tools		  ஈ. Format

7.	 ஆவணத்தில் உள்ள தேடப்படும் வார்த்தை த�ோன்றும் எல்லா இடங்களையும் தேர்வு செய்யும் 
ப�ொத்தான் எது?

	 அ. Find		  ஆ. Find All	 	 இ. Replace 		  ஈ. Replace All

8.	 ஆவணத்தின்  த�ொடக்கத்திற்கு செல்ல குறுக்கு வழி சாவி எது?

	 அ. Ctrl + Home	 ஆ. Ctrl + End	 இ. Home		  ஈ. End

9.	 ஒரு ஆவணத்தில் தேடல் மற்றும் மாற்றியமைத்தலுக்கான குறுக்குவழி சாவி எது?

	 அ. Ctrl + F1	 ஆ. Ctrl + F4		  இ. Ctrl + F5 		  ஈ. Ctrl +F7

10.	ஏற்கனவே செய்த செயலை தவிர்க்க உதவும் குறுக்கு வழி சாவி சேர்மானம்  யாது?

	 அ. Ctrl +E		 ஆ. Ctrl + U		  இ. Ctrl + Z		  ஈ. Ctrl + n

பகுதி - ஆ

II சிறு வினாக்கள் (இரண்டு  மதிப்பெண்கள்)

1.	 உரை வடிவூட்டம் என்றால் என்ன?

2.	 ஓபன் ஆஃபீஸ் ரைட்டரில் உள்ள பல்வேறு த�ொகுப்புகள் யாவை?

3.	 தனியுரிமம் பெற்ற மென்பொருள் மற்றும் திறந்த மூல மென்பொருள் பற்றிய வேறுபாடுகளை எழுதுக.

4.	 ஆவணத்தில் எவ்வாறு திருத்தங்கள் செய்வாய்?

5.	 ஓபன் ஆஃபீஸ் ரைட்டரின் சில அம்சங்களை எழுதுக.

பகுதி – இ
III குறு வினாக்கள் (மூன்று மதிப்பெண்கள்)

1.	 நகர்த்தல் மற்றும் நகலெடுத்தல் பற்றிய வேறுபாடுகளை எழுதுக.

2.	 பக்க அமைவுகள் எத்தனை வகைப்படும்?

3.	 புல்லட் மற்றும் எண்வரிசையை எவ்வாறு நீக்குவாய்?

4.	 ஆவணத்தை சேமிக்க கூடிய பல்வேறு வழிகள் யாவை?

5.	 உரையில் வரி இடைவெளியை மாற்றும் வழிகள் பற்றி எழுதுக.

பகுதி – ஈ
IV  நெடுவினாக்கள்  (ஐந்து மதிப்பெண்கள்)

1.	ர ைட்டரில் பக்க ஓரங்களை மாற்றும் வழிகளைப் பற்றி எழுதுக.

2.	தல ைப்பு மற்றும் அடிக்குறிப்பு என்றால் என்ன? இவற்றில் எவ்வாறு பக்க எண்களை சேர்ப்பாய்?

3.	 பக்க இசைவின் வகைகளைப் பற்றி எழுதுக.

4.	ர ைட்டரில் ஒரு ச�ொல்லை கண்டறிந்து வேறு ஒரு ச�ொல்லாக மாற்றம் செய்வதற்கான படிநிலைகளை   
எழுதுக.

5.	 உள்தள்ளல் என்றால் என்ன? ஆவணத்தில் எவ்வாறு உள்தள்ளல் செய்வது பற்றி விளக்குக.
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ஆவணத்தில் அட்டவணைகள், ப�ொருள்கள் சேர்ப்பது 
மற்றும் ஆவணத்தை அச்சிடல்

7.1 அட்டவணையில் வேலை செய்தல்

	 ஒரு அட்டவணை என்பது குறிப்பிட்ட 

எண்ணிக்கையிலான வரிசை மற்றும் நெடுவரிசை 

க�ொண்ட கட்டங்களின் த�ொகுப்பாகும். நன்கு 

வடிவமைக்கப்பட்ட அட்டவணை மூலம் பயனர் 

ப�ொருளடக்கத்தை எளிதாக புரிந்து க�ொள்ள 

உ த வு கி ற து .

7.1.1 அட்டவணையைச் செருகுவதற்கான 

பல்வேறு நுட்பங்கள்

அட்டவணை உருவாக்க இரு வழிகள் உள்ளன:

•	 அட்டவணை பணிக்குறியைப் பயன்படுத்தி 

அட்டவணையை உருவாக்கலாம்

•	 Insert Table உரையாடல் பெட்டியைப் 

பயன்படுத்தி அட்டவணையை உருவாக்கலாம்.

அட்டவணை பணிக்குறியைப் பயன்படுத்தி 

அட்டவணையை உருவாக்கலாம்

	செந்தரக்  கருவிப்பட்டையிலிருந்து 

ஒரு அட்டவணையை எளிதாக ஆவணத்தில் 

ச ே ர ்க்கலா    ம் :

1.	 அட்டவணையை உருவாக்குமிடத்திற்கு 

செருகும் புள்ளியைக் க�ொண்டு செல்லவும்

பாடம் 7அலகு II ச�ொற்செயலி

2.	 செந்தரக் கருவிப்பட்டையிலுள்ள Table 
பணிக்குறியின் வலது புறத்தில்  உள்ள 

கீழ்நோக்கு அம்புக்குறியைக் கிளிக் செய்யவும்.

3.	 இப்பொழுது த�ோன்றும் கீழிறங்கு பட்டியல் 

பட்டையைக் க�ொண்ட  அட்டவணை 

கட்டங்களில் சுட்டெலியின் உதவியுடன் 

தேவையான எண்ணிக்கையிலான வரிசை 

மற்றும் நெடுவரிசைகளைத் தேர்வு செய்து 

க�ொள்ளலா ம். 

4.	 செருகும் புள்ளியுள்ள இடத்தில் அட்டவணை 

த�ோன்றும்

Insert Table உரையாடல் பெட்டியைப் பயன்படுத்தி 

அட்டவணையை உருவாக்கலாம்

	 Insert Table உரையாடல் பெட்டியின் மூலம் 

ஒரு அட்டவணையை உருவாக்கும் ப�ோது அந்த 

அட்டவணையின் அமைப்பையும், பண்புகளையும் 

மாற்றியமைக்க இயலும். Insert Table உரையாடல் 

பெட்டியைத் திறக்க Table  Insert  Table 
அல்லது Ctrl+F12 கிளிக் செய்யவும். படம் 7.1 –ல் 

காட்டியது ப�ோல் Insert Table உரையாடல் பெட்டி 

த�ோன்றும்.

படம் 7.1  Insert Table உரையாடல் பெட்டி
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•	 Name உரைப் பெட்டியில் அட்டவணைக்கான 
பெயரைத் தர வேண்டும்.

•	 அந்த உரையாடல் பெட்டியில் தேவையான 
வரிசைகள் (rows) மற்றும் நெடுவரிசையின் 
(columns) எண்ணிக்கையை சுழற் 
அம்புக்குறி மூலம் அல்லது எண்ணிக்கையை 
நேரடியாக தட்டச்சு செய்ய வேண்டும்.

•	 அட்டவணையின் முதல் வரிசையை 
தலைப்பாக எடுத்துக்கொள்ள Heading 
தேர்வு பெட்டியைக் கிளிக் செய்யவும். Repeat 
Heading என்ற தேர்வு பெட்டியை கிளிக் 
செய்தால்   அட்டவணை உள்ள எல்லா 
பக்கங்களிலும் தலைப்பு த�ோன்றும்.

•	 அட்டவணையில் கட்டங்களுடன் காட்ட 

Border  தேர்வு பெட்டியை கிளிக்  செய்யவும்.

•	 OK ப�ொத்தானை கிளிக் செய்தால் 

அட்டவணை உருவாக்கப்படும்.

தரவுகளை அட்டவணையில் உள்ளிடல்:

	தேவை யான எண்ணிக்கையிலான 

வரிசைகள் மற்றும் நெடுவரிசைகள் க�ொண்ட 

அட்டவணையை உருவாக்கப்பட்ட பின் 

அட்டவணையில் தரவுகளை  உள்ளிடலாம்.

	 அட்டவணை உருவாக்கும் ப�ோது ஒரே 

அளவிலான உயரம் மற்றும் அகலத்தைக் 

க�ொண்ட அட்டவணை ஆவணத்தின் முழுவதிலும் 

அமையும். அட்டவணையை உருவமைத்தபின் 

செருகும் புள்ளியானது அட்டவணையின் முதல் 

சிற்றரையில் (ஒரு வரிசையும் மற்றும்  நெடுவரிசையும் 

சந்திக்குமிடம்  சிற்றரை எனப்படும்.) பயனர்  

தட்டச்சு செய்யலாம். Tab சாவியைப் பயன்படுத்தி  

சிற்றரையின் வலது பக்கத்திலும்  மற்றும் Shift 
+ Tab சாவியைப் பயன்படுத்தி சிற்றரையின் 

இடது பக்கத்திலும் நகரலாம். அட்டவணையை 

உருவாக்கியவுடன் படம் 7.2 ல் உள்ளது ப�ோன்ற  

Table Formatting கருவிப்பட்டைத் த�ோன்றும்.  

View  Toolbars  Table என்ற கட்டளையைத் 

தேர்வு செய்தும் இந்த கருவிப்பட்டையைத் 

திறக்கலாம்.

7.1.2 வரிசைகள் மற்றும் நெடுவரிசைகளை 

சேர்த்தல் மற்றும் நீக்குதல்

வரிசைகளைச் சேர்த்தல்

	 அட்டவணையில் வரிசைகளை 

சேர்ப்பதற்கு கீழ்க்கண்ட வழிமுறைகளைக் 

கை  ய ா ள லா  ம் .

1.	 இதற்கு மிகவும் எளிமையான வழி, 

அட்டவணையின் கடைசி  சிற்றரையில் Tab 

சாவி ப�ொத்தானை அழுத்த வேண்டும்.

2.	 அட்டவணையில்  ஒரு  வரிசையைச்  

சேர்க்க செருகும் புள்ளியைத்   தேவையான 

சிற்றரைக்கு க�ொண்டு சென்று Table 
Formatting கருவிப்பட்டையில் உள்ள Insert 
row  பணிக்குறியைக்  கிளிக் செய்யவும். 

3.	 ஒன்றுக்கு மேற்பட்ட வரிசைகளைச் 

சேர்க்க விரும்பினால் Table  Insert  
Rows  என்ற கட்டளையைப் பயன்படுத்த 

வேண்டும். படம் 7.3 ல் காட்டப்பட்டுள்ள 
Insert Rows உரையாடல் பெட்டி த�ோன்றும். 
இதில், சுழல் அம்புக்குறிகளை நகர்த்திய�ோ  
அல்லது வரிசையின் எண்ணிக்கைகளை 
நேரடியாக தட்டச்சு செய்தோ தேவையான 
எண்ணிக்கையிலான வரிசைகளைச் 

சேர்க்கலாம். Before அல்லது After 
ரேடிய�ோ ப�ொத்தானை தேர்வு செய்து வரிசை 
எங்கு சேர்க்கப்பட வேண்டும் என்பதைத் 
தீர்மானிக்கலாம்.

4.	 OK ப�ொத்தானை கிளிக் செய்யவும்.

படம் 7.2  Table Formatting கருவிப்பட்டை
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படம் 7.3 Insert Rows உரையாடல் பெட்டி

நெடுவரிசைகளைச் சேர்த்தல்

	ந ெடுவரிசைகளைச் சேர்க்க பல வழிகள் உள்ளன.

1.	 அட்டவணையில் நெடுவரிசையை எங்கு 
சேர்க்க வேண்டும�ோ அந்த இடத்தில் செருகும் 
புள்ளியைக் க�ொண்டு சென்று Insert column  

 பணிக்குறியைக் கிளிக் செய்தால், செருகும் 
புள்ளிக்கு வலது புறத்தில் ஒரு புதிய நெடுவரிசை 
சேர்க்கப்படும்.

2.	 ஒன்றுக்கு மேற்பட்ட நெடுவரிசைச் சேர்க்க, 
செருகும் புள்ளியை அந்த நெடுவரிசையில் 
க�ொண்டு சென்று Table  Insert  Columns 
என்ற கட்டளையைப் பயன்படுத்தினால் படம் 
7.4 – ல் உள்ளது  ப�ோன்ற Insert Columns 
உரையாடல் பெட்டி த�ோன்றும், இந்த உரையாடல் 
பெட்டியில் நெடுவரிசையின் எண்ணிக்கையைச் 
சுழல் அம்புக்குறியைக்கொண்டு நகர்த்திய�ோ 
அல்லது எண்ணிக்கையை நேரடியாகவ�ோ 
தட்டச்சு செய்யலாம்.

3.	 Position விருப்பத்தில் உள்ள Before 
அல்லது After ரேடிய�ோ ப�ொத்தான் மூலம்  
சேர்க்கப்படும் நெடுவரிசையின் இடத்தை 
அட்டவணையில் தேர்வு செய்யலாம்.

4.	 OK ப�ொத்தானை கிளிக் செய்யவும்.

படம் 7.4 Insert Columns உரையாடல் பெட்டி 

வரிசைகள் மற்றும் நெடுவரிசைகளை நீக்க

1.	 ஒரு வரிசை அல்லது வரிசைகளை நீக்க, 

செருகும் புள்ளியை அந்த வரிசையில் அமர்த்தி 

தேவையான வரிசை அல்லது வரிசைகளைத் 

தேர்வு செய்ய வேண்டும். இதன் பின் Table 
Formatting கருவிப்பட்டையில்  உள்ள  Delete 
Row பணிக்குறியை  கிளிக் செய்தால் 

அல்லது Table  Delete  Rows என்ற 

கட்டளையைப் பயன்படுத்தினால் தேர்வு 

செய்யப்பட்ட ஒன்று அல்லது ஒன்றுக்கு 

மேற்பட்ட வரிசைகள் நீங்கும்

2.	 ஒரு  நெடுவரிசை அல்லது நெடுவரிசைகளை 

நீக்க, செருகும் புள்ளியை அந்த 

நெடுவரிசையில் அமர்த்தி தேவையான 

நெடுவரிசை அல்லது நெடுவரிசைகளை 

தேர்வு செய்ய வேண்டும். இதன் பின்                                

Table Formatting கருவிப்பட்டையில்  

உள்ள Delete Column பணிக்குறியை 

 கிளிக் செய்தால் அல்லது Table  
Delete  Columns என்ற கட்டளையைப் 

பயன்படுத்தினால் தேர்வு செய்யப்பட்ட ஒன்று 

அல்லது ஒன்றுக்கு மேற்பட்ட நெடுவரிசைகள் 

நீ ங் கு ம் .

அட்டவணையில் உள்ள ப�ொருளடக்கத்தை 

நீ க் கு த ல்

•	 நீக்க வேண்டிய அட்டவணையைத் 

தேர்வு செய்தபின் Delete ப�ொத்தானை 

அழுத்தினால் அந்த அட்டவணையில் 

உள்ள ப�ொருளடக்கம் மட்டுமே நீக்கப்படும். 

அட்டவணை அப்படியே இருக்கும்.

முழு அட்டவணையை நீக்குதல்

1.	 Edit  Select All என்ற கட்டளையை 

பயன்படுத்திய�ோ அல்லது Ctrl + A 

என்ற குறுக்குவழி பயன்படுத்திய�ோ  முழு 

அட்டவணையை தேர்வு செய்ய வேண்டும்.

2.	 Table  Delete  Table என்ற 

கட்டளையைப் பயன்படுத்தினால் தேர்வு 

செய்யப்பட்ட அட்டவணையை நீக்கலாம்.
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7.1.3	 சிற்றரைகளை இணைத்தல் மற்றும் 

பி ரி த்த  ல்

குழுவாக உள்ள சிற்றரைகளை இணைக்க 

1.	 இணைக்க வேண்டிய சிற்றரைகளைத் தேர்வு 

செய்க.

2.	 Table  Merge Cells  கட்டளை அல்லது 
Merge Cells  பணிக்குறி அல்லது 

வலது கிளிக் செய்து த�ோன்றும் மேல் மீட்புப் 

பெட்டியில் Cell  Merge  என்பதைத் தேர்வு 

செய்ய வேண்டும்.

3.	 தேர்வு செய்யப்பட்ட சிற்றரைகள் ஒரே 

சிற்றரையாக இணைக்கப்படும்.

ஒரு சிற்றரையைப் பிரிக்க

1.	 பிரிக்க வேண்டிய அந்த ஒரு சிற்றரைக்குள் 

செருகும் புள்ளியை அமர்த்த வேண்டும்.

2.	 Table  Split Cells கட்டளை அல்லது Split 
Cells  பணிக்குறி அல்லது வலது கிளிக் 

செய்து த�ோன்றும் மேல்மீட்புப் பெட்டியில்  

Cell  Split என்பதை தேர்வு செய்தால் படம் 
7.5 உள்ள Split Cells உரையாடல் பெட்டி 

த�ோன்றும்.

படம் 7.5 Split Cells உரையாடல் பெட்டி

3.	 இதில் சுழற் அம்புக்குறிகளை நகர்த்தி 

பிரிக்க வேண்டிய எண்ணிக்கையைத் 

தேர்வு செய்யலாம் அல்லது நேரடியாக 

எண்ணிக்கையை தட்டச்சு செய்யலாம்.

4.	 சிற்றரைகளின் வரிசைகளைப் பிரிக்க 

கிடைக்கையாக (Horizontally) என்ற திசை 

தேர்வு செய்யலாம் அல்லது நெடுவரிசையாக 

பிரிக்க நெடுக்கையாக (Vertically) என்ற 

திசை தேர்வு செய்யலாம்.

5.	 தேர்வு செய்யப்பட்ட ஒரு சிற்றரை, 

நாம் விரும்பிய எண்ணிக்கையில் 

வரிசைகள் மற்றும் நெடுவரிசைகளாக 

பி ரி க ்கப்பட்    டு யி ரு க் கு ம் .

7.1.4 அட்டவணையின் அளவை மாற்ற (Resize 
the position of the table)

	 புதிதாக உருவாக்கப்பட்ட அட்டவணை 

க�ொடாநிலையாக அந்த பக்கத்தின் 

முழுமையிலும் அமையும். பயனரின் தேவைகேற்ப 

அட்டவணையின் அளவை மாற்றியமைக்கலாம்.

•	 அட்டவணையின் அளவை விரைவாக மாற்ற, 

அட்டவணையின் ஓரத்திற்கு சுட்டெலியை 

நகர்த்தினால் சுட்டியின் சுட்டி இரு தலை 

க�ொண்ட அம்பு குறியாக மாறும் சுட்டியை 

அழுத்தி அட்டவணையின் எல்லையைப் 

புதிய அளவிற்கு மாற்றிக் க�ொள்ளலாம்.

வரிசையின் உயரத்தை மாற்றியமைக்க

•	 செருகும் புள்ளியை, உயரம் மாற்றப்பட 

வேண்டிய வரிசையின் கிடைக்கை 

எல்லையின் மீது நகர்த்தினால், செருகும் 

புள்ளி இரு தலை க�ொண்ட அம்புகுறியாக 

மாறும், இதை அழுத்திக் க�ொண்டே 

நகர்த்தினால்  வரிசையின் உயரத்தை மாற்ற 

மு டி யு ம் .

நெடுவரிசையின் அகலத்தை மாற்றியமைக்க

•	 செருகும் புள்ளியை அகலம் மாற்றப்பட 

வேண்டிய நெடுவரிசையின் நெடுக்கை 

எல்லையின் மீது நகர்த்தினால் செருகும் 

புள்ளி இரு தலை க�ொண்ட அம்புகுறியாக 

மாறும், இதை அழுத்திக் க�ொண்டே 

நகர்த்தினால்  நெடுவரிசையின் அகலத்தை 

மாற்ற முடியும்.

உரையாடல் பெட்டியின் மூலம் நெடுவரிசையின் 

அகலத்தை மாற்றியமைக்க

•	 நெடுவரிசையில், மாற்றியமைக்கப்பட 

வேண்டிய அகலத்தை துல்லியமாகத் தேர்வு 

செய்த பின். அதை மாற்ற Table  Table 
Properties என்ற கட்டளையைத் தேர்வு 

செய்தால் படம் 7.6 - ல் உள்ளது ப�ோன்ற 
Table Format உரையாடல் பெட்டி த�ோன்றும்.
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•	 நெடுவரிசையின் அகலத்தை மாற்றியமைக்க, 

Columns த�ொகுதியைத் தேர்வு செய்து, 

Column Width சுழற்பெட்டியில் 

நெடுவரிசையின் புதிய அகலத்தைத் தட்டச்சு 

செய்யலாம் அல்லது சுழற் அம்புக்குறியை 

நகர்த்தி நெடுவரிசையின் அகலத்தை 

ம ாற்றலா     ம் .

•	 OK ப�ொத்தானை கிளிக் செய்ய வேண்டும்.

•	 நெடுவரிசைகளின் அகலம் புதிய மதிப்பில் 

மாற்றப்பட்டிருக்கும்.

7.2 அட்டவணை வடிவூட்டல்

	 அட்டவணை அமைப்பு, 

அட்டவணையிலுள்ள உரையை வடிவூட்டம் 

செய்தல், எல்லைகளை மாற்றியமைத்தல், 

பின்னணி மற்றும் தானியங்கு வடிவூட்டல் செய்வது 

அட்டவணை வடிவூட்டல் செயல்பாடுகளாகும்.

7.2.1	 அட்டவணையின் பின்னணியை 

ம ா ற் றி ய மை  க ்க

	 அட்டவணையில் செருகும் புள்ளியை 

அமர்த்த வேண்டும்.

1.	 Table  Table Properties  என்ற 

கட்டளையைத் தேர்வு செய்ய வேண்டும்.

2.	 படம் 7.7- ல் த�ோன்றும் Table Format 
உரையாடல் பெட்டியிலுள்ள Background  
தத்த தேர்வு செய்ய வேண்டும்.

	 For பிரிவில் உள்ள சிற்றரை பகுதியில், 

வரிசை அல்லது அட்டவணையின் பின்னணியை 

மாற்றியமைக்க இவற்றுள் தேவையானவற்றை 

தேர்வு செய்க.

•	 சிற்றரை	 : ஒரு சிற்றரை அல்லது சிற்றரை 

குழுவின் பின்னணியை மாற்றியமைக்க

•	 வரிசை	 : ஒரு வரிசை அல்லது 

வரிசைகளின் பின்னணியை மாற்றியமைக்க

•	 அட்டவணை : தேர்வு செய்யப்பட்ட பின்னணி 

முழு அட்டவணையின் பின்னணியை 

மாற்றியமைக்க.

3.	 As பிரிவில் Color அல்லது Graphic தேர்வு 

செய்க.

•	 Color தேர்வு செய்து, வண்ணத்தட்டில் 

த�ோன்றும் தேவையான நிறத்தை தேர்வு 

செய்து, பின் OK  ப�ொத்தானை கிளிக் செய்தால். 

அட்டவணையின் பின்னணி நிறமாறும்

•	 Graphic தேர்வு செய்து, உலாவி ப�ொத்தானை 

கிளிக் செய்து பயனருக்கு தேவையான 

படத்தை தேர்வு செய்த பின் OK ப�ொத்தானை 

கிளிக் செய்தால் தேர்வு செய்யப்பட்ட படம் 

பின்னணியில் த�ோன்றும்.

படம் 7.6 Table Format உரையாடல் பெட்டி
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படம் 7.7 Table Format உரையாடல் பெட்டி – பின்னணி

7.2.2 அட்டவணையில் த�ோன்றும் உரையின் திசையை மாற்ற 

•	 திசை மாற்றப்பட வேண்டிய உரையை சிற்றரையில் தேர்வு செய்க.

•	 Format  Character என்ற கட்டளையைத் தேர்வு செய்தால், Character உரையாடல் பெட்டி 

த�ோன்றும்.

•	 Position த�ொகுதியில் உள்ள Rotation / Scaling விருப்பத்தைத் தேர்வு செய்க.

•	 இதில் (0,90,270,Fit to line) ப�ோன்ற பலவிதமாக சுழற்சி க�ோணம் உள்ளது, தேவையான சுழற்சி 

க�ோணத்தைத் தேர்வு செய்து, OK ப�ொத்தானை கிளிக் செய்யவும்.

7.2.3 அட்டவணையின் எல்லைகளை மாற்றியமைக்க

	 அட்டவணையின் எல்லைகளை மாற்றியமைக்க, Table  Table Properties  என்ற கட்டளையைத் 

தேர்வு செய்யவும்.

	 Table Format உரையாடல் பெட்டி த�ோன்றும். இதில் Borders த�ொகுதியைத் தேர்வு செய்து, 

அட்டவணை அல்லது சிற்றரைகளின் குழுவின் எல்லைகளை மாற்றலாம்.

XI Std Computer Technology Vol-1 TM Chapter 7_100_117.indd   110 20-04-2020   14:34:20



110 111

படம் 7.8 எல்லைகளை மாற்ற உதவும் Table Format உரையாடல் பெட்டி

எல்லைகளின் பண்புகள்

	பட ம் 7.9 ல் உள்ளது ப�ோல எல்லைகளில் உள்ள க�ோடுகளை மாற்றியமைக்க ரைட்டர் ஐந்து 

வகையான க�ோடு ஏற்றமைப்பு உள்ளது. இவற்றைப் பயன்படுத்தி பயனருக்கு தேவைக்கேற்ப இவற்றை 

மாற்றியமைக்கலாம்.

படம் 7.9 க�ோட்டின் ஏற்றமைப்பு (Line Arrangement)

•	 Line விருப்பம் எல்லையின் பாணியைக் குறிக்கும்.

•	 Color விருப்பம் எல்லைக் க�ோட்டின் நிறத்தைத் தேர்வு செய்ய உதவும்.

•	 Spacing to Content  என்ற விருப்பம் எல்லைக்கும் சிற்றரை உள்ளடக்கத்திற்கும் இடையே உள்ள 

இடைவெளியைக் குறிக்கும்.
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7.2.4 அட்டவணைக்கான தானியங்கு 

வடிவூட்டம்

	 Auto format  விருப்பம்  

வரையறுக்கப்பட்ட பாணிகளில் உதவியுடன் 

அட்டவணையில் வடிவூட்டம் செய்ய முடியும். 

இதில் Autoformat அட்டவணைக்கு எளிய 

முறையில் வடிவூட்ட உதவும். இதை செய்ய :

•	 Table  Autoformat என்ற கட்டளையைத் 

தேர்வு செய்ய வேண்டும். உரையாடல் பெட்டி 

வரையறுக்கப்பட்ட பாணிகள்  மற்றும் 

அவற்றின் பெயருடன் த�ோன்றும்.

•	 இதில் பயனருக்கு தேவையான பாணியைத் 

தேர்வு செய்து OK ப�ொத்தானை கிளிக் 

செய்யவும்.

•	 தேர்வு செய்யப்பட்ட பாணியில் அட்டவணை 

அமையும்.

படம் 7.10 Auto Format உரையாடல் பெட்டி 

7.3 அட்டவணையில் வாய்ப்பாடு  
(Formula) சேர்த்தல்

	 அட்டவணைச் செயலியைப் ப�ோன்றே, 

ரைட்டரிலிம் வாய்ப்பாடு பயன்படுத்தி 

கணக்கீடுகளை எளிதாக செய்யலாம்.

	 அட்டவணையிலுள்ள தரவிற்கு 

கணக்கீடு செய்ய கீழே க�ொடுக்கப்பட்டுள்ளது 

ப�ோன்ற தரவுகளுடன் ஒரு அட்டவணையை 

உ ரு வ ாக்  கு க .

விற்கப்பட்ட 

ப�ொருள்கள்
ஜனவரி பிப்ரவரி ம�ொத்தம்

புத்தகங்கள் 15 70
பேனாக்கள் 30 50
அளவுக�ோல் 25 25

ம�ொத்த 

ப�ொருள்கள்

எந்த சிற்றரையில் கணக்கீடு செய்ய வேண்டும�ோ 

அதில் கிளிக் செய்யவும்.

	 Table  Formula என்ற கட்டளை 

அல்லது F2 கிளிக் செய்தால், அட்டவணைச் 

செயலியில் உள்ளது ப�ோன்ற Formula உள்ளீட்டு 

பகுதியுடன் கூடிய கருவிப்பட்டை த�ோன்றும். 

படம் 7.11 Formula கருவிப்பட்டை

•	 சிற்றரை B2விலிருந்து B4 வரை 

ஒரு குழுவாக தேர்வு செய்ய, தற்போதைய 

சிற்றரையில் =<B2:B4> என்று தட்டச்சு 

செய்து Enter சாவியை அழுத்தவும். கீழே 

காட்டப்பட்டுள்ள எடுத்துக்காட்டில் உள்ள ம�ொத்த 

எண்ணிக்கை உடைய அட்டவணை த�ோன்றும்.

குறிப்பு

கூட்டு எண்ணிக்கை மட்டுமே இந்த முறையில் 

நாம் கண்டறிய முடியும்.

விற்கப்பட்ட 

ப�ொருள்கள்
ஜனவரி பிப்ரவரி ம�ொத்தம் 

புத்தகங்கள் 15 70
பேனாக்கள் 30 50
அளவுக�ோல் 25 25
ம�ொத்த

 ப�ொருள்கள்
 
=<B2:B4>

•	 படம் 7.11 –ல் Formula கருவிப்பட்டையின் 

உதவியுடன் பயனரால் வேறு பல 

எண்கணக்கீடுகளைச் செய்ய முடியும்.
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விற்கப்பட்ட 

ப�ொருள்கள்
ஜனவரி பிப்ரவரி ம�ொத்தம் 

புத்தகங்கள் 15 70 =<b2>+<c2>
பேனாக்கள் 30 50
அளவுக�ோல் 25 25
ம�ொத்த

 ப�ொருள்கள்
70

•	 கணக்கீடு செய்யப்படும் தனிப்பட்ட 

சிற்றரைகளின் பெயரை <> என்ற அடைப்பு 

குறியில் அமர்த்த வேண்டும்.

•	 அட்டவணை அமைப்பில் நெடுவரிசைகள் 
A,B, C …. என்றும் வரிசைகள் 1,2,3 …… 

என்ற எண்ணிலும் பெயரிடப்பட்டிருக்கும். 

உதாரணமாக முதல் சிற்றரை A1, B1 ……. 

ப�ோன்று பெயரிடப்பட்டிருக்கும்.

•	 மேலே  குறிப்பிட்டுள்ள எடுத்துக்காட்டில்,  

ஜனவரி மற்றும் பிப்ரவரி மாதங்களில் 

விற்கப்பட்ட புத்தங்களின் கூட்டுத்தொகை 

கணக்கீடு செய்ய =<b2>+<c2> என்ற 

வாய்ப்பாடு உபய�ோகிக்கலாம்.

•	 =<b2>-<c2> என்ற வாய்ப்பாடு 

கழித்தலுக்கான எடுத்துக்காட்டு.

•	 கூட்டல், கழித்தல், பெருக்கல் மற்றும் 

வகுத்தல் அல்லாமல் வேறுபல சிக்கலான 

கணக்கீடுகளை, படம் 7.12 உள்ள Formula 
கீழிறங்கு பட்டியைக் கிளிக் செய்து பெறலாம்.

படம் 7.12 Formula கீழிறங்கு பட்டி

பயிற்சி பட்டறை 

7.1

•	 ஓபன் ஆஃபீஸ் ரைட்டரில் ஒரு புதிய 

ஆவணத்தை திறக்கவும்.

•	 பணிக்குறி அல்லது அட்டவணை 

பட்டிப்பட்டையில் மூலம் 5 வரிசைகள் 

மற்றும் 6 நெடுவரிசைகள் க�ொண்ட 

அட்டவணையை உருவாக்கி அதில் S.No., 
Name, Maths, Physics, Chemistry and 
Total என்ற தலைப்பைச் சேர்க்கவும்.

•	 Sum  செயற்முறை க�ொண்டு மூன்று 

பாடங்களுக்கு Total கணக்கிடவும்.

•	 ஆறாவது வரிசையின் பின்,  புதிய 

வரிசையைச் சேர்த்து அதற்கான தரவைத் 

தட்டச்சு செய்யவும்.

•	 இரண்டாவது வரியை பணிக்குறி அல்லது 

கட்டளையின் மூலம் நீக்கவும்.

•	 இரண்டாவது வரியின்  முன்புறம்/பின்புறம் 

பணிக்குறி அல்லது கட்டளை மூலம் ஒரு 

வரியைச் சேர்க்கவும்.

•	 ஏதேனும் ஒரு  நெடுவரிசையைப் பணிக்குறி 

அல்லது கட்டளையின் மூலம் நீக்கவும்.

•	 ஆவணத்தைச் சேமித்து மூடவும்.

7.2

•	 பயிற்சி பட்டறை 7.1- ல் உருவாக்கப்பட்ட 

ஆவணத்தைத் திறக்கவும்.

•	 ஆவணத்தில் உள்ள அட்டவணைக்கு 

தேவையான வடிவூட்டங்கள் 

விருப்பங்களை செய்யவும்.

•	 அட்டவணையின் எல்லைகளின் 

வகைகளையும், எல்லைக் க�ோட்டின் 

தடிமனையும் மாற்றுக.

•	 அட்டவணையின் வரிசையின் 

உயரத்தையும், நெடுவரிசையின் 

அகலத்தையும் மாற்றுக.

•	 ஆவணத்தைச் சேமித்து மூடவும்.
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பயிற்சி பட்டறை 

7.3

•	 புதிதாக ஒரு ஆவணத்தை உருவாக்கவும்

•	 4 x 4 வரிசை / நெடுவரிசை க�ொண்ட 
அட்டவணையைக் கருவிப்பட்டையில் 
உள்ள பணிக்குறி அல்லது கட்டளையைக் 
க�ொண்டு உருவாக்கவும்.

•	 ஏதேனும் ஒரு அட்டவணையில், வரிசை 
/ நெடுவரிசை பணிக்குறி அல்லது 
கட்டளையைப் பயன்படுத்தி ஒன்றுக்கு 
மேற்பட்ட சிற்றரைகளாக மாற்றுக.

•	 அட்டவணையில் ஏதேனும் இரண்டு 
வரிசை / நெடுவரிசைகளை, பணிக்குறி 
அல்லது கட்டளையைப் பயன்படுத்தி ஒரே 
சிற்றரையாக இணைக்கவும்.

7.4

•	 பயிற்சி பட்டறை 7.1 -  ல் சேமித்த  
ஆவணத்தைத் திறக்கவும்.

•	 அட்டவணையின் எல்லா வடிவூட்டல் 
விருப்பங்களைச் செய்யவும். 

•	 ஏதேனும் இரண்டு வரிசை / நெடுவரிசைகளை 
சேர்த்து பின்பு நீக்குக.

•	 ஆவணத்தைச் சேமித்து மூடவும்.

7.4 படங்களைச் சேர்த்தல்

7.4.1 படங்களைச் சேர்த்தல் மற்றும் வடிவூட்டம் 

செய்தல்

	 ஓபன் ஆஃபீஸ் ரைட்டரில் படங்களைச் 
சேர்க்க மற்றும் பதிப்பிக்க மிகவும் திறன்மிக்க 
பல எளிமையான வழிகள் உள்ளது.ரைட்டரில் 
உள்ள படத்தொகுப்பு (Picture gallery)–
லிருந்து தேவையான படத்தைத் தேர்வு செய்து 
ஆவணத்தில் சேர்க்கலாம். க�ோப்பிலிருந்து 
படத்தைச் சேர்ப்பதற்கான  வழிமுறைகள்:

•	 எந்த இடத்தில் படத்தைச்  சேர்க்க வேண்டும�ோ 
அந்த இடத்திற்கு செருகும் புள்ளியைக் 
க�ொண்டு செல்லவும்.

•	 Insert  Picture From file என்ற 
கட்டளையைத் தேர்வு செய்யவும்

•	 Insert Picture உரையாடல் பெட்டி 
படத்தொகுப்புடன் (Picture gallery) த�ோன்றும் 
அதில் 		தேவை  யான படத்தைத் 
தேர்வு செய்ய வேண்டும்.

•	 தேவையான படம் படத்தொகுப்பில் 
இல்லையெனில், க�ோப்புறையில் (Folder) 
உள்ள தேவையான படத்தைத் தேர்வு செய்து 
Open ப�ொத்தானை கிளிக் செய்யவும்.

•	 தேர்வு செய்யப்பட்ட படம் ஆவணத்தில் 
சேர்க்கப்பட்டிருக்கும். 

படம் 7.13 Picture கருவிப்பட்டை
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Insert Picture உரையாடல் பெட்டி படம் 7.13ல் 

காட்டப்பட்டுள்ளது.

படங்களுக்கு வடிவூட்டம் செய்ய

சேர்க்கப்பட்ட படத்தின் வடிவூட்டத்தை மாற்ற 

ரைட்டரில் உள்ள Picture கருவிப்பட்டை 

உ த வு கி ற து .

	 படத்தின் மேல் கிளிக் செய்தால் Picture 

கருவிப்பட்டை படம் 7.14 உள்ளது ப�ோல 

த�ோன்றும். இதன் உதவியுடன் படத்தின் அளவு 

மாற்றலாம், எல்லைகளை அமைக்கலாம். 

படத்தின் உயரம் மற்றும் அகலம் பின்னணி 

ப�ோன்ற பல்வேறு வடிவூட்டல்களை படத்திற்கு 

செ  ய ்யலா   ம் .

படம் 7.14 Picture கருவிப்பட்டை

•	 படத்தின் நான்கு மூலைகளைக்  கிளிக் 

செய்து இழுத்தால் அதன் அளவை 

பெரிதாக்க மற்றும் சிறிதாக்க முடியும்.

•	 Crop விருப்பத்தைத் தேர்வு செய்தால் 

Cropping கைப்பிடிகள் த�ோன்றும். இவற்றை 

கிளிக் செய்து இழுத்தால் படத்தை வேண்டிய 

அளவிற்கு வெட்டலாம்.

•	 Crop கட்டளையைக் கிளிக் செய்தால் Crop 
கருவி தேர்வு நீக்கப்பட்டுவிடும்.

•	 Default கீழிறங்கு பெட்டியில் அம்புகுறியைக் 

கிளிக் செய்தால் Black and White, Grey 
Scale  அல்லது Water Mark ( Background) 

ப�ோன்ற விருப்பங்கள் த�ோன்றும், இதில் 

Default விருப்பம் அசல் படத்தைக் காட்டும்.

•	 Flip Horizontally பணிக்குறி  தேர்வு 

செய்தால் படம் கிடைக்கை திசையில் 

பு ர ட ்ட ப்பட்   டி ரு க் கு ம் .

•	 Flip Vertically பணிக்குறி  தேர்வு 

செய்தால் படம் நெடுக்கை திசையில்  

பு ர ட ்ட ப்பட்   டி ரு க் கு ம் .

•	 Transparency பணிக்குறி  

உதவியுடன் படத்தின் த�ோற்ற தெளிவைச் 

சதவீதத்தில்(%)  மாற்றலாம்.

7.4.2 சிறப்பு எழுத்துக்கள் மற்றும் 

சமன்பாடுகளைச் சேர்க்க	

	 கணித சமன்பாடுகளில் உள்ள 

alpha(α), beta (β), pi (π) ப�ோன்ற பல சிறப்பு 

எழுத்துக்கள் பயன்படுத்தப்படுகிறது. ஆனால் 

இந்த சிறப்பு எழுத்துக்கள் வழக்கத்தில் உள்ள 

விசைப்பலகையில் இடம் பெறவில்லை. கணித 

சமன்பாடுகளில் இந்த சிறப்பு எழுத்துக்கள் 

இன்றியமையாததாகும். இது ப�ோன்ற சிறப்பு 

எழுத்துக்களைச் சேர்ப்பதற்கான வழிமுறைகள்:

படம் 7.15 Special Character உரையாடல் பெட்டி
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•	 ஆவணத்தில் எந்த இடத்தில் சிறப்பு 

எழுத்துக்கள் த�ோன்ற வேண்டும�ோ அந்த 

இடத்திற்கு செருகும் புள்ளியைக் க�ொண்டு 

செல்ல    வு ம் .

•	 Insert  Special Character என்ற 

கட்டளையைத் தேர்வு செய்தால், Special 
Character உரையாடல் பெட்டி படம் 7.15 ல் 

உள்ளது ப�ோல் த�ோன்றும்.

•	 Special Character உரையாடல் 

பெட்டியிலிருந்து தேவையான சிறப்பு 

எழுத்தின் மீது கிளிக் செய்ய வேண்டும். 

•	 தேவையான சிறப்பு எழுத்து கண்டறிய 

முடியவில்லை எனில் வேறு எழுத்துரு 

வகையை தேர்ந்தெடுத்து அந்த சிறப்பு 

எழுத்தைப் பெறலாம்.

•	 OK ப�ொத்தானை கிளிக் செய்தால் அந்த 

சிறப்பு எழுத்து தற்போதைய இடத்தில் 

ச ே ர ்க்கப்பட்     டு வி டு ம்

பல்வேறு குறியீடுகளின் உதவியுடன் ஓபன் 

ஆஃபீஸ் ரைட்டரில் கணித சமன்பாடுகளைச் 

சேர்க்கலாம். இவ்வகை சமன்பாடுகளைச் 

சேர்க்க பின்வரும் வழிமுறைகளை பின்பற்றுக.

•	 Insert  Object  Formula என்ற 

கட்டளையைத் தேர்வு செய்ய வேண்டும்.

•	 திரையின் கீழ் பகுதியில் Equation Editor–

ல் வலது கிளிக் செய்தால் ஒரு மேல் மீட்பு 

பட்டி த�ோன்றும். இதில் குறியீட்டைத் தேர்வு 

செய்ய வேண்டும்.

•	 சூத்திரத்தின் மீது  இருமுறை கிளிக் 

செய்தால், சமன்பாட்டை பதிப்பிக்கலாம்.

7.4.3 வடிவங்களைச் சேர்த்தல் மற்றும் 

ப தி ப் பி த்த  ல் 

	 ஓபன் ஆஃபீஸ் ரைட்டரில் உள்ள வரையும் 

கருவிப்பட்டையின் (Drawing toolbar) மூலம் 

பல்வேறு வடிவங்களை உருவாக்க முடியும்.

View  Toolbars  Drawing என்ற 

கட்டளையைக் கிளிக் செய்தால் வரையும் 

கருவிப் பட்டை (Drawing Toolbar) படம் 
7.16ல் உள்ளது ப�ோல் த�ோன்றும்.

வரையும் கருவியை (Drawing Tool) 
பயன்படுத்துவதற்கான வழிகள்:

•	 ஆவணத்தில் எந்த இடத்தில் வரைய 

வேண்டும�ோ அந்த இடத்தில் கிளிக் 

செ  ய ்ய வு ம் . 

•	 வரையும் கருவிப்பட்டையிலிருந்து 

தேவையான கருவியைத் தேர்வு செய்யவும். 

•	 சுட்டியின் வடிவம் Cross hair Pointer - ஆக 

மாறும். குறுக்கு வடிவில் உள்ள சுட்டியை 

ஆவணத்தில் எந்த இடத்தில் வரைபடம் 

த�ோன்ற வேண்டும�ோ அங்கு கிளிக் 

செய்து க�ொண்டே இழுத்து வரைபடத்தை 

உருவாக்கலாம். சுட்டியை அழுத்துவதை 

விட்டுவிட்டால், வரைதலுக்கான தேர்வு 

செயலில் இருக்கும், இதனால் பயனர் 

தேவைப்பட்டால் வேறு வடிவங்களை 

வ ர ை ய லா  ம் .

•	 தேர்வு செய்யப்பட்ட வரைபட செயல்பாட்டை 

ரத்து செய்ய ESC  சாவியை அழுத்தவும் 

அல்லது Drawing கருவிப்பட்டையில் உள்ள 
Select பணிக்குறியைப் பயன்படுத்தலாம்.

படம் 7.16 வரையும் கருவிப்பட்டை (Drawing Toolbar)
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•	 வரைபடத்தின் பண்புகளை (Full color, Line 
Type) ப�ோன்ற மாற்றுவதற்கு Drawing 
Object properties கருவிப்பட்டை அல்லது 

உரையாடல் பெட்டியிலுள்ள விருப்பங்களை 

தேர்வு செய்யலாம்.

•	 T பணிக்குறியைப் பயன்படுத்தி 

உரைபெட்டியை உருவாக்கலாம், இதில் 

பயனருக்கு தேவையான உரையைத் தட்டச்சு 

செய்து அதை ஆவணத்தின் எந்த பகுதியிலும் 

நகர்த்தி வைக்கலாம்.

7.4.4 பக்க முறிவு புகுத்த(Page break)

	த ட்டச்சு செய்யும் ப�ோது, உள்ளடக்கம் ஒரு 

பக்கத்தின் அளவிற்கு மிகுதியாக இருப்பின், ஓபன் 

ஆஃபீஸ் ரைட்டர் தானாகவே புதிய பக்கத்தை 

அமைக்கும். இது மென் பக்க முறிவு  (Soft Page 
Break) என்று அழைக்கப்படும். சில நேரங்களில் 

பயனர் கைமுறையாக பக்க முறிவை நுழைக்க 

வேண்டும் என்றால். இது கடின பக்கமுறிவு என்று 

அழைக்கப்படும்.

1.	 ஆவணத்தி்ல்  எங்கு,  பக்க முறிவு வேண்டும�ோ 

அங்கு செருகும் புள்ளியை அமர்த்தவும்.

2.	 Insert  Manual Break என்ற 

கட்டளையைத் தேர்வு செய்ய வேண்டும். கீழே 

காட்டப்பட்டுள்ளது ப�ோன்ற Insert Break 

உரையாடல் பெட்டி த�ோன்றும்.

படம் 7.17 Insert Break உரையாடல் பெட்டி

3.	 Type விருப்பத்தில் உள்ள Page Break தேர்வு 

செய்து OK ப�ொத்தானை கிளிக்  செய்யவும்.

4.	 தற்போதைய பக்கத்திற்கு பக்க முறிவு 

ச ே ர ்க்கப்ப    டு ம் .

7.4.5 வார்த்தை கலை (Word Art) சேர்க்க

	 Word Art (வார்த்தை கலை) என்பது 
OpenOffice writer யில் உள்ள உரை மாற்றப்படும் 
அம்சமாகும். ஒரு வார்த்தைக்கு அல்லது 
ச�ொற்றொடருக்கு நிழல்கள், வரைபடங்கள், 
வண்ணங்கள், சாய்வு 3D விளைவுகள் ப�ோன்ற 
தாக்கங்கள் (effects) இதன் மூலம் பெறலாம். 
Word Art-ல் உள்ள சிறப்பு தாக்கங்கள் மூலம் 
உரையை மேலும் படிப்பதற்கு எளிமையாகவும் 
மற்றும் தூண்டுவதாகவும் அமைக்க முடியும். 

Word Art செருக (insert) பின்வரும் வழிகள் 
உதவும். 

•	 Drawing கருவிப்பட்டியில் Font work 
பணிக்குறியைக் கிளிக் செய்யவும். 

•	 Font Work Gallery சன்னல் திரையின் 
பல்வேறு வடிவிலான எழுத்துருக்களுடன் 
கூடிய எழுத்து வகைகள் த�ோன்றும்.

•	 தேவையான Font Work பாணி மீது இருமுறை 
கிளிக் செய்து, நமக்கு தேவையான வார்த்தை 
அல்லது ச�ொற்தொடரைத் தட்டச்சு செய்யவும்.

படம் 7.18 WordArt உரையாடல் பெட்டி

7.4.6 Auto text -ஐ சேர்த்தல்

	 Auto text - ல் சாவி அல்லது 

சாவி சேர்மானத்தைப் பயன்படுத்தி உரை, 

அட்டவணை, வரைபடம் ப�ோன்றவற்றை 

உருவாக்கலாம்.உதாரணமாக, “Tamil Nadu” 
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என்ற வார்த்தையை ஒவ்வொரு முறையும் 

தட்டச்சு செய்வதற்கு பதிலாக, “tn” மற்றும் F3 
அழுத்தினால் “Tamilnadu”  என்று திரையில் 

த�ோன்    று ம் .

ஏதேனும் ஒரு உரைக்கு Auto text மூலம் 

குறுக்குவழி அமைத்தலுக்கான வழிகள்:

1.	 உரையை ஆவணத்தில் தட்டச்சு செய்யவும்.

2.	 தேர்வு செய்த உரை உயர்த்திக் காட்டப்படும்.

3.	 Edit  Auto text என்ற கட்டளை அல்லது 
Ctrl+F3 கிளிக் செய்யவும்.

4.	 Name உரைப் பெட்டியில் உரைக்கான 
குறுக்கு எழுத்தை தட்டச்சு செய்யவும். Writer 
தானாகவே ஒரு எழுத்து க�ொண்ட குறுக்கு 
எழுத்தை Shortcut பெட்டியில் காட்டும்.

5.	 உரையாடல் பெட்டியில் வலது புறத்தில் உள்ள 
Auto text ப�ொத்தானை கிளிக் செய்து அதில் 
த�ோன்றும் பட்டியிலிருந்து New (Text only) 
என்பதைத் தேர்ந்தெடுக்கவும்.

6.	 இறுதியாக Close ப�ொத்தானை கிளிக் 
செய்தால் ஆவணத்திற்கு திரும்பிவிடும்.

7.	 குறுக்கெழுத்தை உருவாக்கியவுடன், 
ஆவணத்தை எந்த இடத்தில் Auto text 
உரை த�ோன்ற வேண்டும�ோ அந்த இடத்தில் 
செருகும் புள்ளியைக் க�ொண்டு சென்று 
Ctrl+F3 அழுத்தவும். பட்டியிலுள்ள பெயரைத் 
தேர்ந்தெடுத்து Insert ப�ொத்தானை கிளிக் 
செய்யவும் அல்லது குறுக்கெழுத்தை தட்டச்சு 
செய்தபின் F3 –யை அழுத்தவும். 

8.	 Auto text உரையானது செருகப்பட்டுவிடும்.

குறிப்பு 

Auto text ப�ொத்தானை அழுத்தும்போது Import என்ற விருப்பம் மட்டும் திரையில் 

த�ோன்றினால் Auto text –ற்கு பெயர் க�ொடுக்கவில்லை அல்லது உரையைத் தேர்வு 

செய்யவில்லை என்பதை உணர்த்தும். 

படம் 7.19 Auto text உரையாடல் பெட்டி

7.5 அச்சிடப்படும் முன் ஆவணத்தை பார்வையிடல், அச்சுப்பொறியின் அமைப்பை மாற்றியமைக்க, 

ஆவணத்தை அச்சிடல்.

7.5.1  அச்சிடப்படும் ஆவணத்தை முன்கூட்டியே பார்க்க

	 அச்சிடப்படும் முன் ஆவணத்தை பார்வையிடுதல் நல்ல வழக்கமாகும். ஆவணத்தை அச்சிடும் 

முன் பார்வையிடும் வழிமுறைகள்:
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1.	 File  Page Preview அல்லது Page Preview ப�ொத்தானை கிளிக் செய்யவும். ரைட்டர் தற்போதைய 

பக்கத்தைத் திரையில் காட்டும்.

படம் 7.20 Page Preview கருவிப்பட்டை

2.	 Page Preview கருவிப்பட்டையில் படம் 7.20 உள்ள Multiple Pages பணிக்குறியைக் கிளிக் செய்து 

எத்தனை பக்கங்கள் த�ோன்ற வேண்டும் என்பதைத் தீர்மானிக்கலாம்.

3.	 lose Preview ப�ொத்தானைக் கிளிக் செய்தால் இத்திரை மூடப்படும்.

7.5.2	  அச்சுப்பொறியின் அமைப்பை மாற்றுதல் (Setting the Printer ) மற்றும் அச்சிடல்

அச்சுப்பொறியின் அமைப்பை மாற்றுவதற்கான வழிமுறைகள் பின்வருமாறு:

1.	 File->Print (அ) Ctrl + P (அ) Print File பணிக்குறி கிளிக் செய்தல் Print உரையாடல் பெட்டி படம் 

7.21  காட்டியுள்ளவாறு த�ோன்றும்.

படம் 7.21 Print உரையாடல்பெட்டி

2.	 General த�ொகுதியைக் கிளிக் செய்யவும்.

3.	 பல்வேறு அச்சுப்பொறிகளின் த�ொகுப்பு பட்டியலிருந்து தேவையான அச்சுப்பொறியைக் கிளிக் 

செய்யவும்.

4.	 Range and Copies பகுதியில் த�ோன்றும்  All Pages விருப்பத்தைத் தேர்வு செய்தால் எல்லா 

பக்கங்களும் அச்சிடப்படும், Pages விருப்பத்தைத் தேர்வு செய்தால் தேவையான ஒரு பக்கம் அல்லது 

பக்கங்கள் மட்டும் அச்சிடப்படும்.

5.	 Number of Copies சுழல் பெட்டியில் பக்கத்தை எத்தனை நகல் எடுக்க வேண்டும் என்பதைக் 

குறிப்பிடலாம் 

6.	 Print  ப�ொத்தானை கிளிக் செய்யும்.
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பயிற்சி பட்டறை 

•	 பயிற்சி பட்டறை 7.1- ல் க�ொடுக்கப்பட்ட 

ஆவணத்தை திறக்கவும்.

•	 Dr.A.P.J. அப்துல்கலாம் பற்றிய படங்களை 

இணையத்தில் பதிவிறக்கம் செய்து அவற்றை 

தேவையான இடத்தில் ஆவணத்தில் 

படத்தை சேர்ப்பதற்கான கட்டளை அல்லது 

பணிக்குறியைப் பயன்படுத்தி சேர்க்கவும்.

•	 பயிற்சி பட்டறை 7.2 - ல் உள்ள ஆவணத்தைத் 

திறக்கவும்.

•	 Auto Text யை உருவாக்குவதற்கான 

கட்டளையை விசைப்பலகை  பயன்படுத்தி, 

“VIRUS” என தட்டச்சு செய்தால் “VITAL 
INFORMATION UNDER SEIGE” என 

தானாக த�ோன்றச் செய்யவும்.

•	 ஆவணத்தை அச்சிடுவதற்கான கட்டளை 

பணிக்குறியைப் பயன்படுத்தி அச்சிடுவதற்கு 

தேவையான பண்புகளை மாற்றி Preview 

பார்த்து ஆவணத்தை அச்சிடு.

•	 பயிற்சி பட்டறை 7.3 - ல் க�ொடுக்கப்பட்டுள்ள 

ஆவணத்தைத் திறந்து அதற்குரிய 

படத்தை இணையத்தில் பதிவிறக்கம் செய்து 

தேவையான இடத்தில் சேர்க்கவும்.

•	 ஆவணத்தைச் சேமித்து மூடவும்.

•	 பயிற்சி பட்டறை  7.4 - ல் உருவாக்கப்பட்ட 

ஆவணத்தை திறக்கவும்.

•	 வட்டத்தின் சுற்றளவுக்கான வாய்ப்பாட்டினை, 

சிறப்புக் குறியீடுகளைக் க�ொண்டு தட்டச்சு 

செய்க. 

•	 ஆவணத்தில் வரைவதற்கான பணிக்குறி 

அல்லது கட்டளையைப் பயன்படுத்தி 

கீழ்க்கண்ட படத்தை வரைக. ஆவணத்தை 

அச்சிடுவதற்கான கட்டளையைப் 

பயன்படுத்தி ஆவணத்தை அச்சிடுக.

7.5

•	 புதியதாக ஒரு ஆவணத்தைத் திறக்கவும்.

•	 அதில் (i) Aα+ Bπ +Cβ (ii) πr2h என்ற 

சமன்பாடுகளை, சிறப்புக் குறியீடுகள் 

உருவாக்குவதற்கான கட்டளையைப் 

பயன்படுத்தி தட்டச்சு செய்யவும்.

•	 வரையும் கருவிப்பட்டையைப் பயன்படுத்தி 

பல்வேறு வடிவங்களை ஆவணத்தில் 

சேர்த்து சேமித்து மூடவும்.

Impress

Calc

Writer
Database
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செயல்பாடு 

மாணவர் செயல்பாடுகள்

1.	 வாய்ப்பாட்டைப் பயன்படுத்தி கணக்கீட்டின் கருத்தை அடிப்படையாக் க�ொண்டு, மாணவர்கள் 

அட்டவணையில்  மதிப்பெண்கள் தாளை தட்டச்சு செய்து ம�ொத்த மதிப்பெண்ணையும் மற்றும் 

சராசரி மதிப்பெண்ணையும் ரைட்டரில் காண்க.

2.	 பள்ளியின் ஆண்டு விழாவின் அழைப்பிதழையும் அதில் பள்ளியின் பெயரை “வாட்டர் மார்க்கில்” 

இணைக்க மாணவர்களைத் தயார் படுத்தவும்.

3.	 வகுப்பின் கால அட்டவணையைத் தயாரித்து அதை கவர்ச்சியாக இருப்பதற்கு தேவையான 

வடிவூட்டல் க�ொடுக்க மாணவர்களைத் தயார் படுத்தவும்.

ஆசிரியர் செயல்பாடுகள்

1.	 ஆசிரியர் வாய்ப்பாடுகள் மற்றும் சிறப்பு எழுத்துக்கள் மற்றும் ‘ஓரங்களை மாற்றி ஒரு வினாத்தாளை 

தயார் செய்து அச்சிடுவதற்கு,  ஒரு செய்முறையை செய்து காட்டவும்.

2.	 ஒரு ஆவணத்தில் படத்தை இணைத்து மாற்றம் செய்து, வண்ணம் இட்டு, பின்னணி வண்ணத்தை 

மாற்றி படத்தை மிகவும் கவர்ச்சிகரமாக தயாரிக்க ஒரு செய்முறை செய்து காட்டவும்.

மதிப்பாய்வு

பகுதி I 

சரியான விடையை தேர்வு செய்க

1.	 ”Table Format” உரையாடல் பெட்டியை பயன்படுத்தி ஒரு நெடுவரிசையின் அகலத்தை எவ்வாறு 

க�ொடுக்கலாம்?

	 அ) File  Table properties		  ஆ) Format  Table properties 

	 இ) Table  Table properties		  ஈ) Table  Table format.

2.	 எந்த விருப்பத்தைத் தேர்வு செய்து உரை, அட்டவணை, வரைகலை மற்றும் மற்ற ப�ொருளை ஒரு 

ப�ொத்தானுக்கு அல்லது ப�ொத்தான்களுக்கு க�ொடுக்க முடியும். 	

	 அ) Auto format				    ஆ) Automatic

	 இ) Auto text				    ஈ)  Auto graphics

3.	 Insert பட்டிப்பட்டையிலுள்ள எந்த கட்டளை ஆவணத்தில் பக்க முறிவு சேர்க்க உதவும்?

	 அ) Manual Break				    ஆ) Hard Page Break 

	 இ) Section Break				    ஈ) Page Break
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4. Insert table உரையாடல் பெட்டி திறப்பதற்கான குறுக்கு வழி சாவி சேர்மானம் எது?

	 அ) Ctrl + F5		  ஆ) Ctrl + F8

	 இ) Ctrl + F10		  ஈ) Ctrl + F12

5.	 Drawing கருவிப்பட்டையிலுள்ள எந்த பணிக்குறி உரைப்பெட்டியை பெறும்?		

	 அ) Text பணிக்குறி	 	 ஆ) Text Box பணிக்குறி 

	 இ) Draw  பணிக்குறி		   ஈ) Draw Box பணிக்குறி

பகுதி –II குறுவினாக்கள்

1.	 ஆவணத்தில் ஒரு படத்தை எவ்வாறு சேர்ப்பாய்?

2.	 ஆவணத்தில் சிறப்பு எழுத்துக்களைச் சேர்ப்பதற்கான வழிமுறைகளை எழுதுக.

3.	 ஒரு அட்டவணையில் எவ்வாறு ஒரு சிற்றறையை பல சிற்றறைகளாக பிரிப்பாய் மற்றும் பல 		

	 சிற்றறைகளை எவ்வாறு ஒன்றாக சேர்ப்பாய்?

4.	ர ைட்டரில்  Word Art-யின் பயன் என்ன?

பகுதி – III

1.	 வரைவி கருவிப்பட்டி பற்றி குறிப்பு வரைக.

2.	 எவ்வாறு ஒரு வரிசை மற்றும் நெடுவரிசையை சேர்ப்பாய்?

3.	 பின்னணியிலுள்ள ஒரு படத்தின் தெளிவை எவ்வாறு மாற்றுவாய்?

பகுதி – IV

1. 	 ஒரு வார்த்தைக்கு “Autotext” எவ்வாறு உருவாக்குவாய்?

2. 	 அட்டவணையின் அளவை எப்படி மாற்றுவாய்?

3. 	 படங்களுக்கு எவ்வாறு வடிவூட்டம் செய்வாய்?

4. 	 ஒரு ஆவணத்தை அச்சிடப்படுவதற்கு முன் எவ்வாறு முன்னோட்டம் செய்வாய் என்றும் ஆவணத்தை     

        எவ்வாறு அச்சிடுவாய்.

5. 	 அட்டவணையில் உள்ள தரவுகளின் கூட்டுத்தொகையை வாய்ப்பாடு மூலம் எவ்வாறு செய்வது 	

		 என்பதை பற்றி வழிகளை எழுதுக.
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8.1 மெயில் மெர்ஜ் :

		  ஒரு ச�ொற்செயலாக்கத்தின் 

முக்கிய பணி ஒரு ஆவணத்தை உருவாக்கி பல 

அஞ்சல் முகவரிகள் க�ொண்ட பல பயனருக்கு 

அனுப்புவதாகும். இந்த வசதியை க�ொண்ட 

ச�ொற்செயலி பயனர் முகவரி தரவை சேமித்து 

மற்றும் அதை ஆவணத்தில் ஒன்றிணைத்து 

தேவையான வடிவமைப்பில் அச்சிடுகிறது. 

	ச �ொற்செயலியின் முக்கிய அம்சம் மெயில் 

மெர்ஜ் ஆகும். இதன் மூலம் பெயர்கள் மற்றும் 

முகவரிகளின்  பட்டியலை ஒரு கடிதத்துடன் 

ஒன்றிணைத்து, வெவ்வேறு பெயர்களுக்கு 

மற்றும் முகவரிக்கு அனுப்பலாம்.

	 ஒரு ஆவணத்தின் பல நகல்களை 

பல்வேறு பெறுநர்களின் பட்டியலில் (கடிதங்கள்) 

பின்வரும் வசதிகளால் அனுப்பப்படும்.

1.	 மெயிலிங் (Mailing)

2.	லே பில்ஸ் (Labels)

3.	 என்வலப்ஸ் (Envelopes)

	 இந்த வசதிகள் அனைத்தும், ஒரு பதிவு 

செய்யப்பட்ட "மூல தரவுடன்" (data source) 
த�ொடர்பானவை.  மாறிகள், மூல தரவின் பல்வேறு 

புலம்களை (Fields) குறிக்கின்றன.

மெயில் மெர்ஜ்க்காக மூல தரவினை 

உருவாக்குதல் 

	 ஒரு மூல தரவு என்பது பெயர் மற்றும் 

முகவரியை உள்ளடக்கிய தரவுதளம் அல்லது 

மற்ற தகவல்களை க�ொண்ட பதிவுகளின் மூலம் 

அஞ்சல் பட்டியலை பெறலாம். 

	 மெயில்கள், லேபிள்கள் மற்றும் 

எண்வலப்ஸ் ஆகியவைகளை அச்சிட மூல  தரவு 

வசதிகள் தேவையில்லை.

மெயில் மெர்ஜ் மற்றும் கூடுதல் கருவிகள் 
(Mail Merge and Additional Tools)

பாடம் 8அலகு II ச�ொற்செயலி

படம் 8.1 மெயில் மெர்ஜ் வழிக்காட்டி- Select starting document
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	 ஓப்பன் ஆஃபீஸ் மெயில் மெர்ஜ் ன் மூலம் 

அட்டவணைத்தாள் (Spreadsheet), உரை 

ஆவணங்கள் (text files), தரவுத்  தளங்களாகிய 
MySQL, Adabas  மற்றும் ODBC என பல்வேறு 

மூல தரவுகளை  அணுக முடியும். 

	 பின்வரும் எடுத்துக்காட்டில் Title, First 
Name, Last Name, Address, State / Country, 
Country, Postcode, Gender மற்றும் Points என 

நெடுவரிசையின் தலைப்புகளை (புலம்) க�ொண்ட 

ஒரு  அட்டவணைத்தாள்  பயன்படுத்தப்படுகிறது.  

	 மெயில் மெர்ஜ் வழிகாட்டி (wizard) படம் 

8.1 இல் காட்டப்பட்டுள்ளது. பின்வரும் 

வழிமுறைகள்  மெயில் மெர்ஜ் செயல்களை 

செய்கிறது

Tools  Mail Merge Wizard

படிநிலை – 1 படம் 8.1 காட்டியுள்ள  உரையாடல் 

பெட்டியில் Select Starting document – டை தேர்வு 

செய்யவும். (இதில் ஐந்து  விருப்ப தேர்வுகள் உள்ளன.) 

•	 Use the current document

•	 Create a new document

•	 Start from existing document

•	 Start from a template

•	 Start  from a recently saved documnet 

Create a new document- டை தேர்வுசெய்து 

Next ப�ொத்தானை கிளிக் செய்யவும்.

படிநிலை – 2 படம் 8.2-ல் காட்டியுள்ளவாறு  

உரையாடல் பெட்டி த�ோன்றும். இதில் 

இரண்டு விருப்பங்கள் உள்ளது. 

•	 Letter

•	 E-mail Message

	பெ றுநர்களின் குழுக்களுக்கு 

கடிதங்களை அனுப்ப  Letter என்ற விருப்பத்தை 

தேர்வு செய்து Next ப�ொத்தான கிளிக்செய்யவும்

படம் – 8.2 மெயில் மெர்ஜ் வழிகாட்டி உரையாடல் பெட்டி
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படிநிலை – 3 Insert Address block-கை கிளிக் 

செய்யவும். இந்த படிநிலை ஆவணத்தில் 

இணைக்கபட வேண்டிய முகவரி பட்டியலை 

தேர்வு செய்ய உதவுகிறது. (பார்க்க படம் 8.3)

	 இந்த படிநிலை நான்கு பிரிவுகளை 

க�ொண்டுள்ளது.

	 ஏற்கனவே உள்ள க�ோப்பிலிருந்து முகவரி 

பட்டியலை தேர்ந்தெடுக்க அல்லது புதிய முகவரி 

க�ோப்பை உருவாக்க “Select  Address list” 

என்ற ப�ொத்தானை கிளிக் செய்யவும்.

	 ஏற்கனவே உள்ள மூல தரவை சேர்க்க 

“Add” ப�ொத்தானை கிளிக் செய்யவும்(.படம் 8.4 
ல்  காண்பித்தவாறு)

மூல தரவை உருவாக்க “Create”-டை கிளிக் 

செய்யவும்.

	 இந்த சாளரம் (Window) முகவரிக்கான 

க�ொடாநிலை புலங்களை படம் 8.4 ல்  உள்ளவாறு  
காண்பிக்கும்.

	 புலங்களை சேர்க்க அல்லது நீக்க 

அல்லது பெயரை மாற்ற “Customize” – ஐ கிளிக் 

செய்யவும்.

குறிப்பு

பயனர் முகவரி பட்டியலை 

உருவாக்கும் ப�ோது குறைந்த 

பட்சம் மூன்று புலங்களை தேர்வு 

செய்யவேண்டும்.

படம் – 8.3 முகவரிப்  பட்டியலை சேர்க்க

படம் – 8.4 Add தேர்வு செய்தல்
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படம் – 8.5 புதிய முகவரி பட்டியல் (New Address List)

படம் – 8.6 ஒருங்கிணைப்பு முகவரி பட்டியல் (Customize Address List)

	 முகவரி பட்டியலுக்காக தேவையான புலங்களை தேர்வு செய்தபின் OK ப�ொத்தானை கிளிக் 

செய்யவும். 

	 இது முந்தைய சாளரத்திற்குத் திரும்பும், அங்கு பயனர் பதிவுகளைச் சேர்க்க முடியும்
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படம் – 8.7 நிரப்பப்பட்ட முகவரி பட்டியல்

	 மேலும் பதிவுகளைச் சேர்க்க “New” ப�ொத்தானை கிளிக் செய்யவும்.

	 பயனர் ஒரு பதிவை நீக்க, வேண்டிய பதிவை தேர்வு செய்து “Delete” ப�ொத்தானை கிளிக் 

செய்யவும். பதிவுகளை சேமிக்க “Save As” உரையாடல் பெட்டி த�ோன்றும்.

	 இது "select address list" என்ற உரையாடல் பெட்டிக்கு திரும்பும். “OK”  ப�ொத்தானை கிளிக் 

செய்யவும்.

படம் – 8.8 புதிய முகவரி பட்டியல்
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	 மெயில் மெர்ஜ் முதன்மை சாளரம் த�ோன்றும் அதில் Next ப�ொத்தானை கிளிக் செய்யவும்.

படம் – 8.9 வாழ்த்துக்களை தெரிவிக்கும் Mail Merge  வழிகாட்டி

படிநிலை – 4	க டிதத்தில் ப�ொதுவான வாழ்த்துக்களைச் சேர்ப்பதற்கு இது ஒரு விருப்ப சாளரமாகும்.    	

	                (பார்க்க படம் 8.9)

படிநிலை – 5	 Next ப�ொத்தானை கிளிக் செய்தவுடன் “Adjust Layout” சாளரம் த�ோன்றும்.                             	

                             (பார்க்க படம் 8.10)

படம் – 8.10 அமைப்பை சரிசெய்யும் பட்டி
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	 இது முகவரி லேபில் மற்றும் ப�ொதுவான வாழ்த்துக்களை மாற்றுவதற்கு உதவுகிறது. 

	 Next ப�ொத்தானை கிளிக் செய்யவும்.

படிநிலை – 6 கடிதத்தின் உள்ளடகத்தில் சேர்க்க அல்லது மாற்ற “Edit Document” உதவுகிறது.

	 “Edit Document”-டை கிளிக் செய்யும் ப�ோது மெயில் மெர்ஜ் வழிகாட்டி சாளரம் சுருங்கி பயனர் 

ஆவணத்தின் உள்ளடக்கத்தை மாற்றுவதற்கு கட்டுப்பாடு வழி செய்கிறது.

படம் – 8.11ஆவணத்தின் முன்னோட்டம் மற்றும் பதிப்பித்தல்

	 ஆவணத்தை பதிப்பாய்வு செய்தபிறகு, மேல்மீட்பு பட்டியில் (popup menu) “Return to mail 
merge wizard” –ஐ கிளிக் செய்தவுடன் திரும்பவும் “Mail merge wizard” சாளரத்திற்கு திரும்பி செல்லும். 

Next ப�ொத்தானை கிளிக் செய்யவும்.

படம் – 8.12 சிறிதாக்கப்பட்ட  Mail Merge
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படிநிலை – 7 “Personalize Document” சாளரம் த�ோன்றும். இது தேர்வு செய்யப்பட்ட பதிவுகளுக்கு 

குறிப்புகளை சேர்க்க உதவுகிறது. Next ப�ொத்தானை கிளிக் செய்யவும்.

படம் – 8.13  Mail Merge ஆவணத்தின் தனிப்பயனாக்கம்

படிநிலை – 8 “Save, Print or Send” சாளரத்தில் உருவாக்கிய ஆவணத்திற்கு ப�ொருத்தமான பெயரை 

க�ொடுத்து ஆவணத்தை சேமிக்கலாம்.

இந்த படிவத்தை பயன்படுத்தி மின்னஞ்சலாக இணைக்கப்பட்ட ஆவணத்தை சேமிக்கவும், ஒன்றாக்கவும், 

அச்சிடவும், அனுப்பவும் முடியும். 

படம் – 8.14 ஆவணத்தை சேமிக்க, அச்சிட, அனுப்ப , பயன்படும் வழிகாட்டி
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 “Finish” ப�ொத்தானை கிளிக் செய்தால் திரையில் மெயில் மெர்ஜ் ஆவணத்தை பார்க்க முடியும்.

8.2 கூடுதல் கருவிகள்(Additional Tools)

8.2.1 பிழை சரிபார்ப்பு

	 ஒரு ச�ொற்செயலி மென்பொருளை பயன்படுத்தி உருவாக்கப்பட்ட ஆவணத்தில் எழுத்து பிழைகள் 

இருக்க கூடாது. எழுத்து பிழையை சரிசெய்வதற்க்காக ஓபன் ஆபீஸ் – ரைட்டரில் ஒரு அகராதியும் 

மற்றும் எழுத்து பிழை சரிப்பார்ப்பு நிரலும் உள்ளது. ஓபன் ஆபீஸ் ரைட்டர் ஆவணத்தை தட்டச்சு செய்யும் 

ப�ொழுதே தவறான ச�ொல்லை கண்டுபிடித்து மாற்றும் அல்லது உரை  ஆவணம் முழுவதும் தட்டச்சு 

செய்த பின்பும் எழுத்து பிழையை சரி செய்து க�ொள்ளலாம்.

8.2.2 தானியங்கி எழுத்துப் பிழை சரிபார்ப்பு

	 Auto Spell check விருப்பமானது தட்டச்சு செய்யும் ப�ொழுதே  ஒவ்வொரு வார்த்தைகளின் 

எழுத்துப் பிழைகளை சரிபார்த்து, எழுத்துப்பிழையுள்ள வார்த்தைகளை ஒரு சிவப்பு நிற நெளிக் 

க�ோடிட்டிருக்கும். எழுத்து பிழையை சரி செய்தவுடன்  சிவப்புநிற நெளி க�ோடுகள் மறைந்து விடும்.  

தானியங்கி பிழை சரிபார்ப்பு    என்ற பணிக்குறியை கிளிக் செய்து எழுத்துப் பிழையை சரி  

செய்யலாம். 

	நெ ளிக�ோடிடப்பட்ட வார்த்தையின் மீது சுட்டெலியின் வலது ப�ொத்தானைக் கிளிக் செய்தால், 

பிழையான ச�ொல்லிற்கு பதிலான  பல்வேறு  விதமான சரியான ச�ொற்களுடன் கூடிய ஒரு பட்டி த�ோன்றும். 

அதில் சரியான  ச�ொல்லை  தேர்வு செய்ய வேண்டும். 

	 Spelling and Grammar என்ற ப�ொத்தானை கிளிக் செய்தால் முழு ஆவணம் அல்லது தேர்வு 

செய்த உரைப் பகுதியில் பிழையை கண்டறியலாம். முழு ஆவணம் அல்லது தேர்வு செய்யப்பட்ட பகுதியில் 

ஏதேனும் எழுத்துப் பிழையிருப்பின் Spelling உரையாடல் பெட்டி (படம் 8.15 ) த�ோன்றும்      

படம் 8.15 எழுத்துப்பிழை திருத்தும் உரையாடல் பெட்டி
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Spelling கருவியில் உள்ள மேலும் சில அம்சங்கள் :

•	 Not in dictionary உரை பெட்டி  எழுத்துப்பிழையுடன்  கூடிய ச�ொற்களை காட்டும். 

•	 Suggestions உரை பெட்டி  பிழையுடன் கூடிய  ச�ொல்லுக்கு  பதிலாக மாறிவர வேண்டிய  ச�ொற்களை 

காட்டும் .

•	 Ignore once ப�ொத்தான்  பிழையான ச�ொற்களை ஒரு முறை சுட்டிக்காட்டுவதை தவிர்க்கும்.

•	 IgnoreAll ப�ொத்தான்  பிழையான ச�ொற்களை ஆவணம் முழுதும்  சுட்டிக்காட்டுவதை தவிர்க்கு.

•	 Change ப�ொத்தான் குறிப்பிட்ட பிழையான ச�ொல்லை ஒருமுறை மட்டும் சரியான ச�ொல்லைக் 

க�ொண்டு மாற்றும்.

•	 Change All ப�ொத்தான்பிழையான  ச�ொல்லிற்கு பதில்  ஆவணம்  முழுதும் மட்டும் சரியான 

ச�ொல்லைக் க�ொண்டு மாற்றும்.

•	 	Spelling உரையாடல் பெட்டியின் மூலம் அகராதியின் ம�ொழியை மாற்ற முடியும். (Spanish, French or 
German)

•	 	அகராதியில் ஒரு புதிய ச�ொல்லை சேர்க்க முடியும், இவ்வாறு செய்ய Spelling உரையாடல் பெட்டியில் 

Add ப�ொத்தானை கிளிக் செய்யவும்.

படம் 8.16 தானியங்கு சரிசெய்யும் வழிகாட்டி
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8.2.3 தானியங்கு சரிசெய்யும் தேர்வு 

	 Autocorrect என்ற செயல்பாட்டின் மூலம் பயனர் செய்யும் பிழைகள் மற்றும் தட்டச்சு செய்யும் 

ப�ோது ஏற்படும் பிழைகளை தானாகவே திருத்திக்  க�ொள்ள முடியும். உதாரணமாக “teh” என்ற ஒரு 

ச�ொல்லைத் தட்டச்சு செய்த பிறகு தானாகவே “the” என மாற்றிக் க�ொள்ளும்.

தானியங்கு சரி செய்யும் தேர்வை உருவாக்க

•	 Tools  Autocorrect  என்ற கட்டளையை தேர்வு செய்யவும் 

•	 Autocorrect உரையாடல் பெட்டி த�ோன்றும்.

•	 Replace பெட்டியில் பிழையான ச�ொல்லை தட்டச்சு செய்யவும்.

•	 With பெட்டியில் மாற்று ச�ொல்லை தட்டச்சு செய்யவும்.

•	 New ப�ொத்தானை கிளிக் செய்தால்தானியங்கு சரி செய்யும் தேர்வில் புதிய ச�ொல்லானது  

சேர்க்கப்படும்  ச�ொல் உருவாக்கப்படும்.

Autocorrect என்பது தானாகவே தேர்வு (ON) செய்யப்பட்டிருக்கும். அதை 

நீக்குவதற்கு(Off)  Format- > Auto Format- > While typing  என்ற தேர்வுபெட்டியை 

மீண்டும் கிளிக் செய்யவும் . இம் முறையானது சிறப்புக் குறியீடுகளை உள்ளிடுவதற்கு 

விரைவான வழியாகும். எடுத்துக்காட்டாக (C) என்பதை © என தானியங்கு தேர்வு 

மாற்றும். நமக்கு தேவையான சிறப்புக்குறியீடுகளையும் சேர்க்க முடியும்

செயற்பாடு 1:

•	 	“comupter” என்ற பிழையான ச�ொல்லை தானாகவே “comupter” என்ற ச�ொல்லுக்கு மாற்ற 

வழிகள் 

1.	 Tools  Auto correct விருப்பத்தை தேர்வு செய்யவும்.

படம் 8.17 தானியங்கு சரிசெய்யும் பட்டி
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2.	 Replace தத்தலை கிளிக் செய்து “comupter” என்ற ச�ொல்லை Replace உரைப் பெட்டியில் தட்டச்சு 

செய்யவும்.  with உரைப் பெட்டியில் “computer” என்ற ச�ொல்லைத் தட்டச்சு செய்த பின் Ok 

ப�ொத்தானை கிளிக் செய்ய வேண்டும்.

படம் 8.18 தானியங்கு உரையாடல் பெட்டி

3.	 “comupter” என்ற ச�ொல் “computer” என்ற ச�ொல்லுக்கு தானாகவே மாற்றியிடப்பட்டு திரையில் 

த�ோன்றும்.

படம் 8.19 தானியங்கு பட்டியல்
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	 “comupter” என்ற ச�ொல்லை தட்டச்சு செய்த பின் அது தானாகவே “computer”  என்று 

சரியான ச�ொல்லாக மாறிவிடும்.

தேர்வு செய்யப்பட்ட உரையில் உள்ள ச�ொல்லின் எண்ணிக்கையை காண

	தேவை யான உரையை  தேர்வு செய்தபின் Tools  Word Count விருப்பத்தை தேர்வு செய்க.

பின் தேர்வு செய்யப்பட்ட உரையில் உள்ள ச�ொல்லின் எண்ணிக்கை மற்றும் எழுத்துக்களின் 

எண்ணிக்கையை Word Count  உரையாடல் பெட்டியில் ( படம் 8.20) காணலாம்.

படம் 8.20 Word Count  உரையாடல் பெட்டி

	 File   Properties  Statistics விருப்பத்தை தேர்வு செய்தவுடன் முழு ஆவணத்தில் 

உள்ள ச�ொல்லின் எண்ணிக்கை மற்றும் எழுத்துக்களின் எண்ணிக்கையை படம் -8.21ல் காணலாம்.

படம் 8.21 ஆவணத்தில் எழுத்துக்களின் எண்ணிக்கை
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செயல்பாடு

மாணவர் செயற்பாடு 1-

ஒரு மெயில் மெர்ஜ் வசதியை பயன்படுத்தி,   உங்கள் பள்ளியில் அறிவியல் கண்காட்சியைப் பார்வையிட 

பெற்றோரை அழைக்க அழைப்பிதழை உருவாக்கு.

மாணவர் செயற்பாடு- 2

பிறந்தநாள் அழைப்பினை உருவாக்கவும், அதை உங்கள் நண்பர்களுக்கு அனுப்ப மெயில் மெர்ஜ்-ஐ 

பயன்படுத்தவும்.

ஆசிரியர் செயற்பாடு- 3

மெயில் மெர்ஜ் வசதியை பயன்படுத்தி, பள்ளியில் பெற்றோர் சந்திப்புக்கு, பெற்றோரை அழைப்பதற்கான 

அழைப்பிதழை உருவாக்கு.

மதிப்பாய்வு

பகுதி - அ

I சரியான விடையை தேர்வு செய்க

1.	 அட்டவணையில் சேகரிக்கப்பட்டுள்ள பல நபர்களின் விவரங்கள் அடங்கிய ஒரு ஆவணத்தை   	
	 எல்லா மக்களுக்கும் அனுப்ப நீங்கள் பயன்படுத்தும் வசதி எது?

	 (அ) Turn on the Online Collaboration	 (ஆ) Turn on the Track Changes
	 (இ) Use the Mail Merge	 		  (ஈ) Enabling Hyperlink

2. 	 இதில் எவை அஞ்சல் பட்டியலின் பெயர் மற்றும் முகவரி பதிவுகள் உள்ள தரவுத்தளமாகும்?

	 (அ) மூலதரவு		  (ஆ) ச�ொற்செயலி	 (இ) உரைக�ோப்பு	 (ஈ) பக்கவடிவமைப்பு

3.	 ஒரு ஆவணத்தை உருவாக்க, பதிப்பாய்வு செய்ய மற்றும் ஒழுங்கமைக்க பயன்படும் ஒரு 		
	க ணிப்பொறி பயன்பாடு ____

	 (அ) ச�ொற்செயலி				    (ஆ) அட்டவணைத்தாள்	

	 (இ) நிகழ்த்துதல்				    (ஈ) தரவுதளம்

4.	 இவற்றுள் எவை மெயில் மெர்ஜ் வசதி உடையது அல்ல?

	 (அ) மெயில் உள்ளடகத்தை பல பெருநர்களுக்கு அனுப்புதல்

	 (ஆ) தரவை உருவாக்குதல் மற்றும் வரிசைபடுத்துதல்

	 (இ) லேபில்ஸ்	

	 (ஈ) கணிப்பான்

5.	வெ ளிப்புற முகவரி புத்தகத்தை உருவாக்கும்  வழிகாட்டியின்  பின்வரும் விருப்பத்தேர்வில் எது 	
	ப� ொறுப்பு இல்லை ? 

	 (அ) Mozilla / Netscape			   (ஆ) LDAP Address Data
	 (இ) Outlook Address Book 			   (ஈ) Windows System Address Book
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6.	 பட்டி பட்டையில் உள்ள எந்த விருப்பத் தேர்வு ஒரு ஆவணத்தை மெயில் மெர்ஜ் - க்கு  			 
	 பயன்படுத்தப்படுகிறது?

	 (அ) View	 (ஆ) Format 	 (இ) Table 	 (ஈ) Tools

7.	 பின்வரும் க�ோப்பு பட்டியலில் எது மெயில் மெர்ஜ்-ல் உள்ள முகவரி பட்டியலாக பயன்படுத்த 		
	 முடியாது

	 (அ) OpenOffice Calc				    (ஆ) Microsoft Excel 		

	 (இ) OpenOffice Base				    (ஈ) OpenOffice Impress

8.	 ஆவணத்தில் உள்ள எழுத்துப்பிழைகளை இதன் மூலம் தெரிந்து க�ொள்ள முடியும்       

	 (அ) பச்சை நிற நெளிக்கோடு			    (ஆ)  நீல நிற நெளிக்கோடு

	 (இ) கருப்பு நிற நெளிக்கோடு			    (ஈ) சிகப்பு நிற நெளிக்கோடு

9.	 ஒப்பன் ஆபீஸ் ரைட்டரில் உள்ள மாற்று ச�ொற்கள் இவ்வாறுஅழைக்கப்படுகின்றன.

	 (அ) Antonyms		 (ஆ) Thesaurus		  (இ) Comment 		 (ஈ) Meaning

பகுதி - ஆ

II சிறு வினாக்கள் (இரண்டு  மதிப்பெண்கள்)

1.	 மெயில் மெர்ஜ் என்றால்என்ன?

2.	 முகவரி புத்தகம் என்றால் என்ன?

3.	 மூலதரவு என்றால் என்ன?

4.	 ஒரு அகராதியில் உன்னுடைய பெயரை எவ்வாறு சேர்ப்பாய்?

5.	 தவறாக தட்டச்சு செய்யப்பட்ட ச�ொல்லை எவ்வாறு சரி செய்வாய்?

பகுதி – இ

III குறு வினாக்கள் (மூன்று மதிப்பெண்கள்)

1.	 மெயில் மெர்ஜ் வசதியின் நன்மைகளைப் பட்டியலிடுக.

2.	 மெயில் மெர்ஜ்-ல் மூலதரவைப் பட்டியலிடுக

3.	 ஒரு ஆவணத்தை திறந்து, அதில் எத்தனை வார்த்தைகள் உள்ளன என்பதை கண்டுபிடி.

4.	 ஒரு பத்தியில் உள்ள வார்த்தைகளின்  எண்ணிக்கையை கண்டுபிடிப்பதற்கான படி நிலைகளை 	
	 எழுதுக.

பகுதி – ஈ

IV நெடுவினாக்கள்  (ஐந்து மதிப்பெண்கள்)

1.	 மெயில் மெர்ஜ்-ல் உள்ள வசதிகளை விவரி.

2.	 முகவரி புத்தகத்தில் (Address Book)  உள்ள அம்சங்களை விவரி

3.	 மெயில் மெர்ஜ்-ல் தரவை எவ்வாறு உருவாக்குவாய் மற்றும் சேமிப்பாய்?
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கற்றல் ந�ோக்கங்கள்

	 இந்த பாடத்தை கற்றப்பின் மாணவர்கள் 

அறிந்து க�ொள்பவை

•	 ஓபன் ஆஃபீஸ் கால்கின் சிறப்பியல்புகளை 

அறிந்து க�ொள்ளுதல் 

•	 பல்வேறு செயற்குறிகளின் பயன்பாடுகள் 

•	 வரிசைகளை உருவாக்குதல் 

•	 அட்டவணைத்தாளில் வாய்ப்பாடுகளை 

ப தி ப் பி த ்த ல் 

•	 அட்டவணைத்தாளில் வரிசை /நெடுவரிசைகளை 

கையாளுதல் 

•	 உரை வடிவூட்டலின் பல்வேறு விருப்பங்களை 

அறிந்துக�ொள்ளுதல் 

•	 அட்டவணைத்தாளில் எண் வடிவூட்டலின் 

பயன்பாடு

9.1 அட்டவணைச் செயலி ஓர் அறிமுகம்

	 அட்டவணைச்செயலி அலுவலக 

பயன்பாட்டிற்குத் தேவையான தரவுகளை 

ஒருங்கிணைத்து, ஆராய்ந்து, சேமித்து 

அட்டவணை வடிவில் தருவதற்கு பயன்படும் மிகச் 

சிறந்த கருவியாகும். கைவழி கணக்கீடுகளைச் 

செய்ய உதவும் கணக்கீட்டு தாள்களுக்கு 

இணையாக கணினியில் கணக்கீடுகளைச் 

செய்வதற்கு ஏதுவாக அட்டவணைச்செயலி 

உ ரு வ ா க ்கப்பட்    டு ள்ள  து .

	 அட்டவணைச்செயலியில் தேக்கி 

வைத்த எந்த ஒரு மதிப்பையும் பயனர் மாற்றி 

அமைத்துக்கொள்ளமுடியும். இதன் மூலம் ஏற்படும் 

விளைவுகளினால் கணக்கீட்டு மதிப்புகளில் ஏற்படும் 

மாற்றத்தையும் பயனர் அறியலாம். இதுவே ”என்ன 
– எனில் பகுப்பாய்வு” (What – if analysis) எனப்படும்.

	ந வீன அட்டவணைச் செயலியில் 

தரவுகளை உரை அல்லது எண் அல்லது வரைபட 

வடிவில் தரமுடியும்; மேலும் ஒன்றுக்கு மேற்பட்ட 

அட்டவணைத் தாள்களை ஒருங்கிணைத்து 

அவற்றில் செயலாற்ற முடியும்.

9.1.1 அட்டவணைச் செயலியின் வளர்ச்சி

	டே னியல் பிரிக்லின் மற்றும் பாப் 

ஃப்ராங்ஸ்டன் ஆகிய�ோர், 1979- ஆம் ஆண்டு, 

ஆப்பிள் II என்ற கணிப்பொறிக்காக, விசிகால்க் 
(Visicalc) என்ற முதல் அட்டவணைச்செயலியை 

உருவாக்கினார்கள். அதன் பின்னர், ல�ோட்டஸ் 
கார்ப்ரேசன் (Lotus Corporation) என்ற நிறுவனம் 

ல�ோட்டஸ் 1-2-3 (Lotus 1-2-3) என்ற 

அட்டவணைச்செயலியை, 1982ஆம் ஆண்டு 

உருவாக்கியது. நுண்ணறைகளுக்கு பெயரிடுதல் 

மற்றும் மேக்ரோஸ் ப�ோன்றவை ”ல�ோட்டஸ் 1-2-3”-

ல் முதன் முதலில் அறிமுகப்படுத்தப்பட்டது. 1987-ல் 

மைக்ரோ சாப்ட் நிறுவனம் எக்ஸெல் (Excel) என்ற 

அட்டவணைச்செயலியை அறிமுகப்படுத்தியது. 

சுட்டியைப் பயன்படுத்தும் வரைகலை பயனர் 

இடைமுகம் (GUI - Graphical User Interface) 

வசதி எக்ஸெல் அட்டவணைச் செயலியில் 

செயல்படுத்தப்பட்டது. பல்வேறு  வகையான 

அட்டவணைச்செயலி மென் ப�ொருள்களில் 

இருந்தப�ோதிலும், மைக்ரோ சாப்ட் எக்ஸெல் மிகவும் 

பிரபலமான ஒன்றாகும்.

பாடம் 9அலகு III அட்டவணைச் செயலி

அட்டவணைச் செயலி
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அட்டவணைசெயலியின் தந்தை – 

டேனியல் சிங்கர் “டான் பிரிக்ளின்”

முதல் அட்டவணைச் 

ச ெ ய லி ய ா ன 

“விசிகால்க்”-யை உருவாக்கிய 

டான் பிரிக்லின் மற்றும் பாப் 

ஃப்ராங்ஸ்டன் ஆகிய இருவரில், 

1951 ஜூலை 16ல் பிறந்த, டேனியல் சிங்கர் டான் 

பிரிக்ளின் "அட்டவணைச்செயலியின் தந்தை" என 

அழைக்கபடுகிறார். டான் பிரிக்ளின் சாஃப்ட்வேர் 

கார்டன் (Software Garden Inc.) என்ற நிறுவனத்தை 

உருவாக்கி அதற்கு தலைவராகவும் உள்ளார். மேலும் 

web.com-க்கு ச�ொந்தமான டெரிலிக்ஸ் கார்ப்பரேசன் 

(Trellix Corporation) என்ற நிறுவனத்திற்கும் 

தலைவராக உள்ளார். தற்போது, ஆல்ஃபா சாப்ட்வேர் 

(Alpha software) என்ற நிறுவனத்தின் ”தலைமை 

த�ொழில் நுட்ப அதிகாரி”-யாகவும் 

பணியாற்றிவருகிறார்.

	 ஒபன் ஆஃபீஸ் கால்க் ஒரு பிரபலமான 

திறந்த மூல (Open Source) அட்டவணைச்செயலி 

ஆகும். இதனை தற்போது அபாச்சி (Apache) 
நிறுவனம் நிர்வகித்து வருகிறது. 1985-ல் ஜெர்மன் 

நிறுவனமான ஸ்டார் டிவிஷன் (Star Division) 
உருவாக்கிய ஸ்டார் ஆஃபிஸ் கால்க் (Star Office 
Calc), ஒபன் ஆஃபிஸ் கால்கின் (Open Office Calc) 

மூல பயன்பாடாகும்.

9.2. ஒபன் ஆஃபீஸ் கால்க்-ல் வேலை செய்தல்.

	 கால்க்(Calc) என்பது ஓபன் 

ஆஃபீஸ் (Open Office) த�ொகுப்பில் உள்ள 

அட்டவணைச்செயலியாகும். அட்டவணைச் 

செயலியில் எந்த விதமான தரவுகளையும் உள்ளீடாக 

க�ொடுத்து, செயலாக்கம் செய்து, வெளியீட்டை பெற 

முடியும்.  மேலும் “ என்ன-எனில் பகுப்பாய்வு” 
முறையின் மூலம் ஏதேனும் ஒரு தரவை மீண்டும் 

தட்டச்சு செய்யாமல், மாற்றம் மட்டும் செய்தால் 

அவற்றின் வெளியீடுகள் எவ்வாறு மாறுகிறது 

என்பதை எளிதாக பார்க்க முடியும்.

விசிகால்க் 
(Visible 
Calculator) 
என்பது 

ஆப்பிள் II என்ற 
கணிப்பொறிக்காக, விசிகார்ப் என்ற 
நிறுவனத்தால், தனியாள் கணிப்பொறிக்காக 
வடிவமைக்கப்பட்ட முதல் அட்டவணைச்செயலி 
ஆகும். ப�ொழுது ப�ோக்குக்காக சேகரித்தல் 
மற்றும் பயன்படுத்தும் நிலையில் இருந்த 
கணிப்பொறிகளை, தீவிர வணிக ந�ோக்கில் 
கணிப்பொறிகளைப் பயன்படுத்தும் 
வகையில் மாற்றம் பெற “விசிகால்க்” 
முக்கிய பங்காற்றியுள்ளது. அடுத்த இரண்டு 
ஆண்டுகளில் ஐ.பீ.எம் (IBM-PC) தனியாள் 
கணிப்பொறிகளை அறிமுகப்படுத்தியது. ஆறு 
ஆண்டுகளில் ஏழு இலட்சம் பிரதிகள் வரை 
விற்பனை செய்யப்பட்டது, அதன் வரலாற்றில் 
சுமார் 1 மில்லியன் பிரதிகள் வரை விற்பனை 
ச ெ ய ்யப்ப   ட ்ட து .

9.2.1 ஒபன் ஆஃபீஸ் கால்கின் சிறப்பியல்புகள்

எக்ஸெல் அட்டவணைச்செயலியுடன் இணைப்பு: 

ஓபன் ஆஃபீஸ் கால்க் பயன்பாட்டில் மைக்ரோ 
சாப்ட் எச்ஸெல் அட்டவணைச் செயலிகளை 
திறக்கவும், பதிப்பாய்வு செய்யவும் மற்றும் 
சேமிக்கவும் முடியும். 
தானியங்கு கூட்டல் (Autosum)
	 நுண்ணறைத் த�ொகுப்பில் உள்ள 
மதிப்புகளின் கூட்டுத் த�ொகையை கண்டறிய 
உ த வு கி ற து .
பட்டியல்  தானியங்கு நிரப்பி (List Auto Fill):
	 ஒரு பட்டியலின் இறுதியில், சில 
புதிய தரவுகளைச் சேர்க்கும் ப�ோது, 
மற்ற நுண்ணறைகளுக்கு செய்யப்படும் 
வடிவூட்டல்கள், தானாகவே புதிய தரவுகளுக்கும் 
நீ ட் டி க ்கப்ப   டு ம்
தானியங்கு நிரப்பி (Auto Fill):
	தே திகள் அல்லது எண்கள் வரிசை 
முறை அல்லது மீண்டும், மீண்டும் த�ோன்ற 
வேண்டிய உரைகளை தேர்ந்தெடுக்கப்பட்ட  
நுண்ணறைகளில் விரைவாக த�ோன்ற செய்ய 
தானியங்கு நிரப்பி வசதி வகை செய்கிறது. 
செயற்கூறுகளை நகலெடுக்கவும் இவ்வசதி 
பயன்படுகிறது. மேலும் இதன் மூலம் உரை 
மற்றும் எண்களை மாற்றி அமைக்க முடியும்.

Chapter 9.indd   139 20-04-2020   15:59:21



140

விளக்கப்படம் (Charts):
	தர வுகளை வட்ட (Pie), பட்டை (Bar), 
க�ோட்டு (Line) ப�ோன்ற  விளக்கப்படங்களாக 
தருவதற்கு பயன்படுகிறது. 

செயற்கூறுகள் (Functions):
	தர வுகளின் மீது, சிக்கலான கணக்கீடுகளைச் 
செய்ய உதவும் வாய்பாடுகளை உருவாக்க பயன்படுகிறது.

தரவுத்தள செயற்கூறுகள் (Database functions)
	தர வுகளை ஒழுங்குபடுத்தி, வடிகட்டி, 
சேமிக்க உதவுகிறது.

 9.3 ஒரு புதிய அட்டவணைத்தாளை 
உருவாக்குதல்

	ஸ்டார்  ஆஃபிஸ் கால்க்-ல் ஒரு புதிய 
அட்டவணைத்தாளை பல்வேறு முறைகளில் 
உ ரு வ ா க ்க ல ா ம் .

விண்டோஸ் முகப்புத் திரையிலிருந்து:

	 Start → All programs→ OpenOffice → 
OpenOffice Calc 

(அல்லது)
ஸ்டார் சென்டர் (ஒபன் ஆஃபீஸ் வரவேற்பு திரை)-
லிருந்து

•	 விண்டோஸ் திரைமுகப்பிலுள்ள “Open Office“ 
பணிக்குறியை இருமுறை கிளிக் செய்யவும்.

•	 இப்போது, படம் 9.1 ல் உள்ளது ப�ோல ஓபன் 
ஆஃபீஸ் வரவேற்புத் திரை த�ோன்றும்.

ஸ்டார் ஆஃபீஸின் முகப்புத் திரை 
“ஸ்டார் சென்டர்” (Star Center) என்று  
அழைக்கப்படுகிறது். கால்க் ஒபன் ஆஃபிஸின் 
ஒரு உள்ளிணைந்த பகுதியாகும். எனவே, 
இதனை ஸ்டார் சென்டரில் உள்ள "Spreadsheet" 
பணிக்குறியை கிளிக் செய்வதன் மூலம் எளிதாக 
பெறலாம்.

(அல்லது)
	 ஒபன் ஆஃபிஸின் எந்த ஒரு 
பயன்பாட்டிலிருந்தும்  File→ New→ Spreadsheet 
என்ற கட்டளையின் மூலமும் ஒரு புதிய 
அட்டவணைச் செயலியை உருவாக்கலாம்.

	மேலே  விவரிக்கப்பட்ட ஏதேனும் ஒரு 
வழிமுறைப் பயன்படுத்தி ஒபன் ஆஃபீஸ் கால்க்-ஐ 

திறக்கும் ப�ோது, படம் 9.2ல் காட்டப்பட்டுள்ளபடி 
சன்னல் திரை த�ோன்றும். கால்க்-ன் வெளிப்புற 
சன்னல் திரை, மற்ற ஒபன் ஆஃபீஸ் சன்னல் 
திரையை ப�ோன்றே இருக்கும். கால்க் சன்னல் 
திரையின் முக்கியப் பகுதி பணிப் பகுதி (Work 
area) அல்லது அட்டவணைத் தாள் (Worksheet) 
என்று அழைக்கப்படுகிறது. 

	 அட்டவணைத்தாள் என்பது 
கட்டங்களுடன் கூடிய நுண்ணறைகளைக் 
க�ொண்ட ஒரு அமைப்பு ஆகும். அதன் 
ஒவ்வொறு நுண்ணறையிலும் நிரலாக்கப்பட்ட 
கணிப்பாண்கள் இணைந்துள்ளது. ஒரு புதிய 
அட்டவணைச்செயலியை திறக்கும் ப�ோது, 
க�ொடாநிலையாக மூன்று அட்டவணைத்தாள்களே 
இருக்கும். தேவையெனில் இன்னும் அதிகமான 
அட்டவணைத்தாள்கள் சேர்த்துக்கொண்டு, 
ஒருங்கிணைக்கவும் முடியும்.

 
படம் 9.1 ஒபன் ஆஃபீஸ் முகப்புத் திரை 

(ஸ்டார் சென்டர்)
1

11
10

9

5 6 7 4

3 2

8

1.  தலைப்புப் பட்டை
(Title bar)

2. கட்டுப்பாட்டு ப�ொத்தான்கள்
(Control Buttons)

3. பட்டிப் பட்டை 
(Menu bar)

4.  கருவிப் பட்டை
(Tool bar)

5.  பெயர் பெட்டி / முகவரிப் 
பெட்டி (Name Box / 
Address Box) 

6.  விரைவு செயற்கூறு வழிகாட்டி 
(Quick Function Wizard)

7.  வாய்பாடுப் பட்டை / 
உள்ளீட்டுப் பெட்டி 
(Formula bar / Input Line)

8.  வடிவூட்டல் பண்புகள் 
(Formatting properties)
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9.  பெரிதாக்குதல் 
(Zoom)

10.   உருள் பட்டை 
(Scroll bar)

11.   நிலைமைப் பட்டை 
(Status bar)

படம் 9.2 ஒபன் ஆஃபீஸ் கால்க் சன்னல் திரை

9.3.1  �ஒபன் ஆஃபீஸ்  கால்க் சன்னல் திரையின் 
பகுதிகள் 

	 கால்க்–ன் சன்னல் திரை, முந்தைய 
பாடத்தில் கற்ற  ச�ொற்செயலியின் சன்னல் 
திரை ப�ோன்றே த�ோற்றமளிக்கும். ரைட்டரில் 
தட்டச்சு செய்யப்பட வேண்டிய காலியான 
வெற்றிடம் அதன் பணித்தளம் ஆகும். ஆனால் 
கால்க் – ல் பணித்தளம் கட்டங்களுடன் கூடிய 
நுண்ணறைகளாக இருக்கும்.
9.3.1.1 தலைப்புப் பட்டை

	 சன்னல் திரைய்ின் மேல்பக்கம், 
தலைப்புப் பட்டை என்று அழைக்கப்படுகிறது. 
இது பயன்பாட்டின் பெயரையும், அதன் மூலம் 
உருவாக்கப்படும் க�ோப்பின் பெயரையும் காட்டும். 
ஒபன் ஆஃபீஸ் கால்க்கில், ஒரு அட்டவணை 
சேமிக்கப்படாத நிலையில் க�ொடாநிலையாக 	
Untitled1 என்று பெயரிடப்பட்டிருக்கும்.

9.3.1.2 கட்டுப்பாட்டுப் ப�ொத்தான்கள்

	 தலைப்புப் பட்டையின் வலது ஓரத்தில் 
மூன்று கட்டுப்பாட்டு ப�ொத்தான்கள் உள்ளது. 
அவை, (1) சிறிதாக்கு (2) பெரிதாக்கு / மீட்டமை 
மற்றும் (3) மூடு ப�ொத்தான்கள்.

9.3.1.3 பட்டிப்பட்டை

	 தலைப்புப் பட்டைக்கு கீழே உள்ளது, 
பட்டிப்பட்டை ஆகும். பெரும்பான்மையான 
பட்டியல்கள் (Menu), ஒபன் ஆஃபீஸ் ரைட்டரில் 
உள்ளது ப�ோன்றே இருக்கும்.  
	 File: இந்த பட்டி, க�ோப்பு மேலாண்மை 
கட்டளைகளான, ஒரு புதிய க�ோப்பை 
உருவாக்குதல் (New), ஏற்கனவே 
உருவாக்கப்பட்ட க�ோப்புகளைத் திறத்தல் 
(Open), நடப்பு க�ோப்பை மூடுதல் (Close), ஒரு 
க�ோப்பை சேமித்தல் (Save), ஒரு க�ோப்பை 
வேறு பெயரில் சேமித்தல் (SaveAs), அச்சிடுதல் 
(Print), ஒரு க�ோப்பை ஒரு முறைமையிலிருந்து, 
மற்றொரு முறைமைக்கு மாற்றுதல் (Export) 
ப�ோன்ற செயல்களைச்   செய்வதற்கான 
கட்டளைகளைக் க�ொண்டுள்ளது.

	 Edit:  வெட்டுதல் (Cut), நகலெடுத்தல் 
(Copy), ஒட்டுதல் (Paste), திரும்பப் பெறு 
(Undo), மீண்டும் செய் (Redo), நிரப்பு (Fill) 
ப�ோன்ற அட்டவணைச் செயலியைப் பகுப்பாய்வு 

செய்வதற்கான கட்டளைகளைக் க�ொண்டுள்ளது. 
பெரும்பான்மையான கட்டளைகள் ரைட்டர் Edit 
பட்டியில் உள்ளத�ோடு ஒத்திருப்பினும், கால்க்கின் 
சிறப்பு பதிப்பாய்வு கட்டளைகளையும், இந்த பட்டி 
க�ொண்டுள்ளது.

	 View: கால்க்-ன் பணிச்சூழலை மாற்றி 
த�ோன்ற செய்யப் பயன்படும் கட்டளைகளை 
இப்பட்டி க�ொண்டுள்ளது. 

	 Insert:  நுண்ணறைகள் (Cells), 
வரிசைகள் (Rows), நெடுவரிசைகள் (Columns), 
செயற்கூறுகள் (Functions), விளக்கப்படங்கள் 
(Charts) ப�ோன்ற கால்க்கின் முக்கிய கூறுகளைச் 
செருக தேவையான கட்டளைகளை இந்தப் பட்டி 
க�ொண்டுள்ளது.

	 Format: உரை மற்றும் நுண்ணறைகளை 
வடிவூட்டம் செய்யப் பயன்படும் பல்வேறு 
கட்டளைகளை க�ொண்டுள்ளது.

	 Tools: ச�ொற் பிழைத் திருத்தம் 
(Spell check), ஆவணப் பாதுகாப்பு (Protect 
document), படங்களை இணைத்தல் (Insert 
pictures), மேக்ரோ (Macro) ப�ோன்ற பல்வேறு 
கருவிகளையும், செயற்கூறுகளையும் இப்பட்டி 
க �ொ  ண் டு ள்ள  து .

	 Data: வரிசையாக்கல் (Sort), 
வடிகட்டல் (Filter), கூட்டுத்தொகை (Subtotal), 
செல்லுபடியாக்கல் (Validity) ப�ோன்ற தரவு 
கையாளுகைக்கு பயன்படும் கட்டளைகளை 
இப்பட்டி க�ொண்டுள்ளது.

	 Window:	 புதிய சன்னல் (New 
Window), சன்னலை மூடுதல் (Close Window), 
சன்னல் பிரித்தல் மற்றும் உறைதல் (Split and 
Freeze) ப�ோன்ற காட்சி விருப்பத் தேர்வுகளை 
இப்பட்டி க�ொண்டுள்ளது.

	 Help: ஒபன் ஆஃபீஸ் பயன்பாட்டுடன் 
இணைந்துள்ள உதவி-யைப் பெறுவதற்கு இப்பட்டி 
ப ய ன்ப  டு கி ற து .
9.3.1.4 கருவிப்பட்டை (Tool bar)
	 பட்டிப்பட்டையின் கீழ் க�ொடா நிலையாக 
மூன்று கருவிப்பட்டைகள் உள்ளன. அவை

1.	 செந்தாரக் கருவிப்பட்டை 

2.	 வடிவூட்டல் கருவிப்பட்டை

3.	 வாய்ப்பட்டு பட்டை
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செந்தரக் கருவிப்பட்டை (Standard Tool bar)

வடிவூட்டல் கருவிப்பட்டை(Formatting Tool bar) வாய்ப்பாட்டு பட்டை (Formula bar)
படம் 9.3 ஒபன் ஆஃபீஸ் கால்க் கருவிப்பட்டைகள்

	 செந்தரக் கருவிப்பட்டை – இந்தப் பட்டை, 
File, Edit மற்றும் Data ஆகிய பட்டிப்பட்டையிலுள்ள, 
அடிக்கடி பயன்படுத்தப்படும் கட்டளைகளான, 
New (ஒரு புதிய க�ோப்பை உருவாக்குதல்), Open 
(ஏற்கனவே உள்ள க�ோப்பை திறத்தல்), Save 
(சேமித்தல்), Send (பரிமாற்றம் செய்தல்), Print 
(அச்சிடுதல்), Print preview (அச்சு முன்பார்வை), 
Cut (வெட்டுதல்), Copy (நகலெடுத்தல்), Paste 
(ஒட்டுதல்), Sorting (வரிசையாக்கம்), Inserting 
Chart (விளக்கப்படம் செருகுதல்) ப�ோன்றவற்றை 
பணிக்குறிகளாக (Icons) க�ொண்டுள்ளது.
	 வடிவூட்டல் கருவிப்பட்டை – உரை 
மற்றும் நுண்ணறைகளை வடிவூட்டல் செய்யும் 
கட்டளைகளான, எழுத்துரு வகை (Font 
Style), அளவு (Size), நிறம் (Colour), இசைவு 
(Alignment), நுண்ணறை வடிவூட்டல்கள் (Cell 
Formatting) ப�ோன்றவற்றை பணிக்குறிகளாக 
இந்த கருவிப்பட்டை க�ொண்டுள்ளது. 
	 வாய்பாட்டுப் பட்டை:– ஒரு அட்டவணைச் 
செயலியின் மிக முக்கியமான கூறு, வாய்பாட்டுப் 
ஆகும். இந்தப் பட்டை, பெயர் பெட்டி (Name 
box), செயற்கூறு வழிகாட்டி (Function 
Wizard), கூட்டல் ப�ொத்தான் (Sum button), 
செயற்கூறு ப�ொத்தான் (Function button) மற்றும் 
உள்ளீட்டுத்தாரை (Input Line) ஆகியவற்றை 
க�ொண்டுள்ளது. (படம் 9.4ஐ பார்க்க).
	 பெயர் பெட்டி  (Name Box ):
	 இது நடப்பு நுண்ணறையின் முகவரியை 
க ாட்  டு ம்
	 செயற்கூறு வழிகாட்டி (Function 
Wizard):  செயற்கூறுகளை சேர்க்க உதவுகிறது
	 கூட்டல் ப�ொத்தான் (Sum button): 
கூட்டல் செயற்கூற்றை விரைவாக செருக இது 
உ த வு கி ற து .
	 உள்ளீட்டுத்தாரை (Input line): நடப்பு 
நுண்ணறையில் உள்ள தரவுகளைக் காட்ட இது 
பயன்படுகிறது. இது ஒரு நுண்ணறையில் பயனர் 
எதைத் தட்டச்சு செய்தார�ோ அதனை மட்டுமே 
காட்டும். மேலும், இது நுண்ணறையில் உள்ள 
தரவுகளை பதிப்பிக்கவும் பயன்படுகிறது.

பெயர் பெட்டி / முகவரி பெட்டி
உள்ளீட்டு தாரை

Sum ப�ொத்தான்

செயற்கூறு 
வழிகாட்டி

செயற்கூறு 
ப�ொத்தான்

படம் 9.4 கால்க் வாய்ப்பாடுப் பட்டை

9.3.1.5 திரை உருளல் பட்டை (Scroll bar)
	 அட்டவணைச்செயலி சன்னல் திரை 
இரண்டு விதமான திரை உருளல் பட்டைகளைக் 
க�ொண்டுள்ளது. அவை (1) நெடுங்கிடை திரை 
உருளல் (Vertical Scroll bar) மற்றும் (2) 
படுக்கிடை திரை உருளல் பட்டை (Horizontal 
Scrollbar). (படம் 9.5-யை காண்க)
நெடுங்கிடை திரை உருளல் பட்டை: இது திரையை 
மேல் மற்றும் கீழாக நகர்த்த உதவுகிறது.
படுக்கிடை திரை உருளல் பட்டை: இது திரையை 
வலது மற்றும் இடது புறமாக நகர்த்த உதவுகிறது..
திரை உருளல் ப�ொத்தான்கள் (Scroll buttons) 
திரையைத் தேவையான அளவிற்கு நகர்த்த இது 
உதவுகிறது.

மேல் உருளல் 
அம்புக்குறி

உருளல் ப�ொத்தான்

கீழ் உருளல் 
அம்புக்குறி

வலது உருளல் 
அம்புக்குறி

உருளல் ப�ொத்தான்இடது உருளல் 
அம்புக்குறி

நெடுங்கிடை திரை 
உருளல் பட்டை

படுக்கிடை திரை உருளல் பட்டை

படம் 9.5 கால்க் திரைஉருளல் பட்டை
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9.3.1.6 வரிசை (Row), நெடுவரிசை (Column), 
நுண்ணறை (Cell) மற்றும் நுண்ணறை சுட்டி 
(Cell Pointer):

	 வாய்ப்பாட்டுப் பட்டையின் 
கீழே வரிசைகளும், நெடுவரிசைகளும் 
இணைந்த கட்டங்களான அட்டவணைத் 
தாளின் பணித்தளம் அமைந்துள்ளது. 
அட்டவணைத்தாள், ஒரு குறிப்பிட்ட 
எண்ணிக்கையிலான வரிசைகளையும், 
நெடுவரிசைகளையும் க�ொண்டிருக்கும். 
ஒவ்வொரு நெடுவரிசையும், A, B, C, D 
…….. AA, AB, AC …… என்ற வகையில் 
பெயரிடப்பட்டிருக்கும். வரிசைகள் 
ஒவ்வொன்றுக்கும் 1, 2, 3  ……. என 
எண்ணிடப்பட்டிருக்கும். (படம் 9.6-யை காண்க).

	 ஒபன் ஆஃபீஸ் கால்க் பதிப்பு 4.1.5 
ம�ொத்தம் 1024 நெடுவரிசைகளையும், 10,48,576 
வரிசைகளையும் க�ொண்டுள்ளது. இதன் 
நெடுவரிசைகளின் தலைப்பு (நெடுவரிசை பெயர்) 
ஆங்கில எழுத்தான A-ல் த�ொடங்கி, AMJ-
ல் முடியும். மைக்ரோசாப்ட் ”எக்ஸெல்-2016” 
அட்டவணைச் செயலியை ப�ொருத்தமட்டில், 
ம�ொத்தம் 16,384 நெடுவரிசைகளும் (A முதல் 
XFD வரை), 10,48,576 வரிசைகளையும் 
க �ொண்ட    து .

நுண்ணறை அல்லது கலம் (Cell)
	 ஒரு வரிசையும், நெடுவரிசையும் 
இணையுமிடத்தில் உருவாகும் பெட்டி 
ப�ோன்றத�ொரு அமைப்பு “நுண்ணறை” 
அல்லது “கலம்” என்று அழைக்கப்படுகிறது. 
ஒவ்வொரு நுண்ணறையும் ஒரு தனித்த 

முகவரியை க�ொண்டிருக்கும், அதற்கு 

“நுண்ணறை முகவரி” (Cell Address) என்று 

பெயர். நுண்ணறை முகவரி நெடுவரிசையின் 

பெயரும், வரிசையின் எண்ணும் இணைந்தது.  

எடுத்துக்காட்டாக, B என்ற நெடுவரிசையும், 

வரிசை எண் 4-ம் இணையுமிடத்தில் உருவாகும் 

நுண்ணறையின் முகவரி B4 ஆகும். (படம் 
9.7-யை காண்க) ஒவ்வொரு நுண்ணறையும் 

அதன் தனித்த முகவரியால் அடையாளம் 

க ா ண ப்ப  டு கி ற து .

நுண்ணறைச் சுட்டி (Cell Pointer): 

	 அட்டவணைத்தாள் முழுவதும் நகர்த்தக் 

கூடிய, செவ்வக வடிவிலான பெட்டி ப�ோன்ற 

அமைப்பு “நுண்ணறைச் சுட்டி” என்று 

அழைக்கப்படுகிறது. எந்த நுண்ணறையில் 

நுண்ணறை சுட்டி தற்போது உள்ளத�ோ, அந்த 

நுண்ணறை ”செயற்படு கலம்” (Active Cell) 

எனப்படும். தட்டச்சு செய்யப்படும் எந்த ஒரு 

தரவும், இந்த செயற்படு கலத்தினில் த�ோன்றும். 

செயற்படு கலத்தின் நுண்ணறை முகவரி, பெயர் 

பெட்டி முகவரி பெட்டியில் த�ோன்றும். செயற்படு 

கலத்தின் நெடுவரிசை பெயரும், வரிசை எண்ணும் 

வேறு நிறத்தில் உயர்த்திக் காட்டப்பட்டிருக்கும் 

(Highlighted). இந்த ஒரு காட்சிக் குறிப்பை 

(Visual Clue) வைத்து, செயற்படு கலனை 

எளிதில் அடையாளம் காணலாம். மேலும், 

செயற்படு கலத்திலுள்ள தரவுகள் வாய்ப்பாட்டு 

பட்டையின் த�ோன்றும். 

வ
ரி

சை


 எ
ண்க


ள்

நெடுவரிசை தலைப்புகள்

நுண்ணறை சுட்டி

நுண்ணறைகள்

 படம்  9.6 நுண்ணறை, வரிசை மற்றும் நெடுவரிசை 
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நடப்பு நுண்ணறை முகவரி உயர்த்திகாட்டப்பட்ட நெடுவரிசை தலைப்பு

உயர்த்திகாட்டப்பட்ட வரிசை எண்

செயல்படு கலம்

 படம்  9.7 நுண்ணறை, வரிசை மற்றும் நெடுவரிசை 

9.3.1.7 அட்டவணைத் தத்தல்கள்
செயல்படு தாள்

தாள்களின் எண்ணிக்கை
அட்டவணை தாள் வழிநடத்து 
ப�ொத்தான்கள்

படம் 9.8 கால்க் அட்டவணைத்தாள் தத்தல்கள்

	 நுண்ணறைக் கட்டங்களின் கீழே 

அட்டவணைத்தாள் தத்தல்கள் (Sheet Tabs) 

உள்ளது.   க�ொடாநிலையாக Sheet1, Sheet2  

மற்றும் Sheet3 என்ற பெயரில் மூன்று தாள்கள் 

இருக்கும்.(படம் 9.8-யை காண்க). ஒரு புதிய 

அட்டவணைத் தாளை உருவாக்கும் ப�ோது Sheet 
1 க�ொடாநிலை இயங்கு தாளாக (Default active 
sheet) இருக்கும். இந்த தாள்  தத்தல் வெண்மை 

நிறத்தில் இருக்கும். அடுத்த ஒரு தாளை 

கிளிக் செய்தால், அந்த தாள் இயங்கு தாளாக 

மாறிவிடும், அதன் தத்தலின் நிறம் வெண்மையாக 

மாறும். Ctrl ப�ொத்தானை அழுத்தி பிடித்தவாறு, 

தாள்களின் மீது கிளிக் செய்தால் ஒன்றுக்கும் 

மேற்பட்ட தாள்களை தேர்ந்தெடுக்க முடியும். 

தேர்ந்தெடுக்கப்பட்ட அனைத்து தாள்களின் 

தத்திலின் நிறமும் வெண்மையாக மாறிவிடும். 

	 அட்டவணைத்தாள்களின் தத்தலின் 

இடது பக்கத்தில் உள்ள நான்கு வழிநடத்து 

ப�ொத்தான்களை (Navigation buttons) 

பயன்படுத்தி ஒரு தாளில் இருந்து மற்றொரு 

தாளிற்கு நகரமுடியும்.

1 3

2 4

படம் 9.9 அட்டவணைத்தாள் வழிநடத்து 

ப�ொத்தான்கள்
1.	 முதல் தாளிற்கு நகர

2.	 முந்தைய தாளிற்கு நகர

3.	 அடுத்த தாளிற்கு நகர
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4.	 கடைசி தாளிற்கு நகர

	 நிலைமைப் பட்டையின் இடது 
ஓரத்தில், நடப்பு அட்டவணைச்செயலியில் 
உள்ள ம�ொத்த தாள்களின் எண்ணிக்கையும், 
நடப்பு இயங்கு தாளின் வரிசை எண்ணும் 
க�ொடுக்கப்பட்டிருக்கும். எடுத்துக்காட்டாக, 
நிலைமை பட்டையில் 3/12 எனக் காணப்பட்டால், 
நடப்பு அட்டவணைச்செயலியில் ம�ொத்தம் 12 
தாள்கள் உள்ளது எனவும், அதில் 3வது தாள் 
இயங்கு தாளாக உள்ளது என்றும் ப�ொருள்.

	 அட்டவணைத்தாளின் ஒவ்வொரு 
தாளின் பெயரையும் மாற்ற முடியும். ஒரு தாளிற்கு 
மாற்றுப் பெயரிட, அந்த தாளின் மீது இருமுறை 
கிளிக் செய்யவும். இப்போது படம் 9.10ல் 
காட்டப்பட்டுள்ளது ப�ோன்று, Rename Sheet 
உரையாடல் பெட்டி த�ோன்றும்.

படம் 9.10 மாற்றுப்பெயரிடல் உரையாடல் பெட்டி

	 இது, அட்டவணைத்தாளின் 
தற்போதைய பெயரை Name உரை பெட்டியில் 
காட்டும். காட்டப்படும் பெயரை அழித்துவிட்டு 
அல்லது அதன்மீது நேரடியாக புதிய பெயரை 
தட்டச்சு செய்து, OK ப�ொத்தானை கிளிக் 
செய்ய வேண்டும். இப்போது, புதிய பெயர் தாளில் 
த�  ோ ன் று ம் . 
9.3.1.8 நிலைமைப் பட்டை (Status bar)
	 அட்டவணைத்தாள்கள் மற்றும் 
படுக்கிடை திரைஉருள் பட்டையின் கீழ் உள்ள 
பகுதி, நிலைமைப் பட்டை எனப்படும். இது 
அட்டவணைத்தாளின் நடப்பு நிலைமையை 

காண்பிக்கும். (படம் 9.11-யை காண்க) 
	தாள்க ளின் எண்ணிக்கை (Sheets 
Count): நடப்பு தாளின் வரிசை எண் மற்றும் 
ம�ொத்த தாள்களின் எண்ணிக்கையை காட்டும்.
	 பக்க அமைப்பு (Page Style):நடப்பு 
அட்டவணைத்தாளின் பக்க அமைப்பை 
காட்டும். அதில் ஏதேனும் மாற்றம் செய்ய 
விரும்பினால், “Default” என்பதன் மீது 
இருகிளிக் செய்யவும், இப்போது “பக்க அமைப்பு 
உரையாடல் பெட்டி” (Page Style dialog box) 
த�ோன்றும். அதில், பக்கத்தின் ஓரம் (Margin), 
அமைவு (Orientation), பக்க அளவு (Page 
Size), தலைப்பு (Header), அடிக்குறிப்பு 
(Footer), எல்லை அமைப்பு (Border Style) 
ப�ோன்றவற்றை மாற்றிக்கொள்ள முடியும்

தேர்ந்தெடுப்பு நிலை (Selection mode): நடப்பு 
தாளின் தேர்ந்தெடுப்பு நிலையை காட்டும். 
அட்டவணைத்தாளின் நுண்ணறைகளை 
தேர்ந்தெடுப்பதற்கு மூன்று நிலைகள் உள்ளது. 
அவை, Standard (STD), Entend (EXT) 
மற்றும் Add (ADD).
சேமிக்கப்படாத மாற்றங்கள் (Unsaved 
Changes) நிலைமைப்பட்டையில் * என்ற குறியீடு 
த�ோன்றினால் அட்டவணைத்தாள்களில் 
செய்யப்பட்ட மாற்றங்கள், சேமிக்கப்படாமல் 
உள்ளது என்பதை குறிக்கும். பயனர் 
அட்டவணைத்தாளை சேமிக்கும்போது இந்த 
குறி மறைந்துவிடும்.

நுண்ணறைத்தகவல் (Cell Information):
தேர்ந்தெடுக்கப்பட்ட நுண்ணறைகளில் உள்ள 
மதிப்புகளின் கூட்டுத்தொகையை காண்பிக்கும்.

பெரிதாக்கு நகர்வி (Zoom slider):இது 
பார்வையிடு அளவுக�ோலை (View  Scale) மிகுக்க 
(அல்லது) குறைக்க உதவும்.  க�ொடாநிலையாக 

பெரிதாக்கு  அளவுக�ோலின் அளவு 100% ஆகும்.

தாள்களின் எண்ணிக்கை

பக்க வடிவமைப்பு சேமிக்கப்படாத மாற்றங்கள் நுண்ணறை தகவல்கள்

தேர்ந்தெடுப்பு நிலை பெரிதாக்கு நகர்வி

படம் 9.11 கால்க் நிலைமை பட்டை
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9.4 தரவுகளுடன் வேலை செய்தல்
	 ஒரு புதிய அட்டவணைத்தாளைத் 
திறக்கும்போது, நுண்ணறைச் சுட்டி, A1 
நுண்ணறையில் நிலைக்கொண்டிருக்கும். 
எனவே, A1 நுண்ணறை “Home Cell” 
என்று அழைக்கப்படும். விசைப்பலகையில் 
உள்ள திசைப்பொத்தான்களைப் பயன்படுத்தி, 
நுண்ணறைச் சுட்டியை அட்டவணைத்தாளின் 
எந்த ஒரு பகுதிக்கும் நகரத்தலாம்.

விசைப்பலகையில் உள்ள Tab ப�ொத்தான், 
நுண்ணறைச் சுட்டியை முன்னோக்கி அதாவது 
இடமிருந்து    வலப்பக்கமாக    நகர்த்தும். Shift 
+ Tab ப�ொத்தான், பின்னோக்கி அதாவது, 
வலமிருந்து இடமாக நகர்த்தும். Enter ப�ொத்தானும் 
நுண்ணறையை நகர்த்தப் பயன்படுகிறது. Enter 
ப�ொத்தானை அழுத்தும் ப�ோது, நுண்ணறைச் 
சுட்டி, நடப்பு நுண்ணறையிலிருந்து கீழ்நோக்கி 
நகர்த்தப்படும். நான்கு திசைப்பொத்தான்களும் 
நுண்ணறை சுட்டியை எந்த திசையில் 
வேண்டுமானாலும் நகர்த்தும்.

9.4.1 தரவினை உள்ளீடுதல்

	 அட்டவணைத்தாளில் எந்த ஒரு 
நுண்ணறையிலும் எந்த ஒரு தரவினையும் தட்டச்சு 
செய்ய முடியும். ஆனால், தட்டச்சு செய்யப்பட 
வேண்டிய நுண்ணறை செயற்படு கலமாக 
(Active cell) இருத்தல் வேண்டும். எனவே, எந்த 
நுண்ணறையில் தரவினை உள்ளீட வேண்டும�ோ 
அந்த நுண்ணறைக்கு நுண்ணறைச் சுட்டியை 
நகர்த்தி அல்லது அந்த நுண்ணறையைக் கிளிக் 
செய்து அதை செயற்படு நுண்ணறையாக (Active 
Cell) மாற்ற வேண்டும். இதில் தேவையான 
தரவுகளைப் பயனர் தட்டச்சு செய்யலாம். பயனர் 
தரவினை பின்னர், எந்த ஒரு தரவையும் தட்டச்சு 
செய்ய த�ொடங்கலாம். தரவை நுண்ணறையில் 
தட்டச்சு செய்யும் ப�ொழுது அது எந்த வகை 
தரவினம் என்பதை அறிந்து க�ொள்ளும் திறன் 
அட்டவணைச்செயலிக்கு உள்ளது.

தரவு வகைகள்

	 தரவுகள் பல வகைப்படும். தரவுகள் 
எண்களாகவ�ோ, எழுத்துக்களாகவ�ோ தேதி 
மற்றும் நேரம் ப�ோன்றவையும் மற்றொரு வகை 
தரவு இனமாகும். ப�ொதுவாக தரவு வகைகளைப் 
பின்வருமாறு பிரிக்கலாம்.

எழுத்து தரவினம் (Alphabetic data type) - 
எழுத்துக்களை மட்டும் க�ொண்டிருக்கும்

எண்ணுரு தரவினம் (Numeric data type)- 

எண்களை மட்டும் க�ொண்டிருக்கும் (முழு 
எண்கள் அல்லது மிதப்புப் புள்ளி எண்கள்)

எண்ணெழுத்து தரவினம் (Alphanumeric 
data type) - எழுத்துக்கள் மற்றும் எண்களின் 
த�ொகுப்பு

தேதி தரவினம் (Date data type) - தேதிகளை 
மட்டுமே க�ொண்டிருக்கும்.

நேரம் தரவினம் (Time data type) - நேரத்தை 
மட்டுமே க�ொண்டிருக்கும்.

9.4.1.1 எண்களை உள்ளிடுதல்

	 எந்த எண்ணுரு தரவுகளையும் 
அட்டவணைத்தாளில் உள்ளிட முடியும். 
உள்ளிடப்படும் எண்கள் க�ொடாநிலையாக 
நுண்ணறையில் வலது பக்க இசைவில் தான் 
அமையும். ஒரு எண்ணை எதிர்மறை எண்ணாக 
உள்ளிட, அதன் முன்னொட்டாக எதிர்மறை 
குறியீட்டை (-) பயன்படுத்தலாம் அல்லது அந்த 
எண்ணை அடைப்புக்குறிக்குள் ( ) க�ொடுக்கலாம். 
அடைப்புக்குறிக்குள் ஒரு நேர்மறை எண் 
உள்ளிடப்பட்டால், அது எதிர்மறை எண்ணாக 
மாற்றபட்டு அதன் முன்னொட்டாக (–) குறியீடு 
சேர்க்கப்படும். ஏதேனும் ஒரு எண் சுழியத்தில் 
(0) த�ொடங்கினால், கால்க் அதன் சுழியத்தை 

நீக்கிவிடும். (படம் 9.12 காண்க)

படம் 9.12 தரவுகளை உள்ளீடல்

9.4.1.2 உரையை உள்ளிடுதல்

	 கால்க்-ல் எண்களைப் ப�ோல் எந்த ஒரு 

எழுத்துருவையும் தரவாக உள்ளீடு செய்ய முடியும். 

உள்ளீடு செய்யப்பட்ட உரை க�ொடாநிலையாக 

நுண்ணறையின் இடது இசைவில் தான் அமையும். 

ஏதேனும் ஒரு எண்ணுரு உள்ளீடு செய்யப்பட்டு, 

அது நுண்ணறையின் இடது பக்க இசைவில் 

இருத்தப்பட்டால், உள்ளீடு செய்யப்பட்ட எண்ணை 

கால்க் ஒரு எண்ணுருவாக கருதவில்லை 

என புரிந்துக�ொள்ளலாம். ஒரு எண்ணுருவை, 

எழுத்துருவாக மாற்ற, உள்ளிடப்படும் எண் ஒற்றை 

மேற்கோள் குறியுடன் த�ொடங்க வேண்டும்.  (படம் 

9.13 காண்க)
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படம் 9.13 உரையை உள்ளிடுதல்

9.4.1.3 தேதி மற்றும் நேரம் உள்ளிடுதல்

	 ஒபன் ஆஃபீஸ் கால்க்-ல் தேதியை 
உள்ளீடு செய்வதற்கு முன், கணிப்பொறியின் 
அமைப்பு தேதி வடிவமைப்பை (System date 
format) உறுதி செய்து க�ொள்ளவேண்டும்.  
ஏனெனில், கால்க் கணிப்பொறி அமைப்பு தேதி 
வடிவமைப்பில் மட்டுமே உள்ளிடப்படும் தேதியை 
ஏற்றுக் க�ொள்ளும். கணிப்பொறி, அமெரிக்க 
தேதி வடிவமைப்பை (மாதம்-தேதி-ஆண்டு) 
க�ொண்டிருந்தால், அதே வடிமைப்பில் அதாவது, 
MM/DD/YY என்று தான் கால்க்-ல் தேதி 
உள்ளிடப்பட வேண்டும். ஒருவேளை கணிப்பொறி 
இந்திய தேதி வடிவமைப்பில் இருந்தால், 
DD/MM/YY என்று தேதி உள்ளிடப்பட 
வேண்டும். கால்க் கணிப்பொறியின் நடப்பு 
தேதி முறைமையை மட்டுமே ஏற்றுக்கொள்ளும் 
என்பதை நினைவில் க�ொள்க. 

எடுத்துக்காட்டாக: உமது கணிப்பொறியின் 
தேதி வடிவம் அமெரிக்க முறையில் இருந்தால் 
18 டிசம்பர் 2017-யை உள்ளீடு செய்ய 12/18/17 
என்று உள்ளிட வேண்டும். சரியான முறையில் 
உள்ளிடப்பட்ட தேதி அந்த நுண்ணறையின் வலது 
இசைவில் அமையும். அந்த நுண்ணறையில், 
நுண்ணறை சுட்டியை க�ொண்டு சென்றால்  
வாய்ப்பாடு பட்டையில் உள்ளிடப்பட்ட தேதி 
“12/18/2017” என்று த�ோன்றும். உள்ளிடப்பட்ட 
தேதியை கால்க் ஏற்றுக்கொண்டதா இல்லையா 
என்பதை அறிந்துக�ொள்ளமுடியும்.

	 Cell Formatting உரையாடல் பெட்டியின் 

மூலம் தேதி வடிவமைப்பை மற்ற ஏற்கத் தகும் 

வடிவுக்கு மாற்றலாம்.(படம் 9.14 காண்க)

படம் 9.14 தேதி உள்ளிடல்

	 தேதியை ப�ோலவே, நேரத்தை கால்க் 

HH:MM:SS என்ற ப�ொது வடிவில் தான் உள்ளிட 

வேண்டும். இதில் HH என்பது மணி, MM என்பது 

நிமிடம், SS என்பது ந�ொடி என்பதைக் குறிக்கும்.

பல விதமான தேதி வடிவங்கள்

வடிவமைப்பு நாடுகள்

DD/MM/YYYY
ஆசியா (மத்திய, தென்மேற்கு, மேற்கு) ஆஸ்திரேலியா, நியுஸிலாந்து, 
ஐர�ோப்பாவின் சில பகுதிகள், இலத்தீன் அமெரிக்கா, வடக்கு ஆப்ரிக்கா, 
இந்தியா, இந்தோனேஷியா, வங்கதேசம் மற்றும் ரஷ்யா. 

YYYY/MM/DD
பூட்டான், கனடா, சீனா, க�ொரியா, தைவான், ஹங்கேரி, ஈரான், ஜப்பான், 
லித்துவேணியா, மங்கோலியா.

MM/DD/YYYY
அமெரிக்க ஐக்கிய நாடுகள், மைக்ரோநேசியா மாநிலங்கள் கூட்டரசு, மார்சல்  
தீவுகள்.

DD/MM/YYYY 
மற்றும்

MM/DD/YYYY

மலேசியா, நைஜிரியா, பிலிப்பைன்ஸ், சவுதி அரேபியா, ச�ோமாலியா மலேசியா, 
நைஜிரியா, பிலிப்பைன்ஸ், சவுதி அரேபியா, ச�ோமாலியா

DD/MM/YYYY
மற்றும்

YYYY/MM/DD

ஆப்கானிஸ்தான், அல்பேனியா, ஆஸ்தியா, ஜெர்மனி, செக் குடியரசு, கென்யா, 
மக்காவ், மாலத் தீவுகள், நமீபியா, நேபாளம், சிங்கப்பூர், தென் ஆப்பிரிக்கா, 
இலங்கை, சுவீடன்.
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9.5 வாய்ப்பாடுகளை உருவாக்குதல்
	 அட்டவணைத்தாளில் தரவுகளை உள்ளிட்ட 
பிறகு, வாய்பாடுகளைப் பயன்படுத்தி அதன் மீது 
கணக்கீடுகளைச் செய்யலாம். வாய்ப்பாடுகளை 
உருவாக்குவதற்கு, முதலில் அதன் கட்டளை 
அமைப்பை (Syntax) தெரிந்து க�ொள்ள வேண்டும். 
	 கால்க்–ல்  வாய்ப்பாடுகளை இரு 
முறைகளில் உள்ளீடலாம், நுண்ணறையில் 
நேரடியாக உள்ளிடலாம் (அ) வாய்பாடு பட்டையில் 
உள்ள உள்ளீடுத்தாரையில் உள்ளிடலாம். கால்க்–ல் 
உள்ளிடப்படும் வாய்ப்பாடுகள் = அல்லது + அல்லது 
- குறியுடன் த�ொடங்கி மதிப்புகள், செயற்குறிகள் 
மற்றும் நுண்ணறை முகவரிகளுடைய த�ொகுப்பாக 
அமையும்.
	 வாய்பாடுகள் = அல்லது + அல்லது 
– குறியீட்டுடன் த�ொடங்கலாம் எனினும், = 
(சமக்குறியுடன்) த�ொடங்குவது சிறந்த முறையாகும். 
இந்தப் பாடத்தில், அனைத்து வாய்பாடுகளும், 
செயற்கூறுகளும் = குறியுடன் தான் த�ொடங்கும். 
ஏதேனும் ஒரு வாய்ப்பாடு + அல்லது - குறியுடன் 
த�ொடங்கினால், அதன் த�ொடக்க மதிப்பு நேர்மறை 
அல்லது எதிர்மறை எண்ணாக கருதப்படும்.
9.5.1 செயற்குறிகள் (Operators):
	 கணித, புள்ளியியல் மற்றும் தருக்க 
செயல்பாடுகளைச் செய்வதற்கான குறியீடுகள் 
“செயற்குறிகள்” எனப்படும். மதிப்புகள், 
செயற்குறிகள் மற்றும் நுண்ணறை பார்வையிடல்கள் 
(நுண்ணறை முகவரி) ஆகியவற்றின் 
சேர்மானம் “க�ோவைகள்” (Expressions) 
என்று அழைக்கப்படுகின்றன. ஒபன் ஆஃபீஸ் 
கால்க் பல்வேறு வகையான செயற்குறிகளைக் 
க �ொ  ண் டு ள்ள  து . 
(1)	 எண்கணித செயற்குறிகள் (Arithmetic 
Operators)
(2)	 ஒப்பீட்டுச் செயற்குறிகள் (Relational 
Operators)
(3)	 பார்வையிடு செயற்குறிகள் (Reference 
Operators)
(4)	 உரை செயற்குறிகள் (Text Operators)
9.5.1.1 எண்கணித செயற்குறிகள்:
	 எளிய எண்கணித செயல்பாடுகளான 
கூட்டல், கழித்தல், பெருக்கல், வகுத்தல் 
ப�ோன்றவற்றை செய்வதற்கான குறியீடுகள் 
எண்கணித செயற்குறிகள் ஆகும். இந்த 
செயற்குறிகள் ஒரு எண் மதிப்பை விடையாக 
அ ளி க் கு ம் . 

A B C D E F

1

செ
ய

ற்
கு

றி

செ
ய

ற்
கு

றி
யி

ன்
 

பெ
ய

ர்

நெ
டு

வ
ரி

சை


 

C
-யி

லு
ள்ள


 ம

தி
ப்பு

 D
-யி

லு
ள்ள


 ம

தி
ப்பு

E-
யி

லு
ள்ள


 

வ
ாய

்ப்பா
டு

F-
யி

லு
ள்ள


 வி

டை


 

ம
தி

ப்பு

2 + கூட்டல் 98 25 = B2 + C2 123
3 - கழித்தல் 125 25 = B3 – C3 100
4 * பெருக்கல் 25 5 = B4 * C4 125
5 / வகுத்தல் 90 10 = B5 / C5 9
6 ^ அடுக்கு 25 2 = B6 ^ C6 625
7 % சதவீதம் 600 = B7 * 35% 72
8 சதவீதம் (%) செயற்குறி, க�ொடுக்கப்பட்ட 

தரவுக்கான விடையை சதவீதமாக தரும்.
அட்டவணை 9.1 எண்கணித செயற்குறிகள்

	 பயனர் நுண்ணறையில் ஒரு 

வாய்பாட்டைத் தட்டச்சு செய்து, Enter 

ப�ொத்தானை அழுத்திய பிறகு, நுண்ணறையில் 

கணக்கீட்டின் மதிப்பு த�ோன்றும். ஆனால்,  

வாய்பாட்டை பயனர் நுண்ணறையில் 

உண்மையில் தட்டச்சு செய்த வாய்பாட்டை 

மட்டுமே காட்டும். (படம் 9.15 காண்க)

உள்ளீடப்பட்ட வாய்பாடு

படம் 9.15 சதவீத செயற்குறி

9.5.1.2 ஒப்பீட்டுச் செயற்குறி

	 இரண்டு அல்லது அதற்கு மேற்பட்ட 

மதிப்புகள் சமமானதா, பெரியதா, சிறியதா  ப�ோன்ற 

தருக்க செயல்பாடுகளுக்காக மதிப்புகளை 

ஒப்பிட பயன்படும் செயற்குறிகள் ஒப்பீட்டு 

செயற்குறிகள் ஆகும். ஒப்பீடு என்ற ப�ொருள் 

தரும் விதமாக ஆங்கிலத்தில் Comparative 
Operator என்றழைக்கப்படும் இச்செயற்குறியை, 
Relational Operator என்றும் அழைக்கலாம். இந்த 

செயற்குறிகள் தருக்க மதிப்புகளான சரி (True) 
அல்லது தவறு (False) என்பதை விடையாகத் தரும்.
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A B C D E F

1
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 உ
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D
 - 

ல்
 உ

ள்ள


 ம
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ப்பு

நெ
டு

வ
ரி

சை


 

E-
யி

லு
ள்ள


 வ

ாய
்ப்பா

டு

நெ
டு

வ
ரி

சை


 

F-
யி

லு
ள்ள


 வி

டை


 ம
தி

ப்பு

2 > விடப் பெரியது 98 100 =B2>C2 FALSE

3 >=
விடப் பெரியது 

அல்லது சமம்
85 72 =B3>=C3 TRUE

4 < விட சிறியது 54 24 =B4<C4 FALSE

5 <=
விட சிறியது 

அல்லது சமம்
55 55 =B5<=C5 TRUE

6 = சமம் 12 12 =B6=C6 TRUE
7 <> சமமின்மை 54 45 =B7<>C7 TRUE

அட்டவணை 9.2 ஒப்பீட்டுச் செயற்குறிகள்

9.5.1.3 பார்வையிடு இயக்கி
	 நுண்ணறைகளின் பரப்பை குறிப்பிட 
பயன்படும் செயற்குறிகள் பார்வையிடு 
செயற்குறிகள் ஆகும். ஒரு நுண்ணறையிலிருந்து, 
மற்றொரு நுண்ணறை வரை த�ொடர்ச்சியாக உள்ள 
நுண்ணறைகளின் த�ொகுப்பே “பரப்பு” (Range) 
எனப்படும். கால்க்-ல் நுண்ணறைகளை குறிப்பிட 
மூன்று வகையான பார்வையிடு செயற்குறிகள் 
உள்ளது. அவையாவன, (1) பரப்பு பார்வையிடு 
செயற்குறி (Range Reference Operator) (2) பரப்பு 
இணைப்பு செயற்குறி (Range Concatenation) 
மற்றும் (3) குறுக்கீடு செயற்குறி (Intersection 
Operator).
(1) பரப்பு பார்வையிடு செயற்குறி:
	 அரைப்புள்ளி ( : ) பரப்பு பார்வையிடு 
செயற்குறி ஆகும். இது ஒரு குறிப்பிட்ட 

நுண்ணறைகளின் பரப்பை குறிக்கப் 
பயன்படுகிறது. இந்த செயற்குறியின் கட்டளை 
அமைப்பு பின்வருமாறு:
த�ொடக்க நுண்ணறை முகவரி (இடது பக்கம் ) :  

இறுதி நுண்ணறை முகவரி (வலது பக்கம்)
	 நேரியல் (Linear) பரப்பாக இருப்பின் 
த�ொடக்க நுண்ணறை முகவரியையும், இறுதி 
நுண்ணறை முகவரியையும் நேரடியாக குறிப்பிட 
வேண்டும். செவ்வக வடிவிலான பரப்பாக இருப்பின், 
த�ொடக்க நுண்ணறை முகவரி என்பது, செவ்வக 
பரப்பின், இடது மேல் ஓர (Upper left corner) 
நுண்ணறையின் முகவரியை குறிக்கும். இறுதி 
நுண்ணறை முகவரி என்பது, அப்பரப்பின் கீழ் 
வலது ஓர (Lower right corner) முகவரியை 
குறிக்கும்.

படம் 9.16  ஒப்பீட்டு செயற்குறிகளை உள்ளிடுதல்
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எடுத்துக்காட்டு:

(அ)	 ஒரு வரி பரப்பு: நுண்ணறைகள் A1, A2, A3, A4, A5 என்பது, A1:A5 என்று குறிப்பிடப்படும். 

(ஆ)	ச ெவ்வக வடிவிலான நுண்ணறைகளின் த�ொகுப்பு: நுண்ணறைகள் A2, A3, A4, ….. B2, B3, 
B4,….D5, D6 என்பன, A2:D6  என்று குறிப்பிடப்படும். A2:D6 என்பதும் ஒரு பரப்பு ஆகும். (படம் 
9.17-யை காண்க)

நுண்ணறைகளின் பரப்பு
தேர்ந்தெடுக்கப்பட்ட நெடுவரிசைகள் 

(உயர்த்திக்காட்டப்பட்டது) 

தே


ர்ந்தெ


டு
க

்கப்ப


ட
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 வ
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க
ள்

 
(உ
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படம் 9.17 தேர்ந்தெடுக்கப்பட்ட நுண்ணறைகளின் பரப்பு

	 மேற்காண் படத்தில் பெயர் பெட்டியில், தேர்ந்தெடுக்கப்பட்ட நுண்ணறைகளின் பரப்பு A2:D6 	
என உள்ளதை காணமுடியும்.
(2) பரப்பு இணைப்பு செயற்குறி

	 டில்டு ( ~ ) என்ற குறியீடு, பரப்பு இணைப்பு செயற்குறியாகும். இது இரண்டு வெவ்வேறு பரப்புகளை 
ஒன்றிணைத்து, கணக்கியல் செயல்பாடுகளை செய்யப் பயன்படுகிறது. இச்செயற்குறியின் கட்டளை 
அமைப்பு பின்வருமாறு:

இடது பரப்பு ~ வலது பரப்பு

reference left ~ reference right
எடுத்துக்காட்டு

	 நுண்ணறை A1 -லிருந்து A6 மற்றும் C3 -லிருந்து F3 வரையும் உள்ள மதிப்புகளின் கூட்டுத் 
த�ொகையை  காண =SUM(A1:A6 ~ C3:F3) என்ற வாய்ப்பாடு பயன்படுத்தப்பட்டுள்ளது.

	 ஒரு குறிப்பிட்ட பரப்பிலுள்ள மதிப்புகளின் கூட்டுத் த�ொகையை காண  SUM என்ற செயற்கூறு 
பயன்படுத்தப்படும். (படம் 9.18 காண்க)

செயற்படு கல முகவரி
(Address of the active cell)

இரண்டு பரப்புகளின் 
கூட்டுத்தொகை

(Sum of two set of values)

படம் 9.18 பார்வையிடு இணைப்பு செயற்குறி

குறிப்பு : SUM என்பது ஒரு குறிப்பிட்ட பரப்பிலுள்ள மதிப்புகளின் கூட்டுத் த�ொகையை கணக்கிடப் 
பயன்படுத்தப்படும் ஒரு செயற்கூற்று ஆகும். (படம் 9.18-யை காண்க) 
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குறுக்கீடு செயற்குறி:

	 இரண்டு பரப்புக் குழுக்களையும் 
இணைக்கும் செயற்குறி, குறுக்கீட்டு செயற்குறி 
ஆகும். இது பரப்பு இணைப்பு செயற்குறியை 
ஒத்தது. ஆச்சரிய குறி (!) குறுக்கீடு 
செயற்குறியாக பயன்படுத்தப்படுகிறது. இந்த 
செயற்குறியின் கட்டளை அமைப்பு பின்வருமாறு: 

இடது பரப்பு ! வலது பரப்பு

எடுத்துக்காட்டு:(A2:D3 ! B2:E4)

A

1

2

3

4

B C D E F

பரப்பு- 1 பரப்பு- 2A2 : D3

A1 B1 C1 D1 E1 F1

A2 B2 C2 D2 E2 F2

A3 B3 C3 D3 E3 F3

A4 B4 C4 D4 E4 F4

B2:D3பரப்பு 1 மற்றும் 2 ஆகியவற்றின் குறுக்கீடு

B2:E4

படம் 9.19 குறுக்கீடு செயற்குறி

(A2:D3!B2:E4) என்பதன் வெளியீடு, B2:D3. என்ற பரப்பிலுள்ள மதிப்புகளை ப�ொறுத்திருக்கும், ஏன்ெனன்றால் 
இந்த இரண்டு பரப்புகளும் A2:D3 மற்றும்  B2:E4 நுண்ணறையில்  உள்ளது. (படம் 9.19 மற்றும் 9.20 காண்க)

படம் 9.20 குறிக்கீட்டு செயற்குறியுடன் வேலை செய்தல்
9.5.1.4 உரை செயற்குறி:

	 ஒபன் ஆஃபீஸ் கால்க்-ல், "&" என்ற குறியீடு உரை செயற்குறியாகும். இரண்டு அல்லது 
அதற்கு மேற்பட்ட உரைகளை ஒன்றாக சேர்க்க இந்த செயற்குறி பயன்படுகிறது. இரண்டு உரைகளை 
ஒன்றாக சேர்த்தல் “உரை இணைத்தல்” (Text Concatenation) எனப்படும். உரை செயற்குறிக்கான 
கட்டளை அமைப்பு பின்வருமாறு: (படம் 9.21 காண்க) 
முதல் உரை உள்ள நுண்ணறை & இரண்டாம் உரை உள்ள நுண்ணறை

படம் 9.21 உரை செயற்குறி
	 எண்கணித செயற்குறிகளை வாய்பாடுகளில் பயன்படுத்தும் ப�ோது, ஒபன் ஆஃபீஸ் கால்க் ப�ொது 
கணக்கியல் க�ோட்பாட்டின் செயற்குறி முன்னுரிமை அடிப்படையில் கணக்கீடுகளைச் செய்யும். ப�ொதுக் 
கணக்கியல் செயற்குறி முன்னுரிமை வருமாறு:

i.	 அடுக்கு (Exponent  ^ )
ii.	 எதிர்நிலையாக்கம் (Negation - )
iii.	 பெருக்கல் மற்றும் வகுத்தல் (Multiplication and Division *, /)
iv.		  கூட்டல் மற்றும் கழித்தல் (Addition and Subtraction +, -)
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வாய்ப்பாட்டை உருவாக்குவதற்கான எடுத்துக்காட்டு:
எடுத்துக்காட்டு 1:
பின்வரும் தரவுகளை ஒரு அட்டவணைச் செயலியில் உள்ளீடு செய்க

Reg. No Name Tam Eng CS Com Acc
12001 Jayashree J 147 136 105 163 162
12002 Kowsalya T 156 148 149 147 179
12003 Muskan S 149 165 123 168 179
12004 Ashia Stephy R 168 144 146 192 167
12005 Vennila T P 199 198 150 200 200
12006 Deepika M 187 141 98 130 178
12007 Tharani J 165 102 100 192 192
12008 Thulasi A 143 169 88 176 173
12009 Ayisha B 120 138 109 182 167
12010 Jenifer A 145 135 95 180 185

	 அட்டவணைச்செயலியில் தரவுகள் தட்டச்சு செய்துமுடிக்கப்பட்ட பின், அட்டவணைத் தாள் 
கீழ்கண்டவாறு த�ோன்றும்.

 

உள்ளிடு செய்யப்பட்ட உரை நெடுவரிசையின் அகலத்தை விட அதிகமாக 
இருப்பின், நெடுவரிசையின் இறுதியில் சிவப்பு நிற முக்கோணம் த�ோன்றும் 

படம் 9.22 அட்டவணைச்செயலி எடுத்துக்காட்டு

9.5.2 வாய்பாட்டை உருவாக்குதல்:
	 ஒரு வாய்ப்பாட்டை உருவாக்கும்போது 
கீழ்காணும் விதிமுறைகளை கவனத்தில் க�ொள்ள 
வே  ண் டு ம் . 
•	 எந்த நுண்ணறையில் விடை வரவேண்டும�ோ, 

அந்த நுண்ணறையில் நுண்ணறை சுட்டி 
இருக்க வேண்டும். 

•	 வாய்ப்பாடுகள் அனைத்தும் = குறியுடன் 
த�ொடங்க வேண்டும். 

•	 ஒரு வாய்ப்பாடு உருவாக்கும் ப�ோது, ப�ொது 
கணக்கியல் விதியான BODMAS விதியை 
நினைவில் க�ொள்க. 

•	 ஒரு வாய்ப்பாட்டை உருவாக்குவதற்கான 
ப�ொது கட்டளை அமைப்பு:

= நுண்ணறை முகவரி1  <செயற்குறி> நுண்ணறை 
முகவரி 2 <செயற்குறி> ……………….
•	 நுண்ணறை முகவரி பார்வையிடல் இரண்டு 

வகை (i) ஒப்பீட்டு நுண்ணறை பார்வையிடல் 
(Relative cell reference) (ii) தனித்த 
நுண்ணறைப் பார்வையிடல் (Absolute Cell 
reference)

•	 ஒரு வாய்ப்பாட்டை உருவாக்கும்போது, ஒரு 
நுண்ணறையின் முகவரியை நேரடியாக 
பயன்படுத்துவது “ஒப்பீட்டு நுண்ணறை 
பார்வையிடல்” (Relative Cell reference) 
ஆ கு ம் .

•	 ஒப்பீட்டு நுண்ணறை பார்வையிடல் 
எ டு த் து க ்காட்   டு : 
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A1, B1, C1, D1 ஆகிய 
நுண்ணறைகளில் 
உள்ள மதிப்புகளின் 
கூட்டுத் த�ொகையை 
க ண க் கி ட .

=A1+B1+C1+D1

E4 லிருந்து H3 யை 
க ழி த ்த ல்

= H3 – E4

B5யுடன் A5யை 
பெ  ரு க ்க ல்

= A5 * B5

G1, G2, G3, G4 
ஆகியவற்றின் சராசரி

=(G1+G2+G3+G4)/4

•	 மேற்கண்ட அட்டவணையில் 
க�ொடுக்கப்பட்டுள்ள அனைத்து 
வாய்பாடுகளிலும், உள்ள நுண்ணறைகள் 
“ஒப்பீட்டு நுண்ணறை முகவரி” என்பதை 
நினைவில் க�ொள்க.

•	 வாய்பாடுகளை உருவாக்கும் ப�ோது, 
நுண்ணறை முகவரியின் நெடுவரிசையின் 
பெயர் மற்றும் வரிசை எண் ஆகியவற்றின் 
முன்னொட்டாக $ குறியீட்டை பயன்படுத்தும் 
ப�ோது, அந்த நுண்ணறைகள் ”தனித்த 
நுண்ணறை முகவரி”-களாக மாற்றம் 
பெறும்.

•	 தனித்த நுண்ணறை முகவரி எடுத்துக்காட்டு:

A1, B1, C1, 
D1 ஆகிய 

நுண்ணறைகளில் 

உள்ள 

மதிப்புகளின் 

கூட்டுத் 

த�ொகையை 

கணக்கிட.

=$A$1+$B$1+$C$1+$D$1

E4 லிருந்து H3 யை 

கழித்தல்
= $H$3 – $E$4

B5யுடன் A5யை 

பெ  ரு க ்க ல்
= $A$5 * B5

G1, G2, G3, G4 
ஆகியவற்றின் 

சராச    ரி

=($G$1+G2+$G$3+G4)/4

•	 ஒரு வாய்பாட்டில் உள்ள அனைத்து 
நுண்ணறை முகவரிகளும், தனித்த 
நுண்ணறைகளாகவ�ோ அல்லது ஒப்பீட்டு 
நுண்ணறைகளாகவ�ோ இருக்க வேண்டிய 

கட்டாயமில்லை. இரண்டு முகவரி 
முறைகளையும் கலந்தும் ஒரு வாய்பாடு 
உ ரு வ ா க ்கப்ப   ட ல ா ம் . 

•	 கீழே க�ொடுக்கப்பட்டுள்ள பகுதி ஒப்பீட்டு 
நுண்ணறை முகவரியின் பயன்பாட்டை 
விளக்குகின்றது. தனித்த நுண்ணறை பற்றி 
பின்பு படிக்கலாம்.

•	 H2 (நெடுவரிசைக்கு) நுண்ணறைக்கு 
சுட்டியை நகர்த்தவும்.

•	 கீழ்காணும் வாய்பட்டை தட்டச்சு செய்து, 
“Enter” ப�ொத்தானை அழுத்தவும்.

= C2+D2+E2+F2+G2 (படம் 9.25 காண்க)
	 இப்போது, நுண்ணறை C2, D2, E2, F2 
மற்றும் G2 ஆகியவற்றில் உள்ள மதிப்புகளின் 
கூட்டுத்தொகை நுண்ணறை H2-ல் த�ோன்றும்.
•	 மேலே உள்ள வாய்பாட்டின் மூலம், 

அட்டவணை செயலி நுண்ணறைகளுடன் 
எவ்வாறு செயலாற்றுகிறது என்பதை 
தெளிவாக அறிந்துக�ொள்ள முடியும்.

•	 ஒரு வாய்பாடு உருவாக்கப்படும் ப�ோது, 
நுண்ணறையில் உள்ள மதிப்பை நேரடியாக 
குறிப்பிடாமல், அந்த மதிப்பை உள்ளடக்கிய 
நுண்ணறையின் முகவரியை குறிப்பிடுவது 
மிகச்சிறந்த வழிமுறையாகும். அவ்வாறு 
ஒரு நுண்ணறையின் முகவரியை 
குறிப்பிடும்போது, அட்டவணைச் செயலி, 
அந்த நுண்ணறையில் உள்ள மதிப்பை 
கணக்கீட்டுக்கு எடுத்துக்கொள்கிறது. 
ஏதேனும் ஒரு சூழலில் நுண்ணறையில் 
உள்ள மதிப்பு மாறும் ப�ோது, அட்டவணை 
செயலி அதன் கணக்கீட்டு விடைகளை 
ம ாற்  றி க ் க ொ ள் ளு ம் . 

	 ம�ொத்த மதிப்பெண் கணக்கிடுவதற்கான 
வாய்பாடு உள்ளீடு செய்யப்பட்ட பின், 
அட்டவணை கீழ்கண்டவாறு த�ோன்றும். (படம் 
9.25 காண்க)

படம் 9.23 அட்டவணைத்தாளில் வாய்ப்பாட்டை 
உருவாக்குதல்

9.6 அட்டவணைத்தாளை சேமித்தல், 
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மூடுதல் மற்றும் மீண்டும் திறத்தல்
9.6.1 அட்டவணைத்தாளை சேமித்தல்:
	 ஒரு அட்டவணைத்தாளை சேமிக்கும் வழிமுறை, முந்தைய பாடத்தில் கற்ற ஒரு ஆவணத்தை 
சேமிக்கும் வழிமுறை ப�ோன்றதே. 
படிநிலை 1: 	 File→Save அல்லது Ctrl + S அல்லது செந்தரக் கருவிப்பட்டையிலுள்ள Save 
பணிக்குறியை கிளிக் செய்க.
படிநிலை 2:	 அட்டவணைச் செயலி முன்னர் சேமிக்கப்படவில்லை எனில், “Save As” உரையாடல் 
பெட்டி த�ோன்றும்.
படிநிலை 3: 	  “File Name” உரைப் பெட்டியில், அட்டவணைச் செயலிக்கு ஒரு பெயரை தட்டச்சு செய்யவும். 
ஒபன் ஆஃபீஸ் கால்க் அட்டவணைச் செயலி .ods என்ற நீட்டிப்புடன் (extension) சேமிக்கப்படும். 
படிநிலை 4:	 “Save” ப�ொத்தானை கிளிக் செய்யவும்.
“Save” ப�ொத்தானை கிளிக் செய்து அட்டவணைச் செயலி சேமிக்கப்பட்ட பின், அதன் பெயர் தலைப்புப் 
பட்டியில் த�ோன்றுவதை காணலாம். (படம் 9.24 காண்க).
குறிப்பு: சேமிக்கப்படும் ஒவ்வொரு க�ோப்பும், க�ொடாநிலையாக “Documents” என்ற க�ோப்புறைகளில் 
சேமிக்கப்படும்.

க�ோப்பு நீட்டிப்பு

	 கணிப்பொறி ஒரு க�ோப்பை எளிதில் அடையாளம் காண  நீட்டிப்பு பயன்படுகிறது. ப�ொதுவாக 

பயன்பாட்டில் உள்ள க�ோப்பு நீட்டிப்புகள் பின்வருமாறு:

பிரபலமான க�ோப்பு வகைகள் நீட்டிப்பு

உரைக் க�ோப்பு  (Text Files) .txt

மைக்ரோசாஃட் வேர்டு ஆவணம் (Microsoft 
Word Documents)

.doc / .docx 

ஒபன் ஆஃபிஸ் ஆவணம் (OpenOffice 
Documents)

.odt

மைக்ரோசாஃட் எக்ஸெல் (Microsoft Excel) .xls / .xlsx
ஒபன் ஆஃபிஸ் கால்க் (OpenOffice Calc) .ods
மைக்ரோசாஃட் பவர்பாய்ண்ட் (Microsoft 
PowerPoint)

.ppt / .pptx

ஒபன் ஆஃபீஸ் இம்ப்ரெஸ் (OpenOffice 
Impress)

.odp

இயங்கு க�ோப்புகள்/ பயன்பாடுகள் 
(Executable Files / Applications)

 .exe

இணைய பக்கங்கள் (Web Pages) .htm / .html
ப�ோர்ட்டபல் டாக்குமெண்ட் ஃபார்மெட் 
(Portable Document Format)

.pdf

டிஜிட்டல் புகைப்படங்கள் (Photos)
.jpg / .jpeg (Joint Photographic Experts 
Group)

அசைவுப்படங்கள் (Animated Images) .gif (Graphical Image Format)

ஒலிக் க�ோப்புகள் (Audio) .mp3

ஒலி / ஒளிக் க�ோப்புகள் (Audio / Video) .mp4
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க�ோப்பின் பெயர் பயன்பாட்டின் பெயர்

படம் 9.24  சேமிக்கப்பட்ட அட்டவணைச்செயலி

சேமிக்கப்பட்ட க�ோப்பு தானாகவே "Document folder" -ல் இருத்தப்படும்.

குறிப்பு

உங்களுக்குத் தெரியுமா?

சேமித்தல் என்றால் என்ன?

முதன்மை நினைவகத்திலுள்ள தகவல்களை, வன்வட்டு, பென் டிரைவ், மெமரி 

சிப் ப�ோன்ற இரண்டாம் நிலை நினைவகத்திற்கு மாற்றம் செய்யும் செயல்நுட்பம் 

சேமித்தல் எனப்படும். 

9.6.2 தானியங்கு சேமித்தல் (Auto Save)
	 ஓபன் ஆஃபீஸ் ஒரு க�ோப்பை, குறிப்பிட்ட கால இடைவெளியில் சேமிக்கும் வசதியை 
க�ொண்டுள்ளது, இது தானியங்கு சேமித்தல் என்று அழைக்கப்படுகிறது. க�ொடாநிலை தானியங்கு 
சேமிப்புக்கான கால இடைவெளி 15 நிமிடங்களாகும். இந்த கால இடைவெளியை மேலும் குறைக்க 
முடியும். எதிர்பாரா விதமாக கணிப்பொறியின் இயக்கம் தடைபடும் ப�ோது, இந்த வசதி க�ோப்புகளை 
அழிவிலிருந்து காக்கின்றது. 
9.6.3 அட்டவணைத்தாளை மூடுதல்:
	 ஒரு அட்டவணைத் தாள் சேமிக்கப்பட்டாலும், அது திறந்தே இருக்கும். எனவே, அதில் த�ொடர்ந்து 
வேலை செய்யலாம். வேலை முடிவுற்றதும், File→Save அல்லது Ctrl + S அல்லது Save பணிக்குறியை 
கிளிக் செய்து, சேமித்த பின்னர் File→Close அல்லது Ctrl + W பயன்படுத்தி அட்டவணைத்தாளை 
முறையாக மூட வேண்டும்.
9.6.4 ஏற்கனவே உள்ள அட்டவணைத்தாளை திறத்தல்:
9.6.4.1 Open உரையாடல் பெட்டியை பயன்படுத்துவது
	 ஏற்கனவே உருவாக்கப்பட்ட ஒரு அட்டவணைத்தாளை மீண்டும் திறப்பதற்கு File → Open 
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கட்டளை அல்லது Open பணிக்குறி அல்லது Ctrl + O ஆகிய ஏதேனும் ஒன்றை பயன்படுத்தலாம். 
அவ்வாறு செய்யும் ப�ோது, படம் 9.25ல் காட்டப்பட்டுள்ளவாறு Open உரையாடல் பெட்டி த�ோன்றும். இது 
Save As உரையாடல் பெட்டியை ப�ோன்றே இருக்கும். 
	 இந்த உரையாடல் பெட்டியிலிருந்து, திறக்கப்பட வேண்டிய க�ோப்பை பட்டியலிலிருந்தோ அல்லது 
எந்த க�ோப்புறையில் அந்த அட்டவணைத்தாள் சேமிக்கப்பட்டுள்ளத�ோ அங்கிருந்து அதனை தேர்வு 
செய்து திறக்க வேண்டும். 

தானமைவு க�ோப்புறை

க�ோப்புகள் மற்றும் 
க�ோப்புறைகள்

Read only 
தேர்வுகள்

படம் 9.25 Open உரையாடல் பெட்டி

9.6.4.2 Recent Document தேர்வை பயன்படுத்துவது

	 ஒபன் ஆஃபீஸ் சமீபமாக திறக்கப்பட்ட க�ோப்புகளின் விவரங்களை பதிவு செய்துவைக்கும். இந்த 
வசதியைப் பயன்படுத்தியும், ஏற்கனவே உள்ள அட்டவணைத்தாளை திறக்க முடியும். இவ்வசதி மூலம் 
ஒரு க�ோப்பை திறக்க, File→Recent Document என்ற தேர்வை கிளிக் செய்ய வேண்டும். படம் 9.26ல் 
காட்டப்பட்டுள்ளபடி சமீபத்தில் திறக்கப்பட்ட க�ோப்புகளின் பட்டியல் த�ோன்றும். 

சமீபத்தில் திறக்கப்பட்ட 
ஆவணங்கள்

படம் 9.26 சமீபத்தில் திறக்கப்பட்ட ஆவணங்களின் பட்டியல்

9.7 நகலெடுத்தல், வெட்டுதல் மற்றும் ஒட்டுதல்
9.7.1 தரவை நகலெடுத்து ஒட்டுதல்:
•	 நகலெடுக்க வேண்டிய நுண்ணறைகளை தேர்வு செய்க.
•	 Edit → Copy அல்லது செந்தர கருவிப்பட்டையில் உள்ள “Copy” பணிக்குறியை கிளிக் செய்க 

அல்லது விசைப்பலகையில் Ctrl+C சாவி சேர்மானத்தை அழுத்துக.
•	 நகலெடுக்கப்பட்டவை எந்த நுண்ணறையில் ஒட்டப்பட வேண்டும�ோ, அந்த நுண்ணறைக்கு 

நுண்ணறை சுட்டியை நகர்த்தவும்.
•	 Edit → Paste அல்லது கருவிப்பட்டையில் உள்ள “Paste” பணிக்குறியை கிளிக் செய்யவும். அல்லது 

விசைப்பலகையில் Ctrl+V சாவி சேர்மானத்தை அழுத்தவும்.

Chapter 9.indd   156 20-04-2020   15:59:23



157

9.7.2 தரவை வெட்டி ஒட்டுதல்:
•	 வெட்டப்பட வேண்டிய நுண்ணறைகளை தேர்வு செய்க.
•	 Edit → Cut அல்லது செந்தர கருவிப்பட்டையில் உள்ள “Cut” பணிக்குறியை கிளிக் செய்க அல்லது 

விசைப்பலகையில் Ctrl+X சாவி சேர்மானத்தை அழுத்துக.
•	 வெட்டப்பட்டவை எந்த நுண்ணறையில் ஒட்டப்பட வேண்டும�ோ, அந்த நுண்ணறைக்கு நுண்ணறை 

சுட்டியை நகர்த்தவும்.
•	 Edit → Paste அல்லது கருவிப்பட்டையில் உள்ள “Paste” பணிக்குறியை கிளிக் செய்யவும். அல்லது 

விசைப்பலகையில் Ctrl+V சாவி சேர்மானத்தை அழுத்தவும்.
9.7.3 வாய்ப்பாட்டை நகலெடுத்து ஒட்டுதல்:
•	 ஒரு தரவை நகலெடுத்து ஒட்டுவதற்கு என்னென்ன வழிமுறைகள் பின்பற்றப்பட்டத�ோ, அதே 

வழிமுறை தான், ஒரு வாய்ப்பாட்டை நகலெடுத்து ஒட்டுவதற்கும் பின்பற்றப்பட வேண்டும். 
	 ஒரு வாய்ப்பாட்டை ஒரு நுண்ணறையிலிருந்து மற்றொரு நுண்ணறையில் நகலெடுத்து 
ஒட்டும்போது, நகலெடுக்கப்பட்ட வாய்பாட்டின் நுண்ணறை முகவரி, ஒட்டப்பட்ட நுண்ணறையின் 
முகவரியாக மாற்றம் பெறும். இதற்கு “ஒப்பீட்டு நுண்ணறை பார்வையிடல்” என்று பெயர். (படம் 9.27  
காண்க.) எடுத்துக்காட்டு:

நுண்ணறை D2ல் ஒட்டப்படும் ப�ோது = B3* C3 என மாற்றம்பெறும்

நுண்ணறை D2ல் தட்டச்சு செய்யப்பட்ட வாய்ப்பாடு = B2*C2

வரிசை எண்

படம் 9.27 வாய்ப்பாட்டை நகலெடுத்து ஒட்டுதல்

9.7.4 ஒரு நுண்ணறையில் நகலெடுத்து, ஒன்றுக்கும் மேற்பட்ட நுண்ணறைகளில் ஒட்டுதல்:
(எடுத்துக்காட்டு 1க்கு படம் 9.23 காண்க.)
படிநிலை 1:	 விசைப்பலகையில் Ctrl + C சாவி சேர்மானத்தை அழுத்திய�ோ அல்லது பட்டிப் பட்டையில் 
Edit → Copy என்ற கட்டளையைக் கிளிக் செய்தோ அல்லது செந்தர கருவிப்பட்டையில் (standard) 
Copy பணிக்குறியைக்  கிளிக் செய்தோ, நுண்ணறை H2-ல் உள்ள வாய்பாட்டை நகலெடுக்கவும்.

 

படம் 9.28 நுண்ணறையில் நகலெடுத்து, ஒன்றுக்கு மேற்பட்ட நுண்ணறை ஒட்டுதல் 
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படிநிலை 2:	ம�ொ த்த மதிப்பெண் கணக்கிடப்பட வேண்டிய, H3 முதல் H11 வரையுள்ள நுண்ணறை 
பரப்பைத் தேர்வு செய்க.
படிநிலை 3:	 Ctrl + V அல்லது Edit →Paste அல்லது Paste பணிக்குறி, இவற்றில் ஏதேனும் ஒன்றை 
பயன்படுத்தி, நுண்ணறை H2-ல், நகலெடுக்கப்பட்ட வாய்ப்பாட்டை ஒட்டவும். 

1.	 எடுத்துக்காட்டு 1ல் உருவாக்கப்பட்ட அட்டவணைச்செயலியைத் திறந்துக�ொள்ளவும்.
2.	நெ டுவரிசை I1ல் “Average” என்ற புதிதாக ஒரு நெடுவரிசை தலைப்பைச் சேர்க்கவும்.
3.	 I2 ல் மதிப்பெண்களின் சராசரியைக் கணக்கிட வாய்பாடு ஒன்றை உருவாக்கவும்.
4.	 I2ல் உருவாக்கப்பட்ட வாய்பாட்டை மற்ற அனைத்து நுண்ணறைகளுக்கும் நகலெடுத்து 

ஒட்டுக. 
5.	 மாற்றங்களைச் சேமித்து, க�ோப்பை மூடவும். 

செய்முறை பயிற்சி:

9.8 தானியங்கு நிரப்பு வசதி: 
	 இதுவரை ஒரு நுண்ணறையிலிருந்து, மற்றொரு நுண்ணறைக்கு எவ்வாறு நகலெடுத்து ஒட்டுவது 
என்பதைப் பற்றி அறிந்துக�ொண்டீர்கள். ஒரு நுண்ணறையிலுள்ள தரவுகளையும், வாய்பாடுகளையும் 
நகலெடுத்து, மற்ற நுண்ணறைகளைத் தேர்வு செய்து அதில் ஒட்டுவதற்கு மாற்றாக, தானியங்கு நிரப்பு 
வசதி (Auto Fill feature) பயன்படுகிறது.  
	தா னியங்கு நிரப்பு வசதியின் மூலம், ஒரு நுண்ணறையில் உள்ள தரவுகள் அல்லது வாய்பாடுகளை, 
மற்ற நுண்ணறைகளில் நிரப்ப, வாய்பாடு உள்ளிடப்பட்ட நுண்ணறையில் நுண்ணறைச் சுட்டியை இருத்தி, 
அதன் “Drag fill handle” என்றழைக்கப்படும் பகுதியை மற்ற நுண்ணறைகளின் மீது மேலிருந்து 
கீழாகவ�ோ அல்லது இடமிருந்து வலமாகவ�ோ இழுக்க வேண்டும். 

இழுத்து நிரப்புதல் புள்ளி
 (Drag Fill Handle)

படம் 9.29 இழுத்து நிரப்புதல் புள்ளி

	 அவ்வாறு செய்யும் ப�ோது, இழுக்கப்படும் வாய்பாடு, ஒப்பீட்டு நுண்ணறை முகவரியை 
க�ொண்டிருப்பின், முன்னர் விவரிக்கப்பட்டது ப�ோல, வாய்பாடு, அனைத்து நுண்ணறைகளிலும் அந்தந்த 
வரிசைகளுக்கு ஏற்ப வாய்பாட்டின் நுண்ணறை முகவரியும் மாறிவிடும். 
	 நுண்ணறைகளின் மீது கிளிக் செய்து இழுப்பதற்கு பதிலாக, நுண்ணறைகளைத் தேர்ந்தெடுத்து 
Edit → Fill  →Down அல்லது Edit → Fill → Right பயன்படுத்தலாம்.

9.8.1 தானியங்கு எண் வரிசை நிரப்பி (Auto Fill Series)
	 தானியங்கு நிரப்பு வசதி எண் வரிசைகளை உருவாக்கவும் பயன்படுகிறது. எடுத்துக்காட்டாக, 
1,2,3 ……. என எண் வரிசையை உருவாக்க, நுண்ணறைச் சுட்டியின் Drag fill handle-யை இழுத்தாலே 
ப�ோதும். 
	 முழு எண் வரிசையை உருவாக்குதல்:
படிநிலை 1:	 நுண்ணறை A1ல் 1 என தட்டச்சு செய்து Enter ப�ொத்தானை அழுத்துக.
படிநிலை 2:	 மீண்டும் நுண்ணறை சுட்டியை A1க்கு நகர்த்தவும்.
படிநிலை 3:	 நுண்ணறை சுட்டியின் Drag fill handle –லின் மீது சுட்டி அம்புக்குறியை வைக்க 

வேண்டும். இப்போது சிறிய + குறி த�ோன்றும்.
படிநிலை 4:	 இப்போது, நுண்ணறை சுட்டியின் Drag fill handle-யை கீழ்நோக்கி இழுக்க வேண்டும். 

அவ்வாறு செய்யும்போது ஒவ்வொரு நுண்ணறையிலும் நிரப்பப்படும் மதிப்பு நுண்ணறை சுட்டியின் 
வலது பக்கத்தில் படம் 9.29 ல் உள்ளவாறு த�ோன்றும்.
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படிநிலை 5:	தேவை யான எண் வரிசை த�ோன்றிய பின், சுட்டியை இழுப்பதை விட்டுவிடவும். 

இழுத்து 
நிரப்புதல் புள்ளி 

இழுக்கப்பட்ட 
நுண்ணறைகள்

உருவாக்கப்பட்ட எண் வரிசை

படம் 9.30 தானியங்கு எண்வரிசை நிரப்பி

9.8.2 Edit → Fill → Series கட்டளையை பயன்படுத்தி எண் வரிசையை உருவாக்குதல்:
	 Edit → Fill → Series கட்டளை, பல்வேறு எண் வரிசைகளை உருவாக்க பயன்படுகிறது. இந்த 
வசதியை பயன்படுத்துவதற்கு முன் தேவையான நுண்ணறைகள் தேர்வு செய்யப்பட வேண்டும். இந்த 
முறையில், கீழிருந்து மேலாக, மேலிருந்து கீழாக, வலமிருந்து இடமாக, இடமிருந்து வலமாக என எல்லா 
திசைகளிலும் எண் வரிசைகளை உருவாக்க முடியும். (படம் 9.31 காண்க)

Direction:	 Down / Right/Up / Left என்ற நுண்ணறைத் தேர்வின் திசையை தேர்வு செய்ய வேண்டும்.

Series type : 
Linear: 	கூட்டுத்தொகை த�ொடர்களை உருவாக்க இந்த தேர்வை கிளிக் செய்ய வேண்டும். 

(எடுத்துக்காட்டாக: 2, 4, 6, 8, 10,……….)
Growth: 	பெ ருக்கல் த�ொகை த�ொடர்களை உருவாக்க இந்த தேர்வை கிளிக் செய்ய வேண்டும். 
(எடுத்துக்காட்டாக: 2, 4, 8, 16, 32, 64 ……….)
Date:	தே தித் த�ொடர்களை உருவாக்க இதனை தேர்வு செய்ய வேண்டும். இந்த தேர்வை தேர்வு 
செய்தவுடன், Time unit என்ற பிரிவு தரவு உள்ளீட்டு நிலைக்கு மாறும் (Enabled).
AutoFill:	த�ொ டர்ச்சியான எண் மதிப்புகளை உருவாக்க இந்த தேர்வை தேர்வு செய்ய வேண்டும். 
இந்த தேர்வை தேர்ந்தெடுத்தவுடன், Time unit, End value மற்றும் Increment ப�ோன்ற பிரிவுகள் தரவு 
உள்ளிட முடியாத நிலைக்கு மாற்றம் பெறும் (Disabled).
Time Unit: Date தேர்வை தேர்ந்தெடுக்கும் ப�ோது மட்டுமே இந்த பிரிவு உள்ளீட்டு நிலைக்கு மாறும்.

Day		  :	நா ள் வாரியான தேதித் த�ொடர்களை உருவாக்க

Weekday		  :	 வார இறுதியை மையமாகக் க�ொண்ட த�ொடர்களை உருவாக்க.

Month		 : 	 மாத வாரியான தேதித் த�ொடர்களை உருவாக்க

Year		  :	 ஆண்டுவாரியான தேதித் த�ொடர்களை உருவாக்க

Start Value: 
•	 உருவாக்கப்பட வேண்டிய த�ொடரின் த�ொடக்க மதிப்பு

End Value:
•	 த�ொடரின் இறுதி மதிப்பு

•	 இறுதி மதிப்பை உள்ளிடவில்லை எனில், தேர்வு செய்யப்பட்ட நுண்ணறைகளின் பரப்பின் கடைசி 
நுண்ணறை வரை த�ொடர் உருவாக்கப்படும்.
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படம் 9.31  Fill series உரையாடல் பெட்டி
•	 க�ொடுக்கப்படும் இறுதி மதிப்பை விட குறைவான எண்ணிக்கையிலான நுண்ணறைகள் தேர்வு 

செய்யப்பட்டிருப்பின், தேர்வு செய்யப்பட்ட நுண்ணறைகளில் மட்டுமே த�ொடர் உருவாகும்.
Increment:
•	 ஒரு த�ொடரின் முதலாவது மதிப்பிற்கும், இரண்டாம் மதிப்பிற்கும் இடையே உள்ள வேறுபடும் 

மதிப்பு Increment எனப்படும். அத்தொடரின் மூன்றாவது மதிப்பு, இந்த முதல் இரண்டு மதிப்புகளின் 
வித்தியாச மதிப்பின் அடிப்படையிலேயே உருவாகும்.

இறங்குவரிசை எண் த�ொடர்களை உருவாக்க, Increment மதிப்பை எதிர்மறை எண்ணாக வழங்க 
வேண்டும். 

(அ) 2 முதல் 20 வரையான எண்களில் உள்ள 
இரட்டைப்படை எண்களின் த�ொடர் 
ஒன்றை உருவாக்குக.

(ஆ) 5, 10, 15, 20 ……. எனத் 
தேர்ந்தெடுக்கப்பட்டுள்ள 
நுண்ணறைகளின் அளவுக்கு 
த�ொடர் மதிப்புகளை உருவாக்குக.

(இ) 2, 4, 8, 16 ……… 2048 வரையான எண் 
த�ொடர் உருவாக்குக.

(ஈ) 33, 30, 27 ……….. 3 வரையான எண் 
த�ொடர் உருவாக்குக.

(உ) இன்று வெள்ளிக்கிழமை என்று 
கற்பனை செய்து, இன்றைய 
தேதியை உள்ளிட்டு, அடுத்த 25 
வெள்ளிக்கிழமைகளின் தேதிகளை 
க ண்ட  றி க .

செய்முறை பயிற்சி:

9.8.3 தேதிக் கணக்கீடு

	 கைவழி தேதிக் கணக்கீடு மிகவும் சிக்கலான ஒரு செயலாகும். ஏனெனில், ஒவ்வொரு மாதத்திற்கும் 
எத்தனை நாட்கள் என்பதை நினைவில் க�ொள்ள வேண்டும். அட்டவணை செயலியில் தேதிக்கணக்கீடு 
மிகவும், எளிய ஒரு செயல்முறையாகும். அட்டவணைச் செயலியில், ஒரு தேதியுடன், ஒரு எண்ணைக் 
கூட்டி, புதிய ஒரு தேதியை உருவாக்க முடியும். அதே ப�ோல இரண்டு தேதிக்கு இடையே உள்ள ம�ொத்த 
நாட்களின் எண்ணிக்கையை காணமுடியும். மேலும், பல்வேறு தேதி கணக்கீட்டு செயற்கூறுகளும் 
அட்டவணை செயலில் உள்ளது.

	 எடுத்துக்கட்டாக, A2 என்ற நுண்ணறையில் 02/06/2018 என்று உள்ளிடவும். உள்ளிடப்பட்ட இந்த 
தேதியிலிருந்து 80 நாட்களுக்கு பிறகு என்ன தேதி என்பதை கண்டறிய, =A2 + 80 என்ற வாய்பாட்டை 
A4 நுண்ணறையில் பயன்படுத்தினால், 05/17/18 என்று விடை வரும்.
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தேதி 05/17/18 நுண்ணறையில் த�ோன்றும்.

நீவீர் பிறந்து எத்தனை நாட்கள் 
ஆனது? கண்டுபிடி
•	 முதல் நுண்ணறையில் 
இன்றைய தேதியை உள்ளீடு 

ச ெ ய ்ய வு ம் .

•	 இரண்டாவது நுண்ணறையில், உமது 
பிறந்த தேதியை உள்ளீடு செய்யவும்.

•	 மூன்றாவது நுண்ணறையில், பின்வருமாறு 
வாய்பாட்டை உருவாக்கவும்.

•	 மூன்றாவது நுண்ணறை = முதல் 
நுண்ணறை – இரண்டாவது நுண்ணறை.

அட்டவணைத்தாளை பதிப்பாய்வு செய்தல் 
மற்றும் வடிவூட்டல்

9.9 நெடுவரிசைகள், வரிசைகள் மற்றும் 
நுண்ணறைகளை சேர்த்தல்:

	 கால்க்-ல் அட்டவணைத்தாளில், 
நெடுவரிசைகள், வரிசைகள் மற்றும் 

நுண்ணறைகளை ம�ொத்தமாகவ�ோ அல்லது 
ஒன்றுக்கு மேற்பட்டதாகவ�ோ சேர்க்க முடியும். 
9.9.1 நெடுவரிசைகளைச் சேர்த்தல்:

	 ஒரு புதிய நெடுவரிசையைச் 
சேர்க்கும் ப�ோது, சேர்க்கப்படும் நெடுவரிசை 
நடப்பு நெடுவரிசைக்கு இடது பக்கத்தில் 
சேர்க்கப்படும். நடப்பு நெடுவரிசை என்பது, எந்த 
நெடுவரிசையில், நுண்ணறைச் சுட்டி உள்ளத�ோ, 
அந்த நெடுவரிசையைக் குறிக்கும். கால்க்-ல் 
அட்டவணைத்தாளில், எங்கு வேண்டுமானாலும் 
ஒரு புதிய நெடுவரிசையைச் சேர்க்க முடியும்.

நெடுவரிசையைச் சேர்க்கும் வழிமுறைகள்:

படிநிலை 1:	 எந்த நெடுவரிசையில் ஒரு புதிய 
நெடுவரிசை சேர்க்கப்பட வேண்டும�ோ, அந்த 
நெடுவரிசையின் பெயரின் மீது கிளிக் செய்து, 
அதனை தேர்ந்தெடுத்துக்கொள்ளவும்.

படிநிலை 2: தேர்ந்தெடுக்கப்பட்ட நெடுவரிசையின் 
பெயரில், சுட்டியை வைத்து, வலது கிளிக் 
செய்யவும். இப்போது ஒரு மேல்மீட்பு பட்டிப் 
பட்டைத் த�ோன்றும்.

படிநிலை 3: த�ோன்றும் மேல்மீட்பு பட்டிப் 
பட்டையிலிருந்து, “Insert Columns” என்ற 
கட்டளையைத் தேர்வு செய்யவும்.

இப்போது, ஒரு புதிய நெடுவரிசை நடப்பு 
நெடுவரிசைக்கு இடது பக்கத்தில் 
சே  ர ்க்கப்பட்     டி ரு க் கு ம் .

1  இங்கே வலது கிளிக் செய்யவும்

3  நெடுவரிசையை சேர்க்க கிளிக் செய்யவும்

2  மேல் மீட்பு பட்டி த�ோன்றும்

படம் 9.32 நெடுவரிசையைச் சேர்த்தல் – மேல்மீட்பு பட்டிப் பட்டை

	 Insert → Columns கட்டளையைப் பயன்படுத்தியும், ஒரு புதிய நெடுவரிசையைச் சேர்க்க முடியும். 
(படம் 9.32 காண்க )
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"Insert" பட்டியை கிளிக் செய்க

"columns" தேர்வை கிளிக் செய்க

படம் 9.33 Insert பட்டிப் பட்டை பயன்படுத்தி 
நெடுவரிசையை சேர்த்தல்

(1)	 எடுத்துக்காட்டு 1-ல் உருவாக்கப்பட்ட 
அட்டவணைச்செயலியைத் 
தி றந்  து க �ொள்ள    வு ம் .

(2)	நெ டுவரிசை Eக்கும் Fக்கும் இடையே ஒரு 
புதிய நெடுவரிசையை சேர்க்கவும்.

(3)	 புதிதாக சேர்க்கப்பட்ட நெடுவரிசையில் 
“Eco” என்று தலைப்பிடவும். பின்னர், 
அனைத்து மாணவர்களுக்கும் 
ப�ொருளியல் பாடத்திற்கான 
மதிப்பெண்களை உள்ளிடவும்.

(4)	 “Name” மற்றும் “Tamil” 
நெடுவரிசைகளுக்கு இடையே மேலும், 
ஒரு புதிய நெடுவரிசையைச் சேர்க்கவும். 

(5)	 புதிதாக சேர்க்கப்பட்ட அந்த 
நெடுவரிசைக்கு “Date of Birth” என்று 
தலைப்பிட்டு, அனைத்து மாணவர்களின் 
பிறந்த தேதியை உள்ளிடவும்.

(6)	 அட்டவணைச்செயலியை சேமித்து 
மூ ட வு ம் .

செய்முறை பயிற்சி:

9.9.2 வரிசையைச் சேர்த்தல்: 

	 அட்டவணைத்தாளில், ஒரு புதிய 
வரிசையைச் சேர்க்கும் ப�ோது, சேர்க்கப்படும் 
புதிய வரிசை நடப்பு வரிசைக்கு மேல்பக்கமாக 
சேர்க்கப்படும். நடப்பு வரிசை என்பது, எந்த வரிசையில் 
நுண்ணறை சுட்டி உள்ளத�ோ, அந்த வரிசையைக் 
குறிக்கும். கால்க்-ல் ஒரு புதிய வரிசையை எங்கு 
வேண்டுமானாலும் செருக முடியும்.
ஒரு வரிசையைச் சேர்ப்பதற்கான வழிமுறைகள்:
	 படிநிலை 1:	 எந்த வரிசைக்கு மேல் 

ஒரு புதிய வரிசை சேர்க்கப்பட வேண்டும�ோ, 
அந்த வரிசை எண்ணை கிளிக் செய்து, அந்த 
வரிசையைத் தேர்ந்தெடுத்துக்கொள்ளவும்.

	 படிநிலை 2:	தே ர்ந்தெடுக்கப்பட்ட 
வரிசை எண் மீது, சுட்டியில் வலது கிளிக் 
செய்யவும். இப்போது, ஒரு மேல்மீட்பு பட்டிப் 
பட்டைத் த�ோன்றும்.

	 படிநிலை 3:	மே ல்மீட்பு பட்டிப் 
பட்டையில், “Insert Rows” கட்டளையை 
தேர்வு செய்யவும்.

	 இப்போது, ஒரு புதிய வரிசை தேர்வு 
செய்யப்பட்ட வரிசைக்கு மேல் பக்கத்தில் 
சே  ர ்க்கப்ப    டு ம் .

வரிசையை தேர்ந்தெடுக்கவும், மேல்மீட்பு பட்டியை பெறுவதற்கும் இங்கே வலது கிளிக் செய்யவும்

"Insert Rows" கிளிக் செய்யவும்

படம் 9.34 வரிசையைச் சேர்த்தல் – மேல்மீட்பு 
பட்டி

	 Insert → Rows கட்டளையைப் 
பயன்படுத்தியும் ஒரு புதிய வரிசையை 
சேர்க்க முடியும். (படம் 9.35யை காண்க)

"Insert" பட்டியை கிளிக் செய்யவும்

தேர்ந்தெடுக்கப்பட்ட  
வரிசைக்கு மேல் ஒரு 

புதிய வரிசை 
சேர்க்கப்படும்

"Rows" தேர்வை கிளிக் செய்க 

படம் 9.35 வரிசையைச் சேர்த்தல் – பட்டிப் பட்டை
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(1)	 எடுத்துக்காட்டு -1ல் உருவாக்கப்பட்ட அட்டவணைத்தாளை திறக்கவும்.

(2)	 ஒவ்வொன்றாக எட்டு வரிசைகளை சேர்த்து, கீழ்காணும் அட்டவணையில் தரவுகளை 

உள்ளீடு செய்யவும்.

(3).	 பின்னர் சேமித்து மூடவும்.
Reg. No Name Date of Birth Tam Eng CS Eco Com Acc
12101 Sarika S 26/05/2001 145 135 145 125 180 196
12102 Jewees Celcya J 11/04/2001 102 165 134 95 180 134
12103 Yuvarani T 27/06/1999 172 130 107 155 162 130
12104 Meharunisha I 30/05/2001 132 146 112 185 192 176
12105 Priya W 07/03/2000 130 172 100 92 162 155
12106 Vijaya Vasavi K 03/06/2001 198 175 149 148 158 135
12107 Deepika B 14/03/2001 120 182 103 144 107 186
12108 Viji V 19/04/2001 137 173 128 148 125 177

செய்முறை பயிற்சி:

9.9.3 நுண்ணறைகளைச் சேர்த்தல்:
•	 ஏற்கனவே உள்ள நுண்ணறைகளுக்கு 

இடையே ஒரு புதிய நுண்ணறையைச் 
சேர்க்க, நுண்ணறையின் மேல் வலது கிளிக் 
செய்யவும். 

•	 இப்போது த�ோன்றும் மேல்மீட்பு 
பட்டியிலிருந்து “Insert Cells” கட்டளையை 
கிளிக் செய்யவும். 

•	 இப்போது “Insert Cells” உரையாடல் 
பெட்டி, கீழ்காணும் நான்கு விருப்பத் 
தேர்வுகளுடன் த�ோன்றும். 

(1) Shift cells down	 (2) Shift cells right  (3) 
Entire row	 (4) Entire Column
இந்த நான்கு விருப்பத் தேர்வுகளில், ஏதேனும் 
ஒன்றை தேர்ந்தெடுக்கவும்.

(1)	 Shift cells down – தற்போது 
நுண்ணறை எங்கு உள்ளத�ோ, அங்கு புதிய 
நுண்ணறை செருகப்படும். ஏற்கனவே உள்ள 
நுண்ணறைகள் கீழ்பக்கமாக நகர்ந்துவிடும்.

(2)	 Shift cells right -  தற்போது நுண்ணறை 
எங்கு உள்ளத�ோ, அங்கு புதிய நுண்ணறை 
செருகப்படும். ஏற்கனவே உள்ள நுண்ணறைகள் 
வலது பக்கமாக நகர்ந்துவிடும்.

(3) Entire row – ஒரு புதிய வரிசையை சேர்க்க.

(4) Entire Column – ஒரு புதிய நெடுவரிசையை 
சேர்க்க

படம் 9.36 நுண்ணறைகளை சேர்த்தல் 
உரையாடல் பெட்டி

9.9.4 ஒன்றுக்கும் மேற்பட்ட வரிசை அல்லது 
நெடுவரிசைகளை சேர்த்தல்:

	 ஒவ்வொரு வரிசை அல்லது நெடுவரிசையாக 
சேர்ப்பதற்கு பதிலாக, ஒன்றுக்கும் 
மேற்பட்ட வரிசை அல்லது நெடுவரிசைகளை 
ஒரே நேரத்தில் சேர்க்க முடியும்.

•	 செருகப்படுவதற்காக ஒன்றுக்கும் மேற்பட்ட 
வரிசை அல்லது நெடுவரிசைகளைத் தேர்வு 
செய்க.

•	 9.9.1 மற்றும் 9.9.2ல் விவரிக்கப்பட்ட 
வழிமுறைகளைப் பின்பற்றவும்.

9.9.5 “Insert Cells” கருவிப்பட்டையைப் 
பயன்படுத்தி, வரிசை, நெடுவரிசை மற்றும் 
நுண்ணறைகளைச் சேர்த்தல்:

•	 நுண்ணறைகள், வரிசை மற்றும் 
நெடுவரிசைகளை சேர்க்க ”Insert Cells” 
மிதவை கருவிப்பட்டை பயன்படுகிறது.

•	 “Insert Cells” மிதவை கருவிப்பட்டையை 
பெற, View→Toolsbars → Insert Cells 
கட்டளையைக் கிளிக் செய்யவும்.
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•	 ஒரு சிறிய மிதவைக் கருவிப்பட்டை, நான்கு 
பணிக்குறிகளுடன் த�ோன்றும். இந்தப் 
பணிக்குறிகளைப் பயன்படுத்தி, ஒரு புதிய 
வரிசை, நெடுவரிசை மற்றும் நுண்ணறையை 
சேர்க்க முடியும். (படம் 9.37 காண்க)

வரிசை சேர்த்தல்

நெடுவரிசை 
சேர்த்தல்

வலது பக்கமாக நுண்ணறை சேர்த்தல்

கீழ் பக்கமாக நுண்ணறை சேர்த்தல்

படம் 9.37 Insert Cells மிதவைக் கருவிப்பட்டை
9.10 வரிசை மற்றும் நெடுவரிசைகளை 

நீக்குதல்:

	 ஒன்று அல்லது ஒன்றுக்கும் மேற்பட்ட 
வரிசை அல்லது நெடுவரிசைகளை நீக்க 
மு டி யு ம் .

அட்டவணைச் செயலியில், 
உண்மையில் ஒரு புதிய வரிசை 
அல்லது நெடுவரிசையை செருக 
முடியுமா?

	 அனைத்து அட்டவணை செயலிகளும், 
ஒரு குறிப்பிட்ட எண்ணிக்கையிலான 
வரிசைகளையும், நெடுவரிசைகளையும் 
க�ொண்டிருக்கும் எனில், புதிதாக ஒரு வரிசை 
மற்றும் நெடுவரிசையை எவ்வாறு செருக முடியும். 
அதற்கு ஏதேனும் சாத்தியக்கூறுகள் உள்ளதா?
உண்மையில் சாத்தியமில்லை.
ஒரு அட்டவணை செயலியில், புதிதாக ஒரு 
வரிசை அல்லது நெடுவரிசையை செருகுவது 
சாத்தியமற்றது. ஒரு புதிய வரிசை அல்லது 
நெடுவரிசை செருகப்படும் ப�ோது, ஏற்கனவே 
அந்த வரிசை அல்லது நெடுவரிசையிலுள்ள 
அனைத்து தரவுகள், வாய்ப்பாடுகள் மற்றும் 
வடிவூட்டல்கள் அடுத்த வரிசை அல்லது 
நெடுவரிசைக்கு மாற்றப்படுகின்றது. ஆனால், 
பார்வைக்கு ஒரு புதிய வரிசை அல்லது 
நெடுவரிசை செருகப்பட்டது ப�ோன்று  
த�ோன்றுகிறது. 

9.10.1 ஒன்றை வரிசை அல்லது நெடுவரிசையை 
நீக்குதல்:

•	 சுட்டியைப் பயன்பத்தி ஒற்றை வரிசை 
அல்லது நெடுவரிசையை நீக்கும் 
வழிமுறைகள்.

•	 நீக்கப்பட வேண்டிய வரிசை அல்லது 
நெடுவரிசையைத் தேர்ந்தெடுக்கவும்.

•	 Edit → Delete Cells கட்டளையைத் தேர்வு 
செய்க.

(அல்லது)
•	 நீக்கப்பட வேண்டிய வரிசை அல்லது 

நெடுவரிசை தலைப்பில் வலது கிளிக் 
ச ெ ய ்ய வு ம் .

•	 இப்போது த�ோன்றும், மேல்மீட்புப் 
பட்டியிலிருந்து, Delete Columns அல்லது 
Delete Rows கட்டளையைத் தேர்வு 
ச ெ ய ்ய வு ம் .

9.10.2 ஒன்றுக்கும் மேற்பட்ட வரிசை 
அல்லது நெடுவரிசைகளை நீக்குதல்:
•	 	ஒரே நேரத்தில் ஒன்றுக்கும் மேற்பட்ட வரிசை 

அல்லது நெடுவரிசைகளை நீக்க முடியும். 
(படம் 9.38யை காண்க)

•	 நீக்கப்பட வேண்டிய வரிசைகள் அல்லது 
நெடுவரிசைகளைத் தேர்வு செய்து 
க �ொள்ள    வு ம் .

•	தேர் வு செய்யபட்ட வரிசைகள் அல்லது 
நெடுவரிசைகளின் மீது வலது கிளிக் 
ச ெ ய ்ய வு ம் .

•	 இப்போது த�ோன்று மேல்மீட்புப் பட்டியிலுள்ள, 
Delete Column அல்லது Delete Rows 
கட்டளையை கிளிக் செய்யவும். அல்லது Edit 
→ Delete Cells தேர்வை கிளிக் செய்யவும்.

(1)	 எடுத்துக்காட்டு -1ல் உருவாக்கப்பட்ட 
அட்டவணைச் செயலியை 
தி றந்  து க �ொள்ள    வு ம் .

(2)	 ஏதேனும் மூன்று மாணவர்களின் 
தகவல்களை நீக்கி, க�ோப்பை சேமித்து 
மூ ட வு ம் .

செய்முறை பயிற்சி:

வரிசை அல்லது நெடுவரிசைகளை 
அழித்தல் சாத்தியமில்லை!!!

வரிசை அல்லது நெடுவரிசை 
செருகுதலில் கூறப்பட்டது 

ப�ோலவே, ஒரு வரிசை அல்லது நெடுவரிசையை 
நீக்குவதும் முற்றிலும் சாத்தியமில்லை. ஒரு 
வரிசை அல்லது நெடுவரிசை அழிக்கப்படும் 
ப�ோது, அதில் உள்ள அனைத்து தரவுகள், 
வாய்ப்பாடுகள் மற்றும் வடிவூட்டல்கள் 
அழிக்கப்படுகின்றது. ஆனால், பார்வைக்கு 
அந்த வரிசை அல்லது நெடுவரிசை  
அழிக்கப்பட்டது ப�ோல் த�ோன்றும்.
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தேர்ந்தெடுக்கப்பட்ட நெடுவரிசைகள்

தே  ர ்ந்தெ   டு க ்கப்ப   ட ்ட 
நெ  டு வ ரி சை  க ள ை 
இங்கே கிளிக் செய்யவும்

படம் 9.38 ஒன்றுக்கு மேற்பட்ட நெடுவரிசைகளை அழித்தல்
9.11 அட்டவணைத்தாள் வடிவூட்டல்:

	 நுண்ணறையிலுள்ள தரவுகளை வடிவூட்டல் செய்வது, அத்தரவுகளுக்கு கூடுதலான  தாக்கத்தை  
ஏற்படுத்துவதாகும். அத்தாக்கங்கள் படிப்பவரின் கவனத்தை ஈர்ப்பதற்காக செய்யப்படுகிறது. கூடுதல் 
தாக்கங்கள் என்பது, எழுத்துரு வகை, அளவு, நிறம் ப�ோன்றவற்றை மாற்றுதல், தானியங்கு மென் 
திருப்புதல், தடிமனாக்குதல், அடிக்கோடிடுதல், சாய்வெழுத்தாக்குதல் ப�ோன்றவையைக் குறிக்கும். 
கால்க்-ல் உள்ள தரவுகள் பல்வேறு வழிமுறைகளில் வடிவூட்டல் செய்யப்படுகிறது. 

9.11.1 உரை வடிவூட்டல்கள்:

	 நுண்ணறையில் உள்ளத் தரவுகளை தடிமனாக்குதல், சாய்வெழுத்தாக்குதல், அடிக�ோடிடுதல், 
எழுத்துருவின் வகை, அளவு, நிறம் மாற்றுதல் ப�ோன்றவை உரை வடிவூட்டல்களாகும். ஓபன் 
ஆஃபீஸ் ரைட்டரில் கற்றது ப�ோலவே, அனைத்து வடிவூட்டல் தேர்வுகளும் ”வடிவூட்டல் கருவிப் 
பட்டையில்” உள்ளது. (படம் 9.39 (அ) காண்க.)

நகர்வு புள்ளிகள்
தடிமனாக்குதல் சாய்வெழுத்தது

அடிக்கோடிடுதல்

நு ண்ணறை    
இணைப்பு

இடது, மைய, வலது மற்றும் 
நேர்த்தி இசைவுகள்

பாணிகள் எழுத்துரு வடிவங்கள் எழுத்துரு அளவு {

படம் 9.39 (அ) உரை வடிவூட்டல் பணிக்குறிகள்

வடிவூட்டல் தேர்வு விசைப்பலகை 

குறுக்குவழி

பயன்

எழுத்துரு வகை எழுத்துரு வகையை மாற்றப் பயன்படுகிறது.

எழுத்துரு அளவு எழுத்துருக்களின் அளவை மாற்றுவதற்கு பயன்படுகிறது.
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தடிமனாக்குதல் Ctrl + B தரவை தடிமனாக்குவதற்கு பயன்படுகிறது. 

சாய்வெழுத்தாக்குதல் Ctrl + I தரவை சாய்வெழுத்தாக மாற்றுவதற்கு பயன்படுகிறது.

அடிக்கோடிடுதல் Ctrl + U தரவுகளை அடிக்கோடிடுவதற்கு

வலது இசைவு Ctrl + L நுண்ணறைக்குள் தரவுகளை வலது இசைவில் அமைக்க.

இடது இசைவு Ctrl + R நுண்ணறைக்குள் தரவுகளை இடது இசைவில் அமைக்க.

மைய இசைவு Ctrl + E நுண்ணறைக்குள் தரவுகளை மைய இசைவில் அமைக்க.

நேர்த்தி இசைவு Ctrl + J
நுண்ணறைக்குள் தரவுகளை வலது மற்றும் இடது 

ஓரங்களில் சமமானதாக மாற்றுவதற்கு

நுண்ணறை சேர்ப்பு
தேர்ந்தெடுக்கப்பட்ட நுண்ணறைகளை, ஒரே 

நுண்ணறையாக மாற்றுவதற்கு. 

9.11.2 எண் வடிவூட்டல்:

	 நுண்ணறையிலுள்ள எண் தரவுகள் திரையில் த�ோன்றும் வடிவத்தை  மாற்றம் செய்ய எண் வடிவூட்டல் 
தேர்வுகள் பயன்படுகிறது. இந்த வடிவூட்டல் தேர்வுகள் உண்மை மதிப்பினை எந்த வகையிலும் மாற்றம் 
செய்யாது. எடுத்துக்காட்டக ஒரு எண்ணை, பண மதிப்பில் காட்டவேண்டுமெனில், (அதாவது அதன் 
உண்மை மதிப்பு மாறாமல், அதன் முன்னொட்டாக பணக்குறியீடு இணைக்கப்பட்டு, பின்னொட்டாக 
தசமப்புள்ளியுடன் காட்டவேண்டுமெனில்) படம் 9.39 (ஆ) காட்டப்பட்டுள்ள Number Format: 
Currency பணிக்குறி பயன்படுகிறது.

பணக்குறியீடு

சதவீதம் தசம புள்ளிகள் அழித்தல்

தசம புள்ளி சேர்த்தல்

இயல்புநிலை

படம் 9.39 (ஆ) எண் வடிவூட்டல் பணிக்குறிகள்

எண் வடிவூட்டல் விசைப்பலகை 

குறுக்குவழி
பணக்குறியீடு Ctrl+Shift+4
சதவீதம் Ctrl+Shift+5
இயல்புநிலை Ctrl+Shift+6

(1)	 எடுத்துக்காட்டு – 1ல் உருவாக்கப்பட்ட அட்டவணை செயலியை திறக்கவும்.

(2)	 அனைத்து தலைப்புகளையும் மைய இசைவுக்கு மாற்றி, அவற்றை தடிமனாக்குக.

(3)	 அனைத்து பதிவு எண்களையும், மதிப்பெண்களையும் மைய இசைவுக்கு மாற்றுக.

(4)	 அட்டவணையிள்ள தேர்வுகளுக்கு பலவகையாக எழுத்துரு வகைகளை  க�ொடுக்கவும்

(5)	சே மித்து மூடுக.

செய்முறை பயிற்சி
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 பயிற்சி பட்டறை: 1 

1.	 கீழ்க்காணும் தரவுகளுக்கு ஒரு அட்டவணைத் தாளை உருவாக்குக.

Emp. 
No

Name of Emp. Basic DA HRA CCA MA GPF IT HF

1001 Manivannan M 25500

Ba
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 2
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 1

5%

600 300
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 %
10

250

1002 Kannan K 20200 600 300 250

1003 Gowrishankar N V 24300 600 300 250

1004 Lenin K 23400 600 300 250

1005 Suryanarayanan T 24100 600 300 250

1006 Ramesh K 18500 600 300 250

1007 Govindasami A 13200 600 300 250

1008 Kannan S 20250 600 300 250

1009 Penchil Rao K 28300 600 300 250

1010 Logeswaran M 30200 600 300 250

1011 Arumugam E 12000 600 300 250

1012 Vasu G N 25000 600 300 250

மேற்காணும் தரவுகளுக்கு……,  

(1)	 Gross Salary (ம�ொத்த சம்பளம்), Total Deductions (ம�ொத்த பிடித்தங்கள்) மற்றும் Net Salary 
(நிகர சம்பளம்) கணக்கிடுக. 

(2)	 “IT Cess” என்ற நெடுவரிசையைச் சேர்க்கவும், அதில், அனைத்து பணியாளர்களுக்கும் 3% cess 
கணக்கிடுக.

(3)	 “Govindasami” மற்றும் “Arumugam” ஆகிய�ோரின் பதிவுகளை நீக்குக. 

(4)	 கீழ்க்காணும் பணியளார்களின் விவரங்களைச் சேர்க்கவும்.

(5)	 GPF, IT,மற்றும் Cess ஆகியவற்றின் ம�ொத்த த�ொகையைக் கணக்கிடுக.

Emp.
No

Name of Emp. Basic DA HRA CCA MA GPF IT HF

2001 Murali G 24750
2002 Munirathnam A 23550
2003 Ramakrishnan V G 25500
2004 Srinivasan R 27500
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பயிற்சி பட்டறை: 2 

1.	 ஓபன் ஆஃபீஸ் கால்க்-ல் ஒரு புதிய அட்டவணைத்தாளை திறந்துக�ொள்க. 

2.	 “Chennai whole sale Marketing Pvt. Ltd.”-ன் 2018-ஜனவரி மாதத்தின் சரக்கிருப்பு 	

	 மற்றும் விற்பனை விவரங்களை உள்ளிடுக.
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100 Marie Gold 120 345 15 147 5%
101 Milk Bikis 85 106 10 63 5%
102 Dark Fantasy 75 147 25 43 3%
103 Nutri Choice 250 98 50 12 10%
104 Lays potato chips 52 172 15 152 4%
105 Oreo 120 112 25 85 6%

3.	 வாய்பாடு பயன்படுத்தி, பின்வருவனவற்றை கணக்கிடுக. 

	 (i) Amount of Discount, Selling price மற்றும் Amount of sales ஒவ்வொரு ப�ொருளுக்கும். 

	 (ii) இந்த மாதத்தின் ம�ொத்த தள்ளுபடி (Total amount of discount) மற்றும் விற்பனை.

	 (iii) ஒவ்வொரு ப�ொருளுக்குமான இறுதி சரக்கிருப்பு. 

பயிற்சி பட்டறை: 3 

1.	 ஓபன் ஆஃபீஸ் கால்க்-ல் ஒரு புதிய அட்டவணைத்தாளை உருவாக்குக.

2.	 Tamil Finance Corporation” நிறுவனத்தின், ஜனவரி 2018க்கான அனுமதிக்கப்பட்ட கடன் 	

	 விவரங்களை உள்ளிடவும். 

3. 	 கீழுள்ளவைகளை கணக்கிடுவதற்கான வாய்பாடு உருவாக்குக.

(i)	 Interest, Total amount மற்றும் due date.

(ii)	 இந்த மாதத்தில் அனுமதிக்கப்பட்ட ம�ொத்த கடன், பெற்ற வட்டி மற்றும் ம�ொத்த த�ொகை 

	 (கடன் + வட்டி).
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2001 Senthil 250000 02/01/2018 120 days 9.5%

2002 Kumar 175000 15/01/2018 150 days 9.5%

2003 Ibrahim 550000 16/01/2018 140 days 10.5%

2004 Valli 375000 21/01/2018 210 days 10%

2005 Charles 450000 28/01/2018 130 days 10.5%

4.	 Kumar மற்றும் Ibrahim ஆகிய இருவரின் பதிவுகளுக்கு இடையே ஐந்து புதிய வரிசைகளை 	

	ச ெருகி, கீழ்காணும் நபர்களின் விவரங்களை உள்ளிடுக.
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3001 Pari 250000 03/02/2018 125 days 9.5% 5%
3002 Arul 375000 07/02/2018 155 days 9.5% 5%
3003 Raman 350000 10/02/2018 130 days 10.5% 3%
3004 Givind 450000 10/02/2018 100 days 10% 10%
3005 Zeenath 800000 26/02/2018 90 days 10% 4%

நினைவில் க�ொள்வோம்

•	 அட்டவணை செயலி அலுவலக பயன்பாட்டிற்குத் தேவையான தரவுகளை ஒருங்கிணைத்து, 

ஆராய்ந்து, சேமித்து அட்டவணை வடிவில் தருவதற்கு பயன்படும் மிகச் சிறந்த கருவியாகும்.

•	 டேனியல் பிரிக்லின் மற்றும் பாப் ஃப்ராங்ஸ்டன் ஆகிய�ோர், 1979- ஆம் ஆண்டு, ஆப்பிள் II 

என்ற கணிப்பொறிக்காக உருவாக்கப்பட்ட, விசிகால்க் (Visicalc) முதல் அட்டவணைச்செயலி.

•	 ஓபன் ஆஃபீஸ் கால்க் ஒரு பிரபலமான திறந்த மூல (Open Source) அட்டவணைச்செயலி 

ஆகும். இதனை தற்போது அபாச்சி (Apache) நிறுவனம் நிர்வகித்து வருகிறது.
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நினைவில் க�ொள்வோம்

•	 அட்டவணைத்தாள் என்பது கட்டங்களுடன் கூடிய நுண்ணறைகளைக் க�ொண்ட ஒரு 
அமைப்பு ஆகும். அதன் ஒவ்வொறு நுண்ணறையிலும் நிரலாக்கப்பட்ட கணிப்பான்கள் 
இணைந்துள்ளது.

•	 ஓபன் ஆஃபீஸ் கால்க் பதிப்பு 4.1.5 ம�ொத்தம் 1024 நெடுவரிசைகளையும், 10,48,576 
வரிசைகளையும் க�ொண்டுள்ளது.

•	 ஒரு வரிசையும், நெடுவரிசையும் இணையுமிடத்தில் உருவாகும் பெட்டி ப�ோன்றத�ொரு அமைப்பு 
“நுண்ணறை” அல்லது “கலம்” என்று அழைக்கப்படுகிறது.

•	 அட்டவணைத்தாள் முழுவதும் நகர்த்தக் கூடிய, செவ்வக வடிவிலான பெட்டி ப�ோன்ற அமைப்பு 
“நுண்ணறைச் சுட்டி” என்று அழைக்கப்படுகிறது.

•	 எந்த நுண்ணறையில் நுண்ணறை சுட்டி தற்போது உள்ளத�ோ, அந்த நுண்ணறை ”செயற்படு 
கலம்” (Active Cell) எனப்படும். 

•	 அனைத்து வாய்பாடுகளும் = குறியுடன் த�ொடங்க வேண்டும்

•	 நான்கு வகையான இயக்கிகள் கால்கில் உள்ளது.

செயல்பாடு

மாணவர் செயல்பாடு

1. 	 வாய்ப்பாடுகளைப் பயன்படுத்தி கணக்கீடுகள் செய்யப்படும் கருதுரு அடிப்படையில் பல்வேறு 

அட்டவணை தாள் தரவுகளை உருவாக்கும் பயிற்சிகள்.

ஆசிரியர்செயல்பாடு

1. 	 அட்டவணை செயலியில் வேலை செய்தலை எளிய எடுத்துக்காட்டுகளுடன் விளக்க வேண்டும்.
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மதிப்பீடு

பகுதி - அ 

சரியான விடையை தேர்ந்தெடு:

1.	 முதல் அட்டவணை செயலி எது?

	 (அ) எக்ஸெல் (Excel)			   (ஆ) ல�ோட்டஸ் 1-2-3 (Lotus 1-2-3)
	 (இ) விசி கால்க் (Visicalc)		  (ஈ) ஓபன் ஆஃபீஸ் கால்க் (OpenOffice Calc)

2.	 ஓபன் ஆஃபீஸ் கால்க்-ன்  மூலப்பயன்பாடு எது? 

	 (அ) விசி கால்க் (Visicalc)		  (ஆ) லிப்ரே கால்க் (LibreCalc)
	 (இ) ல�ோட்டஸ் 1-2-3 (Lotus 123)		 (ஈ) ஸ்டார் ஆஃபீஸ் கால்க் (StarOffice Calc)

3.	 கட்டங்களுடன் கூடிய நிரலாக்கப்பட்ட கணிப்பான்: 

	 (அ) அட்டவணைச் செயலி			   (ஆ) தரவுத்தளம்

	 (இ) ச�ொற்செயலி					     (ஈ) லினக்ஸ்

4.	 கால்க்-ல் ஒரு நெடுவரிசையின் தலைப்பு என்பது:

	 (அ) எண் 		 (ஆ) குறியீடு	  	 (இ) தேதி		  (ஈ) எழுத்து

5.	 அட்டவணைத்தாளிற்குள் நுண்ணறை சுட்டியை முன்னோக்கி நகர்த்தும் ப�ொத்தான் எது? 

	 (அ) Enter	 (ஆ) Tab	 	 (இ) Shift + Tab		 (ஈ) Delete

6.	 ஒரு வாய்பாடு இவற்றுள் எதில் த�ொடங்கலாம் 

	 (அ) =		  (ஆ) +			   (இ) -			   (ஈ) இவையனைத்தும்

7.	 + A1^B2 என்ற வாய்பாட்டுகான வெளியீட்டு மதிப்பு எது? (A1=5, B2=2 எனில்)

	 (அ) 7		  (ஆ) 25			   (இ) 10			   (ஈ) 52

8.	 = H1<>H2 என்ற கூற்றுக்கான வெளியீட்டு மதிப்பு என்ன? (H1=12, H2=12 எனில்)
	 (அ) True		 (ஆ) False		  (இ) 24			   (ஈ) 1212

9.	த னித்த நுண்ணறைப் பார்வையிடலுக்கு பயன்படுத்தப்படும் குறியீடு எது? 

	 (அ) +		  (ஆ) %			   (இ) &			   (ஈ) $

10.	 இவற்றுள் எந்த சவிசேர்மானத்தை பயன்படுத்தி நடப்பு நெடுவரிசையின் அகலத்தை அதிகரிக்கலாம் ?

	 (அ) Alt+Right arrow		  (ஆ) Ctrl+Right arrow			   (இ) Alt+Left arrow		
(ஈ) Ctrl+Left arrow

பகுதி - ஆ

அனைத்து வினாக்களுக்கு விடையளிக்கவும்:

1.	 ஓபன் ஆஃபீஸ் கால்க்-ல் எத்தனை வகையான கருவிப்பட்டைகள் உள்ளது? 

2.	 நுண்ணறைச் சுட்டி என்றால் என்ன?  

3.	 ஓபன் ஆஃபீஸ் கால்க்-ன் உரை செயற்குறியை பற்றி குறிப்பு வரைக.

4.	 கால்க்-ல் ஒரு வாய்ப்பட்டை உருவாக்குவதற்கான ப�ொது கட்டளை அமைப்பை எழுதுக. 

5.	ந கலெடுத்தல், வெட்டுதல் மற்றும் ஒட்டுவதற்கான குறுக்குவழி சாவி சேர்மானங்கள் யாவை?

6.	 ஒரு நுண்ணறையிலுள்ள தரவுகளை பதிப்பாய்வு செய்ய முடியுமா? ஆம் எனில் எவ்வாறு? 
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7.	 “Insert Cells” உரையாடல் பெட்டியிலுள்ள தேர்வுகள் யாவை?

8.	ப�ொ ருத்துக.

அ ஆ

(அ) வெட்டுதல், நகலெடுத்தல் மற்றும் ஒட்டுதல் (1) தனித்த நுண்ணறை
(ஆ) நுண்ணறை சுட்டி (2) நிலைமைப் பட்டை
(இ)  தேர்ந்தெடுப்பு நிலை (3) செந்தரக் கருவிப்பட்டை

(ஈ) $A$5 (4) இயங்கு கலம்

9.	 வரையறுக்க (1) உரை செயற்குறி (2) அட்டவணை செயலியில் வரிசை மற்றும் நெடுவரிசை

10.	  நகலெடுத்து ஒட்டுதல் மற்றும் வெட்டி ஒட்டுதல் வேறுபடுத்துக.

பகுதி - இ

அனைத்து வினாக்களுக்கு விடையளிக்கவும்: 

1.	 ஓபன் ஆஃபீஸ் கால்க் – குறிப்பு வரைக. 

2.	 கால்க்-ல் நெடுவரிசை மற்றும் நுண்ணறைகளை சேர்த்தல் பற்றி எழுதுக.

3.	 Backspace மற்றும் Delete ப�ொத்தான்களைப் பயன்படுத்தி தரவுகளை அழித்தலை வேறுபடுத்துக. 

4.	 ஏதேனும் மூன்று வடிவூட்டல் தேர்வுகளை எழுதுக. 

5.	 நுண்ணறை A1, A2 மற்றும் A3 யில் முறையே, 34, 65 மற்றும் 89 ஆகிய மதிப்புகள் உள்ளது. அதன் 
சராசரியை காணும் வாய்பாட்டை எழுதுக. 

பகுதி - ஈ

அனைத்து வினாக்களுக்கு விடையளிக்கவும்: 

1.	 கால்க்-ல் நெடுவரிசையின் அகலத்தை எவ்வாறு மாற்றலாம் என்பதை விளக்குக. 

2.	 5, 10, 20 ….. 2560 என்ற எண் வரிசையை உருவாக்கும் வழிமுறையை விளக்குக.

3.	 பின்வரும் அட்டவணையை உற்று ந�ோக்கவும். 

A B C D E
1 Year Chennai Madurai Tiruchi Coimbatore
2 2012 1500 1250 1000 500
3 2013 1600 1000 950 350
4 2014 1900 1320 750 300
5 2015 1850 1415 820 200
6 2016 1950 1240 920 250

	 2012 முதல் 2016ம் ஆண்டுகளில், தமிழகத்தின் முக்கிய நகரங்களில் விற்பனை செய்யப்பட்ட 
குளிரூட்டியின் விவரங்கள் க�ொடுக்கப்பட்டுள்ளது. இந்த தரவுகளின் அடிப்படையில், பின்வருவனவற்றுக்கு 
வாய்பாடுகளை எழுதுக.

(1)	 2015ம் ஆண்டின் ம�ொத்த விற்பனை 

(2)	 2012 முதல் 2016 வரை க�ோயம்புத்தூரின் ம�ொத்த விற்பனை. 

(3)	 2015 மற்றும் 2016ம் ஆண்டுகளில், மதுரை மற்றும் திருச்சியின் ம�ொத்த விற்பனை

(4)	 2012 முதல் 2016 வரை சென்னையின் சராசரி விற்பனை.

பயிற்சி பட்டறை: 2 

1.	 ஓபன் ஆஃபீஸ் கால்க்-ல் ஒரு புதிய அட்டவணைத்தாளை திறந்துக�ொள்க. 

2.	 “Chennai whole sale Marketing Pvt. Ltd.”-ன் 2018-ஜனவரி மாதத்தின் சரக்கிருப்பு 	

	 மற்றும் விற்பனை விவரங்களை உள்ளிடுக.
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100 Marie Gold 120 345 15 147 5%
101 Milk Bikis 85 106 10 63 5%
102 Dark Fantasy 75 147 25 43 3%
103 Nutri Choice 250 98 50 12 10%
104 Lays potato chips 52 172 15 152 4%
105 Oreo 120 112 25 85 6%

3.	 வாய்பாடு பயன்படுத்தி, பின்வருவனவற்றை கணக்கிடுக. 

	 (i) Amount of Discount, Selling price மற்றும் Amount of sales ஒவ்வொரு ப�ொருளுக்கும். 

	 (ii) இந்த மாதத்தின் ம�ொத்த தள்ளுபடி (Total amount of discount) மற்றும் விற்பனை.

	 (iii) ஒவ்வொரு ப�ொருளுக்குமான இறுதி சரக்கிருப்பு. 

பயிற்சி பட்டறை: 3 

1.	 ஓபன் ஆஃபீஸ் கால்க்-ல் ஒரு புதிய அட்டவணைத்தாளை உருவாக்குக.

2.	 Tamil Finance Corporation” நிறுவனத்தின், ஜனவரி 2018க்கான அனுமதிக்கப்பட்ட கடன் 	

	 விவரங்களை உள்ளிடவும். 

3. 	 கீழுள்ளவைகளை கணக்கிடுவதற்கான வாய்பாடு உருவாக்குக.

(i)	 Interest, Total amount மற்றும் due date.

(ii)	 இந்த மாதத்தில் அனுமதிக்கப்பட்ட ம�ொத்த கடன், பெற்ற வட்டி மற்றும் ம�ொத்த த�ொகை 

	 (கடன் + வட்டி).
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அட்டவணைச் செயலி 
Spreadsheet

கணிப்பொறியில், கணக்கீடுகளை செய்யப் பயன்படும் ஒரு 
மென்பொருள்.   

என்ன - எனில் பகுப்பாய்வு 
What-if analysis

ஒரு குறிப்பிட்ட நுண்ணறையில் உள்ள மதிப்புகளில் செய்யப்படும் 
மாற்றங்கள் அதன் வெளியீட்டை எவ்வாறு பாதிக்கும் என்பதை 
அறிவதாகும்.

விசி கால்க்
VisiCalc

முதல் மின் அட்டவணை செயலி.

GUI வரைகலைப் பயனர் இடைமுகம்.

எக்ஸெல்
Excel

மைக்ரோசாஃட் நிறுவனத்தால் உருவாக்கப்பட்ட மிகப் பிரபலமான 
அட்டவணைச் செயலி.

நுண்ணறை
Cell

வரிசை மற்றும் நெடுவரிசை குறிக்கிடுவதால் ஏற்படும் அமைப்பு.

நுண்ணறை முகவரி
Cell Pointer

அட்டவணைச் செயலியில், ஒரு நுண்ணறையை சுற்றி பளிச்சென்று 
தெரியும் ஒரு செவ்வக அமைப்பு.

செயற்படு கலம்
Active cell

தற்போது நுண்ணறைச் சுட்டி உள்ள நுண்ணறை.

வாய்பாடு
Formula

க�ொடுக்கப்பட்ட ஒரு மதிப்பின் மீது, என்ன மாதிரியான கணித 
செயல்பாடு செய்யப்பட வேண்டும் என்பதை குறிக்கும் ஒரு கணிதச் 
சமன்பாட்டுக் க�ோவை. 

செயற்குறி
Operator

கணக்கீடுகள்,  கணிப்பீடுகள் மற்றும் செயல்பாடுகளை செய்யப் 
பயன்படும் குறியீடு. 

பரப்பு
Range

ஒரு குறிப்பிட்ட எண்ணிக்கையில் அமைந்த நுண்ணறைகளின் 
த�ொகுப்பு.

BODMAS விதி கணித கணக்கீட்டின் செயல்பாட்டு வரிசை:
Brackets (அடைப்புக் குறிகள்) - Orders (அடுக்குகள் மற்றும் 
வர்க்க மூலம்) -  Division (வகுத்தல்) - Multiplication (பெருக்கல்) 
- Addition (கூட்டல்) - Subtraction (கழித்தல்).

இழுத்து நிரப்புதல் புள்ளி
Drag fill handle

நுண்ணறைச் சுட்டியின் கீழ் வலது மூலையில் அமைந்துள்ள ஒரு 
சிறிய சதுரப் பெட்டி ப�ோன்றத�ொரு அமைப்பு.

செயற்கூறுகள்
Function

முன்னரே வரையறுக்கப்பட்ட வாய்பாடுகள் (அல்லது) ஒற்றை 
மதிப்பைய�ோ அல்லது ஒன்றுக்கும் மேற்பட்ட மதிப்புகளைய�ோ 
விடையாக தரும் சிறிய கட்டளைத் த�ொகுப்பு.

வரைபடம்
Chart

தரவுகளை வரைபடங்களாக குறிப்பிடுவது.
Graphical representation of data.

தரவுத்தளம்
Database

பெரிய அளவிலான, தரவுகளின் முறைபடுத்தப்பட்ட த�ொகுப்பு.

ஒற்றைக் க�ோப்புத் 
தரவுத்தளம்
Flat file database

ஒற்றைத் தரவு அட்டவணையைக் க�ொண்ட தரவுதள வகை. 

ச�ொற்களஞ்சியம்
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கற்றல் ந�ோக்கங்கள்

	 இந்த பாடத்தை கற்றப்பின் மாணவர்கள் அறிந்து க�ொள்பவை

•	 ஒன்றுக்கும் மேற்பட்ட அட்டவணைத் தாள்களுடன் செயல்படுவது பற்றி தெரிந்து க�ொள்ளுதல்.

•	 அட்டவணைத் தாளுக்கு மாற்று பெயரிடல் மற்றும் அட்டவணைத் தாளை நீக்குதல் பற்றி அறிதல்.

•	 நகல் எடுத்தல், நகர்த்தல் மற்றும் தாள்களின் வரிசை முறையை மாற்றுதல் பற்றி அறிந்து க�ொள்ளுதல்.

•	 நுண்ணறை, வரிசை மற்றும் நெடுவரிசைகளை எவ்வாறு தேர்ந்தெடுப்பது என்பது பற்றிப் புரிந்து 

க�ொள்ளுதல்.

•	 வடிவூட்டல் கருவிப்பட்டையை பற்றி கற்றுக் க�ொள்ளுதல்.

•	 நுண்ணறை பார்வையிடலின் வகைகளைத் தெரிந்து க�ொள்ளுதல்.

•	 செயற்கூறுகளைப் பயன்படுத்துதல் பற்றி அறிதல்.

•	 வரைபடங்களை உருவாக்க கற்றுக் க�ொள்ளுதல்.

10.1 கணக்கீட்டுத் தாளை நிர்வகித்தல்

10.1.1  அட்டவணைத் தாளை தேர்ந்தெடுத்தல்:

	 ஒன்று அல்லது அதற்கு மேற்பட்ட கணக்கீட்டுத் தாள்களை சுட்டியின் மூலம் தேர்வு செய்ய முடியும்.   

ஒரே நேரத்தில், ஒன்றுக்கும் மேற்பட்ட அட்டவணைத் தாள்களில் மாற்றங்கள் செய்ய, அவையனைத்தையும்  

தேர்வு செய்வது ஒரு நன்மையாகும். 

10.1.2 ஒற்றை அட்டவணை தாளை தேர்ந்தெடுத்தல்

	தேர் வு செய்ய வேண்டிய கணக்கீட்டுத் தாளின், தத்தலின் மீது (sheet tab) கிளிக் செய்ய வேண்டும். 

இப்போது, தேர்வு செய்யப்பட்ட தாளின் தத்தல் வெண்மை நிறத்தில் த�ோன்றும். தேர்வு செய்யப்பட்ட இடத்தை 

கைவிட, ஏதேனும் தேர்வு செய்யப்படாத தாளில் கிளிக் செய்யவும். 

தாள் வழிநடத்து 
ப�ொத்தான்

தாளின் வரிசை எண் / ம�ொத்த தாள்களின் எண்ணிக்கை

தேர்வு செய்யப்பட்ட தாள்

படம் 10.1  ஒரு அட்டவணைத்தாளை தேர்ந்தெடுத்தல்

பாடம் 10
செயற்கூறுகள் மற்றும் வரைபடம்

அட்டவணை செயலிஅலகு III
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10.1.3 த�ொடர்ச்சியான ஒன்றுக்கும் மேற்பட்ட அட்டவணைத் தாள்களை தேர்ந்தெடுத்தல்

	 கீழ்வரும் படிநிலைகளை பயன்படுத்தி த�ொடர்ச்சியான ஒன்றுக்கும் மேற்பட்ட அட்டவணைத் 

தாள்களை தேர்ந்தெடுக்கலாம்.

•	 முதலில் ஒரு கணக்கீட்டுத் தாளின்  தத்தலை (Sheet Tab) கிளிக் செய்யவும்.

•	 Shift ப�ொத்தானை அழுத்தி பிடித்தவாறு கடைசி கணக்கீட்டுத்தாளின் தத்தலை (Sheet Tab) கிளிக் 

செய்யவும். 

	 கிளிக் செய்யப்பட்ட இரண்டு தாள்களுக்கும் இடைப்பட்ட எல்லா தத்தல்களும் தேர்ந்தெடுக்கப்பட்டு 

வெள்ளை நிறமாக மாறிவிடும். பயனர் செய்யும் எந்த ஒரு செயல்பாடும் தேர்ந்தெடுக்கப்பட்டுள்ள அனைத்து 

அட்டவணைத் தாள்களிளும் பிரதிபலிக்கும்.  எடுத்துக்காட்டாக, கணக்கீட்டுத்தாள்கள் Sheet1 லிருந்து 
Sheet5 வரை த�ொடர்ச்சியாகத்  தேர்ந்தெடுக்க கீழ்க்கண்ட படிநிலைகளை பின்பற்றுக.

படிநிலை 1: முதல் அட்டவணைத் தாளை தேர்வு செய்ய Sheet1  யை கிளிக் செய்யவும்

படிநிலை 2:  Shift  ப�ொத்தானை அழுத்திப்பிடித்தவாறு கடைசித் தாளான  Sheet5 கிளிக் செய்யவும்.

	 இப்போது, Sheet1லிருந்து Sheet5 வரை உள்ள அனைத்துத் தாள்களும் தேர்ந்தெடுக்கப்பட்டு 

அவற்றின் தத்தல்கள், படம் 10.2ல் காட்டியவாறு வெள்ளை  நிறமாக மாறும். மேலும் பயனர் செய்யும் எந்த 

ஒரு செயல்பாடும்  தேர்ந்தெடுக்கப்பட்ட  அனைத்து தாள்களிலும் பிரதிபலிக்கும்.

	தேர் வு செய்த அட்டவணைத்தாள்களை கைவிட, தேர்வு செய்யப்படாத  கணக்கீட்டுத்தாளின் 

தத்தலை கிளிக் செய்ய வேண்டும்.

தேர்வு செய்யப்பட்ட தாள்கள் தேர்வு செய்யப்படாத தாள்கள்

படம் 10.2 ஒன்றுக்கும் மேற்பட்ட த�ொடர்ச்சியான அட்டவணை தாளை தேர்ந்தெடுத்தல்

10.1.4 த�ொடர்ச்சியாக இல்லாத ஒன்றுக்கும் மேற்பட்ட அட்டவணைத் தாள்களைத் தேர்ந்தெடுத்தல்

	 கீழ்வரும் படிநிலைகளைப் பின்பற்றி த�ொடர்ச்சியாக அமையாத ஒன்றுக்கும் மேற்பட்ட அட்டவணைத் 

தாள்களை தேர்ந்தெடுக்கலாம்.

படிநிலை1 : ஏதேனும் ஒரு தாளை கிளிக் செய்யவும்.

படிநிலை 2: �Ctrl ப�ொத்தானை அழுத்திப் பிடித்தவாறு, தேர்வு செய்ய வேண்டிய வேறு ஒரு தாளை கிளிக் 

செய்யவும்.

	த�ொ டர்ச்சியாக இல்லாத ஒன்றுக்கும் மேற்பட்ட அட்டவணைத்தாள்களைத் தேர்ந்தெடுக்க Ctrl 
ப�ொத்தானை அழுத்தியவாறு, அட்டவணைத்தாள்களின் தத்தல்களின் மீது Click செய்ய வேண்டும். தேர்வு 

செய்யப்பட்ட தாள்களின் தத்தல்களின் நிறம் வெண்மையாக மாறிவிடும். அவ்வாறு தேர்வு செய்யப்பட்ட 

அட்டவணைத்தாள்களில் ஏதேனும் ஒன்றில் செய்யப்படும் மாற்றம், தேர்வு செய்யப்பட்ட  தாள்களில் 

பிரதிபலிக்கும்.

எடுத்துக்காட்டு: கணக்கீட்டுத்தாள்கள் முறையே, Sheet1, Sheet3 மற்றும் Sheet7 ஆகியவற்றை மட்டும் 

தேர்ந்தெடுத்தல்.
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படிநிலை 1: Sheet1 கிளிக் செய்யவும்.

படிநிலை 2: Ctrl ப�ொத்தானை அழுத்திப் பிடிக்கவும்.

படிநிலை 3: Sheet3  மற்றும்  Sheet7ஐ கிளிக் செய்யவும்.

	தே ர்ந்தெடுக்கப்பட்ட தாளின் நிறம் “வெண்மையாக” மாறும் மற்றும் பயனர் செய்யும் மாற்றங்கள் 

எல்லா தாள்களிலும் மாற்றம் செய்யும்.

ஒன்றுக்கும் மேற்பட்ட த�ொடர்ச்சியற்ற தாள்கள் (Sheet1, Sheet3, and Sheet7)

படம்  10.3 தேர்ந்தெடுக்கப்பட்ட த�ொடர்ச்சியற்ற ஒன்றுக்கும் மேற்பட்ட அட்டவணைத்தாள்கள்

10.2 அனைத்துத் தாள்களையும் தேர்ந்தெடுத்தல்

	 அனைத்துத் தாள்களையும் தேர்ந்தெடுக்க ஏதேனும் ஒரு தத்தலின் மீது வலது கிளிக் செய்து, 

த�ோன்றும் மேல் மீட்பு பட்டியலிருந்து “Select All Sheets” தேர்வை தேர்ந்தெடுக்கவும்.
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"Select All Sheets" என்ற 
தேர்வை கிளிக் செய்க

படம் 10.4(அ) அனைத்து கணக்கீட்டுத்தாள்களையும் தேர்ந்தெடுத்தல்

ம�ொத்த தாள்கள்

தேர்ந்தெடுக்கப்பட்ட தாள்கள்

படம் 10.4 (ஆ) அனைத்து கணக்கீட்டுத்தாள்களையும் தேர்ந்தெடுத்தல்

தேர்வை ரத்து செய்தல் 

	தே ர்ந்தெடுக்கப்பட்ட அட்டவணைத் தாள்களின் தேர்வை ரத்து செய்வது மிகவும் எளிதான 

செயல்பாடாகும். கீழ்கண்ட அட்டவணையில் பல்வேறு வழிமுறைகளில், ஒரு தேர்வு செய்யப்பட்ட தாளின் 

தேர்வை எவ்வாறு ரத்து செய்வது என்பது க�ொடுக்கப்பட்டுள்ளது.

 வரிசை எண்  தேர்வு வகை தேர்வை நீக்கும் செயல்

1 ஒற்றைத்தாள்
தேர்வு செய்யாத ஏதேனும் தாளை 

கிளிக் செய்ய வேண்டும்.
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2 த�ொடர்ச்சியில்லா அட்டவணை தாள்கள்
தேர்வு செய்யாத ஏதேனும் தாளை 

கிளிக் செய்ய வேண்டும்.

3
த�ொடர்ச்சியில்லாத ஒன்றுக்கும் 

மேற்பட்ட அட்டவணைத் தாள்கள்

தேர்வு செய்யாத ஏதேனும் தாளை 

கிளிக் செய்ய வேண்டும்.

4 அனைத்து தாள்கள்
தேர்வு செய்யாத ஏதேனும் தாளை 

கிளிக் செய்ய வேண்டும்.

	தே ர்ந்தெடுக்கப்பட்ட தாள்களின் தேர்வை ரத்து செய்ய, சுட்டியை வலது கிளிக் செய்து வரும் 

மேல்மீட்பு பட்டியலில் இருந்து “Deselect All Sheets” என்னும் தேர்வை தேர்ந்தெடுக்கவும்.

10.3 கணக்கீட்டுத்தாளிற்கு மாற்று 
பெயரிடுதல்

	 கணக்கீட்டுத்தாள்களின் க�ொடாநிலை 

பெயரானது Sheet–n என இருக்கும். இதில் n–
என்பது எண்ணாகும். கணக்கீட்டுத்தாளின் 

பெயரை மாற்ற இரண்டு வழிமுறைகள் 

பின்பற்றப்படுகிறது. 

வழிமுறை 1

•	 மாற்றுப் பெயரிட வேண்டிய 

கணக்கீட்டுத்தாளின் தத்தலின் மீது இரட்டை 
கிளிக் செய்யவும்.

•	 ஒரு சிறிய "Rename Sheet"  என்ற உரையாடல் 

பெட்டி படம் 10.5 ல் காட்டியவாறு த�ோன்றும்.

படம் 10.5   Rename Sheet உரையாடல் பெட்டி

புதிய பெயரை தட்டச்சு செய்து, OK ப�ொத்தானை 

கிளிக் செய்யவும்.

வழிமுறை 2

•	 மாற்றுப் பெயரிட வேண்டிய தத்தலின் மீது 

வலது கிளிக் செய்து த�ோன்றும் மேல்மீட்பு 

பட்டியலிலிருந்து Rename Sheet  தேர்வை 

கிளிக் செய்யவும்.

•	 இப்பொழுது Rename Sheet உரையாடல் 

பெட்டி த�ோன்றும் அதில் புதிய பெயரை தட்டச்சு 

செய்து OK ப�ொத்தானை கிளிக் செய்யவும். 

(படம் 10.6 காண்க)

தாளின் பெயர் எழுத்து அல்லது  

எண் அல்லது சிறப்பு குறியீடுகள் 

(& ! @) ப�ோன்றவற்றில் ஏதேனும் ஒன்றை 

க�ொண்டு த�ொடங்க வேண்டும். தாளிற்கு 

தவறான பெயர் மாற்றம்  செய்தால் பிழை 

செய்தி வெளியிடப்படும்.

குறிப்பு 

ஒரு தா
ளி

ல் வ
லது

 

கிளி
க் செய்க

க�ொடாநிலை பெயருடன் Rename உரையாடல் பெட்டி 

புதிய பெயரை இங்கே 
தட்டச்சு செய்யவும்

படம் 10.6   அட்டவணை தாளுக்கு மற்றுப் 

பெயரிடுதல் பெயர்
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10.3.1 அட்டவணைத் தாள்களை சேர்த்தல் மற்றும் நீக்குதல்

	 ஒரு புதிய அட்டவணைத்தாளை உருவாக்கும் ப�ோது தானமைவாக மூன்று தாள்களுடன் த�ோன்றும். 

தேவையெனில் ஒன்று அல்லது மேற்பட்ட கணக்கீட்டுத் தாள்களை சேர்க்கலாம் அல்லது நீக்கலாம்.

10.3.1.1  கணக்கீட்டு தாளை சேர்த்தல்

	 ஏற்கனவே உள்ள அட்டவணைத் தாள்களில் மேற்கொண்டு ஒரு புதிய தாளை சேர்க்க பல்வேறு வழி 

முறைகள்  உள்ளன.

படிநிலை  1:

•	 கணக்கீட்டுத்தாள் தத்தலின் மீது வலது கிளிக் செய்து த�ோன்றும் மேல்மீட்பு  பட்டியிலிருந்து Insert 
Sheet தேர்வை கிளிக் செய்ய வேண்டும்.

(அல்லது)

•	 Insert → Sheet  என்ற கட்டளையைக் கிளிக் செய்ய வேண்டும். 

(அல்லது)

•	 கடைசித் தாளிற்கும், கிடைமட்ட உருள் பட்டைக்கும் இடையே Enter விசையை கிளிக் செய்யவும்.

Insert → Sheet தேர்ந்தெடுக்கவும்

Insert Sheet கிளிக் செய்யவும்

வலது கிளிக் செய்யவும்

அ
ல

்ல
து

படம் 10.7   ஒன்றுக்கும் மேற்பட்ட தாள்களை சேர்த்தல்

படிநிலை 2:

•	 “Insert Sheets”  உரையாடல் பெட்டி த�ோன்றும் (படம் 10.8 காண்க).
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"OK" கிளிக் செய்க

புதிய அட்டவணை தாள் எங்கு சேர்க்கப்பட 
வேண்டும�ோ அந்த அமைவிடத்தை 

அமைக்க ஒரு தேர்வை கிளிக் செய்க

புதிய தாள்

மற்றொரு க�ோப்பில் 
இருக்கும் தாளை இணைக்க

படம் 10.8  Insert Sheet உரையாடல் பெட்டி

இந்த உரையாடல் பெட்டியில்

•	 Position  என்ற பகுதியில் “Before current sheet”  அல்லது  “After current sheet”  என்பதை 

தேர்ந்தெடுக்கவும். “Before” எனும் தேர்வை கிளிக் செய்தால் புதிய தாள் தேர்வு செய்யப்பட்ட தாளின் 

இடது புறமாகவும்,  “After” என்னும் தேர்வை கிளிக் செய்தால் வலது புறமாகவும் சேர்க்கப்படும்.

•	 Sheet பகுதியில் உள்ள No.of sheet என்ற சுழல் பெட்டியில் தேவையான தாள்களின் எண்ணிக்கையை 

தட்டச்சு செய்தோ அல்லது சுழல் அம்பு குறியை பயன்படுத்திய�ோ தரலாம். ஒரு தாள் மட்டும் 

சேர்க்கப்படுமாயின், Name பெட்டி செயல்நிலைக்கு மாற்றப்பட்டு சேர்க்கப்படும் தாளிற்கு புதிய 

பெயரிடலாம்.  ஒன்றிற்கு மேற்பட்ட தாள்கள்  சேர்க்கப்படுமாயின் Name பெட்டி செயல்படாது.

•	 குறைந்தபட்சமாக 1 தாளும் அதிகபட்சமாக 253 தாள்களும் சேர்க்கலாம். (ஓபன் ஆஃபீஸ் கால்க் 4.1.5)

•	 இறுதியாக  OK  ப�ொத்தானை கிளிக் செய்யவும். 

10.3.2 – அட்டவணைத்தாளை நீக்குதல்

அட்டவணைத் தாள்களை தனியாகவ�ோ அல்லது குழுக்களாகவ�ோ நீக்கலாம்.

அட்டவணைத்தாளை நீக்குதல்:

•	 கணக்கீட்டுத்தாள் தத்தலின் மீது வலது கிளிக் செய்து வரும் மேல்நடப்பு பட்டியிலிருந்து “Delete Sheet” 
தேர்வை தேர்வு செய்ய வேண்டும். 

(அல்லது) 

•	 பட்டி பட்டையிலிருந்து Edit → Sheet → Delete  என்ற தேர்வு வரிசையில் செய்யவேண்டும். (படம் 10.9 

காண்க)
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தேர்வு செய்யப்பட்ட தாள்

வலது கிளிக்அல்லது

Edi
t →

 sh
ee

t →
 D

ele
te

படம் 10.9 அட்டவணைத்தாளை நீக்குதல்

3. மேற்கண்ட இரண்டு வழிகளிலும், "தாள்களை 

நிரந்தரமாக நீக்க வேண்டுமா" என்ற எச்சரிக்கை 

செய்தி த�ோன்றும். அதில் Yes என்பதை கிளிக் 

செய்யவும். 

ஒன்றுக்கு மேற்பட்ட தாள்களை நீக்குதல்:

	 ஒன்றுக்கும் மேற்பட்ட தாள்களை 

நீக்குவதற்கு, நீக்க வேண்டிய 

அட்டவணைத்தாள்களை முன்பே கூறப்பட்டுள்ள 

வழிமுறைகளில் தேர்நதெடுத்து, ஏதேனும் ஒரு 

தாள் தத்தலின் மீது சுட்டியை வலது கிளிக் செய்து 

த�ோன்றம் மேல் மீட்பு பட்டியில் Delete Sheet 

என்றத் தேர்வை கிளிக் செய்ய வேண்டும் அல்லது 

பட்டியல் பட்டையில் இருந்து Edit → Sheet → 
Delete என்ற கட்டளையைத் தேர்ந்தெடுக்க 

வேண்டும். அடுத்து வரும் செயல்முறைகள் ஒரு 

அட்டவணைத் தாளை நீக்குவதற்கான 

செயல்முறையை ப�ோன்றதே ஆகும்.

10.4 – நகலெடுத்தல், நகர்த்தல் மற்றும் 
தாள்களின் வரிசையை மாற்றுதல்

	 அட்டவணைத்தாளின் தத்தலின் மீது 

கிளிக் செய்து இழுத்தல் எளிய நகர்த்துதல் 

முறையாகும். 

	 பட்டி பட்டையைப் பயன்படுத்தியும்  ஒரு 

தாளை நகர்த்தலாம்.

1.	 நகர்த்த வேண்டிய தாளின் மீது வலது 
கிளிக் செய்து த�ோன்றும் மேல்மீட்பு 
பட்டியிலிருந்து Move/copy sheet என்ற 
தேர்வைய�ோ அல்லது பட்டிப்  
பட்டையிலிருந்து Edit  → sheet→ move/
copy  என்ற தேர்வைய�ோ கிளிக் செய்ய 
வேண்டும். (படம் 10.10 காண்க)

படம் 10.10 அட்டவணைத்தாளை நகலெடுத்தல் 

அல்லது நகர்த்துதல்

2.	 Move/Copy Sheet  உரையாடல்பெட்டியில் 

அட்டவணைத் தாள் இடம் பெற வேண்டிய  

புதிய நிலையை குறிக்கவும். 
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ஒபன் ஆஃபீஸ் கால்க்-ல்  திறந்து வைக்கப்பட்டுள்ள வேற�ொரு ஆவணத்திற்கும் அட்டவணைத் தாளை 

நகர்த்தலாம்.

3.	 அட்டவணைத்தாளை நகலெடுக்க Copy என்ற விருப்பத்தை தேர்வு செய்யது

4.	  OK ப�ொத்தானை கிளிக் செய்ய வேண்டும்.

10.5 நுண்ணறைகள், வரிசைகள் மற்றும் நெடுவரிசைகளை தேர்ந்தெடுத்தல் 

10.5.1 ஒற்றை நுண்ணறையைத் தேர்ந்தெடுத்தல்: 

•	 சுட்டியின் அம்புக்குறியை தேவையான நுண்ணறையில் வைத்து கிளிக் செய்யவேண்டும் (அல்லது).

•	 தேவையான நுண்ணறை முகவரியை, முகவரி பெட்டியில் நேரடியாக தட்டச்சு செய்து, Enter ப�ொத்தானை 

அழுத்த வேண்டும்.

ஏதேனும் ஒரு நுண்ணைறையை கிளிக் செய்க 

நுண்ணறை முகவரியை தட்டச்சு 

செய்து, Enter ப�ொத்தானை அழுத்தவும்

படம் 10.11 நுண்ணறையை தேர்ந்தெடுத்தல்

10.5.2 ஒன்றுக்கும் மேற்பட்ட நுண்ணறைகளை தேர்ந்தெடுத்தல்:

	த�ொ டர்ச்சியான நுண்ணறைப் பரப்பை விசைப்பலகை அல்லது சுட்டெலி மூலம் தேர்ந்தெடுக்கலாம். 

10.5.2.  ஒன்றுக்கும் மேற்பட்ட நுண்ணறைகளை சுட்டெலி மூலம் தேர்ந்தெடுத்தல்

•	 ஏதேனும் ஒரு நுண்ணறையில் கிளிக் செய்யவும். 

•	 சுட்டெலியின் இடது ப�ொத்தானை அழுத்திப் பிடித்தவாறு சுட்டியை நகர்த்தவும்.

•	 தேவையான நுண்ணறைகளைத் தேர்ந்தெடுத்த பின் சுட்டியின் ப�ொத்தானை விடுவிக்கவும். 
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நுண்ணறைகளின் பரப்பு

தே


ர்தெ


டு
க

்கப்பட்



டு

, 

உ
ய

ர்த்
தி

க
்கா

ட
்டப்ப


ட

்ட
 வ

ரி
சை


க

ள்

தேர்ந்தெடுக்கப்பட்டு, உயர்த்திக்காட்டப்பட்ட நெடுவரிசைகள்

படம் 10.12 ஒன்றுக்கும் மேற்பட்ட நுண்ணறைகளை தேர்ந்தெடுத்தல்

10.5.2.2 ஒன்றுக்கும் மேற்பட்ட நுண்ணறைகளை விசைப்பலகை மூலம்  தேர்ந்தெடுத்தல்:

•	 தேர்ந்தெடுக்கப்பட வேண்டிய நுண்ணறை பரப்பின் ஏதேனும் ஒரு நுண்ணறையில் கிளிக் செய்யவும். 

•	 Shift- ப�ொத்தானை அழுத்தியவாறே, நகர்வு ப�ொத்தான்களைப் பயன்படுத்தி மீதமுள்ள பரப்பினை 

தேர்வு செய்யலாம்.

10.5.3 வரிசை மற்றும் நெடுவரிசையை தேர்ந்தெடுத்தல்:

•	 தேவையான நெடுவரிசையை தேர்ந்தெடுக்க, நெடுவரிசையின் தலைப்பின் மீது  கிளிக் செய்யவும்.

•	 தேவையான வரிசையை தேர்ந்தெடுக்க, வரிசையின் எண்ணின் மீது கிளிக் செய்யவும். 

தேர்வு செய்யப்பட்ட 

நெடுவரிசைகள் 

முழு வரிசையைத் தேர்ந்தெடுக்க, வரிசை 

எண்ணில் கிளிக் செய்க.

முழு நெடுவரிசையைத் தேர்ந்தெடுக்க, 

நெடுவரிசையின் தலைப்பில் கிளிக் செய்க.

படம் 10.13 ஒரு வரிசை மற்றும் நெடுவரிசையை தேர்ந்தெடுத்தல்
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10.5.4  த�ொடர்ச்சியான ஒன்றுக்கும் மேற்பட்ட வரிசை அல்லது நெடுவரிசைகளைத் தேர்ந்தெடுத்தல் 

	தேர் வு செய்யப்பட வேண்டிய வரிசை அல்லது நெடுவரிசையின்  த�ொகுதிகளில் முதலாவது வரிசை 

அல்லது நெடுவரிசையை கிளிக் செய்யவும்.

•	 Shift  ப�ொத்தானை அழுத்திப் பிடித்தவாறு, தேர்வு செய்யப்பட வேண்டிய பரப்பின் கடைசி வரிசை 

அல்லது நெடுவரிசையை கிளிக் செய்யவும்.

(1) நெடுவரிசை தலைப்பை கிளிக் செய்க

(3) கடைசி நெடுவரிசை தலைப்பை கிளிக் செய்க.

தேர்ந்தெடுக்கப்பட்டுள்ள நெடுவரிசைகள்

(2) Shift ப�ொத்தானை 
அழுத்தி பிடிக்கவும்

Shift

படம் 10.14 த�ொடர்ச்சியான வரிசை / நெடுவரிசைகளை தேர்வு செய்தல்

10.5.5	த�ொ டர்ச்சியல்லாத வரிசை அல்லது நெடுவரிசைகளைத் தேர்ந்தெடுத்தல்

•	 தேர்ந்தெடுக்கப்பட வேண்டிய வரிசை அல்லது நெடுவரிசை பரப்பின் முதலாவது வரிசை அல்லது  

நெடுவரிசையை கிளிக்  செய்யவும்.

•	 Ctrl ப�ொத்தானை அழுத்தியவாறு தேவையான வரிசை அல்லது நெடுவரிசையை கிளிக் செய்யவும்.

த�ொடர்ச்சியல்லாத நுண்ணறைகளைத் தேர்ந்தெடுத்தல்

•	 ஒரு நுண்ணறை அல்லது நுண்ணறைகளின் பரப்பை மேற்கண்ட ஏதேனும் ஒரு முறையில் 

தேர்ந்தெடுக்கவும். 

•	 சுட்டியை அடுத்த பரப்பிற்கான த�ொடக்க நுண்ணறை அல்லது தேவையான நுண்ணறைக்கு 

நகர்த்தவும்.

•	 Ctrl ப�ொத்தானை அழுத்தியவாறு நுண்ணறைகளைக் கிளிக் செய்யவும் அல்லது ஏற்கனவே தேர்வு 

செய்த பரப்போடு மற்றொரு பரப்பை தேர்ந்தெடுக்க கிளிக் செய்து இழுக்கவும். 

•	 தேவையெனில் திரும்ப செய்யவும்.
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10.6  வரிசை, நெடுவரிசைகளை மறைத்தல் 
மற்றும் வெளிப்படுதல்

	 வரிசை அல்லது நெடுவரிசைகள் 

மறைக்கப்பட்டிருக்கும் ப�ோது அவற்றை அச்சிட 

முடியாது. ஆனால் அதை சுற்றியுள்ள வரிசை 

அல்லது நெடுவரிசைகளை நகலெடுக்கும் ப�ோது   

மறைக்கப்பட்டுள்ள வரிசை அல்லது 

நெடுவரிசைகள்   நகலெடுக்கப்படும். எ.கா. 

நெடுவரிசை B ஆனது மறைக்கப்பட்டிருந்தால் 

நெடுவரிசை A மற்றும் C  ஐ நகலெடுக்கும் ப�ோதே 

B யும்  நகலெடுக்கப்படும். 

•	 வரிசை மற்றும் நெடுவரிசைகளை மறைக்கவ�ோ 

அல்லது வெளிப்படுத்தவ�ோ பட்டியல் 

பட்டையில்  Format  என்பதை கிளிக் செய்ய 

வேண்டும் அல்லது சுட்டியை வலது கிளிக் 

செய்து த�ோன்றும் மேல்மீட்புப் பட்டியிலிருந்து 

தேவையான கட்டளையை தேர்வு செய்ய 

வேண்டும்.

•	 முதலில் மறைக்க விரும்பும் வரிசை/ 

நெடுவரிசையை தேர்வு செய்யவும்

•	 பிறகு Format → Row → Hide என்ற தேர்வின் 

மூலம் வரிசையையும்,   Format → Column → 
Hide  என்ற தேர்வின் மூலம் நெடுவரிசையும் 

மறைக்கலாம். 

•	 இதையே வலது கிளிக் செய்து, த�ோன்றும் 

மேல்மீட்புப் பெட்டியில் இதையே வலது கிளிக் 

செய்து, த�ோன்றும் மேல்மீட்புப் பெட்டியில் 

“Hide “ விருப்பத்தை தேர்வு செய்யவும். 

•	 மறைந்துள்ள  வரிசை அல்லது நெடுவரிசையை 

வெளிப்படுத்த. Format → Row→ Show  
அல்லது  Format → Column → Show  என்ற 

தேர்வானது பயன்படுகிறது.

•	 மேல்மீட்பு பட்டியின் மூலம் மறைக்க அல்லது 

வெளிப்படுத்த, வலது கிளிக் செய்து,  மேல்மீட்பு 

பட்டியிலிருந்து “Show” என்பதை தேர்வு 

செய்யவும்.. 

10.7 வரிசை மற்றும் நெடுவரிசையை உறைய 
செய்தல் மற்றும் இயல்பு நிலைக்கு திருப்புதல்

	 உறையச் செய்தல் என்பது தேவையான 

வரிசைகளை அட்டவணைத்தாளின் 

மேல்பகுதியிலும், தேவையான நெடுவரிகைகளை 

அட்டவணைத்தாளின் இடது பக்கத்திலும் 

அல்லது இரண்டையும் நிலைக்க செய்தலாகும்.   

அட்டவணைத்தாளுக்குள் திரை உருளச் 

செய்யும்போது உறையச்  செய்த வரிசைகளும், 

நெடுவரிசைகளும் காணும் நிலையிலேயே 

இருக்கும்.

வரிசை அல்லது நெடுவரிசைகளை 

உறையச்(freeze)  செய்தல்:

1)	 உறையச் செய்ய விரும்பும் வரிசையின் கீழ் 

உள்ள வரிசையின் எண்ணெயும் அல்லது உறையச் 

செய்ய விரும்பும் நெடுவரிசையின் வலது 

நெடுவரிசைமீது கிளிக் செய்யவும்.. 

2)	 Window → Freeze தேர்வை  கிளிக் 

செய்யவும்.

வரிசை அல்லது நெடுவரிசையை உறையச் செய்ய 

(Freeze)

1.	 வரிசை கீழ் மற்றும் நெடுவரிசையின் வலது 

புறத்தில் உள்ள நுண்ணறையை கிளிக் 

செய்யவும்.

2.	 WindowsFreeze தேர்ந்தெடுக்கவும்.

3)	 அந்த நுண்ணறையின் மேல் கிடைக்கோடும், 

இடது புறத்தில் நெடுங்கோடும் த�ோன்றும் 

இப்பொழுது திரை உருளச் செய்தால்  க�ோட்டிற்கு 

மேல் மற்றும் இடதுபுறத்தில் உள்ள அனைத்தும் 

நகராமல் காணும் நிலையில் இருக்கும்.

இயல்புநிலையாக்கல் (unfreezing)

1)	 Window → Freeze எனும்  கட்டளையை 

கிளிக் செய்தால் க�ோடுகள் மறைந்து வரிசை 

அல்லது நெடுவரிசை இயல்புநிலைக்கு திரும்ப 

வந்துவிடும்.
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படம் 10.15 வரிசை அல்லது நெடுவரிசை உறைய 

செய்தல் 

10.8 - நுண்ணறைகளை ஒன்றிணைத்தல் 
(Merge Cells

	 ஒன்றுக்கும் மேற்பட்ட நுண்ணறைகளை 

ஒரே நுண்ணறையாக ஒன்றிணைக்க: 

1.	 தேவையான நுண்ணறைகளைத் 

தேர்ந்தெடுக்கவும்.

2.	 Merge Cell  குறும்படம் அல்லது Format → 
Merge Cells என்பதை பட்டிபட்டையில் 

தேர்வு செய்யவும்.

படம் 10.16 நுண்ணறைகளை ஒன்றினைத்தல்

10.9 – நுண்ணறை வடிவூட்டல், அட்டவணைத்தாள் பாதுகாத்தல், நுண்ணறை பூட்டுதல் மற்றும் 
மறைத்தல்

	 நுண்ணறையில் உள்ள தரவை வடிவூட்டல் செய்தல் என்பது உரைக்கு கூடுதல் விளைவை அளிக்கும் 

என்பதாகும். எழுத்து வகை, அளவு மாற்றுதல், தடிப்பாக்குதல், அடிக�ோடிடுதல், சாய்ந்த எழுத்துக்களாக 

(italics) மாற்றுதல் ப�ோன்றவை கூடுதல் விளைவாகும். அட்டவணைச் செயலியில் உள்ள தரவை பல 

வழிகளில் வடிவமைக்கலாம். (படம் 10.17 காண்க)

10.17   வடிவூட்டல் கருவிப்பட்டை

10.9.1 – வடிவூட்டல் கருவிப் பட்டையிலுள்ள பணிக்குறிகள்

1.	  எழுத்துரு கீழிறக்கு பெட்டி: பல்வேறு எழுத்து வடிவுகளை இந்த பட்டியலில் 

இருந்து தேர்ந்தெடுக்கலாம்.

2.	  எழுத்து அளவு கீழிறக்கு பெட்டி:  இது எழுத்துருக்களின் அளவை மாற்றி அமைக்கப் 

பயன்படுகிறது.

3.	  எழுத்துருக்களை தடிமனாக்குதல் பணிக்குறி: இதனைப் பயன்படுத்தி தரவுகளை தடித்த  

எழுத்துக்களில் காட்டலாம் இதற்கான  குறுக்குவழி Ctrl+B.

4.	  சாய்வெழுத்து பணிக்குறி: இது தரவுகளை சாய்ந்த வடிவில் காட்டப்பயன்படும். இதற்கான 

குறுக்கு வழி Ctrl+I.

5.	  அடிக்கோடிடுதல் பணிக்குறி: இது தரவுகளை அடிக்கோடிட்டுக் காட்டப் பயன்படுகிறது. 

இதற்கான குறுக்குவழி Ctrl+ U
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6.	  நான்கு இசைவு பணிக்குறிகள் – இவை தரவுகளை  இடது, வலது, மையம் மற்றும் 

நேர்த்தி   இசைவுகளில் ஒழுங்குபடுத்த உதவுகிறது. இதற்கான குறுக்கு வழிகள் இடது - Ctrl+L, 
வலது - Ctrl +R , மைய - Ctrl+ E  மற்றும்  நேர்த்தி - Ctrl+ J.

7.	  எண் வடிவமைப்பு பணிக்குறிகள்:  பணக் குறியீடு (Currency)  பணிக்குறி, 
சதவீதம் (Percent) பணிக்குறி, இயல்பு நிலை (Standard) பணிக்குறி, தசம புள்ளியை சேர்த்தல், 

தசம புள்ளியை குறைத்தல் ப�ோன்ற பணிக்குறிகளைப் பயன்படுத்தலாம். இவற்றுள், பணக் குறியீடு, 

சதவீதம் மற்றும் இயல்பு நிலைக்கு முறையே Ctrl+ Shift +4, Ctrl+ Shift +5 மற்றும் Ctrl+ Shift +6 
குறுக்கு வழிகளை பயன்படுத்தலாம்.

8.	  உள் தள்ளல் மிகுப்பு மற்றும் குறைப்புப் (Increase indent and Decrease indent) 

பணிக்குறிகள்: நுண்ணறையில் உள்ள தரவுகளை உள்தள்ளப் பயன்படுகிறது.

9	   எல்லைப் பணிக்குறி (Borders): எல்லையின் வகை (Border style), பின்புற நிறம் 

(Background Color) மற்றும் எழுத்து நிறம் (Font color) பணிக்குறிகள் முறையே அட்டவணைத்தாள்  

க�ோடுகளின் நிறம், பின்புற வண்ணம் மற்றும் தரவுகளின் நிறத்தை மாற்ற பயன்படுகிறது.

10.9.2 - Formatting  Cells உரையாடல் பெட்டியைப் பயன்படுத்தி  வடிவூட்டல் செய்தல்

	 மேற்கண்ட அனைத்து வடிவூட்டல் பணிக்குறிகளை ஒவ்வொன்றாகத்தான் பயன்படுத்தமுடியும். 
ஆனால்  Format → Cells    உரையாடல் பெட்டியைப் பயன்படுத்தி மேற்கண்ட அனைத்து வடிவூட்டல்களையும் 

செய்வத�ோடு, முன்காட்சியையும் (Preview)  பார்க்கலாம். தேர்ந்தெடுக்கப்பட்ட நுண்ணறையில்  வலது 

கிளிக் செய்து, Format Cells என்பதை தேர்ந்தெடுக்க வேண்டும் அல்லது Format → Cells அல்லது Ctrl → 
1  பயன்படுத்தி படம் 10.18ல் காட்டப்பட்டுள்ளவாறு Format Cells உரையாடல் பெட்டியை பெறலாம்.

படம் 10.18 Format Cells உரையாடல் பெட்டி
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Numbers  தத்தல்:

	 Category, Format, Language, Decimal places, Leading Zeros மற்றும்  Thousands separator 
ப�ோன்றவை எண் வடிவூட்டல் தேர்வுகளாகும். பயனர் வரையறுக்கும் வடிவூட்டல்களையும் சேர்ந்துக் 

க�ொள்ளலாம். செய்யப்படும் மாற்றங்களை முன்காட்சியாக (Preview) காண்பது இதன்  சிறப்பாகும்.

Cell Protection தத்தல்:

	 ஓபன் ஆஃபீஸ் கால்க் நுண்ணறையிலுள்ள தரவுகளை எதிர்பாராத மாற்றங்களில் இருந்து தடுத்து 

பாதுகாக்கிறது. கடவுச்சொல் (Password)  மூலமாக பாதுகாப்பைக் க�ொடுக்கிறது. சரியான கடவுச்சொல் 

மூலம் அங்கீகாரம் அளிக்கப்படுகிறது. இதன் மூலம் முழு அட்டவணைத்தாளும் பாதுகாப்பு முறைமையில் 
(Protected mode) இருக்கும் ப�ோது Protected பண்புக்கூறுகள் நுண்ணறைப் பாதுகாப்பை மேலும் உறுதிச் 

செய்கிறது.

படம் 10.19 Format Cell உரையாடல் பெட்டி Cell Protection தத்தல்

1.	 பாதுகாப்பு கூறு தேவைப்படும் நுண்ணறைகளைத் தேர்ந்தெடுக்கவும்.

2.	 Format → Cells உரையாடல் பெட்டியில் Cell Protection  தத்தலை கிளிக் செய்யவும்.

3.	 முழு ஆவணத்தையும் கடவுச்சொல் மூலம் பாதுகாக்க Tools → Protect Document → Sheet கட்டளையை  கிளிக் 

செய்தால் படம் 10.20ல் காட்டப்பட்டுள்ளவாறு Protection Sheet உரையாடல் பெட்டி த�ோன்றும். இதில் Password 

மற்றும் Confirm உரைப் பெட்டிகளில் ஒரே கடவுச்சொல்லை தட்டச்சு செய்து, OK ப�ொத்தானை கிளிக் செய்ய 

வேண்டும்.

4.	 Hide formula தேர்வின் மூலம் வாய்ப்பாடுகளை மறைத்து பாதுகாக்கலாம்.
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5.	 Hide when printing  தேர்வின் மூலம் அச்சிடப்படும் ப�ோது, பாதுகாக்கப்பட்ட நுண்ணறைகள் 

மறைக்கப்படும்.  இவை திரையில் மறைந்திருக்காது.

6.	 Ok ப�ொத்தானை கிளிக் செய்யவும்.

கடவுச்சொல்லின் நீளம் குறைந்தது 5 எழுத்துகளில் இருக்கவேண்டும்.

படம் 10.20 Protect Sheet உரையாடல் பெட்டி

10.10 – நுண்ணறை பார்வையிடல் 

10.10.1 ஒப்பீட்டு நுண்ணறை முகவரி (Relative Addressing)

	 கீழே க�ொடுக்கப்பட்டுள்ள அட்டவணைத்தாளில், A1 முதல்  A3 வரை உள்ள நுண்ணறை பரப்பில் 

உள்ள மதிப்புகளின் கூட்டுத் த�ொகையை கணக்கிடுவதற்கு  நுண்ணறை A4 ல் =SUM(A1:A3) என்றச் 

செயற்கூறு  பயன்படுத்தப்பட்டுள்ளது.  இதே ப�ோன்று நுண்ணறைகள் B1முதல் B3 வரையுள்ள பரப்பின் 

மதிப்புகளை கணக்கிடுவதற்கு, நுண்ணறை A4ல் உள்ள செயற்கூறு B4ல் நகலெடுத்து ஒட்டப்படும் ப�ோது, 

செயற்கூறில் குறிப்பிடப்பட்ட நுண்ணறை முகவரிகள் =SUM(B1:B3) என்று  தானாகவே  மாற்றப்பட்டிருக்கும்.

 

படம் 10.21 ஒப்பீட்டு நுண்ணறை முகவரி 
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10.10.2 தனித்த நுண்ணறை முகவரி (Absolute Addressing):

	 இது ஒப்பீட்டு நுண்ணறை முகவரிக்கு எதிர்மறையானது.  இந்த வகைப் பார்வையிடலில், வாய்ப்பாடு 

அல்லது செயற்கூறில் நுண்ணறைகளின் முகவரிகளை குறிப்பிடும் ப�ோது அதன் வரிசை எண் மற்றும் 

நெடுவரிசைக்கு முன்பும் $  என்ற குறியீடு இட வேண்டும்.

	 கீழே க�ொடுக்கப்பட்டுள்ள எடுத்துக்காட்டில், A4ல் உள்ள செயற்கூறில், நுண்ணறை பரப்பின் 

த�ொடக்க முகவரி A1 என்பது   $A$1 என்றும், இறுதி முகவரி A3 என்பது $A$3 என்றும் குறிப்பிடப்பட்டு,    
=SUM($A$1:$A$3) என வரையறுக்கப்பட்டுள்ளது. இதன் மூலம் இந்த செயற்கூறு தனித்த நுண்ணறை 

பார்வையிடல் வகையாக மாற்றப்பட்டுள்ளது. இந்த வாய்ப்பாட்டை B4க்கு நகலெடுத்து ஒட்டும்போது   

செயற்கூறு நுண்ணறை முகவரி மாறாமல், நுண்ணறை A4ல் என்ன மதிப்பு விடையாக வந்தத�ோ  அதே 

மதிப்பு தான் நுண்ணறை B4லும் வரும். 

படம் 10.22 தனித்த  நுண்ணறை முகவரி 

10.11– ஓபன் ஆஃபீஸ் கால்க் செயற்கூறுகள்

10.11.1 – அறிமுகம்

	 செயற்கூறு என்பது முன்னரே வறையறுக்கப்பட்ட வாய்ப்பாடு ஆகும். இது அட்டவணைச் செயலியில் 

உள்ள தரவுகளைக் கையாளவும், பகுப்பாய்வு செய்வதற்கும் பயன்படுகிறது. அட்டவணைத் தாளில், 

தேவையான விடையை பெறுவதற்கு வாய்ப்பாடுகளை கட்டமைப்பதை செயற்கூறுகள் எளிதாக்குகின்றன. 

அட்டவணைச் செயலியில் கணக்கீடுகளை செய்வதற்கு சமன்பாடுகளை வரையறுப்பதற்கான மாறிகள் 

என்பது, தரவுகள் இடம்பெற்றுள்ள நுண்ணறைகளின் முகவரியை குறிக்கும். ஓபன் ஆஃபீஸ் கால்க்-ல் 

தரவுகளை பகுப்பாய சுமார் 350க்கும் அதிகமான செயற்கூறுகளை க�ொண்டுள்ளது. இந்த செயற்கூறுகள் 

எண்கள், தேதி, நேரம் மற்றும் உரை தரவுகளின் மீது செயல்படும்.

10.11.2 – செயற்கூறுகளின் வகைகளைத் தெரிந்துக�ொள்ளுதல்

	 அட்டவணைச் செயலியின் உள்ளிணைந்த செயற்கூறுகள் அதன் முக்கிய சிறப்பியல்பு ஆகும். 

ஓபன் ஆஃபீஸ் கால்க்-ல் செயற்கூறுகளை, Function wigard உரையாடல் பெட்டியின் மூலம் பெற முடியும். 

Insert → Function கட்டளை அல்லது Ctrl + F2 விசைப் பலகை குறுக்குவழியின் மூலம் படம் 10.22ல் 

காட்டப்படுள்ளவாறு Functiona wizard உரையாடல் பெட்டியை பெறலாம். 
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படம் 10.23 Function Wizard உரையாடல் பெட்டி

1.	 Category கீழிறங்குப் பெட்டியிலிருந்து 

செயற்கூறின் வகையைத் 

தேர்ந்தெடுக்கவேண்டும். Function    பட்டியல், 

தேர்ந்தெடுக்கப்பட்ட செயற்கூறு வகையின், 

செயற்கூறுகளை மட்டும் பட்டியலிடும். 

இதிலிருந்து  தேவையன செயற்கூற்றை 

தேர்ந்தெடுக்கவும்.

2.	 செயற்கூறு தேர்ந்தெடுக்கப்பட்டவுடன் 

அதற்கான விளக்கம் உரையாடல் பெட்டியின் 

வலதுபுறம் த�ோன்றும்.  தேவையான 

செயற்கூறின் மீது இரட்டை கிளிக் செய்யவும்.

3.	 இப்போழுது உரையாடல் பெட்டியில் த�ோன்றும் 

உரைப்பெட்டியில் தேவையான தரவை 

உள்ளிட்டால் Result உரைப்பெட்டியில் அதன் 

விடை த�ோன்றும்.

10.11.3 – கணித மற்றும் புள்ளியியல்  
செயற்கூறுகளுடன் செயல்படுதல்்

10.11.3.1 - கணித செயற்கூறுகள்

	 Category வகையிழுப் பட்டியிலுள்ள   
Mathematical தேர்வின் மூலம் கணித 

கணக்கீடுகளைச் செய்யும் பல்வேறு 

செயற்கூறுகளை பெறலாம்.

படம் 10.24 கணித செயற்கூறுகள்

சில கணித செயற்கூறுகளை கீழே காணலாம்:

ABC ( Number / Cell address)

	 இந்த செயற்கூறு, க�ொடுக்கப்பட்ட ஒரு 

எண்ணின் நேர்மறை மதிப்பை விடையாக 

க�ொடுக்கப் பயன்படும் செயற்குறாகும். 

எடுத்துக்காட்டு:

=ABS(-76)  என்பது 76 என்ற எண்ணையும்,

=ABS(74)  என்பது 74, என்ற எண்ணையும்.
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=ABS(0)  என்பது 0 என்ற எண்ணையும் விடையாக 

தரும்.

ACOS (Number/Cell Address) 

	 இந்த செயற்கூறு தலைகீழ் திரிக�ோண 

க�ொசைன் (cosine) எண்ணைத் திருப்பி 

அனுப்புகிறது.  இந்த எண்ணானது ஒரு க�ோணம் 

(angle) ஆகும்.   இந்த க�ோணத்தில் மதிப்பு 0.0 
முதல் +PI (π )  க்கு இருக்க வேண்டும். Degrees  
செயற்கூறு, க�ோணத்தை பாகை (degresss) 

மதிப்பில் திருப்பி அனுப்புகிறது.

எடுத்துக்காட்டு

=ACOS(-1) செயற்கூறு 3.14159265358979  
என்ற மதிப்பு திருப்பி அனுப்புகிறது.

ACOSH (Number/Cell Address)

	 இந்த செயற்கூறு தலைகீழ் பரவளைய 

க�ொசைன் எண்ணைத் திருப்பி அனுப்புகிறது. 

இந்த  எண்  +1.0. க்கு சமமாகவ�ோ அல்லது 

அதிகமாகவ�ோ  இருக்கலாம்.

எடுத்துக்காட்டு

=ACOSH(1), 0 என்ற மதிப்பு திருப்பி அனுப்புகிறது. 

=ACOSH(COSH(4)), 4 என்ற மதிப்பு திருப்பி 

அனுப்புகிறது.

ACOT(Number/Cell Address)

	 இந்த செயற்கூறு தலைகீழ் திரிக�ோண 

எதிர் த�ொடுக்கை (cotangent) எண்ணைத் திருப்பி 

அனுப்புகிறது. எதிர் த�ொடுக்கை க�ோணமானது 

ஓர் எண்ணாகும். இந்த க�ோணம் 0.0 முதல் 
+PIக்குள் இருக்க வேண்டும். Degees  செயற்கூறு  

க�ோணத்தை பாகை (degrees) மதிப்பில் திருப்பி 

அனுப்புகிறது.

எடுத்துக்காட்டு

=ACOT(1) செயற்கூறு 
0.785398163397448(PI/4 radians) என்ற 

மதிப்பு திருப்பி அனுப்புகிறது.

ASIN (Number/Cell Address)

	 இந்த செயற்கூறு தலைகீழ் திரிக�ோண 

சைன் (sine) எண்ணைத் திருப்பி அனுப்புகிறது. 

இந்த எண் சைன் க�ோணமாகும். இந்த க�ோணம் 
-PI/2 முதல் +PI/2க்குள் இருக்கவேண்டும்.  

Degrees செயற்கூறு க�ோணத்தை பாகை 
(degrees) மதிப்பில் திருப்பி அனுப்புகிறது.

எடுத்துக்காட்டு

=ASIN (0) செயற்கூறு 0 என்ற மதிப்பு திருப்பி 

அனுப்புகிறது.

=ASIN(1) 1.5709963267949(PI/2 radians) 

என்ற மதிப்பை திருப்பி அனுப்பும்.

=DEGREES(ASIN (0.5)) 30 என்ற மதிப்பை 

திருப்பியனுப்பும். SINE 30 மதிப்பு 0.5 ஆகும்.

ATAN (Number/Cell Address)

	 இந்த செயற்கூறு தலைகீழ் திரிக�ோண 

tangent என்னைத் திருப்பி அனுப்புகிறது. இந்த 

எண் க�ோணமாகும். இந்த க�ோணம் -PI/2 முதல் 

PI/2 க்குள் இருக்கும் Degrees செயற்கூறு 

க�ோணத்தை பாகை (degrees) மதிப்பில் திருப்பி 

அனுப்புகிறது.

எடுத்துக்காட்டு

=ATAN (1) என்பது 0.785398163397448 
(PI/4 radians) என்ற மதிப்பு திருப்பி அனுப்புகிறது.

=DEGREES (ATAN (1)) என்பது 45 என்ற 

மதிப்பு திருப்பி அனுப்புகிறது. TAN(45)-ன் மதிப்பு 

1 ஆகும். 

CEILING (Number; Significance; Mode)

	 இந்த செயற்கூறு க�ொடுக்கப்பட்ட 

எண்ணை Significance இலக்கத்தின் நெருங்கிய 

மடங்கின் முழு  எண்ணாக மாற்றுகிறது. Number  

என்பது முழு எண்ணாக மாற்றப்பட்ட வேண்டிய 

எண் Significance என்பது அந்த எண்ணை முழு 

எண்ணாக மாற்றுவதற்கான மடங்கு Mode 
என்பது விருப்பு மதிப்பு.  Mode அளபுரு 

க�ொடுக்கப்பட்டு அதன் மதிப்பு 0 அல்லாத 
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எண்ணாக மற்றும்  Number, Significance இரண்டு 

எதிர்ம எண்ணாக இருந்தால் எண்ணின் தனித்த 

மதிப்பை அடிப்படையாகக் க�ொண்டு எண் முழு 

எண்ணாக மாற்றப்படுகிறது.  Microsoft Excel –
க்கு இதை  Export  செய்யும் ப�ோது Mode அளபுரு 

நீக்கப்படும் ஏன்னென்றால் மூன்றாம் அளபுருவை  
அதிகரிக்காது.

எ.கா

=CEILING(15.5;2;2) என்பது  16 என்ற மதிப்பு 

திருப்பி அனுப்புகிறது.

=CEILING(-11;-2) என்பது -10 என்ற மதிப்பு 

திருப்பி அனுப்புகிறது.

=CEILING(-11;-2;0) என்பது -10 என்ற மதிப்பு 

திருப்பி அனுப்புகிறது.

=CEILING(-11;-2;1) என்பது -12 என்ற மதிப்பு 

திருப்பி அனுப்புகிறது.

COMBIN (Count1; Count2)

	 இது க�ொடுக்கப்பட்ட எண்ணின் ப�ொருள் 

சேர்க்கையினை க�ொடுக்கிறது. Count1 குழுவில் 

உள்ள உருப்படிகளின் எண்ணிக்கை Count2 
என்பது குழுவில் உள்ள தேர்ந்தெடுக்கப்படும் 
உருப்படிகளின் எண்ணிக்கை COMBIN என்பது 

உருப்படிகளை தேர்தெடுக்கும் வழிமுறையாகும். 

எ.கா A,B மற்றும் C குழுவிலிருந்து 2 உருப்புடிகள் 
3 வழிகளில் தேர்ந்தெடுக்கப்பட்டால் அவை AB,AC  
மற்றும் BC  Count1!/(Count2!*(Count1-
Count2)!) என்ற வாய்ப்பாட்டை COMBIN 
பயன்படுகிறது.

எடுத்துக்காட்டு:

=COMBIN(3; 2) என்பது 3, என்ற மதிப்பு திருப்பி 

அனுப்புகிறது.

=COMBIN(5; 3) என்பது 10, என்ற மதிப்பு திருப்பி 

அனுப்புகிறது. 

COMBINA (Count1; Count2)

	 இது க�ொடுக்கப்பட்ட எண்ணின் ப�ொருள் 

சேர்க்கையின் எண்ணிக்கையை க�ொடுக்கிறது. 

ஏற்கனவே உள்ள உருப்புகளின் மாற்றுமுறையும் 

இந்த எடுத்துக் க�ொள்ளப்படுகிறது. Count1  
குழுவில் உள்ள உருப்படிகளின் எண்ணிக்கை 

(Item) Count 2 குழுவில் உள்ள தேர்ந்தெடுக்கப்படும் 

உருப்படிகளின் எண்ணிக்கை. COMBINIA  
என்பது தனித்தன்மையான வழிகளின் மூலம் 

உருப்படிகளைத் தேர்ந்தெடுக்கிறது. 

தேர்ந்தெடுக்கும் வரிசைமுறை எப்படி 

வேண்டுமானாலும் இருக்கலாம். ஏற்கனவே வந்த 

உருப்படிகள் அனுமதிக்கப்படுகிறது. ‘எ.கா A,B 
மற்றும்C குழுவில் இருந்து 2 உருப்படிகள் 6 

வழிகளில்  AB, BA, AC, CA, BC , CB    
அமைக்கலாம்.

=(Count 1+Count2-1)! (Count2!(count1-1)!  
என்ற வாய்ப்பாட்டை COMBINIA  
பயன்படுத்துகிறது.

Example
=COMBINA(3;2) returns 6, =COMBINA(4;3) 
returns 20

COS(Number)

	 இது எண்ணின் திரிக�ோண Cosine 
மதிப்பை திருப்பி க�ோண சுற்றளவுடன் திருப்பி 

அனுப்புகிறது. க�ோணத்தை பாகை மதிப்பில் 

திருப்பி தர RADIANS சார்பு பயன்படுகிறது.

Examples:

=COS(PI()/2) returns 0, the cosine of PI/2 
radians.

=COS(RADIANS(60)) returns 0.5, the cosine of 
60 degrees.

COUNTBLANK (Range)

	 இது நுண்ணறைப் பரப்பில் உள்ள காலி 

நுண்ணறைகளின் எண்ணிக்கையை திருப்பி 

அனுப்பும்

எ.கா

=COUNTBLANK (A1:B2) ஒருவேளை A1, A2, 
B1 மற்றும் B2  காலியாக இருந்தால் 4 என்ற 

மதிப்பைத் திருப்பி அனுப்பும்.

Chapter 10.indd   192 20-04-2020   16:00:47



192 193

COUNTIF (Range; Criteria)

	 Range முறைக்கு  உட்பட்ட பரப்பாகும்.

எ.கா:

	 Criteria என்ற வரன்முறையானது எண் 

அல்லது க�ோவை அல்லது சமமாக இருக்கலாம் 

.இது எந்த நுண்ணறைகளை என்ன வேண்டும் 

என்று தீர்மானிக்கிறது. தேடும் உரையை சாதாரண 

க�ோவை அமைப்பிலும க�ொடுக்கலாம். “b.*” என்ற 

கட்டளை “b”  ல் த�ொடங்கும். அனைத்து 

ச�ொற்களையும் க�ொடுக்கும். தேடல் சரமாக 

இருந்தால் “ “ என்ற குறிக்குள் க�ொடுக்க 

வேண்டும். 

	 A1:A10 வரையான பரப்பு 2000-2009 
வரையான எண்ணைக் க�ொண்டுள்ளது. 

நுண்ணறை B1-ல் 2006 என்ற  எண்ணை 

க�ொண்டுள்ளது. நுண்ணறை B2-ல். சமன்பாட்டை 

உள்ளிடவும்.

=COUNTIF (A1:A10;2006) – திருப்பி அனுப்பும் 

மதிப்பு 1

=COUNTIF (A1:A10;B1) -  திருப்பி அனுப்பும் 

மதிப்பு  1

=COUNTIF (A1:A10;">=2006") – திருப்பி 

அனுப்பும் மதிப்பு  4

=COUNTIF (A1:A10;"<"&B1) - when B1 
இருந்தால் 2006,  திருப்பி அனுப்பும் மதிப்பு 6

=COUNTIF (A1:A10;C2)  C2   >2006 ஆக 

இருந்தால் A1:A10பரப்பில் > 2006 
நுண்ணறைகளை  மட்டும் என்னும்.

 =COUNTIF (A1:A10;"<0") என்னும், எதிர்ம 

எண்ணை மட்டும் என்னும்.

10.11.3.2 - புள்ளியியல் சார்புகள் (Statistical 
functions)

படம் 10.25 புள்ளியியல் சார்புகள்

COUNT(Value1; Value2; ... Value30)

	 அளபுருகளின் பட்டியலில் உள்ள 

எண்களை எண்ணும், உரைகள் தவிர்க்கப்படும் . 
Value1; Value2; ... Value30  என்பது 1முதல் 30 

வரையான மதிப்புகள் அல்லது பரப்பில் உள்ள 

மதிப்புகளை எண்ணும்.

எ.கா

=COUNT(2;4;6;"eight") = 3. எண்களின்  

எண்ணிக்கை 3. Eight என்பது உரை ஆதலால்  

எண்ணிக்கையில் சேர்க்கப்படவில்லை.

COUNTA (Value1; Value2; ... Value30) 

	 அளபுருகளின் பட்டியலிலுள்ள எண்களை 

எண்ணும். உரைகளும் எண்ணப்படும், சரத்தின் 

நாம்  0. ஆக இருந்தாலும் எண்ணிக்கைக்கு 

எடுத்துக்கொள்ளப்படும்.  Value1; Value2; ... 
Value30  என்பது 1 to 30  வரையான எண்கள் 

எண்ணிக்கைக்கு எடுத்துக்கொள்ளப்படும்.
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எ.கா

value 1…4 புலங்களிலுள்ள உள்ளீடுகள் 2,4,6 
மற்றும் எட்டு இதன் எண்ணிக்கையை கணக்கி

=COUNTA(2;4;6;"eight")=4. இதன் 

எண்ணிக்கை 4.

CORREL(Data1; Data2)

	 இது இரண்டு தரவு குழுக்கு  இடையையான  

correction coefficient திருப்பு அனுப்பும்  Data 1 

முதல் தரவு குழு, Data2 இரண்டாவது தரவு குழு 1 

எ.கா

=CORREL(A1:A20;B1:B20) இரண்டு தரவு 

குழுக்களுக்கு இடையையான  lines correction? 

யை கணக்கீட்டு  corretation coefficient 
க�ொடுக்கிறது..

LARGE (Data; Rank_C)
	 க�ொடுக்கப்பட்டதரவு குழுவின்  Rank_C  
வது பெரிய மதிப்பை திருப்பி அனுப்புகிறது Data   
என்பது நுண்ணணுப் பரப்பு  Rank –C  என்பது 

மதிப்பின் தரவரிசை.

எ.கா

=LARGE  (A1 : C50; 2)-  பரப்பு (A1:C50 – ல் 

இரண்டாவது பெரிய மதிப்பைத் திருப்பி 

அனுப்புகிறது.

SMALL (Data; Rank_C)

	 க�ொடுக்கப்பட்ட தர குழுவின் Rank-C வது  

சிறிய மதிப்பை திருப்பி அனுப்புகிறது  data என்பது 

நுண்ணறைப் பரப்பு  Rank-C  என்பது மதிப்பின் 

தரவரிசை

எ.கா

=SMALL(A1:C50;3) பரப்பு  A1:C50. –ல் 3 வது 
சிறிய மதிப்பை திருப்பி அனுப்புகிறது.

AVERAGE(Number1; Number2; ... 
N u m b e r 2 0 )

	 அளபுருக்களின் சராசரியைத் திருப்பி 

அனுப்புகிறது. . Number1; Number2; ... 

Number20  எண் படிவ  1- 20 வரையிலான பரப்பு 

அல்லது என்  மதிப்பாகும்.

எ.கா:

=AVERAGE (A1:A20) பரப்பு A1:A20 

வரையிலான சராசரி மதிப்பை திருப்பி 

அனுப்புகிறது. 

10.11.4 – தருக்க வகை சார்புகளுடன் செயல்படல் 

(Working with the functions in Logical 
Category )

IF (Test; TrueValue; FalseValue)

	த ருக்க ச�ோதனையைக் குறிக்கிறது. 

ச�ோதனை என்பது மதிப்பு அல்லது க�ோவையாக 

இருக்கலாம். அதன் மதிப்பு True  அல்லது False 
ஆகும். தருக்க  ச�ோதனை True  ஆக இருந்தால் 

True value –ல் உள்ள மதிப்பும்  false  ஆக் 

இருந்தால்  FALSE value  -ல் உள்ள மதிப்பும்  

திருப்பி அனுப்பும்.

Examples

=IF(A1>5;”True”;"too small") A1-ன் மதிப்பு 5 
விட பெரிதாக இருந்தால், True எனும் உரை இயக்க 

நுண்ணறையில்  current cell த�ோன்றும் 

இல்லையேல் “False” என்று த�ோன்றும் ( “ “  குறி 

இல்லாமல்).

10.11.5 – தேதி மற்றும் நேரம் சார்புகளுடன் 

செயல்படுதல்

	 Open Office Calc தேதி/ நேரத்தை 

எண்ணாக மதிப்பிடுக்கிறது ஒரு நுண்ணறையில் 

க�ொடுக்கப்பட்ட தேதி அல்லது நேர மதிப்பின் 

வடிவத்தை மாற்ற  Format→cell  என்பதை 

தேர்ந்தெடுத்தபின். த�ோன்றும்  Format cells 
உரையாடல் பெட்டியில்  numbers tabயை கிளிக்  

செய்தால் எண் வடிவமைக்கு தேவையான 

சார்புகள் இருக்கும்.
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படம் 10.26 தேதி மற்றும் நேரம் சார்புகள்

10.11.6 – உரை வகையான சார்புகளுடன் செயல்படல் 

CONCATENATE("Text1"; "Text2";"Text3"; ...)

	 ஒன்றிற்க்கு மேற்பட்ட சரங்களை ஒன்றிணைக்கிறது  Text1; Text2; Text3; ...  என்பவை  1 முதல் 3 
வரையிலான உரைகளை ஒன்றிணைத்து ஒரே சரமாக க�ொடுக்கிறது..

எ.கா.

=CONCATENATE("Good ";"Morning ";"Mr. ";"Ramki")  Good Morning Mr. Ramki என்பதை 

திருப்பி அனுப்பும்.

DECIMAL("Text"; Radix)

	 க�ொடுக்கப்பட்ட சரத்தை (Text)  Radix-ல் எண்முறைக்கு ஏற்ப நேர்ம முழு எண்ணாக மாற்றுகிறது.  
Text என்பது மாற்றப்படவேண்டிய உரையாகும். பதினாறுநிலை எண்ணையும் மற்றும் நுண்ணறை 

முகவரியையும் வேறுபடுத்த  பதினாறு நிலை எண்ணை “   ”, குறிக்குள் க�ொடுக்க வேண்டும். எ.க “A1" 
அல்லது “FACE Radix   என்பது எண்முறைமையின் அடிமானம் இது நேர்ம எண்  2-லிருந்து 36க்கு 

இருக்கலாம்

எ.கா.

=DECIMAL("17";10) திருப்பு அனுப்பும் 17. =DECIMAL("FACE";16) திருப்பு அனுப்பும் 64206.

=DECIMAL("0101";2) திருப்பு அனுப்பும் 5.
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10.12 – OpenOffice Calc –ல் வரைபடம்

10.12.1 – அறிமுகம்

	 வரைபடம் என்பது திறன்மிக்க முறையில் 

தரவுகளை படிப்பதற்கு  எளிதாக புரிந்து 

க�ொள்கின்ற வகையில்  படங்களாக அளிப்பதாகும். 
Openoffice Calc–ல் பல்வேறுபட்ட  

தரவுகளுக்கான வரைபடங்கள் உள்ளன. இது 

தரவுகளை மிகச் சிறந்த வரைபட வடிவில் 

உருவமைத்து மேம்படச் செய்கிறது. 

10.12.2 – வரைபட வகைகள் தெரிந்து   க�ொள்ளல் 

	 பல வகையான வரைபடங்கள் தரவுகளைக்  

க�ொண்டு உருவாக்கப்படும் படங்களாக 

உருவாக்கப்படுகின்றன.  வரைபடம் உருவாக்குதல் 

மற்றும் காட்சியமைத்தல் கீழே 

விவரிக்கப்பட்டுள்ளது.

1.	 நெடுவரிசை வரைபடம் (Column charts)

2.	 பட்டை வரைபடம் (Bar charts)

3.	 வட்ட வரைபடம் (Pie charts)

4.	 பரப்பு வரைபடம் (Area charts)

5.	 க�ோட்டு வரைபடம் (Line charts)

6.	 சிதறல் வரைபட்ம் (Scatter or XY charts)

7.	 குமிழி வரைபடம் (Bubble charts)

8.	 வலை வரைபடம் (Net charts)

9.	 இருப்பு வரைபடம் (Stock charts)

10.	 நெடுவரிசை மற்றும் க�ோட்டு வரைபடம் 
(Column and line chart)

நெடுவரிசை வரைபடம் (Column Charts)

	  இது நெடும்பட்டைகளைக் க�ொண்ட 

வரைபடமாகும். ஒவ்வொரு பட்டையின் உயரம் 

அதன் மதிப்பிற்கு சரியான அளவு விகிதம் 

க�ொண்டதாகும் X அச்சு வகையினையும் Y அச்சு 

வகையினை மதிப்பையும் குறிக்கிறது.

	 Normal  என்ற துணை வகை வகையின் 

அனைத்து மதிப்புகளையும் அடுத்தத்து 

காட்டுகிறது ஒவ்வொரு தனித்த மதிப்பும் பிற 

மதிப்புகளுடன் ஒப்பிடுவதற்கு தனி கவனம் 

செலுத்துப்படுகிறது.

	 Stacked என்ற துணை வகை இது 

ஒவ்வொரு வகையின் தரவு மதிப்புகளை ஒன்றின் 

மீது ஒன்றாக காண்பிக்கும் ஒட்டும�ொத்த 

மதிப்புக்கும் மற்றும் வகையின் ஒவ்வொரு மதிப்பின் 

தனி பங்களிப்பிற்கும் தனி கவனம் 

செலுத்தப்படுகிறது. 

	 Percent என்ற ஒரு துணை வகை இது 

ம�ொத்த தரவு வகையில் தரவின் ஒப்பீட்டு சதவீத்தை 

குறிக்க உதவுகிறது. ம�ொத்த மதிப்புடன் ஒப்பீட்டு 

பங்களிப்புக்கு தனிகவணம் செலுத்துப்படுகிறது.

படம் 10.27 நெடுவரிசை வரைபடம்

பட்டை வரைபடம் (Bar Charts)

	 இது கிடைப்பட்டை (horizontal) க�ொண்ட 

வரைப்படமாகும் ஒவ்வொரு பட்டையின் நீளம் 

அதன் மதிப்பிற்கு சரியான அளவு விகிதம் 

க�ொண்டதாகும்.  Y அச்சு வகையையும், X அச்சு 

வகையின் மதிப்பையும் குறிக்கிறது.

படம் 10.28 பட்டை வரைபடம்

வட்ட வரைபடம்  (Pie Charts)

	 வட்ட வரைபடமானது ம�ொத்த வட்டப்பகுதியில் 

மதிப்புகளை வட்ட க�ோண பகுதியாக குறிக்கிறது. 

வில்லின் நீளம் அல்லது வட்ட க�ோண பரப்பிற்கு 

சரியான அளவு விகிதம் க�ொண்டதாகும்.

	 Normal Pie துணை வகையான இது 

ம�ொத்த வட்டப்பரப்பில் வண்ணம் தீட்டப்பட்ட வட்ட 

க�ோண பகுதி ஒரே ஒரு நெடுவரிசையின் தரவை 

குறிக்கிறது. எந்த ஒரு வட்ட க�ோண பகுதியையும் 

கிளிக் செய்து இழுத்து பிரிக்கலாம், அல்லது 

சேர்க்கலாம்.
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	 Exploded pie துணை வகையான இது 

வட்ட க�ோண பகுதி ஏற்கனவே ஒன்றுக�ொன்று 

பிரிக்கப்ட்டதைக் காட்டுகிறது.  பை வரைப்படத்தின் 

மையத்திலிருந்த சுற்றளவு கூடிய வட்ட க�ோண 

பகுதிய கிளிக் செய்து தகர்த்தலாம்

	 Doughnut துணை வகையான இது பல 

நெடுவரிகைகளின் தரவுகளை காட்டுகிறது. 

ஒவ்வொரு நெடுவரிசை தரவு பிரிமான அமைப்பில் 

காடப்படுகிறது. இந்த அமைப்பில் உள்ள 

துணையின் வழியாக அடுத்த நெடுவரிசையின் 

தரவிணைக் காணலாம். பிரிமனைவின் 

மையத்தியிலிருந்து சுற்றளவுடன் கூடிய வெளி 

வட்ட க�ோண பகுதியை கிளிக் செய்து இழுத்து 

நகர்த்தலாம்.

	 Exploded doughnut துணை வகையான 

இது வெளிவட்ட க�ோண பகுதி ஏற்கனவே 

ஒறுன்கொன்று பிரிக்கப்பட்டதைக் காட்டுகிறது. 

உருவாக்கப்பட்ட வரைபடத்தின் பிரிமனையின் 

மையத்திலிருந்து சுற்றளவுடன் கூடிய வெளி வட்ட 

க�ோண பகுதியை கிளிக் செய்து இருந்த 

நகர்த்தலாம்

படம் 10.29 வட்ட வரைபடம்

பரப்பு வரைபடம் (Area charts)

	 இது மதிப்புகளை புள்ளிகளாக Y- அச்சில் 

காட்டுகிறது அச்சு வகையினைக் காட்டுகிறது. Y 
மதிப்பான ஒவவ�ொரு தரவு வரிசையும் ஒரு 

க�ோட்டின் மூலம் இணைக்கப்படுகிறது. இதற்கு 

க�ோடுகளுக்கு இடைப்பட்ட   பரப்பு வண்ணத்தால் 

நிரப்பப்படுகிறது. இது ஒரு வகையிலிருந்த 

மற்றொரு வகைக்கு கட்டயமாக மாறுவதற்கு  

கவனம் செலுத்துகிறது.

	 Normal - துணை வகையான இது எல்லா 

மதிப்புகளையும் தனித்த Y- மதிப்புகளைக் 

குறிக்கிறது. தரவுப் பரப்பில் உள்ள நெடுவரிசையில்  

கடைசியிலிருந்தே படிப்படியாக முதலாவது 

நெடுவரிசையின் பரப்பைக் குறிக்கிறது. முதல் 

நெடுவரிசையின் மதிப்புகள் பிற மதிப்புகளை விட 

அதிகமாக இருந்தால், கடைசியாக வரையப்பட்ட  

பகுதி மற்ற பகுதிகளை மறைந்து விடும்.  

	 Stacked - துணை வகையான இது 

மதிப்புகளை திரளாக  ஒன்றன் மீது ஒன்றாக 

அடுக்கி வைப்பதைக் குறிக்கிறது. இது தரவுகளை 

ஒன்றுக்கொன்று மறைக்காதவாறு அனைத்தும் 

பார்க்கக்கூடிய வகையில் இருக்கும்படி உறுதி 

அளிக்கிறது. அடுக்கியப் பகுதியில்  அடியில் 

வரையப்பட்ட நெடுவரிசையின் மதிப்பை தவிர பிற Y 
மதிப்புகளை தனி மதிப்புகளாக இருக்காது.

	 Percent -துணை வகையான இது 

மதிப்புகளை திரளாக ஒன்றன் மீது ஒன்றாக 

அடுக்கி வைப்பதற்கு குறிக்கிறது. வகையின் 

ம�ொத்த சராசரியை அளவிடுகிறது.

படம் 10.30 பரப்பு வரைபடம்

Line charts

	 இது  மதிப்புகளை புள்ளிகளாக Y – 
அச்சியில் காட்டுகிறது. X அச்சு வகையை 

காட்டுகிறது. Y-ன் மதிப்பான ஒவ்வொரு தரவு 

வரிசையும் ஒரு கேரட்டின் மூலம் 

இணைக்கப்படுகிறது. Points only துணை 

வகையான இது புள்ளிகளை மட்டும் குறிக்கிறது 
and lines துணை வகையான இது புள்ளிகளை 

குறிக்கவும், ஒரே தரவு வரிசையின் புள்ளிகளை 

ஒரு க�ோட்டின் மூலம் இணைக்கிறது.

	 Points only - துணை வகையான இது 
புள்ளிகளை குறிக்கிறது.

	 Points and lines - இந்த துணைவகை 
ஒரு தரவு வகையான புள்ளிகளை கேட்டின் மூலம் 
இ ணைக்   கி ற து .
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	 Lines only - துணை வகையான இது 

க�ோடுகளை மட்டும் குறிக்கிறது

	 3-D lines - துணை  வகையான இது ஒரே 

தரவு வரிசையின் புள்ளிகளை  3-D  க�ோட்டினால் 

இணைக்கிறது.

படம் 10.31 Line charts

Scatter or XY charts

	 இது பெயர் X- மதிப்புகளின் பட்டியல் 

மற்றும் Y – மதிப்புகளின் பட்டியலைக்  க�ொண்ட 

ஒரு தரவு வரிசையை அடிப்படையாகக்  க�ொண்டது. 

ஒவ்வொரு (XY) இணை மதிப்பும் ஒருங்கிணைந்த 

அமைப்பில் புள்ளிகளாகக் காட்டப்படுகிறது. தரவு 

வரிசையின்  பெயர் Y- மதிப்புகள�ோடு 

த�ொடர்புப்படுத்தப்பட்டு குறிவிளக்கத�ோடு 

காண்பிக்கப்படுகிறது.

	 இந்த வரைபடம் க�ொடநிலை அமைப்பில் 

உருவாக்கப்படுகிறது. வரைபடம். உருவாக்கப்பட்ட 

பின்னர் அதன் பண்புகளை பதிப்பாய்வு செய்து 

அதன் த�ோற்றத்தை மாற்றலாம். Data Series 
Properties  உரையாடல் பெட்டியின் இந்த 

உரையாடல் பெட்டியில் தரவு வரிசையில் பல 

பண்புகளை மாற்றலாம்.

	 2-D வரைபடத்திற்கு  Insert-y-Error Bars 
தேர்வின் மூலம் பிழை பட்டைகள் த�ோன்றுவதை 

இயலச் செய்யலாம்.

Insert பட்டியிலுள்ள கட்டளைகளைப் பயன்படுத்தி. 

சராசரி மதிப்பு க�ோட்டுகளையும் மற்றும் ப�ோக்கு 

க�ோட்டுகளையும் த�ோன்ற செய்யலாம.

Points only

	 ஒவ்வொரு தரவு புள்ளியும் பணிக்குறியாகக் 

குறிக்கப்படும். OpenOffice ஒவ்வொரு தரவு 

வரிசைக்கும் வெவ்வொறு வடிவம் மற்றும் வண்ணம் 

க�ொண்ட க�ொடாநிலை பணிக்குறிகளைப் 

பயன்படுத்துகிறது. Tool → options → Charts 
→ Default  colours  மூலம் க�ொடாநிலை 

வண்ணங்களை அமைக்கலாம். 

Lines Only

	 இது ஒரு தரவு புள்ளிக்கும் அடுத்த தரவு 

புள்ளிக்கும் நேர் க�ோட்டினை வரைகிறது. இந்த 

தரவு புள்ளிகள் பணிகுறிகளாக குறிக்கப்படாது. 

வரையும் வரிசைமுறையும் (order) தரவு 

வரிசையின் வரிசை முறையும் ஒன்றாகும். X  
மதிப்புகளின் வரிசை முறைக்கு ஏற்ப க�ோடுகளை 

வரைய  Sort by x – values குறிக்கவும். இது 

வரைப்படத்திற்கு மட்டுமே ப�ொருந்தும் 

அட்டவணையிலுள்ள தரவுகளுக்கு ப�ொருந்தாது.

புள்ளிகளும் க�ோடுகளும் (Points and Lines)

	 இது க�ோடுகளையும் புள்ளிகளையும் ஒரே 

நேரத்தில் காட்டுகிறது.

3-D க�ோடுகள் (3-D Lines)

	க� ோடுகள் நாடாக்களை ப�ோல் 

காட்டுகிறது. தரவு புள்ளிகள் பணிக்குறிகளால் 

குறிக்கப்படாது முடிக்கப்பட்ட வரைப்படத்தில் 

க�ோண பார்வை (angle of view)  மற்றும் ஒளிவட்டம் 
(illumination)  பண்புகளை அமைக்க  3-D View  
என்பதை தேர்வு செய்யும்.

படம் 10.32 3-D க�ோடுகள்

Bubble charts

	 இது மூன்று மாறிகளின் த�ொடர்பைக் 

காட்டுகிறது- இரண்டு மாறிகள் X- அச்சு மற்றும் y 

அச்சை குறிக்கப் பயன்படுகிறது.  மூன்றாவது 

மாறி ஒவ்வொரு குமிழியின்  சார்பு அளவை ( 
Relative size) காட்டுகிறது.  Data Series 
உரையாடல் பெட்டியின் மூலம் குமிழி  அளவுகளை 

தரவு பரப்பின் மூலம் வரையறுக்க வழி செய்கிறது.
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வலை வரைபடம் (Net chart)

	 இது தரவு மதிப்புகளைப் புள்ளிகளாக 

இணைக்கப்பட்ட க�ோடுகளாகக் காட்டுகிறது. 

வலை சட்டமானது (grid) சிலந்தி வலை அல்லது 

radar குழல் ப�ோல் காட்டுகிறது. வரைப்பட தரவின் 

ஒவ்வொரு வரிசையும் சுற்றளவாக (radial) தரவு 

குறிக்கப்பட்ட பகுதி காட்டப்படுகிறது. எல்லா தரவு 

மதிப்புகளும் ஒரே அளவில் காட்டப்படுகிறது.

ஆதனால் எல்லா தரவு மதிப்புகளும் ஒரே 

பரிமாணத்தில் காட்டப்படுகிறது.

படம் 10.33 வலை வரைபடம்

நெடுவரிசை மற்றும் க�ோட்டு வரைபடம் (Column 
and line charts)

படம் 10.34 நெடுவரிசை மற்றும் க�ோட்டு வரைபடம்

	நெ டுவரிசை மற்றும் க�ோட்டு வரைபடம் 

என்பது நெடுவரிசை வரைப்படம் மற்றும் க�ோட்டு 

வரைபடத்தின் கலவையாகும். கீழ்க்கண்டவற்றில் 

ஒன்றை தேர்ந்தெடுக்கவும்.

Columns and Lines: நெடுவரிசையின் தரவு 

வரிசைகள் செவ்வகங்களாக அருகருகில் 

வரையப்படுவதன் மூலம் அதன் மதிப்புகளை 

எளிதாக ஒப்பிட முடிகிறது.

Stacked columns and Lines நெடுவரிசையின் தரவு 

வரிசைகள் ஒன்றன்மீது ஒன்றாக அடுக்கி 
(Stacked) வரையப்படுவதால் தரவு வரிசையின் 

கூடுதல் (Sum) நெடுவரிசையின் உயரத்தால் 

பார்க்கப்படுகிறது.

வழிக்காட்டி முடித்த பின்னர் Insert- Axis தேர்வை 

க�ொண்டு இரண்டாவது y  அச்சை சேர்க்கலாம்.

10.12.3 – வரைபடம உருவாக்குதல் மற்றும் 

வடிவமைத்தல் (Creating and formatting 
charts)

1.  வரைபடத்திற்கு தேவையான தரவுள்ள 

நுண்ணறைகளைத் தேர்ந்தெடுக்கவும்.

2.   Insert → Chart   அல்லது கருவிப்பட்டையிலுள்ள 
Insert  Chart  பணிக்குறியை கிளிக்  செய்யவும்.

படம் 10.35 (அ) வரைபடம் உருவாக்குதல்
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3.	 வரைபடம் அமைப்பதற்கான படிநிலைகளில் பட்டியல்:

	   வரைபடம் சேர்ப்பதற்கான படிகள்

	  வரைபட வகை பட்டியல்

	 ஒவ்வொரு வரைபடத்திற்கான தேர்வுகள்

	 ஒவ்வொரு வரைபடத்திற்கான விருப்பத்  தேர்வுகள் எந்த நேரத்திலும முன் படிநிலைக்கு சென்று 

தேர்வு செய்த தேர்வுகளை மாற்றலாம்.

படம் 10.35 (ஆ) வரைபடம் வகைகள்

4.	 வரைபட வகையையும் அதன் விருப்பத் தேர்வுகளையும் தேர்ந்தெடுத்தப்பின் Next ப�ொத்தானை 

கிளிக் செய்யவும். 

படம் 10.35 (இ) வரைபடம் வகைகள்
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5.	 படிநிலை 2 –ல்  Data Range  மூலம் தரவுகளை தேர்ந்தெடுப்பதில் உள்ள தவறுகளை சரி செய்ய முடியும்.  
Data series in Rows அல்லது  data series in column இவற்றில் ஏதேனும் ஒன்று தேர்ந்தெடுக்கவும்.  
First row as label அல்லது  First column as label  ஆகிய தேர்வு பெட்டிகளில் ஒன்றைய�ோ அல்லது 

இரண்டையும் தேர்ந்தெடுக்கலாம். பிறகு  Finish ப�ொத்தான் அல்லது  Next ப�ொத்தானைக் கிளிக் 

செய்யவும்.

படம் 10.35 (ஈ) Data சீரியீஸ்

6.	 Data series  பட்டியல் பெட்டி தற்போத வரைப்படத்தின் அனைத்து தரவு வரிசைகளின் பட்டியலைக் 

க�ொண்டுள்ளது.

•	 தரவு வரிசையை ஒழுங்குப்படுத்த, பட்டியிலிருந்து ஒரு உள்ளீட்டைத் தேர்ந்தெடுக்கவும்.

•	 தேர்ந்தெடுககப்பட்ட உள்ளீட்டிற்கு கீழே தரவு வரிசைகளை சேர்க்க  Add ப�ொத்தானை கிளிக் செய்யவும். 

தேர்ந்தெடுக்கப்பட்ட சேர்க்கப்பட்ட புதிய தரவு வரிசையும் ஒரே வகையினமாக இருக்கும்.

•	 தரவு வரிசையிலிருந்து தேர்ந்தெடுக்கப்பட்ட உள்ளீட்டை நீக்குவதற்கு Remove ப�ொத்தானை கிளிக் 

செய்யவும்.

•	 தேர்ந்தெடுக்கப்பட்ட உள்ளீட்டை மேல் மற்றும் கீழ் நகர்துவதற்கு மேல் மற்றும் கீழ் அம்பு குறிகள் 

பயன்படுகிறது. தரவு முல அட்டவணையின் வரிசை முறையை மாற்றாதது. மாறாக வரைபடத்தை 

சீரமைக்கும் ப�ோது வரிசை முறை மாறும்.
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படம் 10.35 (உ)  வரைபட உறுப்புகள்

7.	 Chart Elements Page-ல் தலைப்பையும், விருப்பப்பட்டால் துணை தலைப்பை க�ொடுக்கலாம். 

வரைப்படத்தின் ந�ோக்க பார்வையாளரின் கவனத்திற்கு க�ொண்டுவர தலைப்பு பயன்படுகிறது. எ.கா 
Mark Statement  என்பது இந்த வரைபடத்திற்கு ப�ொருத்தமான தலைப்பாகும். இறுதியாக  Finish  
ப�ொத்தானை கிளிக் செய்யவும்.

படம் 10.35 (ஊ)  சீரியீஸ் இறுதி வரைபடம்

நிகழ்வு ஆய்வு: ஒரு ப�ொருகளுக்கான விற்பனை தரவுகளை  அட்டவணைச் செயலியில் அதை வரைப்படமாக 

உருவமைக்கவும்.
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மதிப்பீடு

பகுதி - அ 

சரியான விடையை தேர்ந்தெடு:

1.	 எது இயங்கு தாளின் நிறம்?

	 அ) சாம்பல்					     ஆ) பச்சை

	 இ) வெள்ளை					     ஈ) மஞ்சள்

2.	 பல த�ொடர்ச்சியான தாள்களைத் தேர்ந்தெடுக்கப் பயன்படும் ப�ொத்தான் எது?

	 அ) Ctrl					     	 ஆ)Shift

	 இ) Alt					     	 ஈ) tab

3.	 ஒற்றைத் தாளை நீக்க எந்த கட்டளையைத் தேர்ந்தெடுக்க வேண்டும்?

	 அ) File→Sheet→Delete				   ஆ) Delete→Sheet→Delete

	 இ) Sheet→ Delete				    ஈ) Edit→Sheet→Delete

4.	 Open Office Calc –ல் மறைக்கப்பட்ட ஒரு வரிசையை காண்பிக்க பயன்படும் கட்டளை எது?

	 அ) Format→Row→Show			   ஆ) Format→Show→Row

	 இ) Format→Display→Row			   ஈ) Format→Row→Display

5.	 Open Office Calc-ல் ஒரு நுண்ணறையை பாதுகாக்க Format→Cells பிறகு தேர்ந்தெடுக்க வேண்டிய 

tab எது?

	 அ) Protect Cell					     ஆ) Protection Cell

	 இ) Cell Protection			   	 ஈ) Cell Protect

6.	 எந்த நுண்ணறையை முகவரி தனித்ததாக மாற்ற குறியீட்டை பயன்படுத்துகிறது

	 அ) தனித்த 				    	 ஆ) ஒப்பீட்டு

	 இ) சார்பு					     	 ஈ)பார்வையிடு

7.	 எந்த சார்பு க�ொடுக்கப்பட்ட எண்ணை இயக்கத்தின் நெருங்கிய மடக்கின் முழு எண்ணாக மாற்றுகிறது.

	 அ) COMBINA					     ஆ) CEILING

	 இ) Floor						     ஈ) ABS

8.	 A5 நுண்ணறையில் மதிப்பு 18 என்றால், (A5<26; “True”, “False”) என்ற சார்பு திருப்பி அனுப்புவது.

	 அ) True					     	 ஆ)False

	 இ) A5				    		  ஈ) Error

9.	 எது திறன்மிக்க முறையில் தரவுகளை படிப்பதற்கு எளிதாக புரிந்து க�ொள்கின்ற வகையில் படங்களாக 

அளிப்பதாகும்.

	 அ) Charts and images			   	 ஆ) graphs and images

	 இ) Charts and graphs			   	 ஈ) Images and Pictures
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10.	  = DECIMAL (“16”;1101) திருப்பி அனுப்பும் மதிப்பு என்ன?

	 அ) 12						      ஆ) 13

	 இ) D						      ஈ) E

பகுதி - ஆ

அனைத்து வினாக்களுக்கு விடையளிக்கவும்:

1.	 ஒபன் ஆஃபீஸ் கால்க்-ல் த�ொடர்ச்சி மற்றும் த�ொடர்ச்சி அல்லாத தாள்களை எவ்வாறு தேர்ந்தெடுப்பாய்?

2.	 தாள்களை பெயர் மாற்றம் செய்யும் வழிமுறையை எழுதுக.

3.	 தாளை உறைய செய்தலின் பயன் யாது?

4.	 நுண்ணறை முகவரின் வகைகள் யாவை?

5.	 வரைபடம் என்றால் என்ன?

பகுதி - இ

அனைத்து வினாக்களுக்கு விடையளிக்கவும்: 

1.	 ஒப்பீட்டு நுண்ணறை முகவரியையும் தனித்த நுண்ணறை முகவரியையும் வேறுபடுத்துக.

2.	 ஒபன் ஆஃபீஸ் கால்-ல் சார்புகள் என்றால் என்ன?

3.	 அட்டவணைத்தாளில் வரிசை மற்றும் நெடுவரிசைகளை எவ்வாறு மறை த�ோன்ற செய்வாய்?

4.	 ஒபன் ஆஃபீஸ் கால்-க் ASIN சார்பை  பற்றி சுருக்கமாக எழுது.

5.	 பரப்பு என்றால் என்ன? எடுத்துக்காட்டு தருக.

பகுதி - ஈ

அனைத்து வினாக்களுக்கு விடையளிக்கவும்: 

1.	 கீழ்க்கண்ட புலங்களைக் க�ொண்ட மாணவர் தரவுத்தளத்தை அட்டவணைத் தாளில் உருவாக்குக.

	 வரிசை எண், பெயர், தமிழ், ஆங்கிலம், கணிதம், அறிவியல், சமூக அறிவியல், ம�ொத்தம், சராசரி.

2.	 அட்டவணைத் தாளை வடிவமைப்பதை விளக்குக.

3.	 ஒபன் ஆஃபீஸ் கால்-ல் வரைபடம் உருவாக்கும் படிநிலைகளை விளக்குக.

4.	 ஒபன் ஆஃபீஸ் கால்-ல் சார்புகள் எவ்வாறு பயன்படுத்தப்படுகிறது? எடுத்துக்காட்டுடன் விளக்குக.
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கற்றலின் ந�ோக்கங்கள்

•	 அட்டவணைச் செயலியில் உள்ள தரவு 

செயலாக்கத்தின் பல்வேறு கருவிகளை பற்றி 

கற்றல். 

•	 அட்டவணைச் செயலியில் உள்ள பக்க 

வடிவமைப்பு மற்றும் அச்சிடுதல் பற்றி கற்றல்.

11.1 தரவு கருவிகள்

	 அட்டவணைச் செயலியில் உள்ள 

தகவல்களை கையாளுவதற்கு தரவு கருவிகள் 

பயன்படுகின்றன.  அட்டவணைச் செயலியில் 

உள்ள தரவு கருவிகள் தானியங்கி 

கையாளுதலுக்கும் பயன்படுகின்றன. புதிய 

பயனர்களுக்கு இந்த கருவிகளானது மேம்பட்ட 

தேர்வுகளாக த�ோன்றும். ஆனால் இந்த 

கருவிகளில் அனுபவம் வாய்ந்த பயனர் கடினமான 

கையாளுதலையும் எளிய வழியில் செய்ய முடியும்.

11.2 நிபந்தனை வடிவூட்டலை உபய�ோகித்தல் 

	 தரவு கருவியின் முக்கியமான பண்பானது 

பயனரின் எளிய புரிதலுக்காக அந்த தகவலை 

காட்சிப்படுத்துதல் ஆகும் (Visualisation). 

நிபந்தனை வடிவமைப்பு பயனருக்கு தேவையான 

வேறுபட்ட தரவுகளுக்கு மாறுபட்ட எழுத்தின் 

அளவு, எழுத்தின் நிறம் மற்றும் பின்புற 

வண்ணத்தை தருகிறது.பயனரால் கூறப்படுகின்ற 

நிபந்தனைகக்கு  ஏற்றவாறு எழுத்து அளவு, 

எழுத்தின் நிறம் மற்றும் பின்புற வண்ணத்தை  

மாற்றுவதற்கு நுண்ணறை வடிவமைப்பை 

அமைக்கலாம்.

	 எடுத்துக்காட்டாக, எண்களைக் க�ொண்ட 

அட்டவணையில் சராசரிக்கு மேற்பட்ட அனைத்து 

மதிப்புகளையும் பச்சை வண்ணத்திலும் சராசரிக்கு 

பாடம் 11
தரவு கருவிகள் மற்றும் அச்சிடுதல்

அட்டவணைச் செயலிஅலகு III

குறைவாக உள்ளவற்றை 

சிவப்பு வண்ணத்திலும் 

காண்பிக்க முடியும்.

	 எடுத்துக்காட்டாக 

மாணவர்களின் 

மதிப்பெண்கள் அட்டவணைச்  செயலியிலில் 

உள்ளிடப்பட்டுள்ளது வெவ்வேறு விதத்தில் உள்ள 

மதிப்பெண்களை வெவ்வேறு வண்ணங்களில் 

காண்பிக்க வேண்டும்.

எடுத்துக்காட்டு 11.1 பின்வரும் நிபந்தனைகளுக்கு 

ஏற்றவாறு அட்டவணை 11.1 ல் நிபந்தனை 

வடிவமைப்பை அமைக்கவும்.

	 1. 50 மற்றும் அதற்கு குறைவான 

மதிப்பெண்களை இளம் பச்சை வண்ணத்தில் 

காண்பிக்கவும்.

	 2.  50க்கும் அதிகமான மதிப்பெண்களை 

நீல வண்ணத்தில் காண்பிக்கவும்.

அட்டவணை11.1 நிபந்தனை வடிவூட்டல்களுடன் 

தரவுகள்

பெயர் மதிப்பெண்கள்

Kumar 32
Arun 67
Gayathri 50
Chandru 98

நிபந்தனை வடிவூட்டலை உபய�ோகிக்கும் செயல் 

முறை

1. மதிப்பெண்கள் உள்ள நுண்ணறைகளை தேர்வு 

செய்க.

2. பட்டிப்பட்டையில் இருந்து Format→ 
Conditional Formatting தேர்வு செய்க. 
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படம் 11.1 Format → Conditional Formatting கட்டளை

3.	 படம் 11.2ல் காட்டியுள்ளவாறு நிபந்தனை வடிவமைப்பு உரையாடல் பெட்டி த�ோன்றும்.

படம் 11.2 நிபந்தனை வடிவமைப்பு  Conditional Formatting உரையாடல் பெட்டி

4.	 நிபந்தனை 1 ஐ தேர்வு செய்து cell value வில் greater than என்பதை தேர்வு செய்து மற்றும் Value Box  
-ல் 50 என தட்டச்சு செய்யவும்.

5.	 பின்பு New Style என்ற ப�ொத்தானை கிளிக் செய்யவும். New Style ப�ொத்தான் மாறுபட்ட தேர்வுகளாகிய   

எழுத்தின் வகை, எழுத்தின் அளவு, எழுத்தின் நிறம், எழுத்தின் இசைவு, எல்லையின் நிறம் மற்றும் 

பின்புற வண்ணம் ஆகியவற்றை க�ொண்டுள்ளது. 
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படம்  11.3(அ) Cell Style உரையாடல் பெட்டி

Conditional Formatting → New Style → Background கட்டளையை மூலம் கிளிக் செய்வதன் மூலம் படம் 

11.3 காட்டியுள்ளவாறு Cell Style உரையாடல் பெட்டி த�ோன்றும்.

Background Tab கிளிக் செய்து இளம் பச்சை வண்ணத்தை தேர்வு செய்யவும் . Ok ப�ொத்தானை கிளிக் 

செய்யவும்

6.	 இதேப�ோல நிபந்தனை 2 ஐ தேர்வு செய்து cell value வில் "less than" என்பதை தேர்வு செய்து மற்றும் 

Value Box - ல் 50 என தட்டச்சு செய்யவும். Background Tab-ல் நீல வண்ணத்தை தேர்வு செய்யவும்.

இறுதியாக ஓபன் ஆபீஸ் கால்க்கின் முடிவானது பின்வருமாறு காண்பிக்கப்படும்.

படம் 11.3 (ஆ) பின்புல நிறம் 
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11.3 வரிசையாக்கம்

	 தரவுகளை ஏறு அல்லது இறங்கு 

வரிசையில் ஒழுங்குபடுத்தும் செயல்முறை 

வரிசையாக்கம் எனப்படும். ஒபன் ஆஃபீஸ் 

கால்க்-ல் மூன்று  வகையான வரிசையாக்க 

முறைகள் உள்ளது. அவை 

	 (1) சாதாரண வரிசையாக்கம் (Simple 
Sorting) 

	 (2) பற்புல வரிசையாக்கம் (Multi Sorting)

	 (3) தேர்ந்தெடுப்பு வரிசையாக்கம் (Sort by 
Selection)

11.3.1 சாதாரண வரிசையாக்கம்

	 ஒற்றை நெடுவரிசையை பயன்படுத்தி 

தரவுகளை ஒழுங்குபடுத்தப்படுவது சாதாரண 

வரிசையாக்கம் எனப்படும்.  தரவுகளை  

வரிசையாக்கம் செய்வதற்கு கால்க்-ன் செந்தரக் 

கருவிப்பட்டையில் இரண்டு பணிக்குறிகள் 

உள்ளது. அவை 

(1)	 Sort Ascending (ஏறுவரிசை வரிசையாக்கம்) 
(A முதல் Z வரை - சிறியது முதல் பெரியது 

வரை)

(2)	 Sort Descending (இறங்குவரிசை 

வரிசையாக்கம்) (Z முதல் A வரை - பெரியது 

முதல் சிறியது வரை)
புலம்

பதிவு

படம்11.4 அட்டவணை செயலி தரவு அட்டவணை

தரவுகளை சாதாரண வரிசையாக்கம் செய்தல்

படிநிலை 1 : வரிசையாக்கம் செய்யப்பட வேண்டிய புலத்தில் (நெடுவரிசை) நுண்ணறைச் சுட்டியை 

இருத்தவும்.

படிநிலை 2 : செந்தரக் கருவிப்பட்டையிலுள்ள Sort Ascending அல்லது Sort Descending பணிக்குறியை 

கிளிக் செய்யவும்.

	 ஓபன் ஆஃபீஸ் கால்க், தேர்ந்தெடுக்கப்பட்ட நெடுவரிசையிலுள்ள தரவுகளின் அடிப்படையில், 

அதனுடன் த�ொடர்புடைய மற்ற நெடுவரிசைகளையும் சேர்த்து வரிசைப்படுத்தும் (படம் 11.6 யை காண்க)
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Sort Ascending Sort Descending

படம் 11.5 செந்தரக் கருவிப்பட்டை

ஏறுவரிசையில் ஒழுங்குபடுத்துவதற்க்கு "Sort 
Ascending"பணிக்குறியை கிளிக் செய்யவும்

நுண்ணறை சுட்டியை Name 

நெடுவரிசையில் ஏதாவத�ொரு 

இடத்தில் இருத்தவும்

படம் 11.6 ஏறுவரிசை வரிசையாக்கம்

11.3.2 பற்புல வரிசையாக்கம்:

	 ஒன்றுக்கும் மேற்பட்ட புலத்தை (நெடுவரிசை) அடிப்படையாக க�ொ ண்டு வரிசையாக்கம் 

செய்யப்படுவதற்கு “பற்புல வரிசையாக்கம்” என்று பெ யர். எடுத்துக்காட்டாக, வெ வ்வேறு வகுப்புகள் 

மற்றும் குழுக்களை சார்ந்த 20 மாணவர்களின் தரவுகைள அட்டவணைத்தாளில் க�ொடுக்கப்பட்டுள்ளது. 

இந்த த ரவுகளை பெ யர் மற் றும் ப ாடம் பிரிவுகளைப் ப�ொ றுத்து வரிசைப்படுத்த ப ற்பல வரிசையாக்கம் 

பயன்படுகிறது. படம் 11.6 யை காண்க.

தரவுகளை பற்புல வரிசையாக்கம் செய்தல்:

படிநிலை 1:

•	 Data  Sort கட்டளையை தேர்வு செய்க.
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முதலில் வரிசைப்படுத்தப்பட வேண்டிய 
தரவுகளைக் க�ொண்ட முதல் 
நெடுவரிசையை தேர்ந்தெடுக்கவும் 

வரிசையாக்க 
முறையைத் 
தேர்ந்தெடுக்கவும்

Fainally Click 
"Ok"

படம் 11.7 பற்பல வரிசையாக்க உரையாடல் பெட்டி

படிநிலை 2:

•	 படம் 11.7 ல் காட்டப்பட்டுள்ளபடி, Sort உரையாடல் பெட்டி த�ோன்றும்.

படிநிலை 3:

•	 “Sort by” கீழிறங்குப் பட்டியல்  பெட்டியிலிருந்து, முதலில் எந்த புலத்தின் அடிப்படையில் தரவுகளை 

வரிசைபடுத்தப்பட வேண்டும�ோ, அந்த புலத்தை தேர்வு செய்க. (எடுத்துக்காட்டாக: Student Name.)

•	 Ascending அல்லது Descending என்ற ரேடிய�ோ ப�ொத்தானில், வரிசையாக்க முறையைத் தேர்வு 

செய்யவும். 

•	 Ascending என்பது தானமைவாக தேர்ந்தெடுக்கப்பட்டிருக்கும்

படிநிலை 4:

•	 “Then by” கீழிறங்குப் பெட்டியிலிருந்து, இரண்டாவதாக எந்த புலத்தின் அடிப்படையில் தரவுகள் 

வரிசைபடுத்தப்பட வேண்டும�ோ, அந்த புலத்தை தேர்வு செய்க. (எடுத்துக்காட்டாக: Group code).
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•	 Ascending அல்லது Descending என்ற ரேடிய�ோ ப�ொத்தானில், வரிசையாக்க முறையைத் தேர்வு 

செய்யவும். 

படிநிலை 5:

•	 இறுதியாக, “OK” ப�ொத்தானை கிளிக் செய்யவும்.

	 ஓபன் ஆஃபீஸ் கால்க்-ல் மூன்று புலங்களின் அடிப்படையில் மட்டுமே தரவுகளை பற்புல 

வரிசையாக்கம் செய்ய முடியும். 

படம்11.8 வரிசையாக்கப்பட்ட அட்டவணை

குறிப்பு: பெயர்களைப் ப�ொறுத்து அவைகள் ஏறுவரிசையில் வரிசைப் படுத்தப்பட்டுள்ளன. பிற 
தரவகளும் மறுவரிசையாக்கம் செய்யப்பட்டுள்ளன.

11.3.3  தேர்ந்தெடுப்பு வரிசையாக்கம் 

	 அட்டவணைத்தாளில், ஒரு குறிப்பிட்ட புலத்தில் உள்ள தரவுகளை மட்டும் வரிசையாக்கம் செய்ய 

முடியும். ஆனால், இந்த வகை வரிசையாக்கம் ப�ொதுவாக பரிந்துரைக்கப்படுவதில்லை. ஏனெனில், ஒரு 

குறிப்பிட்ட புலத்தில் உள்ள தரவுகளை மட்டும் வரிசையாக்கம் செய்யும் ப�ோது, அதனுடன் த�ொடர்புடைய 

மற்ற புலங்களின் தரவுகள் வரிசையாக்கம் செய்யப்படுவதில்லை . இதை மனதில் க�ொண்டே, ஓபன் 

ஆஃபீஸ் கால்க், இந்த வகை வரிசையாக்கம் செய்யும் ப�ோது ஒரு எச்சரிக்கை செய்தியைக் காட்டும். (படம் 

11.9 யை காண்க)

தரவுகளுக்கு தேர்ந்தெடுப்பு வரிசையாக்கம் செய்தல்:

படிநிலை 1:

•	 எந்த புலத்திற்கு வரிசையாக்கம் செய்யப்பட வேண்டும�ோ, அந்த புலத்தை மட்டும் தேர்வு செய்க.
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படிநிலை 2:

•	 செந்தரக்கருவிப்பட்டையிலிருந்து தேவையான Sort பணிக்குறியை (Sort Ascending அல்லது Sort 
Descending) தேர்வு செய்க அல்லது Data  Sort கட்டளையைத் தேர்வு செய்க.

•	 கால்க், படம் 11.9 ல் காட்டப்பட்டுள்ளவாறு எச்சரிக்கை செய்தியை காண்பிக்கின்ற Sort Range 
உரையாடல் பெட்டியை த�ோன்றச் செய்யும். 

•	 Sort Range உரையாடல் பெட்டி, இரண்டு தேர்வுகளைக் க�ொண்டது. அவை (1) Extend selection 

மற்றும் (2) Current selection.

படிநிலை 3:

•	 Extended Selection என்பதை தேர்வு செய்தால், தேர்வு செய்யப்பட்ட புலத்திலுள்ள தரவுகள் 

வரிசையாக்கம் பெறும் ப�ோதே, அதனுடன் த�ொடர்புடைய மற்ற தரவுகளின் வரிசையும் மாற்றம் 

பெறும்.

•	 Current Selection என்பதை தேர்வு செய்தால், தேர்ந்தெடுக்கப்பட்ட புலத்தில் உள்ள தரவுகள் 

மட்டுமே வரிசைபடுத்தப்படும். அதனுடன் த�ொடர்புடைய மற்ற தரவுகள் மாற்றாமல் இருக்கும். 

படம் 11.9 தேர்ந்தெடுப்பு வரிசையாக்கம்
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11.4 வடிகட்டுதல்

	 சில குறிப்பிட்ட தரவுகளை மட்டும் 

திரையில் த�ோன்ற செய்யும் செயல்முறைக்கு 

”வடிகட்டல்” என்று பெயர். ஒரு 

அட்டவணைத்தாளிலுள்ள தரவுகளில் ஒரு 

குறிப்பிட்ட நிபந்தனையை நிறைவு செய்யும் 

தரவுகளை மட்டும் திரையில் த�ோன்ற செய்ய 

வடிகட்டல் வசதி பயன்படுகிறது.  க�ொடுக்கப்படும் 

நிபந்தனைக்கு ப�ொருந்தாத மற்ற தரவுகள் 

மறைக்கபடும். 

	 ஓபன் ஆஃபீஸ் கால்க்-ல் மூன்று 

வகையான வடிக்கட்டல்களை செய்ய முடியும். 

அவை (1) தானியங்கு வடிகட்டல் (Auto Filter) 
(2) செந்தர வடிகட்டல் (Standard Filter) மற்றும் 

(3) மேம்பட்ட வடிகட்டல் (Advanced Filter).

11.4.1 தானியங்கு வடிகட்டல்:

	 தானியங்கு வடிகட்டல் வசதியில், 

ஒவ்வொரு  புலத்திலும் ஒரே மாதியான தரவுகளை 

மட்டும் உருப்படிகளாக் க�ொண்ட ஒரு கீழிறங்கு 

பெட்டி அந்த நெடுவரிசையின் தலைப்பில் 

த�ோன்றும். இந்த கீழிறங்கு பெட்டியை பயன்படுத்தி 

நிபந்தனையை நிறைவு செய்யும் தரவுகளை 

வடிகட்டலாம்.

தானியங்கு வடிகட்டல் வசதியை பயன்படுத்துதல்:

•	 செந்தரக் கருவிப்பட்டையிலுள்ள ”Auto 
Filter” பணிக்குறியை கிளிக் செய்க. 

அல்லது Data  Filter  Auto Filter 
கட்டளையை தேர்வு செய்க.

•	 புலன்களில் ஒரே மாதியான தரவுகளை 

உருப்படிகளாகக் க�ொண்ட கீழிறக்கு 

பெட்டிகள் த�ோன்றும். (படம் 11.10 ,படம் 

11.11-யை காண்க)

•	 ஒவ்வொரு கீழிறங்கு பட்டியல் பெட்டியிலுள்ள 

உருப்படிகள், வடிக்கட்டலின் நிபந்தனை 

மதிப்புகளாக கருதப்படும்.

 படம் 11.10 தானியங்கி வடிகட்டியுடன் உள்ள அட்டவணைதாள்

படம் 11.11 தானியங்கி வடிகட்டியின் கீழிறங்கு பெட்டி

கீழிறங்கு பட்டியல் பெட்டி
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•	 இதிலிருந்து ஏதேனும் ஒரு தரவை கிளிக் 

செய்து தேர்ந்தெடுக்கும் ப�ோது, அந்த தரவை 

நிபந்தனையாகக் க�ொண்ட அனைத்து 

பதிவுகளும் திரையில் த�ோன்றும். மற்றத் 

தரவுகள் மறைக்கப்படும். 

எடுத்துக்காட்டு :

	 அட்டவணைதாள் 11.4 க்கு தானியங்கு 

வடிக்கட்டல் வசதியைப் பெற கீழ்க்காணும் 

படிநிலைகள் பின்பற்றப்பட வேண்டும்.

படிநிலை 1:  அட்டவணைத்தாளில் நுண்ணறை 

சுட்டியை ஏதேனும் ஒரு நுண்ணறையில் 

இருத்துக.

படிநிலை 2:  செந்தரக்கருப்பட்டையில் உள்ள 

“Auto Filter” பணிக்குறியை கிளிக் செய்யவும் 

அல்லது Data  Filter  Auto Filter 

கட்டளையைத் தேர்வு செய்யவும்.

	 இப்போது, அட்டவணையின் அனைத்து 

புலத்திலும், கீழிறங்கு பட்டியல் பெட்டிகள் 

த�ோன்றுவதைக் காணலாம்.

	 பாடப்பிரிவு 402ல் பயிலும் மாணவர்களை 

மட்டும் வடிகட்ட விரும்பினால், Group Code 

என்ற புலத்தின் தலைப்பில் உள்ள கீழிறக்கு 

பட்டியல் பெட்டியின் சிறிய முக்கோணத்தை  

கிளிக் செய்து இறக்கவும். த�ோன்றும் 

உருப்படிகளில், 402யை மட்டும் கிளிக் செய்யவும். 

(படம் 11.12யை காண்க)

	 இப்போது படம் 11.12 ல் 

காட்டப்பட்டுள்ளபடி, பாடப்பிரிவு 402ல் பயிலும் 

மாணவர்களின் தரவுகள் மட்டுமே திரையில் 

த�ோன்றும். மற்ற தரவுகள் மறைக்கப்பட்டிருக்கும்.

 படம்11.12 வடிகட்டப்பட்ட தகவல்கள்

 படம் 11.13 செந்தர வடிகட்டல் உரையாடல் பெட்டி
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தானியங்கு வடிகட்டியை நீக்குதல்:

•	 தானியங்கு வடிகட்டியை நீக்க, 

கருவிப்பட்டையிலுள்ள Auto Filter 

பணிக்குறியை மீண்டும் கிளிக் செய்யவும்.

•	 இப்போது, அட்டவணை மீண்டும் பழைய 

நிலைக்கு திரும்பிவிடும்.

11.4.2 செந்தர வடிகட்டல் (Standard Filter)

	 தானியங்கு வடிகட்டல், ஒரு புலத்தின் 

தரவை மட்டுமே வடிகட்டலின் நிபந்தனை 

மதிப்பாக எடுத்துக்கொள்ளும். 

	 செந்தர வடிகட்டல், ஒன்றுக்கும் மேற்பட்ட 

நிபந்தனைகளின் அடிப்படையில் தரவுகளை 

வடிகட்டப் பயன்படுகிறது.

செந்தர வடிகட்டியைப் பயன்படுத்துதல்:

படிநிலை 1:

•	 Data  Filter  Standard Filter என்ற 

கட்டளையை தேர்வு செய்க.

•	 அட்டவணையிலுள்ள அனைத்து தரவுகளும் 

தேர்ந்தெடுக்கப்பட்டு, படம் 11.14 ல் 

காட்டப்பட்டுள்ளபடி, செந்தர வடிகட்டல் 

உரையாடல் பெட்டி த�ோன்றும். 

படிநிலை 2:

•	 Standard Filter உரையாடல் பெட்டியில், 

Field name கீழிறங்கு பட்டியல் 

பெட்டியிலிருந்து, ஒரு புலத்தின் தலைப்பை 

தேர்வு செய்க.

•	 Condition கீழிறங்கு பட்டியல் 

பெட்டியிலிருந்து >, <, = ப�ோன்ற ஒப்பீட்டு 

செயற்குறிகளில் ஒன்றை தேர்வு செய்க.

•	 Value கீழிறங்கு பட்டியல் பெட்டியிலிருந்து 

நிபந்தனை மதிப்பை தேர்வு செய்க, அல்லது 

நிபந்தனை மதிப்பை நேரடியாக தட்டச்சு 

செய்க.

படிநிலை 3:

•	 இரண்டாவது நிபந்தனை தேர்வு செய்வதற்கு 

முன், Operator என்ற கீழிறங்கு பட்டியல் 

பெட்டியிலிருந்து, AND அல்லது OR 
இவற்றில் ஏதேனும் ஒரு தருக்க 

செயற்குறியை தேர்வு செய்க. 

•	 அடுத்த நிபந்தனைக்கு படிநிலை 2 ஐ 

பின்பற்றவும்.

படிநிலை 4:

•	 இறுதியாக OK ப�ொத்தானை கிளிக் செய்யவும்

எடுத்துக்காட்டு:

•	 	படம் 11.4 - ல் உள்ள தரவுகளில், பாடப்பிரிவு 

402ல், வகுப்பு XII – H2ல் பயிலும் 

மாணவர்களை மட்டும் திரையில் த�ோன்ற 

செய்ய கீழ்க்காணும் வழிமுறைகளைப் 

பின்பற்றுக.

படிநிலை 1:

•	 Data  Filter  Standard Filter 
என்ற கட்டளையைத் தேர்வு செய்க.

•	 அட்டவணையிலுள்ள அனைத்து தரவுகளும் 

தேர்ந்தெடுக்கப்பட்டு, படம் 11.14 ல் 

காட்டப்பட்டுள்ளபடி, செந்தர வடிகட்டல் 

உரையாடல் பெட்டி த�ோன்றும். 

படிநிலை 2:

செந்தர வடிகட்டல்  உரையாடல் பெட்டியில், 

முதலாவது நிபந்தனை அமைத்தல்:

•	 Field name பட்டியலிருந்து, Group Code 
தேர்வு செய்க.

•	 Condition பட்டியலிருந்து = தேர்வு செய்க.

•	 Value பட்டியலிருந்து 402 எனத் தேர்வு செய்க.

படிநிலை 3:

இரண்டாவது நிபந்தனை அமைத்தல்:
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•	 Operator என்ற பட்டியலிருந்து, AND தேர்வு செய்க.

•	 Field name பட்டியலிருந்து, Class தேர்வு செய்க.

•	 Condition பட்டியலிருந்து = தேர்வு செய்க.

•	 Value பட்டியலிருந்து XII – H2 எனத் தேர்வு செய்க.

 படம் 11.14 செந்தர வடிகட்டல்

 படம்11.15 பாடப்பிரிவு 402 - ல் உள்ள XII -H2 மாணவர்கள்

படிநிலை 4:

•	 OK ப�ொத்தானை கிளிக் செய்க.

	 இப்போது, படம் 11.15 ல் காட்டப்பட்டுள்ளபடி இரண்டு நிபந்தனைகளையும் நிறைவு செய்யும்  

பதிவுகள் மட்டும் திரையில் த�ோன்றும்.

செந்தர வடிகட்டலை நீக்குதல்:

•	 Data  Filter  Remove Filter என்ற கட்டளையை பயன்படுத்தி, இந்த வடிகட்டலை நீக்கலாம்.
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11.5 செல்லுபடியாக்கல்

	 தேர்ந்தெடுக்கப்பட்ட வரிசை/நெடுவரிசை/

நுண்ணறைகளில் தரவு உள்ளீடுகளை 

கட்டுப்படுத்தும் செயல்முறைக்கு 

செல்லுபடியாக்கல் என்று பெயர்.

எடுத்துக்காட்டடாக, மாணவர் தரவு தளத்தில் 

அதிகபட்ச வரிசை எண் 50 என்றால் பயனர் 50-

க்கு மேற்பட்ட எண்ணை உள்ளீடு செய்யம்போது 

பிழை செய்தி காண்பிக்கப்படும்.

படிநிலை 1 : நுண்ணறை A1 -ல் வரிசை எண்ணை 

உள்ளீடு செய்து அந்த முழு 

நெடுவரிசையையும்(column A) தேர்ந்தெடுக்கவும்.

படிநிலை 2 : Data  validity க்கு செல்க. பின்னர் 

உரையாடல் பெட்டி த�ோன்றும். அதில் ”criteria” tab-

க்கு செல்லவும். ”Allow” field -ல் முழு எண்களை 

தேர்ந்தெடுக்கவும். அதாவது முழு எண்கள் மட்டுமே 

அனுமதிக்கப்படும். தசம எண்கள் 

அனுமதிக்கப்படாது. “Data” field-ல் ”less than” ஐ 

தேர்ந்தெடுக்கவும் மற்றும் “MAXIMUM” FIELD-

ல் 50-ஐ தட்டச்சு செய்யவும். பார்க்க படம் 11.16

படம் 11.16 செல்லுபடியாக்கல் உரையாடல் பெட்டியின் திரை
	 “Error Alert tab” க்கு சென்று “Show error message when invalid values are entered” என்ற 

த�ோ்வுப் பெட்டியை த�ோ்வு செய்யவும்.  “Action” பட்டியல் பெட்டியில் *"warning" - ஐ தேர்வு செய்து, பிழை 

செய்தியின் தலைப்பை"Title" உரைப்பெட்டியில் உள்ளிடவும்.  பின்னா், “Error message” ல் என்ற பல வரி 

உரைப்பெட்டியில் பிழைசெய்தியை  தட்டச்சு செய்யவும். ( படம் 11.17 காண்க)

படம் 11.17 செல்லுபடியாக்கல் உரையாடல் பெட்டியின் திரை
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	 இப்பொழுது, Roll No. நெடுவரிசையில் பயனா ்50 க்கு மேற்பட்ட மதிப்பை தட்டச்சு செய்தால் பிழை 

செய்தி படம் 11.18ல் காட்டியுள்ளவாறு த�ோன்றும்.

 படம்11.18 செல்லுபடியாக்கல் பிழையின் திரை

11.6 Input Help list ஐ உருவாக்குதல் மற்றும் பயன்படுத்துதல் 

	 Input help ஆனது ஒரு நபரின் இனம் (Gender), ஆண் (அ) பெண் (Male or Female) மற்றும் 

மாதங்கள் (Jan, Feb, Mar, Apr, May, Jun, Jul, Aug, Sep, Oct, Nov, Dec) ப�ோன்ற பல்வேறு தேர்வுகளை  

வழங்க பயன்படுகிறது.  பின்வரும் படிநிலைகள் இனத்திற்கான பட்டியலை உருவாக்க வழிகாட்டுகிறது.

படிநிலை 1: ஏதேனும் ஒரு நுண்ணறையில் (எ.கா.) gender என தட்டச்சு செய்க.

படிநிலை 2 : அடுத்த நுண்ணறையை த�ோ்வு செய்க.  (A2 or B1)

படிநிலை 3: Data →validity கட்டளைக்கு செல்க.  பின்வரும் உரையாடல் பெட்டி த�ோன்றும். (படம் 11.19- 
யை காண்க)

 படம்11.19 Input Help list-ன் திரை நகல்
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படிநிலை 4: Input Help tab ல் “Gender” என்பதை 
title லில் தட்டச்சு செய்க.  Input help புலத்தில் 

Male மற்றும் Female என்பதை தட்டச்சு செய்து 
“Ok” ப�ொத்தானை கிளிக் செய்யவும்.

படிநிலை 5: த�ோ்வு செய்யப்பட்டட நுண்ணறை 

எண்ணிற்கு சென்றால், Input help message 
த�ோன்றும்.  (பார்க்க படம் 11.20)

 படம் 11.20 Input Help List 
பயன்பாட்டிற்க்கு பிறகு அட்டவணைதாளின் 

திரை.

11.8 அட்டவணைத் தாளை அச்சிடுதல்

11.8.1 பக்க அளவு, அமைவு மற்றும் ஓரங்களை 

அமைத்தல் 

படிநிலை 1: பக்க அளவை வடிவமைக்க 

பட்டிப்பட்டையில் உள்ள Format → page 

கட்டளைக்கு செல்லுக. படம் 11.21ல் 

காட்டியுள்ளவாறு உரையாடல் பெட்டி த�ோன்றும்.

 படம் 11.21 Page Style உரையாடல் பெட்டி 
படிநிலை 2: Page tab ஐ த�ோ்வு செய்க. (படம்  11.22 
- யை காண்க)

 படம்  11.22 பக்கவடிவமைப்பின் திரை
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படிநிலை 3: பக்க அளவு, அமைவு மற்றும் பக்க ஓரத்தை த�ோ்வு செய்க.

	 அட்டவணைத் தாளை அச்சிடுவதற்கு முன்பு Print preview வில் தேவையான வடிவமைப்பு உள்ளதா 

என சரிபார்க்க வேண்டும்.

Print preview வை பார்வையிட File → page preview க்கு செல்க.

	தேவை யான வடிவமைப்பு இருந்தால் “Close preview” வை அழுத்தவும் இல்லையெனில் திரையின் 

மேற்பகுதியில் உள்ள Format → page மற்றும் Margin tab ஐ த�ோ்வு செய்யவும்.

11.8.2 தலைப்பு மற்றும் அடிக்குறிப்பை செருகுதல் 

	 தலைப்பு மற்றும் அடிக்குறிப்பு என்பது சில தலைப்புகள் (ஆவணத்தலைப்பு, நூலாசிரியா் பெயா)் 
அல்லது மேற்கோள்கள் (அதாவது பக்க எண், பக்கங்களில் எண்ணிக்கை, தேதி) அல்லது குறிப்புரைகள் 

ஆகியவை பக்கத்தின்  மேல்பகுதியில் அச்சிடப்பட்டால் அவை தலைப்பு (Header) எனவும்,பக்கத்தின்  

கீழ்ப்பகுதியில் அச்சிடப்பட்டால் அடிக்குறிப்பு (Footer) எனவும் அழைக்கப்படுகின்றன   படம் 11.23 மற்றும் 

படம் 11.24 ல் தலைப்பு, அடிக்குறிப்பிற்கான உரையாடல் பெட்டிகள் காண்பிக்கப்பட்டுள்ளன.

 படம்  11.23 தலைப்பு உரையாடல் பெட்டி
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 படம்  11.24 அடிக்குறிப்பு உரையாடல் பெட்டி 

11.8.3 அனைத்துப் பக்கங்களிலும் வரவேண்டிய வரிசை மற்றும் நெடுவரிசைகளை மீண்டும் அச்சிடுதல்

	 ஒரு தாளை பல பக்கங்களில் அச்சிடும்போது நாம் சில வரிசை மற்றும் நெடுவரிசைகளை ஒவ்வொரு 

அச்சிடப்பட  வேண்டிய பக்கத்திற்கும் மீண்டும் வருமாறு அமைக்கலாம்.  எடுத்துக்காட்டாக, தாளின் 

மேற்பகுதியில் உள்ள இரண்டு வரிசைகள் மற்றும் நெடுவரிசை Aவையும் அனைத்து பக்கங்களிலும் 

அச்சிடப்பட வேண்டிய இருந்தால் பின் வரும் படிநிலைகளை செய்யவும்.

படிநிலை 1: Format → print → ranges → Edit த�ோ்வு செய்யவும்.

படம் 11.25 மீண்டும் அச்சிடப்பட வேண்டிய வரிரசகள் / நெடுவரிசைகள்

படிநிலை 2: “Edit Print Ranges” உரையாடல் பெட்டியில் “Rows to repeat” க்கு கீழே வரும் உரைப்பெட்டியில் 

வரிசைகளை உள்ளீடு செய்யவும்.  எடுத்துக்காட்டாக, வரிசை, 1 மற்றும் 2 ஐ மீண்டும் பெற (repeat) $1:$2 
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என்று தட்டச்சு செய்யதால் “Rows to repeat” என்ற தேர்வு  “_none_” ல் இருந்து  “_User defined_”என 

தானாகவே மாற்றம் பெறும்.

நினைவில் க�ொள்க :

•	 அட்டவணைச் செயலியில் உள்ள தகவல்களைக் கையாளுவதற்கு தரவுக் கருவிகள் பயன்படுகின்றன.

•	 நிபந்தனை வடிவமைப்பு பயனருக்குத் தேவையான வேறுபட்ட தரவுகளுக்கு மாறுபட்ட எழுத்து அளவு, 

எழுத்து நிறம் மற்றும் பின்புற வண்ணத்தை தருகிறது.

•	 வரிசையாக்கம் என்பது தரவுகளை (எழுத்துக்களைய�ோ அல்லது மதிப்புகளைய�ோ) ஏறுவரிசை அல்லது 

இறங்கு வரிசையில் ஒழுங்குபடுத்துதல் ஆகும்.

•	 பெரிய அளவு தரவுத் தளத்திலிருந்து தேர்;நதெடுக்ககப்பட்ட தரவு்பபகுதியை மட்டும் காண்பிக்க 

வடிகட்டிகள்  பயன்படுகின்றன.

•	 Input help பலவித த�ோ்வுகளாகிய வாரம், மாதம் ப�ோன்றவற்றை வழங்க பயன்படுகிறது.

•	 தலைப்பு மற்றும் அடிக்குறிப்பு என்பது சில தலைப்புகள் (ஆவணத் தலைப்பு, நூலாசிரியா)் அல்லது 
மேற்கோள்கள் (அதாவது பக்க எண், பக்கங்களின் எண்ணிக்கை, தேதி) அல்லது குறிப்புரைகள் 

ஆகியவை மேல்பகுதியில் அச்சிடப்பட்டால் அவை தலைப்பு (Header) எனவும், கீழ்ப்பகுதியில் 

அச்சிடப்பட்டால் அடிக்குறிப்பு (Footer) எனவும் அழைக்கப்படுகின்றன.

•	 ஒரு தாளை பல பக்கங்களில்  அச்சிடப்படும்போது நாம் சில வரிசை மற்றும் நெடுவரிசைகளை ஒவ்வொரு 

அச்சிடப்படவேண்டிய பக்கத்திற்கும் மீண்டும் வருமாறு அமைக்கலாம்.

மதிப்பீடு

பகுதி - அ 

சரியான விடையை தேர்ந்தெடு:

1.	 அட்டவணைத் தாளில் 10,000 வரிசைகள் உள்ளன.  பயனர் ஒரு  குறிப்பிட்ட வரிசையை தரவுதளத்தில் 

பார்க்க விரும்பினால், கீழ்வரும் எந்தக் கருவியை பயன்படுத்த வேண்டும்?

	 அ. வரிசையாக்கல்		  இ. வடிகட்டுதல்

	 ஆ. சேர்த்தல்			   ஈ. வடிவமைத்தல்

2.	 வாடிக்கையாளார் ப�ொருளின் எண்ணை 101லிருந்து 200 க்குள் வடிவமைக்கிறார்.  பயனர் 200 க்கு 

அதிகமாக அல்லது 100 க்கு குறைவாக உள்ளீடு செய்தால் கணினி பிழை செய்தியை க�ொடுக்கும்.  

பின்வரும் எந்தக் கருவி இதற்கு பயன்படுகிறது? 

	 அ. பட்டியல்				    இ. வடிவமைத்தல்

	 ஆ. வடிகட்டுதல்				    ஈ. செல்லுபடியாக்கல்
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3.	 ஒரு படிவத்தில், ஆசிரியா் (“True or False”) உண்மை அல்லது ப�ொய் என்பதை கீழ்விரிபட்டியாக 

க�ொடுக்க விரும்பினால், பின்வரும் எந்தக் கருவியை பயன்படுத்த வேண்டும்?

	 அ. படிவம் (Form)			   இ. பட்டியல் (List)

	 ஆ. தரவு (Data)				    ஈ. வடிவமைப்பு (Format)

4.	 A4 தாளின் அளவு 21 செ.மீ x 29 செ.மீ பயனா் லேண்ட்ஸ்கேப் (Landscape) அமைவை த�ோ்வு 

செய்தால், தாளின் அளவு?

	 அ. 21x29				    இ. 29 x 29

	 ஆ. 29x21				    ஈ. மேற்கூறிய அனைத்தும்

பகுதி - ஆ

அனைத்து வினாக்களுக்கு விடையளிக்கவும்:

1.	 வரிசையாக்கம் என்றால் என்ன?

2.	 வடிகட்டியின் வகைகள் யாவை?

3.	 தலைப்பு மற்றும் அடிக்குறிப்பு என்றால் என்ன?

4.	 தாளின் ஓரத்தை 1” என அனைத்து ஓரங்களிலும் வடிவமைப்பதற்கான படிநிலைகளை எழுதுக.

பகுதி - இ

அனைத்து வினாக்களுக்கு விடையளிக்கவும்: 

1.	 பயனர் அனைத்துப் பக்கங்களின் அடிப்பகுதியிலும் பக்க எண்களை புகுத்த வேண்டுமானால், எந்த 

கருவியை பயன்படுத்த வேண்டும்?  இதை வடிவமைப்பதற்கான படிநிலைகளை எழுதுக.

2.	 தரவுதளத்தில் வாடிக்கையாளர் பெயர்களை ஏறுவரிசையில் ஒழுங்குப்படுத்துவதற்கான 

படிநிலைகளை எழுதுக.

3.	 அட்டவணைத் தாளின் ஒவ்வொரு பக்கத்திலும் தலைப்பு வரிசையை அச்சிடுவதற்க்கான 

படிநிலைகளை  எழுதுக.

பகுதி - ஈ

அனைத்து வினாக்களுக்கு விடையளிக்கவும்: 

1.	 பதிவெண், மாணவர் பெயர், மதிப்பெண் 1, மதிப்பெண் 2, மதிப்பெண் 3 ஆகியவற்றுடன் கூடிய ஒரு 

மாணவர் தரவுதளத்தை உருவாக்குக. மாணவர்களின் மதிப்பெண்களின் கூட்டுத் த�ொகை மற்றும் 

சராசரியை கணக்கீடுக. 50 க்கும் அதிகமான மதிப்பெண்களை பச்சை வண்ணத்திலும், 50 க்கும் 

குறைவான மதிப்பெண்களை சிவப்பு வண்ணத்தில் காண்பிக்கவும்.

2.	 தலைப்பு மற்றும் அடிக்குறிப்பின் பயன்பாடுகளை எடுத்துக்காட்டுடன் விளக்கவம்.
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செய்முறை 

	 மாணவர் பெயர் மற்றும் பதிவெண் ஆகியற்றை தட்டச்சு செய்து வருகை புரிந்த மாணவர்களின் 

மதிப்பெண்ணை 1 எனவும் வருகை புரியாத மாணவர்களின் மதிப்பெண்ணை 0 (Zero) எனவும் தேதி என்ற 

நெடுவரிசைகளில் உள்ளிடுக. நிபந்தனை வடிவமைப்பை பயன்படுத்தி, வருகை புரிந்த மாணவர்களை பச்சை 

வண்ணத்திலும், வருகை புரியாதவர்களை சிவப்பு வண்ணத்திலும் காண்பிக்கவும். மேலும், கீழ்கண்டவற்றை 

கணக்கிடவும்.

மாணவர்களின்,

	 அ. வருகை புரிந்த நாட்களின் எண்ணக்கை.

	 ஆ. வருகை புரியாத நாட்களின் எண்ணக்கை.

	 இ. சராசரி வருகை.

	 ஈ. ஒவ்வொரு நாளும் வருகை புரிந்த மாணவர்களின் எண்ணிக்கை.

	 உ. ஒவ்வொரு நாளும் வருகை புரியாத மாணவர்களின் எண்ணிக்கை.

Register No .	 Name 29-Nov 08-Dec 13-Dec 20-Dec
160172 SHIVA. M 0 0 0 0
170001 MONICA. A 1 1 1 1
170002 SUGANYA. D 1 1 1 1
170004 POOJA. P 1 1 0 1
170005 MANJU. M 1 1 1 1
170006 MOTHILAL. T 1 1 1 1
170007 DIYA N 1 1 1 0
170008 PRAJAKTA S 1 1 1 1
170009 SIRISHA S 1 1 1 1
170010 SUSMITA S 1 1 1 1
170011 DIVYA K 1 1 1 1
170012 THOMAS S 1 1 1 1
170013 SUPRAJA A 1 1 1 1
170014 RAVIRAJ R 1 1 1 1
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கற்றல் ந�ோக்கங்கள்

	 இந்த பாடத்தை கற்றப்பின் மாணவர்கள் 

அறிந்து க�ொள்பவை

•	 OpenOffice நிகழ்த்துதல் மென்பொருளைப் 

பற்றி அறிந்துக�ொள்ளுதல்.

•	 ஓபன் ஆஃபீஸ் இம்ப்ரெஸ் (OpenOffice 
Impress) பயன்படுத்தி புதிய நிகழ்த்துதலை 

உருவாக்குதல்.

•	 புதிய நிகழ்த்துதலை இம்ப்ரெஸ் பல 

வழிகளில் எவ்வாறு உருவாக்குதல் என்பது 

பற்றி அறிந்துக�ொள்ளுதல்.

•	 இம்ப்ரெஸ் சன்னல் திரையின் முதன்மை 

பாகங்களைப் பற்றி அறிந்துக�ொள்ளுதல்.

•	 பணிப்பலகத்தின் (Task Pane) ஐந்து 

பிரிவுகளை வேறுபடுத்தி 

அறிந்துக�ொள்ளுதல்.

•	 இம்ப்ரெஸ் சன்னல் திரையின் கூறுகளைப் 

பற்றி அறிந்துக�ொள்ளுதல்.

•	 பணிப்பகுதியின் (Workspace) பல்வேறு 

காட்சிகளை வேறுபடுத்தி 

அறிந்துக�ொள்ளுதல்.

•	 வரைபட ப�ொருட்கள் (Drawing objects) 
மற்றும் OLE ப�ொருட்களை செருகுதல்.

•	 கையினால் வரையப்பட்ட வடிவங்களை 
(Freeform shapes) வரைதல்.

•	 ப�ொருட்களை சுழற்றுதல் பற்றி அறிதல்.

•	 சில்லுகள் / ப�ொருட்களில் அசைவுப்படங்களை 

உருவாக்குதல்.

12.1 நிகழ்த்துதல் மென்பொருள் - ப�ொருள்:

•	 நிகழ்த்துதல் 

மென்பொருளானது, ஒரு 

கணிப்பொறி மென்பொருள் 

ஆகும். இது தகவல்களை 

சில்லுக் காட்சிகளாக 

வழங்கப் பயன்படுகிறது.

நிகழ்த்துதல் மென்பொருளின் மூன்று முக்கிய 

செயல்பாடுகளாவன:

•	 உரையை செருகுவதற்கும், 

வடிவமைத்தலுக்கும் ஒரு பதிப்பான் (Editor) 
மென்பொருள். 

•	 வரைகலை படங்களை செருகுவதற்கும் 

மற்றும் கையாளுவதற்குமான வழிமுறைகள்.

•	 தகவல்களை காட்சிப்படுத்துவதற்கான 

சில்லுக்காட்சி.

•	 நிகழ்த்துதல் என்பது, நிகழ்த்துதலை 

உருவாக்கவும், வினா-விடைகள், மின் கற்றல் 

மற்றும் பல்லூடக ப�ொருட்களை 

உருவாக்கவும் பயன்படும் மென்பொருள் 

ஆகும்.

•	 பெரும்பான்மையான நிகழ்த்துதல் 

மென்பொருட்கள் த�ொடர் சில்லுகளை 

பயன்படுத்தி பல்லூடக ப�ொருட்களை 

உருவாக்கப் பயன்படுகிறது.

•	 ஒவ்வொரு சில்லுவிலும், உரை, படங்கள், 

ஒளிக்காட்சிகள், அசைவுப்படங்கள், 

இணைப்பு மற்றும் ஒலி ப�ோன்றவற்றை 

இணைத்து இறுதி ப�ொருட்களை 

உருவாக்குதல்.

	 கீழ்காணும் மிகப் ப�ொதுவான 

நிகழ்த்துதல் நிரல்கள், ஓபன் ஆஃபிஸ் இம்ப்ரஸ், 

மைக்ரோசாப்ட் பவர் பாயின்ட் மற்றும் ஆப்பிள் 

நிறுவனத்தின் கீந�ோட் ஆகும். இந்த 

நிகழ்த்துதல் - ஓர் அறிமுகம்

பாடம் 12அலகு IV அலுவலக  
தானியங்கு கருவிகள்
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பாடப்பகுதியில் நாம் நிகழ்த்துதல் 

மென்பொருளான ஓபன் ஆஃபிஸ் 

இம்ப்ரஸ் பற்றி அறிந்து க�ொள்ள 

உள்ளோம்.

12.2. இம்ப்ரெஸ் 

	 இம்ப்ரெஸ் என்பது ஓபன் 

ஆஃபிஸ்ன் (சில்லுக்காட்சி) ஓர் 

பகுதியாகும்.  சில்லுகளை இம்பரஸ் 
பயன்படுத்தி உருவாக்க இயலும். 

இதில் வெவ்வேறு கூறுகளாக உரை, 

புல்லட் மற்றும் எண்கள்,  கிளிப் 

ஆர்ட் துண்டு படம் மற்றும் 

வரைபடங்கள் உள்ளன. 

	 இம்பெரஸில் எழுத்துப்பிழை 

திருத்தும் வசதியும் தெசாரஸ்  உடன் 

உள்ளது. மேலும் முன்னரே 

த�ொகுக்கப்பட்ட உரை வடிவம் மற்றும் 

பின்னணி  உடன் இணைய உதவி 

உள்ளது.

12.3 புதிய நிகழ்த்துதலை 
திறத்தல்

	 Impress யை துவங்க பல 

வழிகள் உள்ளன. 

•	 Start ப�ொத்தானை அழுத்தி All 
Programs → OpenOffice→ 
Open Office Impress  
கட்டளையை தேர்வு செய்து (படம் 
12.1ல் காட்டியவாறு) புதிய 

நிகழ்த்துதலை திறக்கலாம்.

•	 நிகழ்த்துதல் பயன்பாடானது 

ஏற்கனவே ப�ொருத்தப்பட்டு 

இருப்பின் துவக்க பட்டியில் 

கிளிக் செய்து திறக்கலாம்.(படம் 
12.2)

12.4 புதிய நிகழ்த்துதலை 
உருவாக்குதல்

	 புதிய நிகழ்த்துதல் சில்லுவை 

உருவாக்க கீழ்காணும் முறைகளில் 

ஒன்றை பயன்படுத்தலாம்.

1.	 காலியான நிகழ்த்துதலை தேர்ந்தெடுக்க. 

2.	 முன் வடிவமைத்த சில்லுகளில் இருந்து (Template)  
தேர்ந்தெடுக்கலாம்.

படம் 12.1 – Start → All Programs கட்டளையை 

பயன்படுத்தி நிகழ்த்துதலை திறத்தல்

படம் 12.2 – Start button பயன்படுத்தி நிகழ்த்துதலை 

திறத்தல்

3. ஏற்கனவே உருவாக்கப்பட்டுள்ள நிகழ்த்துதலை 

தேர்ந்தெடுக்கலாம் 
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12.4.1. Using Empty presentation

1.	 காலியான நிகழ்த்துதலை தேர்ந்தெடுக்க 
Type என்ற பகுதியில் Empty Presentation 
என்பதை தேர்வு செய்யவும்.

2.	 Next ப�ொத்தானை கிளிக் செய்தால் படம் 
12.4ல் காட்டியவாறு Presentation Wizard-ன் 

படிநிலை 2 த�ோன்றும்.

3.	 Select a design பகுதியில் உள்ள கீழிறங்கு 

பட்டியல் பெட்டியில் இரு வகையான 

தேர்வுகள் உள்ளன. இதிலிருந்து சில்லுவின் 

வடிவமைப்பை தேர்வு செய்யலாம். 
Presentation  Backgrounds மற்றும் 
Presentations.

4.	 Select a slide design பகுதியின் கீழ் உள்ள 

Select an output medium என்பதில் 

வெளியிடும் ஊடகத்தை தேர்வு செய்யவும். 

தேர்வு செய்த விருப்பங்களை ஒத்த 

முன்னேட்டமானது Preview பகுதியில் 

த�ோன்றும். 

படம் 12.3 – நிகழ்த்துதல் வழிகாட்டி ஜன்னல் திரையை பயன்படுத்தி நிகழ்த்துதலின் வகையை தேர்வு 

செய்தல்

படம் 12.4 வழிகாட்டு ஜன்னல் திரையில் முதன்மை விருப்பங்களை காண்பித்தல்
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5.	 <Original> என்பது காலியான பின்னணி 

க�ொண்டது.முன்னரே வடிவமைக்கப்பட்ட 

மூன்று வகையான நிகழ்த்தலிருந்து 

ஏதேனும் ஒன்றை தேர்ந்தெடுக்கலாம். 

<original>, Introducing a New product 
மற்றும் Recommendation  of a strategy 

(படம் 12.6 காண்க). 

6.	 தேவையான விருப்பத்தை கிளிக் செய்தால் 
Preview  சன்னல் திரையில் தேர்வு 

செய்யப்பட்ட சில்லுவின் வடிவமைப்பின் 
முன்னோட்டத்தைப் பார்க்கலாம்.

7.	 Select an output medium என்ற 

தேர்வானது வெளியிடும் ஊடகத்தை தேர்வு 

செய்ய பயன்படுகிறது. கணிப்பொறியின் 

திரையில் வெளியீடு செய்ய Screen  தேர்வு 

செய்யவும். (படம் 12.6)

8.	 Next என்ற ப�ொத்தானை Click செய்தால் 
The presentation Wizard (படம் 12.7 ல்)  

ஜன்னல் திரை த�ோன்றும். அதில் Effect 
என்ற கீழிறங்கு பட்டியல் பெட்டியில் 

சில்லுவிற்கான மாற்று விளைவுகளையும், 

Speed என்பதில் இருந்து 

வேகமாற்றத்தையும் தேர்வு செய்யலாம். 

வேகமாற்றதிற்கு Medium என்பது 

சிறப்பான தேர்வாகும். Create கிளிக் 

செய்யவும் ஒரு புதிய நிகழ்த்தல் 

உருவாக்கப்படும் (படம் 12.8)

படம் 12.5 நிகழ்த்துதலின் பின்புலத்தை பயன்படுத்தி சில்லுவை வடிவமைத்தல்
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படம் 12.6 slide design பயன்படுத்தி நிகழ்த்துதலை தேர்வு செய்தல்

படம் 12.7 சில்லுவிற்கான விளைவுகளை தேர்வு செய்தல்

12.4.2 முன்வடிவம் (Template)  பயன்படுத்துதல்

•	 புதிய நிகழ்த்துதலுக்கான முன்கூட்டியே வடிவமைக்கப்பட்ட சில்லுகளைக் க�ொண்டு நிகழ்த்துதலை 

உருவாக்க From Template தேர்வு செய்யவும்.த�ோன்றும் முன் வடிவமைப்பு செய்யப்பட்ட சில்லுகளின் 

பட்டியலில் இருந்து தேவையானதை தேர்வு செய்யவும் (படம் 12.9) Introducing a new product, 
மற்றும் Recommendation of a strategy என்பவை முன்கூட்டியே வடிவமைக்கப்பட்ட சில்லுகளில் 

த�ொகுப்பாகும்.
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படம் 12.8 புதிய நிகழ்த்துதல்

படம் 12.9 முன்வடிவ தேர்வை பயன்படுத்தி ஒரு புதிய நிகழ்த்துதலை உருவாக்குதல்

12.4.3 ஏற்கனவே உருவாக்கிய நிகழ்த்துதலை திறத்தல் (Open existing presentation)

•	 Open existing presentation விருப்பத்தை தேர்வு செய்தால் ஏற்கனவே உருவாக்கிய நிகழ்த்துதலை 

த�ொடர உதவி செய்யும். 

•	 ஏற்கனவே உருவாக்கி வைக்கப்பட்டுள்ள நிகழ்த்துதலை திறக்க Open என்ற ப�ொத்தானை கிளிக் 

செய்தால் ஏற்கனவே உருவாக்கிய நிகழ்த்துதல்கள் பட்டியல் த�ோன்றும் அதில் இருந்து நமக்கு 

தேவையானவற்றை தேர்வு செய்து படம் 12.10ல் காட்டியவாறு த�ொடரலாம்.
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படம் 12.10 சேமித்து வைத்துள்ள நிகழ்த்துதலை திறத்தல்

படம் 12.11 குறும்படத்தை பயன்படுத்தி ஒரு புதிய நிகழ்த்துதலை உருவாக்குதல்
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குறிப்பு

•	 Do not show this wizard again 
checkbox என்ற தேர்வு பெட்டியை 

தேர்வு செய்தால் ஒவ்வொரு முறையும் 

impress திறக்கும்போது Wizard 
த�  ோ ன்றா   து .

•	 Preview தேர்வு பெட்டி 

தேர்ந்தெடுக்கப்பட்டிருக்கும்  ப�ோது, 

முன்வடிவங்கள், சில்லு வடிவமைப்புகள் 

மற்றும் சில்லு மாற்றங்கள் நாம் 

தேர்வு செய்த முறையில் முன்னோட்ட 

பெட்டியில் த�ோன்றும்.

இம்ப்ரஸை துவக்குவதற்கான பல்வேறு வழிகள்

Impress துவக்குவதற்கு பல்வேறு வழிகள் 

உள்ளன.

1.	 நிகழ்த்துதலை  இயக்க பட்டியில் அல்லது 

Open Office Quickstarter மூலம் தேர்வு 

செய்யலாம்.

2.	 வலதுப் பக்கத்தில் உள்ள New 
குறும்படத்தை முதன்மை கருவிப்பட்டை 

மற்றும் கீழ் த�ோன்றும் பட்டி மூலம் படம் 

12.11ல் காட்டியவாறு தேர்வு செய்யலாம்.

3.	 அல்லது File→  New→ Presentation 
படம் 12.12ல் காட்டியவாறு தேர்வு செய்யவும்.

12.5 இம்பரஸ் சாளரத்தின் முதன்மையான 
பகுதிகள்

	 முதன்மை Impress சாளரத்தின் மூன்று 

பகுதிகள் உள்ளன. 1. Slides pane 2. 
Workspace 3.Task pane.படம் 12.13ல் 

காட்டியவாறு த�ோன்றும். கூடுதலாக, பல்வேறு  

நிகழ்த்துதல் உருவாக்கும்போது பல்வகையான 

கருவிப்பட்டைகள் காண்பிக்கப்படலாம் அல்லது 

மறைந்தும் இருக்கலாம்.

குறிப்பு

சில்லு பலகத்தை அல்லது பணிப் 

பலகத்தை நீக்க மேல் வலது மூலையில் 
close (X)ப�ொத்தானை கிளிக் செய்ய 

வேண்டும். மேலும் பலகத்தை மறைக்க 

அல்லது திரும்பபெற

View → Slide pane  அல்லது

View → Task pane / Side bar 
ப ய ன்ப  டு த ்த லாம்   .

	
படம் 12.12  File பட்டியில் இருந்து ஒரு புதிய நிகழ்த்துதலை உருவாக்குதல்
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படம் 12.13 நிகழ்த்துதலின் முதன்மை சாளரம்

12.5.1 சில்லு பலகம் (Slides pane)

•	 சில்லு பலகம், நிகழ்த்துதலில் நாம் சேர்த்த 

சில்லுகளின் வரிசைமுறைப்படி, சில்லுகளை 

சிறிய உருவப்படங்களாக க�ொண்டிருக்கும்.

•	 இந்த பலகத்தில் இருக்கும் சில்லுவை Click 
செய்தால், அது தேர்ந்தெடுக்கப்பட்டு, 

பணிபகுதியில் இருத்தப்படும். அந்த 

சில்லுவிற்கு, நாம் வேண்டும் மாற்றங்களை 

மேற்கொள்ளலாம்.

	 சில்லு பலகத்திலுள்ள ஒன்று அல்லது 

அதற்கு மேற்பட்ட சில்லுகளின் மீது பல கூடுதல் 

செயல்பாடுகளை மேற்கொள்ளலாம்.

சில்லு பலகத்தின் மூலம் ஒன்று அதற்கு 

மேற்பட்ட சில்லுகளில் கூடுதல் செயல்கள் 

செய்யலாம்.

•	 Add a new slides- புதிய சில்லுவை முதல் 

சில்லுவிற்கு பிறகு நிகழ்த்துதலில் சேர்க்க

•	 Mark a slide as hidden- ஒரு சில்லுவை 

நிகழ்த்துதலின் ப�ோது அதை மறைக்க

•	 Delete a slide- தேவையற்ற சில்லுவை 

நிகழ்த்துதலிருந்து நீக்க

•	 Rename a slide – சில்லுகள் க�ொடாநிலையாக 

slide 1, slide 2, …. என்று பெயர்களை 

மாற்றம் செய்ய உதவும். 

•	 Copy or move the contents- ஒரு 

சில்லுவிலிருந்து மற்றொரு சில்லுவிற்கு 

அதிலிருந்து ப�ொருளடக்கத்தை நகலெடுக்க 

அல்லது நகர்க்க (நகலெடுத்து ஒட்ட அல்ல 

வெட்டி ஒட்டுவது முறையே) 

•	 சில்லு பலகத்திலிருந்து மேலும் சில 

செயல்களை செய்ய முடியும்.

•	 Change the slide transition- ஒரு சில்லு 

அல்லது சில்லுகளின் குழுவிலிருந்து அடுத்த 

சில்லுக்கு மாற்றம் செய்ய.

•	 Change the sequence of slides- 

நிகழ்த்துதலில் மாற்ற 

•	 Change the slide design-  பயனருக்கு 

தேவையான வடிவமைப்பை 

தேர்ந்தெடுக்கலாம்.

•	 Change the slide layout- ஒரே சமயத்தில் 

சில்லுகளின் குழுவிற்கு வடிவமைப்பு செய்தல் 

(இதற்கு  task பலகத்திலுள்ள Layout பகுதியை 

பயன்படுத்தவும்)
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12.5.2 பணிப் பலகம்

	 பணிப் பலகம் ஐந்து பிரிவுகளை 

க�ொண்டுள்ளது. அவற்றுள் ஒன்று, 

க�ொடாநிலையாக இருக்கும். மற்றவை குறிப்பிட்ட 

பின்னணியை க�ொண்டிருக்கும். (படம் 12.14 

பார்க்க)

1. முதன்மை பக்கங்கள் (Master Pages)

	 நிகழ்த்துதலின் பக்க அமைவு முதன்மை 

பக்கத்தை பயன்படுத்தி வரையறுக்கலாம். 
Impress ல் முன்னரே த�ொகுக்கப்பட்ட முதன்மை 

பக்கங்கள் இருக்கும். (Slide Master)

	 அவற்றுள் ஒன்று க�ொடாநிலையாக 

வெற்று சில்லுவாக இருக்கும். மற்றவை 

குறிப்பிட்ட பின்னணியை க�ொண்டிருக்கும். (படம் 

12.14 காண்க)

படம் 12.14 முதன்மை பக்கங்கள்

2. Layout
	 முன்னரே த�ொகுக்கபட்ட Layout 
காட்டப்பட்டுள்ளது. இதில் ஒன்றை செய்யலாம் 

அல்லது தனித்தேவைகளுக்கு மாற்றம் 

செய்யலாம். தற்போது custom layout உருவாக 

சாத்தியம் இல்லை.

படம் 12.15 வரைநிலை (Layout)

3. அட்டவணை வடிவமைப்பு (Table Design)

	 இந்த பலகத்தில் தரநிலையில் 

அட்டவணைப் பாணி க�ொடுக்கப்பட்டுள்ளது.

மேலும் அட்டவணையின் த�ோற்றத்தில் 

மாற்றங்கள் செய்யலாம். குறிப்பிட்ட வரிசை 

மற்றும் நெடுவரிசையை த�ோன்றச் செய்தோ 

மறையச் செய்தோ இணைக்கச் செய்தோ 

காட்டலாம் அல்லது வரிசை மற்றும் 

நெடுவரிசையை கூட்டாகவ�ோ செய்யலாம்.

படம் 12.16 அட்டவணை வடிவமைப்பு
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படம் 12.17 தனிப்பயன் அசைவு படம்

4  தனிப்பயன் அசைவு படம்

	 சில்லுவில் உள்ள தேர்ந்தெடுக்கப்பட்ட 

கூறுகளுக்கான பல்வேறு வகையான 

அசைவூட்டங்கள் இங்கு பட்டியலிடப்பட்டுள்ளது. 

	 ஒரு சில்லுவில் தேர்ந்தெடுக்கப்பட்ட 

கூறுகளுக்கு வழங்கிய அசைவூட்டங்களை, 

பின்னர், மாற்றவ�ோ அல்லது நீக்கவ�ோ 

செய்யலாம். (படம் 12.17)

5 சில்லு மாற்றம் (Slide Transition)

	 சில்லு மாற்றம் பட்டியல் No Transition 
என்ற தேர்வை உள்ளடக்கியுள்ளது. சில்லு 

மாற்றத்தின் வேகத்தை நாம் தேர்ந்தெடுத்து 

க�ொள்ள முடியும் (Slow, medium, fast). மாற்று 

விளைவு தானாக நிகழ வேண்டுமா அல்லது 

பயனாளர் கட்டுப்பாட்டில் இருக்க வேண்டுமா என 

தேர்ந்தெடுத்துக் க�ொள்ளலாம். 

தேர்ந்தெடுக்கப்பட்ட சில்லு எவ்வளவு நேரம் 

காண்பிக்கப்பட வேண்டும் என்பதையும் 

குறிப்பிடலாம் (automatic மாற்றத்தில் மட்டும்) 

(படம் 12.18).

படம் 12.18 சில்லு மாற்றம்

12.6. Impress சாளரத்தில் கூறுகள்

	 திறந்த மூல இம்பெரஸ் கூறுகளை 

ப�ோன்றே தலைப்புப் பட்டை, பட்டிப் பட்டை, 

கருவிப் பட்டை, ரூலர் (Ruler) பட்டை, உருள் 

பட்டை ப�ோன்றே சரளரத்தில் கூறுகளை 

இம்பரெஸ் க�ொண்டுள்ளது. (படம் 12.19)

12.6.1 காட்சிமுறை ப�ொத்தான் (View Button)

	 பணிப்பகுதியில் ஐந்து தத்தல் குறிகள் 

உள்ளன. Normal, Outline, Notes, Handout 
மற்றும் Slide sorter ப�ோன்றவை படம் 12.19ல் 

காட்டியவாறு உள்ளது. இந்த ஐந்து தத்தல் 

குறிகளையும் காட்சிமுறை ப�ொத்தான்கள் 

என்கிற�ோம்.

12.6.2 நிலைமை பட்டை (Status bar)

	 சாரளத்தின் கீழ் பகுதியில் காணப்படும் 

நிலைமைப் பட்டை, பயன்பாட்டிலுள்ள க�ோப்பை 

பற்றிய சில புள்ளி விவரங்களை காண்பிக்கும். 
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இங்கு காண்பிக்கப்படும் தகவலை கவனத்தில் க�ொள்வது சிறந்த வழக்கமாகும். நிலைமைப்படடையில் 

த�ோன்றும் தகவல், தேவையில்லையெனில், முதன்மைப் பட்டியிலிருந்து View→status bar என்பதை 

தேர்வு செய்து, நிலைமைப்பட்டையை மறையச் செய்யலாம்.

12.6.3 வழிகாட்டிப் பட்டை (Navigator)

	 ஒரு ஆவணத்தில் இருக்கும் அனைத்து ப�ொருட்களும் வழிக்காட்டிப் பட்டையில் காண்பிக்கப்படும். 

இது ஆவணத்தின் பல பகுதிகளுக்கும் சென்று, ப�ொருட்களை கண்டறிய மற்றும�ொரு வழியை 

வழங்குகிறது. (Navigator) வழிகாட்டிப் ப�ொத்தான் நலையான கருவிப்பட்டையில் அமைந்துள்ளது. 

வழிகாட்டிப் பட்டையை, பட்டிப்பட்டையிலுள்ள Edit→Navigator க�ொண்டோ அல்லது Ctrl+Shift+F5 
ப�ொத்தான்களை அழுத்திய�ோ பெறலாம்.

	 படம் 12.20ல் காட்டியுள்ளவாறு, "Object 1" மற்றும் "Picture 1" என்று பெயரிடாமல், ப�ொருட்களுக்கு 
(Pictures, Spreadsheets ப�ோன்ற) ப�ொருத்தமான பெயர்களை குறிப்பிட்டால் வழிகாட்டிப் பட்டை மிகவும் 

பயனுள்ளதாக அமையும்.

பட்டி பட்டை

சில்லுபலகம்

பணி பகுதி

பணிபலகம்

காட்சிமுறை ப�ொத்தான்

கருவிபட்டை

Scroll Bar

படம் 12.19 இம்பரஸ் சாளரத்தின் கூறுகள் 
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படம் 12.20 வழிகாட்டிப் ப�ொத்தான்

12.7 பணிப்பகுதி  (Workspace)

	 பணிப்பகுதியில் ஐந்து தத்தல்கள் 

(Normal, Outline, Notes, Handout மற்றும் 
Slide Sorter) படம் 12.19ல் காணலாம்.இந்த 

ஐந்து தத்தல்களும் காட்சி முறை ப�ொத்தான்கள் 

என்று அழைக்கப்படுகிறது. சில்லு 

உருவாக்குவதில் பல கருவிப் பட்டைகள் 

பயன்படுகிறது. இவற்றை View → Toolbars  
என்ற தேர்வின் மூலம் பெறலாம்.

	 View ப�ொத்தான்களுக்கு கீழே  

பணியிடத்திற்கான பிரிவு உள்ளது. இந்த 

இடத்தில் தான் நீங்கள் தேர்வு செய்த 

சில்லுகளின் பல்வேறு பகுதிகளை 

நிறுவிக்கொள்ளலாம். குறிப்பிட்ட பணியினை 

எளிதாக நிறைவேற்றும் வகையில் காட்சிமுறை 

வடிவமைக்கப்பட்டுள்ளது.

	 Normal view தனித்தனி சில்லுவை 

உருவாக்கவும் பதிப்பிக்கவும் உதவுகிறது. 

சில்லுவை வடிவமைக்க, சேர்க்க, வரைகலை 

படம் மற்றும் அசைவு படங்களை சேர்க்க 

பயன்படுகிறது. 

Outline view சில்லுவின் பெயர் மற்றும் 

தலைப்புகளை தேவைக்கேற்ப பதிப்பித்து 

க�ொள்ளவும் உதவுகிறது. சில்லுகளை 

மறுசீரமைக்கவும், தலைப்புகளை 

மாற்றியமைக்கவும் வரிசைப்படி பட்டியலிடவும் 

புதிய சில்லுவை சேர்க்கவும் பயன்படுகிறது.

Notes view சில்லுகளின் குறிப்புகளை 

சேர்க்கவும், ஏற்கனவே உள்ள குறிப்புகளை 

பார்க்கவும் பயன்படுகிறது. இதை நிகழ்த்துதலில் 

காண இயலாது.

Slide Sorter view இது எல்லா சில்லுகளையும் 

சிறிய வடிவத்தில் பார்க்க உதவுகிறது. சில்லு 

காட்சியின் நேரத்தை குறிப்பிடவும் இரண்டு 

சில்லுகளுக்கிடையேயான பரிமாற்றத்தை 

சேர்க்கவும், சில்லுகளின் வரிசையை மாற்றவும் 

பயன்படுகிறது.

Handout view சில்லுவின் அளவை மாற்றி பல 

சில்லுகள் ஒரே பக்கத்தில் வருமாறும் சில்லுகளை 

அச்சிட்டு கைப்பிடி அறிக்கைகளாக வழங்க 

உதவுகிறது. Tasks Pane → Layout கட்டளை 

மூலம் ஒன்று, இரண்டு, மூன்று, நான்கு, ஐந்து 

ப�ோன்ற சில்லுகளை ஒரே பக்கத்தில் க�ொண்டு 

வந்து அச்சிடலாம். சுட்டியை இழுத்து விடுதல் 

மூலம் மறுசீரமைப்பு செய்யலாம்.

12.7.1. Normal view

	 Normal View வில் சில்லுவை 

வடிவமைக்கும் பகுதியில் சில்லுவை சேர்க்கும் 

இரண்டு வழிமுறைகள் உள்ளது. உலவி பட்டியை 

பயன்படுத்திய�ோ அல்லது   வழிகாட்டி  பட்டியை 

பயன்படுத்திய�ோ கிளிக் செய்து க�ொண்டுவரும் 

வசதி உள்ளது.

	 உலவி பட்டியை திறந்து நிலையான 

கருவிப்பட்டியில் உள்ள உலவி பட்டி ப�ொத்தானை 

கிளிக் செய்து அல்லது  ctrl + shift + F5 சாவி 
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சேர்மானம் க�ொண்டோ சில்லுவை தேர்வு செய்யலாம். உலவி பட்டியை கீழ் உருளல் செய்து தேவைப்படும் 

சில்லின் மீது இரட்டை கிளிக் செய்து திறந்துக்கொள்ளலாம்.(படம் 12.21)

12.7.2. Outline View

	 Outline View எல்லா சில்லுகளும் எண் வரிசையிடப்பட்ட த�ொடராக இருக்கும். உரை மட்டும் 

ஒவ்வொரு சில்லுவிலும் த�ோன்றும்.சில்லுவின் பெயர் இதில் உள்ளடங்காது. Out line View  இரண்டு 

விதங்களில் உதவிபுரிகிறது. 

1.	 சில்லுவின் உரையில் மாற்றங்கள் செய்வதற்கும் Normal View ப�ோன்று ஒரு சில்லுவை 

சேர்க்கவ�ோ நீக்கவ�ோ இயலும்.

ஒரு உரையின் பத்தியை மேல�ோ கீழ�ோ Up down ப�ொத்தான்களை அழுத்தி உரை வடிவூட்டல் கருவிப் 

பட்டை மூலம் நகர்த்தலாம்.  Left மற்றும் Right ப�ொத்தான்களை க�ொண்டு உரைப் பத்தியில் மாற்றங்கள் 

செய்யலாம்.

	 உரைப் பத்தி மற்றும் Outline Level இரண்டையும் நான்கு நகர்வு ப�ொத்தான்களைக் க�ொண்டு 

பயன்படுத்தலாம்.

2.	 Outlineல் உள்ள சில்லுகளை ஒப்பிட்டு (ஏற்கனவே ஒன்றை தயாரித்த பிறகு) மற்றொரு சில்லு 

தேவையென அறிந்தால் Outline நீங்கள் நேரடியாக outline view உருவாக்கலாம் அல்லது Normal 
View சென்று உருவாக்கலாம். Review சென்று எல்லா செல்லுகளையும் பார்வையிடு செய்யலாம்.

	 சரியான வரிசையில் இல்லாவிட்டால் சரியான இடத்திற்கு சென்று சரி செய்யலாம். படம் 12.22ல் 

உள்ளது ப�ோல பணிக்குறியை கிளிக் செய்யது.

	தேவை யான இடத்திற்கு சில்லுவை  நகர்த்தலாம்.

படம் 12.21 Normal view காட்சி முறை
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12.7.3. Notes view

1.	 Notes View பயன்படுத்தி சில்லுவில் குறிப்புகளை சேர்க்கலாம். காட்சிமுறை ப�ொத்தானில் Notes 
View தத்தலை தேர்ந்தெடுக்கவும். (படம் 12.23)

2.	 சில்லுவை தேர்வு செய்து குறிப்புகளை சேர்க்கலாம்.

3.	 இரட்டை கிளிக் மூலம் சில்லு பலகத்திலிருந்து தேர்வு  செய்யலாம். வழிகாட்டி பட்டையில் 

(நெவிகேட்டர்) சில்லுவின் பெயர் இரட்டை கிளிக் செய்யவும்.

படம் 12.22 Outline view காட்சி முறை

படம் 12.23 Notes view காட்சி முறை

3.	 உரைப் பெட்டியின் கீழ் உள்ள சில்லுவில் உரையை சேர்க்க click to add notes ல் கிளிக் செய்து சேர்க்கலாம்.  
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உரைப் பெட்டியை மறு அளவை செய்ய Green resizing handles மூலம் சுட்டுக்குறியை எல்லைக் க�ோட்டின் 

மீது வைத்து நகர்த்தி இழுத்து நகர்த்தலாம். எழுத்துருவில் மாற்றம் செய்ய F11 ப�ொத்தானை அழுத்தி 
Styles and Formatting window வில் மாற்றலாம்.

12.7.4 Slide sorter view

	 இதில் எல்லா சில்லுவும் குறும்படம் வடிவத்தில் காணப்படும்.இதை பயன்படுத்தி எல்லா வேலையும் 

சில்லுவின் த�ொகுப்பில�ோ அல்லது தனி சில்லுவில�ோ செய்யலாம்.ஒரு வரிசையில் சில்லுவின் எண்ணிக்கையில் 

மாற்றம் செய்யலாம். (படம் 12.24)

1.	 View→Toolbars→SlideView கிளிக் செய்து slide view toolbars ல் படம் 12.24ல் காட்டியவாறு 

சரிபார்க்கலாம்.

2.	 சில்லுகளின் எண்ணிக்கையை சரிசெய்யலாம். (அதிக பட்சமாக 15 வரை)

3.	 View→Toolbars→ Slide View பயன்படுத்தி ஒரு சில்லுவின் எண்ணிக்கையை சரிசெய்யலாம்.

Slide Sorter நிகழ்த்துதலில் சில்லுவை நகர்த்துதல்: 

1)	 சில்லுவை Click செய்தவுடன் அதைச்சுற்றி தடித்த கருப்பு நிற எல்லை உருவாக்கப்படும். 

2)	 வேண்டிய இடத்தில் இழுத்துவிடவும்.

3)	 சில்லுவை நகர்த்தியவுடன் ஒரு கருப்பு நிற செங்குத்தான வரி சில்லுவின் ஒரு பகுதியில் த�ோன்றும். 

4)	 கருப்பு நிற செங்குத்தான க�ோடு உள்ள இடம் வரை சில்லுவை நகர்த்த வேணடும்.

•	 குழுவாக உள்ள சில்லுக்களை தேர்வு செய்ய கீழ்க்காணும் ஏதேனும் ஒரு முறையை பயன்படுத்தலாம்

•	 Ctrl ப�ொத்தானை பயன்படுத்துதல்:

	 சில்லுகளின் குழுவை தேர்வு செய்து கீழ்கண்ட முறைகளை பயன்படுத்தி முதல் சில்லுவில் CTRL 

ப�ொத்தானை அழுத்தி விரும்பிய வரிசையில் மாற்றலாம்.

படம்  12.24  Slide Sorter view
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Shift ப�ொத்தானைப் பயன்படுத்துதல்: 

	 அனைத்து சில்லுகளையும் தேர்ந்தெடுக்க, Shift சாவியை அழுத்திக் க�ொண்டு முதல் சில்லுவை 

கிளிக் செய்து, பின் கடைசி சில்லுவை கிளிக் செய்வதால், த�ொகுப்பில் உள்ள அனைத்து சில்லுகளையும் 

தேர்தெடுக்க உதவுகிறது..

சுட்டுகுறியை பயன்படுத்தல்:

	 முதல் சில்லுவை மட்டும் தேர்வு செய்ய, சுட்டியின் இடது ப�ொத்தானை அழுத்த வேண்டும்.

கடைசி சில்லின் சிறுபடம்வரை சுட்டுகுறியை (கர்சரை) இழுக்கவும். சில்லின்  சிறுபடங்களைக் க�ொண்டு 

சுட்டுகுறயைக் இழுக்கும் ப�ோது, தடிமனான கறுப்பு எல்லைக�ோடு செவ்வக வடிவில் தேர்ந்தெடுக்கப்பட்ட 

சில்லுகளை சுற்றி இழுக்கும். இந்தசெவ்வகம் வடிவம் நாம்  விரும்பும் அனைத்து சில்லுகளையும் 

உள்ளடக்குகிறது என்பதை உறுதிப்படுத்தவும். ( படம் 12.25 )

சில்லுகளை ஒரு குழுவாக நகர்த்தல்

1)	 சில்லுகளை ஒரு குழுவாக தேர்ந்தெடுக்கவும்.

2)	 சில்லுகளின் குழுவை புதிய இடத்திற்கு இழுத்து விட வேண்டும். ஒரு  செங்குத்து கருப்பு க�ோடு 

த�ோன்றும், சில்லுகளின் குழு எங்கு ப�ோகும் என்பதை காண்பிக்கும். சில்லு பலகத்தில் 

பணியாற்றுவதைப் ப�ோல்  Slide sorter காட்சி முறையில் நாம் சில்லுகள�ோடு வேலை செய்யலாம் 

மாற்றங்களைச் செய்ய வேண்டும் எனில்,   சில்லின் மீது வலது சுட்டியை அழுத்தி, மேல்மீட்பு 

பட்டிகளை (pop-up)  பயன்படுத்தி, பின்வருவனவற்றைச் செய்யவும்.

•	 தேர்ந்தெடுக்கப்பட்ட சில்லுகளுக்கு  பின் புதிய சில்லுகளை சேர்க்கவும்.

•	தே ர்ந்தெடுக்கப்பட்ட சில்லுகளை நீக்குதல் அல்லது மறுபெயரிடுக.

•	 சில்லுகளின் அமைப்பை மாற்றி அமைக்கவும்.

•	 சில்லு மாற்றல் க�ொண்டு, மாற்றம் செய்யவும்.

ஒரு சில்லுவை தேர்ந்தெடுத்து, விரும்புகிற மாற்றத்தை(transistion) சேர்க்கவும்.

	 ஒன்றுக்கும் மேற்பட்ட சில்லுகள் இருக்குமானால், சில்லு குழுவை தேர்ந்தெடுத்து விரும்பிய 

மாற்றத்தைச் சேர்க்கவும். மறைக்கப்பட்ட சில்லு காட்சிமுறையில் காட்டப்படாது.

ஒரு சில்லுவை நகலெடுக்கவும் அல்லது வெட்டி ஒட்டவும் பயன்படுகிறது.

படம் 12.25 நிகழ்த்துதலில் Slide Sorter பயன்படுத்தி சில்லுவை நகர்த்துதல்
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12.7.5. Hand out view

	 Hand out view என்பது அச்சிடப்பட வேண்டிய சில்லுகளை வடிவமைப்பதற்காக உதவுகிறது.

காட்சிமுறை ப�ொத்தான்களில் உள்ள Handout தத்தலை கிளிக் செய்யவும், பின்னர் பணி பாலகத்தில் 

லேஅவுட் தேர்வை தேர்ந்தெடுக்கவும்.

	 இப்பொழுது பக்கத்திற்கு ஒன்று, இரண்டு, மூன்று, நான்கு அல்லது ஆறு சில்லுகளை ஒரு 

பக்கத்தில் அச்சிட தேர்வு செய்யலாம்.

To print a handout:

1.	 Slide Sorter -யை பயன்படுத்தி சில்லுகளை தேர்ந்தெடுக்கவும்.

	 ( சில்லுகளை குழுவாக தேர்ந்தெடுக்க மேற் கண்ட வழிமுறைகளைப் பயன்படுத்தவும் )

2.	 அச்சிடு உரையாடல் பெட்டியைத் திறப்பதற்கு File →Print அல்லது Ctrl+P-ஐத் தேர்ந்தெடுக்கவும்

3.	 அச்சு உரையாடல் பெட்டியின் கீழ் இடது மூலையில், தேவையான விருப்பங்களைத் தேர்ந்தெடுக்கவும்

4.	 உள்ளடக்க பிரிவில் Handouts –என்ற தேர்வை தேர்ந்தெடுத்து OK கிளிக் செய்யவும்

5.	 அச்சு உரையாடல் பெட்டியை மூட OK ப�ொத்தானை கிளிக் செய்யவும்

படம் 12.26Handout View

முன்பே த�ொகுக்கப்பட்ட அமைப்புகளுக்கான பெயர்களை தெரியவில்லை எனில் , உதவிக்கு 

குறிப்பு அம்சத்தைப் பயன்படுத்தலாம்.லேஅவுட் பிரிவும் அதன் பெயர் ஒரு சிறிய செவ்வக 

வடிவத்தில் காண்பிக்கப்படும்.சுட்டியை ஒரு பணிக்குறி மேல் வைக்கவும் அதன் பெயர் ஒரு சிறிய 

செவ்வக வடிவத்தில் காட்டப்படும்.குறிப்புகள் செயல்படவில்லை எனில், அவற்றை பயனர் செயல்பட 

செய்யலாம் முதன்மை முக்கிய பட்டியிலிருந்து,  Tools→Options→Open Office→General→Help 

குறிப்பு தேர்வை இயக்கி பெட்டியை பெறலாம். நீட்டிக்கப்பட்ட குறிப்புகள் (Extended tooltip) 

சரிபார்க்கப்பட்டால், விரிவான உதவிக்குறிப்பு தகவலை பெறுவ�ோம், ஆனால் உதவிக்குறிப்பு 

பெயர்கள் தானாக வழங்ககாது.

குறிப்பு:  
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செயல்பாடு

மாணவர் செயல்பாடு
1. கீழ்க்கண்ட முறையை பயன்படுத்தி ஒரு நிகழ்த்தலை  உருவாக்கவும்

•	 காலி நிகழ்த்துதல் சில்லுைவ பயன்படுத்தி (Empty Presentation)

•	 முன்வடிவமைக்கப்பட்ட சில்லுவை பயன்படுத்தி (From Template)

•	 முன்பே உருவாக்கப்பட்ட நிகழ்த்தல் (Open Existing Presentation)

2.	மே ற்கண்ட மூன்று முறைகளையும் பயன்படுத்தி நிகழ்த்துதலை உருவாக்கி அதன் 
வேறுபாட்டை காண்க.

3.	 நிகழ்த்துதல் பயன்பாட்டை பல்வேறு வழிமுறைகளை பயன்படுத்தி திறக்கவும்.

ஆசிரியர்செயல்பாடு
இந்த முழு அத்தியாயமும் கீழ்க்கண்ட வழிமுறையின் உதவியுடன் கற்றுக் க�ொள்ளமுடியும்

1.	 ஆய்வகசெயல்பாடு: 

	 அனைத்து மாணவர்களையும் ஆய்வகத்திற்கு அழைத்து சென்று படவீழ்த்தியை பயன்படுத்தி 
ஆசிரியர் நிகழ்த்துதலின் கருத்துருவை விளக்கவும்.

2.	 அல்லது வகுப்பறையில் ஒரு PC மற்றும் படவீழ்த்தியை பயன்படுத்தி கருத்தை விளக்க 
வேண்டும்.

3.	 ஆசிரியர் இந்த திறந்தமூல மென்பொருள் தவிர, சாளரத்தின் கூறுகளை ஒப்பிட்டு, MS 
Powerpoint -யில்  நிகழ்த்தலை உருவாக்கும் முறையை விளக்கவும். 

மதிப்பீடு

பகுதி - அ 

சரியான விடையை தேர்ந்தெடு:

1.	 ஒரு சில்லுவிலிருந்து வேற�ொரு சில்லுவிற்கு  விரைவாக நகர்த்துவதற்கு இதில் எது 
பயன்படுத்தப்படுகிறது?

	 அ) திசைகாட்டி		  ஆ) நேவிகேட்டர்	 இ) Fill Color		  ஈ) Page Border

2	 சில்லுக்காட்சியை துவங்குவதற்கான  குறுக்குவழி விசை  எது? 

	 அ) F6		  ஆ) F9		 இ)  F5		 ஈ) F10

3.	 இம்ப்ெரஸ்ல்  அனைத்து  சில்லுகளின் சிறுபதிப்புகள் கிடைமட்ட வரிசையில் அமைக்கப்பட்டிருக்கும் 
முறை.

	 அ) Notes		  ஆ) Outline		  இ) Handout		  ஈ) Slide Sorter

4.	 Impress-ல் க�ொடாநிலை பார்வை அடையாளம் காண பயன்படுவது.

	 அ) Normal		  ஆ) Slide Sorter	 இ) Handout		  ஈ) Slide Sorter

5.	 எந்த பட்டிபட்ைட சில்லு மாற்ற விருப்பத் ேதர்ைவ க�ொண்டுள்ளது?

	 அ) Slide Show 		 ஆ) View		  இ) Tools		  ஈ)  Format
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6.	 Impress-ல் நிகழ்த்துதல் நீட்டிப்பை (extension) அடையாளம் காணவும்?

	 அ) .odp			  ஆ) .ppt		  இ) .odb		  ஈ) .ood

7.	 நிகழ்த்துதல்  கருவிகளில்,  ஒரு சில்லுவின் நுழைவு விளைவு மற்றொரு சில்ைல நிகழ்த்துதலில்  

மாற்றுகிறது. எந்த தேர்வு இச்செயலை செய்கிறது?

	 அ) Animation			   ஆ) Slide Transition	

	 இ)Custom Animation	 	 ஈ) Rehearse Timings

8.	 வனியா "உலக வெப்பமயமாதல்" என்ற தலைப்பில் ஒரு நிகழ்த்துதலை செய்துள்ளார். அவர் 

வகுப்பில் இத்தலைப்பு பேசும்போது அவரின் நிகழ்த்துதல் தானாகவே காட்சிப்படுத்தப்பட 

வேண்டும். எனில், கீழ்க்காணும் எந்த தேர்வு அவருக்கு பயனுள்ளதாக அமையும்?

	 அ)Custom Animation		 ஆ)Rehearse Timing 

	 இ)Slide Transistion		  ஈ)  (அ) அல்லது (ஆ) 

பகுதி - ஆ

அனைத்து வினாக்களுக்கு விடையளிக்கவும்:

1.	 ஒரு சில்லு மற்றும் சில்லுகாட்சிக்கும் உள்ள வேறுபாடு என்ன?

2.	 எத்தனை உள்ளமைந்த சில்லு வடிவமைப்புகள் (layout) Impress-ல் உள்ளன?

3.	 நிகழ்த்துதல் என்றால் என்ன?

4.	 Impress யில் வார்ப்புரு – வரையறு. 

5.	 சில்லு வடிவமைப்புகள் என்றால் என்ன?

பகுதி - இ

அனைத்து வினாக்களுக்கு விடையளிக்கவும்: 

1.	 இம்ரஸில் எத்தனை வகையான பார்வை காட்சிகள் உள்ளன?

2.	 நிகழ்த்தல் மென்பொருளை யார் பயன்படுத்துகிறார்கள், ஏன்?

3.	 Slide Sorter பார்வை மற்றும் அதன் முக்கியத்துவத்தை வரையறுக்கவும்.

4.	 Normal View என்றால் என்ன? விளக்குக.

5.	 Impress-ல் சிறந்த நிகழ்த்துதலை உருவாக்க சில்லு மாற்று (transistion effect) முறை எவ்வாறு 

உதவுகிறது?

பகுதி - ஈ

அனைத்து வினாக்களுக்கு விடையளிக்கவும்: 

1.	 வளர்மதியின் ஆசிரியர், OpenOffice Impress-யை பயன்படுத்தி  ஒரு நிகழ்த்துதலை 

உருவாக்கும்படி கூறினார். ஆனால் வளர்மதி இதற்கு முன் எப்போதுமே Impressல் வேலை 

செய்தது இல்லை. எனவே, கீழ்காணும் செயல்களை செய்வதற்கு வளர்மதிக்கு உதவி செய்க. 
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	 அ) முதல் சில்லுவை தவிர, எல்லா சில்லுக்கும் ஒரே வடிவமைப்பில் இருக்க வேண்டும். இதற்கு, 

அவர் என்ன செய்ய வேண்டும்?

	 ஆ) பார்வையாளர்கள் எளிதில் த�ொடர்பு க�ொள்ள, விளக்கக்காட்சியின் ஒரு வன்படி நகலை 

	 அவர்களுக்கு வழங்க வேண்டும். இதை அவர் எதை க�ொண்டு உருவாக்க வேண்டும்?

	 இ) படங்கள் மற்றும் திரைப்பட க�ோப்புகளை நிகழ்த்தலில் செருக  விரும்புகிறார். எப்படி இதை 

செய்ய முடியும்?

	 ஈ) நிகழ்த்துதலை பார்வையாளர்களுக்கு காண்பிப்பதற்கு மிகவும் ப�ொருத்தமான சில்லு 

காட்சிமுறையை பரிந்துரைக்கவும். 

	 உ) நிகழ்த்துதலை கவர்ச்சிகரமானதாக மாற்றுவதற்கு, அதில் சில விளைவுகளைச் சேர்க்க 

விரும்புகிறார். எப்படி அதை செய்ய முடியும். பரிந்துரை.

2.	 விற்பனையாளர் தனது தயாரிப்புகளை விருத்திசெய்வதற்கு ஒரு நிகழ்த்துதல்  எப்படி உதவி 

செய்யும்?

3.	 சிவாபாலன் தனது பள்ளியின் வருடாந்திர விழாவில் காண்பிக்க ஒரு நிகழ்த்துதலை உருவாக்கினார்.

நிகழ்த்துதல் துவங்குவதற்கு 5 நிமிடங்களுக்கு முன், அவர் பள்ளியின் பெயர் தவறு என்பதை 

கவனித்தார். அது காட்சி 30 சில்லுகளில் த�ோன்றுகிறது. ஒரே ஒரு மாற்றத்தின் மூலம் அனைத்து 

சில்லுகளிலும் இந்த தவறை அவர் எவ்வாறு சரி செய்ய முடியும்?

4.	 முன்வடிவமைத்த படிவங்கள் (Template) பயன்படுத்தலில்  சில நன்மைக ைள பட்டியலிடு?
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கற்றல் ந�ோக்கங்கள்

	 இப்பாடப்பகுதியை 

கற்றபின் மாணவர் அறிந்து 

க�ொள்ளுதல்.

•	 சில்லுவில் உரையினை 

எவ்வாறு சேர்ப்பது மற்றும் 

வடிவூட்டுவது 

•	 அட்டவணை, வரைபடம், ஒலி மற்றும் 

ஒளிக்காட்சிகளை எவ்வாறு சில்லுவில் 

சேர்ப்பது.

•	 சில்லுவில் சேர்க்கப்பட்ட ப�ொருள்களுக்கு 

அசைவூட்ட விளைவுகளை எவ்வாறு 

வழங்குவது.

•	 சுட்டெலி மற்றும் டைமர் க�ொண்டு 

நிகழ்த்துதலை எவ்வாறு கட்டுப்படுத்துவது.

13.1 உரை செருகுதலின் சிறப்பம்சங்கள்  

13.1.1 உரை செருகுதல் மற்றும் வடிவமைத்தல்

நகலெடுத்து ஒட்டுதல் (Copy and Pasting text)

	 உரைப்பெட்டிக்குள் சேர்க்கப்படும் 

உரையானது வேற�ொரு ஆவணத்தில் இருந்து  

நகலெடுக்கப்பட்டு நிகழ்த்துதல் சில்லுவில் 

ஒட்டப்படலாம். இதனை உறுதி செய்ய பல 

வழிமுறைகள் உள்ளன. அவ்வழிமுறைகள் 

அனைத்தும் கீழே க�ொடுக்கப்பட்டுள்ளன. 

வடிவூட்டம் செய்யப்படாத உரையை ஒட்டுதல்

	 வடிவூட்டல்  செய்யப்படாத உரையை 

நகலெடுத்து ஒட்டுவதும் பின்னர் வடிவூட்டல் 

செய்வதும் ப�ொதுவாக நல்ல நடைமுறையாகும். 

வடிவூட்டல் செய்யப்படாத உரையை ஒட்டுவதற்கு, 
Ctrl+Shift+V என்ற சாவிச் சேர்மானத்தின் 

மூலமாகவ�ோ அல்லது  Edit→Paste Special என்ற  

பாடம் 13
நிகழ்த்துதல் (மேம்பட்டது)

நிகழ்த்துதல்அலகு IV

தேர்வின் மூலமாகவ�ோ த�ோன்றும் உரையாடல் 

பெட்டியில்  Unformatted text என்பதை 

தேர்ந்தெடுக்கவும் (படம் 13.1-னை பார்க்க), 
அல்லது செந்தரக்கருவிப்பட்டையில் paste 

பணிக்குறிக்கு அடுத்து உள்ள சிறிய கறுப்பு நிற 

முக்கோணத்தை கிளிக் செய்து த�ோன்றும் 

பட்டியலில்  Unformatted text என்பதை 

தேர்ந்தெடுக்கவும்.( படம்  13.2-னை பார்க்க)

படம் 13.1 உரையை ஒட்டுவதற்கான paste special 
உரையாடல் பெட்டி

படம் 13.2 செந்தரக்கருவிப்பட்டையில் உள்ள 

உரையை ஒட்டுவதற்கான பணிக்குறி 

ஒட்டப்பட்ட உரையை வடிவூட்டல் 

1.	 உரையானது AutoLayout பகுதியில் 

ஒட்டப்பட்டிருப்பின் உரையை விரும்பிய 

இடத்தில் ஒட்டவும்.

2.	 ஒட்டப்பட்ட உரையை தேர்ந்தெடுக்கவும்.

3.	 Format  பட்டியலில் இருந்து  Default 
formatting என்ற விருப்பத்தை 

தேர்ந்தெடுக்கவும். (படம் 13.3)
4.	 உரையை ப�ொருத்தமான இடத்திற்கு 
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நகர்த்துவதற்கு உரை வடிவூட்டல் 

கருவிப்பட்டையில் உள்ள நான்கு அம்புகுறி 

ப�ொத்தான்களை பயன்படுத்தவும்.

படம் 13.3 க�ொடாநிலை வடிவூட்டலை பட்டி 

பட்டையில் இருந்து தேர்ந்தெடுத்தல்

சிறப்புக் குறியீடுகளை சேர்த்தல் (Inserting 
special characters)

	 பதிப்புரிமை (Copywright) குறியீடு, 

கணிதம், வடிவியல் மற்றும் பணக்குறியீகள் 

அல்லது பிறம�ொழியில் உள்ள எழுத்துக்கள் 

ப�ோன்ற சிறப்புக்குறியீடுகளை சேர்க்க

1.	 உரையினுள் சிறப்புக்குறியீடுகளை 

நுழைக்க, விரும்பும் இடத்தில் செருகும்  

புள்ளியை வைக்கவேண்டும்.

2.	 Insert > Special Character என்ற 

விருப்பத்தை தேர்ந்தெடுக்கவும். Special 
Characters உரையாடல் பெட்டியானது 

திரையில் த�ோன்றும். (படம் 13.4). 

3.	 எழுத்து மற்றும் குறியுருக்களுக்கான 

துணைக்குழுக்களை Font மற்றும் Subset 
கீழிறங்கு பட்டியல் பெட்டியிலிருந்து தேர்வு 

செய்யவும்.

4.	 சேர்க்க விரும்பும் குறியீட்டின் மீது Click 

செய்க (அல்லது) திரைஉருளல் செய்து 

தேவையான குறியீட்டை தேர்வுசெய்யவும். 

5.	 OK  என்ற ப�ொத்தானை Click செய்யவும்.

படம் 13.4 சிறப்புக்குறியீடுகளை க�ொண்ட உரையாடல் பெட்டி
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குறும்படங்களை த�ோன்றச் செய்தல்:

	 கருவிப்பட்டையில் இடம் பெறாத 

பணிக்குறிகளை த�ோன்றச்செய்ய 

கருவிப்பட்டையின் வலது க�ோடியில் உள்ள சிறு 

கீழ்நோக்கிய முக்கோணத்தை கிளிக் செய்து 

த�ோன்றும் பட்டியலில்  visible Buttons  என்ற 

ேதர்வில் சுட்டியின் குறியீட்டை வைத்து 

த�ோன்றச்செய்ய வேண்டிய குறும்படங்களை 

கிளிக் செய்து  த�ோன்றச்செய்யலாம். (படம் 13.5).

AUTO LAYOUT AREA

படம் 13.5 கருவிப்பட்டையில் தேவையான 

குறும்படங்களை த�ோன்றச்செய்தல் 

உரைவடிவூட்டல் 

	 வடிவூட்டம் செய்யப்பட்ட உரையானது 

நிகழ்த்துதலுக்கு நிலையான 

த�ோற்றத்தையும்,மாறுபட்ட பாணிகளையும் 

வழங்க முடியும்.

பாணியை மாற்றுதல் 

	 நிகழ்த்துதலில் இரண்டு விதமான பாணி 

முறைகள் உள்ளன. வழங்கல் பாணி மற்றும் 

வரைகலை பாணி என்பன ஆகும். (presentation 
styles and graphics styles). உரையானது 
AutoLayout பகுதியில் செருகப்பட்டால் வழங்கல் 

பாணி முறையை பயன்படுத்தலாம். உரையானது 

உரைப்பெட்டியில�ோ அல்லது வரைகலை 

ப�ொருள்களில�ோ செருகப்பட்டால் வரைகலை 

பாணியை பயன்படுத்தமுடியும் 

	 நீங்கள் ஒரு வழங்கல் பாணியை 

தேர்ந்தெடுத்தால் படம்13.6 ல் உள்ள  உரையாடல் 

பெட்டியானது திரையில் த�ோன்றும்.  வழங்கல் 

பாணி உரையாடல் பெட்டியானது உரை 

வடிவூட்டலை தீர்மானிக்கிறது.

படம் 13.6 வழங்கல் பாணி உரையாடல் பெட்டி 

	 வரைகலை பாணி முறையில்  மாறுதல்களை மேற்கொள்ள உதவும் உரையாடல் பெட்டியானது  படம்  

13.7காட்டப்பட்டுள்ளது. பயனர் தாமாகவே உரையை வடிவூட்ட விரும்பினால்  அதற்கு முன் தேவையான 

உரையை தேர்வு செய்துக�ொள்ள வேண்டும்.
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படம் 13.7 வரைகலை பாணி வழங்கல் முறையில் மாற்றங்கள் செய்ய உதவும் உரையாடல் பெட்டி

குறியுருக்களை வடிவூட்டல் (Formatting character)

	 Format → Character என்ற தேர்வின் முலம் குறியுருக்களை வடிவூட்டல் செய்ய உதவும் உரையாடல் 

பெட்டியை பெறலாம். அல்லது உரை வடிவூட்டல் கருவிப்பட்டையில் உள்ள Character  குறும்படத்தினை  

கிளிக் செய்யவும் (உரை வடிவூட்டல் கருவிப்பட்டையானது த�ோன்றாவிட்டால்  View → Toolbars→ Text 
Formatting என்ற தேர்வின் முலம் த�ோன்றச்செய்யலாம் .) குறியுரு உரையாடல் பெட்டியானது திரையில் 

த�ோன்றும்.

Font த�ொகுதி (Tab)

	ப டம் 13.8 ல் காட்டியபடி Font த�ொகுதியின் மூலம் விரும்பிய எழுத்தின் வகை (Font Style), 
அடிப்படை பண்புக் கூறுகள் (Bold, Italic, etc.) எழுத்தின் அளவு (Size) ஆகியவற்றை தீா்மானிக்கலாம் 

எழுத்து வகையின் முன்னோட்டமானது உரையாடல் பெட்டியின் கீழ்ப்பகுதியில் வெளிப்படுத்தப்படும். 

வரைகலை பாணியில�ோ அல்லது வழங்கல் பாணியில�ோ மாற்றங்கள் செய்யும்போது இந்த உரையாடல் 

பெட்டியானது திரையில் த�ோன்றும்.

படம் 13.8 எழுத்தின் வகை மற்றும் பண்புக்கூறுகளை  அமைக்க உதவும் உரையாடல் பெட்டி.
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	பல  ம�ொழிகளில் நிகழ்த்துதலை உருவாக்கும்போது, ம�ொழியில் மட்டும் வேறுபாடுக�ொண்டு மற்ற 

அனைத்து பண்புக்கூறுகளும் ஒரே மாதிரியாக உள்ள இரண்டு பாணிகளை உருவாக்குவதன் மூலம் ம�ொழி 

அமைப்பு முறையை சிறந்ததாக மாற்றலாம். த�ோற்றத்தை மாற்றாமல் அனைத்து உள் அடக்கங்களின் 

எழுத்துக்களைச் சரிபார்க்க அனுமதிக்கிறது

Font விளைவுகள் த�ொகுதி (Font effects tab)

	ப டம் 13.9 உள்ள FONT EFFECT த�ொகுதியானது உரைக்கு அடிக்கோடிடுதல், நிறத்தை மாற்றுதல், 
மற்றும் Shadow ப�ோன்ற சிறப்பு விளைவுகளை வழங்க பயன்படுகிறது.  உரையாடல் பெட்டியின் Preview 

பகுதியானது சிறப்பு விளைவுகள் அமைக்கப்பட்ட உரையின் முன்னோட்டத்தை காண அனுமதிக்கிறது.  

வழங்கல் பாணி அல்லது வரைகலை பாணியில் உருவாக்கும்போது அல்லது மாற்றங்கள் செய்யும்போது 

இந்த உரையாடல் பெட்டி த�ோன்றும்.

படம் 13.9 உரைக்கு சிறப்பு விளைவுகளை வழங்கும் உரையாடல் பெட்டி 

Position த�ொகுதி:

(Position Tab)

	 உரையை தனிப்பயனாக்க மேம்பட்ட விருப்பங்களை Position த�ொகுதியானது (படம் 13.10) 
க�ொண்டுள்ளது.  உரைக்கு கீழ்க்குறியீடு (Subscript) அல்லது மேல்க்குறியீடு (Super script) களை 

அமைக்க இத்தொகுதியானது பயன்படுகிறது.

படம் 13.10 குறியுருக்களின் நிலைப்பண்புகளை அமைக்க பயன்படும் உரையாடல் பெட்டி
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பத்தியை வடிவூட்டுதல் (Formatting paragraphs)

	 Format→Paragraph என்ற ேதர்வின் மூலமாகவ�ோ அல்லது உரை வடிவூட்டல் கருவிப்பட்டையில் 

உள்ள Paragraph குறும்படத்தினை கிளக் செய்வதன் மூலமாகவ�ோ பத்தி வடிவூட்டல் உரையாடல் பெட்டியை 

பெறலாம். (உரை வடிவூட்டல் கருவிப்பட்டையானது  திரையில் த�ோன்றா விட்டால் View→Toolbars→Text 
formatting என்ற தேர்வின் மூலம் த�ோன்றச் செய்யலாம்) படம் (13.11) ல் பத்தி உரையாடல் பெட்டியானது 

காண்பிக்கப்பட்டுள்ளது.

படம் 13.11 பத்தி வடிவூட்டல் உரையாடல் பெட்டி

உள்தள்ளுதல் மற்றும் இடைவெளித் த�ொகுதி (Indent and spacing Tab)

	 Indent and spacing த�ொகுதியானது 3 பிரிவுகளை க�ொண்டுள்ளது.

•	 Indent: உரையை இடது அல்லது வலது புறமிருந்து உள்தள்ளுவதற்கு Before text  and after text என்ற 

சுழல் பெட்டிகளும், பத்தியின் முதல் வரியை மட்டும் உள்தள்ள First line என்ற த�ோ்வும் பயன்படுகிறது.

•	 Spacing: ஒவ்வொரு பத்திக்கும் முன், பின் உள்ள இடைவெளியை அமைக்க பயன்படுகிறது.

•	 Line Spacing: இரண்டு வரிகளுக்கு இடையேயான இடைவெளியை அமைக்க பயன்படுகிறது.

Alignment த�ொகுதி:

	ப த்தியை இடது, வலது, மைய மற்றும் ந�ோ்த்தி இசைவுகளுக்கு மாற்ற பயன்படுகிறது.  முன்னோட்ட 

பகுதியானது செய்யப்பட்ட மாற்றங்களை காண உதவுகிறது. (படம் 13.12)
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படம் 13.12 இசைவு விருப்பங்களுடன் கூடிய பத்தி உரையாடல் பெட்டி

Tabs த�ொகுதி:

	 தத்தல் நிறுத்தங்களை அமைக்க Tab த�ொகுதியானது (படம் 13.13) பயன்படுகிறது.  ஏற்கனவே 

அமைக்கப்பட்ட தத்தல்  நிறுத்தங்களை நீக்குவதற்கு, பட்டியலில் இருந்து நீக்க வேண்டிய தத்தலை  த�ோ்வு 

செய்து Delete  என்ற ப�ொத்தானை அழுத்த வேண்டும்.  அனைத்து தத்தல் நிறுத்தங்களையும் நீக்குவதற்கு 
Delete All என்ற ப�ொத்தானை த�ோ்ந்தெடுக்கவும்.

படம் 13.13தத்தல் அமைவுகளுடன் கூடிய பத்தி வடிவமைப்பு உரையாடல் பெட்டி.
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எண் வரிசை மற்றும் புல்லட் குறியீடுகளை உருவாக்குதல்:

	ப ட்டியலின் த�ோற்றத்தை தனித்துவமாக்க, பட்டியலில் உள்ள எல்லா உறுப்புகளுக்கும், அல்லது 

ஒரு குறிப்பிட்ட உறுப்பிற்கு புல்லட் அல்லது எண் வரிசையை மாற்றியமைக்க முடியும்.  

	 புல்லட் மற்றும் எண் வரிசை (Bullets and Numbering) உரையாடல் பெட்டியை பயன்படுத்தி 

மாற்றங்களை செய்ய முடியும் Format→Bullets and Numbering என்ற த�ோ்வின் மூலமாக புல்லட் மற்றும் 

எண் வரிசை உரையாடல்  பெட்டியை பெறலாம்.அல்லது வடிவூட்டல் கருவிப்பட்டையில் உள்ள புல்லட் அல்லது 

எண் வரிசை பணிக்குறியை கிளிக்செய்து அணுகலாம்.  (படம் 13.14)

படம் 13.14 புல்லட் மற்றும் எண் வரிசை உரையாடல் பெட்டி.

பயிற்சி -1

•	 8 சில்லுகளைக் க�ொண்ட ஒரு நிகழ்த்துகளை உருவாக்கி பின்வரும் அம்சங்களை ஒவ்வொரு 
சில்லுவிலும் அமைக்கவும்.

•	 வடிவூட்டப்படாத உரையை ஒட்டுதல் 

•	 ஒட்டப்பட்ட உரையை வடிவூட்டுதல் 

•	 சிறப்புக்குறியீடுகளை சேர்த்தல் 

•	 உரையின் பண்புக்கூறுகளைமாற்றுதல்(Font attributes)

•	 எழுத்துருக்களை வடிவூட்டுதல் 

•	 பத்தியை வடிவூட்டுதல் 

•	 புல்லட் மற்றும் எண்வரிசை பட்டியல்களை உருவாக்குதல் 
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13.1.2 படங்கள்,வடிவங்களை சேர்த்தல் மற்றும் வடிவூட்டல் (Inserting and formatting picture)

	 Open office impress ல் ஒரு படத்தை சேர்ப்பதற்கு படத்தை சேர்க்க விரும்பும் இடத்தில் 

செருகுமிடத்தை வைத்து Insert →Picture→ From file  என்ற தேர்வினை click செய்ய வேண்டும்.  (பார்க்க 

படம் 13.15) Open Office impress ஆனது Insert picture என்ற உரையாடல் பெட்டியை த�ோன்றச் செய்யும்.

	 குறிப்பிட்ட க�ோப்புறையில் இருந்து தேவையான படத்தினை தேர்ந்தெடுத்து Open என்ற 

ப�ொத்தானை கிளிக் செய்ய வேண்டும்.  குறிப்பிட்ட இடத்தில் படமானது செருகப்பட்டிருக்கும்.  (பார்க்க படம் 

13.16)

படம் 13.15  Insert பட்டியல் மூலம் படங்களை சேர்ப்பதற்கான த�ோ்வு

படம் 13.16 குறிப்பிட்ட க�ோப்புறையில் இருந்து படங்களை ச�ோ்த்தல்

	ப டங்களை வடிவூட்டல் செய்வதற்கு படத்தின் மீது சுட்டியை வைத்து வலது கிளிக் செய்து த�ோன்றும்  

பட்டியலில் வடிவூட்டல் மாறுதல்செய்ய தேவையான விருப்பத்தை தேர்ந்தெடுக்க வேண்டும்.  த�ோன்றும் 
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தேர்வுகளின் மூலம் Crop,resize, align, arrange, 
flip ப�ோன்ற இன்னும் பல வடிவூட்டல்களை செய்ய 

முடியும்.

13.17 படத்தின் மீது வலது கிளிக் செய்து 

த�ோன்றும் பட்டியல்

வடிவங்களை சேர்த்தல் மற்றும் வடிவூட்டல் 
(Inserting and Formatting shapes) 

	 View→Toolbars→Drawing என்ற 

த�ோ்வின்மூலம் (Drawig Toolbar) வரைவி 

கருவிப்பட்டையை பெறலாம். (பார்க்க படம் 13.18) 

	 இவ்விருப்பமானது ஏற்கனவே 

த�ோ்ந்தெடுக்கப்பட்டிருந்தால் கருவிப்பட்டை 

(Drawing Toolbar) திரையின் அடிப்பகுதியில் 

த�ோன்றும் (பார்க்க படம் 13.19) இருபரிமான 

படங்களைய�ோ அல்லது முப்பரிமாண 

படங்களைய�ோ இதன் மூலம் நாம்  சேர்க்கமுடியும்.

படம் 13.18 வரைவி கருவிப்பட்டையை த�ோன்றச் 

செய்தல்

படம் 13.19 வரைவி கருவிப்பட்டை

13.1.3  அட்டவணை மற்றும் வரைபடங்களை ச�ோ்த்தல்

	 சில்லுவில் அட்டவணையை சேர்க்க பின்வரும் வழிமுறையை பின்பற்றவும்.

	 சில்லுவின் செயல்பகுதியில் அட்டவணையை ஏற்றுக�ொள்ளக்கூடிய சில்லுவை தேர்ந்தெடுக்கவும்.

தேவையெனில் சில்லுவின் வரைநிலையை பயன்படுத்தி அட்டவணைக்கான இடத்தை ஒதுக்கவும். பிறகு 

Table design ஐ தேர்வு செய்யவும்.

	 Task Pane பகுதியில் அட்டவணை வரைநிலையை (Layout) தேர்ந்தெடுக்கவும். Task Pane ஜன்னல் 

திரையானது த�ோன்றாவிட்டால் View→Task Pane என்ற தேர்வின் மூலம் த�ோன்றச்செய்யலாம். 

	 பட்டியல் பட்டையில் உள்ள Insert→Table என்ற த�ோ்வின் மூலம்  த�ோன்றும் பெட்டியில் வரிசை, 

நெடுவரிசைகளின் எண்ணிகையை க�ொடுத்து OK ப�ொத்தானை கிளிக் செய்வதன் மூலம் அட்டவணையை 

உருவாக்கலாம். த�ோன்றும் அட்டவணையானது க�ொடா நிலை வடிவமைப்பு பாணி மற்றும் அமைவு களை 
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பெற்றிருக்கும்.

படம் 13.20 முதன்மை பட்டி மூலம் 

அட்டவணையை உருவாக்குதல்

	 முன் கூட்டியே வடிவமைக்கப்பட்டுள்ள 

அட்டவணை   வடிவமைப்பு வகையில் ஏதேனும் 

ஒன்றை  தேர்வு செய்து  அட்டவணையின்  வண்ண 

அமைவுகளை மாற்றலாம்.

படம் 13.21 வரிசை மற்றும் நெடுவரிசைகளை 

குறிப்பிடுதல்

	 அட்டவணையானது சில்லுவின் 

மையப்பகுதியில் த�ோன்றும். அட்டவணையை 

தேர்வு செய்து (Click செய்து இழுத்து விரும்பிய 

இடத்தில் அமைத்துக் க�ொள்ளலாம்.)

அட்டவணை கருவிப்பட்டை (Table Toolbar) :

	 அட்டவணையை த�ோ்வு செய்தால் 

அட்டவணை கருவிப்பட்டையானது திரையில் 

த�ோன்றும்.  தேவையெனில் View→Toolbars 
→Table என்ற த�ோ்வின் மூலம் த�ோன்றச் 

செ  ய ்யலா   ம் .

	 க�ொடா நிலையாக இது மிதவை வகை 

கருவிப்பட்டை ஆகும்.  ஆனால் நாம் விரும்பியவாறு 

ஜன்னல் திரையின் ஓரத்தில�ோ அல்லது 

பணிப்பகுதியின் மேல்புறத்தில�ோ இழுத்து 

அமைத்துக் க�ொள்ளலாம்.

படம் 13.22 அட்டவணை வடிவூட்டல் கருவி பட்டை
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1 Create Table 7 Merge Cells 13 Insert Row

2 Line Style 	 8 Split Cells 	 14 Insert Column

3 Line Color (border) 9 Optimize 15 Delete Row

4 Borders 10 Top alignmen 16 Delete Column

5 Area style filling 11 Center alignment 17 Table design

6 Available fillings 12 Bottom alignment 18 Table properties

அட்டவணை கருவிப்பட்டை

	 அட்டவணை கருவிப்பட்டையானது 

அட்டவணையைக் கையாள்வதற்குத் தேவையான 

பெரும்பாலான கருவிகளை க�ொண்டுள்ளது.

அட்டவணையை நீக்குதல்

	 அட்டவணையை த�ோ்ந்தெடுத்து Delete 
என்ற சாவியை அழுத்தினால் அட்டவணையானது 

நீக்கப்படும்.

வரைபடங்களை சேர்த்தல்:

	 Insert→chart என்ற தேர்வானது 

வரைபடத்தை உருவாக்க பயன்படுகிறது.

	 Insert→chart என்ற தேர்வைய�ோ 

அல்லது செந்தரக் கருவிப்பட்டையில் உள்ள 
Insertchart என்ற பணிக்குறியைய�ோ கிளிக் 

செய்யவேண்டும்.  மாதிரி தரவுகளுடன் கூடிய 

வரைபடமானது த�ோன்றும். (பார்க்க படம் 

13.23) மாதிரி தரவுகளுடன் உருவாக்கப்பட்ட 

வரைபடத்தின் மீது சுட்டியை வைத்து வலது 
click செய்து த�ோன்றும் பட்டியலில் Chart data 
table என்ற விருப்பத்தை தேர்வு செய்யவும். முன் 

மாதிரி தரவுகளுடன் கூடிய அட்டவணையானது 

திரையில் த�ோன்றும். த�ோன்றும் வரைபடத் தரவு 

அட்டவணையில் (Chart data table) உம்முடைய 

தேவைக்கு ஏற்றாற்போல் தரவுகளை உள்ளிடவும்.  
(படம் 13.24)

படம்  13.23 மாதிரி தரவுகளுடன் கூடிய 

வரைபடம்

படம் 13.24 வலது click செய்து chart data table 

விருப்பத்தை தேர்ந்தெடுத்தல்

	பல்வே று வகையான வரைபட வகைகள் 

மற்றும் வேறுபட்ட அமைவுகள் க�ொண்ட ஜன்னல் 

திரை த�ோன்றும்.  ஏதேனும் ஒரு வரைபட வகையை 

த�ோ்வு செய்யவும். (படம் 13.26)
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படம் 13.25 வரைபட தரவு அட்டவணையில் தரவுகளை மாற்றுதல்

படம்13.26 இரு பரிமாண வரைபட வகைகளைக் க�ொண்ட உரையாடல் பெட்டி.

13.1.4 மீத்தொடுப்புகளை உருவாக்குதல்:

	 மீத்தொடுப்பினை உருவாக்க அல்லது மீத்தொடுப்பின் த�ோற்றத்தினை தனிப்பயனாக்க பட்டியல் 

பட்டையில் இருந்து Insert →Hyperlinks என்ற தேர்வினை கிளிக் செய்ய வேண்டும். படம் 13.27 ல் 

உள்ளவாறு உரையாடல் பெட்டியானது த�ோன்றும்.
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படம்  13.27 மீத்தொடுப்பினை உருவாக்கும் உரையாடல் பெட்டி

மீத்தொடுப்புகளை உருவாக்கும் உரையாடல் பெட்டி

	 ஜன்னல் திரையின் இடது புறத்தில் 

த�ோன்றும் நான்கு விதமான மீத்தொடுப்புகளில் 

ஒன்றை தேர்வு செய்க.

•	 Internet : வலை தள முகவரி ப�ொதுவாக 
http:// என துவங்கும்.

•	 Mail & News : எடுத்துக்காட்டாக மின்னஞ்சல் 

முகவரி

•	 Document : வேற�ொரு ஆவணத்திற்கு 

மீத்தொடுப்பை உருவாக்குதல் (அல்லது) 

அதே நிகழ்த்துதல் க�ோப்பில் உள்ள மற்றொரு 

சில்லுவிற்கு மீத்தொடுப்பு உருவாக்குதல்

•	 New Document : மீத்தொடுப்பானது புதிய 

ஆவணத்தை உருவாக்கும்.

13.1.5 ஒலி, ஒளிக் காட்சிகளைச் சேர்த்தல் :

	 ஓபன் ஆபீஸ் இம்ப்ரஸ் ஆனது ஒலி 

மற்றும் ஒளிக்காட்சிகளை சில்லுவில் சேர்க்க 

வழி செய்கிறது. Insert→Movies and Sound 

என்ற தேர்வின் மூலம் நிகழ்த்துதலில் ஒலி & 

ஒளிக்காட்சிகளை சேர்க்கலாம் (பார்க்க படம் 
13.28)

படம் 13.28 ஒலி & ஒளிக் காட்சிகளை சேர்க்க 

பயன்படும் தேர்வு
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படம் 13.29 க�ோப்புறையிலிருந்து ஒளி மற்றும் ஒலி காட்சிகளை தேர்வு செய்தல்.

	 உருவப்படங்களை சேர்ப்பது ப�ோலவே, 

த�ோன்றும் உரையாடல் பெட்டியில் இருந்து 

தேவையான ஒலி அல்லது ஒளிக்காட்சியை 

தேர்வு செய்து OPEN  என்ற ப�ொத்தானை கிளிக் 

செய்யவும். படம் 13.29 ல் உள்ளபடி தேர்வு செய்த 

ஒலி அல்லது ஒளிக்காட்சியானது சில்லுவில் 

த�ோன்றும் நிகழ்த்துதலை வழங்கும்போது 

சில்லுவின் மீதுள்ள ஒலி அல்லது ஒளிக்காட்சியின் 

மீது சுட்டியை வைத்து Click செய்தால் அது 

இயங்க துவங்கும்.

13.1.6 சில்லுவில் சேர்க்கபட்ட ப�ொருள்களுக்கு 

அசைவூட்ட விளைவுகளை வழங்குதல் 

•	 குறிப்பிட்ட சில்லுவை Normal View முறையில் 

த�ோன்ற செய்யவும்.

•	 சில்லுவின் மீதுள்ள ப�ொருள்களுள் 

அசைவூட்டம் வழங்கப்பட வேண்டிய  ப�ொருளை 

தேர்வு செய்யவும் 

•	 பணிச்சாளரத்தில் உள்ள (Task Pane) custom 
animation த�ொகுதியை  தேர்வு செய்யுவும்.

ADD என்ற ப�ொத்தானை  கிளிக் செய்யவும். 

அசைவூட்ட விளைவுகள் உள்ள உரையாடல் 

பெட்டியானது த�ோன்றும்.

•	 உரையாடல் பெட்டியில் உள்ள ஒரு 

த�ொகுதியில் இருந்து அசைவூட்ட விளைவை 

தேர்ந்தெடுக்கவும். மேலும் அதன் வேகம் 

(அல்லது) கால அளவை தேர்வு செய்யவும்.

•	 சில்லுவின் மீதுள்ள ப�ொருளானது திரையில் 

த�ோன்றும் ப�ோது அதற்கு அசைவூட்ட 

விளைவுகளை EFFECT த�ொகுதியிலிருந்து 
FLY IN (or) DISSOLVE in ப�ோன்ற 

விளைவுகளை தேர்ந்தெடுக்கவும்.

•	 Emphasis த�ொகுதியினை பயன்படுத்தி 

சில்லுவின் மீதுள்ள உரையின் வண்ணங்களை 

மாற்றக் கூடிய விளைவுகளையும் அல்லது 

உரையானது பின்னுவது ப�ோன்ற சிறப்பு 

விளைவுகளையும் அமைக்க முடியும்.

•	 Exit த�ொகுதியினை பயன்படுத்தி 

சில்லுவின் மீதுள்ள ப�ொருளானது சில்லுக் 

காட்சியில் திரையை விட்டுச் செல்லும் ப�ோது 

அப்பொருளுக்கு அசைவூட்ட விளைவுகளை 

வழங்க முடியும்
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படம் 13.30 பணிச்சாளரத்தில் உள்ள தனிப்பயன் 

பெட்டி

படம் 13.31 தனிப்பயன் அசைவூட்டலுக்கான 

உரையாடல் பெட்டி

•	 சில்லுவின் மீதுள்ள ப�ொருளானது 

நகரும்போது  நேர்க் க�ோட்டில�ோ (அல்லது) 
வளைவுகளுடன�ோ நகர வேண்டும் எனில் 

MOTION PATH த�ொகுதியில் இருந்து 

அசைவூட்ட விளைவுகளை தேர்வு செய்.

•	 OK ப�ொத்தானை அழுத்தி விளைவுகளை 

சேமித்து மீண்டும் CUSTOM ANIMATION 
த�ொகுதிக்கு திரும்பலாம்.

•	 அசைவூட்ட விளைவானது எவ்வாறு துவங்க 

வேண்டும் என்பதையும், அதன் வேகத்தை 

மாற்றுதல், மேலும் கூடுதலான பண்புக் 

கூறுகளையும் Slide Transition பகுதியில் 

தேர்வு செய்யலாம்.

•	 தேர்வு செய்யப்படும் ப�ொருளுக்கு தகுந்தவாறு 

த�ோன்றும் விருப்பங்களானது மாறும். 
(எ.கா) படம் மற்றும் உரையானது வெவ்வேறு 

வகையான Emphasis விருப்பங்களைக் 

க�ொண்டிருக்கும்.

அசைவூட்ட விளைவுகளை துவங்குதல் :

	 அசைவூட்ட விளைவுகளை துவங்க மூன்று 

விதமான வழிமுறைகள் உள்ளன.

•	 On Cilck : அசைவூட்டமானது 

சுட்டியை அடுத்து கிளிக் செய்யும் வரை 

நி று த்த  ப ்ப ட் டி ரு க் கு ம்

•	 WITH PREVIOUS : இம்முறையில் 

அசைவூட்டமானது முந்தைய அசைவூட்டம் 

இயங்கும் அதே நேரத்தில் இயங்கும்

•	 AFTER PREVIOUS : இம்முறையில் முந்தைய 

அசைவூட்டமானது முடிவடைவதைத் 

த�ொடர்ந்து இது இயங்கும்

13.2 சில்லுகளுக்கு மாற்று விளைவுகளை 
வழங்குதல்

	 சில்லு மாற்று விளைவுகள் என்பது 

நிகழ்த்துதலில் ஒரு சில்லுவானது மறைந்து 

அடுத்த சில்லு திரையில் த�ோன்றும் ப�ோது 

அச்சில்லுவிற்கு Roll Down from top, Fly in from 
Left ப�ோன்ற த�ோற்ற விளைவுகளை வழங்கும் 

மு றையா    கு ம் .

	 இவை சில்லுவின் மாற்றத்தின்போது 

அவைகளுக்கு சிறந்த த�ோற்ற விளைவுகளை 

வ ழ ங் கு கி ன ்ற ன .
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	 Slide sorter த�ோற்ற முறையில�ோ 

அல்லது Normal த�ோற்ற முறையில�ோ 

சில்லுகளுக்கு மாற்ற விளைவுகளை சேர்க்கலாம். 

தேர்ந்தெடுத்த விளைவின் செயல்பாட்டைக் 

காண, Normal த�ோற்ற (Normal View) 
முறையில் இருந்து க�ொண்டு பணிப்பலகையில் 
(Task Pane) உள்ள Slide Transition என்ற 

த�ொகுதியில் AUTOMATIC PREVIEW என்ற 

தேர்வுப்பெட்டியை தேர்வு செய்ய வேண்டும்.

	 நிகழ்த்துதலில் உள்ள அனைத்து 

சில்லுகளுக்கும் ஒரே சில்லு மாற்ற விளைவை 

வழங்க முடியும். மேலும் ஒரு சில்லுவிற்கு பல 

மாற்ற விளைவுகளைய�ோ அல்லது ஒவ்வொரு 

சில்லுவிற்கும் ஒவ்வொரு மாற்ற விளைவுகளைய�ோ 

வழங்க முடியும்.

சில்லுவிற்கு மாற்ற விளைவுகளை வழங்குதல்

•	 பணிப்பலகையில் இருந்து (Task Pane) Slide 
Transition என்பதை தேர்வு செய்யவும் (படம் 
13.32)

•	 Slide Pane அல்லது Slide Sorter காட்சி 

முறையில் இருந்தோ மாற்ற விளைவுகளை 

வழங்க வேண்டிய சில்லுவை தேர்வு செய்யவும்

•	 apply to all slides என்ற விருப்பத்தை முதலில் 

தேர்ந்தெடுக்க தேவையில்லை.

•	 சில்லுவிற்கான மாற்ற விளைவுகளை 

தேர்ந்தெ      டு க ்க வு ம்

•	 தேர்ந்தெடுக்கப்பட்ட மாற்ற விளைவின் 

வேகத்தை மாற்றுதல் அல்லது 

ஒலிக்கோப்பினை இணைத்தல் ப�ோன்ற 

அமைவுகளை MODIFY Transition என்ற 

பகுதியில் செய்யலாம்

•	 ஒலிக்கோப்புகள் பட்டியலில் இருந்து ஒரு ஒலிக் 

க�ோப்பினை தேர்வு செய்யலாம். இப்பொழுது 
THE LOOP UNTIL THE NEXT SOUND 
என்ற தேர்வுப்பெட்டியானது செயல் நிலைக்கு 

(ACTIVE) மாறும். இத்தேர்வுப்பெட்டியை 

தேர்வு செய்தால் இயங்கிக் க�ொண்டிருக்கும் 

ஒலிக்கோப்பானது அடுத்த ஒலிக்கோப்பு 

துவங்கும் வரை மீண்டும் மீண்டும் 

த�ொடர்ச்சியாக இயங்கும்

•	 அடுத்த சில்லுக்காட்சியானது எப்போது 

த�ோன்ற வேண்டும் என்பதை தேர்வு செய்க 
(manually – சுட்டெலியை click செய்யும்போது) 
அல்லது automatically தானியங்கி முறையை 
(automatically) தேர்ந்தெடுத்தால் ஒரு 

சில்லுக் காட்சியானது திரையில் எவ்வளவு 

நேரம் த�ோன்ற வேண்டுமென்பதை 

அதாவது அடுத்த சில்லுவானது தானாக 

த�ோன்றுவதற்கு தேவையான கால அளவை 

குறிப்பிட வேண்டும்.

•	 நீங்கள் தேர்வு செய்த விளைவுகள் அனைத்தும் 

எல்லா சில்லுகளுக்கும் வர வேண்டுமெனில் 
APPLY TO ALL SLIDES என்ற ப�ொத்தானை 

கிளிக் செய்யவும்.

•	 மாற்ற விளைவுகளை முன்னோட்டமாக 

பார்ப்பதற்கு PLAY என்ற ப�ொத்தானை 

அ ழு த்த  வு ம் .

•	 நடப்பு சில்லுவின் இருந்து நிகழ்த்துதலை 

துவங்க Slide Show என்ற ப�ொத்தானை கிளிக் 

செய்யவும்.
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படம்13.32 சில்லு மாற்று விளைவுகளுக்கான 

பெட்டி

சில்லு மாற்ற விளைவுகளை நீக்குதல்

	தேவையான  சில்லுவை தேர்ந்தெடுக்கவும் 

	ப ணிச்சாளரத்தில் உள்ள Slide 
Transition பெட்டியில் த�ோன்றும் பட்டியலில் 

இருந்து NoTransition என்பதை 

தேர்ந்தெடுக்கவும்.

	 நிகழ்த்துதலில் உள்ள அனேக 

சில்லுகளுக்கு ஒரே மாதிரியான மாற்று 

விளைவுகளையும் சில சில்லுகளுக்கு 

வேறுமாதிரியான மாற்று விளைவுகளை வழங்க 

விரும்பினால், ஒரே மாதிரியான விளைவை எல்லா 

சில்லுகளுக்கும் அமைத்து விட்டு, பின்பு 

தேவையான சில்லுவை தேர்ந்தெடுத்து வேறுபட்ட 

மாற்று விளைவுகளை வழங்குவது சுலபமான 

வழியாகும்.

13.3 நிகழ்த்துதலை துவங்குதல் – கட்டுப்படுத்துதல் 

– சுட்டெலியின் மூலம் அல்லது Timer மூலமாக.

நிகழ்த்துதலை துவங்குதல்.

•	 Slide show→Slide show என்ற தேர்வின் 

மூலம் நிகழ்த்துதலை துவங்கலாம். (பார்க்க 

படம் 13.33)

•	 நிகழ்த்துதல் கருவிப்பட்டையில் உள்ள 

Slide show குறும்படத்தை கிளிக் செய்தும் 

துவங்கலாம் (பார்க்க படம் 13.34)

•	 F5 ப�ொத்தானை அழுத்தியும் துவங்கலாம்.

படம் 13.33 நிகழ்த்துதலை துவங்குதல்
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படம்13.34  Slideshow குறும்படம் மூலம் நிகழ்த்துதலை துவங்குதல்

•	 நிகழ்த்துதலில் சில்லு மாற்றமானது தானமைவாக (Automatically) அமைக்கப்பட்டால் 

குறிப்பிடப்பட்டுள்ள நேரத்திற்கு பிறகு சில்லு மாற்றம் நிகழும்.

•	 சில்லு மாற்றமானது சுட்டெலியின் மூலம் கட்டுப்படுத்தப்பட்டிருந்தால்  கீழ்கண்ட வழிமுறைகளில் 

ஏதேனும் ஒன்றின் மூலமாக ஒரு சில்லுவில் இருந்து மற்றொன்றுக்கு மாறலாம்

•	 விசைப்பலகையில் உள்ள நகர்வு ப�ொத்தான்கள் மூலம் (arrow keys) அடுத்த சில்லுவிற்கோ அல்லது 

முந்தைய சில்லுவிற்கோ மாறலாம்.

•	 சுட்டியின் ப�ொத்தானை அழுத்தி அடுத்த சில்லுவிற்கு மாறலாம்.

•	 Space bar ப�ொத்தானை அழுத்தி அடுத்த சில்லுவிற்கு மாறலாம்

•	 கடைசி சில்லு காட்சிக்கு அடுத்து செல்ல முயன்றால் CLICK TO EXIT PRESENTATION என்ற 

செய்தியானது த�ோன்றும். சுட்டியை CLICK செய்தோ அல்லது விசைப்பலகையில் உள்ள ஏதேனும் ஒரு 

ப�ொத்தானை அழுத்துவதன் மூலம் நிகழ்த்துதலை விட்டு வெளியேறலாம்.

•	 சில்லுக் காட்சியை விட்டு இடையில் வெளியேற அல்லது சில்லுக் காட்சி முடிந்த பின்பு வெளி வர Esc 
சாவியானது பயன்படுகிறது.

நினைவில் க�ொள்க :

•	 சில்லுவை சேர்ப்பதற்கு – INSERT  →  SLIDE

•	 சில்லுவை நீக்குவதற்கு – EDIT  →   DELETE SLIDE

•	 சில்லுக்காட்சியை துவங்குவதற்கு – SLIDESHOW    →  SLIDESHOW

•	 நிகழ்த்துதலை சேமிக்க – FILE  →   SAVE

•	 SLIDE MASTER பார்க்க – VIEW  →   MASTER  →   SLIDE MASTER

•	 வரைதல் கருவிகளுடன் கூடிய கருவிப்பட்டையை த�ோற்றுவிக்க – VIEW → TOOLBARS      
→DRAWING

•	 படங்களை சேர்ப்பதற்கு – INSERT → PICTURE → FROM FILE

•	 ஒலி மற்றும் ஒளிக் காட்சிகளை சேர்க்க – INSERT→ MOVIE AND SOUND
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மதிப்பீடு

பகுதி –அ

பின்வரும் வினாக்களுக்கு சரியான விடையை தேர்ந்தெடுத்து எழுதவும்.

1)	 நிகழ்த்துதலில் புதிய சில்லுவை உருவாக்கும்போது அது க�ொடா நிலையாக என்ன வரைநிலையுடன் 
த�ோன்றும்?

	 அ) காலி நிகழ்த்துதல் (Blank slide Layout) வரை நிலையுடன்

	 ஆ)  தலைப்புடன் கூடிய (TITLE slide Layout) வரை நிலையுடன்

	 இ)  தலைப்பை மட்டும் க�ொண்ட (TITLE only Layout) வரை நிலையுடன்

	 ஈ)  தலைப்பு மற்றும் உள்ளடக்கத்தை க�ொண்ட  (Title and Content) வரை   நிலையுடன்

2)	 பின்வருவனவற்றுள் எது நிகழ்த்துதலில் முன்கூட்டியே வடிவமைக்கப்பட்ட வரை நிலை இல்லை ?
	 அ) முக்கிய உள்ளடக்க அமைப்பு (Main Content Layout)
	 ஆ) தலைப்பு, 6 உள்ளடக்க அமைப்பு (Title, 6 Content Layout)
	 இ)  காலி சில்லுவுடன் கூடிய வரை நிலை(Blank slide Layout)
	 ஈ)  தலைப்பு, 2 உள்ளடக்க அமைப்பு (Title, 2 Content Layout)

3)	 உதவி (HELP) பட்டியலில் உள்ள EXTENTED HELP என்ற விருப்பத்தின் பயன் யாது?

	 அ) விரிவான கருவி உதவிக்குறிப்பு தகவல்

	 ஆ) குறிப்பு வழங்கும் ஜன்னல் திரையின் அளவை மாற்ற

	 இ)  அடிக்கடி கேட்கப்படும் கேள்விகளை (FAQ) இயக்குவதற்கு

	 ஈ)  அடிக்குறிப்பினை உருவாக்குவதற்கு

4)	 உரைவடிவமைப்பு செய்ய பயன்படும் குறுக்குவழி சாவி எது ?

	 அ)  F10		  ஆ)  F7		 இ)  F11		  ஈ)  F5

5)	 நிகழ்த்துதலில் கூடுதலாக சில்லுவை சேர்க்கும்போது, சில்லுவில் த�ோன்றும் த�ொடாநிலை வரை 
நிலை எது?

	 அ)கால நிகழ்த்துதல் சில்லு வரைநிலை

	 ஆ)தலைப்புடன் கூடிய சில்லு வரைநிலை

	 இ)  தலைப்பு, 6 உள்ளடக்கத்துடன் கூடிய வரைநிலை

	 ஈ)  மையப்படுத்திய உரையுடன் கூடிய வரைநிலை

6)	 படத்தில் உள்ள குறும்படத்தின் பெயர் யாது?

	 அ) புதிய நிகழ்த்துதலை உருவாக்கல்			   ஆ) புதிய வரைநிலையை உருவாக்கல்

	 இ) கூடுதலாக புதிய சில்லுகளை உருவாக்குதல்		 ஈ) மேற்கண்ட ஏதுமில்லை

7)	 கூடுதலாக உருவாக்கப்படும் சில்லுகளில் எந்த கூறானது இடம் பெறாது ?

	 அ)Insert Chart		  ஆ)Insert Movie	 இ)  Insert Picture	 ஈ)  Insert Grid

8)	 நிகழ்த்துதலை துவக்க பயன்படும் Slide show தேர்வானது எந்த பட்டியல் பட்டையில் இடம்பெறும் ?

	 அ)Toolbar	 ஆ)Menu bar		  இ)  Navigation bar	 ஈ)  Sliding Tool bar

Chapter 13.indd   265 20-04-2020   16:03:29



266 PB

பகுதி – ஆ

பின்வரும் வினாக்களுக்கு விடையளி

1)	 தானியங்கு தகவலை மீட்டு சேமித்தல் முறை (Save Autorecovery information) பற்றி நீ அறிந்த்து 
யாது ?

2)	 விரிவாக்கப்பட்ட குறிப்புகள் (Extented TIPS) – வரையறு

3)	 முன்கூட்டியே வடிவமைக்கப்பட்டுள்ள வரைநிலைகளைப் பட்டியலிடு

4)	 Slide Master – வரையறு

5)	 நிகழ்த்துதலை ஆதரிக்கும் க�ோப்புகளின் வகைகளை பட்டியலிடு

பகுதி – இ

பின்வரும் வினாக்களுக்கு விடையளி

1)	 நிகழ்த்துதலில் முதல் சில்லுவை உருவாக்கும் வழிமுறைகள் யாவை ?

2)	 நிகழ்த்துதலில் ஒரு சில்லுவை நீக்கும் வழிமுறை யாது?

3)	 நிகழ்த்துதல் க�ோப்பினை எவ்வாறு சேமிப்பாய்?

4)	 Master slide – என்பதை வரையறு

பகுதி – ஈ

பின்வரும் வினாக்களுக்கு விடையளி

1)	 நிகழ்த்துதலில் உள்ள வரைகலை ப�ொருள்கள் பற்றி (Graphics Objects) விரிவாக விவரிக்கவும்.

2)	ப ல்லூடக க�ோப்புகளை நிகழ்த்துதலில் பயன்படுத்தும் வழிமுறைகளை விளக்குக

3)	 நிகழ்த்துதலில் Master Page-ஐ பயன்படுத்துவதால் ஏற்படும் நன்மைகளைப் பட்டியலிட்டு விவரி?

4)	 பள்ளி ஆண்டு சாதனை பற்றிய நிகழ்த்துதலை உருவாக்கி கீழ்காணும் செயல்பாட்டை செய்க
	 1)	 தலைப்பு வரைநிலையுடன் கூடிய (TITLE SLIDE LAYOUT) முதல் சில்லுவாக சேர்த்தல்
	 2) 	� கூடுதல் சில்லுகளை உருவாக்கி அதில் பள்ளியின் சாதனை பற்றிய புகைப்படங்கள், 

ஒளிக்காட்சிகள் ஆகியவற்றை சேர்த்தல்
	 3) 	 சில்லுகளை நீக்குதல் மற்றும் மறுசீரமைத்தல் செயல்பாடுகளை செய்யவும்.
	 4) 	 இறுதியாக சில்லுக்காட்சியை இயக்கி நிகழ்த்துதலை துவங்கவும்.

ச�ொற்களஞ்சியம்

1. Auto recovery : பாதிக்கப்பட்ட க�ோப்புகளை தாமாகவே மீட்டெடுத்தல்

2. Layout : முன்கூட்டியே வடிவமைக்கப்பட்ட மாதிரி

3. Right Click : ஒழுங்குபடுத்தப்பட்டுள்ளதை மறுசீரமைத்தல்

4. Rearrange : முன்கூட்டியே பின்னணி வடிவமைக்கப்பட்ட முதன்மை சில்லு ஆகும்

5. Master slide : முன்கூட்டியே பின்னணி வடிவமைக்கப்பட்ட முதன்மை சில்லு ஆகும்

6. Slide Masters : முன்கூட்டியே த�ொகுக்கப்பட்ட 28 சில்லுகளைக் க�ொண்ட 
த�ொகுப்பாகும்.
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கற்றலின் ந�ோக்கங்கள்

இந்தப் பாடத்தின் இறுதியில், 
மாணவர்கள் அறிந்துக் 
க�ொள்ளக் கூடியவை

•	 வலையமைப்பாக்கத்தின் 
பரிணாம வளர்ச்சியை 
வி ளக்  கு த ல் .

•	 வலையின் இணைப்பு அமைப்பின் வகைகள்

•	 வலையின் வகைகளை விளக்குதல் மற்றும் 
ஒப்பிடுதல்

•	 ஆய்வகத்தில் வலையின் வகைகளை 
அடையாளம் காணுதல்

•	 கணினிகள் மற்றும் பயனர்களை வலை 
அமைப்பில் அடையாளம் காணுதல்.

•	 இணையப் பயன்பாட்டை விளக்குதல்

•	 வ ைல பாதுகாப்பு கருத்துகளை அறிந்து 
க �ொ  ள் ளு த ல் .

•	 கம்பியில்லா நகரும் தகவல் த�ொடர்பு பற்றி 
விளக்குதல்

•	 DNS சேவையகத்தைப் பயன்படுத்தி 
வலையைமப்பு வள சேவையகத்துடன் 
இ ணைத   ்த ல் .

கணிப்பொறி வலையமைப்பு
	  கணிப்பொறி வலையமைப்பு என்பது 
இணைப்பில் உள்ள கணிப்பொறியின் வன்பொருள், 
மென்பொருள், வளங்கள்  மற்றும் தரவுகளை 
அவற்றிற்கிடையே உள்ள த�ொடர்பு இடையகத்தின் 
வழியே பகிர்ந்து க�ொள்கிறது.

	 கணிப்பொறி வலையகத்தில் உள்ள 
கணிப்பொறிகள் கம்பிகள், த�ொலைப்பேசி கம்பிகள், 
வான�ொலி அலைகள் செயற்கைக�ோள்கள் 
அல்லது அகச்சிவப்பு அலைகற்றைகள்  வழியாக 
இ ணை  க ்கப்ப   டு கி ற து .

பாடம் 14
கணிப்பொறி வலையமைப்பு 

கணிப்பொறி வலையமைப்பு, 
இணையம் மற்றும் மின்னஞ்சல்அலகு V

14.1. வலையமைப்பின் பரிணாம வளர்ச்சி

	 எந்தவ�ொரு கணிப்பொறி 
வலையமைப்பிலும் கணிப்பொறிகளுக்கு 
இடையே தரவுகளைத் தானாகவே 
பரிமாறிக்கொள்வது அடிப்படை த�ொழில்நுட்பம்  
ஆ கு ம் .

	 முதல் வலையமைப்பானது 
க�ோப்பு பரிமாற்றம், தரவுத்தள ஒத்திசைவு 
(Synchronization), மின்னஞ்சல் மற்றும் பிற 
வலையக சேவைகளைச் செயல்படுத்துவதற்காக 
உ ரு வ ா க ்கப்ப   ட ்ட து .

14.1.1. ஆர்பாநெட் (ARPANET)
	 ஆர்பாநெட் பின்வரும் இரண்டு முக்கிய 
காரணங்களுக்காக 1969 ஆம் ஆண்டு 
Advanced Research Projects Agency (ARPA)
யால் நிறுவப்பட்டது. 

•	 வெவ்வேறு ஆராய்ச்சி நிறுவனங்களுக்கு 
இடையே தரவுகளை இடமாற்றம் செய்ய 
அ னு ம தி க் கி ற து .

•	 அணு ஆயுதப் ப�ோரின் ப�ோதும் கூட  
அரசாங்கத்திற்கு செய்திகளை வழங்கும் 
த�ொழில் நுட்பத்தினை அமெரிக்க பாதுகாப்பு 
துறையானது பெற்றிருந்தது.

14.1.2 உலகளாவிய வலை (WWW - World 
Wide Web). 
	 உலகளாவிய வலை என்பது ஆவணங்கள் 
மற்றும் சேவைகளின் த�ொகுப்பாகும். இதை 
இணையம் முழுவதும் மீஉரை இணைப்பு மூலம் 
பகிர்ந்து அளிக்கவும், இணைக்கவும் முடியும். 
எனவே, வலை என்பது இணையத்தின் துணை 
த�ொகுப்பாகும்.

	 உலகளாவிய வலை திம�ொதி பெர்னர்ஸ் 
லீ (Timothy Berners Lee) என்பவரால் 1989 ம் 
ஆண்டு ஜெனிவாவில் உள்ள செர்ன் (CERN)என்ற 
இடத்தில் உருவாக்கப்பட்டது.
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	 வலைப்பக்கம் (Web page) என்பது 
உலகளாவிய வலையில் உள்ள ஆவணங்கள் 
ஆகும். வலைப்பக்கம் உரை, வரைகலை, ஒலி, 
ஒளி மற்றும் மீத்தொடுப்பு  ப�ோன்ற தகவல்களைக் 
க�ொண்டிருக்கும். இந்த மீத்தொடுப்புகள் மற்ற 
வலைப்பக்கங்களுக்கான இணைப்புகள் ஆகும்.

	 வலை உலவி (Web browser) என்பது 
வலையில் உள்ள தகவல்களைப் பார்க்க மற்றும் 
ஆய்வு செய்ய அனுமதிக்கும் பயன்பாட்டு 
மென்பொருள் ஆகும்.

	 பின்வருபவை தற்போது கிடைக்கும் 
முக்கிய வலை உலவிகள் ஆகும்.

அட்டவணை14.1

உலவி வழங்குபவர்

Internet 
Explorer

Microsoft

Google 
Chrome

Google

Mozilla 
Firefox

Mozilla

Netscape 
Navigator

Netscape Communications 
Corp.

Opera Opera Software

Safari Apple

Sea 
Monkey

Mozilla Foundation

K-meleon K-meleon

உலகளாவிய வலையின் செயற்பாடுகள்

	 பயனர்-சேவையக (Client-Server) 

அணுகு முறையில் உலகளாவிய வலை வேலை 

செய்   கி ற து .

	 வலை வேலை செய்யும் விதத்தை பின்வரும் 

படிநிலைகள் விளக்குகின்றன.

1.	 வலை உலாவியில் உள்ள முகவரிப் 

பட்டையில்  (address bar) வலைப்பக்கத்தின் 
URL-யை (say http://www.tngovernmentjobs.
in/) பயனர் உள்ளிடுகிறார்.

2.	 பிறகு www. tngovernmentjobs.in 

உடன் த�ொடர்புடைய IP முகவரியை களப்பெயர் 

சேவையகத்திடம் (DNS) உலவி கேட்கிறது.

3.	 IP முகவரியைப் பெற்ற பிறகு, 

உலவி வலைப்பக்கத்திற்கும் மற்றும் வலை 

சேவையகத்திற்கும் க�ோரிக்கையை HTTP 
Protocolயைப் பயன்படுத்தி அனுப்புகிறது.

4.	 பிறகு வலை சேவையகம் HTTP Protocol  
யைப் பயன்படுத்தி க�ோரிக்கைப் பெற்று க�ோரப்பட்ட 

வலைப்பக்கத்தைத் தேடுகிறது. தேவையான 

வலைப்பக்கம் கிடைத்த பிறகு வலை உலாவிக்கு 

அனுப்பி பின் HTTP இணைப்பை மூடுகிறது.

5.	 இப்பொழுது வலை உலவி 

வலைப்பக்கத்தைப் பெற்று, ம�ொழி மாற்றி மற்றும் 

வலை உலவியின் திரையில் வலைப்பக்கத்தின் 

உள்ளடக்கத்தைக் காண்பிக்கிறது.

Request for web page

Web page 
HTML file

Internet

Web browser 
(Client)

Web browser 
Web page 
HTML file

Request for web page

படம் 14.1 WWW செயல்பாடு
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	 வலைச் சேவையகம் என்பது வலையின் 

உள்ளடக்கங்கள் சேமிக்கப்பட்ட ஒரு கணிப்பொறி 

ஆகும். அடிப்படையில், வலைச் சேவையகம் 

இணைய தளத்தைத் த�ொகுக்கப் பயன்படுகிறது..

இணையம்

•	 இணையம் என்பது உலக அளவில் 

ஒன்றுக்கொன்று இணைக்கப்பட்ட 

கணிப்பொறி வலையமைப்புகளின் 

முழுமையான அமைப்பாகும்.

•	 இணையம் தரமான Internet Protocol களை  

(TCP/IP) உபய�ோகிக்கிறது.

•	 இணையத்தில் உள்ள ஒவ்வொரு  

கணிப்பொறியும் தனித்தன்மை வாய்ந்த IP  
முகவரியால் அறியப்படுகிறது.

•	 IP முகவரி என்பது கணிப்பொறியின் 

இருப்பிடத்தைக் கண்டறிவதற்கான 

தனித்தன்மை வாய்ந்த எண்களின் 

(110.22.33.114) த�ொகுப்பாகும். 

•	 சிறப்பு கணிப்பொறியாகிய DNS (Domain 
Name Server) என்பது IP முகவரிக்குப் 

பெயரைக் க�ொடுக்கப் பயன்படுகிறது. எனவே, 

பயனர் கணிப்பொறியின் இருப்பிடத்தைப் 

பெயரை வைத்து அறிந்து க�ொள்ள முடியும். 

•	 இணையம் உலகத்தில் உள்ள அனைத்து 

பயனர்களும் அணுகத் தக்கதாகும்.

இணையத்தின் வளர்ச்சி

•	 இணையத்தின் துவக்கம்  Advanced Research 
Project Agency Network (ARPANET) என்ற 

கருத்துருவில் இருந்து பிரிக்கப்பட்டதாகும்.

இணையத்தின் நிறைகள்

•	 த�ொலை  தூரத்தில்   உள்ள   மக்களையும்       த�ொடர்பு 

க�ொள்வதற்கு இணையம் அனுமதிக்கிறது. 

வலையில் இணையத்தின் வழியாக த�ொடர்பு 

க�ொள்ள உதவும் பயன்பாடுகள் உள்ளன. 

பல்வேறு சமூக வலைதளங்கள் பின்வருமாறு 

க�ொடுக்கப்பட்டுள்ள:

	 • முகநூல்(facebook)

	 • டுவிட்டர்-கருத்துக்பக்கம்(Twitter)

	 • யாகூ(Yahoo)

	 • குகூள் ப்ளஸ்(Google+)

	 • ஃபிளிக்கர்(Flickr)

	 • ஓர்க்குட்(Orkut)

•	 தேடுப்பொறிகள் மூலமாக இணையத்தில் 

உலவி, எந்த விதமான தகவல்களையும் பெற 

முடியும்.

•	 தகவல் த�ொடர்பு மற்றும் அடிப்படைத் 

தகவல்கள் தவிர இணையம் 

ப�ொழுதுப�ோக்கிற்காகவும் உதவுகிறது. 

இணையத்தில் ப�ொழுதுப�ோக்கிற்கான 

பல்வேறு முறைமைகள் பின்வருவனவற்றுள் 

க �ொ  டு க ்கப்பட்    டு ள ்ள ன .

•	 இணையவழி த�ொலைக்காட்சி(online 
Television)

•	 இணையவழி விளையாட்டுகள்(online 
Games)

•	 பாடல்கள்(Songs)

•	 ஒளிக்காட்சிகள்(Videos)

•	 சமூக வலைத்தள பயன்பாடுகள்(Social 
Networking)

•	 பின்வரும் பல்வேறு சேவைகளைப் பயன்படுத்த 

இணையம் அனுமதிக்கிறது:

•	 இணையவழி வங்கிச் சேவை(Internet 
Banking)

•	 திருமணத்தகவல் சேவை (Matrimonial 
Service)

•	 இணையவழி ப�ொருள்கள் 

வாங்குதல்(Online Shopping)

•	 இணையவழி நுழைவுச்சீட்டு விற்பனை 

பதிவு(Online Ticket Booking)

•	 இணையவழி பண வழங்கீடு(Online Bill 
Payment)
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•	 தரவு பகிர்வு(Data Sharing)

•	 மின்னஞ்சல்(E-mail)

•	 இணையம் மின்-வணிகம் (e-commerce) 
எனும் கருத்துருவை வழங்கி, மின்னனு 

சாதனங்களின் மூலம் த�ொழிலைக் 

கையாள்வது (business deals) குறித்த 

வழிக்காட்டுதலை வழங்குகிறது.

இணைப்பு அமைப்பு (Topology):

	 இணைப்பு அமைப்பு என்பது உட்புற 

கம்பி வட அமைப்பு மற்றும் தருக்க முறையில் 

தரவுகளைக் கூறுகளுக்கு இடையில் 

நகர்த்துவதை விளக்குகிறது.

14.2. வலையக இணைப்பு அமைப்புகள் 
(Network Topologies)

	 வலையமைப்பை ஒழுங்குபடுத்தி, கம்பி 

இணைப்பு மூலம் பல்வேறு முனையங்களை 

(அனுப்புநர் மற்றும் பெறுநர்) இணைப்பது வலையக 

இணைப்பு அமைப்பாகும்.

14.2.1. பாட்டை இணைப்பு அமைப்பு (BUS 
Topolog y)

	 பாட்டை இணைப்பு அமைப்பு என்பது 

ஒருவகை வலை அமைப்பாகும். இதில் ஒவ்வொரு 

கணிக்பொறியும் மற்றும் வலைச்சாதனங்களும் 

ஒரே கம்பி மூலம் இணைக்கப்பட்டிருக்கும். 

அனைத்து சாதனங்களும் ஒரு ப�ொதுவான  

நேர்கோட்டு கம்பியில்  (back bone) 
இணைக்கப்பட்டிருக்கும். அதிகபட்சமாக 30 
முனையங்களை இணைக்க முடியும். 

பாட்டை இணைப்பு அமைப்பின் தனிச்சிறப்புகள் 

(Features of Bus Topology)

1.	 இது தரவுகளை ஒரே திசையில் பரிமாற்றம் 

செய்யும்

2.	 ஒவ்வொரு சாதனமும் ஒரே ஒரு கம்பி மூலம் 

இணைக்கப்பட்டிருக்கிறது.

Bus Topology

Node

Node
Node

Terminator Terminator
Backbone Cable

படம்14.2 பாட்டை இணைப்பு அமைப்பு

பாட்டை  இணைப்பு அமைப்பின் நிறைகள் 

1.	 இது விலை குறைந்தது.

2.	சாத னத்தை நிறுவுதல் மிக எளிது.

3.	 மற்றவற்றுடன் ஒப்பிடும் ப�ோது இதற்கு 

தேவையான கம்பிகள் மிக குறைவு.

4.	 சிறிய வலையமைப்புகளிலும் 

ப ய ன்ப  டு த ்த ப்ப  டு கி ற து .

பாட்டை இணைப்பு அமைப்பின் குறைகள்

1.	 பின்புல கம்பி பழுதடைந்தால் முழு 

வலையமைப்பும் த�ோல்வி அடையும்.

2.	 ஒரே கம்பித் த�ொகுதியில் 
செயல்படுவதால் பிரச்சனைகளைக் 
கண்டறிவது கடினம் ஆகும்

3.	 வலைப் ப�ோக்குவரத்து அதிகமானால் 
அல்லது முனையங்களின் எண்ணிக்கை 
அதிகமானால் வலையின் செயல்திறன் 
குறையும்.

4.	 கம்பிகள் குறைந்த நீளமுடையவை.

நட்சத்திர இணைப்பு அமைப்பு (STAR 
To p o l o g y )
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படம்  14.3 நட்சத்திர இணைப்பு அமைப்பு

	 இந்த வகை இணைப்பு அமைப்பில் 

அனைத்து கணிப்பொறிகளும் ஒரு கம்பி மூலம் 

ஒரு மையத்துடன் (hub) அல்லது இணைப்பியுடன்  

(Switch) இணைக்கப்பட்டிருக்கும். இந்த மையமே 

நடு முனையமாகும். இதனுடன் அனைத்து 

முனையங்களும் இணைக்கப்பட்டிருக்கும்.

நட்சத்திர வலையின் சிறப்பம்சங்கள் (Features of 
Star Topology)

1.	 இந்த வகையில் ஒவ்வொரு முனையமும் 

மையத்துடன் தனது தனிப்பயன் 

(dedicated) இணைப்பில் இருக்கும்.

2.	மை யம் தரவுப் பாய்வின் மறுஉருவாக்கமாக 

(repeater) செயல்படுகிறது.

நட்சத்திர இணைப்பு அமைப்பின் நிறைகள் 

(Advantages of Star Topology)

1.	 குறைந்த முனையங்கள் மற்றும் வலைய 

ப�ோக்குவரத்து குறைவாகவும் இருந்தால் 

செயல்திறன் அதிகமாக இருக்கும்.

2.	மை யத்தை எளிதாக மேம்படுத்த முடியும்.

3.	 இதில் தவறுகளை எளிதாக கண்டறிந்து, 

அமைக்கவும் மாற்றவும் முடியம்.

4.	 பழுதான முனையம் மட்டுமே பாதிக்கப்படும். 

மற்றவை சுமூகமாக இயங்கும்.

நட்சத்திர இணைப்பு அமைப்பின் குறைகள் 

(Disadvantages of Star Topology)

1.	மை யம் பழுதடைந்தால் முழு வலையமைப்பும் 

நிறுத்தப்படுகிறது. ஏனெனில் அனைத்து 

முனையங்களும் மையத்தைச் 

சார்ந்    து ள ்ள து .

2.	 கம்பிகள் அதிக நீள முடையவை.

மர இணைப்பு அமைப்பு (TREE Topology)

	 இந்த வகை இணைப்பு அமைப்பு, ஒரு மர 

அமைப்பு வடிவத்தில் ஒழுங்குபடுத்தப்பட்டுள்ளது. 

இதில் உயர்மட்ட நிலையில் பெற்றோர் முனையம் 

(root node) உள்ளது. இது இரண்டாம் நிலையில் 

குழந்தை முனைகளுடன் த�ொடர்புடையது. இந்த 

இரண்டாம் நிலை முனையங்கள் மூன்றாம் நிலை 

முனையங்கள�ோடு இணைக்கப்பட்டுள்ளது. அதே 

ப�ோல, மூன்றாம் நிலை, நான்காம் நிலைய�ோடு 

இணைக்கப்பட்டு, இந்த இணைப்பு நிலை 

த�ொடரும். உயர்மட்டநிலைய முனையத்தை தவிர 

மற்ற அனைத்து நிலை முனையங்களுக்கும் 

பெற்றோர் முனையம் உள்ளது. இது படிநிலை 

இணைப்பு அமைப்பு என்றும் அழைக்கப்படுகிறது.
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படம் 14.4 மர இணைப்பு அமைப்பு

மர இணைப்பு அமைப்பின் சிறப்பம்சங்கள்Features 
of Tree Topology

1.	 பணிநிலையங்கள் அல்லது முனையங்கள் 

குழுக்களில் அமைந்தால் சிறந்தது. 

2.	 இது பரந்த வலையமைப்பில் பயன்படுகிறது.

மர இணைப்பு அமைப்பின் நிறைகள் (Advantages 
of Tree Topology)

1.	 இந்த வகையில் முனையங்களின் 

விரிவாக்கம் சாத்தியமாகிறது.

2.	 இது எளிதாக நிர்வகிக்கப்பட்டு 

ப ர ா ம ரி க ்கப்ப   டு க றி து .

3.	 இதில் பிழை கண்டறிவது மிக எளிது.

மர இணைப்பு அமைப்பின் குறைகள் 

(Disadvantages of Tree Topology)

1.	 அதிக முனையங்கள் சேர்க்கப்பட்டால் 

பராமரிப்பது கடினம்.

2.	மை யம் பழுதடைந்தால் வலையமைப்பும் 

ப ழு தடை   யு ம் .

பயிற்சி-1

	 1. உனது கணினி ஆய்வகத்திற்கு 

சென்று எந்த வகையான இணைப்பு அமைப்பு 

உள்ளது என்பதை ஆசிரியர் உதவிய�ோடு 

க ண்ட  றி க . .

14.3. வலையமைப்பின் வகைகள் (Types of 
Network)

14.3.1. கணிப்பொறி வலையமைப்பு (Computer 
Networks): கணிப்பொறி வலையமைப்பானது 
அதனுடைய அளவு, தூரம் மற்றும் அமைப்பைப் 
ப�ொறுத்து நான்கு வகைப்படுத்தப்படுகிறது.  
அவையாவன:  தனிப்பட்ட வலை  பகுதி (Personal 
area network), குறும் பரப்பு வலையமைப்பு [LAN 
(Local Area Network)], நகரப் பரப்பு வலையமைப்பு 
[ MAN (Metropolitan Area Network)], பரந்த 
வலையமைப்பு[WAN (Wide Area Network)].

தனிப்பட்ட வலை  பகுதி (Personal area network)
•	 தனிப்பட்ட பகுதி வலை அல்லது PAN என்பது 

கணிப்பொறி சாதனங்களுக்கிடையேயான 
த�ொடர்பைச் செயல்படுத்தும் 
வ ல ை ய மைப்பா     கு ம் .

•	 PAN என்பது கம்பிகள் (அதாவது USB  
அல்லதுFireware) அல்லது கம்பி இல்லாத 
(அதாவது அகச்சிவப்பு infrared, ZigBee, 
ப்ளூடூத், புறபரப்பு (ultra wide band)UWB

•	 இதன் பரப்பு சில மீட்டர்களே ஆகும். 
கம்பியில்லா PAN அல்லது WPAN-க்கு 
எடுத்துக்காட்டுகள்:கைப்பேசியின் தலையணி 
ஒலிவாங்கி (head set) கம்பியில்லா 
விசைப்பலகைகள், கம்பியில்லா சுட்டிகள், 
அச்சுப்பொறிகள், பட்டைக் குறிவருடிகள், 
விளையாட்டு கட்டுப்பாட்டு அமைவு 
ஆகியவற்றை உள்ளடக்கிய சாதனங்கள் 
ஆ கு ம் .
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குறும்பரப்பு வலையமைப்பு -LAN (Local Area 
Network)
•	 தனியார் ச�ொந்த கணினி வலை சிறிய புவியியல் 

பகுதியான வீடு, அலுவலகம் அல்லது  
கட்டிடங்களை இணைக்கும் வலையமைப்பே 
குறும்பரப்பு வலையமைப்பு எனப்படும். (எ.கா. 
பள்ளி வலையமைப்பு)

•	 நாம் பல்வேறு வகையான இணைப்பு 
அமைப்புகளை LAN வழியாகப் 
ப ய ன்ப  டு த ்த லா  ம் 

•	 LAN வலையமைப்பு மூலம் அச்சுப்பொறிகள், 
வன்தட்டுகள் ப�ோன்ற வளங்களைப் பகிர்ந்து 
க�ொள்ள பயன்படுகிறது.

•	 ப�ொதுவாக LANன் அளவு சிறியதாகும். 
இதில் உள்ள பல்வேறு சாதனங்கள் மைய 
சாதனங்கள�ோடு (மையம் / இணைப்பி) 
கம்பிகள் மூலம் இணைக்கப்படுகிறது.

•	 தற்பொழுது LANகம்பியில்லா த�ொழில்நுட்பம் 
மூலம் நிறுவப்படுகிறது. 

•	 ஒரு விநாடிக்கு 4லிருந்து 16 மெகாபிட்டுகள் 
வரை அதிக வேகத்துடன் தரவுகளைத் 
த�ொடர்புடுத்துகிறது. 

LAN

Printer

Print 
server

Mail 
server

File 
server

படம் 14.5  குறும்பரப்பு வலையமைப்பு
குறும்பரப்பு வலையின் நிறைகள்

•	 இந்த வலையமைப்பில் ஒரு கணிப்பொறி 
சேவையகமாகவும் மற்ற அனைத்து 
கணிப்பொறிகளும் பயனர்களாகவும் (client) 
உள்ளது. சேவையகம் பயனர்களுக்கு 
சேவைகளை வழங்குகிறது. மென்பொருள் 
சேவையகத்தில் சேமிக்கப்பட்டு 
பயனர்களுக்குப் பயன்படுகிறது.

•	 இணையத்தின் அணுகுதல் இல்லாமலேயே 
கட்டிடத்தில் உள்ள அனைத்து 
பணிநிலையங்களையும் ஒன்றுக்கொன்று 
உள்ளமைவாக இணைக்க முடியும்.

•	 ப�ொதுவான வளங்களாகிய அச்சுப்பொறிகளை 
எளிமையாக  LAN மூலம் பகிர்ந்துக் 
க�ொள்ளலாம்.

குறும்பரப்பு வலையின் குறைகள் (Disadvantages 
of LAN)
•	 தனியுரிமை மீறல்: ஒவ்வொரு LAN 
பயனரின் தனிப்பட்ட தரவுக் க�ோப்புகளைச் 
ச�ோதிக்க LAN நிர்வாகிக்கு அதிகாரம் உண்டு. 
அது மட்டுமல்லாமல் LAN பயனருடைய இணைய 
வரலாற்றையும், கணிப்பொறி பயன்பாட்டு 
வரலாற்றையும் நிர்வாகியால் ச�ோதிக்க முடியும்..
•	த ரவு பாதுகாப்பு அச்சுறுத்தல்: ப�ொதுவாக 
சேமிக்கப்பட்ட தரவுகள் LAN நிர்வாகியால் சரியாக 
பாதுகாக்கப்படவில்லையெனில் அனுமதியற்ற 
பயனர்கள் நிறுவனத்தின் முக்கியமான தரவுகளை 
அணுக முடியும்..
•	 குறைந்த பகுதியை மட்டுமே இணைத்தல் 
LAN  குறைந்த பகுதியாகிய, ஒன்று 
அல்லது அருகாமையில் உள்ள கட்டிடங்கள், 
அலுவலகங்கள் ஆகியவற்றை மட்டுமே 
இ ணைக்   கு ம் . 

நகரப்பரப்பு வலையமைப்பு -Metropolitan Area 
Network (MAN)
	 LAN ன் பெரிய வடிவம் MAN ஆகும். ஒரு 
நகரம் முழுவதையும் இணைக்க விரிவாக்கப்பட்டு 
வடிவமைக்கப்பட்டுள்ளது. 100 கி.மீக்கு 
மேல் விரிவடைந்து இணைக்க வல்லது. ஒரு 
நகரத்தில் உள்ள பெரிய நிறுவனத்தின் பல்வேறு 
கிளைகளை இணைப்பதற்கு ப�ொதுவாக 
பயன்படுத்தப்படுகிறது. வேறுபட்ட வன்பொருள் 
மற்றும் பரிமாற்ற ஊடகங்களின் பிணைப்பு ஆகும்.

	 இது கேபிள் டிவி வலையமைப்பை 
ப�ோல தனித்த வலையமைப்பாகவும் அல்லது 
பெரிய வலையமைப்பில் உள்ள பல LAN களை 
இணைப்பதாகவும் இருக்கலாம். எனவே ஒரு LAN 
லிருந்து மற்றொரு LAN னிற்கும், ஒரு சாதனத்தில் 
இருந்து மற்றொரு சாதனத்திற்கும் வளங்களை 

பகிர்ந்து க�ொள்ள முடியும்.
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படம்  14.6 நகரப் பரப்பு வலை -Metropolitan Area Network (MAN)
நகரப்பரப்பு வலையமைப்பின் நிறைகள் 
(Advantages of MAN)
•	 இது மிகவும் திறமையானது மற்றும் அதிவேக 

கடத்திகள் (carrier fibre optic cable) 
வழியாக விரைவான தகவல் த�ொடர்புகளை 
வழங்குகிறது. 

•	 இது பரந்த வலையான WANக்கு ஒரு நல்ல 
பின்புலத்தையும் உரிய அணுகுதலையும் 
வழங்குகிறது.

•	 MAN ல் உள்ள இரட்டை பாட்டைகள் ஒரே 
நேரத்தில் இரு திசைகளில் தரவு 
பரிமாற்றத்திற்கு உதவுகிறது.

•	 MAN ப�ொதுவாக ஒரு நகரம் அல்லது முழு 
நகரத்தின் பல த�ொகுதிகளை சூழ்ந்துள்ளது. 

பரந்த வலையமைப்பு (Wide area network (WAN)
	 இது ஒரு த�ொலைத்தொடர்பு 
வலையமைப்பாகும். LAN வலையமைப்பு  
எதிர்திசையில் அமைந்திருக்கும் பல 
கட்டிடங்கள், நாடு முழுவதும் அல்லது உலகம் 
முழுவதும் உள்ள பல LAN வலையமைப்புகளை 
இணைக்கிறது. பரந்த வலையமைப்பில் 
இணைக்கப்பட்டுள்ள கணிப்பொறிகள் ப�ொது 
வலையமைப்பான த�ொலைபேசி அமைப்பு மூலம் 
இணைக்கப்படுகின்றன. இவைகள் பிணைப்பு 
இணைப்புகள் மற்றும் செயற்கைக�ோள்கள் 
மூலமாகவும் இணைக்கப்படுகின்றன. மிகப் பெரிய 
பரந்த வலையமைப்பு இணையம் ஆகும்.

 

Internet

Firewall

Router

Switch
Switch

Web Server

FaxPlotterColour PrinterFile Server File Server File Server

படம் 14.7 பரந்த வலையமைப்பு ( Wide area network)
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பரந்த வலையமைப்பின் நிறைகள்

•	 இது மிகப் பெரிய புவியியல் பரப்பை 

உ ள ்ள ட க் கி ய து .

•	 இது மென்பொருள் மற்றும் வளங்களை 

இணைக்கப்பட்டுள்ள பணிநிலையங்களுக்கு 

இடையேப் பகிர்ந்தளிக்கிறது.

•	 இந்த வலையமைப்பில் உள்ள 

மற்றவர்களுக்கும் செய்திகளை மிக விரைவாக 

அனுப்புகிறது. இந்த செய்திகள் படங்கள், ஒலி 

அல்லது தரவுகளை உள்ளடக்கிய இணைப்பு 

(attachment) ஆகும்.

o	 வலையமைப்பில் உள்ள அனைவரும் ஒரே 

தரவை பயன்படுத்த முடியும். பழைய தகவல்களை 

சில பயனர்கள் பயன்படுத்துவதால் ஏற்படும் 

பிரச்சனைகளைத் தடுக்கிறது.

பயிற்சி-2
	 1. உனது கணினி ஆய்வகத்திற்கு 
சென்று எந்த வகையான வலையமைப்பு 
உள்ளது என்பதை ஆசிரியர் உதவிய�ோடு 
கண்டறிக . .

14.4. கம்பி த�ொழில்நுட்பங்கள் (Wired 
Te c h n o l o g i e s )
	த ரவுகள் ஒரு இடத்திலிருந்து மற்றொரு 
இடத்திற்கு எதன் மூலம் அனுப்பப்படுகிறத�ோ 
அதுவே பரிமாற்றம ஊடகம் அல்லது த�ொடர்பு 
ஊடகம் ஆகும். கணிப்பொறி த�ொடர்புக்காகப் 
பயன்படுத்தப்படும் பரிமாற்ற ஊடகம் இரண்டு 
வகைப்படும். அவையாவன,

•	 கம்பி/எல்லைக்குட்பட்ட/வழிகாட்டும் ஊடகம்

•	 கம்பியில்லா/ எல்லையில்லா/ வழிகாட்டா 
ஊ ட க ம்

பரிமாற்ற ஊடகம்

எல்லைக்குட்பட்டது

இணையச்சு

Baseband Baseband பாதுகாப்பற்றது பாதுகாப்பானது

வான�ொலி அலை பரிமாற்றம்

எல்லையில்லாதது

நுண்ணலை பரிமாற்றம்இழைஒளி முறுக்கிய இரட்டை

படம் 14.8 கம்பித் த�ொழில்நுட்பம்

எல்லைக்குட்பட்ட / வழிகாட்டும் ஊடகம்

	த ரவுப் பரிமாற்றத்தில் மூன்று வகையான 
எல்லைக்குட்பட்ட ஊடகங்கள் உள்ளன. அவை  
•	 முறுக்கிய இரட்டை வடம் (Twisted-Pair 

Cable)
•	 இணையச்சு வடம் (Coaxial Cable), மற்றும் 
•	 இழை ஒளியியல் வடம் (Fibre-Optic Cable)
	  (Twisted Pair) மற்றும் (Co axial cable)
வடங்கள் உல�ோக (செம்புக்) கடத்திகளைப் 
பயன்படுத்தி மின்னோட்ட முறையில் 
சமிக்ஞைகளைப் பெற்று இடம்பெயர செய்கிறது. 

Fibre – optic ஒளி முறையில் சமிக்ஞைகளைப் 
பெற்று இடம் பெயரச் செய்கிறது.

14.4.1. முறுக்கிய இரட்டை வடம் (Twisted Pair 
Cable)
	 ஒரு Twisted-pair ஆனது இரு 
கடத்திகளை (ப�ொதுவாக செம்பு) க�ொண்டுள்ளது. 
ஒவ்வொன்றும் அதனுடைய நெகிழி காப்பீட்டால் 
ஒன்றோடு மற்றொன்று  முறுக்கப்பட்டுள்ளது. 
இதிலுள்ளள ஒரு கம்பியானது பயனர் 
சமிஞ்சைகளை தரவுக் குறிப்புக்காக மட்டும் 
பயன்படுகிறது. அது மட்டுமல்லாமல், இந்த 
கம்பிகளில் ஒன்று சமிஞ்சைகளை அனுப்புநருக்கு 
அனுப்புகிறது. தடங்கல் (சத்தம்), மற்றும் 
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குறுக்கிடுபேச்சு இரைச்சல் (cross talk) 
இரண்டு கம்பிகளையுமே பாதித்து. தேவையற்ற 
சமிக்ஞைகளை உருவாக்கலாம்.  
Twisted Pair-ன் இரண்டு வகைகள்:

•	 பாதுகாப்பற்ற முறுக்கிய இரட்டை வடம் 
(Unshielded Twisted Pair (UTP))

•	 பாதுகாப்பான முறுக்கிய இரட்டை வடம் 
(Shielded Twisted Pair (STP))

Unshielded Twisted Pair Cable

படம் 14.9 பாதுகாப்பற்ற முறுக்கிய இரட்டை வடம்

14.4.2 பாதுகாப்பற்ற முறுக்கிய இரட்டை வடம்

	 இது இரண்டு காப்பீட்டு செம்புக் கம்பிகளை 
க�ொண்டிருக்கும். ஒரே மாதிரியான இணையின் 
மின் குறுக்கீட்டைக் குறைக்க இந்த கம்பிகள் 
சுருள் வலைய வடிவில் ஒன்றோட�ொன்று 
குறுக்கப்பட்டிருக்கும். நெகிழிக் காப்பீடுகள் 
வண்ணமிடப்படுவதின் காரணம் அடையாளம் 
காண்பதற்கு ஆகும்.
நிறைகள்

•இது அதிவேக திறன் உடையது.

•	 ஈதர்நேட் ப�ோன்ற LAN நுட்பங்களில் உயர்தர 
UTPபயன்படுகின்றன..

14.4.3 பாதுகாப்பான முறுக்கிய இரட்டை வடம் 
(Shielded Twisted Pair Cable)
	 இந்த வடம்  உல�ோகத்தகடு மற்றும் 
பின்னப்பட்ட கம்பி வலையைக் க�ொண்டிருக்கும். 
மின் காந்த சத்தம் ஊடுருவல் உல�ோக உறை 
மூலம் தடுக்கப்படுகிறது. உல�ோக உறையானது 
குறுக்கீடுகளை நீக்குகிறது. இது பாதுகாப்பற்ற  

மற்றும் இணையச்சுகளைவிட வேகமானது. 

படம் 14.10 பாதுகாப்பான முறுக்கிய இரட்டை 

வடம்

நிறைகள்

•	 இது ஒப்புமை மற்றும் இலக்க வகை 
பரிமாற்றத்திற்குப் பயன்படுகிறது.

•	 இது சமிக்ஞை வீதத்தை அதிகப்படுத்துகிறது.

•	 இது குறுக்கீடு பேச்சுகளை நீக்குகிறது.

14.4.4 இணையச்சு வடம் (Coaxial Cable)
•	 ஒன்றுக்கொன்று இணையான இரண்டு 

கடத்திகளைக் க�ொண்டிருப்பதால் இது 
இணையச்சு வடம் என  அழைக்கப்படுகிறது. 

•	 மையக்கடத்தியாக இதில் செம்பு 
பயன்படுகிறது. இது PVC யால் 
சூ ழ ப்பட்   டு ள ்ள து . 

•	 வெளிப்புற உல�ோக மடக்கு சத்தத்திற்கு 
எதிராக ஒரு கேடயமாகவும், சுற்றுகளை 
முடிக்கும் கடத்தியாக இரண்டாம் மடக்கு 
ப ய ன்ப  டு கி ற து  

•	 வெளிப்புற கடத்தி காப்புறையில் 
உறையிடப்பட்டிருக்கிறது. வெளிப்புற பகுதி 
என்பது முழுக் கம்பியையும் பாதுகாக்கின்ற 
நெகிழி உறையாகும்:

ப�ொதுவான இணையச்சு தரங்களாவன

•	 50-Ohm RG-7அல்லது  RG-11 : அடத்தியான 
ஈதர்நெட்  பயன்படும்.

•	 50-Ohm RG-58 : மெல்லிய ஈதர்நெட்டுடன் 
பயன்படும்.

•	 75-Ohm RG-59 : கேபிள் த�ொலைக்கட்சியில் 
பயன்படுகிறது.

•	 93-Ohm RG-62 : ARCNET-ல் பயன்படுகிறது..

Insulator

Inner 
conductor

Outer conductor 
(shieldPlastic Cover

படம் 14.11 இணையச்சு வடம்

நிறைகள்

•	 இது மிக அதிக த�ொலைவில் உள்ள 

த�ொலைபேசி இணைப்புகளில் பயன்படுகிறது.

•	 இது இலக்க சமிக்ஞைகளை 10Mbps அதிக 

வேகத்தில்  கடத்துகிறது .
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•	 அதிகமான சத்தத்தைக் கட்டுப்படுத்தும் 
திறன் உள்ளது.

•	 எந்த தரவையும் உருக்குலைவு இல்லாமல் 
(distortion) கடத்துகிறது.

•	 முறுக்கிய இரட்டை வடத்தைக் காட்டிலும் இது 
ஒரு நல்ல காப்புறையைக் க�ொண்டிருப்பதால் 

அதிக வேகமாக த�ொலை தூரங்களுக்கு 

சுழற்சி செய்கிறது.

14.4.5 இழை ஒளியியல் வடம் (Fiber Optic Cable)

	 இது கண்ணாடி அல்லது நெகிழியால் 

ஆனது. ஒளி வடிவில் சமிக்ஞைகள் கடத்துகிறது. 
Fibre Optical cable ல் ஒளி ஒரு வழியில் மட்டுமே 

நகர்கிறது. இருவழி தகவல் த�ொடர்பில் இரு 

சாதனங்களுக்கு இடையில் இரண்டாவது தகவல் 

த�ொடர்பு கண்டிப்பாக ஏற்படுத்தப்பட வேண்டும். .

Sender

Cladding

Cladding
ReceiverCore

படம் 14.12 இழை ஒளியியல் வடம்

	 இது பிரதிபலிப்பு முறையில் ஒளியை 
ஊடகத்தின் வழியாக வழி நடத்துகிறது. 
கண்ணாடி அல்லது நெகிழியின் மையம் குறைந்த 
அடர்த்தியான கண்ணாடி அல்லது நெகிழி 
ஒரு வெளியுறையால் சூழப்பட்டுள்ளது. இரண்டு 
ப�ொருள்களின் அடர்த்திக்கு உள்ள வேறுபாடு, 
மையத்தின் மூலமாக நகரும் ஒளிக்கற்றையானது 
வெளியுறையின் மீது ஒளிவிலகல் ஆகாமல் 
பிரதிபலித்து செல்வது ப�ோல இருக்க வேண்டும்.  

இழை ஒளியியல் வட இணைப்பான்கள் (Fibre-
Optic Cable Connectors)

	 கீழ் உள்ள படத்தில் காட்டியவாறு, இதில் 

மூன்று விதமாக இணைப்பான்கள் உள்ளன.

SC connector

RX

TX

ST connector

MT-RJ connector

படம்14.13 இழை ஒளியியல் வட 
இணைப்பான்கள்

	 கேபிள் டிவி இணைப்பிற்கு (Subscriber 
Channel (SC)) பயன்படுத்தப்படுகிறது. இது 
தள்ளு / இழு பூட்டு முறையைப் பயன்படுத்துகிறது. 
வலையமைப்பு சாதனங்களில் உள்ள கம்பிகளை 
இணைக்க நேரான முனை (Straight-Tip 
(ST)) இணைப்பான் பயன்படுத்தப்படுகிறது. 
MT-RJ என்ற இணைப்பான் இரண்டு இழை 
களைப் பயன்படுத்தி அவற்றை ஒரே வடிவமாக 
ஒருங்கிணைத்து RJ45 இணைப்பான் ப�ோல 
த�ோற்றமளிக்கச் செய்கிறது. 
நிறைகள்

	 உல�ோக கம்பிகளைக் காட்டிலும் இது பல 

நிறைகளை க�ொண்டுள்ளது

•	 இது அரிப்பை எதிர்க்கிறது.

•	 பதிவு செய்தலில் பெரிதும் உதவுகிறது.

பயிற்சி-3

1.	 உன்னுடைய கணினி 

ஆய்வகத்திற்கு சென்று அங்குள்ள 

கம்பி த�ொழில்நுட்பத்தை கண்டறிந்து 

அறிக்கை தயார் செய்க.

14.5. கம்பியில்லா த�ொழில்நுட்பம் (Wireless 
Technologies)

	 அன்றாட வாழ்வில் கம்பியில்லா 

த�ொழில்நுட்பம் முக்கியப் பங்கு வகிக்கிறது. 

கம்பியில்லா த�ொழில்நுட்பம் என்பது கம்பிகள், 

வடங்கள் மற்றும் ஏதாவது ஒரு மின் கடத்திகள் 

ஆகியவற்றை பயன்படுத்தாமல் த�ொலை தூர 

தகவல் த�ொடர்பு மற்றும் பரிமாற்றத்தைக் 

குறிக்கிறது. தகவல் த�ொடர்பு அமைக்கப்பட்டு 

தகவல் மின்காந்த அலைகளான (வான�ொலி 

அதிர்வெண் அலைகள், அகச்சிவப்பு 

அலைகள்) செயற்கைக் க�ோள்கள் வழியாகக் 

க ட த ்த ப்ப  டு கி ற து .

கம்பியில்லா தகவல் த�ொழில்நுட்பத்தின் வகைகள்

	 கம்பியில்லா த�ொலைபேசி, செல்பேசி, GPS  
அலகுகள், கம்பியில்லா கணினி பகுதிகள்  மற்றும் 

செயற்கைக�ோள் த�ொலைக்காட்சி ஆகியவை 

கம்பியில்லா தகவல் த�ொடர்பிற்குப் பயன்படும் 

சாதனங்கள் ஆகும்..
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14.5.1. புளுடூத்  (Bluetooth)
	 இது டேனிஷ் ராஜா ஹரால்டு புளுடூத் 
என்பவரின் பெயரால் அழைக்கப்படுகிறது. 
கம்பியில்லா த�ொழில்நுட்பத்தின் மூலம் தரவை 
பரிமாறிப் பகிர்ந்து க�ொள்ள பயன்படுகிறது. 
வெவ்வேறு மின் சாதனங்களை இணைக்க புளுடூத் 
பயன்படுகிறது. அலைபேசியை கை பயன்படாத 
காது கருவிகள், (handfree ear tools) கம்பியில்லா 
விசைப்பலகை, சுட்டி, ஒலிபெருக்கி மூலம் மடிக் 
கணினியை இணைத்துத் தகவல்களை ஒரு 
சாதனத்தில் இருந்து மற்றொரு சாதனத்திற்கு 

பரிமாற்றம் செய்வதற்கு புளுடூத் பயன்படுகிறது.

படம் 14.14 புளுடூத் த�ொழில் நுட்பம்

அகச்சிகப்பு த�ொழில்நுட்பம்

	 அகச்சிவப்பு த�ொழில்நுட்பம் என்பது 
அகச்சிவப்பு   கதிர்வீச்சுகளின் வழியாக அகச்சிவப்பு 
பயன்படுத்தப்பட்டுள்ள இரண்டு சாதனங்களுக்கு 
இடையில் தரவு பரிமாற்றத்திற்கான கம்பியில்லா 
தகவல் த�ொழில்நுட்பத்தின் ஒரு வகையாகும்.  
கம்பியில்லா தரவு பரிமாற்றத்தில் இந்த 
த�ொழில்நுட்பம் முக்கிய பங்கு வகிக்கிறது. 
இது சுட்டி, கம்பியில்லா விசைப்பலகை மற்றும் 
அச்சுப்பொறிகள் ப�ோன்ற சாதனங்களில் 
ப ய ன்ப  டு கி ற து .

அகச்சிவப்பு வலையமைப்பு சமிஞ்சைகள்

	 Wi-Fi  மற்றும் புளுடூத் த�ொழில்நுட்பம் 
ப�ோல அல்லது அகச்சிவப்பு சுவர் அல்லது 
தடைகளை ஊடுருவி செயல்படாது.  இது 
ஒரே த�ொலைந�ோக்கு நேர்க்கோட்டு ஒளியில் 
செ  ய ல்ப  டு ம் .

	 இது குறைந்த பரப்பையே 
த�ொடா்புக�ொள்ளும் அமைப்பை உடையது.  எனவே, 

ஒரு அறையில் பயன்படுத்தப்படும் அகச்சிவப்பு 
அமைப்பானது அடுத்த அறையில் பயன்படும் 
வேறு ஒரு அமைப்பினால் பாதிக்கப்படாது.  
இதனால் தான் நமது வீட்டில் பயன்படுத்தப்படும் 
அகச்சிவப்பு ரிம�ோட் கன்ட்ரோல், நமது அண்டை 
வீடுகளில் பயன்படுத்தப்படும் அகச்சிவப்பு ரிம�ோட் 
கன்ட்ரோலினால் பாதிக்கப்படுவதில்லை.

	 புளுடூத்சாதனம் பரவல் 
முறையில் வேலை செய்கிறது.  இது 
சிதறல் (Scatter) முறை என்றும் 
அழைக்கப்படும்.  அதாவது, 

ஆரம்பம் மற்றும் முடிவு ஒன்றுக்கொன்று நேரடி 
த�ொடா்பில் இருக்காது.  எ.கா. 
த�ொலைக்காட்சியின் ரிம�ோட் கண்ட்ரோல்.  
இந்த சாதனம் அமைப்பிற்கு அருகே நேரடியாக 
சுட்டிக் காட்டப்பட வேண்டியதில்லை.  ஆனால் 
அந்த அறைக்குள்ளேயே, அல்லது சிறிது 
வெளியே கதவு திறந்த நிலையில் இருக்க 
வேண்டும்.

	த�ொல ை ந�ோக்கு பார்வை 

பரிமாற்றம் என்பது மின்காந்த 

கதிர்வீச்சின் பண்புகளாகும்.  

அதாவது அலைகள் நேரடிப் 

பாதையில் ஆரம்பத்தில் இருந்து முடிவு வரை 

பயணிக்கும்.

Line of Sight

Location A Location B

படம்  14.15 த�ொலைந�ோக்கு நேர்க்கோடு

வை-பை (Wi-Fi)

	 இது கம்பியில்லா மிகக்குறைந்த செலவு 

க�ொண்ட தகவல் த�ொடர்பு த�ொழில்நுட்பமாகும்.  

Wi-Fi அமைப்பு கம்பியில்லா திசைவி (Router) 
க�ொண்டுள்ளது.  இது த�ொடா்பு மையமாக 

செயல்பட்டு எடுத்துச் செல்லத்தக்க (portable) 

சாதனத்தை இணையத்துடன் இணைக்கிறது.

	 ரவுட்டர் (Router) கட்டமைப்பை 
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ப�ொறுத்து பல சாதனங்களின் இணைப்பை 

இந்த வலையமைப்பு நிர்ணயிக்கிறது.  குறைந்த 

மின் பரிமாற்றத்தினால், வலையமைப்பின் 

பரப்பு குறைந்து உள்ளது.  மிக அருகில் உள்ள  

அமைப்பை மட்டும் இணைக்க பயனரை 

அ னு ம தி க் கி ற து .

படம் 14.16 வை-பை

	 இரண்டு சாதனங்களை 

நேரடியாக இணைக்க புளுடூத் 

சாதனம் உருவாக்கப்பட்டுள்ளது.  

எனவே அவைகள் ஒரு சாதனத்தில் 

இருந்து மற்றொரு சாதனத்திற்கு தகவல் 

பரிமாற்றம் செய்வதற்காகத் த�ொடா்பு க�ொள்ள 

முடியும்.  வழக்கமாக சில அடி துாரத்தையே 

இணைக்க முடியும்.  ஆனால் Wi-Fi ல் அதிக 

துாரத்தை இணைக்கலாம்.

Wi-Fi என்பது ப�ொதுவாக பல சாதனங்களை 

ஒரு மைய சாதனத்துடன் (Wi-Fi உள்ள 

திசைவி) இணைப்பதற்கு பெரும்பாலும் 

இணையத்தை அணுகவும் பயன்படுகிறது.  

அதிகமான நேரத்திற்கு இணைக்கும்போதும், 

அதிக அளவு தரவுகளை இடமாற்றம் 

செய்யும்போதும் Wi-Fi நிலையானதாக மற்றும் 

சிறப்பானதாக செயல்படுகிறது.

வான�ொலி இணைப்பு (Radio Link)
•	 வான�ொலி இணைப்பு என்பது தரவு 

வலையமைப்பில் உள்ள இரண்டு 
முனையங்கள் (அ) வான�ொலி அலகுகளுக்கு 
இடையில் உள்ள கம்பியில்லா இணைப்பாகும் 
(கம்பியில்லா முனையம்-முனையம் (point 
-to-point) இணைப்பு)

•	 ஒவ்வொரு வான�ொலி அலகும் ஒரு 

அனுப்பிவாங்கியையும் (transceiver) 
(சமிக்ஞைகளை அனுப்பி மீண்டும் பெறும் 
சாதனம்) மற்றும் மிகவும் உத்திரவாதமான 
மின்காந்த அலை வாங்கி (antena) வையும் 
க�ொண்டுள்ளது.  அது சுட்டிக்காட்டும் 
திசையில் மட்டுமே சக்தியை வெளியிடுகிறது 
மற்றும் பெறுகிறது.

•	 இரண்டு வான�ொலி அலகுகளும் ஒன்றை 
ஒன்று பார்க்கும் விதமாக நடுவில் ஏதும் 
தடையில்லாமல் அதாவது (கட்டிடங்கள் 
தடங்கலாகவ�ோ இடையூறாகவ�ோ இல்லாத 
வகையில் அமைக்கப்படுகிறது.

•	 இணைப்புகள் நேரடியாக இருப்பதால் 
இரைச்சல் விகிதத்திற்கு மிக உயா்ந்த 
சமிக்ஞையை செயல்படுத்துவதன் 
மூலம், உயா்ந்த தரவு விகிதங்களை இது 
செ  ய ல்ப  டு த் து கி ற து .

•	 வான�ொலி இணைப்புகளின் உகந்த 
செயல்திறனுக்கு நேரடி த�ொலை ந�ோக்கு 
நேர்க்கோட்டுப்பார்வை தேவையே இதன் 
முதன்மை வீழ்ச்சியாகும். ஓர் குறிப்பிட்ட 
அதிர்வெண்ணில் (freqencies) ம�ோசமான 
வானிலை இணைப்பை வான�ொலி குறுக்கீடு 
செய்வது ப�ோல, இழையுடன் ஒப்பிட்டால், இந்த 
இணைப்பு குறைந்த நிலையானது (stable).

நுண்ணலை இணைப்பு : (Microwave link)
•	 நுண்ணலை இணைப்பு என்பது கம்பியில்லா 

தகவல் த�ொடர்பு த�ொழில்நுட்பம் ஆகும். இது 
வான�ொலி அலைகளின் அதிக அதிர்வெண் 
கற்றைகளை பயன்படுத்தி ஒலி, ஒளி மற்றும் 
தரவுத் தகவல்களை அனுப்ப மற்றும் 
பெறக்கூடிய அதிவேக தகவல் த�ொடர்பு 
இணைப்புகளை வழங்குகிறது.

•	 நுண்ணலை இணைப்புகள் அகலக்கற்றை 
(Broad band) ஆக இருப்பதால் இது 
தகவமைத்துக் க�ொள்கின்றன.

•	 இரண்டு முனைய புள்ளிகளுக்கு இடையே 
உபகரணங்கள் மற்றும் வசதிகள் 
தேவையில்லை. எனவே நுண்ணலை 
இணைப்பை கேபிள் இணைப்பை விட 
விரைவாகவும் குறைந்த செலவிலும் 
உ ரு வ ா க ்கலா   ம் .

•	 நுண்ணலைகள் மழை, பனி, மூடுபனி 
ஆகியவற்றில் ஊடுருவி செல்வதால் 
ம�ோசமான வானிலையிலும் பரிமாற்றம் 
தடைபடாமல் இருக்கும்.
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செயற்கைக்கோள் இணைப்பு (Satellite link) 
•	 செயற்கைக்கோள்  உதவியுடன்  சமிக்ஞைகளை 

அனுப்புநரிடமிருந்து பெறுனருக்கு பரிமாற்றம் 
செய்ய உதவும் கம்பியில்லா த�ொழில்நுட்பமே 
செயற்கைக்கோள் தகவல் த�ொடர்பு எனப்படும்.

•	 இது உலகம் முழுவதும் பரவி, பயனர்கள் 
உலகின் எந்த பகுதியில் இருந்தாலும் 
மெய்நிகராக (virtualy) இணைப்பில் இருக்க 
அ னு ம தி க் கி ற து .

•	 இந்த த�ொடர்பில் உள்ள 
செயற்கைக்கோள்கள் சுற்றுப்பாதையிலுள்ள 
செயற்கைக்கோள்களுடன் வான�ொலி 
சமிக்ஞைகள் மூலம் நேரடியாக த�ொடர்பு 
க�ொள்ளப் பயன்படுகிறது.

•	 செயற்கைக்கோள் த�ொடர்பு செயல்முறை 
பூமி நிலையத்தில் இருந்து த�ொடங்குகிறது. 
பூமியின் சுற்றுப்பாதையில் உள்ள 
செயற்கைக்கோள்களிலிருந்து 
சமிக்ஞைகளைப் பெற்று திருப்பி அனுப்புமாறு 
நி று வ ப்பட்   டி ரு க் கி ற து

•	 பூமியின் பணி நிலையத்தில் இருந்து 
செயற்கைக்கோளுக்கு அலைவரிசை மூலம் 
பரிமாற்றப்படும் அமைப்பு துணைக்கோள் 
இணைப்பு (uplink) எனப்படும். 
செயற்கைக்கோளில் இருந்து பூமியின் 
பணி நிலையத்திற்கு அலைவரிசை மூலம் 
பரிமாறப்படும் அமைப்பு புவி இணைப்பு 
(downlink) எனப்படும்.

பயிற்சி – 4
புளூடூத் த�ொழில்நுட்ப உதவியுடன் ஒரு 

கையடக்க த�ொலைபேசியை மற்றொரு 

த�ொலைபேசியுடன் இணைப்பதற்கான 

வழிகளைக் கண்டறிக

14.6 வலையமைப்பு சாதனங்கள்

	 வலையமைப்பு சாதனங்கள் 

கணிப்பொறிகள் அல்லது பிற மின்னணு 

சாதனங்களையும் இணைக்க பயன்படும் 

கூறுகளாகும். இவை க�ோப்புகள் மற்றும் 

வளங்களைப் பகிர்ந்து க�ொள்ளும்.

14.6.1 மையம் (hub)

	 இது வலையமைப்பில் உள்ள 

சாதனங்களின் இணைப்புப் புள்ளி ஆகும். இது 

வலையமைப்பில் உள்ள பணி நிலையங்கள், 

அச்சுப்பொறிகள் மற்றும் சேவையகங்களை 

ஒன்றோட�ொன்று இணைத்து அதை 

த�ொடர்புக�ொள்ள வைக்கிறது. ஒவ்வொரு 

மையத்திலும் குறிப்பிட்ட எண்ணிக்கையிலான 

த�ொடர்பு முகங்கள் (Ports) உள்ளன. அவை 

வலையமைப்பு கம்பிகள் வழியாக பிற 

சாதனங்களுடன் மையத்தை இணைக்கிறது. 

ஒரு மையமானது அதன் த�ொடர்பு முகத்துடன் 

அனைத்து சாதனங்களையும் ஒன்றாக 

இணைக்கிறது. ஒரு த�ொடர்பு முகப்பில் தரவு 

பெறப்படும்போது அது மற்றொரு த�ொடர்பு 

முகத்திற்கு அனுப்பப்படுகிறது. இதனால் 

அனைத்து சாதனங்களும் அனைத்து தகவல் 

ப�ொட்டலங்களையும் (Packets) பார்க்க முடியும்.

படம்  14.17 மையம்(Hub)

இணைப்பி (Switch)
	 ஒரு இணைப்பி என்பது வலையமைப்பு 

ப�ொட்டலங்களை வடிகட்டித் திருப்பி 

அனுப்பும் வன்பொருள் சாதனமாகும். ஒரு 

வலையமைப்பு இணைப்பி, மையம் (hub) 

ப�ோன்றே கணிப்பொறிகளை ஒன்றோட�ொன்று 

இணைக்கிறது. இணைப்பி தரவுப் 

ப�ொட்டலங்களைப் பெற்றவுடன் எந்த கணிப்பொறி 

அல்லது சாதனத்திற்குரியது என்பதைக் 

கண்டறிந்து அந்த கணிப்பொறிக்கு மட்டுமே 

அதை அனுப்புகிறது. அதை மையத்தைப் 

ப�ோல அனைத்து கணிப்பொறிகளுக்கும் 

ஒலிபரப்புவதில்லை (broadcast). இந்த 

காரணத்திற்காகவே இணைப்பிகள் மையங்களை 

விட அதிகமாக தேர்வுசெய்யப்படுகிறது.
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படம் 14.18 இணைப்பி

மறுவுருவாக்கி (Repeater)
	 மறுவுருவாக்கிகள் உள்வரும் 

சமிக்ஞைகளில் உள்ள தேவையற்ற சத்தத்தை 

நீக்குகிறது. இது சமிக்ஞைகளின் பலத்தை 

அதிகப்படுத்துகிறது. எனவே, இதை அதிகமான 

தூரத்திலும், தரத்தில் எவ்வித இழப்பும் 

இல்லாமல் அனுப்பிப் பெற முடியும். வலையமைப்பு 

மருவுருவாக்கிகள் உள்வரும் மின்னணு, 

கம்பியில்லா, ஒளியியல் சமிக்ஞைகளை பெற்றுத் 

திருப்பி அனுப்புகிறது.

	 எப்பொழுதெல்லாம் மறுவுருவாக்கி 

சமிக்ஞைகளை ஒரு த�ொடர்பு முகத்தின் மூலம் 

பெறுகிறத�ோ, அப்பொழுது அதை மற்றொரு 

த�ொடர்பு முகத்திற்கு திருப்பி அனுப்புகிறது. இதன் 

முக்கியமான பயன் யாதெனில் சமிக்ஞைகளை 

அதிகப்படுத்தி மீண்டும் உருவாக்குகிறது.

 

Repeater

Weak inbound 
digital signal

Strong outbound 
digital signal

படம் 14.9 மருவுருவாக்கி

நுழைவு வாயில் (Gateway)

	 ஒரு வலையமைப்பு நுழைவுவாயில் இரண்டு 

வலையமைப்புகளை இணைக்கிறது. எனவே ஒரு 

வலையமைப்பில் உள்ள சாதனங்களை மற்றொரு 

வலையமைப்பில் உள்ள சாதனங்கள�ோடு த�ொடர்பு 

க�ொள்ள முடியும். நுழைவுவாயில் வலையமைப்பின் 

நுழைவு மற்றும் வெளியேறும் புள்ளியாக 

செயல்படுகிறது. இல்லங்களில் உள்ள அடிப்படை 

இணைய இணைப்புகளில் முழு இணையத்தையும் 

அணுகக்கூடிய இணைய சேவை வழங்குபவராக 

(ISP) இது திகழ்கிறது.

	 இது திசைவியுடன் (Router) 

த�ொடர்புடையது. திசைவிகள் நுழைவுவாயிலாகவும் 

செயல்படுகிறது. ஏனெனில் தகவல்கள் 

உள்ளே வரும் மற்றும் வெளியேறும் பாதையை 

க ட் டு ப்ப  டு த் து கி ற து .

தானமைவு நுழைவு வாயில் என்பது மீதமுள்ள 

வலையமைப்பு அல்லது இணையத்தை 

அணுகுவதற்கு தேவையான இயந்திரத்தின் IP 

எ ண்ணா   கு ம் .

Internet Web server

Workstations

Gateway

படம் 14.20 நுழைவு வாயில்

14.7 கணிப்பொறிகளையும், பயனர்களையும் 
வலையமைப்பில் கண்டறிதல்

14.7.1 களப் (domain name) பெயரின் அடிப்படை 

கருத்து

•	 களப் பெயர் என்பது ஒரு வலைத்தளத்தை 

அடையாளம் காண உதவும் தனித்தன்மை 

வாய்ந்த பெயர் ஆகும். ஒவ்வொரு 

வலைத்தளத்திற்கும் ஒரு களப் பெயர் 

முகவரியாக அமைந்து, அந்த வலைதளத்தை 

அணுக உதவுகிறது. எடுத்துக்காட்டாக 
“google.com“ என்பது களப் பெயர்

•	 எப்பொழுதெல்லாம் வலைதளம் 

பார்வையிடப்படுகிறத�ோ அப்போது வலை 

உலவியின் முகவரிப் பட்டையில் களப் பெயர் 

த�ோன்றும். சில களப் பெயர்கள் ”www” 
என்பதை முன்னொட்டாக க�ொண்டிருக்கும்.  

(www – ட�ொமைன் பெயரின் ஒரு பகுதி 

அல்ல), சில களப் பெயர்கள் ”www” என்பதை 

முன்னொட்டாகக் க�ொண்டிருக்கவில்லை

•	 அனைத்து களப் பெயர்களும் பின்னொட்டாக 
“.com”, ”.net” அல்லது ”.org” க�ொண்டிருக்கும். 

களப் பெயரின் பின்னொட்டானது 

வலைதளத்தின் வகையைக் கண்டறிய 

ப ய ன்ப  டு கி ற து .

Chapter 14.indd   281 20-04-2020   16:04:07



282 283

இதுப�ோல சில குறிப்பிட்ட களங்களே உள்ளன.

எடுத்துக்காட்டாக,

.gov – அரசு நிறுவனங்கள்

.edu – கல்வி நிறுவனங்கள்

.org – லாபந�ோக்கமில்லா நிறுவனங்கள்

.mil – இராணுவம்

.com – வணிக த�ொழில்

.net – வலையமைப்பு நிறுவனங்கள்

.ca – கனடா

.th _ தாய்லாந்து

	 களப் பெயரைப் பதிவு செய்ய மிக 

குறைந்த செலவே ஆகும். எனினும் அவற்றை 

வருடத்திற்கொரு முறை அல்லது குறிப்பிட்ட 

வருடங்களுக்குப் பிறகு புதுப்பிக்க வேண்டும். யார் 

வேண்டுமானாலும் களப் பெயரை பதிவு செய்யலாம். 

அதற்கு வலைதளம் அல்லது வலைப்பதிவிற்கான 
(blog) தனித்தன்மை வாய்ந்த களப் பெயரை 

வாங்க வேண்டும்.

	 வ ல ை த ்த ளத்தை    
அணுகும்போது ட�ொமைன் 
பெயரானது ப�ொதுவாக IP 
முகவரியாக மாற்றப்படுகிறது. 

இந்த IP முகவரி வலைதளம் அமைந்திருக்கும் 
சேவையகத்தை வரையறுக்கிறது. இந்த 
மாற்றம் DNS என்ற சேவையால் 
நிறைவேற்றப்படுகிறது.

MAC முகவரி

•	 MAC என்பதம் விரிவாக்கம் ”Media Access 
Control”

•	 வலையமைப்பில் உள்ள ஒவ்வொரு 

சாதனங்களையும் தனித்தனியே 

கண்டறிவதற்கான வன்பொருள் கண்டறியும் 

எண்ணே MAC முகவரி எனப்படும்.

IP முகவரி

•	 IP ன் விரவாக்கம் – “Internet Protocol”

•	 IP முகவரி என்பது இணையம் அல்லது உள் 

வலையமைப்பில் உள்ள சாதனங்களைக் 

கண்டறிவதற்கான தனித்தன்மை வாய்ந்த 

முகவரியாகும்.

	செ ல்லுபடியான IP முகவரி 
என்பது xxx.xxx.xxx.xxx என்ற 
வடிவத்தில் இருக்க வேண்டும். 
இதில் xxx என்பது 0 – 255 வரை 

உள்ள எண்களாகும். IPV6 என்பது இணைய 
நெறிமுறையில் ஆறாவது மறுபதிப்பு மற்றும் 
IPV4 ளை த�ொடர்ந்து வரும். பின்வரும் பதிப்பு 
ஆகும். இது IPV4 ப�ோன்றே இயங்குகிறது. 
இணையத்தில் இணைக்கப்பட்ட சாதனங்கள் 
த�ொடர்பு க�ொள்ளத் தேவையான தனித்தன்மை 
வாய்ந்த IP முகவரி எண்களை வழங்குகிறது. 
IPV6 128 பிட் முகவரியை பயன்படுத்துகிறது. 
IPV4 32 பிட் இணைய முகவரியை 
பயன்படுத்துகிறது.

பயிற்சி-5

	 உங்கள் கணினி ஆய்வகத்தில் உள்ள 

கணிப்பொறிகளின் IP முகவரிகளை எழுதுக. 

14.8 கம்பியில்லா / நகரும் த�ொடர்புகள் 
(Wireless / mobile communication)

	 கம்பியில்லா த�ொடர்பு என்பது தரவு 

த�ொடர்பின் ஒரு வகையாகும். இது கம்பியில்லாமல் 

செயல்பட்டு தரவை விடுவிக்கிறது. இது கம்பியில்லா 

த�ொடர்பு த�ொழில்நுட்பம் மற்றும் சாதனங்களின் 

வழியாக கம்பியில்லா சமிக்ஞைகளைப் 

பயன்படுத்தி இரண்டு அல்லது அதற்கு மேற்பட்ட 

சாதனங்களை இணைப்பதற்கும் த�ொடர்பு 

க�ொள்வதற்கும் உள்ளடக்கிய அனைத்து 

விதிமுறைகள் மற்றும் படிவங்களின் அகன்ற 

ச�ொற்கூறு (broad term) ஆகும்.

14.8.1 நகரும் த�ொடர்பின் ப�ொது அமைப்பு (GSM 
(Global System for Mobile communication))

	ந கரும் த�ொடர்பின் ப�ொது அமைப்பு (GSM) 
என்பது நகரும். வலையமைப்பின் 2G (second 
generation) தரம் ஆகும்.
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படம் 14.21 GSM த�ொகுதி வரைபடம்

	 1980 களில் ஐர�ோப்பிய தகவல் 
த�ொடர்புகளின் தர நிறுவனம் (European 
Telecommunications standards Institute – 
ETSI) இலக்க வகை நகரும் த�ொடர்பு அமைப்பை 

உருவாக்க ஒரு குழுவை ஏற்படுத்தியது. அதன் 

பெயரானது Group special mobile (GSM). இதன் 

முக்கிய பணியானது, ஒரு நிலையான மேம்பட்ட 

உறுதி வாய்ந்த கம்பியில்லா த�ொழில்நுட்பத்தை 

ஐர�ோப்பிய நாடுகளுக்கு உருவாக்குவதே ஆகும்.

	 GSM தரமானது மூன்று 
வேறுபட்ட அதிர்வெண்களில் 
செயல்படுகிறது. 900 MHz 
அலைவரிசை (band) GSM 

அமைப்பில் பயன்படுகிறது. 1800 MHz 
அலைவரிசை சேர்க்கப்பட்டு அதிக 
வாடிக்கையாளர்களுக்கு ஆதரவளிக்கிறது. 
1900 MHz அதிர்வெண் U.S ல் பயன்படுகிறது.

CDMA (Code Division Multiple Access)
	 CDMA என்பது 2G மற்றும் 3G கம்பியில்லா 
த�ொடர்புகளில் பயன்படுத்தப்படும் நெறிமுறை 
ஆகும். இது பன்முகமாக்கத்தின் ஒரு வகை 
ஆகும். பல்வேறு சமிக்ஞைகளை ஒரே பரிமாற்ற 
அலைவரிசையில் இடம்பெற வசதி செய்கிறது. 
இது ஏற்கெனவே உள்ள பட்டை அகலத்தின் 
(Bandwidth) பயன்பாட்டை மேம்படுத்துகிறது. 
இந்த த�ொழில்நுட்பம் Ultra High Frequency 
(UHF) செல்லுலார் த�ொலைப்பேசி அமைப்பில் 
பயன்படுகிறது. (800 MHz லிருந்து 1.9 GHz 
வரையுள்ள பரப்பு)
GPRS (General Packet Radio Service)
	 GPRS என்பது செல்லுலார் 
வலையமைப்பிற்கான ப�ொட்டலம் நிலைமாற்றத் 
(Packet) த�ொடர்பிற்கான நெறிமுறைகள் ஆகும். 

GPRS த�ொழில்நுட்பம் உள்ள கைப்பேசிகள் தரவு 
மற்றும் தகவலை பெறுவதற்காகப் பயன்படுகிறது 
அதாவது (மின்னஞ்சலும், வலைப்பக்கங்களும்) 
இது “always on” த�ொழில்நுட்பமாகும். அதாவது, 
கைபேசிகள் எப்பொழுதும் தரவை பெறுவதற்குத் 
தயாராக இருக்கும்

GPRS ஆதரிக்கும் சிறப்பம்சங்கள் :
•	 குறுஞ்செய்தி சேவை (Short Message 

Service (SMS)) – உரை செய்திகளுக்காக 
வடிவமைக்கப்பட்ட சிறப்புமிக்க த�ொடர்பு 
நெ  றி மு றை  க ள் .

•	 பல்லூடகச் செய்தி சேவை (Multimedia 
Messaging Service (MMS))– உரை 
மட்டுமில்லாமல் கூடுதலாக வீடிய�ோ 
செய்திகளையும் பரிமாற்றக்கூடிய SMS ன் 
அடுத்த கட்ட சேவையாகும்.

•	 கம்பியில்லா பயன்பாட்டு நெறிமுறை 
(Wireless Application Protocol (WAP)) 
– இவை நகரும் (mobile) உலாவிகளுக்கான 
சிறப்புமிக்க தகவல்தொடர்பு நெறிமுறைகள் 
ஆ கு ம் .

WLL (Wireless Local Loop)
	 உள்ளூர் த�ொலைபேசி நிலையத்தில் 
சந்தாதாரர்களை கம்பியில்லாமல் 
இணைப்பதற்கான அமைப்பாகும். இது மிக 
பழமை வாய்ந்த த�ொலைப்பேசி சேவைகளையும் 
அகலக்கற்றை (broadband) சேவைகளையும் 
வாடிக்கையாளர்களுக்கு வழங்குகிறது. 
த�ொலைதூர இடத்திற்கும் த�ொலைப்பேசி வசதியை 
வழங்கும் சீரிய பயன்பாடு இது ஆகும். அதிக 
செலவுமிக்க மற்றும் வேகம் இல்லாத கட்டமைப்பு 
க�ொண்ட வளரும்நாடுகளில் இந்த த�ொழில்நுட்பம் 
பயன்படுகிறது. இது வாடிக்கையாளர்களுக்கும் 
இணைப்பிக்கும் இடையே உள்ள ஒரு இணைப்பாகும்.
	 இது த�ொலைதூர இடங்களுக்கு 
த�ொலைபேசி இணைப்பை வழங்கும் வான�ொலி 
வலையமைப்பை தழுவிய அமைப்பாகும். WLLன் 
வேறுபட்ட வகைகளாவன, அகலக்கற்றை 
கம்பியில்லா அணுகுதல் (Broadband Wireless 
Access), சுற்றில் உள்ள வான�ொலி (Radio in the 
loop), நிலையான வான�ொலி அணுகுதல் (Fixed 
Radio Access) மற்றும் நிலையான கம்பியில்லா 
அணுகுதல் (Fixed Wireless Access).
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அனைத்து 4G சேவைகளும் 4G 
அல்லது 4G LTE (Long Term 
Evolution) என்று அழைக்கப்படும். 
அடிப்படை த�ொழில்நுட்பம் 

அனைத்து கடத்தியிலும் சமமானதாக 
இருப்பதில்லை. 4G வலையமைப்பிற்கு சில 
சேவைகள் Wimax த�ொழில்நுட்பத்தைப் 
பயன்படுத்துகின்றன. Verizon கம்பியில்லா 
சேவைகள் LTE த�ொழில்நுட்பத்தைப் 
பயன்படுத்துகின்றன.

14.9 இணையத்தின் பயன்பாடுகள்
14.9.1 குறுஞ்செய்தி சேவை (SMS)
	 SMS ன் விரிவாக்கம் short message service 
ஆகும். இது ப�ொதுவாக ‘உரை செய்தி அனுப்புதல்’ 
என அழைக்கப்படுகிறது. 160 குறியருக்களைக் 
க�ொண்ட குறுஞ்செய்தி சேவையை, ம�ொபைல் 
சாதனங்களான செல்லுலார் த�ொலைபேசிக்கும், 
ஸ்மார்ட் கைபேசியிசிக்கும் மற்றும PDA-
விற்கும் அனுப்புகிறது. (5-பிட் முறைமையில் 224 
குறியுருக்கள்)
குரல் அஞ்சல் அமைப்பு (Voice Mail System) 
(VMS) மற்றும் பதில் தரும் இயந்திரம் (Answering 
machine)
	 குரல் அஞ்சல் அமைப்பு என்பது 
த�ொலைப்பேசி பயனர்கள், த�ொலைப்பேசி 
வழியாக குரல் செய்திகளைச் சேமித்து, திரும்ப 
பெறும் செய்திப் பெட்டியாக கருதப்படுகிறது. 
பயனர் அவர் விருப்பப்படும் ப�ொழுது அவருடைய 
அனைத்து அழைப்புகளையும் அவருடைய குரல் 
அஞ்சல் அமைப்பிற்கு திருப்ப முடியும். குரல் 
அஞ்சல் அமைப்பு மற்றும் பதில் தரும் இயந்திரம் 
(answering machine) ஆகியவற்றுக்கு இடையில் 
உள்ள வேறுபாடு என்னவென்றால், குரல் அஞ்சல் 
அமைப்பு என்பது மைய அமைப்பாகும். இதில் 
குரல் அஞ்சல் பெட்டிகள்  பல பயனர்களுக்காகக் 
கையாளப்படுகிறது. ஆனால்  பதில் தரும் 
இயந்திரம் என்பது ஒரு த�ொலைப்பேசித் த�ொடர் 
உடன் இணைக்கின்ற தனித்த அமைப்பாகும். பல 
த�ொலைப்பேசி கருவிகள் உள்ளமைந்த பதில் தரும் 
இயந்திரத்தைக் க�ொண்டுள்ளது.

	 பதில் தரும் இயந்திரத்தில் சேமிக்கப்பட்ட 
செய்திகளை இதே கருவியில் திரும்ப கேட்க 
முடியும். ஆனால் த�ொலைதூரத்திலிருந்து 

அணுகமுடியாது. ஆனால் குரல் அஞ்சல் 
செய்திகளை த�ொலைப்பேசி இணைப்பு வழியாக 
உலகின் எந்தப் பகுதியில் இருந்தும் அணுக, 
கேட்க மற்றும் கையாள முடியும்.

	 குரல் தரும் இயந்திரம் ஒரு இணைப்பை 
பயன்படுத்துகின்ற வீடுகளுக்கும், குரல் அஞ்சல் 
அமைப்பு பல த�ொலைப்பேசி இணைப்புகள் 
மற்றும் EPABX வழியான விரிவாக்கங்களை 
பயன்படுத்துகிற அலுவலகங்களுக்குப் 
ப�ொருத்தமாக இருக்கும்.

EPABX இயந்திரம்-ப�ொதுவான 
குரல் அஞ்சல் அமைப்பு செயல்படும் 
விதம்:

1.	 A என்பவர் B யை அழைக்கிறார்.

2.	 B அந்த அழைப்பை ஏற்க இயலாத 
நிலையில் உள்ளார்.A ன் அழைப்பு 
Bன் குரல் அஞ்சல் பெட்டிக்கு திருப்பி 
அ னு ப்பப்ப    டு கி ற து .

3.	 அழைப்பாளர் A விற்கு B யிடமிருந்து ஒரு 
வரவேற்பு அழைப்பு B யினுடைய அஞ்சல் 
பெட்டியைத் த�ொடர்புக�ொள்ளும் படி 
விடப்படுகிறது. பின்னர் beep ஒலிக்குப் 
பிறகு குரல் செய்தியை பதிவிடுமாறு A 
கேட்டுக்கொள்ளப்படுகிறார்.

4.	 அழைப்பாளர் A தனது B க்கான குரல் 
செய்தியைப் பதிவு செய்த பிறகு, அந்த 
பதிவை திரும்ப கேட்பதற்கு அல்லது 
இணைப்பை துண்டிப்பதற்கு வாய்ப்பு 
வழங்கப்படுகிறது .

5.	 எப்பொழுது B அவருடைய 
த�ொலைப்பேசியை திறக்கிறார�ோ 
அப்பொழுது அவர் கேட்காத குரல் 
செய்தியை ஏதேனும் ஒரு ப�ொத்தானை 
அழுத்தி கேட்டுக் க�ொள்கிறார்.

6.	 B வெளியூரில் இருந்தால் அவர் குரல் 
அஞ்சல் பெட்டி எண்ணிற்கு (ஏற்கெனவே 
குரல் அஞ்சல் அமைப்பு க்கு என 
ஒதுக்கப்பட்ட எண்) த�ொடர்பு க�ொண்டு 
ஏதேனும் புதிய குரல் செய்தி பதிவாகி 
உள்ளதா என அறிந்து க�ொள்ளலாம். 
பிறகு அவர் அவருடைய குரல் 
மின்னஞ்சலில் உலவி, செய்திகளைக் 
கேட்கலாம் அல்லது அழித்து விடலாம்.
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படம் 14.22 குரல் அஞ்சல் அமைப்பு

மின்னஞ்சல் (E-mail)
	 E-mail (Electronic mail) 
மின்னஞ்சல் என்பது த�ொலைத்தகவல் த�ொடர்பு 

மூலமாக கணிப்பொறியில் சேமிக்கப்பட்ட 

செய்திகளைப் பரிமாறிக் க�ொள்வதாகும். 

ப�ொதுவாக மின்னஞ்சல் செய்திகள் ASCII 
உரைகளாகக் குறியிடப்படுகிறது. வரைகலைப் 

படங்கள் மற்றும் ஒலிக்கோப்புகள் ப�ோன்ற 

உரையில்லா க�ோப்புகளையும் இருநிலை 

முறையில் இணைப்புகளை அனுப்புவதைப் 

ப�ோல அனுப்பலாம். இணையத்தின் முதல் 

பயன் மின்னஞ்சல் ஆகும். இது இன்றும் 

மிகப் பிரசித்தி பெற்றதாக உள்ளது. ம�ொத்த 

இணைய ப�ோக்குவரத்தில் அதிக சதவிகிதத்தை 

மின்னஞ்சலே பெற்று உள்ளது. மின்னஞ்சலானது 

ஆன்லைன் சேவை வழங்கும் பலனருக்கும் மற்றும் 

இணையத்தில் இல்லாத ப�ொதுவான மற்றும் 

தனியான வலையமைப்பையும் பரிமாற முடியும்.

அளவளாவுதல் (chat)
	 அளவளாவுதல் என்பது உரை 

தழுவிய நேரலையான அல்லது உண்மை நேர 

த�ொலைத்தொடர்பு ஆகும். எடுத்துக்காட்டாக 
chat ல் ஒருவருடன் உரை நிகழ்த்தும்போது 

எந்த தட்டச்சு செய்யப்பட்ட உரையும் உடனடியாக 

அடுத்த பயனரைச் சென்றடையும்.

காண�ொளி கலந்துரையாடல் (Video 
Conferencing)
	 காண�ொளி கலந்துரையாடல் என்பது 

வெவ்வெறு இருப்பிடங்களில் வசிக்கின்ற இரண்டு 

அல்லது அதற்கு மேற்பட்ட மக்களுக்கு இடையே 

நேரலையாக, பார்க்கக்கூடிய த�ொடர்பிற்கான 

இணைப்பைக் க�ொண்டிருக்கிறது. மிக 

எளிமையாக, காண�ொலி கலந்துரையாடல் 

என்பது நிலையான படங்கள் மற்றும் உரைகளை 

இரண்டு இருப்பிடங்களுக்கு இடையே பரிமாற்றிட 

உதவுகிறது. இது முழு அசைவுப்படங்கள் 

மற்றும் உயர்தர ஒலி ஆகியவற்றைப் பல 

இருப்பிடங்களுக்கு இதையே பரிமாற்ற 

உதவுகிறது.	

	 எடுத்துக்காட்டாக, பாயிண்ட் – பாயிண்ட் 

(இரு-நபர்கள்) காண�ொளி கலந்துரையாடல் 

அமைப்பு காண�ொளி த�ொலைப்பேசி ப�ோல 

செயல்படுகிறது. பங்குபெறும் ஒவ்வொருவருக்கும் 

காண�ொளி புகைப்படக் கருவி (video camera), 
நுண்ஒலிப்பேசி (microphone) மற்றும் ஒலி 

பெருக்கிகள் (speaker) ஆகியவை அவர்களுடைய 

கணிப்பொறியில் இணைக்கப்பட்டிருக்க வேண்டும். 

இரண்டு பங்கேற்பாளர்களும் ஒருவருடன் ஒருவர் 

பேசிக்கொள்ளும் ப�ோது, வலையமைப்பு மூலமாக 

இவர்களுடைய குரல்கள் எடுத்துச்செல்லப்பட்டு 

மற்ற பங்கேற்பாளர்களுக்கு வழங்கப்படுகிறது. 

காண�ொளி புகைப்படக் கருவி முன் த�ோன்றும் 

எந்த ஒரு புகைப்படமும் மற்ற பங்கேற்பாளர்களின் 

திரையில் உள்ள சாளரத்தில் (Window) 
த�ோன்றும்.
	 பலமுனை (Multipoint) காண�ொளி 

கலந்துரையாடல் மூன்று அல்லது அதற்கு 

மேற்பட்ட பங்கேற்பாளர்களை மெய்நிகர் 

கலந்துரையாடல் அறையில் (visual 
conferenceing room) அனுமதிக்கிறது. 

மேலும் ஒருவருக்கொருவர் பங்கேற்க அருகருகில் 

அமர்ந்திருப்பவர்களைப் ப�ோல த�ொடர்பு 

க�ொள்ளவும் அனுமதிக்கிறது.
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14.10 வலையமைப்பு பாதுகாப்பு கருத்துருக்கள் 

14.10.1.Cyber Law
	சை பர் விதி என்பது இணையம், 

இணையவெளி (cyber space) மற்றும் அவற்றின் 

ச�ொந்த சட்டச் சிக்கல்கள் ஆகியவற்றைக் 

கையாளும் ஒட்டும�ொத்த சட்ட அமைப்பு முறையின் 

ஒரு பகுதியாகும். ைசபர் விதி, கருத்து சுதந்திரம், 

இணையம் மற்றும் இணைய வழி நிகழ்ேநர 

தனியுரிைம  படம் 14.23 மற்றும்  பயன்பாடு 

உட்பட மிகவும் பரந்த பகுதியை உள்ளடக்கியது. 

சைபர் விதியானது இணைய விதி என்றும் 

அ ழை  க ்கப்ப   டு கி ற து .

படம் 14.23 Cisco வன்பொருள் தீச்சுவர்

	 ஃபயர்வால் (Firewall) என்பது பாதுகாப்பு 

வலையமைப்பு வன்பொருள் அல்லது மென்பொருள் 

அடிப்படையிலானது, வலையமைப்பில் உள்  

வரும்  மற்றும்  வெளியேறும்  ப�ோக்குவரத்து 

நெரிச்சலைக் கட்டுப்படுத்தும்  விதிமுறைகளைப் 

பயன்படுத்துகிறது. இது நம்பிக்கையான 

வலையமைப்பிற்கும் நம்பிக்கையில்லா 

வலையமைப்பிற்கும் இடையே தடை அரணாக 

செ  ய ல்ப  டு கி ற து .

	 இது வலையகத்தின் வளங்களை 

நேர்ம கட்டுப்பாட்டு படிமம் வழியாக 

அணுகலைக் கட்டுப்படுத்துகிறது. அதாவது 

ஃபயர்வால் க�ொள்கையில் (Firewall Policy) 
வரையறுக்ககப்பட்ட ப�ோக்குவரத்தினை 

அனுமதிக்கிறது, பிற ப�ோக்குவரத்தினை 

ம று க் கி ற து .

குக்கீஸ் (Cookies)

	 குக்கீஸ் என்பது பயனரின் 

கணிப்பொறியில் தேக்கி வைக்கப்படும் சிறிய 

க�ோப்புகளாகும். இது மிதமான அளவிலான 

தரவினை தனிப்பட்ட பயனர் மற்றும் 

வலைத்தளத்தில் பிடிப்பில் வைத்திருப்பதைக் 

குறிக்க மற்றும் வலை சேவையகம் அல்லது 

பயனர் கணிப்பப�ொறி மூலமாக அணுக முடியும்.

ஹேக்கிங் (Hacking)

	 கணிப்பொறி ஹேக்கிங் என்பது 

கணிப்பொறி மென்பொருள் மற்றும் வன்பொருளின் 

ந�ோக்கத்தை மாற்றும் நடைமுறையாகும். இது 

உருவாக்குபவரின் உண்மைக் குறிக்கோளுக்கு 

புறம்பாக செயல்படுவதை ந�ோக்கமாக க�ொண்டது. 

இந்த பணியில் ஈடுபம் தனி நபர்களை "ஹேக்கர்ஸ்" 

என்று குறிக்கப்படுகிறார்கள்.

அரண் உடைப்பவர் (Crackers)

	 பிறருடைய கணிப்பொறி முறைமையில் 

அல்லது பிணையத்தில் நுழைபவர் அரண் 

உடைப்பவர் ஆவார். இவர் கடவுச்சொல் அல்லது 

உரிமம் வழியாக நுழைவது அல்லது பிற வழிகளில் 

வேண்டுமென்றே கணிப்பொறி பாதுகாப்பில் வரம்பு 

மீறும் செயலைக் செய்கிறார்.
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•	 கணிப்பொறி வலையமைப்பு என்பது இணைப்பில் உள்ள வெவ்வெறு கணிப்பொறிகளாகும்.

•	 ARPANET 1969ம் ஆண்டு Advanced Research Projects Agency (ARPA) ஆல் நிறுவப்பட்டது.

•	 உலகளாவிய வலை (www) திம�ொதி பெர்னர்ஸ்லீ (Timothy Berners Lee) என்பவரால் 1989ம் 

ஆண்டு ஜெனிவாவில் உள்ள செர்ன் (CERN) என்ற இடத்தில் உருவாக்கப்பட்டது

•	 வலைப்பக்கம் (Web page)) என்பது உலகளாவிய வலையில் உள்ள ஆவணங்கள் ஆகும்.

•	 வலை உலவி என்பது வலையில் உள்ள தகவல்களைப் பார்க்க மற்றும் ஆய்வு செய்ய அனுமதிக்கும் 

பயன்பாட்டு மென்பொருள் ஆகும்.

•	 வலைச் சேவையகம் என்பது வலையின் உள் அடக்கங்கள் சேமிக்கப்பட்ட ஒரு கணிப்பொறி ஆகும். 

அடிப்படையில் வலைச் சேவையகம் இணைய தளத்தைத் த�ொகுக்கப் பயன்படுகிறது.

•	 இணையம் என்பது உலக அளவில் ஒன்றுக்கொன்று இணைக்கப்பட்ட கணிப்பொறி 

வலையமைப்புகளின் முழுமையான அமைப்பாகும்.

•	 வலையமைப்பை ஒழுங்குப்படுத்தி கம்பி இணைப்பு மூலம் பல்வேறு முனையங்களை (அனுப்புநர்-

பெறுநர்) இணைப்பது வலையக இணைப்பு அமைப்பாகும்.

•	 தனிப்பட்ட பகுதி வலை (Personal Ares Network – PAN) என்பது கணிப்பொறி சாதனங்களுக்கு 

இடையேயான த�ொடர்பை செயல்படுத்தும் வலையமைப்பாகும்.

•	 தனியார் ச�ொந்த கணினி வலை சிறிய புவியியல் பகுதியான வீடு, அலுவலகம் அல்லது கட்டிடங்கள் 

இணைக்கும் வலையமைப்பே குறும்பரப்பு  வலையமைப்பு எனப்படும். (எ.கா. பள்ளி வலையமைப்பு)

•	 ஒரு நகரத்தில் உள்ள பெரிய நிறுவனத்தின் பல்வேறு கிளைகளை இணைப்பதற்கு நகரப்பரப்பு வலை 

பயன்படுத்தப்படுகிறது. (Metropolitan Area Network – MAN)

•	 பரந்த வலையமைப்பில் இணைக்கப்பட்டுள்ள கணிப்பொறிகள் ப�ொது வலையமைப்பு மூலம் 

இணைக்கப்படுகின்றன.

•	 இழை ஒளியியல் வடம் கண்ணாடி அல்லது நெகிழியால் ஆனது. இது ஒளி வடிவில் சமிக்ஞைகளை 

கடத்துகிறது.

•	 கம்பியில்லா த�ொழில்நுட்பம் என்பது கம்பிகள், வடங்கள் அல்லது மின்கடத்திகள் ஆகியவற்றை 

பயன்படுத்தாமல் த�ொலைதூர தகவல் த�ொடர்பு மற்றும் பரிமாற்றத்தைக் குறிக்கிறது.

•	 புளூடூத் என்பது தரவை கம்பியில்லா த�ொழில்நுட்பம் மூலம் பரிமாறி பகிர்ந்து க�ொள்ள பயன்படும் 

வெவ்வெறு மின் சாதனங்களை இணைக்கப் பயன்படுகிறது.

•	 அகச்சிவப்பு த�ொழில்நுட்பம் என்பது அகச்சிவப்பு கதிர்வீச்சுகளின் வழியாக அகச்சிவப்பு 

பயன்படுத்தப்பட்டுள்ள இரண்டு சாதனங்களுக்கு இடையில் தரவு பரிமாற்றத்துக்கான கம்பியில்லா 

த�ொழில்நுட்பத்தின் ஒருவகை ஆகும்.
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•	 புளூடூத் என்பது தரவை கம்பியில்லா த�ொழில்நுட்பம் மூலம் பரிமாறி பகிர்ந்து க�ொள்ள பயன்படும் 

வெவ்வெறு மின் சாதனங்களை இணைக்கப் பயன்படுகிறது.

•	 அகச்சிவப்பு த�ொழில்நுட்பம் என்பது அகச்சிவப்பு கதிர்வீச்சுகளின் வழியாக அகச்சிவப்பு 

பயன்படுத்தப்பட்டுள்ள இரண்டு சாதனங்களுக்கு இடையில் தரவு பரிமாற்றத்துக்கான கம்பியில்லா 

த�ொழில்நுட்பத்தின் ஒருவகை ஆகும்.

•	 Wi-Fi அமைப்பு என்பது கம்பியில்லா திசைவியைக் (Router) க�ொண்டது. இது த�ொடர்பு மையமாக 

செயல்பட்டு சிறிய சாதனத்தை இணையத்துடன் இணைக்கிறது.

•	 மையம் (HUB) என்பது வலையமைப்பில் உள்ள சாதனங்களில் இணைப்பு புள்ளி ஆகும்.

•	 இணைப்பி (Switch) என்பது வலையமைப்பு ப�ொட்டலங்களை வடிகட்டி திருப்பி அனுப்பும் வன்பொருள் 

சாதனம் ஆகும்.

•	 மறுவுருவாக்கி (Repeater) உள்வரும் சமிக்ஞைகளில் உள்ள தேவையற்ற சத்தத்தை நீக்குகிறது.

•	 நுழைவுவாயில் (Gateway) வலையமைப்பின் நுழைவு மற்றும் வெளியேறும் புள்ளியாக செயல்படுகிறது.

•	 களப் பெயர் என்பது ஒரு வளைதளத்தை அடையாளம் காண உதவும் தனித்தன்மை வாய்ந்த பெயர் 

ஆகும்.

•	 MAC என்பதன் விரிவாக்கம் “Media Access Control”

•	 IP ன் விரிவாக்கம் “Internet Protocol”. IP முகவரி என்பது இணையம் அல்லது உள் வலையமைப்பில் 

உள்ள  சாதனங்களைக்  கண்டறிவதற்கான  தனித்தன்மை  வாய்ந்த  முகவரியாகும்.

•	 கம்பியில்லா த�ொடர்பு என்பது தரவுத் த�ொடர்பின் ஒரு வகையாகும். இது கம்பியில்லாமல் செயல்பட்டு 

தரவை விடுவிக்கிறது.

•	 நகரும் த�ொடர்பின் ப�ொது அமைப்பு (GSM) என்பது நகரும் வலையமைப்பின் 2G தரம் ஆகும்.

•	 CDMA  என்பது 2G மற்றும் 3G கம்பியில்லா த�ொடர்புகளில் பயன்படுத்தப்படும் நெறிமுறை ஆகும்.

•	 GPRS என்பதுசெல்லுலார் வலையமைப்பிற்கான ப�ொட்டலம் நிலை மாற்றத் த�ொடர்பிற்கான 

நெறிமுறை ஆகும்.

•	 WLL என்பது உள்ளூர் த�ொலைபேசி நிலையத்தில் சந்தாதாரர்களைக் கம்பியில்லாமல் 

இணைப்பதற்கான அமைப்பாகும்.

•	 குரல் அஞ்சல் அமைப்பு என்பது த�ொலைப்பேசி, பயனர்கள் த�ொலைப்பேசி வழியாக குரல் 

செய்திகளைச் சேமித்து, திரும்பப்பெறும் செய்திப் பெட்டியாக கருதப்படுகிறது.

•	 காண�ொளி கலந்துரையாடல் என்பது வெவ்வேறு இருப்பிடங்களில் வசிக்கின்ற இரண்டு அல்லது 

அதற்கு மேற்பட்ட மக்களுக்கு இடையே நேரலையாகப் பார்க்கக் கூடிய த�ொலைத்தொடர்பிற்கான 

இணைப்பைக் க�ொண்டிருக்கிறது.
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நினைவில் க�ொள்க

•	 சைபர் விதி என்பது இணையம், சைபர் ஸ்பேஸ் (cyber space) மற்றும் அவற்றின் ச�ொந்த சட்ட 

சிக்கல்கள் ஆகியவற்றை கையாளும் ஒட்டும�ொத்த சட்ட அமைப்பு முறையில் ஒரு பகுதி ஆகும்.

•	 தீச்சுவர் என்பது பாதுகாப்பு வலையமைப்பு மென்பொருள் அல்லது வன்பொருள் அடிப்படையிலானது, 

வலையமைப்பில் உள்வரும் மற்றும் வெளியேறும் ப�ோக்குவரத்து நெரிசலைக் கட்டுப்படுத்தும் 

விதிமுறைகளைப் பயன்படுத்துகிறது.

•	 குக்கீஸ் என்பது கணிப்பொறியில் சேமிக்கப்பட்டுள்ள சிறிய க�ோப்புகளாகும்.

•	 அரண் உடைப்பவர் என்பவர் பிறருடைய கணிப்பொறி முறைமையில் அல்லது பிணையத்தில் 

நுழைபவர் ஆவார்.

மாணவர் செய்முறை பயிற்சி

1.  உங்கள் கணினி ஆய்வகத்தில் உள்ள வலையமைப்பின் வகைகளை கண்டறிக.

2.  கணினி ஆய்வகத்தில் உள்ள கம்பித் த�ொழில்நுட்பத்தின் வகையைக் கண்டறிக.

3.  உங்கள் பள்ளியில் உள்ள கம்பிகளின் வகைகளைப் பற்றி அறிக்கை தயார் செய்க.

4.  உங்கள் கணிப்பொறியின் IPV4 முகவரியை எவ்வாறு மாற்றுவாய்? அதன் படிநிலைகளை எழுதுக

5.  புகழ்பெற்ற 10 கல்வி வலையமைப்பின் ட�ொமைன் பெயர்களைக் கண்டறிக

ஆசிரியர்  பயிற்சி

1.	 ஆசிரியர் மாணவர்களை கணினி ஆய்வகத்திற்கு அழைத்துச் சென்று பின்வரும் கருத்துக்களை 

விளக்கவும்

	 அ) வலையின் இணைப்பு அமைப்புகள்

	 ஆ) வலையமைப்பின் வகைகள்

	 இ) கம்பித் த�ொழில்நுட்பங்கள்

	 ஈ) கம்பியில்லா த�ொழில்நுட்பங்கள்

	 உ) வலையமைப்பு சாதனங்கள்

2.	மேலே  குறிப்பிட்டவற்றுக்கு நிகழ்த்துதலை (Presentation) தயார் செய்து கருத்துக்களை விளக்க 

வேண்டும்.

3.	 கம்பிகளின் வகைகள், வலையமைப்பு சாதனங்கள் ப�ோன்ற உண்மையான ப�ொருள்களை 

பயன்படுத்தி மேலே கூறப்பட்ட கருத்துக்களை விளக்கவும்.

4)	 IPV4 முகவரியை எவ்வாறு அமைப்பது அல்லது மாற்றுவது என்பதை ஆசிரியர் விளக்கவும்.
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மதிப்பீடு

பகுதி - அ 

சரியான விடையை தேர்ந்தெடு:

1)	 பின்வருவனவற்றுள் எது ஊடக அணுகுக் கட்டுப்பாட்டில் பயன்படுவது இல்லை ?

	 அ) ஈதர்நெர்

	 ஆ) இலக்க சந்தாதாரர் இணைப்பு

	 இ) Fiber விநிய�ோகிக்கப்பட்ட சந்தாதாரர் இணைப்பு

	 ஈ) மேலே கூறியவற்றில் எதுவும் இல்லை

2)	 தகவல்களைப் பரிமாற்றம் செய்ய பயன்பட்ட முதல் வலையமைப்பு எது ?

	 அ) CNNET	  ஆ) NSFNET		  இ) ASAPNET		 ஈ) ARPANET

3)	 புளூடூத்தை எடுத்துக்காட்டாக க�ொண்ட வலையமைப்பின் வகையை கண்டறிக.

	 அ) தனிப்பட்ட பகுதி வலை (PAN) 		  ஆ) குறும்பரப்பு வலையமைப்பு (LAN)

	 இ) மெய்நிகர் தனி வலையமைப்பு (VPN)	  	 ஈ) இதில் ஏதுமில்லை

4)	ப�ொ ட்டலங்களில் உள்ள வழிப்படுத்தும் செயல்முறையால் வலையமைப்புகளுக்கு இடையே 

ப�ொட்டலங்களை அனுப்பும் சாதனங்களைக் கண்டறிக

	 அ) BRIDGE	 ஆ)ஃபயர்  வால் 	 இ) திசைவி	 ஈ) மேலே உள்ள அனைத்தும்

5)	 ஒரு நிறுவனம் நகர்ப்புற அலுவலகத்தில் ஒரு LAN வலையமைப்பைக் க�ொண்டுள்ளது. புறநகரில் 

உள்ள தயாரிப்பு நிறுவனத்தில் ஒரு LAN வலையமைப்பை அமைக்கப்போகிறது. இந்த இரண்டு LAN 

களுக்கு இடையே இணைப்பை தரவு மற்றும் வளங்களை அனைவரும் பகிர எந்த வகையான சாதனம் 

தேவைப்படுகிறது?

	 அ) ம�ோடம்		   ஆ) வடம் 		  இ) மையம்	 ஈ) திசைவி

6)	 கட்டிடம் அல்லது வளாகத்தினுள் உள்ள தரவு த�ொடர்பு அமைப்பைக் கண்டறிக.

	 அ) LAN			  ஆ) WAN		  இ) MAN	 ஈ) மேலே கூறிய எவையுமில்லை

7)	 எந்த twisted pair cable ல் உள்ள உல�ோக உறை சத்தம் (அ) குறுக்கீடுகளை அதிகப்படுத்துகிறது 

என்பதைக் கண்டறிக.

	 அ)காப்பிடப்பட்ட முறுக்கு இரட்டை வடம்		  ஆ) பாதுகாப்பான முறுக்கு இரட்டை வடம்

	 இ) பாதுகாப்பற்ற முறுக்கு இரட்டை வடம்		 ஈ) அ மற்றும் ஆ

8)	 ASCII விரிவாக்கம்

	 அ) American standard code for Information Interchange

	 ஆ) American scientific code for International Interchange

	 இ) American standard code for Intelligence Interchange

	 ஈ) American scientific code for Information Interchange
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9)	 பின்வரும் கூற்றுகளை படித்து சரியான தேர்வைக் கண்டறிக.

	 கூற்று A : குரல் அஞ்சல் என்பது மைய அமைப்பாகும். இதில் குரல் அஞ்சல் பெட்டிகள் பல 

பயனர்களுக்காகக் கையாளப்படுகிறது.

	 கூற்று  B : குரல் அஞ்சல் செய்திகளைத் த�ொலைப்பேசி இணைப்பு வழியாக உலகின் எந்தப் பகுதியில் 

இருந்தும் அணுக, கேட்க மற்றும் கையாள முடியும்.

	 அ) கூற்று A சரியானது			   ஆ) கூற்று B சரியானது

	 இ) இரண்டு கூற்றுகளும் சரியானது	 ஈ) இவைகளில் ஏதுமில்லை

10)	 உள்வரும் மற்றும் வெளியேறும் வலையமைப்பு ப�ோக்குவரத்தைக் கட்டுப்படுத்தும் விதிகளை 

பயன்படுத்துகின்ற வலை பாதுகாப்பு அமைப்பைக் கண்டறிக

	 அ) Firewall	 ஆ) Cookies		  இ) Hacking		  ஈ) Crackers

பகுதி - ஆ

அனைத்து வினாக்களுக்கு விடையளிக்கவும்:

1)	 கணிப்பொறியின் வலையமைப்பை வரையறு?

2)	 மின்னணு வணிகம் என்றால் என்ன?

3)	 மின் அஞ்சல் குப்பைகள் (spamming) என்றால் என்ன?

4)	 கணினி வலையமைப்பில் உள்ள முனையம் பற்றி நீ புரிந்தவற்றை எழுதுக

5)	 3G மற்றும் 4G த�ொலைத்தொடர்புக்கு இடையேயானா வேறுபாடு யாது ?

பகுதி - இ

அனைத்து வினாக்களுக்கு விடையளிக்கவும்: 

1)	 வலைப்பக்கம், வலை உலவி மற்றும் வலை சேவையகம் ஆகியவற்றை வேறுபடுத்துக.

2)	ப�ொ துவாக, இணைப்பிகள் மையத்தை விட விரும்பப்படுகிறது. ஏன்?

3)	 பின்வருவனவற்றிற்கு சிறிய குறிப்பு எழுதுக

	 அ) மையம்			   ஆ) இணைப்பி		  இ) நுழைவுவாயில்

4)	 பின்வருவனவற்றிற்கு எல்லைக்கோடு படம் வரைக.

	 அ) இணையச்சு வடம்	 ஆ) இழை ஒளியியல் வடம்

5)	  பின்வருவனவற்றின் குறிப்பிட்ட செயற்பாட்டினை எழுதுக

	 அ) சந்தாதாரர்	 	 ஆ)Straight-TIP		  இ) MT-RJ connector

பகுதி - ஈ

அனைத்து வினாக்களுக்கு விடையளிக்கவும்: 

1.	 இணைப்பு அமைப்பை வரையறு, திட்ட வரைபடத்தைப் பயன்படுத்தி வேறுபட்ட இணைப்பு 

அமைப்புகளை விவரிக்கவும்.

2.	 கணிப்பொறி வலையமைப்பின் வகைகளை அதன் அளவு, துாரம் மற்றும் கட்டமைப்பைப் ப�ொறுத்து 

விளக்கவும்.
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3.	 கம்பித் த�ொழில் நுட்பத்தை வரைய தரவுப்பரிமாற்றத்தில் உள்ள பிணைக்கப்பட்ட ஊடகத்தின் 

ப�ொதுவான வகைகளை விவரிக்கவும்.

4.	நா ம் பயன்படுத்தும் கம்பியில்லா த�ொழில்நுட்பத்தை குறிப்பிட்டு ஒவ்வொன்றாக விளக்கவும்.

5.	 இணையத்தின் பயன்பாடுகளை விவரி?

ச�ொற்களஞ்சியம்

1. திசைவிகள் (Routers) :
பல கணிப்பொறி வலையமைப்புகளை கம்பி அல்லது 

கம்பியில்லாத இணைப்புகள் மூலம் ஒன்றாக இணைக்கும் 

ஒரு சிறிய மின்னணு சாதனமே திசைவிகள் எனப்படும்.

2. WWW :

உலகளாவிய வலை (World wide web) என்பது  தகவல்கள் 

இருக்கும் இடம் ஆகும்.  இங்கு ஆவணங்கள் மற்றும் 

வலையின் மற்ற வளங்கள் URL  ஆல் கண்டறியப்பட்டு 

இணையம் வழியாக அணுகலாம்.

3. MILNET :

1983 ல் ARPANET ல் இருந்து பிரிக்கப்பட்ட 

வலையமைப்பின் பெயரே MILNET.  இது அமெரிக்க 

பாதுகாப்பு துறையின் பயன்பாட்டிற்காக நியமிக்கப்பட்ட 

இணைய வலையமைப்பாகும்.  பிறகு இரு DOD  
பாதுகாப்பு வலையமைப்பின் ஒரு பகுதியானது.

4. NSFNET :

National Science Foundation Network என்பது 
1985ல் த�ொடங்கிய National science Foundation ஆல் 

வழங்கப்பட்ட ஒருங்கிணைக்கப்பட்ட திட்டங்கள் ஆகும்.  

இது அமெரிக்காவின் உயரிய ஆராய்ச்சி மற்றும் கல்வி 

வலையமைப்பு ஆகியவற்றை வழங்குகிறது.

5. HTTP :

Hypertet Transfer Protocl என்பது உலகளாவிய 

வலையில் உள்ள க�ோப்புகளை (உரை, வரைகலை 

படங்கள், ஒலி, ஒளி மற்றும் பிற பல்லுாடக க�ோப்புகள்) 

பரிமாற்றும் விதிகளின் த�ொகுப்பாகும்.

6. MTRJ CONNECTOR :
Mechanical Transfer Registered Jack என்பது MTRJ 
என்பதின் விரிவாக்கம் ஆகும்.

7. MTRJ :
ஒரு இழைஒளி வடம் (Fiber optic cable)  இணைப்பியாகும்.  

இத்ன சிறிய அளவின் காரணமாக இது சிறிய வடிவ 

சாதனங்களில் மிகவும் பிரபலமானதாக உள்ளது.

8.
GSM (Global 
System for Mobile 
C o m m u n i c a t i o n )

:
இது, ஐர�ோப்பிய தகவல் த�ொடா்புகளின் தர நிறுவனத்தால் 

உருவாக்கப்பட்ட திட்டமாகும்.
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9.
கம்பியில்லா தகவல் 

த�ொடா்பு Wireless 
C o m m u n i c a t i o n

:

மின் கடத்தியால் இணைக்கப்படாத இரண்டு அல்லது 

அதற்கு மேற்பட்ட புள்ளிகளு்ககு இடையில் தகவல் 

அல்லது சக்தியை பரிமாற்றம் செய்வதே கம்பியில்லா 

தகவல் த�ொடா்பு ஆகும்.  ப�ொதுவான கம்பியில்லா 

த�ொழில்நுட்பம் ரேடிய�ோ அலைகளை பயன்படுத்துகிறது.

10.
CDMA (Code Division 
Multiple Access)

:
இது பல்வேறு ரேடிய�ோ தகவல் த�ொடா்பு 

த�ொழில்நுட்பங்களால் பயன்படுத்தப்படும் அலைவரிசை 

அனுகும் முறை ஆகும்.

11.
GPRS (General Packet 
Radio Service)

:
இது 2G/3G செல்லுலார்  வலையமைப்பிற்கான ப�ொட்டலம் 

சார்ந்த கைபேசி தரவு சேவை.

12.
மெய்நிகா் தனிப்பட்டட 

வலையமைப்புகள் 
( V P N )

:

 இது Virtual Private Network (VPN) ஆகும்.  இது ப�ொது 

வலையமைப்பு முழுவதிலும் ஒரு தனியார் வலையமைப்பு 

நீட்டிக்கப்பட்டு தங்கள் கணினி சாதனங்களை 

நேரடியாக தனியார் வலையமைப்புடன் இணைத்தல் 

ப�ோல பகிர்வு அல்லது ப�ொது வலையமைப்பு முழுவதும் 

பயனர்கள் தரவுகளை அனுப்புவதற்கும் பெறுவதற்கும் 

வழிவகுக்கிறது.

13.
Wireless Local Loop 
(WLL)

:
சாதாரண த�ொலைபேசி சேவையை (Pots) 

வழங்குவதற்கான இணைப்பைப் ப�ோல உள்ள 

கம்பியில்லா தகவல் த�ொடா்பு இணைப்பாகும்.

14.
Plain old Telephone 
Service (POTS)

:
இது குரல் வழி த�ொலைப்பேசி சேவைகளுக்கு செம்பு 

வளைய ஒப்புமை வகை சமிக்ஞை பரிமாற்றத்தைப் 

பரப்புகிறது.

15.
LTE (Long Term 
E v o l u t i o n )

:

LTE  என்பது கம்பியில்லா தரவு வலையமைப்புகளின் 

திறன் மற்றும் வேகத்தை அதிகரிக்க மே்பட்ட 

முன்னணி த�ொழில்நுட்பங்களை ந�ோக்கி சுமூகமான 

மற்றும் திறமையான மாற்றத்திற்கான ஒரு தரத்ததை 

குறிக்கிறது.

15. Wima technology :
இது கம்பியில்லா தரவு த�ொடர்பு த�ொழில்நுட்பமாகும்.  

இது IEE 802.16 தரநிலையை அடிப்படையாக க�ொண்டு 

பரந்த பகுதியில் அதிக வேக தரவை வழங்கும்.

17.
Voice Mail System 
( V M S )

:

 Voice Mail System என்பது கணிப்பொறி தழுவிய 

அமைப்பு.  இது பயனார்கள் மற்றும் ச்நதாதாரா்களின் 

தனிப்பட்டட குரல் செய்திகளை பரிமாற்ற அனுமதிக்கிறது 

மற்றும் குரல் தகவல்கள் தேர்வு செய்து வழங்குகிறது.  
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கற்றலின் ந�ோக்கங்கள்:

•	 வணிகத்தில் இணையத்தின் 
இன்றியமையாமை.

•	 வலை அமைப்பின் வகைகள்.
•	 இணையத்தில் வழங்கப்படும் சேவைகள்.
•	 இணையத்தின் பயன்பாடுகள் 
•	 இணையம் (Internet), அகஇணையம் 

(Intranet) மற்றும் புறஇணையம் (extranet)
இடையே வேறுபாடு அறிதல்.

•	 வலைப்பக்கம் மற்றும் வலைத்தளம் 
இடையேயான வேறுபாடு.

•	 நிலையான மற்றும் இயங்குநிலை 
வலைப்பக்கங்களுக்கு இடையேயான 
வேறுபாடு. 

•	 வலை உலாவிகள் மற்றும் தேடு 
ப�ொறிகளுக்கிடையேயான வேறுபாடு.  

•	 இணைய உலாவலின் ப�ோது செய்ய 
வேண்டியதும், செய்யக்கூடாததும்.

15.1 இணையத்தின் தேவை
	 வலையமைப்பு என்றால் என்ன என்பது 
பற்றியும் அதின் முக்கியத்துவத்தையும் பற்றியும் 
அறிந்திருத்தல் அவசியம் ஆகும்.  வலையமைப்பு 
என்பது ஒன்றோட�ொடன்று இணைக்கப்பட்ட 
சாதனங்கள் த�ொகுப்பாகும்,  (கணிப்பொறி, 
அச்சுப்பொறி ப�ோன்றவை) வலையமைப்பின் 
முக்கியத்துவத்தை பற்றி அறிவதற்கு 
வலையமைப்பு உருவாக்கப்படுவதற்கு முன்பு 
எவ்வாறு இவை இயங்கின என்பது பற்றி தெரிந்து 
க�ொள்வோம்.  இதற்காக வலையமைப்பு 
உருவாக்கப்படுவதற்கு முன்னால் ஒரு பன்னாட்டு 
நிறுவனம்  இருப்பதாக கருதுவ�ோம்.

	 உணவு ப�ொருள்களை விற்பனை செய்யும்.
அந்நிறுவனத்தின் பெயர் ஸ்ரீ மதர் இன்டர்நேசனல் 
லிமிடெட் எனக் க�ொள்வோம்.  ஒவ்வொரு நாளும் 
விற்பனை பற்றிய முடிவுகளை எடுப்பதற்கு 
அந்நிறுவனத்தின் ப�ொருள்களின் அன்றைய 
விற்பனை, சரக்கு இருப்பு ப�ோன்ற தகவல்கள் 
தேவை, இவ்விவரங்களை பெறுவதற்கு அவர்கள் 
அந்நிறுவனத்தின் உள்ளூர் அதிகாரிகளை தபால்/
அஞ்சல், அல்லது த�ொலைநகல் மூலம் அச்சிடப்பட்ட 
அறிக்கைகளை அனுப்புவார்கள் அல்லது 

15
இணைய தளம் மற்றும் மின்னஞ்சல் - ஓர் அறிமுகம்

நெகிழ்வட்டில் சேர்த்து அஞ்சல் 
மூலம் அனுப்ப இயலும்.  
அஞ்சல் அவர்களை 
சென்றடையும் ப�ோது அதில் 
உள்ள தரவுகள் முதல் நாள் 
தகவலாக இருக்கும்.  தரவுகள் 
த�ொலை நகல் (fax) மூலம் 
அனுப்பப்பட்டாலும் கூட அந்த அறிக்கைகளை 
த�ொகுப்பது மிகப்பெரும் வேலையாகும். அதிக 
எண்ணிக்கையிலான தரவுகளை/அறிக்கைகளை 
த�ொகுக்கும் ப�ோது மனித பிழைகள் (HUMAN 
ERRORS) ஏற்படுவதற்கான வாய்ப்புகள் அதிகம் 
ஆகும்.  இது இச்செயல் முறைகளின் ஒரு 
பகுதியாகும்.  மேலும் உள்ளூர் அதிகாரிகள் 
தேவையான அறிக்கைகளை தர அவர்கள் 
தலைமை அலுவலகம் மற்றும் இதரப் பகுதிகளில் 
உள்ள உள்ளூர் அலுவலகங்களைத் 
த�ொடர்புக�ொண்டு அதற்கான தரவுகளைத் 
திரட்டவேண்டும் என்பதை கருத்தில் க�ொள்ள 
வேண்டும். அதே நிறுவனம் தற்போது அதன் 
அனைத்து கிளை அலுவலகங்களும் ஒன்றோடு 
ஒன்று இணைக்கப்பட்டிருப்பதாக 
எடுத்துக்கொள்வோம்.  அதன் அனைத்து கிளை 
அலுவலகங்களில் இருந்தும் தரவுகள் அந்த 
நிறுவனத்தின் தலைமை அலுவலகத்தில் ஒரு click 
மூலம் உடனடியாக சேமிக்கப்படும்.  
அந்நிறுவனத்தின் மேலாண்மை குழு ஆனது 
உலகத்தின் எந்த இடத்திலும் உள்ள 
அந்நிறுவனத்தின் கிளை அலுவலகங்களின் 
தகவல்களை விரும்பிய வடிவில் பார்க்க முடியும்.  
மேலும் இத்தரவானது நிகழ்கால/தற்போதைய 
தேசத்தின் தரவாகும்.  அதாவது அவர்கள் 
தற்போதைய நிலவர தகவல்களை பார்க்க இயலும்.  
தரவுகளானது மையப்பாடுற்றதாக/மையப்பகுதியில் 
சேமிக்கப்படுவதால் எந்த அலுவலகத்தில் இருந்தும், 
எந்த அலுவலக விற்பனை த�ொடர்பான 
தரவுகளையும் காண முடியும்.
	 வலை அமைப்பு இல்லாமல் தரவுகளை 
அனுப்பும் ப�ோது அதற்கான விலை, நேரம், 
உழைப்பு அகியவை மிக அதிகமானதாக 
இருக்கும். தரவுகளை மாற்றி அனுப்புவதற்கான 
செலவு, நேரம், மற்றும் உழைப்பு ஆகியவை 
வலையமைப்பினால் குறைகின்றது.  மேலும் இது  

HTML மற்றும் CSS பயன்படுத்தி 
வ ைலப்பக்கங்க ைள உருவாக்குதல் பாடம்அலகு III
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உற்பத்தியை அதிகரிக்கவும் வழி செய்கின்றது.   
இவை வளங்களை பகிர்ந்து க�ொள்வதன் மூலம்,  
வளங்களை மேம்படுத்த உதவுகின்றன. 
வளப்பகிர்வுக்கு எடுத்துக்காட்டாக.  ஒரு 
அலுவலகத்தில் உள்ள அச்சுப்பொறியை 
அனைத்து கணிப்பொறிகளும் பகிர்ந்து 
க�ொள்ளுதல்.

	 வலையமைப்பின் பயன்கள் பற்றி தெரிந்து 
க�ொண்டோம்.  தற்போது பல்வேறு வகையான 
வலையமைப்புகளை பற்றி பார்க்கலாம்.

15.2 இணையம் மற்றும் WWW 
(உலகளாவிய வலை)

	 உலகத்தில் உள்ள சிறிய மற்றும் பெரிய 
வலையமைப்புகள் ஒன்றோட�ொன்று இணைந்து 
பரந்த உலகலாவிய வலையை உருவாக்குகின்றன. 
இது இணையம் எனப்படும். உலகளாவிய வலை 
அமைப்பான இணையம், TCP/IP (Transmission 
Control Protocol/Internet Protocol) 
நெறிமுறையை பயன்படுத்தி பல்வேறு ஊடகங்கள் 

வழியாக தரவு பரிமாற்றத்தை செய்கிறது. TCP/IP 
என்பது ஒரு வலையமைப்பிற்கான விதிமுறை 
அல்ல.  TCP/IP என்ற நெறிமுறைகளை/
படிநிலைகளை உள்ளடக்கிய நெறிமுறைகளின் 
த�ொகுப்பாகும்.  எந்த வடிவ தகவல் 
பரிமாற்றமானாலும் இரண்டு நிலைகள் தேவை. 
அவை செய்தியை பரிமாற்றம் செய்தல் வேண்டும் 
மேலும் நம்பகத் தகுந்த முறையில் பரிமாற்றம் 
செய்தல் வேண்டும். (Internet protocol) IP என்பது 
ஒவ்வொரு கணிப்பொறிக்கும் ஒரு முகவரியை 
வழங்குகின்றது.  இதன் மூலம் லட்சக் கணக்கான 
பயனர்கள் பயன்படுத்தும் கணிப்பொறிகளுள் 
ஒன்றை அடையாளம் காண உதவுகின்றது.  
வலையமைப்பில் ஒவ்வொரு கணினியும் HOST 
(புரவன்) என அழைக்கப்படும்.
	 இவ்வுலகில் மிகவும் விலை குறைவான 
வழிமுறையில் தகவல்களை பரிமாற்றம் 
செல்வதற்கு இணையம் ஒரு வழி முறையாகும்.
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படம்  15.1

இணையமானது TCP/IP எனப்படும் நெறிமுறைகளை பயன்படுத்தி இயங்குகின்றது.  TCP/IPஆனது 
ஒரு கணிப்பொறியில் இருந்து, மற்றொரு கணிப்பொறிக்கு இணையத்தின் வழியாக தரவுகளை 
ப�ொட்டலங்களாகப் பிரித்து சரியான இருப்பிடத்திற்கு அனுப்ப அனுமதிக்கிறது.

புறஇணையம் (EXTRANET) என்பது இணைய த�ொழில் நுட்பத்தையும் ப�ொது த�ொலைத் த�ொடர்பு 
வசதிகளையும் பயன்படுத்துகின்ற ஒரு தனியார் வலையமைப்பு ஆகும்.  இது வியாபாரம் த�ொடர்பான 
தகவல்கள், செயல்பாடுகள் ஆகியவற்றை வழங்குவ�ோர்கள், விற்பனையாளர்கள், பங்கு தாரர்கள், 
வாடிக்கையாளர்கள் அல்லது பிற வணிகர்களுடன் பகிர்ந்து க�ொள்ள உதவுகிறது.
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இணையத்தில் வழங்கப்படும் சில சேவைகள்

1.  மின்னஞ்சல் (E-mail)
2.  ஒலி/ஒளி வசதியுடன் கூடிய இணையம் வழி 

கருத்தரங்கம்.

3.  இணையத்தில் உள்ள திரைப்படங்கள் மற்றும் 

விளையாட்டுக்கள்.

4.  க�ோப்பு பரிமாற்ற நெறிமுறை மூலம் தரவு/தகவல் 
(or) க�ோப்புகளை பரிமாறிக் க�ொள்ளுதல்.

5.  உடனடி செய்தி பரிமாற்றம்.

6.  இணைய குழுக்கள்.

7.  சமூக வலையமைப்புகள்.

8.  இணையம் மூலம் ப�ொருள்களை வாங்குதல்.

9.  ப�ொருளாதார சேவைகள்.

15.2.1 Domain  பெயர் (Domain Name)
	 இணையத்தில் இணைந்திருக்கும் ப�ோது 

வலைப்பக்கங்களின் வகையை பற்றி அறிய வலை 

உலாவியானது பயன்படுகின்றது.

Generic 
Domain 

Name
Description

.com Commercial Organisation

.gov Government institution

,org Non-profit Organisation

.net Network Support Group

.edu Educational Institution

அக இணையம் (Internet) மற்றும் 

இணையத்தின் இதயமாக 

கருதப்படுவது DNS (DOMAIN 
NAME SYSTEM) ஆகும்.  இதன் 

வழியாக கணிப்பொறிகள் ஒன்றோட�ொன்று 

த�ொடர்பு க�ொள்ளவும். மேலும் மின்னஞ்சல் 

ப�ோன்றவற்றை பரிமாறிக்கொள்ளவும் அல்லது 

வலைப்பக்கத்தை வெளிப்படுத்தவும் முடியும்.

Country Level 
Domain Name Description

.in India

.au Australia

.us United States of America

,jp Japan

.ru Russia

.sg Singapore

15.2.2.   URL  என்பது என்ன?
	 இணையத்தில் ஒவ்வொரு சேவையக 
கணிப்பொறியும்  ஒரு IP (Internet Protocol) 
எண்ணை பெற்றுள்ளன. இது நான்கு பகுதிகளை 
க�ொண்ட தனித்துவமான எண்ணால் 
குறிக்கப்படும். ஒவ்வொரு பகுதியும் புள்ளியால் (.) 
பிரிக்கப்பட்டிருக்கும்.  இந்த IP எண் ஆனது 
சேவையகத்தின் முகவரியாக கருதப்படும்.

		  165.113.245.2
		  128.143.22.55
	 சில நேரங்களில் எண்கள் த�ொடர்ச்சியாக 
மாறும்.  எனவே எண்களை நினைவில் 
வைத்துக்கொள்வது ச�ொற்களின் சேர்க்கையினை 
நினைவில் வைத்துக் க�ொள்வதை விட கடினம் 
ஆகும்.  ஆகையால் முகவரியானது ச�ொற்களை 
அடிப்படையாகக் க�ொண்டு தரப்படுகின்றது. இது 
URL என அழைக்கப்படுகின்றது.  எனவே URL 
இணையதள முகவரி என்பதும் IP (இணைய 
நெறிமுறை) என்பதும் ஒன்றே ஆகும். 

படம்  9.2

இணையம் INTERNET என்பது ஒரு நிறுவனத்தினால் பயன்படுத்தப்படும் வலைத்தளம் ஆகும். 
பணியாளர்கள் நிறுவனத்தை பற்றிய தகவல்களை அறிந்து க�ொள்ளவும் (எ.கா.  க�ொள்கைகள், 
விதிமுறைகள், பணியாளர்களின் விவரங்கள், விவரக்கையேடுகள், துறைகள் பற்றிய தகவல்கள்) 
கருவிகள் (ப�ொதுவான பயன்பாடுகளுக்கான விரைவு இணைப்புகள், படிவங்கள்) மற்றும் சமூக 
தகவல்களை பகிர்ந்துக�ொள்ளவும் உதவும் (முகநூல் ப�ோன்றவற்றை அணுகவும் உதவுகின்றது.)
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URL என்ற முகவரி உலகளாவிய 
வலையின் ஒரு குறிப்பிட்ட பகுதியை 
தேடி காண்பிக்கிறது. URL என்பது  

Uniform Resource Locator  என்பதன் 
குறுக்கமாகும்.

15.2.3. இணையத்தை நிர்வகிப்பது யார்?
	 இணையத்தை ப�ொருத்த வரையில் அதை 

நிர்வகிப்பது யார் என்பது ப�ொதுவாக எழுப்பப்படும் 

கேள்வியாகும்.  உண்மையாது எனில் 

இணையத்தை ப�ொருத்தவரை மையப்படுத்தப்பட்ட 

மேலாண்மை அமைப்பு என்பது இல்லை.

	 இணையம் முழுவதையும் 

கட்டுப்படுத்தக்கூடிய ஒற்றை கட்டுப்பாட்டு 

அமைப்பு என்பது இல்லை இணைய சமூகம் என்ற 

தன்னார்வ உறுப்பினர் அமைப்பானது 

இணையத்தில் உலகளாவிய தகவல்களை 

பரிமாறிக் க�ொள்வதில் ப�ொறுப்பு 

எடுத்துக்கொள்கிறது.  ஐகான் (Internet 
Corporation For Assigned Names and 
Numers) என்ற அமைப்பு இந்த முகவரி பதிவை 

நிர்வகிக்கின்றது.  ஏற்கனவே பதிவு செய்யப்பட்ட 

பெயர் மீண்டும் பதிவு செய்யாப்படாமல் இருக்க 

உதவுகிறது.

ஐகான் (ICANN) என்ற 
அமைப்பானது செப்டம்பர் 18, 1998 
ஆண்டில் உருவாக்கப்பட்டது.  இதன் 
தலைமையகம்  லால் ஏஞ்ஜல்ஸ் 

அருகில் உள்ள Playa vista ல் உள்ளது.

15.3.4  W3C என்றால் என்ன?  

WORLD WIDE WEB CONSORTIUM 
(உலகளாவிய வலை கூட்டமைப்பு) 
என்பதே W3C என்பதாகும் W3C அமைப்பானது 
முழுநேர பணியாளர்கள், த�ொழில்துறை 
நிபுணர்கள், பல்வேறு உறுப்பினர் அமைப்புகள் 
க�ொண்ட சர்வதேச அமைப்பாகும்.  இந்த 
அமைப்பானது உலகலாவிய வலைக்கான 
நெறிமுறைகளை உருவாக்குகிறது.

	 உலகலாவிய வலை கூட்டமைப்பு (W3C) 
என்ற சர்வதேச சமூக அமைப்பானது வலையை 
மேம்படுத்துவதில் உறுதி க�ொண்டுள்ளது.  பல்வேறு 
த�ொடர்புடைய, தகவல் த�ொழில் நுட்பம் சார்ந்த பல 
நூறு உறுப்பினர் அமைப்புகளை க�ொண்டு இது 

உருவாக்கப்பட்டுள்ளது. உலகளாவிய  வலைக்கான 
நெறிமுறைகளை அமைப்பதன் மூலமாக சிறந்த 
தகவல் த�ொடர்வு திறன் மற்றும் அனைத்து வலை 
பங்குதாரர்களையும் ஒருங்கிணைப்பது 
ப�ோன்றவற்றை W3C அமைப்பு மேற்கொள்கிறது.  
இது உலகளாவிய வலையை (WWW) 
உருவாக்கியம் பெர்னர்ஸ் லீ (Tim Berners-Lee) 
என்பவரால் 1994 ல் நிறுவப்பட்டது.

 15.3 இணைய சேவையின் வகைகள்:
ப�ொதுவான சில இணைய சேவைகளின் வகைகள் 
இங்கு க�ொடுக்கப்பட்டுள்ளது.

கம்பி இல்லா இணைப்பு (Wireless)
	 த�ொலைபேசி (அல்லது) கம்பி வடம் 
இணைப்புகளுக்கு பதிலாக ரேடிய�ோ அலைகள் 
பயன்படுகின்றன. கம்பியில்லா இணைய 
இணைப்பின் மிகப் பெரும் அனுகூலமே, 
வலையமைப்பு விரிந்துள்ள இடத்திற்குள் இணைய 
இணைப்பை எந்த இடத்திலிருந்தும், எப்போதும்.  
அணுகமுடியும் ம�ோடத்தின் உதவியின் மூலமும் 
கம்பியில்லா இணைப்பை அமைக்கமுடியும்.  இது  
இணைய சமிக்ைஞகளை பெற்று மற்ற 
சாதனங்களுக்கு அனுப்புகிறது.

கைப்பேசி (Mobile)
	 பல கைப்பேசி மற்றும் ஸ்மார்ட் ப�ோன் 
தயாரிப்பு நிறுவனங்கள் குரல் வழி அழைப்பு 
வசதியுடன் கூடிய இணைய சேவைகளை 
வழங்குகின்றன.  நல்ல வேகத்துடன் 
இணையத்தை அணுகுவதற்கு கைப்பேசி வழி 
இணைய இணைப்பானது பயன்படுகிறது.

ஹாட்ஸ்பாட் (Hotspots)
	 கம்பியில்லா குறும்பரப்பு வலையமைப்பை 
ப�ோன்று இணைய வசதியை அணுக  ஹாட்ஸ்பாட்ஸ் 
(Hotspots) பயன்படுகின்றது.  Hotspots  
சாதனமானது ரவுட்டர் (ROUTER) ப�ோல் 
செயல்பட்டு இணைய சேவை வழங்குபவருடன் 
இணைப்பை ஏற்படுத்துகிறது.    அது கம்பி இல்லா 
இணைப்பு முனையை பயன்படுத்துகின்றது.  
மின்னணு சாதனங்கள் இணையத்துடன் 
த�ொடர்புக�ொள்ள அல்லது  தகவல்களை 
பரிமாறிக்கொள்ள ரேடிய�ோ அலைகளை (Radio 
waves) பயன்படுத்துகிறது. ஹாட் ஸ்பாட் 
இணைப்பானது கைப்பேசி அடிப்படையில�ோ, 
வணிக அடிப்படையில�ோ  இருக்கலாம் அல்லது 
ப�ொதுமக்களுக்கு இலவசமாகவ�ோ கிடைக்கலாம்.

பிராட்பேண்ட் (Broadband)
	 பிராட்பேண்ட் இணைய இணைப்பு என்பது 
த�ொலைபேசி நிறுவனங்களால் வடம் (cable) 
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மூலமாகவ�ோ அல்லது த�ொலைபேசி மூலமாகவ�ோ 
அதிவேகத்துடன் வழங்கக் கூடிய இணைப்பாகும். 
அகண்ட அலை வரிசை இணைய அமைப்பபானது 
ஒன்றுக்கு மேற்பட்ட தரவுப்பாதைகள் வழியாக 
அதிக எண்ணிக்கையிலான தகவல்களை 
அதிவேகமாக அனுப்புவதற்கு ஒருமுறைய 
அகண்ட அலை வரிசை கற்றை என்பது சுருக்கமாக 
பிராட்பேண்ட எனப்படும்.  பிராட்பேண்ட் இணைய 
இணைப்பு என்பது DSL (or) வடம் (cable) மூலமாக 
வழங்கப்படும் அதிவேக இணைய 
இணைப்புகளாகும்.  பல DSL இணைய இணைப்புகள் 
பிராட்பேண்ட் இணைப்புகளாக கருதப்படுகின்றன.  
இருந்த ப�ோதும் எல்லா பிராட்பேண்ட் 
இணைப்பகளும் DSL இணைப்புகள் அல்ல.

DSL
	 DSL என்பது DIGITAL SUBSCRIBER 
LINE என்பதன் சுருக்கம் ஆகும்.  இது இரண்டு 
தாமிரக்கம்பிகளால் ஆன த�ொலைபேசி வடங்களை 
இணைய இணைப்பிற்கு பயன்படுத்துவதால்   தரை 
வழி த�ொலைபேசி ப�ோல செயல்படுகிறது.  பயனர் 
இணையத்தில் உலாவும் அதே வேலையில் குரல் 
அழைப்புகளையும் த�ொலைபேசி வழியாக 
மேற்கொள்ள முடியும்.
வடங்கள் (Cable)
	 வடங்கள் வழியாக மேற்கொள்ளப்படும் 
இணைய இணைப்பானது பிராட்பேண்ட் 
அமைப்பைப் ப�ோன்றது.  கம்பி வழி 
த�ொலைக்காட்சிக்களை ம�ோடத்தை 
பயன்படுத்தினாலும் பயனர் அதன் வழியாக 
இணையத்தை அணுக முடியும்.  கம்பி வழி 
ம�ோடமானது இணையத்தை அதி வேகமாக 
அணுகுவதற்கு உதவுகிறது.

செயற்கைக் க�ோள் (Satellite)
	 பிராட்பேண்ட் இணைய இணைப்பானது 
வழங்கப்படாத சில பகுதிகளில் இணைய 
இணைப்பை வழங்க செயற்கைக் க�ோளானது 
பயன்படுகின்றது.  கம்பி இல்லா இணைய வசதியை 
ப�ோன்றே, செயற்கைக் க�ோள் இணைய 
இணைப்பும் ம�ோடத்தை பயன்படுத்துகிறது.

ISDN
	 ISDN (Integrated Services Digital 
Network) என்பது பயனர்கள் தரவுகள், குரல் 
தரவுகள், ஒலி மற்றும் ஒளி காட்சிகளை இலக்க 
முறை த�ொலை பேசி கம்பிகள் வழியாக (or) தரம் 
வாய்ந்த த�ொலைபேசி கம்பிகள் வழியாக அனுப்ப 
அனுமதிக்கிறது.  இவ்வசதியை பெற 
இருமுனைகளிலும் அதாவது சேவையை பெறுபவர் 
மற்றும் சேவையை வழங்குபவர் என்ற 
இருமுனைகளிலும் ISDN ஏற்பியானது (adapter) 
நிறுவப்படுதல் வேண்டும்.

டாங்கிள்ஸ் / தரவு அட்டை (Dongles / Data 
Card)
	 இன்றைய நாட்களில் பல டாங்கிள்கள் 
கம்பி இல்லா இணைய வசதியை வழங்கும் திறனை 
பெற்றுள்ளன. (எ.கா.) யூ.எஸ்.பி, வைஃபை (USB, 
Wi-Fi) ப�ோன்றவை டாங்கிள்கள் எனப்படும்.  
இன்றைய கணிப்பொறிகள் மிகப் பெரும் 
பாலானவை வைஃபை, மற்றும் செல்லுலார் தரவு 
ஏற்பிகளை (adapters) முன் கூட்டியே 
க�ொண்டுள்ளதால் 3G மற்றும் 4G டாங்கிள்கள் 
(DONGLES) அதிகமாக பயன்படுகின்றன.  
இவ்வகையான டாங்கிள்கள் வைஃபை வசதி 
இல்லாவிட்டாலும் கூட இணையத்தை அணுக 
கூடியவை ஆகும்.

டாங்கிள்ஸ் (DONGLE) மற்றும் தரவு அட்டை (DATA CARD) இடையேயான வேறுபாடு.

Dongle Data Card
கூடுதல் பாதுகாப்பை 

வழங்கும் நீக்கக்கூடிய 
(removable) கூறுகளை 

குறிக்கிறது.  யு.எஸ்.பி 

டாங்கிளின் வகைகள்

•	 WIFI டாங்கிள்

•	 BLUETOOTH 
•	 MEMORY டாங்கிள்

இது தரவுகளை சேமித்துவைக்கவும் 

பயன்படும் நீக்கக்கூடிய மின்னணு அட்டை 

ஆகும்.

 DATACARD ன் வகைகள்

•	 Expansion Card
•	 Memory Card or Flash Card
•	 Identification Card

15.3.1  இணைய இணைப்பு மற்றும் அணுகும் முறைகள்:
	 இணைய வசதியை பெறுவதற்கு பல விதமான வழிகள் (or) முறைகள் உள்ளன.

	 இணையத்தை அணுகுவதற்கு பயன்படும் நேரடி மற்றும் மறைமுக அணுகல் முறை மற்றும் இவை 
நிலையான (அல்லது) மாறும் வசதியை க�ொண்டிருக்கும்.
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15.3.1.1  மறைமுக அணுகல்:
	 வீடு மற்றும் அலுவலகங்களில் 
பெரும்பாலும் பயன்படும் வலையமைப்பாகும்.  (எ.கா) 
கணிப்பொறியானது ஈதர்நெட் அல்லது வைஃபை 
மூலமாக வலையமைப்புடன் இணைக்கப்பட்டு 
அந்த வலையமைப்பானது ADSL (ASYMMETRIC 
DIGITAL SUBSCRIBER LINE) மூலமாக 
இணையத்துடன் இணைக்கப்பட்டிருக்கும் (வடம் 
(or) ஒளியிழை வடம் மூலமாக) (cable or fibre).

15.3.1.2  Direct Access (நேரடி அணுகுதல்)
	 பயணத்தின் ப�ோது இம்முறையானது 
பெரும்பாலும் பயன்படும்.

(எ.கா) அலைப்பேசியானது 3G/4G அலைப்பேசி 
வலையமைப்பு மூலமாக (Public) ப�ொது வைஃபை 
மூலமாக இணையத்தில் இணைதல்.

இணையத்தில் தகவலை பார்வையிட இரண்டு 
வழிமுறைகள் உள்ளன.
1.	 வலைத்தளத்தின் முகவரி தெரிந்தால் யாரும் 
நேரடியாக முகவரிப்பட்டையில் தட்டச்சு 
செய்யலாம்.

2.	 வலைத்தளத்தின் முகவரி தெரியாத ப�ோது 
தேடு ப�ொறிகள் தேவையான தகவலை பெற 
உதவுகிறது.

	தே டு ப�ொறிகள் என்பது தேவையான தகவலை 
உலகளாவிய வலையில் இருந்து (www) தேடி 
தருவதற்காக வடிவமைக்கப்பட்டுள்ள 
மென்பொருளாகும்.

	 (எ.கா.) பரவலாக பயன்படும் தேடு ப�ொறிகள் 
Yahoo, Lycos, Altavista, Hotbot, Google மற்றும் 
Askjeeves.
1. வலை உலவியானது வலை தளத்தைய�ோ, வலை 
பக்கத்தைய�ோ அணுக பயன்படுகிறது. ஆனால் 
தேடு ப�ொறிகள் ஒரு குறிப்பிட்ட தகவலை தேட 
பயன்படுகிறது. 

2. Internet Explorer, Chrome, Firefox மற்றும் 
Safari, ஆகியவை புகழ்பெற்ற வலை உலவிகள் 
ஆகும். GOOGLE மற்றும் YAHOO ஆகியவை 
மிகவும் புகழ்பெற்ற தேடு ப�ொறிகளாகும்.

3. இணையத்தை அணுகுவதற்கு வலை 
உலாவியானது பயன்படுகிறது.  அதே சமயம் தேடு 
ப�ொறிகளை திறக்க வலை உலவி தேவைபடுகிறது.

தேடு ப�ொறிகள் மூலம் பயனர்களுக்கு திரும்ப 
கிடைக்கும் பட்டியலிடப்பட்ட உரையானது (URL’S) 
SERP (SEARCH ENGINE RESULTS PAGE) 
எனப்படும்.

15.4 இணைய பயன்பாடுகள்:

1. இணைய த�ொலைபேசி (INTERNET 
TELEPHONY)
	 இணையம் மூலம் வழங்கப்படும் 
சேவைகளுல் இணைய வழி த�ொலைபேசி என்பது 
மற்றும�ொரு ப�ொதுவான சேவையாகும்.  (எ.கா.) 
Skype) இணையத்தின் மூலமாக நடைபெறும் 
அனைத்து குரல் வழி பரிமாற்றங்களும் VOIP 
(VOICE-OVER-INTERNET PROTOCOL)
என்ற நெறிமுறையின் அடிப்படையில் 
செயல்படுகிறது.

2. வேலை தேடல் (JOB SEARCH) 
	 இன்றைய நாட்களில் இணையத்தின் 
மூலம் வேலை தேடுதல் அதிகரித்துள்ளது 
இணையத்தின் மூலம் வேலை தேடும் ப�ோது 
விரைவாகவும் மேலும் பல்வேறு துறைகளில் உள்ள 
பெரும் எண்ணிக்கையிலான காலிப்பணியிட 
விவரங்களையும் பெறமுடியும், வேலை தேடுபவர்கள் 
குறிப்பிட்ட வேலைக்காக தங்களை பற்றிய 
விவரங்களை (RESUME) இணையத்தில் பதிய 
இயலும் naukri.com, monster.com, summerjob.
com, recruitment.com  ப�ோன்ற நிறுவனங்களின் 
வலைதளங்கள் இச்சேவையை வழங்குகின்றன.

3. இணையத்தில் ப�ொருள்களை வாங்குதல் 
(ONLINE SHOPPING) 
	 இணையமானது மெய் நிகர் சந்தைகளால் 
(Online Shopping) கட்டமைக்கப்பட்டு 
உள்ளடக்கிய புதிய சந்தை முறை வசதியை 
அறிமுகப்படுத்துகின்றது.  (www)   சேவையங்கள் 
மூலம் ப�ொருள்களை பற்றிய விபரங்களைய�ோ 
அல்லது வழங்கும் சேவைகள் பற்றிய 
தகவல்களைய�ோ வலைத்தளத்தில்  அறிந்து 
க�ொள்ள முடியும். இணைய சேவை  வாடிக்கையாளர் 
குறிப்பிட்ட ப�ொருள்களை பற்றிய விவரங்கள் 
மற்றும் விலை விகரங்கள் ப�ோன்ற 
க�ோரிக்கைகளை கேட்டு பெறலாம்.

	 (எ.கா.) amazon.com உலகளாவிய 
வலையை அடிப்படையாக க�ொண்டு 
(இணையத்தை) இணையத்தில் செயல்படும் புத்தக 
கடை ஆகும்.  இதில் சர்வதேச நூல்கள் பற்றிய 
விவரங்கள் அனைத்தும் இடம்பெற்றுள்ளன.  
அதாவது புத்தகத்தை நாம் இணைய வழியில் பெற 
இயலும். 

4. பங்குச் சந்தை பற்றிய தகவல்களை பெறுதல் 

(Stock market updates)
	 இணையத்தின் மூலம் வீட்டில் 
இருந்தபடியே நிறுவனங்களின் பங்குகளை 

Chapter 15.indd   299 20-04-2020   16:05:03



300

வாங்கவ�ோ, விற்கவ�ோ முடியும். ndtvprofit.com, 
moneypore.com ப�ோன்ற வலைதளங்கள் பங்கு 
சந்தையில் முதலீடு செய்வது த�ொடர்பான 
தகவல்களை க�ொண்டுள்ளன.

5. பயணங்கள் (Travel):
	 சுற்றுலா தளங்கள் பற்றிய விபரங்களை 
ஒருவர் இணையத்தின் மூலம சேகரிக்க முடியும்.  
இதன் மூலம் விடுமுறை கால சுற்றுலாக்களை 
முன் கூட்டியே பதிவு செய்வது, மேலும் தங்கும் 
இடங்கள் (hotels), புகைவண்டி (train), பேருந்து 
(bus), விமானம் (flights) வாடகை வண்டிகள் 
ப�ோன்றவற்றையும் பதிவு செய்ய இணையமானது 
உதவுகின்றது goibibo.com, makemytrip.com, 
olacabs.com ப�ோன்ற வலைத்தளங்கள் 
இச்சேவையை வழங்குகின்றன.

6. ஆராய்ச்சி (Research) 
	 ஆராய்ச்சியாளர்கள் மேற்கொள்ளும் 
இலக்கிய ஆய்வு பற்றிய இதழ்கள் இணையத்தில் 
வழங்கப்படுகின்றன.

7. காண�ொளி காட்சி (Video conferencing)
	 வலையமைப்பின் மூலமாக வெப் கேமரா, 
நுண் பேசிகள் ப�ோன்ற த�ொடர்பு கருவிகளை 
பயன்படுத்தி காண�ொளி காட்சி கலந்தாய்வு 
முறையை வழங்குகின்றது.  த�ொலை தூர 
இடத்தில் உள்ள ஒருவர் குறுகிய கால 
அவகாசத்தில் ஏற்பாடு செய்யப்படும் கருத்தரங்கில் 
காண�ொளி காட்சி மூலம் பங்கேற்க முடியும்.  இது 
நேரத்தையும், பணத்தையும் மிச்சமாக்குகிறது.  
இத் த�ொழில் நுட்பமானது த�ொலை தூர இடத்தில் 
உள்ள பணியாளர் வீட்டில் இருந்த படியே 
பணியாற்ற வகை செய்கின்றது.  கல்வியில் 
காண�ொளி காட்சி மூலம் மிக எளிதாக 
ஆசிரிசியரிடமிருந்து  வகுப்பறைக்கு, பல் வேறு 
இடங்களில் உள்ள மாணவர்களுக்கிடையேயான 
வகுப்பறை ப�ோன்றவற்றை ஊடாகும் முறையில் 
வழங்க முடியும்.

8. மின் வணிகம் (e–commerce)
	 இணையத்தை அடிப்படையாக க�ொண்டு 
உருவாக்கப்படும் மின்னணு வலையமைப்பின் 
மூலமாக ப�ொருள்களை வாங்குதல், விற்றல் 
மற்றும் சேவைகள் அல்லது பணம் அல்லது 
தரவுகளை பரிமாறுதல் ப�ோன்றவை மின் வணிகம் 
எனப்படும்.  வணிக பரிவர்த்தன வணிகர்கள்-
வணிநர்கள், வணிகர்கள்-நுகர்வோர், நுகர்வோர் - 
நுகர்வோர் அல்லது நுகர்வோர்-வணிகர்கள் 
ப�ோன்ற ஏதேனும் ஒரு முறையில் நடைபெறும்.  
இந்தியாவில்  பிளிப்கார்ட் (FLIPKART), 
அமேசான் இந்தியா (AMAZON INDIA), ஸ்னாப் 

டில் (SNAP DEAL), பேடிஎம் (PAY TM) ப�ோன்ற 
நிறுவனங்கள் பெரிய மின்வணிக நிறுவனங்களாக 
உள்ளன.

9. இணையம் வழி பணம் செலுத்துதல் (Online 
payments)
	 இணையம் வழி பணம் செலுத்துதல் 
முறையானது அதிக எழுச்சியாக, புதிய 
நிறுவனங்கள் த�ொழில் துறைக்கு வர வழி வகை 
செய்துள்ளது. (எ.கா.) PAY TM இணையம் வழி 
பணம் செலுத்துதல் முறையில் (From Wallet) 
பெரிய நிறுவனம் ஆகும்.  இணையம் வழி பணம் 
செலுத்தும் முறையின் வளர்ச்சியானது ஸ்மார்ட் 
ப�ோன் (Smart Phone), டேப்ளட் (Tablet), அகண்ட 
அலைக் கற்றை(or) (Broad band), 4G மூலம் 
இணையத்தை விரைவாக அணுகுதல் 
ப�ோன்றவற்றின் தேவையை அதிகரித்துள்ளது.

10. சமூக வலையமைப்பு (Social Networking)
	ச மூக வலையமைப்பு என்பது 
இணையத்தை அடிப்படையாகக் க�ொண்டு 
உருவாக்கப்பட்ட சமுக வலைத்திட்டம் ஆகும்.  
இதன் மூலம் நண்பர்கள், குடும்ப உறுப்பினர்கள், 
வகுப்புத் த�ோழர்கள், வாடிக்கையாளர்கள் 
ப�ோன்றவர்களுக்கிடையே த�ொடர்பினை 
ஏற்படுத்த முடியும். சமூக ந�ோக்கத்திற்காக 
அல்லது வணிக ந�ோக்கத்திற்காக அல்லது 
இரண்டிற்குமாக சமூக வலையமைப்புகள் 
உருவாக்கப்படுகின்றன.  இம்முறையானது  தனி 
நபர்களுக்கிடையேயான த�ொடர்புகளை 
மேம்படுத்தி புதிய த�ொடர்பு ஏற்படுத்திக் க�ொள்ள 
உதவுகிறது. (எ.கா.) சமூக வலையமைப்பிற்கு முக 
நூல் (face book) எடுத்துக்காட்டாகும்.

11. குரல் வழி செய்தி (Voicemail)
	 குரல் வழி செய்தி சேவை என்பது த�ொலை 
பேசியுன் மூலம் அனுப்பப்படும் செய்தியாகும்.  
நீங்கள் த�ொடர்பு க�ொள்ள நினைக்கும் நபரின் 
அழைப்பானது ஒரு இயந்திரத்தின் மூலம் பதில் 
கூறப்படும் ப�ோது அழைக்கும் நபருக்கு நீங்கள் 
ஒரு குரல் வழி செய்தியை அனுப்பலாம்.  அவர்கள் 
பின்னர் தங்கள் செய்திகளை கேட்க முடியும்.

12. அரட்டை (Chatting)
	 இணைய வழி அரட்டை என்பது, ஒரே 
சமயத்தில் இணையத்தில் தங்களுடன் 
இணைந்திருக்கும் மற்றொரு நபருடன் 
உரையாடுவது ஆகும்.  இணையத்தில் எங்கிருந்தும் 
பங்கேற்கின்ற பயனர்கள்  தட்டச்சு செய்யப்பட்ட 
செய்திகளை பரிமாறிக�ொள்ளும் உரையாடல் 
ஆகும்.  அரட்டையானது ஒரு குறிப்பிட்ட நேரம் 
மற்றும் கால அளவில் த�ொடரமால் அநேக 
அரட்டைகள் ஒரு குறிப்பிட்ட தலைப்பைப் பற்றியே 
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நிகழ்கின்றன சிறப்பு வல்லுனர்கள் அல்லது 
பிரபலமான மக்கள் என எவரும் இணைந்து 
யாருடனும் பேசலாம்.  உரையாடலின் நகல்கள் 
பிற்கால தேவைக்காக குறிப்புகளாக 
காக்கப்படலாம்.

13. மின்-வங்கி (e-banking)
	 மின் வங்கி என்பது இணைய வங்கி எனவும் 
அழைக்கப்படுகிறது.  இந்த மின்னணு பண 

பரிவர்த்தன முறையானது ஒரு வங்கியின் 
வாடிக்கையாளர் அல்லது நிதி நிறுவனம் ஆனது 
தனது வலையகத்தின் மூலம் நிதி 
பரிவர்த்தனைகளை மேற்கொள்ள உதவுகிறது. 
மின்னணு வங்கி முறையானது ப�ொதுவாக 
வங்கியால் இயக்கப்படும் க�ோர் பேங்கிங் (core 
banking system)அமைப்பின் ஒரு பகுதியாக 
இணைக்கப்படல் வேண்டும்.

Electronic Banking

Electronic Banking 
Using aTelephone

Connection

Payment ins truments 
and Self-Service Zones

Automated 
Telephone 

System

Mobile 
banking

Internet 
Banking

Mail 
banking

Self-
service 
zone

pyment 
card

Electronic 
wallet

Home 
Banking

Electronic Banking 
Using Personal Computers 
using internet connection
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14. மின் கற்றல் (e-learning)
	 மின் கற்றல் என்பது இணையத்தின் 
வழியாக எங்கிருந்தும் கற்பதற்கு வழங்கப்படும் 
கல்வி முறையாகும்.  பேராசிரியர் ப�ோதிக்கும் 
வகுப்பறையை ப�ோல் இல்லாமல் எங்கிருந்தும் 
கல்வி கற்பதற்கு இணையத்தின் வழியாக 
வழங்கப்படும் கல்வி முறையாகும்.  
இம்முறையானது குறுந்தகடு அல்லது குறுவட்டு 
(CD-ROM) (விடிய�ோ டேட்) ஒளிக்காட்சி 
பதிவுகள், அல்லது த�ொலைக்காட்சி சேனல்கள் 
மூலம் கல்வி வழங்கும் முறையாக இருக்காது. 
மின் கற்றல் ஆனது மின்னணு த�ொழில் 
நுட்பங்களை பயன்படுத்தி இயல்பான 
வகுப்பறைக்கு மாற்றாக பாடத்திட்டத்தை கற்கும் 
முறையாகும்.  இது முழுவதும் இணையம் மூலம் 
வழங்கப்படும் முறையாகும், மின் கற்றல் மூலமாக 
ஆசிரியர்கள், பேராசிரியர்கள், அல்லது மற்ற 
மாணவர்களுடன் உரையாட முடியும்.  சில 
நேரங்களில் நீங்கள் உங்கள் கைகளை உயர்த்தி 
நிகழ் நேரத்தில் உரையாட முடியும்.  மேலும் சில 
நேரங்களில் முன் பதிவு செய்யப்பட்ட விரிவுரையாக 
இருக்கும்.  ஒரு ஆசிரியருடன் ஊடாடுவது / 
உரையாடுவது பணிகளில் பங்குக�ொள்வது, 
தேர்வுகள் நடத்துவது ப�ோன்றவை எப்போதும் 
இருக்கும்.

15.மின் ஆளுமை  (e - governance)
இணையம் மூலம் அரசாங்கம் வழங்கும் 
சேவைகளைப் பெறவும், அவை த�ொடர்பான 
தகவல்களை தெரிந்து க�ொள்ளவும், (ICT) உதவும் 
பயன்பாடு மின் ஆளுமை  எனப்படும்.

மின் ஆளுமையின் பயன்பாடுகள்
•	 ஊழலைக் குறைத்தது
•	 அதிக வெளிப்படைத்தன்மை
•	 அதிகரித்த வசதி
•	 ஒட்டும�ொத்த செலவில் குறைப்பு.
•	 அரசாங்கத்தின் விரிவாக்கம்

15.5  Email
	 மின் அஞ்சல் (Electronic Mail (or) e-mail) 
என்பது தகவல்களை கணிப்பொறியில் உள்ளிட்டு, 
த�ொலைத் த�ொடர்பு வசதி மூலம் இரு 
பயனர்களுக்கிடையே பரிமாறிக் க�ொள்வதாகும்.  
உரை, படம், க�ோப்புகள் அல்லது ஏதேனும் ஒரு 
இணைப்பைக்கொண்டு செய்தியானது 
வலையமைப்பு மூலம் குறிப்பிட ஒரு நபருக்கு 
அல்லது குழுவிற்கு அனுப்படும் முறை மின்னஞ்சல் 
எனப்படும்.

முதல் மின்னஞ்சல், 1971 ஆம் 
ஆண்டு டாம்லின்கள் என்பவரால் 
“QWERTYUIOP” என்ற உரையுடன் 
ச�ோதனை முறையில் அனுப்பபட்டது.
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TO புலத்தில் குறிப்பிடப்பட்டிருக்கும் அனைத்து 
பெறுனர்களின் அனைத்து மின்னஞ்சல் 
முகவரியையும் பெறுநர்கள் காண இயலும் இதுவும் 
விருப்பத் தேர்வு ஆகும்.

	 MESSAGE BODY:  பெறுநருக்கு அனுப்ப 
வேண்டிய செய்திகளை தட்டச்சு செய்ய பயன்படும் 
பகுதியாகும்.  இது பெரும்பாலும் கீழ் பகுதியில் 
கையால் எழுதப்படும் கடிதம் ப�ோன்று அனுப்புநர் 
விவரங்களை க�ொண்டிருக்கும்.

15.5.2 மின்னஞ்சலின் நன்மைகள்

	 மின்னஞ்சலின் முக்கியமான நன்மைகள் 
சில கீழே பட்டியலிடப்பட்டுள்ளன.

•	 இலவச விநிய�ோகம் (Free delivery) - 
மின்னஞ்சல் அனுப்புவது இணைய செலவை 
தவிர்த்து கிட்டதட்ட இலவசமாகவே உள்ளது.  

15.5.1: மின்னஞ்சலின் கட்டமைப்பு:

மின்னஞ்சல் எழுதுதல்

மின்னஞ்சல் அனுப்பும் ப�ோது சில 
புலங்கள் பூர்த்தி செய்யப்பட வேண்டும்.

•	 To என்னும் புலத்தில்/பகுதியில் 
மின்னஞ்சல் சென்று சேர வேண்டிய     
நபரின் மின்னஞ்சல் முகவரியை 
தட்டச்சு செய்ய வேண்டும்.

•	 From என்னும் புலம் அனுப்புபவரின்/
உன்னுடைய மின்னஞ்சல் முகவரியை 
க�ொண்டிருக்கும்.

•	 ஒரு மின்னஞ்சலுக்கு பதிலளிக்கும் 
ப�ோது From மற்றும் To புலங்கள் 
தாமாகவே மின்னஞ்சல் முகவரியை 
எடுத்துக்கொள்ளும்.  ஒரு புதிய 
மின்னஞ்சல் உருவாக்கும் ப�ோது 
From, To முகவரிகளை நாமே உள்ளிட 
வேண்டும்.

•	 Subject பகுதியில் மின்னஞ்சலின் 
ப�ொருளடக்கத்தை பற்றி சில ச�ொற்களை 
க�ொண்டு குறிப்பிட வேண்டும். Subject, 
மின்னஞ்சல் பெறுபவர் அதை திறந்து 
படிக்காமல், அந்த மின்னஞ்சல் எதைப் 
பற்றியது என்பதை தெரிந்து க�ொள்ள வழி 
செய்கிறது.  இது ஒரு விருப்பத்தேர்வாகும்.

	 CC (Carbon Copy) புலமானது நேரடி 
அணுகல் இல்லாத பெறுநர்களை குறிப்பிட 
உதவுகின்றது ஒரு விருப்பத் தேர்வு ஆகும்.

	 BCC (Blind Carbon Copy) இதுவும் CC 
– ப�ோன்றதே ஆகும். இதில் பெறுநர்கள் பட்டியல் 
இரகசியமாக வைக்கப்படும். எனவே இப்புலத்தில் 
குறிப்பிடப்பட்டு மின்னஞ்சல் பெறுபவர், வேறு 
யாருக்கெல்லாம் இந்த மின்னஞ்சல் 
அனுப்பப்பட்டுள்ளது என்பதை காண முடியாது. 

படம்  9.13
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கடிதத்தை அனுப்புவதைப் ப�ோல அஞ்சல் 
வில்லைகள் வாங்க வேண்டிய தேவை இல்லை.

•	 உலகளாவிய விநிய�ோகம் (Global delivery) 
- மின்னஞ்சலானது உலகின் எந்தப் பகுதியில் 
உள்ள எந்த நாட்டிற்கும் அனுப்பப்படும்.

•	 உடனடி விநிய�ோகம் (Instant delivery) - 
மின்னஞ்சலானது இணையத்தின் மூலமாக 
உடனடியாக அனுப்பப்பட்டு பயனரால் 
பெறப்படும்.

•	 க�ோப்புகளை இணைத்தல் (File attachment): 
மின்னஞ்சலானது ஒன்று அல்லது ஒன்றிற்கு 
மேற்பட்ட இணைப்புகளை க�ொண்டிருக்கலாம்.  
ஆவணங்கள், படங்கள், அல்லது மற்ற 
க�ோப்புகளை இணைத்து அனுப்ப வகை 
செய்கிறது.

•	 நீண்ட கால சேமிப்பு (Long-term storage): 
மின்னஞ்சலானது மின்னணு முறையில் 
சேமிக்கப்படுவதால் நீண்ட காலத்திற்கு 
தகவல்களை தேக்கி வைக்கவும், 
பாதுகாக்கவும் அனுமதிக்கிறது.

•	 சுற்றுச் சூழலை பாதுகாத்தல் 
(Environmentally friendly) : மின்னஞ்சல் 
அனுப்புவதற்கு காதம் தேவையில்லை  
அட்டைகள�ோ அல்லது பேக்கிங்டேப்புகள�ோ 
தேவையில்லை காகித வளத்தை பாதுகாக்க 
உதவுகிறது.

15.5.3 மின்னஞ்சலில் என்னென்ன அனுப்பலாம்

	 மின்னஞ்சலில் செய்திகளுடன் 
அனுப்பப்படுவதுடன், மேலும் க�ோப்புகள் அல்லது 
மற்ற தரவுகளை இணைத்தும் அனுப்பலாம்.  (எ.கா) 
இணைத்து அனுப்பக் கூடிய இணைப்பானது 
படங்களாகவ�ோ, PDF (Portable Document 
Format) ச�ொற்செயலி க�ோப்புகளாகவ�ோ அல்லது 
கணிப்பொறியில் சேமிக்கப்பட்ட எந்த ஒரு 
க�ோப்பாகவும் இருக்கலாம்.

15.6 இணைய அச்சுறுத்தல்
	 உலகளாவிய இணைய வலையில், 
இன்றைய நிலையில் மிகவும் அச்சுறுத்தலாக 
உள்ளது.  அந்நியர்களுடன் பழகக்கூடாது என்று 
அம்மா கூறுவதை நாம் இணையம் என்ற மாய 
உலகிலும் கடைபிடிக்க வேண்டும்.  புதியவர்களிடம் 
நம்முடைய வணிகம் சார்ந்த வங்கிக் கணக்குகளை 
தரும் ப�ோது எச்சரிக்கையாக இருக்க வேண்டும்.  
நாம் நம்முடைய வங்கியின் இணையதளத்தில் 
தான் உள் நுழைந்துள்ளோமா அல்லது சைபர் 
குற்றவாளிகளால் உருவாக்கப்படும் ப�ோலியான 
வலைத்தளத்தில் உள் நுழைந்துள்ளோமா 
என்பதை உறுதிப்படுத்திக் க�ொள்ள வேண்டும்.  

சைபர் குற்றவாளிகள் பல விதமான முறைகளை 
பயன்படுத்தி உங்களுடைய இரகசியமான 
விபரங்களைய�ோ அல்லது வணிகத் 
தகவல்களைய�ோ வசப்படுத்த முயற்சி  
செய்வார்கள்.  எனவே நாம் நிகழ்நிலையில் 
(ONLINE) உள்ள ப�ோதும் அல்லது இல்லாத 
ப�ோதும் (OFFLINE) மிகவும் கவனத்துடன் 
எச்சரிக்கையாக இருக்க வேண்டும்.

நச்சு நிரல் (Computer virus):
	ந ச்சு நிரல் என்பது ஒரு சிறிய 
மென்பொருளாகும்.  இது பாதிக்கப்பட்ட கணிப் 
ப�ொறியில் இருந்து மற்றொரு கணிப்பொறிக்கு 
எளிதாக பரவும்.  நச்சு நிரலானது கணிப்பொறியில் 
உள்ள தகவல்களுக்கு பாதிப்பை ஏற்படுத்தும் 
அல்லது தகவல்களை நீக்கும் அல்லது வன்வட்டில் 
உள்ள அனைத்து தகவல்களையும் நீங்கும்.  

மால்வேர் (Malware):
	மால்வே ர் என்பது Malicious Soft Ware 
(தீங்கிழைக்கும் மென்பொருள்) என்பதன் 
சுறுக்கம் ஆகும்.  மால்வேர் என்பது பல்வேறு 
விதங்களில் அடையாளம் காணப்படுகிறது. 
அதாவது எதிர்மறை விளைவுகளை ஏற்படுத்தும் 
மென்பொருள் அல்லது நிரல் ஆகும்.  மால்வேர் 
என்பது கணிப்பொறி நச்சு நிரலாகவ�ோ/ட்ரோஜன் 
ஹார்ஸஸ் (Trojan Horses), நேர்மையற்ற ஒற்றறி 
மென்பொருள் (Spyware), மற்றும் தீங்கிழைக்கும் 
ருட்கிட்டுகள் ஆகும் அவற்றை பின்வருமாறு 
காணலாம்.

ட்ரோஜன் குதிரை (Trojan horse):
	 கணினி பயனாளர்கள் பயன்பாடுகளை 
இணையத்தில் இருந்து நம்பிக்கையான 
மென்பொருள் என நினைத்து பதிவிறக்கும் செய்யும் 
ப�ோது, அதற்கு மாறாக அவை தீங்கிழைக்கும் 
மென்பொருளாக ட்ரோஜன் ஹார்ஸ் என்ற 
மென்பொருளால் கணியை பாதிப்படைய செய்கிறது. 

தீங்கழைக்கும் ஒற்றறி மென்பொருள் 
(Malicious spyware):
	சைப ர் குற்றவாளிகளால் உருவாக்கப்பட்டு 
தீங்கிழைக்கும் ஒற்றறி மென்பொருளானது 
ட்ரோஜன் பயன்பாட்டை ப�ோன்றே உளவு பார்க்க 
பயன்படுகிறது.

கணினி முனையப் பெருக்கி (Computer worm):
	 இவ்வகை மென்பொருளானது 
மனிதர்களின் எந்த தலையீடும் இல்லாமல் 
தன்னைத்தானே நகலெடுத்து பெருக்கி ஒரு 
கணிப்பொறியில் இருந்து மற்ற கணிப்பொறிக்கு 
பரவும்.
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பாட்நெட் (Botnet):
	 இணையத்தில் இணைக்கப்பட்டுள்ள 
கணிப்பொறிகளை ஹேக்கர்ஸ் கணிப்பொறி நச்சு 
நிரல் அல்லது ட்ரோஜன் ஹார்ஸ் மூலம் தீங்கு 
இழைக்கும் எண்ணத்துடன் கணிப�ொறிக்குள் 
அனுமதியின்றி நுழைகின்றனர்.  இக்குழுவில் 
உள்ள தனிப்பட்ட கணிப்பொறி “Zombie” 
கணிப்பொறி எனப்படும்.

ஸ்பேம் (Spam):
	ஸ்பே ம் என்பது பாதிப்பை ஏற்படுத்துகின்ற 
அல்லது தேவையற்ற மின்னஞ்சலை பற்றி 
குறிப்பதாகும்.  இது தேவையற்ற மின்னஞ்சல் 
செய்திகளை தங்களது "இன்பாக்ஸ்" (Inbox) 
பகுதியில் சேமிக்கிறது. அதுப�ோல் உங்களது 
மின்னஞ்சல் சேவையகத்தில் அதிக இடத்தையும் 
எடுத்துக்கொள்ளும். 

ஃபிஷிங் (Phishing):
	 தனியார் பற்றிய தகவல்களை பெற சைபர் 
குற்றவாளிகளின் ம�ோசடி முயற்சிகள் ஆகும்.  
இவை மின்னஞ்சல் ப�ோன்று 
வடிவமைக்கப்பட்டிருக்கும் மேலும் சட்டப்பூர்வமான 
இடத்தில் இருந்து வந்தது ப�ோல் முகப்பில் 
த�ோற்றமளிக்கும்.

	 (எ.கா)  ஃபிஷிங் செய்திகள் உங்கள் வங்கி 
அல்லது மின்னஞ்சல் சேவை வழங்குபவரின் 
வலைத் தளத்தை புதுப்பிக்கவும், உங்கள் கணக்கர் 
தகவலை துல்லியப்படுத்த வேண்டும் என்றும் 
அதற்கு மின்னஞ்சலில் உள்ள இணைப்பை click 
செய்து உங்கள் தனிப்பட்ட தகவலை வழங்குமாறு 
உங்களை கவரக்கூடிய செய்தியாகும்.

ரூட்கிட் (Rootkit):
	 ஒரு கணிப்பொறியின் அல்லது 
கணிப்பொறி வலையமைப்பின் நிர்வாகி 
முறையிலான அணுகலைப் பெற பயன்படும் 
கருவிகளின் த�ொகுப்பாகும்.  உங்கள் கணினியில் 
சட்டப்பூர்வமான பயன்பாட்டில் பாதுகாப்பு 
குறைபாடுகளை பயன்படுத்தி ருட்கிட் ஆனது 
சைபர் குற்றவாளிகளால் நிறுவப்பட்டிருக்கலாம்.

	மே லும் அது உளவு மென்பொருளையும் 
க�ொண்டிருக்கலாம்.  அது உங்கள் பதிவுகளையும், 
விசைப்பலகை பயன்பாட்டையும் கண்கானிக்கும்.

15.7 உலவிகள்

	 இணையத்தில் தகவல்களை தேடும் 
முறைக்கு உலவுதல் அல்லது தேடுதல் என்று 
பெயர்.  இணையத்தில் உலவுதலுக்கு வலை உலவி 
அல்லது உலாவி என்னும் மென் ப�ொருளானது 
பயன்படுகின்றது.

	 மின் – வணிகம், சமூக ஊடகங்கள், மற்றும் 
இன்று நம்மால் இணையத்தில் பெறப்படும். பல 
விசயங்கள் இணைய உலவி இல்லை எனில் 
சாத்தியமற்றதாக இருக்கும். வலைப்பக்கத்தின் 
HTML ஆவணங்களை வலை உலாவிகள் ம�ொழி 
பெயர்த்து, அவற்றை நாம் திரையில் காண 
அனுமதிக்கிறது.

15.7.  �வழக்கத்தில் உள்ள புகழ் பெற்ற வலை 
உலாவிகள்

1.  கூகிள் குர�ோம் (Google Chrome):
	 கூகுள் குர�ோம் உலவி கூகுள்  
நிறுவனத்தால் உருவாக்கப்பட்ட புகழ்பெற்ற  
இலவச மென்பொருள் ஆகும். வேகம், எளிமை, 
பாதுகாப்பு, தனியுரிமை, மற்றும் தனிப்பட்ட 
அம்சங்கள் ஆகியவற்றில் இது சிறந்தது.  கூகிள் 
குர�ோமானது ஆண்ட்ராய்டு 4.0 அல்லது அதற்கு 
மேம்பட்ட பதிப்பிலும், அல்லது Mac osx 10.6 
அல்லது அதற்கு மேம்பட்ட பதிப்பினும் விண்டோஸ் 
(XP SP2 அல்லது அதற்கு மேம்பட்ட பதிப்பினும்) 
மற்றும் லினக்ஸ் அமைப்பில் இது இயங்கும்.

Mozila Firefox:
	 இவ்வலை உலாவியானது ம�ோசில்லா 
பவுன்டேசன் மற்றும் ம�ோசில்ல நிறுவனத்தால் 
உருவமைக்கப்பட்ட இலவச மற்றும் திறந்த மூல 
மென்பொருள் ஆகும்.  உபுண்டு இயக்க (open 
source) அமைப்பின் க�ொடாநிலை உலவி இது 
ஆகும்.  விண்டோஸ்,  Max osx, லினக்ஸ், மற்றும் 
ஆண்ட்ராய்டு ப�ோன்ற இயக்க அமைப்புகளை 
ஆதரிக்கின்றது.

Internet Explorer
	 இண்டர்நெட் எக்ஸ்புேளாரர் என்பது 
Microsoft Internet அல்லது விண்டோஸ் 
எக்ஸ்புள�ோரர் என அழைக்கப்படுகிறது.  
விண்டோஸ் இயக்க அமைப்பு அல்லது 
விண்டோஸ் கணிப்பொறிகளில் இது க�ொடாநிலை 
வலை உலவி ஆகும்.  இது மைக்ரோசாப்ட்   
நிறுவனத்தால் உருவாக்கப்பட்டது.

Safari 
	 வலை உலாவியானது Apple 
நிறுவனத்தால் உருவாக்கப்பட்டது இது osx   
மற்றும் ios  இயக்க அமைப்புடன் இணைந்து 
வெளிவரும்.  இவ்வலை உலாவியின் சில பதிப்புகள் 
விண்டோஸ் இயக்க அமைப்பையும் ஆதரிக்கும்.   
Apple Mac கணிப்பொறி மற்றும் பயன்படக் 
கூடியதாகும்.
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15.8 வலைப்பக்கம், வலைதளம் வேறுபாடு

வலைதளம்:

	 வலைதளம் என்பது வலைப்பக்கங்களின் 
த�ொகுப்பாகும்.  ஒரு நிறுவனமானது sricompany.
com என்ற பெயரில் இணையதளம் 
வைத்திருப்பதாக க�ொள்வோம்.  
இவ்விணையதளமானது, முதல் பக்கம், 
நிறுவனத்தை பற்றிய தகவல்கள் (About us), 
இல்லம் த�ொடர்பு க�ொள்ள (Contactus), சான்றுகள் 
(Testimonials), ப�ொருள்கள் (Products), 
சேவைகள் (Services), FAQ’s மற்றும் பல 
வலைப்பக்கங்களை க�ொண்டிருக்கும் 
வலைத்தளத்தின் முதல் பக்கமானது 
இல்லப்பக்கம் (Home Page) எனப்படும்.  
இவ்வாறான பக்கங்கள் இணைந்தது வலைத்தளம் 
எனப்படும்.

வலைப்பக்கம்:

	 வலைப்பக்கம் என்பது வலைத்தளத்தின் 
ஒரு பக்கம் ஆகும்.  வலைப்பக்கத்தை அதனுடைய  
URL முகவரி மூலம் வலை உலாவியை பயன்படுத்தி 
அணுகலாம், மேலும் அப்பக்கத்தை நகல் 
எடுக்கவ�ோ அல்லது நண்பர்களுக்கு அனுப்பி 
கருத்துகளை கேட்கவ�ோ முடியும்.  வலை 
த்தளமானது பல்வேறு வலைப்பக்கங்களின் 
த�ொகுப்புகளை க�ொண்டதாகும் மற்ற பக்கங்களை 
பார்வையிட வழிநடத்தி செல்லும் பக்கங்களையும் 
க�ொண்டதாகும். 

	 வலைப்பக்கம் என்பது வலைத்தளத்தின் 
ஒரு பக்கமாகும்.  வலைத்தளத்தில் ஒவ்வொரு 
வலைப்பக்கமும் தனித்தனி முகவரியைக் 
க�ொண்டுள்ளன.  அவை URL (UNIFORM 
RESOURCE LOCATOR) என அழைக்கப்படும் 
URL - முகவரியானது வலைப்பக்கங்களை வலை 
தளத்தில் இடம் பெற செய்யும்.

வலைப்பக்கம், வலைத்தளம் வேறுபாடு

வலைப்பக்கம் வலைத்தளம்

1.ஒரு 

ஆவணத்தைக் 

க�ொண்டு வலை 

உலவியால் 

வெளிக்காட்டப் 

படுவதாகும்.

பல வலை 

ஆவணங்களைக் 

க�ொண்டு 

உருவமைக்கப்பட்டு வலை 

உலவியால் 

வெளிக்காட்டப்படும்.

2.தனிப்பட்ட 

ட�ொமைன் 

பெயருடன் 

பகிரப்படும்.

வலைத்தளமானது 

தனித்துவமான 

ட�ொமைன் பெயரை 

க�ொண்டுள்ளது.

3.வலைத்தளத்தை 

உருவாக்க 

உதவுகிறது.

ஒன்று அல்லது பல 

வலைப்பக்கங்களை 

க�ொண்டிருக்கும்.

15.9 நிலையான மற்றும் மாறக்கூடிய 
வலைப்பக்கம்

	 வலைப்பக்கமானது நிலையான மற்றும் 

மாறக்கூடிய வலைப்பக்கம் என இரண்டு 

வகைப்படும்.  

	நா ம் பார்வையிடும் ப�ோதெல்லாம் 

வலைத்தளமானது அதே நிலையிலேயே 

த�ொடர்ந்து இருக்கும்.  இவ்வகை வலைத்தளங்கள் 

நிலையான வலைத்தளங்கள் எனப்படும்.  ஒரு 

சிறிய வணிக நிறுவனத்தின் வலைத்தளம் மற்றும் 

பள்ளியினுடைய வலைத்தளம் ப�ோன்றவை 

நிலையான வலைத்தளங்களுக்கு 

எடுத்துக்காட்டடாகும்.

	 ப�ொதுத் தேர்வு முடிவுகள், நுழைவுத் தேர்வு 

முடிவுகள் ப�ோன்றவற்றை வெளியிடும் 

வலைத்தளமானது பயனர் உள்ளிடும் 

பதிவெண்ணிற்கு ஏற்ப வலைப்பக்கம் மாறும்.  இது 

ப�ோன்ற வலைத்தளங்கள் மாறக்கூடியவை 

எனப்படும்.  (எ.கா) அரசினுடைய வலைத்தளம், 

நுழைவுத் தேர்வு முடிவுகளை வெளியிடும் 

வலைத்தளம்.
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நிலையான மற்றும் மாறக்கூடிய வலைப்பக்கங்களின் ஒப்பீடு

நிலையானது மாறக்கூடியது

1. வலைப்பக்கத்தின் ப�ொருளடக்கமும் த�ோற்றமும் 

றிலையானதாக இருக்கும்.

ப�ொருளடக்கமும் த�ோற்றமும் இயக்க நேரத்தின் 

ப�ோது மாறும்.

2. நிலையான வலைப்பக்கமானது தரவுத்தளத்தை 

உபய�ோகிக்காது.

வினவல்களால் மாறக்கூடிய ப�ொருளடக்கத்தை 

க�ொண்ட வலைப்பக்கத்தை தரவுத்தளத்தை 

பயன்படுத்தி உருவாக்கும்.

3. நிலையான வலைப்பக்கமானது, 

சேவையகத்தின் எந்த பயன்பாட்டின் 

துணையுமின்றி நேரடியாக வலை உலாவியில் 

இயங்கும்.

மாறக்கூடிய வலைப்பக்கமானது 

சேவையகத்தின் பயன்பாட்டு நிரலைக் க�ொண்டு 

முடிவை வெளியிடுவதன் மூலம் இயங்கும்.

4. நிலையான வலைப்பக்கத்தை உருவாக்குவது 

எளிது.

மாறக்கூடிய வலைப்பக்கத்தை உருவாக்க 

நிரலாக்கத்திறன் தேவை.

15.10 வலை – பயன்பாடுகள்:
	 மின்-வணிகம் என்பது ப�ொருள்களை 
இணையத்தின் மூலம் வாங்குவது அல்லது 
விற்பனை செய்யும் செயல் ஆகும்.  மின்னணு 
வர்த்தகம் என்பது அலைபேசி மூலம் வணிகம், 
மின்னணு பணப் பரிமாற்றம், விநிய�ோக சங்கிலி 
மேலாண்மை, இணையம் மூலம் சந்தைப்படுத்துதல், 
ஆன்லைன் மூலம் பணப்பரிமாற்றம்.  மின்னணு 
தகவல் பரிமாற்றம் (), சாக்கு மேலாண்மை அமைப்பு 
மற்றும் தானியங்கு தரவு சேகரித்தல் ப�ோன்ற 
த�ொழில் நுட்பங்களை, ஈர்க்கிறது.

15.11 பாதுகாப்புடன் இணையத்தில் உலவுதல்:
	 இணையப் பாதுகாப்பை பற்றி நிலையான 
விழிப்புணர்வு தேவை என்பது பெரிய நினைவூட்டலாக 
உள்ளது.  இணையப் பாதுகாப்பை மீறுபவர்களுக்கு 
எதிராக முன்னெச்சரிக்கை நடவடிக்கை 
எடுக்காவிட்டால் நிறைய விசயங்கள் இணையத்தில் 
நடக்கக் கூடும்.  இதை மனதில் க�ொண்டு 
மகிழ்ச்சியுடன் இணையத்தில் உலவுவதை 
உறுதியாக்கி க�ொள்ளுங்கள்.

இணையப் பாதுகாப்பு நாள்

	 இணையப் பாதுகாப்பு நாளானது ஒவ்வொரு 
ஆண்டும் பிப்ரவரி மாதம் "உருவாக்குதல், 
இணைதல், மற்றும் மரியாதை" என்ற 
கருப்பொருளுடன் க�ொண்டாடப்படுகிறது.

இணையத்தில் செய்ய வேண்டியதும், 
செய்யக்கூடாததும்

1.	 உங்கள் தனிப்பட்ட தகவலை க�ொடுக்க 
வேண்டாம்.  உங்கள் தனிப்பட்ட தகவலான வீட்டு 

முகவரி, த�ொலைபேசி எண்கள், பெற்றோர்கள் 
பணிபுரியும் இடத்தின் முகவரி ப�ோன்றவற்றை 
இணையத்தில் பதியக்கூடாது.  சைபர் 
குற்றவாளிகள் தங்களுடைய விபரங்களை 
க�ொண்டு ப�ோலியான சுய விவரக் குறிப்புகளை 
உருவாக்கிக் க�ொள்கிறார்கள்.

2.	 WHAT GOES ON LINE, STAYS ONLINE:
	 தனிமறை அமைப்புகளை பயன்படுத்தி தாங்கள் 

பதிவிடும் புகைப்படங்கள், மற்றும் செய்திகளை 
நண்பர்கள் மற்றும் உறவுனர்கள் மட்டுமே 
பார்க்குமாறு செய்ய வேண்டும்.

3.	பா துகாப்பு மற்றும் தனிமறை அமைப்பை 
சரிபார்த்துக் க�ொள்ளுதல் :

	ச மூக வலை அமைப்புகளுக்கான அமைப்பை 
(settings) பாதுகாப்பாக அமைத்துக் 
க�ொள்வதன் மூலம் தங்களுடைய சுய 
விபரங்களை நண்பர்கள் மற்றும் உறவினர்கள் 
மட்டுமே பார்ப்பதை உறுதி செய்யவும், மேலும் 
தங்களின் தனிமறை அமைப்புகளை 
பயன்படுத்தி தங்களின் பதிவுகள், 
புகைப்படங்கள், ஒளிக்காட்சிகள் 
ப�ோன்றவற்றை யார் மட்டும் பார்க்க முடியும் 
என்பதை கட்டுப்படுத்த முடியும்.

4.	 கடவுச்சொல் பாதுகாப்பு :

	 உங்களுடைய கடவுச் ச�ொல்லை உங்களுடைய 
பெற்றோர்களுடன் பகிர்வது என்பது அறிவார்ந்த 
ய�ோசனை ஆகும்.  ஆனால் தங்கள் நண்பர்கள் 
தங்களுடைய கடவுச்சொல்லை யாரிடமும் 
ச�ொல்ல மாட்டேன் என அறுதியிட்டு கூறினாலும் 
பகிரக் கூடாது.  கடவுச்சொல்லை 
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அமைக்கும்போது யாரும் எளிதில் யூகிக்க 
முடியாததாக இருப்பதை உறுதி செய்யவும், 
அதாவது உங்களின் செல்லப்பிராணியின் பெயர், 
ப�ோன்றவை.

5.	 அலைப்பேசியினை பாதுகாப்பாக 
வைத்திருத்தல் :

	 உங்கள் அலைப்பேசியானது கடவுச் ச�ொற்கள் 
(எண்கள் ) மூலம் பாதுகாப்பாக உள்ளதை உறுதி 
செய்து க�ொள்ளவும்.  இதன் மூலம் 
அலைப்பேசியினுள்  சேமிக்கப்பட்டுள்ள 
தங்களின் சுய விபரங்கள் பாதுகாக்கப்படும்.  
உங்களுடைய அலைப்பேசியானது த�ொலைந்து 
ப�ோனால�ோ அல்லது திருடு ப�ோனால�ோ அதில் 
உள்ள தகவல்களை இங்கிருந்து அழிக்க 
பாதுகாக்கும்  பயன்பாட்டை  (app) பதிவிறக்கம் 
செய்து க�ொள்ள வேண்டும்.

6.	 அந்நியர்களுடன் ஆன்லைனில�ோ அல்லது 
ஆஃப் லைனில�ோ த�ொடர்பு க�ொள்ள வேண்டாம்.  
அந்நியர்கள் உங்களை ஆன்லைனில் த�ொடர்பு 
க�ொள்ள முயற்சி செய்தால் உங்கள் 
பெற்றோருக்கு தெரியப்படுத்தவும்.

7.	 பெரியவர்களின் பேச்சை கேளுங்கள் :

	 பெரியவர்கள் உங்களை பற்றி எப்போதும் 
கவலைப்படுவார்கள்.  அந்நியர்களுன் 
ஆன்லைனில் நேரத்தை செலவிடுவதை 
தவிர்த்து அவர்களின் மனதை 
அமைதிப்படுத்துங்கள்.

8.	 பாதுகாப்பற்ற அல்லது தெரிந்திருக்காத வலைத் 
தளங்களில் கவனமுடன் இருங்கள்:

	 ஆன்லைனில் ப�ொருள் வாங்கும்போது 
நேர்மையான மற்றும் அறியப்பட்ட 
விற்பனையாளரை பயன்படுத்துங்கள்.

9.	 நீங்கள் Click செய்யும் இணைப்புகளில் 
கவனமாக இருக்க வேண்டும். மின்னஞ்சல், 
உடனடி செய்திகள், அல்லது சமூக 
வலைத்தளங்களில் வரும் இணைப்புகளை, 
அவை உங்களுக்கு தெரிந்தவர்களிடமிருந்து 
உறுதியாக தெரியாத வரை அவற்றை Click 
செய்யாதீர்கள்.

	நா ம் இப்போது இந்த அத்தியாயத்தின் முடிவிற்கு 
வந்து விட்டோம்.  அடுத்த அத்தியாயம் வலை 
பக்கங்களை உருவாக்கப்பயன்படும் HTML 
ஒட்டுகளை பற்றிய அறிமுகத்தை வழங்குகிறது.

ஸாண்ட் பாக்ஸிங் (Sandboxing) 
என்ற மென்பொருள் மேலாண்மை 

நுட்பம் மூலம் வைரஸ் 

பாதிக்கபட்டிருக்கலாம் என 

ஐயப்படும் மென்பொருளை இயக்க உதவுகிறது 

இவ்வகை நிரல்கள் தனிப்பட்ட நினைவக 

பகுதியில் இயக்கப்படுவதால் இயக்க 

அமைப்பிற்கு எந்த வகை பாதிப்பும் ஏற்படாது.

•	 LAN, MAN, WAN, PAN, CAN, மற்றும்  WLAN ஆகியவை வலையின் வகைகள் ஆகும்.
•	  TCP/IP க்கு தேவையான இரண்டு அம்சங்கள்
	 a)  பரிமாற்றம் செய்வதற்கான செய்தி
	 b)  செய்தியை நம்பகத்தன்மைய�ோடு பரிமாற்றம் செய்யும் வழிவகை
•	 வலையில் உள்ள ஒவ்வொரு கணிப்பொறியும் புரவலன் எனப்படும்
•	 இணையத்திற்கு எடுத்துக்காட்டுகள் :
	 1.  மின்னஞ்சல் (e-mail)
	 2.  உடனடி செய்திகள்
	 3.  சமூக வலையமைப்பு
	 4.  இணையம் மூலம் ப�ொருள்கள் வாங்குதல்.
•	 Internet Corporation For Assigned Names and Numbers (ICANN) அமைப்பானது பதிவு 

செய்தலை ட�ொமைன் (domain) நிர்வகிக்கிறது. ஒரு வலைத்தளத்திற்கு பதிவு செய்யப்பட்ட பெயர் 
மற்றொரு வலைத்தளத்திற்கு வழங்கப்படுவதை தவிர்க்கின்றது.

•	 W3C என்பதன் விரிவாக்கம்  World Wide Web Consortium (உலகளாவிய இணையக் 
கூட்டமைப்பு) ஆகும்.  இது உலகளாவிய வலையின் சிறப்பான தகவல் த�ொடர்பு திறனுக்கான தர 
நிலைகளின் த�ொகுப்பை க�ொண்டுள்ளது.  உலகளாவிய வலையை (www) உருவாக்கிய TIM 

நினைவில் க�ொள்க
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2.	 வளாக வலையமைப்பிற்கான வரம்பு

	 a) 10 கி.மீ		  b) 5 கி.மீ

	 c) 25 கி.மீ		  d) 20 கி.மீ

3.	� வலையில் உள்ள ஒவ்வொரு கணிப்பொறியும் 
______________ கருதப்படுவது.

	 a) புரவலர் (host)	
	 b) சேவையகம் (server)
	 c) பணிநிலையம் (workstation)
	 d) முனையம்

Berners Lee என்பவரால் 1994 ல் உருவாக்கப்பட்டுள்ளது.
•	 உலகளாவிய வலையமைப்பான இணையம் TCP/IP (Transmission Control Protocol/Internet 

Protocol) என்ற நெறிமுறையை பயன்படுத்தி பல்வேறு ஊடகங்கள் வழியாக தரவு பரிமாற்றத்தை 
செய்கிறது.

•	 பகரலை (HOT-SPOT) ஆனது இணைய சேவை வழங்குனருடன் இணைக்கும் திசைவி மூலம் 
பிணையத்திற்கு இணைய அணுகலை வழங்குகின்றன.

•	 இன்டர்நெட் டெலிப�ோன் இணையத்தின் உருவாக்கம் மூலம் சாத்தியமான மற்றொரு ப�ொதுவான 
த�ொடர்பு சேவையாகும்.  VOIP என்பது Voice – Over – Internet Protocol என்பதன் குறுக்கம் 
ஆகும்.

•	 வெப்கேமரா, மைக்ரோ ப�ோன், மற்றும் இதர கருவிகள் துணையுடன் வலையின் வழியாக நேருக்கு 
நேர் த�ொடர்பு க�ொள்வதற்கு காண�ொளி காட்சியானது உதவுகிறது.  காண�ொளி காட்சியானது 
குறுகிய கால நேரத்தில் ஏற்பாடு செய்யப்படும் கூட்டத்தில் பங்கேற்க வழி வகை செய்வதுடன், 
நேரத்தையும் பணத்தையும் மிச்சமாக்குகிறது.

•	 ப�ொருள்களை வாங்குதல், விற்றல், சேவைகள் அல்லது பண பரிவர்த்தனை அல்லது தரவுகளை 
பரிமாறுதல் ப�ோன்றவை மின்னணு வலையமைப்பின் மூலம் (முதன்மையாக இணையம் மூலம்)
மேற்கொள்ளப்படுவது மின் வணிகம் எனப்படும்.

•	 சமூக வலை அமைப்பு என்பது இணையம் சார்ந்த சமூக ஊடகம் ஆகும்.  இது நண்பர்கள், 
குடும்பத்தினர், வகுப்புத் த�ோழர்கள், வாடிக்கையாளர் இடையே த�ொடர்பினை ஏற்படுத்த 
உதவுகின்றது.

•	 இ-மெயில் (E-MAIL) என்பது ELECTRONIC MAIL என்பதன் குறுக்கம் ஆகும்.  இது அஞ்சல் 
ப�ோன்றது இணையத்தின் மூலம் பெறுநர்க்கு அனுப்பப்படுகின்றது.

•	 இணையத்தை அணுகுவதற்கும், வலைப்பக்கங்களை நம் கணிப்பொறியில் காண்பதற்கும் உதவும் 
நிரல்கள் இணைய உலாவிகள் எனப்படும்.  இவை வலை உலாவிகள் எனவும் அழைக்கப்படும்.

•	 வலைத்தளம் என்பது பல வலைப்பக்கங்களின் த�ொகுப்பாகும். Sri Company.com என்ற பல 
வலைப்பக்கங்களை க�ொண்ட வலைத்தளத்தை ஒரு நிறுவனம் பெற்றிருப்பதாக க�ொள்வோம்.  
அதாவது முகப்புபக்கம், நிறுவனம் பற்றிய தகவல்கள், த�ொடர்பு க�ொள்ள, சான்றுகள், ப�ொருள்கள், 
சேவைகள், FAQ மற்றும் பல பக்கங்கள்.  இந்த எல்லா பக்கங்களும் ஒன்றாக இணைத்து 
வலைத்தளத்தை உருவாக்குகின்றன.

•	 வலைப்பக்கம் என்பது வலைத்தளத்தின் ஒரு பக்கம் ஆகும்.  வலைத்தளத்தில் உள்ள 
வலைப்பக்கத்தை அதன் URL மூலம் ஒரு வலை உலாவியால் அணுக முடியும்.  அந்தப் பக்கத்தை 
நகலெடுக்கவும் அல்லது நண்பருக்கு அனுப்பி கருத்துக்களை கேட்டறியவும் முடியும்.  வலைத்தளம் 
என்பது பல வலைப்பக்கங்களின் த�ொகுப்பாகும்.  மேலும் மற்ற ப�ொருளடக்கத்தை காண வழிநடத்தி 
செல்பவையும் ஆகும்.

நினைவில் க�ொள்க

மதிப்பீடு

பகுதி - அ
சரியான விடையை தேர்ந்தெடு:
1.	 WLAN - என்பதன் விரிவாக்கம்.

	 a)Wireless Local Area Network
	 b)  Wired local Area Network
	 c) Wireless Local Area Netware
	 d)  Wireless Area Netbande
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4.	� இணையம்______________ ஆல் 
நிர்வகிக்கப்படுகிறது?

	 a)  ICANM		  b) ICANN
	 c) ICMA		  d) ICNNA

5.	 W3C என்பதன் விரிவாக்கம்
	 a) World Wide Web Consortium
	 b) Wide World Web Consortium
	 c) World Web Wide  Consortium
	 d) World Wide Web Consortum

6.	� W3C 1994 ஆம் ஆண்டில் ______________  
என்பவரால் த�ோற்றுவிக்கப்பட்டது

	 a) டிம் – பெர்னர்ஸ் லீ
	 b) டிம் –பர்னார்டு லீ
	 c)  கிம் – பெர்னர்ஸ் 
	 d) கிம் – பர்னார்டு

7.	� பின்வருவனவற்றுள் பகரலை (hotspot) எந்த 
வலையமைப்பைப் பயன்படுத்துகிறது?

	 a) LAN		  b) PAN
	 c) WLAN		  d) CAN

8.	� யுஎஸ் பி, வைஃபை அடாப்டர்ஸ் எவ்வாறு 
அழைக்கப்படும்?

	 a) Data Card		  b) Pen Drive
	 c) Dongles		 d) Memory Card 

9.	� இணையத்தில் தகவலை தேடுதல் எவ்வாறு 
அழைக்கப்படுகிறது?

	 a) உலாவுதல் (Surfing)
	 b) தேடுதல் (Searching)
	 c) கண்டறிதல் (Finding)
	 d) கண்ணோட்டமிடல் (glancing)

10.	� Safari - வலை உலாவியானது யாரால் 
உருவாக்கப்பட்டது?

	 a) கூகுள் (Google)
	 b) ஆப்பிள் (Apple)
	 c) மைக்ரோ சாப்ட் (Microsoft)
	 d) லினக்ஸ் கார்ப்பரேசன் (Linux Corpn)

11.	� எத்தனை வகையான வலைத்தளங்கள் 
உள்ளன?

	 a) 3		  b) 2	
	 c)  4		  d) 6  

பகுதி - ஆ
குறுவினா  (2 மதிப்ெபண்):

1.	� இணையத்தில் உள்ள இரண்டு முக்கியமான 
நெறிமுறைகளின் பெயரை கூறு.

2.	 வலையமைப்பு என்றால் என்ன?

3.	 ICANN - அமைப்பின் பணி யாது?

4.	 தேடு ப�ொறி என்றால் என்ன?

5.	 வலை உலாவி என்றால் என்ன?

6.	 URL - முகவரியில் உள்ள கூறுகள் யாவை?

7.	 வலைத்தளம் என்றால் என்ன?

8.	� மின்னஞ்சலில் உள்ள CC மற்றும் BCC 
என்றால் என்ன?

9.	 நிலையான வலைப்பக்கம் என்றால் என்ன?

10.	மாறக் கூடிய வலைப்பக்கம் என்றால் என்ன?

11.	மின் – அரசாண்மையின் நன்மைகள் யாவை?

12.	ஃபிஷிங் (Phishing) என்றால் என்ன?

பகுதி - இ
பெருவினா  (3 மதிப்ெபண்):

1.	 TCP/IP என்றால் என்ன?

2.	�ப கரலை (hotspot) இணைய சேவை பற்றி 
சிறுகுறிப்பு வரைக

3.	� டேட்டாகார்டு (Data card) மற்றும் டாங்கில்ஸ் 
(Dongles) வேறுபடுத்துக.

4.	� இணையத்தில் இணைவதற்கு பயன்படும் 
இரண்டு அணுகுமுறைகளை கூறுக.

5.	� வலை உலாவி மற்றும் தேடு ப�ொறிகள் 
வேறுபடுத்துக (எ.கா உதவியுடன்).

6.	 வலைத்தளம், வலைப்பக்கம் வேறுபடுத்துக.

7.	� நிலையான வலைப்பக்கத்திற்கும், மாறும் 
வலைபக்கத்திற்கும் உள்ள வேறுபாடு யாது.

8.	 மின்னஞ்சலின் நன்மைகள் யாவை?

பகுதி - ஈ
விரிவான விடை தருக (5 மதிப்பெண்கள்):

1.	 ஏதேனும் 5 இணைய சேவைகள் பற்றி விவரி?

2.	� ஏதேனும் 5 இணைய பயன்பாடுகள் பற்றி 
தகுந்த எடுத்துக்காட்டுடன் விவரி?

3.	� பாடப்புத்தகத்தில் தரப்பட்டுள்ள வலை 
உலாவிகள் தவிர ஏதேனும் 5 வலை உலாவிகள் 
பற்றி விவரி.

4.	 இணைய உலாவுதலிள் செய்ய 
வேண்டியவையும், செய்யக்கூடாததும் பற்றி விவரி.
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செயல்பாடு

மாணவர் செயல்பாடு

1.	 வலையமைப்பின் வகைகள் பற்றி விளக்குக.

2.	 உனக்குத் தெரிந்த இணைய சேவையகம் சிலவற்றை கூறுக.

3.	 இப்பாடப்புத்தகத்தில் குறிப்பிடப்பட்டுள்ள இணைய பயன்பாடகள் தவிர மேலும் சில வற்றை குறிப்பிடவும்.

4.	 இப்பாடப்புத்தகத்தில் குறிப்பிடப்படாத வலை உலாவிகள் சிலவற்றை பட்டியலிடுக.

ஆசிரியர் செயல்பாடு

Students is  taught to develop Static and Dynamic Websites as  workshop.
1.	 STATIC மற்றும் DYNAMIC  வலைப்பக்கங்களை மாணவர்கள் உருவாக்குவதற்கு பயிற்சியளிக்கவும்.

ச�ொற்களஞ்சியம்

No. சுருக்கெழுத்து விரிவாக்கம்

1 LAN Local Area Network
2 MAN Metropolitan Area Network
3 WAN Wide Area Network

4 PAN Personal Area Network

5 CAN Campus Area Network

6 WLAN Wireless Local Area Network
7 VSNL Videsh Sanchar Nigam Ltd
8 TCP Transmission Control Protocol

9 IP Internet Protocol

10 Host
கணிப்பொறி வலையமைப்பில் இணைக்கப்பட்டுள்ள ஒரு கணிப்பெலாறி 
வழங்கு கணிப்பொறி எனப்படும்

11 ICANN Internet Corporation for Assigned Names and Numbers
12 W3C World Wide Web Consortium
13 WWW World Wide Web
14 Tim Berners-Lee உலகளாவிய வலையை உருவாக்கியவர்

15 DSL Digital Subscriber Line
16 ISDN Integrated Services Digital Network
17 URL Uniform Resource Locator

18 Dongle
கணிப்பொறியானது கம்பியில்லா அகலத்தை இணைய த�ொடர்பை 
அணுகவும், பாதுகாக்கப்பட்ட மென்பொருள்களை பயன்படுத்தவும் 
கணிப்பொறியுடன் இணைக்கப்படும் சாதனமாகும்.

19 ADSL Asymmetric Digital Subscriber Line

20 Browser
இணைப்பக்கங்களை அணுகுவதற்கு பயன்படும் மென்பொருள் வலை  
உலாவி ஆகும்.

21 Search Engine
உலகளாவிய வலையில் தகவல்களை கண்டறிவதற்கு  நேடுப�ொறிகள் 
பயன்படுகின்றன. இது ஒரு இணையம் சார்ந்த கருவியாகும். எ.கா.GOOGLE
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22 SERP.
தேடுப�ொறியின் மூலம் பயன்பயனருக்கு திரும்பக் கிடைக்கக் கூடிய 
உள்ளடக்கத்தின் பட்டியல் (வலைத் தளங்களின் பட்டியல் ).  
Search Engine Result எனப்படும்.

23 Phishing
தனியார் தகவலை பெறுவதற்கு சைபர் குற்றவாளிகளால்  
மேற்கொள்ளப்படும் ம�ோசடி முயற்சிக்கு ஃபிஷிங் எனப்படும்.

24 WebSite வலைப்பக்கங்களின் த�ொகுப்பு ஆகும்.

25 WebPage வலைத்தளத்தின் ஒரு பக்கமாகும்.

26 EDI Electronic Data Interchange
27 ICT Information and Communication Technology

28 SID
ஒவ்வொரு வருடமும் பிப்ரவரி மாத்தில் கடைபிடிக்கப்படும் பாதுகாப்பான 
இணைய நாள் 

29 Voice mail த�ொலைபேசி மூலம் அனுப்பப்படும் குரல் வழி செய்தியாகும்.

30 e-commerce
மின்னனு வலையமைப்பின் மூலம் ப�ொருள்களை வாங்குதல், விற்றல் மற்றும் 
தேவையான சேவைகளை பெறுதல் ப�ோன்றவகை மின் வணிகம் எனப்படும்.

31 e-governance
இணையம் மூலம் அரசாங்கம் வழங்கும் சேவைகளைப் பெறவும், அவை 
த�ொடர்பான தகவல்களை தெரிந்து க�ொள்ளவும், உதவும் பயன்பாடு மின் 
ஆளுமை  எனப்படும்.

32 Internet
உலகில் உள்ள சிறிய, பெரிய மற்றும் பல்வேறு வகையான வலையமைப்புகள் 
ஒன்றோடு ஒன்று இணைந்து உருவாக்கப்படும் உலகளாவிய வலை 
இணையம் எனப்படும்.

33 Intranet
நிறுவனம் த�ொடர்பான தகவல்களை பணியாளர்கள் அணுகுவதற்கு 
நிறுவனத்தின் மூலம் உருவாக்கப்படும் அமைப்பு ஆகும்

34 Extranet
வணிகம் த�ொடர்பான குறிப்பிட்ட தகவல்களை பங்குதாரர்கள் மற்றும் 
வாடிக்கையாளர் இடையே பகிர்ந்து க�ொள்ள உதவும். இணைய த�ொழில் 
நுட்பம் சார்ந்த தனியார் வலையமைப்பு ஆகும்.

துணை நூல்கள்:

1.	 Mastering HTML, CSS & JavaScript Web Publishing – Laura Lemay, Rafe Colburn, Jennifer 
Kyrnin – BPB Publications.

2.	 Informatics Practices, A text book for CBSE class XII – Sumita Arora – Dhanpat Rai & Co
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16.1 அறிமுகம்

“ பிறநாட்டு நல்லறிஞர் சாத்திரங்கள்

தமிழ்மொழியிற் பெயர்த்தல் வேண்டும்; 

இறவாத புகழுடைய புதுநூல்கள் 

தமிழ்மொழியில் இயற்றல் வேண்டும்; 

மறைவாக நமக்குள்ளே பழங்கதைகள் 

ச�ொல்வதில�ோர் மகிமை இல்லை; 

திறமான புலமையெனில் வெளிநாட்டோர்; 

அதை வணக்கஞ் செய்தல் வேண்டும்.”

-  மகாகவி பாரதி

	 இருபதாம் நூற்றாண்டின் இணையற்ற 
மனித கண்டுபிடிப்புதான் கணிப்பொறி. த�ொடக்க 
காலத்தில் கணக்கிடும் கருவியாக த�ொடங்கிய 
கணிப்பொறியின் வளர்ச்சி இன்று கணிப்பொறி 
இல்லாமல் மனித வாழ்வு இல்லை என்ற நிலையில் 
தனது அசுர வளர்ச்சியால் மனிதர்களின் 
அத்தியாவசிய ப�ொருளாக மாறிவிட்டது. 

	 மாறிவரும் த�ொழில்நுட்பங்களுக்கு 
ஈடுக�ொடுத்து தன்னை தகவமைத்துக்கொள்ளும் 
ஆற்றல் எந்த ம�ொழிக்கு இல்லைய�ோ அந்த ம�ொழி 
கால வெள்ளத்தில் அடித்து செல்லப்பட்டுவிடும் 
என்பது உண்மை. எத்தனை புதிய 
த�ொழில்நுட்பங்கள் வந்தாலும் அவை 
அனைத்தையும் தன்வயப்படுத்திக்கொண்டு 
தன்னிலை மாறாது, வாழும் ம�ொழியாக பல 

பாடம் 16
கணிப்பொறியில் தமிழ்

அலகு V கணிப்பொறியில் தமிழ்

ஆயிரம் ஆண்டுகளாக வாழ்ந்து வருவது நமது 
செந்தமிழ். தமிழ் வெறும் ம�ொழியல்ல, நமது 
அடையாளம், நமது உயிர், நமது உணர்வு.

“எங்கள் வாழ்வும், எங்கள் வளமும் மங்காத 
தமிழென்று சங்கே முழங்கு” – புரட்சி கவி.

	 இயல், இசை, நாடகம் எனும் 
முத்தமிழ் இன்று கணினித்தமிழ் என 
“நான்தமிழ்” (நான்கு + த மிழ்) என்றாகி 
தமிழ்த்தாயின் முடியில் மேலும் ஓர் 
அணியாய் திகழ்கின்றது. கணிப்பொறியில் 
தமிழின் நிலை அதன் எதிர்காலம் பற்றி 
இனி காணாலாம்.

16.2 இணையத்தில் தமிழ்:
	 இணையம்  இன்று  ஒவ்வொரு  சாதாரண  
மனிதனின் வாழ்விலும் பிரிக்கவியலா ஓர் 
அங்கமாகிவிட்டதை நாம் அறிவ�ோம். இணையம் 
மிகச்சிறந்த தகவல் த�ொழில்நுட்ப சாதனம்.  
இணையத்தின் மூலம் நாம் அனைத்தையும் 
தெரிந்துக�ொள்ளலாம். 

	 சிங்கப்பூர்-யை தலைமையிடமாக்க 
க�ொண்ட KPMG என்ற நிறுவனம் கூகுளு-டன் 
இணைந்து கடந்த ஆகஸ்டு 2017-ல் நடத்திய 
ஆய்வில், 2016ம் ஆண்டுவாக்கில் இந்தியாவில் 
இணையத்தில் அதிகமாக பயன்படும் ம�ொழிகளில் 
தமிழ் முதலிடம் வகிப்பதாகவும், 42% பேர் தமிழ் 
மூலம் இணையத்தை பயன்படுத்துவதாகவும் 
தெரிவித்துள்ளது. 
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	மே லும், 2021ம் ஆண்டுவாக்கில், 74% பேர் தமிழில் இணையத்தை அணுகுவார்கள் என்றும் 

அப்போதும், இந்தியாவில் இணையத்தில் தமிழே முதலிடத்தில் இருக்கும் எனவும் தெரிவிக்கப்பட்டுள்ளது. 

இந்த புள்ளிவிவர கணக்குகள் மேலும் பல இணைய சேவைகளை தமிழில் வழங்க உதவும்.

16.3 தமிழில் தேடுப�ொறிகள்:

	 இணையம் என்ற அகன்ற வெளியில், உங்களுக்கு தேவையான தகவல்களை ந�ொடிப்பொழுதில் 

தேடித்தருபவை “தேடுப�ொறிகள்”. பல தேடுப�ொறிகள் இருந்தாலும், அவற்றில் சிறந்து விளங்குபவை ஒரு 

சில மட்டுமே. இணைய உலகில் சிறந்த பத்து தேடுப�ொறிகளில், “கூகுள் (Google)” முதலிடத்திலும், 

மைக்ரோசாஃப்ட் நிறுவனத்தின் “பிங் (Bing)” இரண்டாம் இடத்திலும், “யாகூ (Yahoo)” மூன்றாமிடத்திலும் 

உள்ளது. இதில், கூகுள் மற்றும் பிங் தமிழில் தேடும் சேவைகளை வழங்கி வருகின்றது. கூகுள் தமிழில் 

தேடுவதற்கு வசதியாக, தமிழ் தட்டச்சு வசதியையும் வழங்குகின்றது. 

உள்ளீட்டுக் கருவிகள்
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படம் 16.1(a) தமிழில் கூகுள் (இந்தியா)

உள்ளீட்டுக் கருவிகள்

படம்  16.1(b) தமிழில் கூகுள் (சிங்கப்பூர் மற்றும் மலேசியா)

படம்  16.2 கூகுளில் தமிழில் தேடுதல்

16.4 மின் அரசாண்மை (e-Governance):

	 ஒரு அரசின் சேவைகளை இணையத்தின் வழியே பெறுவது மின் அரசாண்மை எனப்படும். நமது 

தமிழ்நாடு அரசு தனது அனைத்து சேவைகளையும் இணையத்தின் வழியே வழங்கி வருகின்றது. 

தமிழகத்தின் எந்த மூலையில் இருந்தாலும், அரசுடன் உடனடியாக இணையத்தின் வழியே த�ொடர்பு 

க�ொள்ள முடியும். முக்கிய அறிவிப்புகள், அரசாணைகள், அரசின் திட்டங்கள், சேவைகள் ப�ோன்றவை 

இணையத்தின் வழியே கிடைக்கின்றது. 
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படம்  16.3 தமிழக அரசின் இணையதளம்

தமிழ் வழி மின் அரசாண்மை இணைய முகவரி

தமிழ்நாடு அரசு அதிகாரப்பூர்வ இணையதளம் http://www.tn.gov.in/ta
வேளாண்மை ப�ொறியியல் துறை http://www.aed.tn.gov.in/ 
தமிழ்நாடு அரசு சுற்று சூழல் துறை http://www.environment.tn.nic.in/ 
அரசு தேர்வுகள் துறை http://www.dge.tn.nic.in/ 
தமிழ்நாடு சுகாதாரத் துறை http://www.tnhealth.org/ 
தமிழ்நாடு சிறு, குறு த�ொழில் முனைவ�ோர் 

நலத்துறை
http://www.msmeonline.tn.gov.in/ 

ஊரக வளர்ச்சி மற்றும் ஊராட்சித் துறை http://www.tnrd.gov.in/ 
பிற்படுத்தப்பட்டோர், மிகவும் பிறபடுத்தப்பட்டோர் 

மற்றும் சிறுபான்மையினர் நலத்துறை
http://www.bcmbcmw.tn.gov.in/ 

தமிழ்நாடு அரசு வனத்துறை https://www.forests.tn.gov.in/ 
இந்து அறநிலையத் துறை http://www.tnhrce.org/ 

தமிழ்நாடு அரசு பணியாளர் தேர்வாணையம் 
(TNPSC)

http://www.tnpsc.gov.in/tamilversion/index.
html 

இலங்கை அரசின் அதிகாரப்பூர்வ இணையதளம் https://www.gov.lk/index.php 
	 இந்தியாவிற்கு வெளியே, இலங்கை அரசு தனது இணைய சேவை முழுவதும் தமிழில் வழங்குகிறது. 

சிங்கப்பூர் அரசு தனது அதிகாரப்பூர்வ இணைய தளத்தை தமிழில் இயக்கவில்லை எனினும், அனைத்து 

அரசு சேவைகளை, தமிழிலும் வழங்கி வருகின்றது

16.5 மின் நூலகம்:

	 மின்நூல்களை (e-Books) த�ொகுத்து வழங்குபவை மின் நூலகங்கள், லட்சக்கணக்கான 

தமிழ்நூல்களைக் க�ொண்ட மின்நூலகங்கள் பல நிறுவப்பட்டுள்ளது. இவை, இணையத்தின் வழியே அச்சு 

புத்தகங்கள் ப�ோய் சேரமுடியாத இடங்களில் வாழும் ஆயிரக்கணக்கான தமிழர்களுக்கு நல்ல பல 

தமிழ்நூல்களை க�ொண்டு சேர்க்கும் பணியினை செய்து வருகின்றன.
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மின் நூல்கள் கிடைக்கும் தளங்கள் இணைய முகவரிகள்

ஒன்றாம் வகுப்பு முதல் 12 ம் வகுப்பு 

வரையான தமிழ்நாடு மாநில பள்ளி 

பாடப்புத்தகங்களும், இடைநிலை ஆசிரியர் 

பயிற்சி பாடப்புத்தகங்களும்

http://www.textbooksonline.tn.nic.in/ 

தமிழ்நாடு இணைய கல்விக் கழக மின் 

நூலகம்

(முன்னர் தமிழ்நாடு இணையப் பல்கலைக் 

கழகம் என அழைக்கப்பட்டது)

http://www.tamilvu.org/library/libindex.htm 

கன்னிமரா மின் நூலகம்
http://connemarapubliclibrarychennai.com/
Veettukku_oru_noolagam/index.html 

தமிழிணைய மின்னூலகம் http://tamildigitallibrary.in/ 
சென்னை நூலகம் http://www.chennailibrary.com/ 

தமிழகம்
http://www.thamizhagam.net/parithi/parithi.
html 

மதுரை தமிழ் இலக்கிய மின் த�ொகுப்புத் 

திட்டம்
http://www.projectmadurai.org/pmworks.html 

பழமையான புத்தகங்கள் மற்றும் 

கையெழுத்துப் பிரதிகள்
http://www.tamilheritage.org/old/text/ebook/
ebook.html 

நூலகம் http://www.noolaham.org/wiki/index.php/ 
அண்ணா நூற்றாண்டு நூலகம் http://www.annacentenarylibrary.org/ 

16.6  தமிழ் தட்டச்சு இடைமுக மென்பொருள்

	 கணிப்பொறியை பயன்படுத்தி 

ச�ொற்செயலிகளில் ஆவணங்களை தட்டச்சு 

செய்யவும், இணையத்தின் வழியே தகவல்களை 

தேடவும், பெறவும் மட்டுமே தமிழ் அதிகமாக 

பயன்படுத்தப்படுகிறது. கணிப்பொறியில் தமிழில் 

தட்டச்சு செய்ய பல்வேறு வழிமுறைகள் 

பயன்படுத்தப்படுகிறது. அவற்றில், தமிழ் இடைமுக 

மென்பொருட்களை பயன்படுத்தி  தட்டச்சு செய்யும் 

முறை தற்போது மிகவும் பிரபலமான ஒன்றாகும். 

கணிப்பொறிகள் மட்டுமின்றி ஸ்மார்ட் 

கைப்பேசிகளிலும், இம்முறையில் தட்டச்சு 

செய்வது மிகவும் எளிதான ஒன்றாகும். 

16.6.1 பிரபலமான தமிழ் இடைமுக 

விசைப்பலகைகள்:

•	 NHM Writer, e-கலப்பை மற்றும் லிப்பிகார் – 

ப�ோன்றவை ஆங்கில ஒலியியல் முறையில், 

தமிழ் யுனிக�ோட், தமிழ் 99 ப�ோன்ற தட்டச்சு 

முறையில் வேலை செய்யும் தமிழ் விசைப் 

பலகை இடைமுக மென்பொருட்கள் ஆகும்.

•	 செல்லினம் மற்றும் ப�ொன்மடல் – ஸ்மார்ட் 

கைப்பேசிகளில், ஆண்ட்ராய்டு இயக்க 

அமைப்பில், ஆங்கில ஒலியியல் முறையில் 

பயன்படுத்தப்படும் இடைமுக விசைப்பலகை 

மென்பொருட்கள் ஆகும்.

படம்  16.4 eKalappai த�ொடக்க திரை
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16.7 தமிழ் அலுவலக மென்பொருட்கள்

	 பிரபலமான அலுவலக 
மென்பொருட்களான மைக்ரோசாப்ட் ஆஃபீஸ், 
ஒபன் ஆஃபீஸ் ப�ோன்றவை தமிழில் பயன்படுத்தும் 
வகையில் தமிழ் இடைமுக வசதியை வழங்குகிறது. 
இவ்வசதிகளை இணையத்தின் வழியே 
பதிவிறக்கம் செய்து, நிறுவிக் க�ொள்ள முடியும். 
தமிழ் இடைமுகம் நிறுவப்பெற்ற பின்னர், அலுவலக 
மென்பொருட்களின் (மைக்ரோசாப்ட் ஆஃபீஸ், 
ஒபன் ஆஃபீஸ்) பட்டிப்பட்டை, குறும்படங்களின் 
பெயர்கள் ப�ோன்ற அனைத்தும் தமிழில் 
த�ோன்றும். மேலும், க�ோப்புகள் மற்றும் 
க�ோப்புரைகளின் பெயர்களை தமிழிலேயே 
உருவாக்க முடியும். 

படம் 16.5 Libra Office Writer தமிழ் பதிப்பு

	 இவை மட்டுமின்றி, முழுவதும் தமிழிலேயே 
இயங்கும் அலுவலக மென்பொருட்களும் 
பயன்பாட்டில் உள்ளது. அவற்றில் தமிழ் லிபரெ 
ஆஃபீஸ், தமிழ் ஒபன் ஆஃபீஸ், அழகி யுனிக�ோட் 
எடிட்டர், ப�ொன்மொழி, மென்தமிழ், கம்பன், வாணி 
ப�ோன்ற அலுவலக மென்பொருட்கள் முழுவதும் 
தமிழில் பயன்படுத்தும் வகையில் 
வடிவமைக்கப்பட்டுள்ளது. 

16.8 தமிழ் ம�ொழிபெயர்ப்பு பயன்பாடுகள்:
	 ”தமிழ்பொறி” என்ற மென்பொருள், சுமார் 
30000 க்கும் அதிகமான ஆங்கில ச�ொற்களுக்கு 
ஈடான தமிழ் ச�ொற்களை உள்ளடக்கிது. இதன் 
மூலம், சிறிய ஆங்கில ச�ொற்றொடர்களுக்கு 
இணையான தமிழ் ம�ொழி பெயர்ப்பை பெறலாம். 

	 மேலும், கூகுள் நிறுவனம், தமிழிலிருந்து 
பிற ம�ொழிகளுக்கு ம�ொழி பெயர்க்கும் 
“ம�ொழிபெயர்ப்பு” நிகழ்நேர பயன்பாட்டை 
வழங்கிவருகின்றது.

16.9 தமிழ் நிரலாக்க ம�ொழி:
	 கணிப்பொறி மற்றும் ஸ்மார்ட் 
கைப்பேசிகளில் மென்பொருட்களை வடிவமைக்க 
பயன்படும் நிரலாக்க ம�ொழிகள் இதுவரை 
ஆங்கிலத்தில் மட்டுமே இருந்துவந்த நிலையில், 
தமிழிலும், நிரலாக்க ம�ொழி வடிவமைக்கும் 
முயற்சிகள் நடைபெற்றுவருகின்றன. 
அதனடிப்படையில், பைத்தான் நிரலாக்க 
ம�ொழியை அடிப்படையாக க�ொண்டு, முதல் தமிழ் 
நிரலாக்க ம�ொழி “எழில்” வடிவகைக்கப்பட்டுள்ளது. 
இந்த நிரலாக்க ம�ொழியை பயன்படுத்தி, சிறிய 
அளவிலான நிரல்களை தமிழிலேயே எழுதமுடியும். 

தமிழ் தகவல் பரிமாற்றத்திற்கான குறியீட்டு 
முறைகள்

16.10 தகவல் பரிமாற்றத்திற்கான தமிழ் 
குறியீட்டு முறை

TSCII (Tamil Script Code for Information 
Interchange) 
	 கணிப்பொறி இருநிலை எண்களை 
அடிப்படையாக க�ொண்டது எனவும், 
கணிப்பொறியில் உள்ளிடப்படும் தரவுகள் 
இருநிலை எண்களாக மாற்றப்படும் என்பதையும், 
இந்த பாடப் புத்தகத்தின் முதல் அலகில் 
கற்றீர்கள். கணிப்பொறியில் க�ொடுக்கப்படும் 
தரவுகளும், தகவல்களும் கையாள ASCII என்ற 
குறியீட்டு முறை பயன்படுத்தப்பட்டுவந்தது. இந்த 
குறியீட்டு முறை ஆங்கில ம�ொழியை மட்டுமே 
கையாளும் திறன் பெற்றது. எனவே, ஆங்கிலம் 
அல்லாத பிற ம�ொழிகளை கணிப்பொறி உள்ளிட்ட 
மின்னணு சாதனங்களில் எளிதில் கையாள 
ப�ொருத்தமான ஒரு குறியீட்டு முறை பற்றிய 
ஆய்வில், நமது தமிழ் ம�ொழியை கையாள 
உருவாக்கப்பட்ட முதல் குறியீட்டு முறை தான் 
TSCII (Tamil Script Code for Information 
Interchange) என்பதாகும். இந்த குறியீட்டு முறை 
2007ம் ஆண்டில், ICANN-ன் IANA (Internet 
Assigned Numbers Authority)யில் பதிவு 
செய்யப்பட்டது. இந்த குறியீட்டு முறை தழுவியே 
தமிழுக்கான Unicode முறையும் 
வடிவமைக்கப்பட்டது. 

தகவல் பரிமாற்றத்திற்கான இந்திய குறியீட்டு 
முறை

ISCII (Indian Script Code for Information 
Interchange) 
	 இந்திய ம�ொழிகளை கையாளுவதற்காக 
வடிவமைக்கப்பட்ட ஒரு குறியீட்டு முறை. இந்த 
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முறையை, ஒருங்குறி முறையுடன் 
இணைக்கப்பட்டுவிட்டது. 

ஒருங்குறி  Unicode:
	 தமிழ் உள்ளிட்ட பல்வேறு உலக 
ம�ொழிகளை கையாளுவதற்காக 
வடிவமைக்கப்பட்ட ஒரு குறியீட்டு முறை தான் 
ஒருங்குறி என்று அழைக்கப்படும் யுனிக�ோட். 
இதன் முதல் பதிப்பான யுனிக�ோட் 1.0.0 என்பது 
அக்டோபர் 1991ல் அறிமுகப்படுத்தப்பட்டது. 
அறிமுகப்படுத்தப்பட்ட ப�ோது, தமிழ் உள்ளிட்ட 23 
ம�ொழிகளை கையாளும் திறன் பெற்றிருந்தது. 
தமிழை கையாள பல குறியீட்டு முறைகள் 
இருப்பினும், இன்று ஒருங்குறியே சிறந்த ஒன்றாக 
திகழ்கிறது.

16.11  தமிழ் இயக்க அமைப்புகள் 
	 கணிப்பொறி அல்லது ஸ்மார்ட் கைப்பேசி 
ப�ோன்ற மின்னணு சாதனங்களை இயக்க 
ஏதேனும் ஒரு இயக்க அமைப்பு வேண்டும். 
தனியாள் கணிப்பொறிகளில் மிகப்பிரலமான 
இயக்க அமைப்பு மைக்ரோசாப் நிறுவனத்தின், 
விண்டோஸ் ஆகும். விண்டோஸ் இயக்க 
அமைப்புக்கு அடுத்த இடத்தில், திறந்த மூல 
இயக்க அமைப்பான லினக்ஸ் உள்ளது. 

	 ஒரு கணிப்பொறியை எளிதில் இயக்க 
இயக்க அமைப்பு பயன்படுகிறது. ஒரு இயக்க 
அமைப்பு பயன்படுத்துவதற்கு எளிதாகவும், 
பயன்படுத்துவ�ோர் புரிந்துக�ொள்ளும் வகையிலும் 
அமைக்கப்பட்டிருக்க வேண்டும் என்ற வகையில், 
கணிப்பொறியில் பயன்படுத்தப்படும் விண்டோஸ், 
லினக்ஸ் ப�ோன்ற இயக்க அமைப்புகளையும், 
ஸ்மார்ட் ப�ோன்களில் பரவலாக பயன்படுத்தப்படும் 
ஆண்டிராய்டு இயக்க அமைப்பும் தமிழ் ம�ொயில் 
வழங்கப்பட்டுள்ளது. 

	 விண்டோஸ் இயக்க அமைப்பின் 
பணிப்பட்டை, திரை முகப்பு, பணிக்குறிகள், 
கட்டளைகள் அனைத்தும் தமிழிலேயே காணக் 
கிடைக்கும். விண்டோஸ்-ன் தமிழ் இடைமுக 
வசதி, மைக்ரோசாப்ட் நிறுவனத்தின் 
இணையதளத்திலிருந்து பதிவிறக்கம் செய்து, 
நிறுவிக்கொள்ளலாம்.

16.12 தமிழ் வளர்க்கும் நிறுவனங்களும், 
திட்டங்களும்:

தமிழ் இணையக் கல்விக்கழகம்:

	 தமிழை உலகெங்கிலும் இணையத்தின் 
வழியே க�ொண்டு சேர்க்கும் ந�ோக்குடன், 2001ம் 
ஆண்டு பிப்ரவரி மாதம் 17ம் நாளில், தமிழ் 

இணையப் பல்கலைக் கழகம், தமிழக அரசால் 
த�ொடங்கப்பட்டது. தற்போது தமிழ் இணையக் 
கல்விக் கழகம் என்ற பெரியில் செயல்பட்டு வரும் 
இந்நிறுவனம் இணையத்தின் வழியை தமிழ் 
ம�ொழி, தமிழர் கலாச்சாரம், பண்பாடு ப�ோன்றவை 
உலகெங்கிலும் வாழும் மக்களுக்கு 
வழங்குவதற்காக, மழலையர் கல்வி முதல் பட்டப் 
படிப்பு வரை பல்வேறு கல்வித் திட்டங்களை 
செயல்படுத்தி வருகின்றது.

இணைய முகவரி:  http://www.tamilvu.org/
index.php
வளர் தமிழ் இயக்கம், சிங்கப்பூர்

	 சிங்கப்பூரில் தமிழ்மொழியை வாழும் 
ம�ொழியாகவும் பயன்பாட்டு ம�ொழியாகவும் 
நிலைபெறச் செய்வத�ோடு, அனைத்து 
வயதினரையும் தமிழால் ஒன்றிணைத்து, 
சிங்கப்பூரில் தமிழ்மொழியை ஓங்கச் செய்யும் 
ந�ோக்கத்துடன் 2001ம் ஆண்டில், சிங்கப்பூர் 
தகவல் கலை அமைச்சகத்தின் மேற்பார்வையில் 
இந்த இயக்கம் த�ொடங்கப்பட்டது.

 

இணைய முகவரி:   http://tamil.org.sg/ta

மதுரை தமிழ் இலக்கிய மின் த�ொகுப்புத் திட்டம்:

	 தமிழில் உள்ள அனைத்து நூல்களையும், 
இணையத்தில் மின்னணு வடிவில் 
வெளியிடுவதற்கான ஒரு தன்னார்வ அரசு சாரா 
திட்டம் ஆகும். அதாவது தட்டச்சு செய்தல், பழைய 
புத்தகங்களை ஸ்கேன் செய்தல் மற்றும் 
அணைத்து பிரபலமான கணினிகளிளும் 
பயன்படுத்துவதறகாக எளிதில் அணுகக்கூடிய 
வடிவங்கள் ஒன்றில் உரையை காப்பகப்படுத்துதல் 
ப�ோன்றவை ஆகும். இத்திட்டத்தின் மூலம் 1998ம் 
ஆண்டு முதல், இது வரை தமிழில் வெளிவந்துள்ள 
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அனைத்து நூல்களையும் இணையத்தில் ஏற்றும் 
பணிகள் மேற்கொள்ளப்படுகிறது. 2004 முதல் தமிழ் 
ஒருங்குறியிலும் இணைய புத்தகங்கள் 
வெளியிடுவது த�ொடங்கப் பட்டது. உலகெங்கிலும் 
வாழும் தமிழர்களின் தன்னலமற்ற முயற்சியால் 
இத்திட்டத்தில் இதுவரை பல  நூல்கள் இணைய 

வெளியில் பதிவேற்றம் செய்யப்பட்டுள்ளது. 

இணைய முகவரி: http://www.projectmadurai.
org/

தமிழ் விக்கிபீடியா:

	 விக்கிபீடியா ஒரு திறந்த நிலை 
களஞ்சியமாகும். விக்கிபீடியாவில் எவரும், எந்த 
தலைப்பிலும் கட்டுரைகளை எழுதலாம். தமிழ் 
விக்கிபீடியா தமிழில் ஒரு இலட்சத்திற்கும் 
மேலான கட்டுரைகளை உள்ளடக்கிய ஒரு மிகப் 
பெரிய கலைக் களஞ்சியமாகும். 

இணைய முகவரி:  Web Site: https://
t a . w i k i p e d i a . o r g /

	 தமிழை, வாழும் ம�ொழியாக்க 

வேண்டுமெனில், த�ொழில்நுட்பத்தில் வளர்ச்சியில், 

தமிழை பங்குபெற செய்ய வேண்டியது தமிழராகிய 

நமது கடமை. தனது இனத்தின் மதிப்புகளை  

மறந்தவர், "ந�ோமட்ஸ்" (no mades) நாம் எத்தனை 

பெரிய த�ொழிநுட்பங்களை கற்றாலும், அதனுள் 

நமது இனத்தின் அடையாளமான தமிழை 

க�ொண்டு சேர்க்க வேண்டும். உலகின் முதல் 

ம�ொழி, மூத்த ம�ொழி ஐந்தாயிரம் ஆண்டுகளுக்கும் 

மேலாக இன்றைக்கும் வாழும் ம�ொழியை, கணினி 

த�ொழில்நுட்பத்துடன் இணைப்பது நமது கடமை.

•	 இந்தியாவில் 2016 ஆம் ஆண்டு 
இறுதியுடன், தமிழ் ம�ொழி முதன்மையான 
பட்டியலுடன் விளங்கி, இணையம் 42 
விழுக்காடு பயன்படுத்துகின்றனர்.

•	 தமிழில் தேடுதல் வசதிகளை கூகுள் 
(Google)  மற்றும் பிங் (Bing)  
அளிக்கின்றன.

•	 இணையத்தின் மூலமாக அரசு 
சேவைகளைப் பெற இ-சேவை 
வழங்குகின்றன.

•	 ஆயிரக்கணக்கான தமிழ் புத்தகங்கள் 
மின்னணு தமிழ் சேவைகள் மின்னனு 
புத்தக  வடிவமாகி இலவசமாக 
கிடைக்கின்றன.

•	 ஆங்கில எழுத்துகளுக்கு இணையாக 
தமிழ் எழுத்துக்கள் 30,000 ம�ொழிபெயர்ப்பு 
செயலி தமிழ் ப�ொறியில் இருக்கிறது.

•	 தமிழ் ம�ொழி நிரலில் முதன்மையானது 
“எழில்” 

•	 உலக ம�ொழிகளை கையாள, தமிழையும் 
சேர்த்து ஒருங்குறி (Unicode) 
ஒன்றிணைத்து செய்கின்றது. 

•	 சன்னல் (Windows) தமிழ் சுற்றுச்சுழல் 
இண்டர்பேஸ் செயல் இறக்கி 
இணையத்தின் மூலம்  பதிவிறக்கம் செய்து 
நிறுவலாம். 

நினைவில் க�ொள்க

மதிப்பீடு

பின்வரும் வினாக்களுக்கு விடையளி

1.	 தமிழில் சேவைகளை வழங்கி வரும் தேடுப�ொறிகளை  பட்டியலிடுக

2.	 ஆண்ட்ராய்டு பயன்பாடு விசைப்பலகை என்றால் என்ன?

3.	 தமிழ் நிரலாக்க  ம�ொழி-சிறு குறிப்பு வரைக.

4.	 TSCII என்றால் என்ன?

5.	 தமிழ் இணையக் கல்விக்கழகம்  சிறு குறிப்பு வரைக.
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கணினி த�ொழில்நுட்பம்   
மேல்நிலை முதலாமாண்டு - ெதாகுதி-1

வல்லுநர்கள், மேலாய்வாளர்கள் மற்றும் நூலாசிரியர்கள் பெயர் பட்டியல்

கலை மற்றும் வடிவமைப்புக் குழு
வடிவமைப்பு
THY டிசைனர்ஸ் & கம்யூட்டர்ஸ், சென்னை..
டேனியல்.அ
In-House - QC
ராஜேஷ் தங்கப்பன்
ெஜரால்ட் 
சி. பிரசாந்த் 
மதன் ராஜ்

அட்டை வடிவமைப்பு - கதிர் ஆறுமுகம்

ஒருங்கிணைப்பு
ரமேஷ் முனிசாமி

இந்நூல் 80 ஜி.ஸ்.எம். எலிகண்ட் மேப்லித்தோ தாளில் அச்சிடப்பட்டுள்ளது. 
ஆப்செட் முறையில் அச்சிட்டோர்:

பாடப்பொருள் வல்லுநர்கள்
க. சசிகலா
இணைப் பேராசிரியர், 

கணினி அறிவியல் துறை, இராணி மேரி கல்லூரி, சென்னை.

ப�ொ. பாக்கியலட்சுமி
உதவி பேராசிரியர், 
கணினி பயன்பாட்டியல் துறை, இராணி மேரி கல்லூரி, சென்னை.

முனைவர் சித்ரா பாபு
பேராசிரியர் மற்றும் துறைத்தலைவர்,
கணினி அறிவியல் துறை, எஸ்.எஸ்.என். கல்லூரி, சென்னை.

முனைவர் பெ. இராதா
உதவி பேராசிரியர், 
தகவல்  த�ொழில்நுட்பவியல் துறை,
அரசினர் கலை மற்றும் அறிவியல் கல்லூரி, க�ோயம்புத்தூர்.

முனைவர் மெ. நெஸ்டர் ஜெயக்குமார்
இணைப் பேராசிரியர் மற்றும் துறைத்தலைவர்,
கணிப்பொறியியல் துறை, இலய�ோலா கல்லூரி, சென்னை.

முனைவர் நா. சீனிவாசன்
பேராசிரியர், 
கணிப்பொறியியல் துறை, சத்தியபாமா நிகர்நிலை பல்கலைக் கழகம், சென்னை.

முனைவர் பா. சந்திரம�ோகன் 
இணைப் பேராசிரியர், 
கணினி அறிவியல் துறை, VIT, வேலூர்.

இரா. சேதுராமன்
உதவி பேராசிரியர், 
கணினி அறிவியல் துறை, சத்தியபாமா நிகர் நிலை பல்கலைக்கழகம், சென்னை.

க. சங்கர்
உதவி பேராசிரியர், 
கணினி அறிவியல் துறை, RKM விவேகானந்தா கல்லூரி, மைலாப்பூர், சென்னை. 

பாட வல்லுநர்கள்  ஒருங்கிணைப்பாளர்
திரு. இரவிகுமார் ஆறுமுகம்,
துணை இயக்குநர்,	
மாநில கல்வியியல் ஆராய்ச்சி மற்றும் பயிற்சி நிறுவனம், சென்னை.

மேலாய்வாளர்கள்
முனைவர் ரஞ்சனி பார்த்தசாரதி
பேராசிரியர்,  
தகவல் மற்றும் அறிவியல் த�ொழில்நுட்பம், ப�ொறியியல் கல்லூரி,  
அண்ணா பல்கலைகழகம், கிண்டி, சென்னை.

E. முனிவேல்
விஞ்ஞானி/ப�ொறியாளர் ‘C’
தகவல் த�ொழில்நுட்பம் (தகவல்  பாதுகாப்பு), 
NIELI, NIT வளாகம், காலிகட், கேரளா.

நூலாசிரியர்கள்
க. கண்ணன்
முதுகலைப் பட்டதாரி ஆசிரியர், 
சென்னை பெண்கள் மேனிலைப் பள்ளி, இராட்லர் தெரு, சென்னை.

வி . க�ோ. இராமகிருஷ்ணன்    
முதுகலைப் பட்டதாரி ஆசிரியர், 
கர்நாடக சங்கா மேல்நிலைப்பள்ளி, தி.நகர், சென்னை.

பிந்து  ம�ோகன்தாஸ்
முதுகலைப் பட்டதாரி ஆசிரியர், 
விஜயந்தா மாதிரி மேல்நிலைப்பள்ளி, எச்.வி.எஃப். எஸ்டேட், ஆவடி, சென்னை.

நு . வீ.  க�ௌரி சங்கர்   
முதுகலைப் பட்டதாரி ஆசிரியர், 
சென்னை பெண்கள் மேல்நிலைப் பள்ளி, நுங்கம்பாக்கம், சென்னை.

இரா.சீனிவாசன் 
முதுகலைப் பட்டதாரி ஆசிரியர், 
சாந்தோம் மேல்நிலைப் பள்ளி, சென்னை. 

க�ோ. லெனின்
முதுகலைப் பட்டதாரி ஆசிரியர், 
சென்னை பெண்கள் மேல்நிலைப்பள்ளி, சைதாப்பேட்டை, சென்னை. 

ஆ. சங்கீதா  
முதுகலைப் பட்டதாரி ஆசிரியர், 
அரசினர் மேல்நிலைப்பள்ளி,  
இராசந்தாங்கல், திருவண்ணாமலை மாவட்டம்.

முனைவர் க.எ. வளர்மதி
முதுகலைப் பட்டதாரி ஆசிரியர்,  
வேலம்மாள் வித்யாஷ்ரம் பள்ளி, சூரப்பட்டு, சென்னை.

இரா. கஜலஷ்மி
முதுகலைப் பட்டதாரி ஆசிரியர், 
ஜெயக�ோபால் கர�ோடிய இந்து வித்யாலயா மேல்நிலைப்பள்ளி,  
மேற்கு மாம்பலம், சென்னை.

முனைவர் ஹ. வித்யா 
முதுகலைப் பட்டதாரி ஆசிரியர், 
டி.ஏ.வி. ஆண்கள் மேல்நிலைப் பள்ளி, க�ோபாலபுரம், சென்னை.

பாடநூல் ஒருங்கிணைப்பாளர்
திருமதி R. தமிழ்ச்செல்வி
பட்டதாரி ஆசிரியை, 
அரசு உயர் நிலைப் பள்ளி, பூனாம்பாளையம், திருச்சி மாவட்டம்.

XI Std Computer Technology Vol-1 TM Acknowledgement 194.indd   320 20-04-2020   16:25:21



321

குறிப்பு

XI Std Computer Technology Vol-1 TM Acknowledgement 194.indd   321 20-04-2020   16:25:21



322

குறிப்பு

XI Std Computer Technology Vol-1 TM Acknowledgement 194.indd   322 20-04-2020   16:25:21


	XI Std Computer Technology Vol-1 TM Introduction Pages
	XI Std Computer Science Vol-1 TM Chapter 1 001-022
	XI Std Computer Science Vol-1 TM Chapter 2 023-058
	XI Std Computer Science Vol-1 TM Chapter 3 059-071
	XI Std Computer Science Vol-1 TM Chapter 4 074-089
	XI Std Computer Science Vol-1 TM Chapter 5 090-130
	XI Std Computer Technology Vol-1 TM Chapter 6 
	XI Std Computer Technology Vol-1 TM Chapter 7_100_117
	XI Std Computer Technology Vol-1 TM Chapter 8_117_132 
	Chapter 9
	Chapter 10
	Chapter 11
	Chapter 12
	Chapter 13
	Chapter 14
	Chapter 15
	Chapter 16
	XI Std Computer Technology Vol-1 TM Acknowledgement 194

